User’s Guide

The license agreement is included in this user’s guide. Carefully read the agreement, since by opening the diskette package you agree to its terms and conditions.

PC DOS 7
Note

Before using this information and the product it supports, be sure to read the general information under Appendix C, “Notices” on page 561.

First Edition (January 1995)

The following paragraph does not apply to the United Kingdom or any country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time.

It is possible that this publication may contain reference to, or information about, IBM products (machines and programs), programming, or services that are not announced in your country. Such references or information must not be construed to mean that IBM intends to announce such IBM products, programming, or services in your country.

Requests for technical information about IBM products should be made to your IBM authorized reseller or IBM marketing representative.

© Copyright International Business Machines Corporation 1981, 1995. All rights reserved.

Note to U.S. Government Users — Documentation related to restricted rights — Use, duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.
PC DOS 7 is a new release in a long line of DOS releases from IBM. We have added new functions, extended familiar utilities, and maintained the compatibility you depend upon. Why? Because IBM wants to continue to provide the operating systems that meet your needs.

Over time, some of you will move to a 32-bit operating system like OS/2. Many will continue with PC DOS. Others will run both. Today, PC DOS 7 provides comfortable reliability while adding features that help you get the most from your PC. I hope you'll enjoy the new capabilities and enhancements in PC DOS 7.

Sheryl Winton
PC DOS Product Manager
Personal Systems Products
Contributors

Author
Margaret Averett

Contributing Author
Dana Liburdi

Managing Editor
Larry Thorn

Publications Manager
M. B. (Peg) Ryan

Information Development Planner
R. J. (Bob) Lotito

Production Coordinator
Eugene Ignatowski

Editor
Elizabeth Jean

National Language Support
Marion Bucko
Oystein Kleven
To the members of the PC DOS technical team and to the numerous others who helped ensure the technical accuracy of the PC DOS documentation—a very special “thank you” for your support and continual dedication to quality.
IBM Program License Agreement

IF YOU USE THIS PROGRAM, YOU AGREE TO THESE TERMS AND CONDITIONS FOR THE PROGRAM INCLUDED IN THIS PACKAGE OR PRE-LOADED ON A SYSTEM.

The Program is licensed not sold. International Business Machines Corporation, or the applicable IBM country organization, (IBM) grants you a license for the Program only in the country where you acquired the Program. You obtain no rights other than those granted you under this license.

The term "Program" means the original and all whole or partial copies of it, including modified copies or portions merged into other programs. IBM retains title to the Program. IBM owns, or has licensed from the owner, copyrights in the Program.

You are responsible for the selection of the Program and for the installation of, use of, and results obtained from, the Program.

The section, on the following pages, entitled "License Information" contains additional information on the Program.

1. License

Under this license, you may:

1) use the Program on only one machine at any one time, unless the License Information specifies otherwise;
2) copy the Program for backup or in order to modify it;
3) modify the Program and/or merge it into another program as an essential utilization of the Program in conjunction with your machine; and
4) transfer the possession of the Program to another party.

If you transfer the Program, you must transfer a copy of this license, the License Information, all other documentation and at least one complete, unaltered copy of the Program to the other party. You must, at the same time, either transfer all your other copies of the Program to the other party or destroy them. Your license is then terminated. The other party agrees to these terms and conditions by its first use of the Program.

You must reproduce the copyright notice(s) on each copy, or partial copy, of the Program.

You may not:

1) use, copy, modify, merge, or transfer copies of the Program except as provided in this license;
2) reverse assemble or reverse compile the Program; or
3) sublicense, rent, lease, or assign the Program.

2. Limited Warranty

Some Programs have limited warranties. The warranty details and limitations are described in their Statement of Limited Warranty. Some Programs are not warranted and IBM will specify that they are provided "AS IS."

All Programs have a three-month limited warranty on their media. THESE WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES (OR CONDITIONS), EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Some jurisdictions do not allow exclusion of implied warranties, so the above exclusion may not apply to you.
3. Limitation of Remedies

IBM's entire liability under this license is the following.

IBM will provide any warranty described in IBM's Statement of Limited Warranty. IBM will a) replace defective media, or b) make a warranted Program operate or replace the Program with a functionally equivalent Program, as warranted. Otherwise, you may terminate your license, return all your copies of the Program, and IBM will refund the amount you paid for the license.

For any claim (including fundamental breach), in any form, related in any way to this license, IBM's liability will be for actual damages only and will be limited to the greater of:

1) the equivalent of U.S. $25,000 in your local currency; or
2) IBM's then generally available license fee for the Program.

This limitation will not apply to claims for bodily injury or damages to real or tangible personal property for which IBM is legally liable.

IBM will not be liable for any lost profits, lost savings, or any incidental damages or other economic consequential damages, even if IBM, or its authorized supplier, has been advised of the possibility of such damages. IBM will not be liable for any damages claimed by you based on any third party claim.

This limitation of remedies also applies to any developer of a Program supplied to IBM. IBM's and the developer's limitations of remedies are not cumulative. Such developer is an intended beneficiary of this Section.

Some jurisdictions do not allow these limitations or exclusions, so they may not apply to you.

4. General

You may terminate your license at any time. IBM may terminate your license if you fail to comply with the terms and conditions of this license. In either event, you must destroy all your copies of the Program.

You are responsible for payment of any taxes, including personal property taxes, resulting from this license.

Neither party may bring an action, regardless of form, more than two years after the cause of the action arose.

If you acquired your Program in the United States, this license is governed by the laws of the State of New York. If you acquired the Program in Canada, this license is governed by the laws of the Province of Ontario. Otherwise, this license is governed by the laws of the country in which you acquired the Program.
STATEMENT OF LIMITED WARRANTY
(MEDIA AND PROGRAM)

International Business Machines Corporation (IBM) grants the following limited warranty for this IBM Licensed Program (Program) if this copy of the Program is delivered by IBM, an IBM Authorized Dealer for this Program, or any other IBM approved supplier for this Program to a user. (Such a user is referred to herein as "original user.") A “user” shall mean a Customer who acquired possession of and is licensed to use this copy of the Program for its own use or for use within its own business enterprise and not for remarketing. Any unused portion of the Warranty Period may be conveyed to another user.

1. MEDIA

The Warranty Period for the media on which the Program is recorded is for three months from the date of its delivery to the original user as evidenced by a receipt.

IBM warrants that this media will be free from defects in material and workmanship under normal use during the Warranty Period. If notified during the Warranty Period that the media contains such defects, IBM will replace such media. If IBM is unable to deliver replacement media, you may terminate your license and your money will be refunded upon return of all your copies of the Program.

2. PROGRAM

The Warranty Period for this Program is for three months from the date of its delivery to the original user as evidenced by a receipt.

IBM warrants that this Program, if unaltered, will conform to its Program Specifications during the Warranty Period when such Program is properly used on a machine for which it was designed. If notified during the Warranty Period that the Program contains defects such that it does not conform to its Program Specifications, IBM will 1) attempt to make the Program operate as warranted a) if prior to the Service Expiration Date, by providing a correction, or b) if after the Service Expiration Date, by providing any existing corrections, or 2) replace the Program with a functionally equivalent Program, as determined by IBM. In the event that IBM does not provide such a remedy, you may terminate your license and your money will be refunded upon return of all your copies of the Program.

IBM does not warrant that any other defects in the Program will be corrected or that the operation of the Program will be uninterrupted.

This limited warranty will apply only if the Program is licensed and located in the United States or Puerto Rico.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you. This limited warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

* IBM is a trademark of the IBM Corporation.
• PC DOS 7 provides user commands to perform the following functions:
  - Manage information by creating, assigning attributes to, copying, comparing, renaming, listing, printing, erasing, replacing, moving, backing up, restoring, recovering files, and rewriting fragmented files contiguously.
  - Manage directories by creating, removing, modifying, copying, and displaying the structure of directories.
  - Format, unformat, copy, and compare diskettes.
  - Format, partition, and check status of a disk.
  - Perform system tasks, including:
    - Assign drives
    - Change the system code page and keyboard layout
    - Clear the screen
    - Set the system time and date
  - Create a PC DOS 7 batch file to perform special or repetitive tasks.
  - Configure your system for multiple configurations.

• Memory Support:
  - Memory optimization of available upper memory.
  - Expanded Memory Support (EMS) and Extended Memory Support (XMS).
    This support conforms to the Lotus**/Intel**/Microsoft** (LIM) 4.0 definition.

• Disk Cache
  PC DOS 7 provides an improved hard-disk caching program.

• Hard-Disk Support:
  PC DOS 7 allows greater than 32MB fixed disk partition support.

• Advanced Power Management (APM)
  PC DOS 7 supports the latest standard of APM 1.1 and continues to support systems with APM 1.0 bios.

• Virus Detection and Antivirus Support
  - Full-screen utility
  - Terminate-and-stay-resident
  - Updated signature files to detect over 2100 viruses

• Full-Featured Backup Utility
  - Provides a full-screen utility
  - Backs up to diskette, tape, or network drive

** See Special Notices section of this book for trademark information.
• REstructured eXtended eXecutor language (REXX)

PC DOS 7 provides this easy-to-use structured programming language that:
- Offers powerful functions
- Provides extended mathematical capabilities
- Works across multiple platforms (WARP, AIX, VM, and PC DOS)

• Text Editor

PC DOS 7 provides a full-screen text editor that allows the end user to create, edit, save, browse, and print ASCII files.

• Full-Screen DOS Interface (PC DOS Shell)

- Provides a limited application switching mechanism which suspends execution of one application while executing another.
- Enables the creation of a user-defined menu system for the execution of applications.
- Provides a full-screen user interface to facilitate DOS file and directory maintenance.

• Full-Screen Interactive Installation Program

- Installs all PC DOS 7 utilities and optional tools.
- Creates user configuration files.
- Installs to a new system or replaces an existing system.

• Scheduler Utility

- Allows execution of DOS programs at specific times.
- Provides a full-screen, easy-to-use interface.

• Data Compression Utility

- Automatic, transparent data compression that frees up storage space.
- A Stacker Anywhere program, allowing you to use compressed data on a system without compression.
- A conversion function for DBLSPACE compressed files.
- DOS and Windows toolbox interfaces.
- Automated uncompress to convert compressed data to its original form.

• Docking Support

PC DOS 7 provides the ability to dynamically load certain device drivers and to execute specified commands when docking events occur.

• File Synchronization Utility

PC DOS 7 provides a file monitoring utility that synchronizes files whenever files are moved from one computer to another.
• PCMCIA Support
  
  PC DOS 7 includes PCM 3.01 support for PCMCIA card services.

• Documentation Viewing Facility
  
  PC DOS 7 provides a text-based, full-screen, online documentation and help facility. This viewer can be used to read the following books online: PC DOS 7 Command Reference, PC DOS 7 Error Messages, and PC DOS 7 REXX for DOS.

• National Language Support
  
  – Code pages 865, 912, and 915
  – Keyboards 452 and 453 (German keyboard layout DIN 2137)

Deleted Files
The following files were deleted from this version of PC DOS 7:

<table>
<thead>
<tr>
<th>File</th>
<th>File</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>4201.CPI</td>
<td>EPS.CPI</td>
<td>GRAPHICS.PRO</td>
</tr>
<tr>
<td>4208.CPI</td>
<td>EXE2BIN.EXE</td>
<td>PPDS.CPI</td>
</tr>
<tr>
<td>COMP.COM</td>
<td>FASTOPEN.EXE</td>
<td>PRINTER.SYS</td>
</tr>
<tr>
<td>EDLIN.EXE</td>
<td>GRAPHICS.COM</td>
<td></td>
</tr>
</tbody>
</table>

If you have a licensed copy of PC DOS 6.3, you are authorized to copy these commands to any system with a licensed copy of PC DOS 7.

System Requirements
PC DOS 7 will operate on all models of Personal System/2*, Personal System/1, IBM Personal System/55*, IBM Personal Computer*, IBM Personal Computer XT*, Personal Computer XT-286, Personal Computer AT*, Portable Personal Computer, PC Convertible, and IBM compatibles with a minimum system memory of 512K.

The system should also have a 1.44MB or 2.88MB 3.5-inch, or a 1.2MB 5.25-inch floppy diskette drive. The PC DOS 7 Upgrade requires a system with a prior version of PC DOS or MS-DOS*" (3.3 or higher) installed on the hard disk.

Program Requirements
There are no program requirements.

Licensed Program Materials Availability
This licensed program is available in object code only.
# Contents

## About This Book
- Other PC DOS Documentation ........................................... xix
- PC DOS 7 Coupon Booklet .................................................. xx

## What's New for PC DOS 7 .................................................. xxii

## Part 1. Using the DOS Operating System ................................. 1

### Chapter 1. Installing ................................................... 3
- What's New about Setup for PC DOS 7 ................................ 3
- Before You Begin .......................................................... 5
- SETUP Command and Its Options ...................................... 8
- Other Installation Options ................................................. 9
- Optional Tools Selection .................................................. 10
- Installation Guidelines ................................................... 12
- PC DOS Standard Installation ............................................ 14

### Chapter 2. Learning Basic DOS Concepts ............................... 19
- Understanding Files ...................................................... 19
- Working with Files ........................................................ 23
- Understanding and Working with Directories ......................... 32
- Viewing Directory Contents .............................................. 34
- Viewing Groups of File Names in a Directory ......................... 35
- Making Directories ....................................................... 35
- Deleting Directories ...................................................... 36
- Copying Directories ...................................................... 38

### Chapter 3. Using the Online Book Viewer ............................... 41
- Starting the PC DOS Viewer .............................................. 41
- Viewing the Initial PC DOS Viewer Screen ............................ 43
- Moving Around in the PC DOS Viewer .................................. 44
- Exiting from the PC DOS Viewer ........................................ 45
- Getting Other Types of Online Help ................................... 45
- Linking to More Topics ................................................... 49
- Printing from the PC DOS Viewer ....................................... 51
- Copying Topic Information into a File ................................. 51

### Chapter 4. Configuring Your System ..................................... 53
- Bypassing CONFIG.SYS and AUTOEXEC.BAT Commands .......... 54
- Specifying Startup Commands in Your CONFIG.SYS File .......... 56

© Copyright IBM Corp. 1981, 1995
Using Multiple Configurations ............................................. 60
Specifying Startup Commands in Your AUTOEXEC.BAT File ........ 66

Chapter 5. Managing Disks ................................................. 73
Types of Disks ............................................................... 73
Types of Diskette Drives .................................................. 74
Considerations for Formatting Disks ...................................... 75
Considerations for Labeling a Disk ...................................... 79

Chapter 6. Partitioning Your Hard Disk .................................. 81
Understanding Hard-Disk Partitions ...................................... 81
Using FDISK ................................................................. 83
Formatting Your Hard Disk after Using FDISK ......................... 94

Chapter 7. Working with Batch Programs ................................. 97
Understanding Batch Program Commands ........................... 98
Making a Small Batch Program ......................................... 100
Testing a Batch Program .................................................. 101
Displaying Messages with a Batch Program ......................... 101
Using the PAUSE Command .............................................. 102
Including Remarks in a Batch Program .............................. 103
Running One Batch Program from Another .......................... 104
Using Replaceable Parameters ......................................... 105
Controlling Program Flow ................................................. 106

Chapter 8. Redirecting Input and Output ............................... 109
Redirecting Command Input and Output ............................. 109
Passing Information through Filter Commands ...................... 111
Controlling the Screen Display by Using the MORE Command .... 111
Searching for Text by Using the FIND Command .................. 112
Sorting Text Files .......................................................... 112
Combining Commands with Redirection Characters ................. 113

Chapter 9. Using DOSKey and Editing Keys ............................ 115
Using DOSKey to Work with Commands ............................. 115
Using DOSKey to Work with Macros ................................ 120
Using DOS Editing Keys .................................................. 127

Chapter 10. Working with the Text Editor ............................... 131
What's New about the E Editor for PC DOS 7 ....................... 131
Choosing a Text Editor .................................................... 132
Starting the E Editor ....................................................... 133
Creating or Modifying a File ............................................. 137
Using Cursor Movement Keys to Move Around in the Text File .................. 141
Performing Basic Editing Tasks ............................................. 143
Selecting Text ................................................................. 148
Using Key Combinations to Manipulate Text ............................... 151
Using E Editor Commands ..................................................... 156
Customizing the E Editor ...................................................... 169
Comparing a Text Editor and a Word Processing Program ................. 172

Chapter 11. Connecting Computers ........................................... 175
Establishing the Connection between Computers ......................... 176
Understanding What the InterLnk Program Does .................................. 177
Including INTERLNK in Your CONFIG.SYS File ......................... 180
Running the InterLnk Program .................................................... 181
Redirecting Drives ..................................................................... 182
Excluding Drives from Redirection ............................................ 183
Breaking the Connection between Computers ............................... 183
Remote Copying of INTERSVR.EXE and INTERLNK.EXE Files .......... 183
Reviewing Cable Specifications ..................................................... 184

Chapter 12. Using File Update ................................................... 189
Installing File Update at the Base Location .................................... 190
Using File Update Menu Choices ............................................... 194
Transferring Updated Files to the Remote Location ......................... 196
Troubleshooting ...................................................................... 203

Chapter 13. Making More Memory Available ................................. 205
Determining Your System’s Memory Type ...................................... 205
Understanding How RAMBoost Works ......................................... 206
Using Advanced Features ......................................................... 214
Using RAMBoost Tips and Techniques ........................................ 218

Chapter 14. Speeding Up Your System .......................................... 231
Improving the Efficiency of Your Hard Disk .................................... 231
Using DOS Defragmenter ......................................................... 233
Using the BUFFERS Command .................................................... 235
Using SMARTDrive ................................................................. 236
Using RAMDrive .................................................................. 238

Chapter 15. Using Central Point Undelete ..................................... 241
Installing Central Point Undelete for Windows .............................. 241
Starting Undelete .................................................................... 243
Deleted File Condition ............................................................. 245
Delete Protection Methods ........................................................ 247
Getting More File Information .................................................. 248
Sorting the File List ................................................................. 248
Selecting Files ................................................................. 249
Undeleting Files on a Network .................................................. 251
Undeleting Directories and Their Files ................................. 252
Scanning the Disk for Lost Files and Deleted Data .................. 258
Showing Existing Files ..................................................... 260
Advanced Undelete Methods ............................................. 261
Purging Deleted Files .................................................... 266
How the Delete Protection Method Affects File Recovery ........ 267
Central Point Data Monitor ............................................... 270

Chapter 16. Using Central Point Scheduler ................................. 275
Scheduling a Program ....................................................... 275
Editing Existing Scheduled Events ..................................... 278
Deleting Scheduled Events ............................................. 279
Removing Scheduler from Memory .................................... 280

Chapter 17. Troubleshooting .................................................. 281
PC DOS Installation ............................................................ 281
Memory Problems ............................................................ 287
DOS Command Problems ................................................ 292
PC DOS Shell ................................................................. 295
AntiVirus ........................................................................ 297
Stacker Compression ............................................................ 299
Central Point Backup .......................................................... 312
File Update Utility ............................................................. 313
Other Common Problems ............................................. 313

Part 2. Using the DOS Optional Tools ........................................ 317

Chapter 18. Using the PC DOS Shell ........................................ 319
Installing the PC DOS Shell after Installing PC DOS .............. 319
Starting the PC DOS Shell .................................................. 320
Displaying Information About Your Files and Programs .......... 323
Introducing PC DOS Shell Basics ........................................ 324
Using PC DOS Shell Commands ....................................... 333
Getting Help ................................................................. 334
Starting a Program ............................................................ 338
Using the Task Swapper ..................................................... 341
Leaving the PC DOS Shell ................................................ 342
Customizing the PC DOS Shell .......................................... 343
Organizing Programs ....................................................... 348
Working with Properties .................................................. 353

Chapter 19. Using IBM AntiVirus/DOS ................................. 363
Installing IBM AntiVirus/DOS after Installing PC DOS ........ 363
Starting IBM AntiVirus/DOS ............................................. 365
Protecting Your Computer Data against Viruses .................. 367
Checking for Viruses ..................................................... 369
Customizing AntiVirus .................................................. 372
Cleaning Up When a Virus Is Detected .............................. 376
Running the AntiVirus Stand-Alone Program ...................... 379
Systems that Use Resident Data Compression ..................... 381
Systems that Use Security Software .................................... 382
Troubleshooting IBM AntiVirus/DOS ................................. 382

Chapter 20. Using Central Point Backup ............................... 383
Installing Central Point Backup after Installing PC DOS ....... 383
Configuring Central Point Backup ..................................... 384
Viewing the Main Central Point Backup Window ................. 388
Changing the User Level ................................................ 389
Making a Backup ......................................................... 391
Selecting Files ............................................................ 394
Selecting Drives to Back Up ............................................ 400
Viewing Files ............................................................... 402
Working with Setup Files ............................................... 403
Comparing Data .......................................................... 407
Restoring Data ............................................................ 409
Performing Network Backups .......................................... 411
Configuring Tape Drives ................................................. 415
Backup Strategies ........................................................ 421
Using the CPBDIR Program ............................................. 425

Chapter 21. Using Stacker Compression ............................... 427
Installing Stacker after Installing PC DOS .......................... 427
Before Using Stacker ..................................................... 428
What's New about PC DOS's Stacker Compression ............... 429
Setting Up Stacker ....................................................... 430
Monitoring Your Drives from DOS .................................... 438
Using the Stacker Tools (DOS and Windows) ....................... 440
Compressing Additional Drives ........................................ 440
Compressing Diskettes (or Other Removables) ..................... 442
Working with Advanced Stacker ....................................... 455
Using Stacker Commands ............................................... 467
Monitoring Your Drives from Windows ............................. 469
## Troubleshooting Stacker

Troubleshooting Stacker ..................................................... 479

### Chapter 22. Using PenDOS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing PenDOS after Installing PC DOS</td>
<td>481</td>
</tr>
<tr>
<td>Starting PenDOS</td>
<td>483</td>
</tr>
<tr>
<td>Using the Pen</td>
<td>484</td>
</tr>
<tr>
<td>Using the Mouse as a Pen</td>
<td>484</td>
</tr>
<tr>
<td>Using the PenDOS Menu</td>
<td>485</td>
</tr>
<tr>
<td>Entering Characters</td>
<td>486</td>
</tr>
<tr>
<td>Editing Characters</td>
<td>490</td>
</tr>
<tr>
<td>Working with Applications</td>
<td>493</td>
</tr>
<tr>
<td>Aligning the Tablet</td>
<td>497</td>
</tr>
<tr>
<td>Recognition Tips</td>
<td>498</td>
</tr>
<tr>
<td>Character Variations</td>
<td>499</td>
</tr>
</tbody>
</table>

### Chapter 23. Using PCMCIA Support

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing Phoenix PCMCIA Support after Installing PC DOS</td>
<td>502</td>
</tr>
<tr>
<td>Starting PCMCIA</td>
<td>503</td>
</tr>
<tr>
<td>Setting Up PCMCIA (PCMDINST)</td>
<td>505</td>
</tr>
<tr>
<td>Configuring Your PCMCIA System (PCMSETUP)</td>
<td>505</td>
</tr>
<tr>
<td>Configuring PCMCIA</td>
<td>512</td>
</tr>
<tr>
<td>Using Advanced Configuration</td>
<td>517</td>
</tr>
<tr>
<td>Configuring PC Cards after the Original Installation</td>
<td>524</td>
</tr>
</tbody>
</table>

### Appendix A. More About Installing

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choosing the Correct Installation Procedure</td>
<td>533</td>
</tr>
<tr>
<td>Performing the LAN Server Administrator Installation of PC DOS</td>
<td>540</td>
</tr>
<tr>
<td>Installing PC DOS from a CD-ROM Drive</td>
<td>544</td>
</tr>
<tr>
<td>Rerunning Setup</td>
<td>544</td>
</tr>
<tr>
<td>Uninstalling and Restoring Your Previous Version of DOS</td>
<td>547</td>
</tr>
<tr>
<td>Viewing and Editing the System Files during Install</td>
<td>548</td>
</tr>
<tr>
<td>Viewing the README.TXT File</td>
<td>550</td>
</tr>
<tr>
<td>Working with XDF-Formatted Diskettes</td>
<td>550</td>
</tr>
<tr>
<td>Working with Setup Bundle Files</td>
<td>554</td>
</tr>
<tr>
<td>Using the Emergency Startup Diskette</td>
<td>555</td>
</tr>
<tr>
<td>Troubleshooting PC DOS Setup</td>
<td>556</td>
</tr>
</tbody>
</table>

### Appendix B. Accessibility for Individuals with Disabilities

Appendix B. Accessibility for Individuals with Disabilities ............ 557

### Appendix C. Notices

Appendix C. Notices ....................................................... 561

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trademarks and Service Marks</td>
<td>561</td>
</tr>
</tbody>
</table>

Index .................................................................................. 565
About This Book

This book is written for novice users or users who are already familiar with PC DOS and who have experience using computers.

This book is organized into two parts. Part 1 contains instructions for use with the fundamental PC DOS features. Part 2 contains information on the Optional Tools available with PC DOS.

If PC DOS is not yet installed on your computer system, you will need to run the Setup program. For information about how to set up PC DOS, see Chapter 1, "Installing" on page 3.

Other PC DOS Documentation

The PC DOS library includes the following documentation:

• **PC DOS 7 Command Reference and Error Messages**
  
  Part 1 of this book contains the commands, listed in alphabetical order, that can be typed from the DOS command prompt. It also includes information on DOS device drivers, CONFIG.SYS commands, menu configuration commands, REXX commands for DOS, and .INI file information. Part 2 includes error messages in a cause-and-action format.

• Online books are provided with PC DOS containing the same information as is available in the **PC DOS 7 Command Reference and Error Messages** hardcopy manual. The three online books provided with PC DOS include:
  
  – **PC DOS 7 Command Reference**
  – **PC DOS 7 Error Messages**
  – **PC DOS 7 REXX Reference**

• **PC DOS 7 Keyboards and Code Pages**
  
  This book, available for optional purchase, contains examples of keyboard layouts and code page tables that can be used with PC DOS.

• **PC DOS 7 Technical Update**
  
  This book, available for optional purchase, is written for programmers who develop applications for DOS.

  Included with the hardcopy version of this book is a diskette, containing the online version, which is viewable using the PC DOS Viewer.
• *PC DOS 7 REXX User's Guide and Reference*

This book, available for optional purchase, describes how to write programs with REXX and is for both beginners and experienced programmers.

**PC DOS 7 Coupon Booklet**

This booklet contains coupons provided by major hardware and software computer companies. These coupons offer discounts or information about their products.
What's New for PC DOS 7

PC DOS 7 includes the following new features as well as enhancements to features in prior versions of PC DOS:

- The PC DOS Setup program includes enhancements that allow you to:
  - Use a mouse device during installation.
  - Use the DOSKey program immediately after installing DOS, because the DOSKEY command-line statement is now automatically added to your AUTOEXEC.BAT file.
  - View or edit the changes Setup made to your CONFIG.SYS and AUTOEXEC.BAT files prior to system restart. For example, if you use another command retrieval program than DOSKEY, you can edit the AUTOEXEC.BAT file and delete this command-line statement before the Setup changes become effective.
  - Understand what changes were made to these system files by reviewing comment lines added by Setup. Comment lines describe what was added in these files or what was replaced, updated, or deleted if upgrading your version of DOS.

See the installation information for a complete list of Setup enhancements.

- RAMBoost more effectively handles multiple configurations now. The most common questions asked about RAMBoost and RAMBoost Setup are now included in a tips and techniques section.

- The E Editor has the following enhancements for PC DOS 7: menu selection, mouse awareness, expanded sort capabilities, deleted record recovery, ability to change E Editor default settings for color, tab and margin settings, window mode, and a new browse mode for the online F1 help.

- A new program, File Update, compares files on two different computers to help keep files synchronized (for example, when you work on one computer at home and one at work).

- A new documentation viewer, PC DOS Viewer, is used to read or search online books for PC DOS information. Three online books are included with PC DOS: a Command Reference, a REXX Reference, and an Error Messages book, which includes the more common error messages.

This viewer also allows quick access to help for DOS commands, DOS device drivers, and DOS .INI files information. In addition you can get quick help for REXX commands or DOS error messages.
• The enhanced Advanced Power Management driver (POWER.EXE) has added power management events.

• PC DOS now provides support for a docking event. Docking is the process of connecting a mobile computer to a docking station and subsequently accessing the additional docking station system resources (for example, CD-ROM or DASD). Your docking station and mobile computer must be plug-and-play enabled to perform the docking and undocking events.

• The new PC DOS command, DYNALOAD, can be used to change the current system device configuration without requiring you to modify the CONFIG.SYS file and restart the system, such as for docking support.

• The amount of conventional memory required by PC DOS has been reduced, allowing more memory for your applications.

• The QCONFIG command now identifies and displays additional machines, adapters, and planars.

• The BACKUP command (not included in PC DOS versions 6.1 or 6.3) is provided as a command with PC DOS 7.

### New, Changed, or Removed PC DOS Commands and Device Drivers

The following commands and device drivers are new for PC DOS 7:

<table>
<thead>
<tr>
<th>ACALC</th>
<th>DPMS.EXE</th>
<th>REMOVDRV</th>
<th>STACHIGH.SYS</th>
</tr>
</thead>
<tbody>
<tr>
<td>BROWSE</td>
<td>DYNALOAD</td>
<td>REPORT</td>
<td>STACKER</td>
</tr>
<tr>
<td>CHECK</td>
<td>FILEUP</td>
<td>RESIZE</td>
<td>STACWIN</td>
</tr>
<tr>
<td>CNFIGNAM.EXE</td>
<td>HCONVERT</td>
<td>REXX</td>
<td>SYSINFO</td>
</tr>
<tr>
<td>CONFIG</td>
<td>PASSWD</td>
<td>SCREATE.SYS</td>
<td>TUNER</td>
</tr>
<tr>
<td>CRC</td>
<td>PCM</td>
<td>SDEFRAG</td>
<td>UNCOMP</td>
</tr>
<tr>
<td>CREATE</td>
<td>PCMDINST</td>
<td>SDIR</td>
<td>UNPACK2</td>
</tr>
<tr>
<td>DCONVERT</td>
<td>PCMFDISK</td>
<td>SETUP (Stacker)</td>
<td>VIEW</td>
</tr>
<tr>
<td>DDPOPUP</td>
<td>PCMRMAN</td>
<td>SGROUP</td>
<td>XDF</td>
</tr>
<tr>
<td>DOSDATA</td>
<td>PCMSETUP</td>
<td>SSETUP</td>
<td>XDFCOPY</td>
</tr>
<tr>
<td>DOSDOCK</td>
<td>PCMWIN</td>
<td>STAC</td>
<td></td>
</tr>
</tbody>
</table>

The following commands and device drivers are enhanced for PC DOS 7:

<table>
<thead>
<tr>
<th>ANSI.SYS</th>
<th>DOSKEY</th>
<th>HIMEM.SYS</th>
<th>RAMBOOST</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUFFERS</td>
<td>E (E Editor)</td>
<td>INTERLNK</td>
<td>RAMBOOST.EXE</td>
</tr>
<tr>
<td>DEFRAG</td>
<td>EMM386.EXE</td>
<td>MSCDEX</td>
<td>RAMDRIVE.SYS</td>
</tr>
<tr>
<td>DISKCOPY</td>
<td>FIND</td>
<td>POWER</td>
<td>RAMSETUP</td>
</tr>
<tr>
<td>DISPLAY.SYS</td>
<td>HELP</td>
<td>QCONFIG</td>
<td>SETUP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SMARTDRV.EXE</td>
</tr>
</tbody>
</table>

For further information about new or enhanced DOS commands and device drivers, type `help` followed by the name of the command or device driver.
You must add the extension of the device driver file. For example, you would type `help ansi.sys` to get online help about the ANSI.SYS device driver.

The following commands and device drivers are no longer provided with PC DOS 7:

- **SuperStor/DS compression commands.**
  
<table>
<thead>
<tr>
<th>Command</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBLSPACE.SYS</td>
<td>SSUTIL</td>
</tr>
<tr>
<td>MOUNT</td>
<td>UDEOFF</td>
</tr>
<tr>
<td>RTOOL</td>
<td>UDEON</td>
</tr>
<tr>
<td>SSTOR</td>
<td>UNMOUNT</td>
</tr>
<tr>
<td>SSUNCOMP</td>
<td></td>
</tr>
</tbody>
</table>

- **PCMCIA Support commands** replaced because of the new DOS and Windows full-screen installation interfaces.
  
<table>
<thead>
<tr>
<th>Command</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCMFDD.EXE</td>
<td>PCMMTD.EXE</td>
</tr>
<tr>
<td>PCMINFO.EXE</td>
<td>WPCMINFO.CPL</td>
</tr>
</tbody>
</table>

If you have a previous version of DOS installed and are upgrading your system, these commands will not be removed during PC DOS installation.

- **Infrequently used files or commands** that are not being provided as part of PC DOS 7.
  
<table>
<thead>
<tr>
<th>File/Command</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>4201.CPI</td>
<td>FASTOPEN.EXE</td>
</tr>
<tr>
<td>4208.CPI</td>
<td>GRAPHICS.COM</td>
</tr>
<tr>
<td>COMP.COM</td>
<td>GRAPHICS.PRO</td>
</tr>
<tr>
<td>EDLIN.EXE</td>
<td>PPDS.CPI</td>
</tr>
<tr>
<td>EPS.CPI</td>
<td>PRINTER.SYS</td>
</tr>
<tr>
<td>EX2BIN.EXE</td>
<td></td>
</tr>
</tbody>
</table>

- If you have a previous version of DOS installed and are upgrading your system, these commands will not be removed during PC DOS installation.

- If you still want to use these commands and have no diskettes from previous versions of DOS, these commands will be available through electronic delivery, such as bulletin board services.

- If you have a licensed copy of PC DOS 6.3, you are authorized to copy these files that are not provided to any system with a licensed copy of PC DOS 7.

- If you use these commands with PC DOS 7, first you must use the `SETVER` command to change the version.
• Commands no longer provided by PC DOS.

EXPAND
MEUTOINI
RECOVER

If you have a previous version of DOS installed and are upgrading your system, these commands will not be removed during PC DOS installation.

New, Changed, or Removed Optional Tools
The new features of, and enhancements to, the optional tools provided with PC DOS include:

• REXX Language Support has been added as the PC DOS programming language tool of choice. REXX for DOS includes utilities and REXX commands that have been designed to work specifically with PC DOS.

• Stacker Compression is now the optional tool that provides data compression for your system. If you are upgrading from PC DOS 6.1 or 6.3, SuperStor/DS will not be removed from your system during installation.

Stacker Compression allows you to:
– Convert any existing SuperStor/DS, DoubleSpace, or DriveSpace compression during Stacker Setup.
– Convert most stand-alone versions of Stacker Compression you might already have installed.
– Make menu selections using either the Stacker DOS Toolbox or the Stacker Windows Toolbox.
– Use data on compressed diskettes even on a computer that does not have Stacker installed.
– Guard your data because, every time you start up your system, Stacker runs AutoProtect to make sure your data is in good condition.

• PCMCIA Support now provides easier Setup procedures through new DOS and Windows full-screen interfaces included with PC DOS 7. The PCM.INI file is updated for you as you use the PCMCIA installation program to make selections for the type of PCMCIA support you want.

• Antivirus protection provided with PC DOS (AntiVirus or IBM AntiVirus for Windows), has been updated to recognize and fix more viruses.
If you are using IBM AntiVirus Services, a full-service, antivirus protection offering provided separately by IBM or if you have previously purchased the IBM AntiVirus/DOS product separately, you do not need to install the IBM AntiVirus/DOS optional tool provided with PC DOS. For more information about IBM AntiVirus Services, refer to the coupon provided in the PC DOS 7 coupon booklet.

- IBM DOS Shell is now named the PC DOS Shell.

**New, Changed, or Removed .INI Files**
The following .INI files have been added, changed, or are no longer required for PC DOS 7:

<table>
<thead>
<tr>
<th>New</th>
<th>Changed</th>
<th>Removed</th>
</tr>
</thead>
<tbody>
<tr>
<td>E.INI</td>
<td>RAMBOOST.INI</td>
<td>ADDSTOR.INI</td>
</tr>
<tr>
<td>PCM.INI</td>
<td></td>
<td>DBLSPACE.INI</td>
</tr>
<tr>
<td>RAMSETUP.INI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STACKER.INI</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**New, Changed, or Removed Keyboard Layouts and Code Pages**
The following keyboards and code pages have been added or changed for PC DOS 7:

- 452 keyboard
- 453 keyboard (provides the DIN 2137 German keyboard layout)
- 865 code page
- 912 code page
- 915 code page

The United Kingdom keyboard 168 has been removed.

Type `help keyb` to see a table that summarizes all the keyboard-layout and country code-page information.
Part 1. Using the DOS Operating System

Chapter 1. Installing .................................................. 3
Chapter 2. Learning Basic DOS Concepts ....................... 19
Chapter 3. Using the Online Book Viewer ...................... 41
Chapter 4. Configuring Your System ............................. 53
Chapter 5. Managing Disks .......................................... 73
Chapter 6. Partitioning Your Hard Disk ......................... 81
Chapter 7. Working with Batch Programs ...................... 97
Chapter 8. Redirecting Input and Output ...................... 109
Chapter 9. Using DOSKey and Editing Keys .................. 115
Chapter 10. Working with the Text Editor ..................... 131
Chapter 11. Connecting Computers ............................. 175
Chapter 12. Using File Update ..................................... 189
Chapter 13. Making More Memory Available .................. 205
Chapter 14. Speeding Up Your System ......................... 231
Chapter 15. Using Central Point Undelete ..................... 241
Chapter 16. Using Central Point Scheduler .................... 275
Chapter 17. Troubleshooting ....................................... 281
Chapter 1. Installing

This chapter provides what you need to know to perform a standard installation of PC DOS 7 (PC DOS) on your computer system. A standard installation means you are:

- Installing PC DOS on your existing hard disk over another version of DOS (such as MS-DOS** or earlier versions of PC DOS).
- Installing PC DOS on a newly formatted and partitioned hard disk (also see page 83 for partitioning information).
- Installing PC DOS on a new computer system that does not have any type of operating system installed.

Special installation procedures might be required because of the software or hardware you are using with your computer system. These procedures can be found in the appendix of this guide. Or, you can review the installation guidelines (Table 2 on page 13). This table helps you choose the installation information that pertains to your system. Read the specific information that applies to your system before beginning the install process to ensure a successful installation.

What's New about Setup for PC DOS 7

The PC DOS Setup program (Setup) includes unique features not found in previous versions of DOS. Review this abbreviated description of enhancements before beginning the installation. Complete information regarding these enhancements is described elsewhere in this chapter or in the installation information in the appendix.

- Diskettes used for PC DOS installation (other than the Setup diskette) have been specially formatted using a format process known as eXtended Density Format** (XDF**). XDF extends the capacity of the diskettes. *This special format does not affect running Setup.* The Setup program is specifically designed to use XDF-formatted diskettes.

- The Setup Diskette runs the Setup program file (SETUP) and also serves as an emergency startup diskette to start your computer system. This diskette is not XDF-formatted; its format is a standard DOS format.

- There is a new command, the XDFCOPY command. The purpose of this new command is to allow you to make backup copies of all your PC DOS

** MS-DOS is a trademark of the Microsoft Corporation.
** XDF and eXtended Density Format are trademarks of Ametron, Inc.

© Copyright IBM Corp. 1981, 1995 3
XDF-formatted installation diskettes. If you need to copy your Setup Diskette or any standard-formatted diskette, continue to use the DISKCOPY command as you always have.

• PC DOS Setup files are now packed together in what is known as a bundle file. If you need a copy of a file from the PC DOS installation diskettes, the recommended method is to rerun Setup because Setup unpacks and copies files in one step. The EXPAND command is no longer needed or supported.

• Because XDF-formatted diskettes are different than standard DOS-formatted diskettes, some DOS commands are affected by this format:
  – Certain DOS commands only work with XDF-formatted diskettes (XDF and XDFCOPY).
  – Some DOS commands can be used on the XDF-formatted diskettes but only under specific circumstances (DIR and FORMAT).
  – Certain DOS commands cannot be used with XDF-formatted diskettes (DISKCOPY and DISKCOMP).

Refer to “Working with XDF-Formatted Diskettes” on page 550 or the online PC DOS 7 Command Reference for specifics about using these commands with XDF-formatted diskettes.

• If you already have a mouse device attached and loaded, PC DOS Setup will provide mouse support during installation for making selections.

• Comment lines are added to your system files (AUTOEXEC.BAT and CONFIG.SYS) to identify the changes PC DOS Setup made. Setup identifies the lines in the files that were added, deleted, replaced, and updated. If deleting, replacing, or updating a line, it includes the original statement on the comment line for reference.

• New switches have been added to the SETUP command:
  – The /c switch allows you, after installation has completed, to remove the comment lines from your system files that Setup added.
  – The /q switch provides the easiest method for making keyboard layout and country code changes.

• Setup renumbers the backup versions for each of the two system files (AUTOEXEC.BAT and CONFIG.SYS) whenever you run or rerun SETUP. Both files are renumbered to the identical file extension number, but the highest number might not be the latest backup version.
Before You Begin

Before installing, take a few minutes to review the questions that follow before you actually begin the installation.

• Do you have enough conventional memory to install DOS?
• Do you have enough free space to install DOS?
• Do you have the correct required hardware?
• Which installation procedure should you use?
• Should you be using a SETUP command parameter to install?

To find out the answers to these questions, you should read the information in the following sections before proceeding to "PC DOS Standard Installation" on page 14.

Hardware and Software Prerequisites
PC DOS operates on all IBM or IBM-compatible computers with at least 512K of conventional memory. As a minimum, you must have a computer that has a 1.44MB-capacity, 3.5-inch diskette drive or a 1.2MB-capacity, 5.25-inch diskette drive specified as drive A. Your hard drive should have a minimum of 6.0MB of free space to install only the DOS files and Central Point Backup* for DOS. 18.5MB of free space is needed if you want to install PC DOS plus all the optional tools.

If upgrading from a previous version of DOS, keep the following things in mind:
• You can upgrade only DOS Version 3.3 or higher.
• You can upgrade only a FAT-formatted hard disk.
• You might want to back up and save your previous version of DOS (see "Uninstalling and Restoring Your Previous Version of DOS" on page 547).

Mouse Support during Setup
PC DOS allows you the option of using a mouse during installation if you have a mouse program loaded.

Click mouse button 1 (normally the left mouse button) once to make an option selection, choose a function key, or toggle choices from NO to YES in the optional tools list.

Note: The only time mouse support would not be available during Setup is if you need to boot the system using the Setup Diskette (also known as the emergency startup diskette) from the PC DOS installation diskettes.

** Central Point and Central Point Backup are trademarks of Central Point Software, Inc.
If all the selections you can make are not visible at one time in a window, you will see the word “More” and an arrow in brackets (for example, [More ↑]) at the top or bottom of the window to indicate there is additional information that cannot be seen in the window. Click on the arrow to see more choices.

Changes Made by Setup to the AUTOEXEC.BAT and CONFIG.SYS Files

Setup modifies your AUTOEXEC.BAT file and your CONFIG.SYS file. Optionally, you can make additional changes to the system files yourself during installation. What modifications Setup makes to your system files depend on whether or not you already have a version of DOS or PC DOS installed on your system.

If you have a previous version (rerunning Setup or upgrading) of DOS:
The following are the changes that PC DOS Setup makes to these files.

- Backing up your current system files as AUTOEXEC.nnn or as CONFIG.nnn, where nnn is the next highest incremental number between 000 and 999. Even if only one of the system files is changed, both the AUTOEXEC.BAT and the CONFIG.SYS files are given the same incremental number so they can be easily identified as corresponding pairs.

  For example, if you have both a CONFIG.003 file and a CONFIG.005, file (and because CONFIG.005 is currently the highest incremental number), the next file extension number would be CONFIG.006 instead of CONFIG.004.

- Verifying that all the required lines are included in the system files and, if not, adding them.

  For example, if you selected an optional tool requiring a command-line statement, the appropriate statement will be added.

- Updating DOS programs with new programs that perform the same function (see “What’s New for PC DOS 7” on page xxi).

- Removing obsolete DOS programs, if necessary.

- Preserving existing DEVICE and INSTALL command-line statements in the CONFIG.SYS file, even if you have multiple configurations for system startup.

- Detecting if Microsoft** Windows** is installed, and making appropriate changes to the Windows .INI files, such as SYSTEM.INI, PROGMAN.INI, and WIN.INI files. Also, saving a backup version of these files with a file name extension of .BAK.

** Windows and Microsoft are trademarks of the Microsoft Corporation.

6 PC DOS User’s Guide
• Adding one of the following four types of comment lines for each command-line statement changed. The type of comment line added depends on how Setup modified the comment-line statement:

```
REM ===== PC DOS 7.0 - Add =====
REM ===== PC DOS 7.0 - Delete ===== original_statement
REM ===== PC DOS 7.0 - Replace ===== original_statement
REM ===== PC DOS 7.0 - Update ===== original_statement
```

When Setup updates, deletes, or replaces a command-line statement, the original statement is placed on the comment line for reference. Edit these files if you want to return the command-line statement to how it was originally.

To view or edit changes made to your system files, answer YES when queried during Setup. Refer to “Viewing and Editing the System Files during Install” on page 548.

After completing Setup, you can remove all the comments added by Setup at the same time. Any command-line statements where you added the REM statement will not be removed.

To remove the PC DOS 7.0 REM comments (after the installation has completed), insert the Setup Diskette into drive A and type the following at the DOS command prompt:

```
a:setup /c
```

**If you do not have a previous version of DOS:**
Setup will create system files if they do not already exist.

A minimum CONFIG.SYS configuration is created that includes:

• Adding a HIMEM.SYS statement
• Adding a FILES statement with at least 30 files.
• Adding a BUFFERS statement with at least 10 buffers.
• Adding a SETVER statement.

A minimum AUTOEXEC.BAT file configuration is created that includes:

• Creating a path statement for the DOS directory.
• Adding the DOSKey program, which allows you to view, edit and carry out DOS commands you used previously.
SETUP Command and Its Options

The SETUP command is used when you are installing the latest version of PC DOS. Insert the Setup Diskette into your drive. Then, to see the syntax and a brief explanation of this command online, type a:setup /? (if drive A is your diskette drive) at the DOS command prompt.

After installing PC DOS, if you still need further details about the SETUP command, type help setup at the DOS command prompt.

Command Syntax

The following syntax shows the options that can be used with the SETUP command:

```
drive: setup[/a][/b][/c][/e][/p][/q][/t:filepath][/u][/w]  
or  
drive: setup [/?]  
```

**Note:** Setup does not copy the SETUP program file to your hard drive. To use this command or any of the SETUP command parameters, you must first insert the Setup Diskette from the PC DOS installation diskettes into the diskette drive you install from.

Command Parameters

The following list provides a brief explanation of how each switch can be used with the SETUP command.

```
drive: Specifies the drive where you insert the Setup Diskette that contains the SETUP program. If you change to the diskette drive, this parameter is not needed.

/a Allows you to specify which type of LAN Server Administrator directory you want to create—an administrator directory or a directory of DOS files and tools. See “Performing the LAN Server Administrator Installation of PC DOS” on page 540 for detailed information.

/b Specifies to use black and white instead of color screen display.

/c Removes comment lines from your AUTOEXEC.BAT and CONFIG.SYS system files placed there by Setup. This switch is used after installation has been completed.
```
/e Installs only the files needed for the PC DOS optional tools you select. DOS files are not recopied when you use this switch. Modifications are made to your AUTOEXEC.BAT and CONFIG.SYS files, based on the tools you select.

/p Installs PC DOS on a disk that might be incompatible with DOS.

/q Allows you to change your keyboard and country selections without a complete re-installation of PC DOS. Your AUTOEXEC.BAT and CONFIG.SYS files are modified using this switch.

/t:filepath Specifies the target path to copy DOS files to.

/U for Setup
Use to uninstall the current version of DOS. You must have backed up your previous version to uninstall.

/w Allows Windows tools to be installed even though a valid Windows directory was not found.

/? Displays the abbreviated online help. Insert the Setup Diskette into your diskette drive and type a:setup /? (if, for example, your diskette is inserted into drive A).

You can use more than one switch at one time. For example, you could type a:setup /a /b to use a black and white display for a LAN administrator installation. However, if you use the /t switch combined with SETUP /A (for example, if you typed setup /a /t:c:\pcdos7), Setup will default to creating an administrator directory.

Other Installation Options

The PC DOS Setup program provides your system with the information it needs to operate effectively. During the installation, PC DOS will prompt you to verify and change information and then acts on your choices; you might be prompted to make certain decisions, such as:

- Do you want to change the current time and date?
- Do you want to partition and format your hard disk?
- What keyboard and country code page do you want to use?
- Do you want ISO fonts?
- Which optional tools do you want installed?
- Where do you want to install DOS to?
- Do you want to back up your previous version of DOS?
• Where are your current DOS files located now (applies only when you are upgrading your system)?
• Do you need to edit or view the changes made to your system files by Setup or make your own additional changes to the system files (CONFIG.SYS and AUTOEXEC.BAT)?

If you do not know the answers, just accept the choices that PC DOS installation makes for you (called defaults)—except for optional tools.

Most of the optional tools are defaulted to NO, which means the tools will not be installed; be sure to select the optional tools you want so the program files get copied. To see all the tools, scroll to the top of the optional tools window.

Note: The selection of the PC DOS Central Point Backup for DOS optional tool has already been defaulted to YES.

You can always rerun Setup later to add any optional tools you did not want to install initially using the /e switch (for example, typing a:setup /e if installing from drive A).

Optional Tools Selection

PC DOS includes the optional tools listed in Table 1 on page 11. During installation, you are prompted to choose which ones you want on your system. After you select the tools you want, Setup copies the required program files for the selected tools to your DOS directory.

Certain optional tools must run their own installation program before they can be used (for example, Stacker** Compression and PCMCIA** Support) because they require certain user-specified information, which is obtained during program installation. Before running the optional tool installation program, you should review the installation information about each tool.

If you are upgrading your current version of DOS to PC DOS 7 and currently have Windows installed on your computer, you will see additional optional tools just for Windows.

If you do not currently have Windows installed, the Windows tools will not be included in the list of optional tools. If you want to add the optional tools for

** Stacker is a trademark of Stac Electronics.
** PCMCIA is a trademark of the Personal Computer Memory Card International Association.
Windows at a later time, install Windows first and then rerun Setup using the /e switch (see “Installing Additional DOS and Windows Optional Tools” on page 545).

**Note:** Installing Windows first ensures that the Windows .INI files are updated properly.

<table>
<thead>
<tr>
<th>Optional Tool:</th>
<th>What It Does:</th>
<th>Refer to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>PenDOS**</td>
<td>PenDOS allows the use of pen-based applications and allows you to use the mouse as the pen for applications (for software and hardware prerequisites, see “Installing PenDOS” on page 539).</td>
<td>Page 481</td>
</tr>
<tr>
<td>PC DOS Shell</td>
<td>Uses color and graphics to provide a visual way of working with DOS. Information is set up in different areas on your screen, making it easy to find.</td>
<td>Page 319</td>
</tr>
<tr>
<td>Phoenix** PCMCIA Support</td>
<td>Phoenix Personal Computer Memory Card International Association (PCMCIA) support provides support for PCMCIA devices if your computer is equipped with PCMCIA sockets. A credit card-sized device is inserted into these sockets extending the capability of the computer.</td>
<td>Page 501</td>
</tr>
<tr>
<td>Central Point Undelete for Windows</td>
<td>Central Point's Undelete for Windows is a support utility for Windows if it is installed on your computer.</td>
<td>Page 241</td>
</tr>
<tr>
<td>IBM AntiVirus/DOS for Windows</td>
<td>IBM AntiVirus/DOS for Windows provides support for Windows when using this tool to protect your computer from viruses.</td>
<td>See page 367</td>
</tr>
<tr>
<td>IBM AntiVirus/DOS</td>
<td>IBM AntiVirus/DOS checks for computer viruses on either your hard drives or diskettes to prevent loss of data.</td>
<td>Page 363</td>
</tr>
<tr>
<td>REXX Language Support</td>
<td>REXX is a simple yet powerful programming language that can be used by both beginners and experienced users to write programs.</td>
<td>The online PC DOS 7 Command Reference</td>
</tr>
</tbody>
</table>

** PenDOS is a trademark of the Communication Intelligence Corporation.

** Phoenix is a trademark of Phoenix Technologies, Ltd.
Table 1 (Page 2 of 2). Optional Tools for DOS and Windows

<table>
<thead>
<tr>
<th>Optional Tool:</th>
<th>What It Does:</th>
<th>Refer to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stacker Compression</td>
<td>Provides data compression utilities for effectively and safely increasing the amount of data you can store on your hard drives and diskettes.</td>
<td>Page 427</td>
</tr>
<tr>
<td>Central Point Backup for Windows</td>
<td>Central Point Backup for Windows provides support for Windows when using this full-screen program to backup the information on your computer.</td>
<td>See page 385</td>
</tr>
<tr>
<td>Central Point Backup for DOS</td>
<td>Full-screen program for backing up the information on your computer. Installed as a default. If you do not want to install or use Central Point Backup, be sure to select NO on the optional tools screen.</td>
<td>Page 383</td>
</tr>
</tbody>
</table>

**Installation Guidelines**

Before beginning the install:

- Check the installation guidelines that apply to your system. See the Installation Guidelines table, Table 2 on page 13.

- Make sure that your system has 512K of available memory. This is the minimum amount of memory needed for PC DOS.

  For additional information about the hard disk-space requirements, see "Hardware and Software Prerequisites" on page 5.

- Read the introductory information earlier in this chapter, if you have not already done so.

- Be aware that this install is designed to replace all the existing DOS files currently in the directory you install to. A file will be replaced if it has the same file name as that being installed and if it already exists in the directory you install to.
The following table helps you choose the correct procedure for the type of installation you want to do.

<table>
<thead>
<tr>
<th>Installation Guidelines</th>
<th>See page...</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are installing PC DOS for the first time and you have no other systems on your computer</td>
<td>14</td>
</tr>
<tr>
<td>If you are installing PC DOS on a new hard disk, a newly formatted hard disk, or a partitioned hard disk</td>
<td>14 and 83</td>
</tr>
<tr>
<td>If you are upgrading PC DOS on your hard disk</td>
<td>14</td>
</tr>
<tr>
<td>If you are installing PC DOS and you have Windows on your computer</td>
<td>14</td>
</tr>
<tr>
<td>If you are installing PC DOS files on a drive other than drive C</td>
<td>533</td>
</tr>
<tr>
<td>If you are installing PC DOS and you have OS/2* installed</td>
<td>534</td>
</tr>
<tr>
<td>If you want to use OS/2 Dual Boot (after installation)</td>
<td>535</td>
</tr>
<tr>
<td>If you are installing PC DOS on a PS/1*</td>
<td>536</td>
</tr>
<tr>
<td>If you are installing PC DOS on a compressed drive</td>
<td>537</td>
</tr>
<tr>
<td>If you want to review prerequisites for PenDOS before installing</td>
<td>539</td>
</tr>
<tr>
<td>If you are a LAN Administrator responsible for installing PC DOS</td>
<td>202</td>
</tr>
<tr>
<td>If you are a LAN user and need to upgrade to PC DOS</td>
<td>543</td>
</tr>
<tr>
<td>If you want to install PC DOS from a CD-ROM</td>
<td>544</td>
</tr>
<tr>
<td>If you want to rerun Setup to add optional tools</td>
<td>545</td>
</tr>
<tr>
<td>If you need to uninstall PC DOS</td>
<td>547</td>
</tr>
<tr>
<td>If you want to view or edit the changes Setup made to your system files</td>
<td>548</td>
</tr>
<tr>
<td>If you need to view the PC DOS README.TXT file</td>
<td>550</td>
</tr>
<tr>
<td>If you need to work with XDF-formatted installation diskettes</td>
<td>550</td>
</tr>
<tr>
<td>If you are not installing on a hard disk but want to use some of the DOS commands</td>
<td>555</td>
</tr>
<tr>
<td>If you have an installation problem</td>
<td>281</td>
</tr>
</tbody>
</table>

* *PS/1 and OS/2 are trademarks of the IBM Corporation.*
PC DOS Standard Installation

Setup installs PC DOS on drive C on the hard disk in your computer and makes choices (installation defaults) for you. Most people wanting to install PC DOS will want to use this standard installation procedure.

To install PC DOS:

1. If you do not currently have DOS installed on your system (booting from diskettes):
   a. Insert the Setup Diskette into drive A.
   b. Turn the power on (cold boot) for your computer or, if it is already powered on, press CTRL+ALT+DEL (warm boot) to restart your computer.
   c. Type Y to answer YES when queried whether you want to install PC DOS 7.

If you currently have DOS installed on your system:
   a. Turn on your computer and start your current system.
   b. Insert the Setup Diskette into drive A or B.

   Note: See the PC DOS README.TXT file for special instructions if you have DR DOS currently installed on your system. The README.TXT file can be found on the Setup Diskette.

   c. Type either a:setup or b:setup, respectively, at the DOS command prompt.

2. After the PC DOS Welcome screen is displayed, press ENTER or click on Continue to continue following instructions on the screens.

   A selection window is displayed that allows you to change the current time and date, character set for the country, keyboard layout for the country, or the ISO font (if you have a VGA or above display).

3. If you want to change these options:
   a. Either use the UP ARROW and DOWN ARROW to scroll through the list, and press ENTER for the list item you want to change while it is highlighted, or use the mouse to make your change. (Each list item is highlighted as you come to it.)
      
      After making your selection, you are returned to the selection window.
   b. Continue to scroll the screen making the changes you want.
   c. After changing options, either use the DOWN ARROW to scroll to:
      Options correct. Continue Setup.

      and press ENTER, or click on this line if using a mouse.
A selection window is displayed that lets you specify the optional tools you want to install. (You will only see Windows optional tools, listed if Windows is installed on your system before running Setup.)

Always select the same path when rerunning Setup.

Use the UP ARROW or click here to see additional tools.

In order to have the files necessary for each optional tool copied to your hard disk, you must change the selection choice from NO to YES for the selected tool.

**Note:** Central Point Backup for DOS is defaulted to YES for you.

4. **If you want to select any optional tools:**

   a. Use the UP ARROW and DOWN ARROW to scroll through the list of optional tools. Each list item is highlighted as you come to it.

      Note that other tools, such as PenDOS, might not be visible. If you see the word “More” appearing at the top of the optional tools selection window, either use the mouse and click on the rectangular bar or use the UP ARROW to scroll to the top of the list.
b. Either press ENTER, or click on the item using the mouse to select an optional tool for your system. Note that pressing ENTER or, clicking on the optional tool, toggles (changes back and forth) your choices from NO to YES or YES to NO. The amount of available disk space is updated and displayed on the screen as you select optional tools.

c. Continue to scroll the screen making the choices you want. When you have finished, scroll to the Options correct. Continue Setup. line and press ENTER, or click on this line using your mouse.

A selection window is displayed that lets you change the path for your previous DOS and Windows (if Windows is detected during installation) directories, if necessary. Changing the path is only necessary if you are upgrading from a previous version of DOS or Windows. Also, you can specify whether or not to back up your previous version of DOS files.

5. Select one of the following:

- **If you do not want to back up your previous version of DOS:**
  Make sure the option specifies NO, which is the default.

- **If you want to back up your previous version of DOS:**
  Highlight the Back up previous DOS files line and press ENTER, or click on the line if using a mouse, to change the option to specify YES. You will need to have enough blank diskettes available to save your previous DOS files.

6. When you have finished, either use the DOWN ARROW to scroll to the Options correct. Continue Setup. line and press ENTER, or click on this line using your mouse.

Follow the instructions on your screen until you have backed up all the files. The actual number of diskettes depends on what version you are backing up and the diskette density you elect to use.

7. Continue to follow the instructions on your screen and insert the remaining installation diskettes in the order prompted. If you did not select all the optional tools, you might not need to insert every diskette during installation.

Notice that, as Setup unpacks and copies files to the DOS directory, the file's name is displayed at the bottom of your installation screen.
Immediately before the PC DOS installation is finished, you are prompted whether you want to view or edit the changes made by Setup and saved in your AUTOEXEC.BAT and CONFIG.SYS files. Optionally, you can edit these files yourself and modify the changes that Setup made.

8. When prompted whether to edit the changes in the system files, do one of the following:

   • **If you do not want to view or edit the changes:**
     Make sure the Option correct. Continue Setup. line is highlighted and press ENTER. Or, click on this line if using a mouse.

   • **If you want to view or edit the changes:**
     a. Use the UP ARROW to scroll to:
        
        Edit AUTOEXEC.BAT and CONFIG.SYS changes?
        
        and press ENTER, or click on this line if using a mouse, to change the option to specify YES.

        b. Use the DOWN ARROW to scroll to the line:
        
        Option correct. Continue Setup.
        
        and press ENTER, or click on this line if using a mouse. You can refer to “Viewing and Editing the System Files during Install” on page 548 for more complete instructions.

9. Follow the instructions on the screen until you are informed that the installation has been completed and that your system will be rebooted.

   System file changes only take effect following a system reboot. Be sure to remove any diskettes from the diskette drive before pressing any key to reboot.

**Notes for Installing:**

   • **If you are making backup diskettes of your installation diskettes:**
     Use the DISKCOPY command for the Setup Diskette and the XDFCOPY command for all other diskettes.

   • **If you choose not to install every optional tool:**
     You may not be required to insert every diskette.

   • **If you have an error message occur during the installation process:**
     See “PC DOS Installation” on page 281. This section contains actions you can take to resolve problems you might have while running Setup.
• **If you want to add any optional tools not installed initially at a later time:**
  You can use the /e switch (see “Installing Additional DOS and Windows Optional Tools” on page 545).

• **If you have questions about any of the procedures or options:**
  Help is available by pressing the F1 key.

• **If you install PC DOS over an existing version of DOS:**
  Setup updates your existing CONFIG.SYS and AUTOEXEC.BAT files and saves the original files as CONFIG.nnn and AUTOEXEC.nnn.
Chapter 2. Learning Basic DOS Concepts

The information that your computer uses is stored in files. To help you keep track of your files, you can group your files into directories and subdirectories. To access the data stored in your files, you must identify the drive and directory where DOS is to search.

This chapter discusses a few of the basic concepts and terminology you need to know to use DOS:

- Files, file names, and extensions
- Drives and current drives
- Directories, current directories, subdirectories, and directory trees
- Paths, full and relative
- Wildcards
- DOS command prompt

Understanding Files

The information your computer uses is stored in files. The instructions used to run an application are stored in program files, and the information you create by using an application is stored in data files.

As you work with an application, DOS processes the information stored in program files and passes it along to your system when it is needed. When you are finished using the application, you can save your data files on a hard disk (also referred to as fixed disk) or on a diskette.

Every file has a name. Most files also have an extension. The file's name always appears first, and the extension is separated from the name by a period as in the following example:

readme.txt

In this guide, a file's name and extension are jointly referred to as the file name.
File Names

The name you assign to a file must meet the following criteria:

• It can contain no more than eight characters.
• It can consist of the letters A through Z, the numbers 0 through 9, and the following special characters:

  underscore  caret
  dollar sign  tilde
  exclamation point  number sign
  percent sign  ampersand
  hyphen  braces
  at sign  single quote
  apostrophe  parentheses

Note: No other special characters are acceptable.

• The name cannot contain spaces, commas, backslashes, or periods (except the period that separates the name from the extension).
• The name cannot be one of the following reserved file names: CLOCK$, CON, AUX, COM1, COM2, COM3, COM4, LPT1, LPT2, LPT3, LPT4, NUL, and PRN.
• It cannot be the same name as another file within the directory.

File names are not case sensitive, so you can type the file name in either uppercase, lowercase, or mixed case characters.

Extensions

Extensions can help you identify the type of information in a file. For example, if you have a file called MINUTES.TXT, the extension .TXT usually identifies that it is a text file. The extension must contain no more than three characters. File-name restrictions regarding characters and spacing also apply to extensions.

The following are some of the extensions used by DOS:

• .EXE (executable) or .COM (command) for files that contain programs.
• .BAT (batch or REXX) for files containing lists of commands that DOS carries out consecutively.
• .INI (initialization) for files containing startup commands for an application.
Current Drive

If you type a command at the DOS command prompt, commands will be carried out on the drive you are currently working in unless you specify a different drive.

The drive you are currently working in is called the current drive. The letter of the current drive is usually shown as part of the DOS command prompt (such as C:\> if the current drive is C).

For example, suppose the current drive is drive A. To view a list of files on a diskette in drive A, you would type the following:

   dir

You do not need to type the drive letter to see the current drive.

To change the current drive, type the letter of the drive you want to change to, followed by a colon. For example, suppose the current drive is C. To change the current drive to drive A, type the following:

   a:

Directories

To help you keep track of your files, you can group your files into directories. Just as file folders in a file cabinet contain groups of related documents, directories can contain groups of related files. Each directory can be assigned a unique name so that you can identify it. For more information, see “Making Directories” on page 35.

Sometimes you might want to further divide a directory to be more specific, or else your directory might contain so many files that it is too confusing to find the one you want. When this happens, you can use DOS to create additional directories. The directory contained within another directory is called a subdirectory. This is similar to placing a file folder within a larger file folder. A directory that contains another directory is called the parent directory.

For more information about directory trees and how to view items in your directory, see “Viewing Directory Contents” on page 34.

Paths

When you give the full path name for a file, you are stating a series of directory names that DOS follows before any actions are performed on that file. Each directory name is separated by a backslash (\).
Every file has its own separate path. If you have two files with the same file name but in different directories, DOS considers these to be two completely different files because it considers the path and the file name to be the full file specification.

For example, C:\NOTES\AGENDA.DOC and C:\MEETING\AGENDA.DOC can have files with the same file name, but the file contents can be different because their file specification is different.

The following illustration shows the components that make up a path statement. The path statement is limited to 127 characters.

```
C: \OFFICE\MEETING\AGENDA.DOC
```

You can specify a PATH command-line statement in your AUTOEXEC.BAT file. The PATH command indicates which directories DOS is to search for executable files whenever you start your computer. When you designate more than one directories, you must separate them with a semi-colon (;) such as in the following example:

```
path c:\dos\system;c:\utils;
```

**Wildcards**

If you want to perform a task for a group of files whose names have something in common, you do not have to use the same command repeatedly for each file name in the group. A substitute for a name or extension is known as a *wildcard*. You can use wildcards to specify groups of files.

There are two DOS wildcards:

- The asterisk (*) represents a whole word or a group of characters.
- The question mark (?) represents a single character.
The following table shows various wildcard combinations.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>What it represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.TXT</td>
<td>All files with a .TXT extension</td>
<td>JULY93.TXT, RECIPE.TXT</td>
</tr>
<tr>
<td>REPORT.*</td>
<td>All files named REPORT with any extension</td>
<td>REPORT.TXT, REPORT.WRI</td>
</tr>
<tr>
<td>M*.</td>
<td>All files beginning with the letter M, regardless of extension</td>
<td>MEMO.TXT, MARCH.XLS</td>
</tr>
<tr>
<td>???.*</td>
<td>All files having names containing three letters or less, with any or no extension</td>
<td>SUN.BMP, WIN.INI, AUG</td>
</tr>
</tbody>
</table>

**Note:** When you use an asterisk in the file name or the extension, DOS ignores the letters that come after the asterisk. For example, if you use the wildcard

```
*M.EXE
```

it is the same as if you typed

```
*.EXE
```

**DOS Command Prompt**

When you see this prompt (C:\>), this means DOS is ready to receive a command. The C:\> prompt is set by typing:

```
prompt $p$g
```

where $p$ stands for the path, and $g$ provides the greater than (>) sign. If you want to change this prompt, you can view the options available by typing `help prompt` or `prompt /?`

The PROMPT command allows you to keep track of where you are in your tree structure visually. For example, the prompt `C:\OFFICE\LETTERS>` shows you the root, OFFICE, and LETTERS directories in the tree structure.

Add the PROMPT command to your AUTOEXEC.BAT file so that the prompt you specify is available every time you start your computer.

**Working with Files**

Certain DOS commands allow you to do tasks such as: finding, copying, renaming, deleting, moving, comparing, modifying, creating, and viewing the contents of files and directories.
Finding Files
To find a file, use the DIR /S command. This command directs the system to list every occurrence, in the specified directory and all subdirectories, of a specified file name. For example, to find all occurrences of “MYFILE.DAT” on drive C, type the following at the DOS command prompt:

dir c:\myfile.dat /s

Copying Files
You can use the COPY command to copy:

- A file from one directory or diskette to another
- A group of files by using DOS wildcards

Note: If you want to copy files from the PC DOS 7 installation diskettes, refer to “Working with Setup Bundle Files” on page 554 first.

If your copy request involves a file that has the same name as a file or files in the directory to which you are copying, DOS displays a message indicating that you are about to overwrite an existing file. You are prompted to provide direction to the system as the following example indicates:

c:\dos>copy *.dat 
Overwrite c:\scores.dat (yes/no/all)?

Your choice affects the COPY command as follows:

Yes (Y)  Overwrite the file and continue copying, or return to the DOS command prompt if only one file is involved.

No (N)    Do not overwrite the file. Continue copying and receiving the system prompt for overwriting if other duplicate file names are found. Or, return to the DOS command prompt if only one file is involved.

All (A)   Overwrite the indicated file and all subsequent files and suppress the system prompt for overwriting while copying.

For detailed information on copying a directory tree with files, type help xcopy at the DOS command prompt. For detailed information on duplicating a diskette, type help diskcopy at the DOS command prompt. In both cases the online PC DOS 7 Command Reference is opened to the discussion about the specified command.

If you only want to review the abbreviated online help about a command, type the command name followed by a /? switch (for example, diskcopy /? displays the abbreviated online help for the DISKCOPY command).
Copying a Single File
To copy a file to another diskette or directory, use the COPY command. To use the COPY command, type the location and file name of the file you want to copy from (source file). Then type the location and file name of the file you want to copy to (target file).

Suppose drive C is the current drive. If you want to copy the AGENDA.DOC file from the \MEETING directory on a hard disk in drive C to the root directory on a diskette in drive A, you would type the following command:

```
copy \meeting\agenda.doc a:\agenda.doc
```

DOS takes a copy of the AGENDA.DOC file in the \MEETING directory on drive C and places the copy in a file having the same file name in the root directory of drive A. If you want the source and target files to have the same file name, omit the target file name. For example, you could use the following command to produce the same result achieved by using the previous command:

```
copy \meeting\agenda.doc a:\
```

After you use the COPY command, DOS indicates how many files were copied:

```
1 file(s) copied
```

If DOS cannot find the file you want to copy, it displays the File not found message. Check to see that you typed the file name correctly and that the file is in the directory you specified.

Using Wildcards to Specify a Group of Files to Copy
Suppose you have a number of files on a diskette in drive A that you designated as temporary by giving them the same extension (such as .TMP). If you want to copy these files to a diskette in drive B, you can use the asterisk wildcard:

```
copy a:\*.tmp b:\
```

Renaming a File as It Is Copied
If you want to give a new name to a file you are copying, specify the new file name as the destination file. For example, to copy the OUTGO.XLS file from a diskette in drive A to a diskette in drive B and rename it EXPAND.XLS, type the following at the DOS command prompt:

```
copy a:\outgo.xls b:expand.xls
```
You can copy a file to the same directory if you rename the file. If you do not rename the file when copying it to the same directory, DOS displays the following message:

File cannot be copied onto itself
0 file(s) copied

Renaming a File
To change the name of a file without changing its location, use the REN command. The REN command stands for rename.

For example, suppose you have two versions of a file named SALES.LST. The version on the diskette in drive A contains last year’s sales projections, whereas the version in drive C is up-to-date. Assume drive C is the current drive. To avoid confusion between the two files, you can use the following command to rename the file that contains outdated prices:

For example, the following command changes a file named SALES.LST to SALES.OLD:

ren a:\sales.lst sales.old

You can use DOS wildcards to rename a group of files. For example, if you want all .TMP files to be renamed to .TXT files in a directory, use the following command:

ren *.tmp *.txt

Deleting Files
You will eventually want to clean up your hard disk by removing files that are no longer useful. You can delete a single file, a group of files, or all files in a directory on a hard disk or diskette. When you delete files, you might not be able to recover them. Ensure that the files you specify for deletion are the ones you want to remove.

If you accidentally delete files you want to keep, use the UNDELETE command as soon as possible to recover them. Refer to “Recovering Deleted Files” on page 28 for more information.
Deleting a Single File
You delete a single file by typing the DEL command, followed by the location and name of the file you want to delete. For example, to delete a file named SALES.LST from a directory on drive C, you would type the following command:

```plaintext
del c:sales.lst
```

Deleting a Group of Files
You can use DOS wildcards (an * is a wildcard) to delete a group of files. For example, the following command deletes all files with the .TMP extension on a diskette in drive A.

```plaintext
del a:\*.tmp
```

Before using the wildcard, it is a good idea to use the DIR command to view the files in a directory. If the display scrolls off the screen too quickly, use the DIR command with the /p switch. This switch pauses the display of information at the end of each full screen of text and gives you a Press any key to continue... message that allows you to continue on to the next screen display until completed. For example, you could type the following command to view all the files with .TMP extension on a diskette in drive A and pause the information between screens:

```plaintext
dir a:\*.tmp /p
```

Deleting All Files in a Directory
To clear a directory of all files, you can use the DEL command and DOS wildcards. For example, to delete all the files in the \OFFICE directory on drive C, type the following:

```plaintext
del c:\office\*.*
```

If you do not specify a directory, all files in the current directory are deleted.

Whenever you specify *.* with the DEL command, the following prompt is displayed.

```
All files in directory will be deleted!
Are you sure (Y/N)?
```

If you type the directory without specifying any files, it is assumed you want to delete all the files in that directory. For example, to delete all files in the \MYDOCS directory on drive C, you could type the following command:

```plaintext
del c:\mydocs
```

If you want to delete the directory itself, use the RD (remove directory) command. Or, you can use the DELTREE command to delete both the directory and all the files at one time. The RD command and the DELTREE command are discussed in more detail in “Deleting Directories” on page 36.
Recovering Deleted Files
When you delete a file, DOS does not delete the data in the file. Instead, it marks the file as deleted so DOS can reuse the area of the hard disk or diskette occupied by the deleted file. The data remains on the hard disk or diskette until DOS records the data of another file in the same region of the disk.

Because the data in a deleted file can remain intact for a while, it is possible to recover a file that was accidentally deleted. As soon as you discover that the file has been deleted, use the UNDELETE command to restore the file. If you have created or changed other files after issuing the DELETE command, the UNDELETE command might not be able to recover the deleted files. For more information about undeleting files and directories, see Chapter 15, “Using Central Point Undelete” on page 241.

The UNDELETE command works best if you set up your system to keep track of files you delete by using the DATAMON command in your AUTOEXEC.BAT file as described in “Choosing a Delete Protection Method” on page 271.

Moving Files
To move files, use the MOVE command. For example, the following command moves the file AGENDA.DOC from the current drive to a diskette in drive A.

`move agenda.doc a:`

If the destination you specify already has a file or files with the same name, you are prompted to give direction to the system. You can choose the following:

**Yes (Y)** Overwrite the file and continue moving, or return to the DOS command prompt if only one file is involved.

**No (N)** Do not overwrite the file. Continue moving and receiving the system prompt for overwriting if other duplicate file names are found. Or, return to the DOS command prompt if only one file is involved.

**All (A)** Overwrite the indicated file and all subsequent files and suppress the system prompt for overwriting while moving files.
You can also move groups of files using wildcards. For example, to move all the files on drive A with an extension of .TXT to drive C in the directory \TEXT, you would type:

```
move a:*.* c:\text
```

You can rename a directory when you move files. For example, to move all the files in the \NOTES directory to a new directory with the name \LETTERS, type:

```
move c:\notes\*.* c:\letters
```

You are prompted whether you want the directory created if it does not already exist:

```
Make directory "c:\letters"? (Y/N)
```

The MOVE command allows you to rename a file when you move only one file. To move the file LETTER1.TXT from the root directory of drive C, rename it to NEWLTR.TXT, and place it in the \LETTERS directory on drive D, type:

```
move c:\letter1.txt d:\letters\newltr.txt
```

If the directory does not already exist, you will receive the [Unable to create destination] message. Use the MD command to create the directory, and then retry the MOVE command.

### Comparing Files

To get an approximate comparison of two files, you can look at file size and time of creation. To get a precise comparison of two files, use the FC command. For example, you have two text files that have the same file name; they exist on two different diskettes. To see if they are the same and where they differ, you can use the FC command.

### To use the FC command to compare two files:

1. Insert one diskette in drive A and one in drive B.
2. Type the following at the DOS command prompt:

```
few /a a:(filename).txt b:(filename).txt
```
The `/a` switch in this example abbreviates the output for the comparison of the two text files. DOS starts at the beginning of the two files and compares each byte. When DOS finds a difference, it displays the file name, the line of text that begins a set of differences, and the line that ends the set of differences, as in the following example:

```
*****a:(filename).txt
Our expected revenues for the month of January are expected to rise
\...
when the results are not yet certain.
*****b:(filename).txt
Our expected revenues for January are less than projected
\...
when the results are not yet certain.
*****
```

For more information about the FC command, type `help fc` at the DOS command prompt.

**Viewing and Changing File Attributes**

Every file can have the following attributes associated with it. These attributes are used as switches with the `ATTRIB` command.

- **a**: Specifies the archive attribute which is used with the `RESTORE`, `XCOPY`, and other commands to control which files are backed up.
- **r**: Specifies the read-only attribute which prevents a file from being changed or deleted. When a file has this attribute, you can look at the file but you cannot delete it or change its contents.
- **h**: Specifies the hidden attribute which prevents DOS from displaying a file in a directory list. The file remains in a directory, but you cannot use the file unless you know its file name. This attribute is useful if you are working on confidential files.
- **s**: Specifies the system attribute which designates a file as a system file. Files with the system attribute are not shown in directory listings.

Type `help attrib` for more information about these attributes and how they are used with the `ATTRIB` command.

**Viewing File Attributes**

To see a file's attributes, type the `ATTRIB` command followed by the file name. For example, you would type the following to see the attributes associated with the `CONFIG.SYS` file on a disk in drive A:

```
attrib a:\config.sys
```
DOS displays up to four attributes in front of the file name. For example, if the CONFIG.SYS file has the archive and read-only attributes, DOS displays the following:

```
A R C:\CONFIG.SYS
```

You can see the attributes for a group of files by using wildcards with the ATTRIB command. For example, you would type the following to see the attributes of all files in the root directory of drive C:

```
attrib c:\*.*
```

### Changing a File Attribute

You can add to or take away file attributes by using the ATTRIB command along with the attribute letter. To assign an attribute, precede the attribute letter with a +. To remove an attribute, precede the attribute letter with a -. For example, use the following command to make the OUTGO.XLS read only:

```
attrib +r outgo.xls
```

If you decide at a later time to remove the read-only attribute from this file, you would type:

```
attrib -r outgo.xls
```

### Finding Text Within a File

If you want to search one or more files for specified text, you can use the FIND command. For example, if your personal phone book is in the PHONE.TXT file, you can use the following command to view all lines of the file that contain the text "Area Code: 206":

```
find "Area Code: 206" phone.txt
```

DOS searches the PHONE.TXT file and displays each line that includes the text "Area Code: 206". You must enclose the search text in quotation marks. DOS finds only text that exactly matches the characters you specify, including capitalization and spacing. If the text in the file has formatting codes (for example, if the words "Area Code" are underlined), DOS cannot find the specified text.

You can use wildcards to search all subdirectories for a set of files. Add the /s switch to specify this type of search. The following example searches all .TXT files and the ADDR.LST file in all subdirectories:

```
find "Area Code: 206" *.txt addr.lst /s
```
Understanding and Working with Directories

When you type a command at the DOS command prompt, it is carried out on the directory you are currently using unless you specify a different directory.

Directory Tree

The organization of directories and files is called the directory tree. When you format a hard disk, DOS creates one directory called the root directory. The root directory is the very top-most directory. All other directories you create on the hard disk branch out from the root directory. This is illustrated by the following:

![Diagram of the directory tree]

You can view a list of files and directories in a directory by using the DIR command (see “Viewing Directory Contents” on page 34).

Naming Directories

Except for the root directory, which is always represented by the first backslash (\) following the drive letter, each directory has a name. A directory can also have an extension.

The rules for directory names and extensions are the same as for naming files. Typically, however, directory names do not use extensions. For more information, see “File Names” on page 20.

Sometimes, you see “.” and “..” entries in a directory (especially when you use the DIR command to view the files and directories in a directory). These are normal entries that are present in every directory. The single period (.) represents the current directory and the double period represents the parent directory. If you delete these entries, you can lose files.
**Working in the Current Directory**

The directory you are currently working in is called the *current directory* for that drive. The name of the current directory is usually shown as part of the DOS command prompt. You might see `C:\NOTES>` if your current directory is `\NOTES` in drive C.

For example, if drive C is the current drive and `\OFFICE\NOTES` is the current directory, you can delete the REPORT1.TXT file in the `C:\OFFICE\NOTES` directory by typing this command:

```
   del report1.txt
```

Because drive C is the current drive and `\OFFICE\NOTES` is both the current directory and where the file is located, you do not need to specify the path in the command. DOS searches for the file in the current directory. When the file is not located in the current directory, you can do one of the following:

- Specify where the file is located by including its path in the command.
- Change to the directory containing the file by using the CD command. The CD command is described in “Changing Directories.”

If you are working with more than one drive, each of them has a current directory. If you do not specify a different path for the files, DOS will complete the operation in the current drive and directory.

When you start your system, all current directories are the root directories of the drives in your system. The current directory on a diskette drive changes to the root directory when you change diskettes.

**Changing Directories**

To change to a different directory on the current drive, use the CD command. The CD command stands for change directory.

To use the CD command, type:

```
   cd
```

followed by the directory to which you want to change.

If you want to change from the current directory to a subdirectory, a directory contained within the current directory, type the name of the subdirectory. For example, the following command changes the current directory to the MYDOCS directory within the current directory:

```
   cd mydocs
```
If you want to change to a directory that is not a subdirectory of the current directory, type the path for the new directory. For example, to change from the directory C:\MEETING\STATUS to the directory C:\ART, type the following:

    cd \art

You can use double periods as a shortcut to typing the name of the parent directory. To change to the parent of the current directory (the directory one level closer to the root), you can also use two periods (..) in the command.

    cd ..

Regardless of which directory is current, you can change to the root directory of the current drive by typing:

    cd \ 

### Viewing Directory Contents

To view the contents of a directory, use the DIR command. The DIR command stands for directory and lists the contents of the directory you specify.

For example, if C:\ is your current directory, type the following command to view its contents:

    dir

DOS displays a listing similar to the following:

```
:  
CONFIG    SYS    525  03-30-94  6:47p
AUTOEXEC   BAT    495  03-30-94  7:04p
DOS        <DIR>  01-14-93  9:38a
MYFMT      TXT    4735  02-16-93 10:43p
MOVEDIR    BAT    7046  03-08-93  8:58a
NETWORK    <DIR>  03-29-93  6:47p
:  
```

**Note:** The file names shown here are separated from the extensions, not by a period but by several spaces. When you refer to these files, however, you must separate the file names from the extensions with a period.

If there is more information than can fit on one screen, use the DIR command followed by the /p switch to view files and subdirectories one screen at a time. For example, to view the contents of the current directory one screen at a time, type:

    dir /p
You see one screen of the directory contents. At the bottom of the screen, you see this prompt:

    Press any key to continue . . .

If you add the path of a directory to the command, DOS displays the contents of the specified directory rather than the current directory. Regardless of which drive and directory are current, you would use the following command to view a list of files in the MEETING directory on drive C:

    dir c:\meeting

Viewing Groups of File Names in a Directory

Unless you specify otherwise, DOS displays all file names and directory names contained in a directory. To view only certain file names in a directory, you can use wildcards. For example, to see a list of all files that have a .DOC extension in the root directory of a diskette in drive B, type:

    dir b:\*.doc

Making Directories

When you have a group of related files (such as specialized files that you use with one program or files from a specific project), you might want to store them in their own directory. To create a new directory, you can use the MD command, which stands for make directory. The new directory cannot have the same name as any other file or directory contained in that directory.

For example, suppose the current directory is the root (\). To create a directory called OFFICE, you would type the following command:

    md office

The MD command makes a directory within the current directory, unless you specify a different directory. For example, suppose the current directory is \OFFICE. While you are within the OFFICE directory, the DOS command prompt looks like this:

    C:\OFFICE>

To make a directory called NOTES, you can type:

    md notes

In this example, DOS makes a directory called NOTES in the \OFFICE directory. To see this change, type:

    cd notes
at the C:\OFFICE> command prompt. The command prompt then changes to display:

C:\OFFICE\NOTES>

If you are not making a directory within the current directory, you must type the entire path of the new directory or specify the path relative to the current directory. If you include a drive letter with the MD command, you can create a directory on a hard disk or diskette that is not current.

Deleting Directories

There are two ways to delete directories:

- You can use the DELTREE command, which allows you to remove the directory at the same time you delete all the files and subdirectories within the directory.
- You can use the RD command, which allows you to remove the directory or subdirectory after you have deleted all the files within the directory.

Deleting All Files and the Directory Simultaneously

To delete a directory and all the subdirectories and files in it, you can use the DELTREE command. For example, to delete the \WORK directory and all the files in the directory on drive C, type the following:

deltree c:\work

You also can use the DELTREE command to delete one or more files and directories. For example, to delete all the subdirectories and files in the \WORK directory on drive C and to delete the \OFFICE directory and all the files within this directory on drive A, type the following:

deltree c:\work a:\office

Use caution when you use the DELTREE command, because every file and subdirectory within the directory you specify will be deleted. You are prompted before the deletion of each top-level directory or file, similar to the following:

Delete directory "c:\work" and all its subdirectories? (Y/N)

Deleting Only the Directory

The directory you delete cannot contain any files or other directories. If the directory you want to delete contains files or other directories, you must delete them first.
To delete only the directory, use the RD command, which stands for remove directory. For example, to delete the \MEETING\NOTES directory, type the following command:

```
rd \meeting\notes
```

DOS removes the NOTES subdirectory from the \MEETING directory on the current drive.

If DOS does not delete a directory after you have deleted all files and subdirectories in it, there might be hidden or read-only files in the directory. For information about viewing or changing the attributes of hidden or read-only files, type help attrib at the DOS command prompt.

**CAUTION:**
Do not use the ERASE command to delete the “.” or “..” entries in a directory. These are normal entries that are present in every directory. If you erase these entries, you can lose files. (The DELETE command cannot delete these entries.)

**To delete a directory:**

1. Delete all files and directories within the directory you want to delete.
   For example, suppose the current directory is \ART, and \ART contains a directory called WORK. Before you can remove the WORK directory, which does not contain any other directories, you must delete its contents by typing:
   ```
del work\*.*
```
   You can also type the following command with the same results:
   ```
del work
```

2. The following message appears:
   ```
   All files in directory will be deleted!
   Are you sure? (Y/N)
   ```
   Type Y for Yes to delete the files. Or, type N to cancel the command.

3. Make sure the directory you are trying to delete is not the current directory. If it is, change to the directory one level higher by typing the following command:
   ```
cd..
```
   You cannot remove a directory while it is the current directory.

4. Use the RD command to remove the directory.
For example, when the WORK directory is empty, you can type the following command to remove the directory from the \ART directory:

```
rd work
```

DOS removes a subdirectory of the current directory, unless you specify otherwise by typing the full path of another directory. If you include a drive letter with the RD command, you can remove a directory from a drive that is not current.

If you delete a directory accidentally, you can use the UNDELETE command to recover the directory and its files. For more information about undeleting a directory, refer to "Undeleting a Directory" on page 253.

---

**Copying Directories**

To copy a directory and its subdirectories, you can use the XCOPY command. The XCOPY command works with a single directory or a group of directories. You can create new files in the destination directory as well as new subdirectories with this command.

If the destination you specify already has a file or files with the same name, you are prompted to give direction to the system. You can choose the following:

- **Yes (Y)** Overwrite the file and continue xcopying, or return to the DOS command prompt if only one file is involved.
- **No (N)** Do not overwrite the file. Continue xcopying and receiving the system prompt for overwriting if other duplicate file names are found. Or, return to the DOS command prompt if only one file is involved.
- **All (A)** Overwrite the indicated file and all subsequent files and suppress the system prompt for overwriting while xcopying.

---

**Copying All Files in a Directory**

To copy a single directory (without subdirectories), use the XCOPY command without switches. For example, the following command copies all files in the C:\NEW\REPORTS\FINANCE directory to the \FINANCE directory on a diskette in drive A:

```
xcopy c:\new\reports\finance a:\finance
```

If you do not make a directory before you use the XCOPY command, one will be created for you by the XCOPY command.
Because the XCOPY command copies all files in a directory, you do not need to use wildcards. For example, the following XCOPY command copies all files in the current directory from drive A to drive B:

```
xcopy a: b:
```

While DOS prepares to copy the files, it displays a Reading source file(s) message. A message is also displayed showing the names of the files it copies and indicating how many files were copied when the operation has completed.

**Creating Directories as You Copy Files**

If the destination path in an XCOPY command does not exist, DOS creates it. For example, the following command copies all files from the root directory of a diskette in drive A to the C:\TMP directory:

```
xcopy a: c:\tmp
```

If the directory does not exist, you are prompted whether the name specified is a file or directory. To prevent DOS from prompting you, add a backslash at the end of the directory name.

If you do not type a path, DOS copies the files to the current directory.

**Copying Subdirectories**

To copy files in a directory along with any subdirectories that contain files, add the /s switch to the XCOPY command. For example, you have a diskette in drive A that contains the following subdirectories: SCHOOL, WORK, and HOME in the \SCHEDULE directory. The following command copies the files in the \SCHEDULE directory of drive A, including the three subdirectories and all their files, to the \MEMOS directory on drive C:

```
xcopy a:\schedule\ c:\memos /s
```

The backslash (\) after a: indicates that DOS should start at the root directory. When the /s switch is added, every file in every subdirectory that contains files is copied. DOS copies files from A:\SCHEDULE to C:\MEMOS from A:\SCHEDULE\SCHOOL to C:\MEMOS\SCHOOL, from A:\SCHEDULE\WORK to C:\MEMOS\WORK, and from A:\SCHEDULE\HOME to C:\MEMOS\HOME. If any of the directories do not exist on drive C, DOS creates them. In this example, empty subdirectories on drive A are not copied.
To copy an empty directory, use the /e switch with the /s switch. For example, suppose the diskette in drive A has an empty subdirectory called MISC, in addition to the three subdirectories just mentioned. You could type the following command to copy all subdirectories, including the empty subdirectory:

xcopy a:\ c:\memos /s /e

You can use the /s switch without the /e switch, but you cannot use the /e switch without the /s switch.

**Renaming Directories**

To rename a directory, use the MOVE command. The following command renames the \OPS\STATS directory to \OPS\FIGURES:

move \ops\stats \ops\figures

The REN command, which you use to rename files, cannot be used to rename directories.
Chapter 3. Using the Online Book Viewer

The *PC DOS Viewer* is the documentation viewer for PC DOS 7 that allows you to read online books. PC DOS 7 comes with three books online:

<table>
<thead>
<tr>
<th>Name of Online Book</th>
<th>Windows Icon</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDREF</td>
<td><img src="cmdref.png" alt="Command Reference" /></td>
<td>The online PC DOS Command Reference, which provides information about command syntax, PC DOS commands, device drivers, and .INI files.</td>
</tr>
<tr>
<td>DOSREXX</td>
<td><img src="rex.png" alt="REXX Information" /></td>
<td>A description of the DOS REXX commands.</td>
</tr>
<tr>
<td>DOSERROR</td>
<td><img src="error.png" alt="Error Messages" /></td>
<td>An explanation of the more common error messages for DOS and the optional tools provided with PC DOS.</td>
</tr>
</tbody>
</table>

**Note:** You must have selected at least one optional tool for Windows in order to have the PC DOS 7.0 Tools group and the online book icons available when you start Windows.

Starting the PC DOS Viewer

The PC DOS Viewer can be started from:

- The DOS command prompt
- PC DOS Shell
- IBM's OS/2
- Microsoft Windows

**Starting the PC DOS Viewer from the DOS Command Prompt:** All online books for PC DOS 7 have a file extension of .INF and are in the same directory as your other PC DOS 7 files. To start the PC DOS Viewer and view any online DOS book with an extension of .INF, at the DOS command prompt type:

```
view bookname
```

where *bookname* is the name of the online book—either CMDREF, DOSREXX, or DOSERROR. For example, you would type `view cmdref` to view the online Command Reference. The online book also opens when you include the .INF extension (for example, `view cmdref.inf`).

© Copyright IBM Corp. 1981, 1995
**Starting the PC DOS Viewer from PC DOS Shell:** Before you can start the PC DOS Viewer from the PC DOS Shell, first you must:

- Add the program item to the Main group.
- Give the program a title, such as "Command Reference," "Error Messages," or "REXX Information."
- Specify the command that starts the program, such as `view cmdref.inf` to start the online *PC DOS 7 Command Reference*.

For complete instructions for adding a program, refer to "Adding a Program Item" on page 350.

**Starting the PC DOS Viewer from OS/2:** OS/2 allows you to start DOS programs from the OS/2 desktop from either a DOS full screen or from a DOS window. The online documentation viewer, PC DOS Viewer, is just another program that can be started from the OS/2 desktop.

**To start a DOS program from the OS/2 desktop:**

1. From your OS/2 desktop, double-click on the OS/2 System icon.
2. Double-click on the Command Prompts icon.
3. Double-click on either the DOS Full Screen or the DOS Window icon.
4. To start the PC DOS Viewer, type the command used by the program (`VIEW.EXE`), followed by the file name of the online book.

   For example, you would type the following:
   ```
c:\DOS\view.exe cmdref.inf
   ```
   if your DOS files were on drive C in the \DOS directory, to start the VIEW command and open the CMDREF.INF file to view the online *PC DOS 7 Command Reference*.

   Be sure to include the letter of the drive and path containing the PC DOS Viewer program.
5. Press ENTER.
6. Type `exit` and then press ENTER to close the DOS window and return to OS/2 when you are finished.
7. Point to the title bar icon of the Command Prompts window and double-click.
8. Point to the title bar icon of the OS/2 System window and double-click.
Starting the PC DOS Viewer from Windows: To start the PC DOS Viewer while using Windows, use mouse button 1 and double-click on the icon for the book you want to view. The PC DOS Viewer starts, and the online book you selected is opened.

The icons for the PC DOS online books are located in the PC DOS Tools group.

Viewing the Initial PC DOS Viewer Screen

Whenever you type the VIEW command followed by the name of an online book, you will see a screen similar to this:

- **Menu bar** for task selection such as: copying and appending to a file, expanding and collapsing the information tree, searching, printing, accessing online help information about the PC DOS Viewer, and exiting the PC DOS Viewer.

Select any one of the options on the menu bar by clicking on it with a mouse or, if you are using the keyboard, highlight the option by using ALT in combination with the highlighted letter of the option, such as the letter "O" in Options.
- Window displaying the contents of each book.

If a topic has subtopics, you will see a plus sign (+) in front of the topic. If you click on the plus sign, the subtopics are expanded and visible. Also, the plus sign is replaced by a minus sign (-). If you click on the minus sign, the list of topics will return to its collapsed format.

- **Push buttons** where you can select either the searching, printing, or viewing the index tasks. These are located at the bottom of the PC DOS Viewer screen.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click on Previous</td>
<td>To go back to the previous topic you were viewing before you clicked on the hypertext link. This button is grayed when you have not linked to or opened another topic.</td>
</tr>
<tr>
<td>Or press ALT+E</td>
<td></td>
</tr>
<tr>
<td>Click on Search</td>
<td>Search for information by typing a word that indicates the subject you want to find. See “Searching for a Specific Topic” on page 49.</td>
</tr>
<tr>
<td>Or press ALT+S</td>
<td></td>
</tr>
<tr>
<td>Click on Print</td>
<td>Print the topics you have opened and active.</td>
</tr>
<tr>
<td>Or press ALT+P</td>
<td></td>
</tr>
<tr>
<td>Click on Index</td>
<td>Access the index for the online book quickly.</td>
</tr>
<tr>
<td>Or press ALT+I</td>
<td></td>
</tr>
<tr>
<td>Click on Contents</td>
<td>Jump to the Table of Contents and make the window active.</td>
</tr>
<tr>
<td>Or press ALT+T</td>
<td></td>
</tr>
<tr>
<td>Click on Forward</td>
<td>Go to the next topic. You can use this button to page through the online book, much like when you read through a hardcopy book.</td>
</tr>
<tr>
<td>Or press ALT+F</td>
<td></td>
</tr>
</tbody>
</table>

**Moving Around in the PC DOS Viewer**

There are several ways to move around quickly within the PC DOS Viewer and within the online book:

- Click on any of the push buttons at the bottom of the main PC DOS Viewer screen.

- Use the combination keys, **CTRL+letter**, specified for menu selections:
  
  From the active (selected) Table of Contents window or from an active topic window, you can, for example, press both **CTRL+I** keys at the same time to access the Index.

- Use the combination keys, **ALT+letter**, specified for pushbuttons and menu options:
At any time, you can, for example, press both ALT+I keys at the same time to access the Index pushbutton. Or, you can press both ALT+V keys at the same time to access the Services menu option.

For more information about the other keys and key combinations you can use, click on Help from the menu bar, and then select Keys help. Click on Key assignments to see a list of the keys and key combinations.

- Use the hypertext links to jump from subject to subject. Many help screen have an "Examples" hypertext link that, when you double-click on it, opens a window showing examples of how to use the command.

- Use the table of contents to scan the list of topics and then move to that item by selecting it. Either double-click on the table of contents topic or use the DOWN ARROW or UP ARROW to highlight the topic and then press ENTER.

---

**Exiting from the PC DOS Viewer**

To exit from the PC DOS Viewer and return to the DOS command prompt:

- If you are using a mouse, click on Services and then click on Exit.
- If you are using a keyboard:
  
  Press F3.
  Or, press ALT+V and then type x

---

**Getting Other Types of Online Help**

There are various ways to get online help in addition to using the PC DOS Viewer, including the following:

- HELP command
- /? switch
- F1 function key
- Help option from the menu bar

---

**Using the HELP Command**

Accessing help using the HELP command varies, depending on which of the three online books the information is found in. Use one of the following to find the type of help information you need.
To see information about a specific DOS command:

1. At the DOS command prompt, type:
   
   help doscommand
   
   where doscommand is the name of the PC DOS command.

2. Press ENTER.

For example, if you want help about the DEFRAG command, type help defrag

To exit the viewer, press F3.

To see information about a specific DOS error message:

1. At the DOS command prompt, type:

   help letter

   where letter is the first letter of the error message.

2. Press ENTER

For example, type help a to find the error message “Access denied”. You might need to use the scroll bars on the right side of the window to scroll to the message you want to read.

If the name of the DOS command and the letter that the error messages begins with are the same (for example, the E command and error messages that begin with the letter “e”), add error preceding the error message letter:

   help error letter

To exit the viewer, press F3.

To see information about a specific REXX command for DOS:

1. At the DOS command prompt type:

   help rexxcommand

   where rexxcommand is the name of the REXX command you need information about.

2. Press ENTER.

For example, to find out more information about the REXX LASTPOS command, you would type help lastpos at the DOS command prompt.
If the name of the DOS command and the REXX command are the same, add `rexx` preceding the REXX command name:

```
help rexx rexxcommand
```

**To look at command examples:**

The online help used with the PC DOS Viewer might show the highlighted word "Examples" highlighted in the top center portion of the help screen. This is called a *hypertext link*.

If you move the mouse cursor to this word and double-click on it, a small window will pop up showing one or more examples of how to use this command. If you are not using a mouse, tab to a highlighted word then press ENTER.

To exit the viewer, press F3.

**Using the */?* Switch**

Each command has a */?* switch that allows you to view the syntax and other optional switches. The online help information displayed is more concise than the information you see when you use the PC DOS Viewer.

**To view the syntax of a command:**

1. At the DOS command prompt, type:

   ```
   command /?
   ```

   where `command` is the specific DOS or REXX command you need syntax information for.

2. Press ENTER.

For example, you might type `qconfig /?` to view the syntax of the QCONFIG command and the switches and parameters that can be used with this command.

If you type `view /?` you will see what to type to use the PC DOS Viewer and open the online books.
Using F1 or the Help Option

Certain applications and most PC DOS optional tools, including the PC DOS Viewer, have their own help information so you may not need to use the PC DOS Viewer.

To access this help information, you must first access the application or the optional tool by either:

- Typing the command name at the DOS command prompt to start them (for example, typing cpbackup to start Central Point Backup).
- Or, if you are using a shell program, such as the PC DOS Shell or Windows, double-clicking on the icon for the optional tool or application you need help for.

Whether you type the command or click on an icon, you can then access help by pressing F1, clicking on Help at the bottom of the screen or by selecting Help from the menu. Note that not all applications or tools have a menu bar.

While in the PC DOS Viewer, F1 provides help about menus, fields, push buttons, and menu bar options. Place your cursor within the field or menu area or highlight the menu option or push button for which you need information before pressing F1. When you press F1, you see detailed help about the specific item where the cursor is placed or that you have highlighted.

Getting Help while Using the PC DOS Viewer

On the menu bar is the Help option. You can select Help from the menu bar by clicking on it with the mouse or by pressing ALT+H.

From the Help option of the PC DOS Viewer, you can get the following types of help:

Help Index
An index of references to help topics for the document you are viewing.

General Help
General information about the Help facility, including descriptions for other items on the menu bar and the other types of help available.

Using Help
Information about how to use the Help facility.

Keys Help
A list and description of keys you can use while working with or moving around in the Help facility.

Product Information
Information specific to the product you are viewing.
Linking to More Topics

The online books used with the PC DOS Viewer have highlighted words and phrases that link (called a hypertext link) to another part of the online book.

If you move the mouse cursor to one of these highlighted words or phrases and double-click on it, you link to that related information in the online book. If you are not using a mouse, tab to a highlighted word or phrase and then press ENTER. If there is only one highlighted link, just press ENTER.

To go back to the screen from which you linked, click on Previous at the bottom of the PC DOS Viewer screen or click on the button, which is the rectangular box in the top-left corner similar to this: [ ]

Searching for a Specific Topic

If you need information about a topic, you can search for a keyword (a word that indicates the subject you want to find) that might be found in either the text of the online book or in the book's index.

There are three different ways to access the search dialog box to search for a word in the text or index:

- Click on Search found at the bottom of the PC DOS Viewer screen if you are using a mouse, or press ALT+S to jump to the Search push button if you are using a keyboard.
- Press ALT+V and then type the letter s or click on Services on the menu bar and then click on Search.
- Press CTRL+S.

After the Search for dialog box is displayed, type the keyword you are searching for. Search looks for the keyword in both uppercase and lowercase letters. For example, if you searched for the word “typewriter”, it might find Typewriter, typewriter, or TYPEWRITER. Up to 250 matches will be listed. Try not to search for a word that is too common (for example, the word “the”) or you will exceed the limitation of 250 matches.

Specify whether you want to search This section, All sections, or the Index.

Note: You can only search This section if you have the topic opened already. When searching just This section, the matches are highlighted in the text; a list of matches will not be displayed for this selection.
If matches are found, they are displayed in a window for you. Double-click on one of the matches using the mouse, or use the UP ARROW or DOWN ARROW to highlight the item and then pressing ENTER. After you have read the information, you can return to the other items that matched by clicking on the button, (the rectangular box, I, in the top-left corner) once for each opened window until the Search results list is redisplayed. Or you can click on Previous at the bottom of the PC DOS Viewer screen.

Finding Index Topics

If you just want to view the topics that are in the Index, you can do one of the following:

- Press ALT and the letter i to jump to the Index push button at the bottom of the initial PC DOS Viewer screen.

- Click on Index found at the bottom of the PC DOS Viewer screen if you are using a mouse, or press ALT+I to jump to the Index push button if you are using a keyboard.

- Press ALT+O and then type the letter i or click on Options on the menu bar and then click on Index.

- Press CTRL+I.

To view additional screens of index topics, use the scroll bars found on the right side of the window or press the Page Down key. The Index must be active before you can see the scroll bars. A window is active after you click anywhere within the Index window. Also, the window is always active when you use any of the methods discussed previously to access the Index.
To close the Index, click on the Close button [ ] in the top-left corner of the active Index window.

To expand the size of the Index window, click on the arrow (↑) in the top-right corner. Click on the double arrow (‡) in the top-right corner to return the window to its original size.

**Printing from the PC DOS Viewer**

After locating the information you need in the PC DOS Viewer, you can print it. Using the PC DOS Viewer PRINT command, you can print the index, the table of contents, a particular section (only if the topic is open), or all sections.

First, access the Print dialog box by doing one of the following:

- Click on Print found at the bottom of the PC DOS Viewer screen if you are using a mouse or, if you are using a keyboard, press ALT+P to jump to the Print push button.
- Press ALT+V and then type the letter p or click on Services on the menu bar and then click on Print.

Then specify what you want to print. You can also specify which printer you want to select to print (parallel printers LPT1 through LPT3 or serial printers COM1 through COM4).

**Copying Topic Information into a File**

With the PC DOS Viewer, you can copy information to a new file or append information to an existing file.

First, the topic must be opened or the Copy to file or Append to file selections from the Services menu option will be grayed.

You will know a topic is grayed if the *hot key letter*, (also known as mnemonic character) is not showing as a different color or as a brighter color intensity if you are using a monochrome system. An example of a hot key is the letter “v” in the word “Services” on the menu bar.
Copying Information to a File

With the PC DOS Viewer, you can copy the information about a topic into a separate file.

To copy topic information into a file:

1. Open a topic.
2. Press ALT+V and then type the letter c or click on Services on the menu bar and then click on Copy to file.
3. Press CTRL+F.

When you select Copy to file, the information is copied to a temporary file named TEMP.TXT. This file is always placed in the directory you are currently working in. If you want to specify your own file name, just type over TEMP.TXT in the filename field. Add the path if you want a different path than the current directory path.

After the information is in a file, you can also use the E Editor to read this file online or print it.

When you select Copy to file again, the TEMP.TXT file will be overwritten (unless you specified a file name other than TEMP.TXT) and the first topic information will no longer be available. If you want your information to be added cumulatively, select Append to file instead.

Appending Information to a File

Appending information to a file allows you to add additional information about additional topics to the same TEMP.TXT file. The information is cumulative. If no TEMP.TXT file exists, this file will be created the first time you append to a file.

You can also name your own file rather than use the TEMP.TXT file. Specify the path and name of the file and remember to specify this same path and file name information every time you want to append to the file. Or, it may be simpler to append to TEMP.TXT and rename it after completing your appends.

To append information about a topic or topics to the TEMP.TXT file:

1. Open a topic.
2. Press ALT+V and then type the letter a Or, click on Services on the menu bar and then click on Append to file.
3. Press CTRL+A.

As with copying information, the topic must be opened, or the Append-to-file selection from the Services menu option will be grayed.
Chapter 4. Configuring Your System

Configuring your computer is setting it up so that DOS, your hardware, and your applications work the way you want them or the way they were intended to be used. This can be as simple as customizing the appearance of the DOS command prompt or as complex as setting up a new hardware component. Most of DOS's configuration information is stored in two files:

- The CONFIG.SYS file is a text file that contains special commands. These commands set up your computer's hardware components and load the device drivers (such as memory, keyboard, mouse, and printer) so that DOS and applications can use them. When DOS starts, it processes the commands in the CONFIG.SYS file.

- The AUTOEXEC.BAT file is a special batch file that DOS runs immediately after carrying out the commands in your CONFIG.SYS file. AUTOEXEC.BAT can contain any commands you want to carry out when you start your system. For example, this file can contain commands that define the port to which your printer is connected, clear your screen of startup messages, or start your favorite program.

These files must be located in the root directory of your hard disk (usually drive C) for system startup to carry out the commands in these configuration files.

Normally, DOS carries out the commands in both the CONFIG.SYS and AUTOEXEC.BAT files each time you start your computer. However, if you need to, you can instruct DOS to bypass the commands in these files. For more information, see "Bypassing CONFIG.SYS and AUTOEXEC.BAT Commands" on page 54.

When you installed DOS, Setup created a basic system configuration that works for most people. You might want or need to change your system configuration. Before changing your configuration, refer to the following information.
To:       See:

Customize the way DOS uses hardware, memory, and files.   "Specifying Startup Commands in Your CONFIG.SYS File" on page 56.

Add a new hardware component or reconfigure an existing component.   "Hardware Devices Configuration" on page 57.

Specify commands you want DOS to carry out when your computer starts.   "Specifying Startup Commands in Your AUTOEXEC.BAT File" on page 66.

Define more than one system configuration. For example, if several people use the same computer, each person can have a separate configuration.   "Using Multiple Configurations" on page 60.

The rest of this chapter explains how to configure your system by using commands in your CONFIG.SYS and AUTOEXEC.BAT files.

The settings in your CONFIG.SYS file control the basic components of your system, such as memory and disk drives. If you change your CONFIG.SYS file and the new settings are incorrect, your system might not be able to start correctly. If this happens, restart your computer using your bootable startup diskette (the Setup Diskette from your installation diskettes), and then exit from Setup by pressing F3. Or, you can use the procedure to bypass CONFIG.SYS and AUTOEXEC.BAT commands.

Bypassing CONFIG.SYS and AUTOEXEC.BAT Commands

If you need to, you can start your system without running the commands in your CONFIG.SYS and AUTOEXEC.BAT files. This is most useful when you are experiencing system problems that might be related to the settings in your CONFIG.SYS or AUTOEXEC.BAT file. You have two choices:

- You can bypass your startup files completely.
- You can have DOS confirm each CONFIG.SYS command and each AUTOEXEC.BAT command.
Bypassing Your Startup Files

If you are having system problems that might be related to the commands in your CONFIG.SYS or AUTOEXEC.BAT files, you can temporarily bypass those files to start your computer.

To bypass the CONFIG.SYS and AUTOEXEC.BAT files:

1. Start your computer.
2. Press F5 immediately after your computer displays the message Starting PC DOS...

Any device that requires an installable device driver does not work when the installable device drivers are not loaded. For example, programs that require expanded or extended memory are not able to run because no expanded-memory or extended-memory drivers are loaded.

DOS uses the default environment variables of PATH=C:\DOS, PROMPT=$P$G, and COMSPEC=C:\COMMAND.COM temporarily until you correct the problem and restart your computer.

Confirming Each CONFIG.SYS and AUTOEXEC.BAT Statement

You can bypass individually selected CONFIG.SYS and AUTOEXEC.BAT statements when you initialize your system.

To bypass command-line statements:

1. Start your computer. Just after your computer starts, DOS displays the message Starting PC DOS...
2. Immediately press and release F8.

One at a time, PC DOS displays each command in your CONFIG.SYS file, followed by a prompt. For example, if the DOS=HIGH command-line statement is in your CONFIG.SYS file, the following prompt will be displayed:

   DOS=HIGH [Y,N,ESC]?

3. Respond by typing Y for Yes or N for No to load each command in your CONFIG.SYS file.

   If you press ESC before all lines of the CONFIG.SYS file are displayed, your system processes the rest of the lines in your CONFIG.SYS and AUTOEXEC.BAT files. If you press F5 at the [Y,N,ESC]? prompt, the remaining command-line statements in the file are skipped and you are then returned to the DOS command prompt.
When PC DOS finishes processing the CONFIG.SYS file, it displays the following prompt:

Process AUTOEXEC.BAT [Y,N]?

4. Answer Y for Yes or N for No to confirm each statement in your AUTOEXEC.BAT file.

As each line of your AUTOEXEC.BAT file is shown, you are given the same choice as you had going through each line of your CONFIG.SYS.

Specifying Startup Commands in Your CONFIG.SYS File

When your computer starts, DOS carries out commands that configure hardware and reserve space in memory for information processing. The file that contains these commands is called CONFIG.SYS. PC DOS Setup creates a CONFIG.SYS file and stores it in the root directory of your startup hard disk. The commands within this file control devices like your printer, your mouse, the display, various types of memory, and so forth. You can add and change CONFIG.SYS commands to configure your system as needed.

For a list of the CONFIG.SYS commands supported by PC DOS and an explanation of how to use them, see the online PC DOS 7 Command Reference.

CONFIG.SYS File Editing

To edit the CONFIG.SYS file, use a text editor, such as E Editor, that can save files as unformatted (ASCII) text. Do not edit the CONFIG.SYS file using a word processor that saves files in a special document format. If you do, your computer might not start.

Because the CONFIG.SYS file controls how DOS starts, DOS reads it only when you start your computer. Therefore, after changing the CONFIG.SYS file, you must restart your computer for your changes to take effect.

To make changes to your CONFIG.SYS file:

1. Make a copy of your CONFIG.SYS file on a separate diskette before you make any changes.

2. Edit the CONFIG.SYS file using a text editor, such as the E Editor provided with PC DOS.

3. Add or change CONFIG.SYS commands, as necessary. Each CONFIG.SYS command must begin on a separate line.
4. When you have finished editing the CONFIG.SYS file, save your changes and exit from the text editor.

5. Restart your system by pressing CTRL+ALT+DEL so that your changes can take effect.

Hardware Devices Configuration
Each hardware component of your computer is called a device. Your computer's keyboard, mouse, display, printer, disk drives, and memory boards are all devices. Each device has its own characteristics that can be customized.

DOS uses a special program called a device driver to control each device. For example, DOS uses a built-in device driver to control how information is read to and from a diskette drive. DOS has built-in device drivers for your keyboard, display, hard drives and diskette drives, and communication ports. Because these device drivers are built in, you do not have to do anything special to use them. You can customize certain features of these devices by using CONFIG.SYS commands. For a list of these commands, see the online PC DOS 7 Command Reference.

Other devices, such as memory boards, a mouse, or CD-ROM have device drivers that are not built into DOS. Such a device driver is called an installable device driver because you install it by adding a command to your CONFIG.SYS file. Many hardware devices come with their own device drivers. For example, DOS comes with a device driver called HIMEM.SYS. Several other installable device drivers are included with DOS.

To use your CD-ROM and access it through PC DOS (using MSCDEX.EXE):
The CD-ROM device driver must be loaded by the CONFIG.SYS file. The device driver for your CD-ROM does not come with PC DOS. For more information about MSCDEX**, see “Specifying Startup Commands in Your AUTOEXEC.BAT File” on page 66.

To use an installable device driver:
Add a DEVICE command for that driver to your CONFIG.SYS file. When DOS starts, it loads the device driver into memory. For example, to load the HIMEM.SYS device driver from the C:\DOS directory, you would add a command similar to the following to your CONFIG.SYS file:

```
    device=c:\dos\himem.sys
```

** MSCDEX is a trademark of the Microsoft Corporation.
When DOS reads this command, it loads the HIMEM.SYS device driver into memory. The HIMEM.SYS device driver remains in memory and manages extended memory.

Many hardware devices come with installation programs that automatically add the necessary commands to your CONFIG.SYS file.

The order in which DEVICE and DEVICEHIGH commands appear in the CONFIG.SYS file is important because some device drivers enable devices that are then used by other drivers. For example, the HIMEM.SYS extended-memory driver must be started before any drivers that use extended memory.

The order in which device drivers should appear in your CONFIG.SYS file is as follows:

1. HIMEM.SYS if your system has extended memory.
2. Your expanded-memory manager if your system has an expanded-memory board.
3. EMM386.EXE if your system is an 80386 or higher processor with extended memory. If your CONFIG.SYS file includes both an expanded-memory manager and EMM386, the EMM386 command line should include the **noems** switch.

   EMM386 uses extended memory to simulate expanded memory on systems that do not have expanded memory. EMM386 can also provide access to the upper memory area. For more information, see Chapter 13, “Making More Memory Available” on page 205.

4. Any other device drivers.

This list is intended to show only the correct order for device drivers. It is not intended to be a list of the commands that your CONFIG.SYS file should contain. The contents of your system's CONFIG.SYS file depends on the type of system, the amount or type of memory, the hardware configuration, and the applications you use.
**CONFIG.SYS File Examples**

The following is a typical CONFIG.SYS file for an 80386 computer with 2MB or more of extended memory:

```plaintext
device=c:\dos\himem.sys
dos=high,umb
device=c:\dos\emm386.exe ram
files=40
buffers=20
break=on
devicehigh=c:\dos\ansi.sys
```

In this example:

- The BUFFERS command reserves 20 buffers for transferring information to-and-from disk drives.
- The FILES command reserves enough room to have 40 files open at one time.
- The BREAK command checks frequently for the CTRL+C or CTRL+BREAK key combinations.
- The DOS=HIGH,UMB command runs DOS in the high memory area and specifies that programs should have access to the upper memory area. For more information about the upper memory area, see Chapter 13, "Making More Memory Available" on page 205.
- The DEVICE commands load the HIMEM.SYS and EMM386.EXE device drivers. The HIMEM.SYS driver manages extended memory. The EMM386.EXE driver, when used in a DEVICE statement with the ram switch, provides access to the upper memory area and simulates expanded memory.
- The DEVICEHIGH commands load device drivers into the upper memory area.

**Note:** Windows and DOS contain several programs that have the same name. However, the PC DOS programs have been updated after the release of Windows 3.1. If you install Windows after installing DOS, check your CONFIG.SYS and AUTOEXEC.BAT files to make sure that you are using the programs HIMEM.SYS, EMM386.EXE, and SMARTDRV.EXE from the DOS directory and not from the Windows directory.
If you use a network, and your system includes an 80286 processor and expanded memory, your CONFIG.SYS file might look like this:

```plaintext
rem This computer’s expanded-memory board came with
rem its own expanded-memory driver, EMSDRV.SYS.
device=c:\emsdrv\emsdrv.sys
devicehigh=c:\dos\himem.sys
device=c:\net\network.sys
device=c:\dos\ramdrive.sys /a
rem The /a switch instructs RAMDrive to use expanded memory.
buffers=20
files=30
break=on
rem The following command reserves space for 26 drives letters.
lastdrive=z
```

In this example:

- This CONFIG.SYS file loads device drivers for the expanded memory board, the HIMEM.SYS memory manager, and the network.
- The RAMDRIVE.SYS driver creates a RAM drive in expanded memory.
- The LASTDRIVE command reserves space for 26 logical drives so that letters from A to Z are available as labels for drives.

### Using Multiple Configurations

A single CONFIG.SYS file can define several different system configurations. This can be useful if several people share a single computer, or if you want to be able to start your computer with a choice of configurations. Each step in defining how you would type multiple configuration commands in your CONFIG.SYS file is explained.

**Step 1: Defining a Startup Menu**

To use multiple configurations, you must define a startup menu. To do this, create a configuration block with the block heading [Menu]. A menu block can contain any of the following commands:

- The MENUITEM command
- The MENUNDEFAULT command
- The MENUCOLOR command
- The SUBMENU command

When your computer starts, the startup menu appears and lists the available configurations; you choose the configuration you want.
If you type this in your CONFIG.SYS file:

[DOS_ANSWER]

menuitem=DLS, Load DOS LAN Services Client
menuitem=INTLNK, Load InterLnk Client
menuitem=CPSW, Load Code Page Switching
menucolor=7,1
menudefault=DLS,20

DOS produces this startup menu:

IBM DOS Startup Menu
==================================
1. Load DOS LAN Services Client
2. Load InterLnk Client
3. Load Code Page Switching

Enter a choice: 1 Time remaining: 20

In this example:

• The MENUITEM command defines the item on the menu. The first MENUITEM command value, [DLS], specifies the name of the associated configuration block. The second value, which is optional, specifies the text, Load DOS LAN Services Client to display on the menu. If you do not specify any menu text, DOS uses the name of the configuration block as the menu text.

• The MENUCOLOR command is optional. This command can be used, as in this example, to set the text color to 7 (white) and the background color to 1 (royal blue) from the default colors of white text on a black background. Type help menucolor for a table listing the valid color numbers.

• The MENUDEFAUL T command is optional. When this command is used, it specifies which menu item is to be the default configuration. The block must be defined elsewhere in the CONFIG.SYS file. When DOS displays the startup menu, the default menu item is highlighted, and its number appears after the Enter a choice prompt. If no item is specified, the default is set to the first item.

The MENUDEFAUL T command also sets a timeout value. You can specify a timeout value from 0 to 90 seconds. A timeout of 0 seconds forces automatic selection of the default, effectively bypassing the menu display.

If you specify a timeout value but no item is selected within the specified time, DOS starts the computer with the default configuration.

If you do not specify a timeout value, DOS does not continue until ENTER is pressed.

Step 2: Defining Configuration Blocks

A configuration block is a set of CONFIG.SYS commands that you want DOS to run when that particular configuration is selected from the startup menu. A configuration block begins with a block header—the block name surrounded by
brackets. The block name must be a single word but can be as long as you want. When DOS starts with a particular configuration, it carries out all the commands between that block header and the next block header.

A configuration block can contain any command you would normally place in your CONFIG.SYS file. A CONFIG.SYS file can define a [COMMON] block that includes commands common to all configurations. DOS carries out the command in a [COMMON] block for every configuration. You can have as many [COMMON] blocks as you want; DOS runs [COMMON] commands in the order in which they appear in the CONFIG.SYS file.

The following CONFIG.SYS file defines two configurations and includes several commands that are common to both:

```plaintext
CONFIG.SYS file (continued)

:
  [COMMON]
files=30
buffers=30
lastdrive=z
break=on
device=C:\DOS\HIMEM.SYS
dos=HIGH,UMB
device=C:\DOS\EMM386.EXE NOEMS
device=C:\DOS\SETVER.EXE

  [CPSW]
country=001,,C:\DOS\COUNTRY.SYS
devicehigh=C:\DOS\display.sys con=(ega,,1)

  [DLS]
devicehigh=C:\NET\protman.dos /i:C:\NET
devicehigh=C:\NET\dlselp.sys
devicehigh=C:\NET\ibmtok.dos

  [INTLNIK]
devicehigh=C:\DOS\INTERLNK.EXE

  [COMMON]
devicehigh=C:\DOS\ANSI.SYS
shell=C:\DOS\COMMAND.COM /P /E:512
:
```
This CONFIG.SYS file configures the computer for LAN networking [DLS], laptop computer connectivity [INTLNK], and code page switching and keyboard support [CPSW]. For all three configurations, DOS runs the commands in the [COMMON] configuration blocks.

The INTLNK configuration uses the Client Device Driver (INTERLNK.EXE) to make the client computer use the devices on the server computer as though they were local drives. INTERLNK loads itself into upper memory when upper memory blocks are available. The [COMMON] section makes these upper memory blocks available.

**Step 3: Using INCLUDE statements for Multiple Configurations**

The CONFIG.SYS file can also contain the INCLUDE command. You can include the contents of one configuration block in another by using the INCLUDE command. The INCLUDE command instructs DOS to carry out the commands in another configuration block as well as the commands in the current block. This command specifies the name of the block you want to include; the command can be used only within a configuration block.

Suppose you wanted to add another configuration that includes all three of the previously discussed configuration blocks combined. You could use the INCLUDE command to do this by adding a fourth configuration similar to the following:

```
[LOADALL]
include=CPSW
include=DLS
include=INTLNK
set path=c:\net;c:\dos
::

[COMMON]
```

The [LOADALL] configuration uses the INCLUDE command to include the [CPSW], [DLS], and [INTLNK] blocks. It also has its own SET PATH command.
It is a good idea to place a [COMMON] block at the end of your CONFIG.SYS file, even if it does not contain any commands. Some applications append commands to your CONFIG.SYS file. If your CONFIG.SYS file has a [COMMON] block at the end, an application can append commands to the CONFIG.SYS, and DOS will carry out those commands for all your configurations.

**Step 4: Modifying the AUTOEXEC.BAT File for Multiple Configurations**

When using multiple configurations, it can be useful to have DOS run different AUTOEXEC.BAT commands for each configuration. You can create branching code in the AUTOEXEC.BAT file by using batch commands such as the IF and GOTO commands. With batch commands, you can have DOS carry out different AUTOEXEC.BAT commands, depending on the startup configuration.

When a configuration is selected from the startup menu, DOS sets the CONFIG environment variable to the name of the selected configuration block. In the AUTOEXEC.BAT file, you can use the IF command to test the value of the CONFIG variable and then have DOS carry out different commands for different values. When you test the value of the CONFIG variable, you can enclose it both in percent signs (%) and double quotes ("), as shown in the example below. For information about the IF command, type help if at the DOS command prompt.

The following AUTOEXEC.BAT file tests the CONFIG variable and executes different commands, depending on the result; it is designed to work with the example CONFIG.SYS file.
When DOS runs this AUTOEXEC.BAT file, it sets the path, prompt style, and the TEMP environment variable. DOS then tests the value of the CONFIG variable. The CONFIG.SYS value was set when you entered your choice of configuration from the Startup Menu.

For example, if the name of the current configuration is not CPSW, DOS inquires whether you want mouse support. If you do not want to load the mouse (or you do not make a choice of whether to load the mouse in three seconds), mouse support is not loaded.

Whether or not you choose to have mouse support, this configuration then runs DOSKEY, starts the IBM AntiVirus/DOS, and starts the PC DOS Shell.
Specifying Startup Commands in Your AUTOEXEC.BAT File

Each time you start your system, DOS carries out the commands in your AUTOEXEC.BAT file. This file is located in the root directory of your hard disk (usually drive C).

The .BAT file-name extension indicates that the file is a batch file—a series of commands that you specify you want DOS to run. The commands in the AUTOEXEC.BAT file set the characteristics of your devices, customize information that DOS displays, and start memory-resident programs and other applications. To run AUTOEXEC.BAT without restarting your system, type autoexec at the DOS command prompt.

AUTOEXEC.BAT File Editing

You can customize your system by adding commands to your AUTOEXEC.BAT file. Use any commands you would normally type at the DOS command prompt.

To edit the AUTOEXEC.BAT file, use a text editor, such as E Editor, that can save files as unformatted (ASCII) text. Do not edit the AUTOEXEC.BAT file using a word processor that saves files in a special document format. If you do, your computer might not start.

Because the AUTOEXEC.BAT file controls how DOS starts, DOS reads it only when you start your computer. Therefore, after changing the AUTOEXEC.BAT file, you must restart your computer for your changes to take effect.

To make changes to your AUTOEXEC.BAT file:

1. Make a copy of your AUTOEXEC.BAT file on a separate diskette before you make any changes.

2. Edit the AUTOEXEC.BAT file using a text editor, such as the E Editor provided with PC DOS.
   
   For example, to edit your AUTOEXEC.BAT file using the E Editor, type e autoexec.bat at the DOS command prompt.

3. Add or change AUTOEXEC.BAT commands, as necessary. Each AUTOEXEC.BAT command must begin on a separate line.

4. When you have finished editing the AUTOEXEC.BAT file, save your changes and exit from the text editor.

5. Restart your system by pressing CTRL+ALT+DEL so that your changes can take effect.

Note: Before changing your original AUTOEXEC.BAT file, copy and save it as a different name, such as AUTOEXEC.BAK, as a precaution.
If you have a CD-ROM, you might want to include the MSCDEX command in your AUTOEXEC.BAT file. This command must include a `/drive:drivename` parameter that matches the `/drive:drivename` parameter used in the CONFIG.SYS file for the CD-ROM device driver. Each CD-ROM device driver currently in use must have a unique driver name.

The device driver that came with your CD-ROM must be loaded in the CONFIG.SYS file before you can access it in PC DOS using the MSCDEX command.

For more information about this command, refer to the online *PC DOS 7 Command Reference*.

**AUTOEXEC.BAT Commands**

Every command in an AUTOEXEC.BAT file can also be used in other batch programs or on the command line. Some of the most common AUTOEXEC.BAT commands are:

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROMPT</td>
<td>Sets the appearance of your DOS command prompt.</td>
</tr>
<tr>
<td>MODE</td>
<td>Sets the characteristics of your keyboard, monitor, and serial and parallel ports.</td>
</tr>
<tr>
<td>PATH</td>
<td>Specifies the directories in which DOS searches for executable files (files with a .COM, .EXE, or .BAT file-name extension).</td>
</tr>
<tr>
<td>ECHO OFF</td>
<td>Directs DOS not to display the commands in your AUTOEXEC.BAT file as they run. You can also prevent a command from being displayed by inserting an at sign (@) at the beginning of that line.</td>
</tr>
<tr>
<td>SET</td>
<td>Creates an environment variable that can be used by programs. The SET command can also be used in the CONFIG.SYS file.</td>
</tr>
</tbody>
</table>

For detailed information about these commands, refer to the online *PC DOS 7 Command Reference*, or type the command name followed by `/?` for the abbreviated online explanation and command syntax.

For more information about programming batch files, see Chapter 7, "Working with Batch Programs" on page 97.
Terminate-and-Stay-Resident Programs

Another common use of the AUTOEXEC.BAT file is to start *memory-resident programs*—programs that load into memory and stay there while you use other programs. These are also called *terminate-and-stay-resident* (TSR) programs. DOS comes with several memory-resident programs that are commonly started from the AUTOEXEC.BAT file, such as:

- APPEND
- CPSCHED
- DATAMON
- SENTRY (or TRACKER)
- KEYB
- MOUSE
- SMARTDRV

For more information about these programs, you can type `help` followed by the command name at the DOS command prompt. This opens the online *PC DOS 7 Command Reference* at the command specified.

For an abbreviated explanation and command syntax for each commands, you can type the command name followed by the `/?` switch.

Changing Screen Attributes

You can change your screen attributes using the PROMPT command and an ANSI set graphics mode escape sequence in your AUTOEXEC.BAT file. To do this, you must ensure that the ANSI.SYS driver is loaded in your CONFIG.SYS file.

If you load the ANSI.SYS driver after loading RAMBoost, place your DEVICE statement after the RAMBoost statement in the CONFIG.SYS file.

There are three kinds of screen attributes:

- **text format**: Specifies whether text is bold, underscored, blinking, or hidden.
- **text color**: Specifies the text color.
- **background color**: Specifies the screen color.

You must use the following syntax when changing these attributes in your AUTOEXEC.BAT file:

```
prompt $e[x;xx;xxm]
```
In this example:

<table>
<thead>
<tr>
<th>$e</th>
<th>Indicates the ANSI escape code.</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x</td>
<td>Indicates the number 1, 4, 5, 7, or 8 that controls the text format.</td>
</tr>
<tr>
<td>$xx</td>
<td>Indicates the numbers 30 through 37 that control the color of the text.</td>
</tr>
<tr>
<td>$xmm</td>
<td>Controls the screen color and the ANSI set graphics mode, where xx is a number from 40 through 47 and $m$ represents the ANSI set graphics mode.</td>
</tr>
</tbody>
</table>

The order in which you type the parameters is not important. However, each parameter must be separated by a semicolon.

**To change the text format**, use one of the following:

1. Changes the text to bold or high intensity.
4. Changes the text to be underscored. This works on monochrome displays only.
5. Changes the text so that it blinks.
7. Changes the screen display to reverse video. Reverse video reverses the foreground and background colors or shades used on the screen. For example, if your screen normally displays light letters on a dark background, reverse video displays dark letters on a light background.
8. Hides the text unless you subsequently change the background color.

**To change the text color**, use one of the following:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>Black</td>
</tr>
<tr>
<td>31</td>
<td>Red</td>
</tr>
<tr>
<td>32</td>
<td>Green</td>
</tr>
<tr>
<td>33</td>
<td>Yellow</td>
</tr>
<tr>
<td>34</td>
<td>Blue</td>
</tr>
<tr>
<td>35</td>
<td>Magenta</td>
</tr>
<tr>
<td>36</td>
<td>Cyan</td>
</tr>
<tr>
<td>37</td>
<td>White</td>
</tr>
</tbody>
</table>

**To change the background color**, use one of the following:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td>Black</td>
</tr>
<tr>
<td>41</td>
<td>Red</td>
</tr>
<tr>
<td>42</td>
<td>Green</td>
</tr>
<tr>
<td>43</td>
<td>Yellow</td>
</tr>
<tr>
<td>44</td>
<td>Blue</td>
</tr>
<tr>
<td>45</td>
<td>Magenta</td>
</tr>
<tr>
<td>46</td>
<td>Cyan</td>
</tr>
<tr>
<td>47</td>
<td>White</td>
</tr>
</tbody>
</table>

If you choose a parameter that is not supported, the system ignores it and no change takes place.
Some examples of the types of statements you can put in your AUTOEXEC.BAT file are:

```plaintext
prompt $e[1;33;41m  Adding this command to your AUTOEXEC.BAT file would show yellow text on a red background in bold or high intensity the next time you reboot your system.
prompt $e[5;34;47m  Adding this command to your AUTOEXEC.BAT file would show blue text on a white background and would be blinking.
```

The default prompt that PC DOS provides is a C:\> prompt and blinking cursor. To return to your original C:\> prompt, add a PROMPT command similar to the one in the next example (prompt $p$g).

**AUTOEXEC.BAT File Examples**

The following example of a AUTOEXEC.BAT file contains the most commonly used AUTOEXEC.BAT commands:

```plaintext
path=c:\;c:\dos;c:\utility;c:\batch
prompt $p$g
set temp=c:\temp
doskey
c:\smartdrv.exe
```

In this example:

- The PATH command directs DOS to search for program files in the current directory and then in the following directories: the root directory of drive C, C:\DOS, C:\UTILITY, and C:\BATCH. A semicolon (;) separates each directory.
- The PROMPT command sets the command prompt so that it shows the current drive and directory, followed by a greater-than sign (>), which is the default prompt.
- The SET command creates an environment variable named TEMP and sets it equal to the directory C:\TEMP.

The name you specify must be the name of an existing directory. Many programs, including DOS itself, use this variable when storing temporary files.

- The DOSKEY command loads the DOSKey program into memory. This program provides keyboard shortcuts at the DOS command prompt. DOSKEY.COM is normally installed by the PC DOS Setup program in the directory containing your DOS files.
- The SMARTDRV command loads the SMARTDrive program into memory.
Suppose your system has one diskette drive, one hard disk drive, a laser printer connected to port COM1, and PC DOS Shell. You might want to put the following commands in your AUTOEXEC.BAT file:

```batch
@echo off
path=c:\;c:\dos;c:\utility;c:\lotus;c:\norton
prompt $p$g
mode lpt1=com1
set temp=c:\temp
doskey
dosshell.exe
```

In this example:

- The ECHO OFF command prevents the AUTOEXEC.BAT commands from being displayed as they are carried out. The @ sign at the beginning of the line prevents the ECHO OFF command from being displayed.

- The MODE command redirects printer output from LPT1 (its default port) to the serial port COM1.

- The DOSSHELL command starts the PC DOS Shell program, which provides a graphical interface that performs many of the same file-management and disk-maintenance tasks that you perform from the command line.
Chapter 5. Managing Disks

Disks provide long-term information storage. The information you save on disks remains intact until you delete it. This chapter discusses:

- Types of disks and how they are used
- How to format and unformat a disk
- How to create a system diskette
- How to label disks

Types of Disks

There are generally two classifications of disks:

- Hard disks (also referred to as fixed disks)
- Diskettes that come in two basic sizes: 5.25 and 3.5 inches

Disks store information on magnetic surfaces. In a diskette, the magnetic surface is a thin, flexible disk inside a protective plastic cover. A hard disk has two or more rigid disks stacked on top of each other in a sealed case. It remains in your computer until you upgrade to a larger hard disk or it somehow becomes damaged.

Information on disks is divided into tracks and sectors. The more tracks a disk has, the more information it can store. The information is divided by DOS into sectors. A sector is the basic unit of storage on a disk.

All disks need to be formatted so that they can receive and store information. Formatting writes track and sector marks on the disk defining the areas that DOS can use. When you format, the disk is checked for defects.

Diskettes vary in physical size and the amount of information they can hold. The storage size of a diskette is measured in bytes for files, and kilobytes and megabytes for disks. These terms are defined as follows:

- **byte**  
  The amount of space it takes to store a character.

- **kilobyte**  
  A kilobyte is approximately 1000 bytes, represented by a K in this guide (1024 bytes for CPU memory).

- **megabyte**  
  A megabyte is approximately 1000000 bytes, represented by MB in this guide (1048576 bytes for CPU memory).
The most common types of diskettes that PC DOS can work with, and the capacity for the diskettes drives include:

<table>
<thead>
<tr>
<th>Diskette</th>
<th>Diskette-Drive Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.25-inch, double-sided/double-density</td>
<td>360K</td>
</tr>
<tr>
<td>5.25-inch, double-sided/high-density</td>
<td>1200K or 1.2MB</td>
</tr>
<tr>
<td>3.5-inch, 1MB capacity</td>
<td>720K</td>
</tr>
<tr>
<td>3.5-inch, 1MB/2MB capacity</td>
<td>1440K or 1.44MB</td>
</tr>
<tr>
<td>3.5-inch, 1MB/2MB/4MB capacity</td>
<td>2880K or 2.88MB</td>
</tr>
</tbody>
</table>

The 1MB diskettes can be used in 720K, 1.44MB, and 2.88MB diskette drives; they must be formatted to 720K, which you do with either a 720K or a 1.44MB diskette drive. When you use a 1.44MB diskette drive, be sure to specify a format of 720K.

The 2MB diskettes can be used in 1.44MB diskette drives or 2.88MB diskette drives only and must be formatted to 1.44MB. You must use a 1.44MB or 2.88MB diskette drive to format.

If you intend to transfer diskettes between computers that have diskette drives with different capacities, use only 1MB diskettes formatted to 720K.

**Note:** A 1.44MB diskette drive might have “1.44” printed on the diskette eject button. A 720K diskette drive usually has no identification mark.

Most diskettes have labels indicating their type. You can also use the DIR or CHKDSK command to view information about the storage capacity of a formatted diskette. Type `help dir` or `help chkdsk` for detailed information about these commands. The online *PC DOS 7 Command Reference* is opened to the command you specified.

### Types of Diskette Drives

Not all types of diskettes are compatible with all types of diskette drives. In general, the diskette must be formatted at a capacity less than or equal to the capacity of the drive in order for the diskette and diskette drive to be compatible. For example, if you have a high-density 5.25-inch diskette drive designed to work with 1.2MB diskettes, you can use diskettes formatted as 360K disks. However, if you have a 360K drive, you usually cannot use disks formatted as 1.2MB disks.
If you are unsure whether a diskette works with a certain drive, you can try using
the diskette by inserting it into the diskette drive and using the DIR command. If
the diskette and drive are incompatible or if the diskette is unformatted, DOS
displays a General failure error message.

DOS adjusts its operations to work with the type of diskette drive you are using.
When using some commands, you must add a switch if your diskette drive and
diskette do not have the same capacity.

Considerations for Formatting Disks

Before you can use a disk or diskette you must prepare it by using the FORMAT
command. The disks might or might not have been previously formatted.

When you format a disk or diskette, DOS performs a safe format by default.
Because of the safe format, you can restore the disk to the way it was before the
format by using the UNFORMAT command, provided you have not stored files on
the newly formatted disk.

When you format a diskette or hard disk, DOS reserves a small part of the disk for
its tracking system. The tracking system consists of two parts: a file allocation
table, which tracks the location of each file on the disk, and the root directory, which
stores the name, size, creation date and time, and file attributes for the files on the
disk.

If you are using a new hard disk, you must partition it before you can format it.
While you are running the DOS Setup program, if the hard disk is unpartitioned or
unformatted, you can partition and format it. For information about setting up
PC DOS on a hard disk, refer to Chapter 1, "Installing" on page 3. You can also
partition a new hard disk by using the Fixed Disk Setup Program (FDISK). For
information about FDISK and partitioning, see Chapter 6, "Partitioning Your Hard
Disk" on page 81.

CAUTION:
Because the FORMAT command destroys all information on a disk, it is a
good idea to develop the habit of using the DIR command before formatting a
disk so that you do not destroy important files. DOS displays a warning
message if you attempt to format your hard disk. If you accidentally format
your hard disk and you have not written new information to it, you might be
able to use the UNFORMAT command to recover its contents. For more
information, see "Unformatting a Disk" on page 78.
Formatting a Disk

To format a diskette or hard disk, use the FORMAT command. For example, type the following command to format a diskette in drive A:

```
format a:
```

You must specify the drive that contains the diskette you want to format.

To format a hard disk after it has been partitioned, type:

```
format drive:
```

at the DOS command prompt. If the hard disk has already been formatted, this message prompt is displayed:

```
Warning, all data on non-removable disk drive C: will be lost!
Proceed with format (Y/N)?
```

Type y to proceed or n to cancel the command.

There are several switches that can be used with the FORMAT command. Some of the more common ones that you will use are:

- `/q` Use this switch on a previously formatted disk to speed up formatting.
- `/u` Use this switch on new disks to speed up formatting or on a disk where you have received read and write errors during the use of the disk.

  Use this switch to specify unconditional formatting. Using this switch destroys all existing data on a disk and prevents you from using the UNFORMAT command after formatting has taken place.

- `/f` Use this switch to specify the size of the diskette to format. For example, if drive A is a 1.2MB, 5.25-inch drive, and you want to format a 360K diskette in it, you would type:

  ```
  format a: /f:360
  ```

For more information about the switches that can be used with the FORMAT command, type `help format` to open the online `PC DOS 7 Command Reference` to the detailed discussion about FORMAT.

As it formats the disk, DOS displays the percentage of the disk that has been formatted. After the disk is formatted, you are prompted to give the disk a `volume label`. Type the name you want to give the disk, or press ENTER if you do not want a label.
DOS then displays information about how the disk has formatted:

1,213,952 bytes total disk space
1,213,952 bytes available on disk

512 bytes in each allocation unit
2,371 allocation units available on disk

Volume Serial Number is 382C-17F4

Bytes total disk space Indicates the storage capacity of the disk.

Bytes used by system Displayed if you have transferred the DOS system files to the disk. This line shows how much disk space is used by the three system files.

Bytes in bad sectors Indicates how much of the disk is unusable because of bad sectors. If there are no bad sectors, this line is omitted. If a diskette has any bad sectors, do not store important files or backup files on it. Most hard disks have a small number of bad sectors. In general, the portion of a hard disk taken up by bad sectors should be a small fraction of the total space available.

Bytes available on disk Indicates the total disk space minus the space taken up by the system files and any bad sectors. If the disk does not contain system files and there are no bad sectors, this number should be the same as the "bytes total disk space" number.

Bytes in each allocation unit and allocation units available on disk Indicates how DOS has divided the available disk for file storage. If you multiply the two numbers on these lines, the result is the same as the "bytes available on disk" number.

Volume serial number Indicates the serial number assigned to the disk. This number does not change unless the disk is formatted again.

Following this information, you are prompted to format another disk. Type y to format another disk in the same drive with the same switches, or type n to return to the DOS command prompt.
Unformatting a Disk

You can restore a disk that has been reformatted by using the UNFORMAT command. The disk should be safe-formatted (that is, if you used the FORMAT command without the /u switch). The UNFORMAT command is most effective if used immediately after a disk has been reformatted.

If the disk was safe-formatted, UNFORMAT restores the disk to the way it was at the time of the format. To restore a disk that has been safe-formatted, use the UNFORMAT command. For example, to restore a hard disk (drive C), type:

    unformat c:

You cannot restore a formatted disk if you use the /u switch with the FORMAT command. The /u switch performs an unconditional format (removes the safe-formatting). You also cannot restore a diskette if you changed its storage capacity when you reformatted it. You need to use the UNFORMAT command immediately after you have formatted a disk. If you have saved anything on the disk between formatting and unformatting, you will probably lose some of the information.

Type help unformat for more information about the UNFORMAT command.

Creating a System Diskette

It is recommended that you make a system diskette (sometimes called startup diskette) to handle emergencies such as your computer system not starting. The Setup Diskette of the PC DOS installation diskettes can be used as a startup diskette. It has all the files you will need to restart your system. When the system files are on a diskette, you can use the diskette to start your system from your diskette drive.

System diskettes must contain the three DOS system files—IBMBIO.COM, IBMDOS.COM, and COMMAND.COM. When you start your system, these three files are copied from the system diskette to your system's random-access memory (RAM). The IBMBIO.COM and IBMDOS.COM files are hidden files; you do not see them in directory listings on the diskette unless you use the /a switch with the DIR command. The COMMAND.COM file is usually in the root directory of every system diskette.

In addition to these three DOS system files, you want to include the file FDISK.COM and an editor. You must copy these files to the system diskette.
To create a system diskette during formatting, use the FORMAT command with the /s switch. For example, the following command formats the diskette in drive B and makes it a system diskette:

```
format b: /s
```

You can also use the following to ensure the use of a system diskette:

- Make a formatted diskette a system diskette by using the SYS command. For example, to copy the system files COMMAND.COM, IBMIBIO.COM, and IBMDOS.COM to a formatted diskette in drive A, type:

```
sys a:
```

- Keep the Setup Diskette from your installation diskettes handy. This diskette also can be used as a startup diskette to start your system.

You cannot make a system diskette by using the COPY command. This command does not copy the hidden system files. You must use the FORMAT or SYS command. For more information about these commands, type help format or help sys at the DOS command prompt.

For information as to what files you should have if you are creating your own system diskette or if you are creating a bootable Stacker diskette for your compressed drives, refer to "Bootable Stacker Diskette" on page 309.

---

**Considerations for Labeling a Disk**

Each disk can have a name, called the volume label, and a number, called the volume serial number. DOS uses the volume serial number to keep track of which disk is in a drive. DOS assigns a serial number to a disk when you format it. The serial number does not change unless the disk is formatted again. Only disks formatted by DOS Version 4.0 and later have a serial number. DOS displays the disk’s volume label and serial number above the list of files in every directory.

You can change a disk’s volume label by using the LABEL command. The volume label you choose can contain no more than 11 characters, and it cannot include the following characters: asterisk (*), question mark (?), slash (/), backslash (\), period (.), comma (,), colon (:), semicolon (;), plus sign (+), equal sign (=), less-than sign (<), greater-than sign (>), caret (^), quotation mark ("), brackets ([ ]), ampersand (&), parentheses ( ), or any key combinations. Volume labels can include spaces but not tabs.

**Note:** You can use extended characters in a label; if you do, it is recommended that you use code page 850. If you use code page 437, support for extended characters is limited.
If you need more information about extended characters, this can be found in the
*PC DOS 7 Keyboards and Code Pages* book. This book can be optionally
purchased. See the coupon booklet included with PC DOS 7.

**Assigning Labels**

If you work with a large number of disks, it might be convenient to create a label for
each disk. You can view the label when you use the DIR or VOL command.

To assign a volume label, use the LABEL command. For example, to assign the
label "disk 2" to a diskette in drive A, type:

```
label a:disk 2
```

If you type a drive letter, but no label, DOS prompts you for a label. For example,
to label the diskette in drive B, type:

```
label b:
```

DOS displays the current label and serial number of the diskette in drive B and then
prompts you to type a new volume label.

**Deleting Labels**

To delete a volume label, use the LABEL command without a name. When DOS
prompts you to type a new volume label, press ENTER. A message appears,
asking you to confirm deletion of the volume label. Type y to delete the label.

**Viewing Labels**

To view a disk's volume label and serial number, use the DIR or VOL command.
When you use the DIR command, the volume label and serial number for the disk
that you specify are displayed above the list of files.

The VOL command displays the volume label and serial number of the diskette in
the drive you specify (if the disk has no serial number, only the volume label is
displayed). For example, to view the volume label and serial number of the diskette
in drive A, type:

```
vol a:
```
Chapter 6. Partitioning Your Hard Disk

Each operating system has conventions for storing files on a hard disk. If you use only DOS, your entire hard disk can be set up to use DOS conventions. However, if you want to use another operating system in addition to DOS, you must partition your hard disk into DOS sections and non-DOS sections.

If you use only DOS, you can create a single DOS partition that occupies your entire disk. If you use only DOS and want to separate groups of directories, you can create a second DOS partition. When you use multiple partitions, DOS still has access to the entire hard disk. However, the files in the second partition appear to be on a different drive.

If you are going to use your hard disk with another operating system (for example, OS/2, which might be HPFS-formatted), you must create a partition for DOS and a partition for the other operating system. You use an operating system by making its partition active.

Partitioning your disk is different from formatting it. When you partition a disk, you specify which sections of the disk DOS or another operating system can use. When you format a disk, DOS prepares an existing partition to receive files. After partitioning your disk, you must still format each partition before it can be used. See “Formatting Your Hard Disk after Using FDISK” on page 94.

To create one or more DOS partitions on a hard disk, use the Fixed Disk Setup Program (FDISK) described in “Using FDISK” on page 83.

Understanding Hard-Disk Partitions

You can create two types of DOS partitions on a hard disk:

- The primary DOS partition is the area that stores the IBMBIO.COM, IBMDOCS.COM, and COMMAND.COM hidden files necessary to run DOS. The primary partition can contain other files as well. If you want to start DOS from a hard disk, that disk must have a primary DOS partition that is active.

- An extended DOS partition is an area where other non-system files can be stored on a disk. An extended partition is optional.
You can have up to a maximum of four partitions on a hard disk: one primary DOS partition, one extended partition, and some non-DOS partitions, such as Boot Manager or Novell. The extended partition can contain up to 23 logical drives. A logical drive is a section of a hard disk that serves as a separate disk drive. If you create a primary partition that does not occupy the entire hard disk, you can create an extended partition in the remaining space. In the extended partition, you can create logical drives.

**The Primary DOS Partition**

If you start DOS from a hard disk, the disk must have a primary DOS partition that contains the three DOS system files (IBMBIO.COM, IBMDOS.COM, and COMMAND.COM). This partition must be the active partition. In general, the primary DOS partition on the first hard disk is assigned the drive letter C.

You can reserve a portion of the disk space for the primary DOS partition. The rest of the disk space can be used for other partitions.

**The Extended DOS Partition**

When you create an extended DOS partition, you divide it into one or more logical drives. There are 26 letters available for logical drives (A through Z). Drives A and B are reserved for diskette drives. Drive C is reserved for the first primary DOS partition. Thus, there is a maximum of 23 logical drives that you can create in an extended DOS partition.

You can use logical drives to group your directories and files. Logical drives do not create more disk space, however.

For information about creating an extended DOS partition, see “Creating an Extended DOS Partition” on page 88.

**Non-DOS Partitions**

*Non-DOS partitions* are partitions for other operating systems (such as OS/2 HPFS). You cannot use the DOS version of the Fixed Disk Setup Program to create a non-DOS partition. For information about creating non-DOS partitions, see the documentation provided for your non-DOS operating system.
The Active Partition
To start your operating system from a hard disk, you must make the primary partition (in which the operating system is stored) the active partition. For example, to use DOS, make your primary DOS partition active. You can use a partition that is not designated as active, but you cannot start an operating system from that partition. The only way you can start an operating system from a partition not designated as active is if you run a multi-boot manager program, such as IBM OS/2 Boot Manager, which must be active.

A hard disk can have only one active partition at a time.

When you have only a primary DOS partition, it is the active partition. For more information about the active partition, see “Setting the Active Partition” on page 91.

Using FDISK
The FDISK program displays information about partitions, creates partitions and logical drives, sets the active partition, and deletes partitions and logical drives.

If your computer has never had an operating system installed on it, you can choose to have your disk partitioned during installation. Or, you can run FDISK at any time to partition a disk.

CAUTION:
FDISK destroys all existing files in partitions you modify. If you are using FDISK to change the partitions on a disk with files on it, be sure to back up the files you want to keep before you begin. If you want to create smaller partitions on a hard disk that has only a large DOS partition, you must first back up all files you want to save.

Running FDISK during DOS Installation
If DOS is the first operating system to be set up on your computer, you can choose to partition your disk when you run the Setup program. By default, the Setup program creates one primary DOS partition that occupies the entire disk. If you want to create more than one partition, select Allocate some free hard disk space for PC DOS during Setup. To partition the disk, follow the steps described in the subsequent sections of this chapter. When you finish creating partitions, DOS continues the Setup program. For more information about setting up DOS, refer to Chapter 1, “Installing” on page 3.
Running FDISK after DOS Has Been Installed

If you want to repartition your disk (at any other time than during PC DOS installation), type the following at the DOS command prompt:

    fdisk

When the Fixed Disk Setup Program starts, the main FDISK options menu appears, as follows:

    PC DOS Version 7.0
    Fixed Disk Setup Program
    Copyright (c) IBM Corporation 1983 - 1995

    FDISK Options

    Current fixed disk drive: 1

    Choose one of the following:

    1. Create DOS partition or Logical DOS Drive
    2. Set active partition
    3. Delete partition or Logical DOS Drive
    4. Display partition information
    5. Change current fixed disk drive

    Enter choice: [1]

    Press Esc to exit FDISK

CAUTION:
If you use FDISK to delete existing partitions on a hard disk, you lose the information contained in those partitions. Be sure you have copies of all files in a partition before using FDISK to delete the partition.

To choose a menu option, type the option number and then press ENTER. To return to a previous menu, press ESC. To quit FDISK, return to the options menu, and then press ESC.

Each menu displays a Current fixed disk drive message, followed by a number. If you have only one hard (fixed) disk drive, the number is always 1. If you have more than one hard disk drive, the number shows which drive FDISK is currently working with. The first hard disk drive in your system is 1, the second is 2, and so on. Changing the current drive when you are using FDISK does not change the current drive when you return to the DOS command prompt. The current drive refers only to physical disk drives, not logical drives, when you are using FDISK.
Viewing Partition Data

You can view information about the status, type, and size of the partitions on a hard disk by selecting Display partition information (option 4) from the FDISK options menu.

The Display Partition Information screen looks similar to this:

Display Partition Information

Current fixed disk drive: 1

<table>
<thead>
<tr>
<th>Partition</th>
<th>Status</th>
<th>Type</th>
<th>Volume Label</th>
<th>Mbytes</th>
<th>System</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:1</td>
<td>A</td>
<td>PRI DOS</td>
<td>PCDOS_7</td>
<td>21</td>
<td>FAT16</td>
<td>50%</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>EXT DOS</td>
<td></td>
<td>21</td>
<td></td>
<td>50%</td>
</tr>
</tbody>
</table>

Total disk space is 42 Mbytes (1 Mbyte = 1048576 bytes)

The Extended DOS partition contains Logical DOS Drives. Do you want to display logical drive information (Y/N)......? [Y]

Press Esc to return to FDISK options

The information displayed varies, depending on the number, size, and type of partitions on your hard disk.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition</td>
<td>Shows the drive letter associated with each partition and the disk number of each partition.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the letter A next to the active partition.</td>
</tr>
<tr>
<td>Type</td>
<td>Shows whether a partition is a primary DOS partition (PRI DOS), an extended DOS partition (EXT DOS), or a non-DOS partition (Non-DOS).</td>
</tr>
<tr>
<td>Volume Label</td>
<td>Shows the volume label of the primary partition, if one exists.</td>
</tr>
<tr>
<td>Mbytes</td>
<td>Shows the size of each partition, in megabytes.</td>
</tr>
<tr>
<td>System</td>
<td>Shows the type of file system being used on the partition.</td>
</tr>
<tr>
<td>Usage</td>
<td>Shows the percentage of the current disk that each partition occupies.</td>
</tr>
</tbody>
</table>

If there is an extended DOS partition that contains logical drives, a prompt appears, asking whether you want to see information about that partition's logical drives. Type Y if you want to view this information.
The screen displaying information about logical drives resembles this:

Display Logical DOS Drive Information

<table>
<thead>
<tr>
<th>Drv</th>
<th>Volume Label</th>
<th>Mbytes</th>
<th>System</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>D:</td>
<td>BACKUPA</td>
<td>18</td>
<td>FAT16</td>
<td>90%</td>
</tr>
<tr>
<td>E:</td>
<td>BACKUPB</td>
<td>2</td>
<td>FAT12</td>
<td>10%</td>
</tr>
</tbody>
</table>

Total Extended DOS Partition size is 20 Mbytes (1 Mbyte = 1048576 bytes)

Press Esc to continue

The information varies, depending on the number and size of the logical drives.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drv</td>
<td>Displays the drive letter of each logical drive.</td>
</tr>
<tr>
<td>Volume Label</td>
<td>Shows the label assigned to each drive.</td>
</tr>
<tr>
<td>Mbytes</td>
<td>Shows the size of each logical drive, in megabytes.</td>
</tr>
<tr>
<td>System</td>
<td>Shows the type of file system being used on that partition.</td>
</tr>
<tr>
<td>Usage</td>
<td>Shows the percentage of available space in the extended DOS partition that each logical drive occupies.</td>
</tr>
</tbody>
</table>

Creating a Primary DOS Partition

The hard disk you use to start DOS must have a primary DOS partition. You can create a primary DOS partition that occupies the entire hard disk or only part of it. If you want to create an extended DOS partition with logical drives or if you want to have space for a non-DOS partition, you must create a primary DOS partition that does not occupy your entire disk.

You cannot change the size of an existing primary DOS partition. If you want a primary DOS partition of a different size, you must delete the existing partition and create a new one. When you delete the existing partition, you lose any information stored there, so back up files you want to save. For information about deleting a partition, see “Deleting a Partition or Logical Drive” on page 92.

If your hard disk does not already have a partition, you can use the following procedure to create a primary DOS partition that occupies the entire disk.
To create a primary DOS partition that occupies the entire hard disk:

1. From the FDISK options menu, select Create DOS partition or Logical DOS Drive (option 1) and press ENTER.
   
   Another menu is displayed.

2. Select Create Primary DOS Partition (option 1) and press ENTER.

   Another prompt appears, displaying this message:
   
   Do you wish to use the maximum size for a Primary DOS Partition and make the partition active (Y/N).........? [Y]

3. Type Y

   If you type N, FDISK prompts you to create a smaller primary partition. See the next procedure for more information.

   FDISK creates a primary partition that takes up all the available space on the hard disk. If you have only one hard disk, DOS displays the following message:

   System will now restart

   Insert DOS system diskette into drive A:
   Press any key when ready

4. Insert the Setup Diskette from your PC DOS installation diskettes into drive A, and then press any key.

After partitioning the hard disk, you need to format it by using the FORMAT command with the /s switch. For more information, see “Formatting Your Hard Disk after Using FDISK” on page 94.

To create a primary DOS partition that occupies part of the hard disk:

1. From the FDISK options menu, select Create DOS partition or Logical DOS Drive (option 1) and press ENTER.

   Another menu is displayed.

2. Select Create Primary DOS Partition (option 1) and press ENTER.

   Another prompt appears, displaying this message:
   
   Do you wish to use the maximum available size for a Primary DOS Partition and make the partition active (Y/N).........? [Y]
3. Type N and another menu is displayed.

4. If you want the default size (100 percent), press ENTER.

   The following message is displayed:
   
   Primary DOS Partition created, drive letters changed or added.
   
   Otherwise, type the number of megabytes or the percentage of the disk to use. If you type a percentage, follow the number with a percent (%) sign.

   **Note:** When you create a primary DOS partition that does not occupy your entire hard disk, you must make the partition active before you can use the hard disk with DOS. For more information about making a partition active, see “Setting the Active Partition” on page 91.

5. To return to the FDISK options menu, press ESC.

When you quit FDISK, you need to format the new partition on your hard disk by using the FORMAT command with the /s switch. For more information, see “Formatting Your Hard Disk after Using FDISK” on page 94.

**Creating an Extended DOS Partition**

If you want to divide your hard disk into more than one DOS partition, you can create an extended DOS partition in addition to the primary DOS partition. Within the extended DOS partition, you typically can assign up to 23 logical drives. Logical drives are areas of your hard disk that DOS treats as separate disk drives. You must assign at least one logical drive to an extended DOS partition.

- **If you have one hard disk:**
  Before you can create an extended DOS partition, there must already be a primary DOS partition that uses only part of the disk.

- **If you have more than one hard disk:**
  Only the disk you use to start your system must have a primary DOS partition. Your other hard disk can contain only extended DOS partitions.

- **If you have more than one hard disk but are using only one partition per disk:**
  Set the one single partition as the primary partition.
To create an extended DOS partition:

1. From the FDISK options menu, select Create DOS partition or Logical DOS Drive (option 1).
   The Create DOS Partition or Logical DOS Drive menu appears.
2. From this menu, select Create Extended DOS Partition (option 2) and press ENTER.
   A menu is displayed showing the total number of megabytes available for an extended partition. The default for the partition size is the maximum available space on the hard disk drive, minus the size of the primary partition. If there is no space available, you must delete and re-create the primary DOS partition so it is smaller or reduce the size of any non-DOS partitions that exist.
3. If you want the default size, press ENTER. Otherwise, type the number of megabytes or the percentage of the unused disk space to be used for the extended DOS partition. If you type a percentage, follow the number with a percent (%) sign.
   The Create Logical Drive(s) screen in the Extended DOS Partition menu is displayed.

When you create an extended DOS partition, you can set up one or more logical drives. See the following section for more information.

**Note:** If FDISK finds defective tracks at the beginning of an extended DOS partition, it adjusts the partition boundaries to avoid those tracks.

**Creating Logical Drives in an Extended DOS Partition**
To store information in an extended DOS partition, you must create one or more logical drives. Each logical drive is assigned a drive letter. You can store to and retrieve information from a logical drive as though it were a physical disk drive. For example, you can use logical drive D to store files for a particular program, and you can work with those files by specifying drive D.
To create or modify a logical drive:

1. Create an extended DOS partition.
   See page 89 for information about how to create an extended DOS partition.

2. Using the Create Logical DOS Drive(s) menu, type the number of megabytes or the percentage of the partition space you want to use for the first logical drive. If you type a percentage, follow the number with a percent (%) sign. If you want one logical drive to occupy the whole extended DOS partition, press ENTER.

3. Continue specifying the sizes of partitions until you have used up the entire partition or until you have created all the logical drives you want.
   If the entire partition is assigned to logical drives, the FDISK options menu reappears. To quit the menu before all the space has been allocated, press ESC.

   After you create a logical drive, you must format it. For more information about formatting a logical drive, see "Formatting Your Hard Disk after Using FDISK" on page 94.

How Drive Letters Are Assigned
The primary DOS partition on your startup hard disk is drive C. The drive letters of additional hard disks and logical drives depend on the number of disks you are using and how they are partitioned.

If you have only one hard disk, logical drives you create in the extended DOS partition are given letters beginning with D. For example, if you create five logical drives in the extended DOS partition, they are named D, E, F, G, and H.

If your system has more than one hard disk and you have only one primary DOS partition, all logical drives you create in the extended DOS partitions are assigned drive letters consecutively.

Suppose your system has two hard disks. The first has a primary DOS partition and an extended DOS partition with two logical drives, and the second hard disk has an extended partition with two logical drives. The primary DOS partition on the first disk is drive C; the two logical drives on the disk are drives D and E. The two logical drives on the second disk are drives F and G.

You might have primary DOS partitions on more than one hard disk. If so, DOS assigns drive letters consecutively to all the primary DOS partitions first and then assigns drive letters consecutively to the logical drives in the extended DOS partitions.
Substituting Drive Letters

Some programs accept only drive letters A and B. In these cases, you can use the SUBST (substitute) command, which temporarily substitutes a drive letter with another drive letter and path. While a substitution is in effect, DOS regards any reference to drive A or B as a reference to a directory on your hard disk.

For example, suppose you are using a communications program that accepts only files from drive A. To substitute the drive letter A for the \COMM directory on drive C, you would type the following command before starting the program:

```
subst a: c:\comm
```

Then, when the program requests files from drive A, DOS looks in C:\COMM instead.

The drive letter you specify in the SUBST command must not be greater (in alphabetic order) than the last drive being used on your computer or the letter specified in the LASTDRIVE command in your CONFIG.SYS file.

Type `help lastdrive` for more information about the LASTDRIVE command. The online *PC DOS 7 Command Reference* is opened to the LASTDRIVE command.

When you finish using the program, remove the association between the drive and the directory by using the `/d` switch:

```
subst a: /d
```

The following commands ignore any substitutions you make when using the SUBST command: FORMAT, CHKDSK, DISKCOMP, DISKCOPY, FDISK, LABEL, RESTORE, and SYS.

Setting the Active Partition

The active partition contains the operating system that is loaded when you start or reset your system. Unless you create a primary DOS partition that occupies your entire hard disk, you must set the active partition by using FDISK. If you are using a non-DOS partition, you must reset the active partition when you want to switch between DOS and the non-DOS operating system. Only one partition can be active at a time.
To set the active partition:

1. From the FDISK options menu, select Set Active Partition (option 2).

   A menu is displayed that indicates the status of each partition. The active partition is designated by the letter A in the Status column.

2. Type the number of the partition you want to make active. The default setting is the current active partition number.

3. To return to the FDISK options menu, press ESC.

You can make only primary partitions active. If you try to make an extended DOS partition active, FDISK displays a message similar to the following:

   Partition selected (3) is not startable, active partition not changed.

Deleting a Partition or Logical Drive
You might need to change the size of your partitions. You cannot reduce or enlarge an existing partition. If you want to change a partition's size, you must delete the partition and re-create it.

When you delete a partition, all information in the partition is deleted and cannot be recovered. Therefore, be sure you have backup copies of the information you want to save. When you delete a partition, you do not lose information stored in other partitions on your disk. For example, if you delete the extended DOS partition but not the primary DOS partition, files in the primary DOS partition are not deleted.

If you want to delete the primary DOS partition on a disk, first delete each logical drive in the extended partition, and then delete the extended partition itself.

You can delete one or more logical drives in the extended DOS partition of a hard disk. All information on a logical drive is lost when you delete it. Deleting one logical drive does not affect the information on other logical drives.

If there are logical drives that have drive letters greater (in alphabetic order) than the drive you delete, these letters will change. Suppose, for example, that you have logical drives D, E, and F on a disk. If you delete drive D, drive E becomes drive D, and drive F becomes drive E.

Note: To continue using DOS after you delete the primary DOS partition, you must restart your system, using the Setup Diskette from your PC DOS installation diskettes into drive A.
To delete a partition or logical DOS drive:

1. From the FDISK options menu, select Delete partition or Logical DOS Drive (option 3).
   
   Another menu is displayed.

2. Type the number of the option you want.
   
   FDISK displays the status of the partition or logical drives, along with a message warning that the data in the partition or logical drive will be lost.

3. Type the number that corresponds with the drive letter and then type the volume label of the logical drive you want to delete.
   
   FDISK displays a message confirming the information you typed.

4. Type Y to delete the partition or drive.

If you deleted your primary DOS partition, you need to create a new one before you can use DOS from your hard disk.

To create a new primary DOS partition before you quit the Fixed Disk Setup Program:

1. From the FDISK options menu, select Create DOS partition or Logical DOS Drive (option 1).
   
   Another menu appears.

2. Follow the instructions in the preceding sections to create a DOS partition that occupies either your entire hard disk or only part of it.
   
   When FDISK is finished, a prompt appears.

3. Insert the Setup Diskette from your PC DOS installation diskettes into drive A and press any key to restart your system.

4. Format the new partition by using the FORMAT command with the /s switch.

5. Remove the Setup Diskette from drive A and restart your system.

At this point, your hard disk contains the DOS files IBMBIO.COM, IBMDOS.COM, and COMMAND.COM.
Working with More Than One Hard Disk

If your system has more than one hard disk drive, you can use FDISK to create and modify partitions on any drive. The first physical disk must have a primary DOS partition. Your other disks can have primary DOS partitions or extended DOS partitions, or both. On most computers with multiple hard disks, only drive C can be used to start the operating system.

When you start FDISK, you work with the first hard disk on your system. To work with a different disk drive, you must select Change current fixed disk drive (option 5) from the FDISK options menu and specify the number of the drive you want to work with. If you have only one hard disk drive, the Change Current Fixed Disk Drive option is not displayed on the FDISK options menu.

Formatting Your Hard Disk after Using FDISK

When you quit FDISK after you change the size of any of the DOS partitions on your hard disk, this message is displayed:

System will now restart

If you changed the size of your primary DOS partition, FDISK prompts you to insert the DOS system diskette (the Setup Diskette from your PC DOS installation diskettes) into drive A and press any key. You then return to the DOS command prompt.

After using FDISK, you must use the FORMAT command to prepare any partition that you create or change. If you do not format the disk, DOS gives you the following error message when you try to use the hard disk:

Invalid media type

If you are formatting the primary DOS partition of the hard disk from which you will start your system, be sure to transfer the DOS system files from a diskette by using the FORMAT command with the /s switch or by using the SYS command after you format.

When you format your hard disk, you must format each new partition separately. For example, if you made your primary DOS partition (drive C) smaller and created two logical drives in an extended DOS partition (drives D and E), you must use the FORMAT command three times:

format c: /s
format d:
format e:
The first command formats the primary partition and transfers the DOS system files from the startup disk to that partition. The second and third commands format the logical drives.

**CAUTION:**
If you made changes to some but not all of the partitions or logical drives on your system, be careful when you format the partitions or drives you changed. Because FDISK can assign different letters to drives after you change partitions or logical drives, you might inadvertently format a drive that has information stored on it.

Before you format a drive, you can use the CHKDSK command to check the contents of the drive. If you see the message Probable non-DOS disk or Invalid media type before the disk information is displayed, the drive is not formatted. If the disk information is displayed without this message, the drive is formatted.

You might want to give a descriptive label to each logical drive you create so that you know what information is on it when you make changes to your system. You can do this by using the \(/v\) switch when you use the FORMAT command.

For more information, see “Considerations for Formatting Disks” on page 75.
Chapter 7. Working with Batch Programs

As you work with DOS, you might find yourself repeatedly typing identical sequences of commands. For example, you might often type the same three commands to change the current drive, change the current directory, and then start a program. By using DOS, you can store commands in a batch program or batch file. Instead of typing commands individually, you need only type the name of the batch program. DOS carries out this "batch" of commands as if you had typed the commands individually from the keyboard.

A batch program is an unformatted text file that contains one or more DOS commands. For example, a batch program might contain the commands you use to change your directory and start a text editor, such as the E Editor.

Suppose you are copying files to a diskette by using the following commands:

```
cd\work\docfiles
copy *.txt a:
cd\reports\xfiles
copy *.txt a:
```

To put these four commands into a batch program, store them in an unformatted text file and assign the file a .BAT extension. Each time you want to copy these files, type the name of the batch program at the DOS command prompt.

Using batch programs gives you the following advantages:

- Batch programs speed up your work. When you run a batch program, you only have to remember one command, instead of several. You do not have to retype multiple commands or look up commands you cannot remember.

- Batch programs customize DOS. Using batch programs, you can create personalized commands that perform the exact task you need. You can also design your own prompts and messages.
Understanding Batch Program Commands

Any DOS command you use at the DOS command prompt or run from the PC DOS Shell can also be put in a batch program. In addition, there are DOS commands that are specially designed for batch programs. The commands and their functions are as follows:

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CALL</td>
<td>Runs a second batch program and then returns to the first one.</td>
</tr>
<tr>
<td>CHOICE</td>
<td>Prompts you to choose from a set of choices, waits until you choose by pressing a key, and beeps if you select a key that is not among the available choices.</td>
</tr>
<tr>
<td>ECHO</td>
<td>Displays messages on your screen or turns the ECHO feature on or off.</td>
</tr>
<tr>
<td>FOR</td>
<td>Carries out a command for a group of files or directories.</td>
</tr>
<tr>
<td>GOTO</td>
<td>Switches to commands in another part of your batch program and continues processing the commands from that point.</td>
</tr>
<tr>
<td>IF</td>
<td>Carries out a command, based on the result of a condition.</td>
</tr>
<tr>
<td>PAUSE</td>
<td>Temporarily stops your batch program from running; your program starts running again when you press any key.</td>
</tr>
<tr>
<td>REM</td>
<td>Annotates your batch program so that you can remember what each part of the program does.</td>
</tr>
<tr>
<td>SHIFT</td>
<td>Changes the position of replaceable parameters.</td>
</tr>
<tr>
<td>@</td>
<td>Is placed in front of a command in your batch program and prevents the single command from being displayed.</td>
</tr>
</tbody>
</table>

The CALL, ECHO, GOTO, IF, PAUSE, and REM commands are explained further in this chapter.

For information about the remaining commands (FOR, CHOICE, and SHIFT), refer to the online PC DOS 7 Command Reference, or type the command name followed by /? for the abbreviated online help.
Creating a Batch Program

You can create a batch program by using the E Editor or the COPY command. When you use a text editor other than the E Editor to create a batch program, save your files as unformatted (ASCII) text. Most text editors have an option for saving files this way. For information about the E Editor, see Chapter 10, “Working with the Text Editor” on page 131.

When you are creating a small batch program, it might be more convenient to use the COPY command, which is described on page 102.

Naming a Batch Program

A batch program must have a .BAT file-name extension. It is generally not a good idea to give a batch program the same name as an existing DOS command. Suppose, for example, that you create a batch program for a customized formatting command and name it FORMAT.BAT. The program does not run if DOS finds the FORMAT.COM file before it finds FORMAT.BAT, because DOS gives precedence to files with .COM and .EXE extensions.

You can avoid this problem by using a name that is not already assigned to a DOS command. For example, you might name the program MYFMT.BAT.

Running a Batch Program

To run a batch program, you type its name without the extension. For example, if you had a file named FILES.BAT in your current directory, type the following command to run the batch program:

```
files
```

When the batch program has parameters, add a space after the file name. For example, when the FILES.BAT program requires a file specification as a parameter, type a command like this:

```
files c:\reports\data
```

By default, DOS displays each command in a batch program as the command is carried out. After the batch program runs, DOS might display two DOS command prompts because it treats the end-of-file character in a batch program as a new line.
Stopping a Batch Program

When you want to stop a batch program before all of its commands have run, press CTRL+C or CTRL+BREAK (more than once, if necessary). You get a message asking to confirm that you want to stop the batch program.

Type y to stop the program or n to continue with the next command. You can temporarily stop a batch program by pressing CTRL+S or the PAUSE key. This "freezes" the screen until you press another key.

When your batch program is on a diskette and you remove the diskette while the program is running, DOS displays the following message:

Not ready reading drive A
Abort, Retry, Fail?

Re-insert the diskette, and type the letter r to continue running the batch program.

Making a Small Batch Program

You can use the E Editor provided with DOS to create a batch program. When there are more than a few lines in your batch program, it is a good idea to use a text editor to create the file.

Suppose, for example, you want to create a batch program that formats a 360K diskette in your high-density diskette drive. To create the program and name it MYFMT.BAT, use the following E command:

```plaintext
e c:\myfmt.bat
```

At this point, the file is empty and the cursor is placed where you can add the FORMAT command to the file. Type the following:

```plaintext
format a: /f:360
```

Now you are ready to close the file and return to the DOS command prompt. You do so by pressing F4.

After you have created the batch program, you need only type the name of the batch program to format a 360K diskette in your high-density diskette drive, as follows:

```plaintext
myfmt
```

DOS displays the FORMAT command on the screen, and then prompts you to insert a diskette into drive A. Make sure the directory that contains this batch program is either current or in the directory search path.
Testing a Batch Program

It is generally best to create a large batch program in stages. This ensures that one part of the batch program works before you create another part.

When you run a batch program that contains a command that is not valid, DOS cancels that command and proceeds to the next. If the batch program is set up to display commands as they are carried out, you will see an error message when a command is not valid. If commands are not displayed, the batch program will contain an ECHO OFF command. Remove any ECHO OFF commands if you want commands to be displayed along with the error messages.

Displaying Messages with a Batch Program

You can include messages in a batch program to prompt you for additional information or to remind you of a particular task that the batch program does.

When you want DOS to display a message on your screen, use the ECHO command. For example, to display the message Put a diskette into drive A, you would use the following command:

`echo Put a diskette into drive A`

**Tip:** On networks, your message is displayed quicker when you put it in a .TXT file and then use the TYPE command in your batch program to display the message.

DOS displays this message on the screen. When you want the message shifted to the right a certain number of spaces, you must include the spaces as part of the message. For example, to center the message on your screen, add the necessary spaces in the command, as follows:

`echo Put a diskette into drive A`

When you want to skip a line, type ECHO followed by a period:

`echo .`

When ECHO is on, DOS displays batch commands at the command prompt as it carries them out. Therefore, the message in the preceding example (Put a diskette into drive A) is displayed twice: first at the command prompt as part of the batch command and then as a prompt to carry out the command itself. To suppress commands that appear at the command prompt and display a message only once, use the following command:

`echo off`

Make this command the first line of your program.
To prevent a single command in your batch program from being displayed, put an at sign (@) in front of it. For example, to prevent the display of the ECHO OFF command, type:

@echo off

When you want commands to be displayed, use this command at the beginning of the program:

echo on

---

**Using the PAUSE Command**

To momentarily stop a batch program at a predetermined command or print task, use the PAUSE command in the batch program, as follows:

```
pause
```

When DOS finds a PAUSE command in a batch program, it displays the following message:

```
Press any key to continue...
```

DOS stops running the program until you press any key (except the PAUSE key).

For example, adding a PAUSE command to the following COPYIT.BAT program stops the program from running while you put a diskette into drive A.

```
echo off
echo Put a diskette into drive A then
pause
copy c:\work\may\*.txt a:
copy c:\reports\may\*.doc a:
cls
echo Here are the files you copied:
```

echo.

dir a: /p

When this batch program pauses, DOS displays the following:

```
Put a diskette into drive A then
Press any key to continue...
```
Including Remarks in a Batch Program

When your batch program is longer than a few lines, it is helpful to include remarks. You can use remarks to comment on the commands in a batch program and to make the program easier to read by separating it into sections.

You add a remark by typing `rem` followed by a space and the comment you want to include, as in this example:

```plaintext
rem This part of the batch program copies files to a diskette.
```

**Note:** Ensure that the ECHO command is turned off before using the REM command.

After you type `rem` and a space, DOS ignores any other text on the line. Therefore, you can type any character you want on the remark line or leave it blank with the exception of the following character symbols that have special meanings for COMMAND.COM:

- less-than (`<`)
- greater-than (`>`)
- pipe (`|`)

For example, the following remarks divide and explain sections of COPYIT.BAT:

```plaintext
rem *****Copy of the MAY subdirectories*****
rem
echo off
echo Put a diskette into drive A then
pause
copy c:\work\may\*.txt a:
copy c:\reports\may\*.doc a:
rem
rem Clear the screen and display the files that were copied
rem
cls
echo Here are the files you copied:
echo.
dir a: /p
```

Remarks do not affect the way a batch program runs; they simply annotate the commands for anyone who reads the file.
Running One Batch Program from Another

You can run a batch program from another batch program by including just the name of the program you want to start or by including the CALL command with the name of the program. If you type only the name, the original batch program quits running, and the new batch program runs.

For example, the following batch program runs four commands and then starts a batch program named NEXTONE:

```
a:
cd\tmp
copy c:\*.sys a:
cd\perm
nextone
```

When NEXTONE finishes running, DOS displays the command prompt.

If you want to return to the original batch program after running the other batch program, use a CALL command with the name of the program you want to start. When the second batch program finishes running, DOS returns to the original batch program and carries out the next command.

For example, the following batch program carries out two commands, starts NEXTONE, and then carries out two more commands when NEXTONE finishes running:

```
a:
cd\tmp
call nextone
copy c:\*.sys a:
cd\perm
```
Using Replaceable Parameters

DOS includes symbols called *replaceable parameters*, numbered %0 through %9. You can include replaceable parameters in a batch program. When you run the batch program, DOS replaces the symbol with the parameter you include when you type the batch command.

The %0 replaceable parameter substitutes for the name of the batch command as it is typed at the DOS command prompt.

Replaceable parameters %1 through %9 substitute for command-line parameters typed after the batch-command name. The first parameter on the command line is %1, the second is %2, and so on. If you want to specify more than nine parameters, use the SHIFT command.

Type `help shift` for information about the SHIFT command.

Suppose you created a batch program (COPYIT.BAT) that moved data from one subdirectory to another. After the creation of the batch program, you could use the replaceable parameter feature to accomplish this task. The following example illustrates this:

```
copyit %1 %2
```

This batch program in COPYIT.BAT is set up to move all information from the first parameter %1 to the second parameter %2. If you wanted to move all information from subdirectory c:\april\*.* to drive A using the replaceable parameters, type the following at the DOS command prompt:

```
copyit c:\april\*.* a:
```

DOS replaces %1 with c:\april\*.* and %2 with a:

**Note:** If you use the percent sign (%) as part of a file name or string within a batch program, you must type it twice. The first occurrence indicates that the second % is part of a name, rather than a replaceable parameter.

In addition to replaceable parameters, you can use environment variables in a batch program. Type `help set` for information about environment variables and an example of how to use one in a batch program.
Controlling Program Flow

To increase the flexibility of a batch program, you can use the IF command to carry out different commands under different conditions and use the GOTO command to switch to different parts of the program. By using replaceable parameters with IF and GOTO commands in a batch program, you can perform complex tasks.

Using the IF Command

You can use the IF command to specify a condition that must be true for a command to be carried out. For example, suppose you want to create a batch program named RUNIT.BAT that starts your chess program, CMATE, when you type the following command:

runit A

To perform this task, include the following IF command in RUNIT.BAT:

```bash
if "%1"=="A" cmate
```

The double equal sign (==) means the parameter must equal the value. When DOS carries out this command, it checks to see whether or not %1 is an A. If %1 is an A, DOS carries out the command that follows (in this case, it starts the CMATE program). When you quit CMATE, DOS carries out the command on the next line of RUNIT.BAT.

If %1 is not an A, DOS skips the command that runs CMATE and moves to the next line of the batch program. Both the parameter and the letter with which it is compared should be enclosed in quotation marks to avoid syntax errors when no parameter is present.

Using the GOTO Command

The GOTO command directs your program to switch to another part of the program and continue processing the commands at that point. The line that the program is to switch to is marked with a label preceded by a colon (:). The same label appears in the GOTO command, as in the following example:

```bash
goto skipdown
echo both of these echo commands
echo will be skipped
:skipdown
cls
```
Using the IF and GOTO Commands Together

If you use the GOTO command with an IF command, you can run different sections of a batch program under different conditions. For example, when you are at the command line about to run the batch file, the following command directs DOS to switch to the line labeled chess if you type an uppercase A:

```
if "%1"=="A" goto chess
```

Using a series of IF commands, you can create a batch program that can run several programs. For example, the following batch program changes to the C:\GAMES\CHESS directory and runs the CMATE program if you type an uppercase A; it also changes to the C:\GAMES\CHECK directory and runs the CHECKERS program if you type anything but an uppercase A.

```
if "%1"=="A" goto chess
rem
rem***********************************************************************
rem If the user doesn't type A, run Checkers.
rem
rem cd\games\check
checkers
rem Checkers game has finished running to the end of this batch file
rem Skip over Chess by jumping to the line labeled :end.
goto end
rem
rem
rem***********************************************************************
rem If DOS jumps to this label, the user wants Chess.
rem
:chess
cd\games\chess
cmate
rem The following line marks the end of the batch program.
:end
```
Chapter 8. Redirecting Input and Output

Redirection characters let you perform many useful tasks. A *redirection character* changes the place that a command gets information from or sends information to. Redirection characters are useful when you want DOS to save information in a file rather than display it on your screen. You can also use a *filter command* to redirect information that a command typically would send to the screen. Filter commands help you sort, view, and select parts of the output of a command.

Redirecting Command Input and Output

Unless you specify otherwise, DOS receives input from your keyboard and sends output to your screen. Sometimes it is useful to redirect the input or output to a file or a printer. For example, you might want to redirect a directory listing from the screen to a file.

To redirect the input or output of a command, use one of the following redirection characters:

- The greater-than sign (>) sends the output of a command to a file or a device, such as a printer.
- The less-than sign (<) takes the input needed for a command from a file rather than from the keyboard.
- The double greater-than sign (>>) adds output from a command to the end of a file without deleting the information already in the file.

Redirecting the Output of a Command

Almost all commands send output to your screen. Even commands that send output to a drive or printer also display messages and prompts on your screen.

To redirect the output from the screen to a file or printer, use the greater-than sign (>). You can use the greater-than sign with most DOS commands. For example, in the following command, the directory listing produced by the DIR command is redirected to the DIRLIST.TXT file:

```
dir > dirlist.txt
```

If the DIRLIST.TXT file does not exist, DOS creates it. If DIRLIST.TXT exists, DOS replaces the information in the file with the output from the DIR command.
The following command creates a file named CHECKDSK.TXT, which contains the output of the CHKDSK command:

```
chkdsk a: > checkdsk.txt
```

If CHECKDSK.TXT already exists, DOS replaces its contents with the output that the CHKDSK command usually sends to your screen.

To add the output from a command to the end of a file without losing any of the information already in the file, use a double greater-than sign (>>). For example, in the following command, the directory listing produced by the DIR command is appended to the DIRLIST.TXT file:

```
dir >> dirlist.txt
```

To send the output of a command to a printer, use the greater-than sign with the name of the port to which the printer is connected. For example, the following command redirects the output of the DIR command from the screen to the printer attached to the LPT1 port:

```
dir > lpt1
```

**Note:** Some command output, such as error messages, cannot be redirected when using the greater-than sign (>).

### Redirecting the Input to a Command

Just as you can send the output of a command to a file or printer rather than to your screen, you can take the input for a command from a file rather than from the keyboard. To take input from a file, use the less-than sign (<). For example, the following command takes the input for the SORT command from the LIST.TXT file:

```
sort < list.txt
```

DOS alphabetizes the lines of the LIST.TXT file and displays the result on your screen.

For more information about the SORT command, see "Sorting Text Files" on page 112.
Passing Information through Filter Commands

Filter commands divide, rearrange, or extract portions of the information that passes through them. DOS has three filter commands:

- The MORE command displays the contents of a file or the output of a command one screen at a time.
- The FIND command searches through files and command output for the characters you specify.
- The SORT command alphabetizes files and command output.

To send input from a file to a filter command, use the less-than sign (<). If you want the filter command to get its input from another command, use the pipe (|).

Before using the pipe, you should set a TEMP environment variable. For information about setting environment variables using the SET command, type help set at the DOS command prompt.

Controlling the Screen Display by Using the MORE Command

The MORE command displays the contents of a file or the output of a command one screen at a time. For example, the following MORE command displays the contents of the LIST.TXT file one screen at a time:

```
more < list.txt
```

After a screen of information is displayed, you see the word More appear. To continue to the next screen, press any key. To stop the command without viewing more information, press CTRL+C.

The MORE command is helpful if you are working with a command that produces more than one screen of output. For example, suppose you want to view a directory tree for your hard disk. If you have more directories than DOS can display on the screen, you can use the TREE command with a pipe (|) and a MORE command as in the following example:

```
tree c:\ | more
```

The first screen of output from the TREE command is displayed, followed by the word More. DOS pauses until you press any key (except the PAUSE key).
Searching for Text by Using the FIND Command

The FIND command searches one or more files for the text you specify. DOS displays every line containing that text. The FIND command can be used as a filter command or as a standard DOS command.

For information about the FIND command as a standard DOS command, type help find at the DOS command prompt.

To use FIND as a filter command, include a less-than sign (<) and a file name to search through. The search is case-sensitive. For example, the following command finds occurrences of the string Pacific Rim in the file TRADE.TXT:

```shell
find "Pacific Rim" < trade.txt
```

To save the output of the FIND command rather than display it, use a greater-than sign (>) and the name of the file that is to store the output. For example, the following command finds occurrences of Pacific Rim in the TRADE.TXT file and saves them in the NWTRADE.TXT file:

```shell
find "Pacific Rim" < trade.txt > nwtrade.txt
```

To print the output rather than display it, use a greater-than sign and the name of the port your printer is attached to, as in the following command:

```shell
find "Pacific Rim" < trade.txt > LPT1
```

Sorting Text Files

The SORT command alphabetizes a text file or the output of a command. For example, you would use the following command to sort the contents of a file named LIST.TXT and display the results on your screen:

```shell
sort < list.txt
```

In this example, the SORT command sorts the lines of the LIST.TXT file and displays the results without changing the file. To save the output of the SORT command rather than display it, include a greater-than sign (>) and a file name in the command. For example, you would use the following command to alphabetize the lines of the LIST.TXT file and store the results in the ALPHLIST.TXT file:

```shell
sort < list.txt > alphlist.txt
```
To sort the output of a command, type the command followed by a pipe (|) and the SORT command. For example, the following command sorts the output of the FIND command:

\[
\text{find } "\text{Jones}\" \text{ maillst.txt } | \text{ sort}
\]

When you type this command, DOS lists in alphabetical order the lines in which the string Jones appears.

You can use the SORT command on files that are 64K or less in size. Type \texttt{help sort} for more information about the SORT command.

**Combining Commands with Redirection Characters**

You can combine filter commands, other commands, and file names to make custom commands. For example, you might use the following command to store the names of files that contain the LOG string:

\[
\text{dir } /b | \text{ find } "\text{LOG}\" > \text{ loglist.txt}
\]

DOS sends the output of the DIR command through the FIND filter command and stores the file names that contain the LOG string in the LOGLIST.TXT file. The results are stored as a list of file names (for example, A.LOG, LOGDAT.SVD, and MYLOG.BAT).

To use more than one filter in the same command, separate the filters with a pipe (|). The following command would search every directory on drive C, find the file names that include the string LOG and display them one screen at a time:

\[
\text{dir c: } /s /b | \text{ find } "\text{LOG}\" | \text{ more}
\]

Because you use a pipe (|), DOS sends the output of the DIR command through the FIND command. The FIND command selects only file names that contain the LOG string. The MORE command displays the file names that are selected by the FIND command—one screen at a time.
Chapter 9. Using DOSKey and Editing Keys

You can use editing keys to quickly view and edit your last command rather than retype it. In addition, you can use the DOSKey program to do your editing. The DOSKEY command-line statement has been added automatically by the PC DOS Setup program to your AUTOEXEC.BAT file. This program is loaded and ready to use every time you start your computer. The DOSKey program includes the DOS editing keys plus a number of other keys that are useful for editing commands.

Using the DOSKey program, you can also:

- Store the commands you use over and over again so that you do not have to retype them to use them.
- Create macros that contain a series of commands. A macro runs much like a batch program.

Using DOSKey to Work with Commands

You can use the DOSKey program to view, edit, and carry out DOS commands that you have used previously. DOSKey includes the DOS editing keys and other keys that make it easy for you to use previous commands. When using DOSKey, you can type several commands on one line.

In addition, you can create, run, and save command macros. A macro is one or more DOS commands that are stored in random-access memory (RAM). It runs much like a batch program. The first time you use DOSKey, it is loaded into RAM. Thereafter, DOS saves your previous commands and any macros you create.

Although you have more editing power with DOSKey than you do with DOS editing keys, DOSKey takes up a small amount of your computer's memory. If you need the maximum amount of memory for other purposes, you might want to use DOS editing keys instead of DOSKey.

Loading DOSKey Into Memory

To load the DOSKey program into memory, type the following at the DOS command prompt:

doskey
Unless you indicate otherwise, DOS reserves 512 bytes of memory for the commands and macros you record. If your average command contains 15 characters, you can store or have the ability to recall about 35 commands with the amount of memory reserved. The resident portion of the DOSKey program itself occupies about 4K of memory.

**Note:** If you are running HIMEM.SYS, DOSkey occupies about 1K of memory.

If you want to reserve more or less memory, you can include the `/bufsize=` switch in the command. For example, to reserve 300 bytes of memory for recorded commands, type:

```
  doskey /bufsize=300
```

As the memory you reserved for DOSKey is used up, the oldest commands are removed so that the new ones can be stored in the buffer. You can clear the buffer by pressing ALT+F7.

**Typing More Than One Command on a Line**

Typically, you type one command per line. After you install DOSKey, you can type several commands on a line. You separate each command by pressing CTRL+T. A paragraph mark (~) appears on your screen each time you press CTRL+T. You can type as many commands as you like on one line as long as the total line length does not exceed 127 characters.

For example, to delete all the files in the \TMP directory and then remove the directory, type the following two commands on the same line:

```
  del \tmp\*.* ~ rd \tmp
```

The DEL command is initiated and you are prompted to confirm the deletion. Then the second command is initiated.

**Viewing Previous Commands**

When DOSKey is loaded, it keeps a list of your commands as you type them. You can use the following keys to view previous commands. To carry out a command again after it is displayed, press ENTER.
Editing Key | Command Carried Out
---|---
UP ARROW | Displays the previous command in the list.
DOWN ARROW | Displays the next command in the list.
F7 | Displays the list of commands DOSKey has stored.
F8 | Cycles through the stored commands that start with the characters you specify. (You type the search text and then press F8).
F9 | Prompts you to type the number of the stored command you want. To see the numbered list of commands, press F7.
PAGE UP | Displays the oldest command in the list.
PAGE DOWN | Displays the newest command in the list.
ESC | Clears the command from the screen.

**Viewing the List of Stored Commands**

DOSKey displays a numbered list of the commands it saves. For example, suppose you type the following three commands after you load DOSKey:

```plaintext
copy c:\work\*.txt c:\revised
dir c:\revised\*.txt
dir c:\work\*.txt
```

DOSKey saves the three commands. To view the full list of commands, press F7. A numbered list of the commands appears:

1: copy c:\work\*.txt c:\revised
2: dir c:\revised\*.txt
3: dir c:\work\*.txt

If there are more commands in the list than can fit on one screen, DOSKey pauses after each screen of commands. To see the next screen of commands in the list, press any key except PAUSE.

**Viewing the Previous or Next Command**

The first time you press the UP ARROW key, DOSKey displays the most recent command. You can reuse the command by pressing ENTER.

If you press the UP ARROW key more than once, DOSKey displays commands further back in the list. To move backward in the list and view the next most recent command, press the UP ARROW key again. Continue this process to move backward in the list of commands.

To move forward in the list, press the DOWN ARROW key.
Viewing the First or Last Command
To view the most recent command, press PAGE DOWN. To view the oldest command, press PAGE UP.

Viewing Other Commands in the List
You can use F9 or F8 to view a specific command in the list. Suppose DOSKey has saved the following list of commands:

1: a:
2: dir
3: c:\myuts\figdsk a: time=30 space=35.8
4: dir
5: del *.tmp

If you want to view command number 3, you can use the arrow keys or press F9. When you press F9, the following appears:

Line number:

To view line 3, type 3 and then press ENTER.

You can also use F8 to view a command that begins with letters you specify. For example, to view a command that begins with C:\, type C:\ at the DOS command prompt and then press F8.

When you press F8, DOSKey displays the most recent command that begins with the characters you typed. You can press F8 again to view the next command in the list that begins with the characters you typed. Keep pressing F8 to cycle through all the matching commands. If DOSKey does not find a matching command in the list, nothing happens.

Editing and Using Previous Commands
As you type a new command or after you view a previous command, you can use editing keys to change it. You can use the same editing keys with DOSKey that you use with the command template. When you use some of these keys with DOSKey, however, you see slightly different results. DOSKey provides a number of additional editing keys that make it easy to change a previously typed command. The editing keys affect only the displayed command; they do not change any commands that DOSKey has already stored.
You can use the following editing movement keys with DOSKey:

<table>
<thead>
<tr>
<th>Editing Key</th>
<th>Movement Carried Out</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOME</td>
<td>Moves the cursor to the beginning of the displayed command.</td>
</tr>
<tr>
<td>END</td>
<td>Moves the cursor to the end of the displayed command.</td>
</tr>
<tr>
<td>LEFT ARROW</td>
<td>Moves the cursor back one character in the displayed command.</td>
</tr>
<tr>
<td>RIGHT ARROW</td>
<td>Moves the cursor forward one character in the displayed command.</td>
</tr>
<tr>
<td>CTRL+LEFT ARROW</td>
<td>Moves the cursor back one word in the displayed command.</td>
</tr>
<tr>
<td>CTRL+RIGHT ARROW</td>
<td>Moves the cursor forward one word in the displayed command.</td>
</tr>
<tr>
<td>BACKSPACE</td>
<td>Deletes the character before the cursor on the current command line, without affecting the template.</td>
</tr>
<tr>
<td>DEL</td>
<td>Deletes the character at the cursor.</td>
</tr>
<tr>
<td>CTRL+END</td>
<td>Deletes all characters from the cursor to the end of the line.</td>
</tr>
<tr>
<td>CTRL+HOME</td>
<td>Deletes all characters from the cursor to the beginning of the line.</td>
</tr>
<tr>
<td>INSERT</td>
<td>Toggles between insert mode and replace mode.</td>
</tr>
<tr>
<td>ESC</td>
<td>Clears the displayed command from the screen.</td>
</tr>
</tbody>
</table>

If you hold down CTRL while you press the RIGHT ARROW or LEFT ARROW key, the cursor moves to the beginning of the next or previous word. A word in this case is a group of characters separated from other characters by a space. For example, the following command has three words:

    copy c:\games\suzz.exe a:

If the cursor is at the end of the line, as in this example, you can move it to the “C” in C:\GAMES\SUZZ.EXE by pressing CTRL+LEFT ARROW twice.

With the cursor anywhere in the word C:\GAMES\SUZZ.EXE, you can move the cursor to the beginning of the next word by pressing CTRL+RIGHT ARROW. If you press CTRL+RIGHT ARROW again, the cursor moves to the end of the line.

By pressing the INSERT key, you can add characters at the position of the cursor. The INSERT key toggles between insert and replace mode. In replace mode, new characters you type replace any characters that follow the cursor. After you press the INSERT key, you switch to insert mode; the character at the cursor position and the characters following the cursor move right as you type. For example, suppose the following line is displayed, and the cursor is under the S in SUZZ.EXE:

    copy c:\games\suzz.exe a:
To change the line so that C:\GAMES\SUZZ.EXE becomes C:\GAMES\NEW\SUZZ.EXE, you press the INSERT key and type new\. The line now appears like this:

    copy c:\games\new\suzz.exe a:

To turn off insert mode, press the INSERT key again. The characters you now type replace any characters following the cursor. Insert mode is turned off when you press ENTER to carry out a command. You can start DOSKey and specify insert mode as the default by using the /insert switch.

Type help doskey for more information about the DOSKEY command.

**Deleting the List of Stored Commands**

To delete the list of stored commands and begin a new list, press ALT+F7. The list is also deleted when you reload DOSKey or reset your system.

**Saving the List of Stored Commands in a Batch Program**

To save the list of stored commands, you can type the DOSKEY command with the /history switch, the output redirection character (>), and the name of the file in which you want the list stored. For example, to store your list of commands in the SAVCOMMS.TXT file, type:

    doskey /history > savcomms.txt

To create a batch program by using DOSKey, first press ALT+F7 to delete the list of commands from DOSKey. Then, type the commands you want to save. Use the /history switch to save the commands in a file with a .BAT extension.

**Using DOSKey to Work with Macros**

A *macro* is a set of commands that you can carry out by typing the name of the macro. A macro is very much like a batch program. Both contain sets of commands that you carry out by typing a name.
A macro has the following characteristics:

- It is stored in RAM and, as a result, processes much faster than a batch program.
- It can be run from any directory.
- The macro is created as one command or a series of commands separated by a special character all on one line. The total length of the macro cannot exceed 127 characters.
- You can use replaceable parameters. These are represented by the characters $1$ through $9$.
- Macros are lost each time you turn your system off or reset it. This can be avoided by putting the definition commands for the macros you commonly use into one batch program. To make the macros available, you run the batch program.

**Creating a Macro**

To create a macro, type `doskey` followed by the macro name, an equal sign, and the commands in the macro. For example, to create a macro called `DDIR` that displays a directory in wide format, type:

```
doskey ddir=dir /w
```

If you type `ddir` at the DOS command prompt, DOS processes the macro, displaying a five-column list of the files in the current directory. Because the macro is stored in memory, it does not matter which directory is current when you run it.

To include more than one command in a macro, separate the commands with a dollar sign ($$) and the letter T. For example, the following command creates a macro called `CMP` that alphabetizes and lists the `.DOC` files and then the `.BAK` files in the current directory:

```
doskey cmp=dir *.doc /o:n $t dir *.bak /o:n
```

While you are creating and testing a macro, it is easiest to type the command that defines the macro at the DOS command prompt. Then, you can use the DOSKey editing keys to change and redefine the macro quickly.

Because macros are stored in memory, they are lost when you turn your system off or reset it. Therefore, if you create a macro that you use often, put the command that defines the macro in your `AUTOEXEC.BAT` file so the macro is available each time DOS starts.
Running a Macro

To run a macro, type its name at the DOS command prompt. For example, to run the DDIR macro, type:

```
ddir
```

There cannot be any space between the DOS command prompt and the macro name. If there is, DOS does not recognize the name and displays the following message:

```
Bad command or file name
```

Suppose you want to create a macro that has the same name as a command. You could use the following command to create a macro called DIR so that typing `dir` would replace the DOS DIR command:

```
doskey dir=dir /w
```

When you have a macro with the same name as a command, DOS runs the macro rather than the command. Thus, when you are at the DOS command prompt, DOS runs the DIR macro rather than the DIR command.

Whenever you want to use the DIR command instead of the DIR macro, you can type a space between `dir` and the DOS command prompt. Now, DOS does not recognize DIR as a macro name, but it does recognize it as a command.

You cannot run a macro from within a batch program, but you can define it in a batch program. For more information about batch programs, see Chapter 7, "Working with Batch Programs" on page 97.

When you want to stop a currently running macro, you must press CTRL+C for every command in the macro. Each time you press CTRL+C in a macro, DOS stops the command it is currently processing.
Editing a Macro

You can change a macro by editing the command that created it. If the macro is defined in a batch program, you can edit the batch program and then run it again. If the macro is one of the commands that DOSKey has stored, you can redisplay the macro command, edit it by using DOSKey editing keys, and complete the edit by pressing ENTER. For information about DOSKey editing keys, see “Editing and Using Previous Commands” on page 118.

Saving a Macro

To save macros stored in memory, use the DOSKEY command with the /macros switch, a greater-than sign (>), and a file name. In the following example, the names and contents of the macros currently in memory are stored in the MACS.BAT file:

```
doskey /macros > macs.bat
```

If you add the DOSKEY command to the beginning of each macro that you saved in the MACS.BAT file, you can load the macros into memory by running the batch program. For example, suppose you created the following three macros and saved them in the MACS.BAT file:

```
dir=dir /oe /p
mv=copy $1 $2 $t del $1
where=dir /s /p $1:\*.$2
```

If you want these macros to be available each time you start your system, first add the DOSKEY command to them, as follows:

```
doskey dir=dir /oe /p
doskey mv=copy $1 $2 $t del $1
doskey where=dir /s /p $1:\*.$2
```

Each time you run the batch program, DOSKey loads the three macros into memory. You might want to run the batch program from your AUTOEXEC.BAT file by using the CALL command. Put the name of the batch file after the CALL command. When you start your system, the macros are re-created. For more information about the AUTOEXEC.BAT file, see Chapter 4, “Configuring Your System” on page 53.
Deleting a Macro

To delete a macro, type `doskey`, followed by the name of the macro you want to delete plus an equal sign. For example, to delete the DDIR macro, type:

```
doskey ddir=
```

DOSKey removes the macro from memory. To delete all macros, press ALT+F10.

Deleting macros makes the memory available for other macros, but it does not return the memory to the command-history buffer.

Using Replaceable Parameters

You can use replaceable parameters in a macro in much the same way you use them in a batch program. In a macro, the replaceable parameters are $1 through $9 rather than %1 through %9.

For example, the following command creates a macro named FINDIT that searches through the directories on drive C for file names that match the one you specify:

```
doskey findit=dir c:\$1 /s
```

The `/s` switch is used to display file names from all directories on drive C (including the current directory) that match the file name you specify.

To run this macro, type `findit` followed by a file name at the DOS command prompt. For example, to locate all files on drive C that have the extension .OLD, type:

```
findit *.old
```

DOSKey substitutes the file name you type for the $1 parameter in the macro. The resulting command looks like this:

```
dir c:/*.old /s
```

You can use the same parameter more than once in a macro. For example, the following command creates a macro called DDEL. This macro moves a file to a directory named DELETED on drive C.

```
doskey ddel=copy $1 c:\deleted $t del $1
```
When you run the DDEL macro, you type the name of the file that is to go into the C:\DELETED directory. DOSKey replaces the $1 in the macro with the file name. It copies the file to DELETED and then deletes it from its original directory.

To delete the files in the C:\DELETED directory, you can use this macro named CLEANUP:

```dos
doskey cleanup=dir c:\deleted $t del c:\deleted\*.*
```

The macro displays a list of files in the C:\DELETED directory and then starts the DEL command. Because the DEL command prompts you to confirm deletion of all the files, you have a chance to review the file names before deleting any files.

**Using the $* Replaceable Parameter**

You can use the $* replaceable parameter to assign to a single parameter all of the text following the command that starts a macro. Typically, DOS distinguishes parameters by looking for a space. The text between the first two spaces is the first parameter, the text between the second and third spaces is the second parameter, and so on. If you use the $* parameter, DOSKey ignores spaces and assigns all text to the $* parameter.

The $* parameter is most useful when the macro you create uses a variable number of parameters. For example, you can use the following command to create a macro named D that allows you to abbreviate the DIR command:

```dos
doskey d=dir $*
```

This macro works exactly like the DIR command, regardless of the number of parameters you specify. For example, all of the following commands are carried out in the same way with the D macro as they are with the DIR command:

```dos
    d *.txt
    d *.txt /s
    d *.txt /s /b
```

If you use the $1 parameter instead of the $* parameter with the macro, DOS substitutes the first parameter and ignores the rest of the command line.
Redirecting Input and Output

You redirect input and output in macros the same way you do using DOS commands. The only difference is that macros require different characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>Redirection</th>
</tr>
</thead>
<tbody>
<tr>
<td>$L (or $l)</td>
<td>Equivalent to the less-than sign (&lt;). It redirects the input to a command.</td>
</tr>
<tr>
<td>$G (or $g)</td>
<td>Equivalent to the greater-than sign (&gt;). It redirects the output from a command.</td>
</tr>
<tr>
<td>$G$G (or $g$g)</td>
<td>Equivalent to the double greater-than sign (&gt;&gt;). It appends output onto the end of a file.</td>
</tr>
<tr>
<td>$B (or $b)</td>
<td>Equivalent to the pipe (</td>
</tr>
</tbody>
</table>

For example, the following command creates a macro named PDIR that prints directory listings:

```
doskey pdir=dir $g lpt1:
```

The following command creates a macro named MTYPE that displays the contents of the file you specify and pauses between each screen of information:

```
doskey mtype=type $1 $b more
```

The following command creates a macro named ASORT that alphabetizes the file and stores the information in a different file:

```
doskey asort=sort $L $1 $g $2
```

To run this macro, you type the file name you want to sort. DOSKey replaces the $1 replaceable parameter with the first file name you specify. The $L parameter redirects the file to the SORT command. The $g and $2 parameters redirect the output of the SORT command to the second file you specify.

For example, after you create the ASORT macro, type the following:

```
asort input.txt output.txt
```

This is the same as typing:

```
sort < input.txt > output.txt
```
When defining a DOSKey macro, you must mark the dollar sign ($) when it occurs anywhere other than in parameters, command separators, and redirection characters. You mark it by typing two dollar signs rather than one.

For example, suppose your macro copies a file to the $&CENTS directory. When you type the name of the directory, you must use "$$&cents" in your macro definition. As the command is carried out, the dollar sign is assumed to be a standard character rather than a marker or parameter.

Using DOS Editing Keys

This section describes the editing keys you can use if you do not have the DOSKey program loaded in your AUTOEXEC.BAT file. Because the PC DOS 7 Setup program installs the DOSKEY command for you, you will need to remove or comment out (REM) the DOSKEY command-line statement in your AUTOEXEC.BAT file before you can use the DOS editing keys or any other third-party command retrieval program.

DOS provides several editing keys that you can use to edit the last command you typed at the command line. For example, suppose you misspell the name of a file in a COPY command. Rather than retype the entire command, you can use editing keys to view the command and change the part that is misspelled.

When you type a command, DOS carries out the command and saves it in a temporary location called the template. For example, suppose you type:

```
type ada.txt
```

When you press ENTER, DOS displays the contents of ADA.TXT and copies the command `type ada.txt` to the template. The template can contain only the previously typed command. For information about saving and reusing more than one command, see “Using DOSKey to Work with Commands” on page 115.
You can use the command stored in the template as a starting point for typing your next command. The following editing keys display and edit the previous command stored in the template:

<table>
<thead>
<tr>
<th>Editing Key</th>
<th>Command Carried Out</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 (or RIGHT ARROW)</td>
<td>Copies the previous command to your screen, one character at a time. One character is displayed each time you press F1. For example, if your last command was <code>dir c:\work\finals\*.bak</code>, by pressing F1 three times, <code>dir</code> is displayed at the DOS command prompt. To add a character, press the INSERT key, type the character, and press F1 to display the rest of your command one character at a time.</td>
</tr>
<tr>
<td>F2</td>
<td>Copies the previous command to your screen, up to but not including the character you specify. For example, <code>dir c:\work\new\final</code> was your last command. If you press F2 and type , <code>dir c:</code> is displayed at the DOS command prompt.</td>
</tr>
<tr>
<td>F3</td>
<td>Copies the remainder of the previous command to your screen.</td>
</tr>
<tr>
<td>F4</td>
<td>Deletes the previous command from the template, starting from the beginning of the command, up to but not including the letter you specify. For example, if <code>type ada.txt</code> was the previous command, press F4 and type d before pressing F3 to copy the template to your screen. DOS displays <code>da.txt</code> at the DOS command prompt.</td>
</tr>
<tr>
<td>F5</td>
<td>Copies the current command line to the template but does not carry out the command.</td>
</tr>
<tr>
<td>F6</td>
<td>Places a CTRL+Z character (^Z) in the current command line.</td>
</tr>
<tr>
<td>LEFT ARROW or BACKSPACE</td>
<td>Deletes the character before the cursor on the current command line, without affecting the template.</td>
</tr>
<tr>
<td>DEL</td>
<td>Deletes the character on the template corresponding to the current cursor position.</td>
</tr>
<tr>
<td>INSERT</td>
<td>Starts insert mode so that characters you type do not replace characters in the same position in the template. Press the INSERT key again to stop insert mode.</td>
</tr>
<tr>
<td>ESC</td>
<td>Cancels the current command line without carrying it out, leaving the template unchanged.</td>
</tr>
</tbody>
</table>

**Note:** Some of these keys function differently when DOSKey is loaded.
Copying a Previously Typed Command
When you type a command, DOS carries it out, copies the command to the template, and displays the DOS command prompt. For example, suppose you type:

```
copy c:\work\*.txt a:
```

The files are copied to a diskette in drive A, the command is copied to the template, and the DOS command prompt appears. At this point, you can view the entire previous command by pressing F3. The command from the template is displayed:

```
copy c:\work\*.txt a:
```

The cursor appears at the end of the command. To copy your files to another disk, insert a different disk in drive A and then press ENTER. DOS carries out the COPY command again.

Editing a Previously Typed Command
Using F3 and the LEFT ARROW key, you can quickly fix a command that you mistyped. For example, suppose you typed *.dpc and pressed ENTER when you meant to type *.doc, as in the following command:

```
copy c:\work\*.dpc a:
```

Rather than retype the command, you can edit the incorrect one. To edit the command, first press F3. The command from the template is displayed:

```
copy c:\work\*.dpc a:
```

The cursor appears at the end of the command. To change dpc to doc, press the LEFT ARROW key five times to move the cursor back five spaces:

```
copy c:\work\*.d_
```

To correct the command, type o, press F3, and then press ENTER.
Chapter 10. Working with the Text Editor

The E Editor is the text editor provided with PC DOS. A text editor allows you to create, edit, and print memos, letters, and special files (such as AUTOEXEC.BAT or CONFIG.SYS) that customize DOS. For prior users of the E Editor, you will find the E Editor provided with PC DOS 7 has many new enhancements.

The E Editor that comes with PC DOS, is not intended to take the place of a word processing program. While some word processing function may be noticed, the E Editor is not intended to be a substitute for your word processing program. For readers who are interested in comparing the differences of a text editor to a word processing program, see “Comparing a Text Editor and a Word Processing Program” on page 172.

What’s New about the E Editor for PC DOS 7

PC DOS 7 introduces many new features and enhancements to the E Editor. Some that will prove beneficial are:

- Menu selections for most of the tasks you perform with a text editor.
- The ability to use a mouse to make selections and mark text.
- Improved use for the F11 and F12 keys on an enhanced keyboard to switch between loaded files. If you do not have an enhanced keyboard, you can use the key combinations of CTRL+P or CTRL+N.
- The ability to browse a file in read-only mode so that you do not inadvertently change or delete it.
- An editable E.INI file that allows you to customize most functions of the E Editor. There is no need to reboot after making changes to the E.INI file; exit the E Editor for changes to take effect.
- Syntax-directed editing for REXX and C files.
- Expanded math capabilities so that you can work with larger numbers, including binary numbers.
Choosing a Text Editor

The E Editor:
Using the E Editor, you can type commands from the E Editor command line or use the menus to do selected editing tasks. Some of the things you can do are as follows:

- Select text and move, copy, overlay, or delete it.
- Copy and move text from one file into another file.
- Access multiple files.
- Locate and make a change globally in a file.
- Size and drag an editing window.
- Draw boxes around text.
- Add and multiply numbers in a marked area.
- Change characters in a marked area to all uppercase or all lowercase letters.
- Edit large text files.
- Use online help for information about the E Editor function keys and commands.

This chapter only discusses how to use the E Editor. It does not give instructions on using the EDLIN text editor or the DOS 5.0 text editor.

The EDLIN editor:
EDLIN is a line editor included in previous versions of DOS. If you are upgrading your version of DOS, the EDLIN editor is not removed from your system so it is also available to use as a text editor.

The DOS 5.0 Editor:
When you install this version of DOS, it analyzes your system and determines if you have a previous version of DOS on your system. If you are a previous user of DOS 5.0, the DOS editor provided with DOS 5.0 will still be available for your use. If you prefer to use this editor, you can type edit at the DOS command prompt (C:>) followed by the path and name of the file you want, to load the DOS 5.0 Editor.
Starting the E Editor

You can start the E Editor by typing e (or e followed by the path and name of the file) at the DOS command prompt.

When you load the E Editor, you have the option of using the E Editor command line for all your editing tasks or using the menus to perform selected editing tasks. If you use the E Editor command line, you need to press ESC to switch between the command line and the editing window.

Viewing the E Editor Screen

After you start the E Editor and begin typing, the version number displayed is replaced by the function keys at the bottom of the screen and you see a screen similar to the following:

Reminder Line
The bottom line of the E Editor screen displays a brief reminder of each action associated with the function key (or F keys, such as F1=Help and F2=Save). You can perform the most common editing tasks with one keystroke.
<table>
<thead>
<tr>
<th>Function Key</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1=Help</td>
<td>Accesses help information about function keys and editing commands. You can page through this help information using the PAGE UP and PAGE DOWN keys.</td>
</tr>
<tr>
<td>F2=Save</td>
<td>Saves the file you are editing but does not exit the file.</td>
</tr>
<tr>
<td>F3=Close</td>
<td>Removes your file's text from memory without saving it. If your file has been modified, you will be asked whether you really want to close the file without saving. When there are no remaining files in memory, you exit to DOS.</td>
</tr>
<tr>
<td>F4=File</td>
<td>Saves your file and quits the E Editor after saving. When there are no remaining files in memory, you exit to DOS.</td>
</tr>
<tr>
<td>F5=Print</td>
<td>Lets you print a file.</td>
</tr>
<tr>
<td>F6=Draw</td>
<td>Starts the drawing text graphics feature. Then you type a number (1 through 6), B for blank, or / followed by any character. You can create or erase text graphic drawings by moving around with the cursor keys. See “Drawing Lines” on page 163 for more information. This function key and associated action is not displayed on the reminder line. However, it is active.</td>
</tr>
<tr>
<td>F7=Rename</td>
<td>Lets you change the name of the file you are editing. Type the new name and press ENTER. Afterwards, press ESC to return the cursor to the text area; this does not change the name of the previous copy on disk. It changes the name of the file to be saved. Renaming is a good way to begin a revised copy without losing the original file.</td>
</tr>
<tr>
<td>F8=Open</td>
<td>Lets you open another file or more than one file at a time. Type a filename, cursor to the text area so you can begin editing this second file. You can enter more than one file name separated by a space and can specify wild cards in file names (for example, *.doc or *.c.). Press F11 or F12 on an enhanced keyboard to switch between the multiple files you are editing. If you do not have an enhanced keyboard, you can use the selections on the menu for options (for example, Next file or Previous file). or press CTRL+P (Previous file) and CTRL+N (Next file). Do not select F8=OPEN to edit your current file.</td>
</tr>
<tr>
<td>F9=Undo</td>
<td>Restores the original contents of a line you typed incorrectly. Undo does not restore deleted lines or changes to multiple lines. Only the current line you are editing can be restored.</td>
</tr>
<tr>
<td>F10=Menu</td>
<td>Jumps to the menu. Then the arrow keys can be used to move from selection-to-selection and to access the associated menus. From a menu, you can use mnemonics to make selections.</td>
</tr>
</tbody>
</table>
### Function Key

<table>
<thead>
<tr>
<th>Function Key</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>F11 = Previous</td>
<td>Accesses the previous file you have worked on when you have loaded multiple files in the E Editor. This key is available only on an enhanced keyboard. This function key and the associated action is not displayed on the reminder line. However, it is active.</td>
</tr>
<tr>
<td>F12 = Next</td>
<td>Accesses the next file in the ring when you have loaded multiple files into the E Editor. This key is available on an enhanced keyboard. This function key and the associated action is not displayed on the reminder line. However, it is active.</td>
</tr>
</tbody>
</table>

The reminder line, called the *function key text area*, changes when you hold down a SHIFT, CTRL, or an ALT key to show you the function key text appropriate to that shifted state.

### Information Line
You also can see the name of the file you are editing, location of the cursor (line number and column number), working mode (insert, replace, or browse), and the version number of the E Editor.

### Command Line
The command line can be found near the bottom of the E Editor screen. To jump the cursor from the typing area to the command line, press ESC. Press ESC again to return to the typing area.

### Window Style
You can change the location of the reminder line, the information line, and the command line by selecting a different window style. See “Customizing the E Editor” on page 169 to learn how to alter the appearance of the editing screen and to use other customization techniques.
Getting Help

To get information about the E Editor after the editing window appears, press F1 to display help information.

<table>
<thead>
<tr>
<th>E Editor Help</th>
<th>Directory of Help Panels</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-2</td>
<td>Cursor Movement and Mouse Actions</td>
</tr>
<tr>
<td>3-4</td>
<td>Function Key Summary</td>
</tr>
<tr>
<td>5-6</td>
<td>Alt-Key Summary</td>
</tr>
<tr>
<td>7-8</td>
<td>Ctrl-Key Summary</td>
</tr>
<tr>
<td>9-13</td>
<td>Command Summary</td>
</tr>
<tr>
<td>14</td>
<td>Edit Commands</td>
</tr>
<tr>
<td>15</td>
<td>Termination Commands</td>
</tr>
<tr>
<td>16</td>
<td>Copying, Moving, and Deleting text</td>
</tr>
<tr>
<td>17-18</td>
<td>ASCII conversion table</td>
</tr>
</tbody>
</table>

C:\DOS\EHELP.HELP

When you access the E Editor online help, you are automatically put into browse mode. It is not possible to edit the help file in browse mode. You can use the arrow keys to scroll right, left, up, or down. In addition, you can use HOME to move your cursor to the top line of the file or END to move the cursor to the bottom line of the file.

You can use the PAGE UP and PAGE DOWN keys to move forward and backward through the help screens.

To exit the online Help file, press F3.
Leaving the E Editor
   You can stop editing and exit from the E Editor three ways: close (without saving changes), file (saving changes), and exit.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3=Close</td>
<td>Removes your file's text from memory without saving it. If your file has been modified, you will be asked whether you really want to close the file without saving. When there are no remaining files in memory, exit to DOS.</td>
</tr>
<tr>
<td>F4=File</td>
<td>Saves your file and removes it from memory. When all files are removed from memory, you exit to DOS.</td>
</tr>
<tr>
<td>ALT+F4=Exit</td>
<td>Exits the E Editor after closing all files. You are given the option of saving your changes if necessary. You are returned to the DOS prompt.</td>
</tr>
</tbody>
</table>

Creating or Modifying a File
   You can use the E Editor to create a new text file or modify an existing file. For example, try entering some lines of text in a file named REPORTS.TXT in your root directory. Type the following at the DOS command prompt:

   e c:\reports.txt

   and press ENTER

   You must always type the full path of the file unless you started the E Editor from the directory where you eventually want the file to be placed.

   You see the editing window. Your directory path and file name are displayed at the bottom of the screen. For descriptions of the parts of an E Editor screen, see “Viewing the E Editor Screen” on page 133.

   1. Begin typing your text from where the cursor is positioned. Try typing the text in the following example:

      The following reports are required for the staff meeting on Friday:
         1. Weekly Status Report
         2. Funding Report

      The default margins are set at 1 and 254. When you reach 254, the text automatically wraps to the next line.

      As you enter the text, note that the Line and Col numbers change near the bottom of the screen.

   2. Save and file the information as C:\REPORTS.TXT by pressing F4.

      You see Saving C:\REPORTS.TXT flash at the bottom of your screen.
If you do not specify the full path and file name when you load the E Editor, your file will be saved to the same drive and directory you were at when you created the file.

You can change it by typing `save` followed by a new drive, directory, or file name. If you were in the `C:\OFFICE\NOTES` subdirectory when you typed `e reports.txt`, your file is saved as `C:\OFFICE\NOTES\REPORTS.TXT` instead of `C:\`. If you want to save the file to this directory, you would type the following at the E Editor command line:
```
save c:\reports.txt
```

3. Press ENTER.

After leaving the E Editor, you are returned to a command line.

**Naming an Unnamed File**

If you type only `e` at the DOS command prompt without specifying a file name, you see `.Unnamed file` near the bottom on the left side of the screen.

**To name the unnamed file:**

1. Press `F7=Rename` if you loaded an unnamed file by typing `e` without a file name.

   You are prompted to enter a name for the file on the E Editor command line.

   Enter a file name after `Rename` on the E Editor command line.

   **Remember:** Be sure to include a full path name (drive, directory, and subdirectory, if applicable) where you want to find this file when you exit the E Editor. Unlike word processing programs that always place files in a specific directory, you must specify the exact location where you want to place this file. Otherwise, the file is put in the same drive and directory as you were in when you loaded the E Editor.

2. Save and file under the new name by pressing `F4`.

In addition to creating a new file and editing an existing file, you can also save and print files using the E Editor.

**Saving and Exiting a File**

After you create a file or make changes to an existing file, you can save it using a new name or you can save it using the name you specified when you opened the file. You also can save it with the same file name or new file name in a different drive or directory.
It is a good idea to save your work in case there is a power loss or equipment failure by pressing F2 often during the editing session. Also, the E Editor has an “autosave” feature. You can activate this feature using the Options menu or you can type `autosave` followed by a number at the E Editor command line. Your file is temporarily saved to a file after you press ENTER the number of times equal to the number you typed after the word “autosave”.

**CAUTION:**
Some files that you open might include special formatting characters. If you save such a file when using the E Editor, special characters lose their formatting function.

| To save the file and exit using the same file name: | • Press F4 to save the file and exit.  
The file is saved in the same drive and directory you were in when you started the E Editor or where you specified the path. |
| To save the file and exit using a different file name: | 1. Press ESC to get to the E Editor command line.  
2. Type:  

```
file newname.ext
```

where `newname.ext` is the new file name and extension for the file you are saving.  

**Remember:** If you attempt to save a file using the name of a file that already exists, the E Editor will not display a message asking whether you want to replace the existing file.

| To save the file in a different drive or directory and exit: | 1. Press ESC to get to the E Editor command line.  
2. Type:  

```
file drive:\dir\filename.ext
```

where `drive:\dir` is the new drive and directory where you want to store the file, and `filename.ext` is the name you want to give the file. The name can be the same name or a new name.  

**Remember:** If you attempt to save a file in a directory that contains a file with the same name, you are not prompted and asked whether you want to replace the existing file.

**Tip:** You can save a modified version of a file without losing the original version. For example, if you have a file named MEMO.TXT, you can keep the original file and save a modified version as MEMO_2.TXT.
Editing Multiple Files

One advantage you have with the E Editor over other text editors is the ability to open and edit more than one file at a time. This ability to edit multiple files means, for example, that you can create a new file and copy (or move) information from an existing file into the new file. Or, you can edit multiple new files, multiple existing files, or any combination of new and existing files. The files are placed into memory in a type of invisible ring, and you can switch between all files in the ring by pressing F11 or F12 on an enhanced keyboard. If you do not have an enhanced keyboard, you can select Previous file or Next file from the Options menu. Or, you can press CTRL+N to see the next file or press CTRL+P for the previous file.

To edit more than one file at a time:

Open a file from the DOS command prompt by typing the E command from the DOS command prompt.

Here are some sample commands you might type:

C:\>e report.txt  In this first example, the E Editor loads the file REPORT.TXT you created earlier in the chapter into the E Editor.

C:\>e report.txt data.dat  In this second example, two files are loaded into the E Editor. Use F11 or F12 on an enhanced keyboard to switch between files that are loaded for editing.

C:\>e *.c  In this third example, all the files with the C extension are loaded into the E Editor.

While one file is opened, you can open another file by pressing F8, and then typing either a new file name and path if creating a file, or typing the file name and path if modifying an existing file.

From the E Editor command line, the equal sign (=) substitutes the current file’s directory and saves keystrokes if you are editing several files in another directory. File names must be separated by spaces. For example:

Your current directory is C:\EDIT
The current file is C:\MYDOC\PROG\DOUG.DOC
You issue the command: EDIT =TODD.TXT
The E Editor loads C:\MYDOC\PROG\TODD.TXT
Printing a File
You can use the E Editor PRINT command or press F5 to print an open file or just the marked text within the file. In either case, the printer must be connected to or redirected through your printer port. You can specify which printer port you want to use by editing the E.INI file. Refer to information about the E.INI file in the online PC DOS 7 Command Reference.

To print a file:
1. Edit the file you want to print. You can use REPORTS.TXT as a file you want to print.
2. At the E Editor command line, type:
   ```
   print
   ```
   or press F5.
3. Press ENTER.
   If your file has marked text, the following message is displayed:
   ```
   Print marked area or entire file (M/F)?
   ```
   Type the applicable letter designator and press ENTER.
   The readiness of the printer is tested first to avoid having to wait for a device time-out in case the printer is offline. You might see the message:
   ```
   Printer not ready
   ```
   which means the printer is turned off, offline, or perhaps out of paper. Make sure the printer is ready and then repeat the PRINT command.

Using Cursor Movement Keys to Move Around in the Text File
When you load an existing file into the E Editor, your file appears on the screen and the cursor is placed in the top, far-left position in the text. To view a different part of the file, you have to move the cursor.
## Summary of Cursor Movement Keys

<table>
<thead>
<tr>
<th>Cursor Movement Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>UP ARROW</td>
<td>Moves cursor one line up.</td>
</tr>
<tr>
<td>DOWN ARROW</td>
<td>Moves cursor one line down.</td>
</tr>
<tr>
<td>LEFT ARROW</td>
<td>Moves cursor one character to the left.</td>
</tr>
<tr>
<td>RIGHT ARROW</td>
<td>Moves cursor one character to the right.</td>
</tr>
<tr>
<td>HOME</td>
<td>Moves cursor to column 1 of the current line.</td>
</tr>
<tr>
<td>END</td>
<td>Moves cursor to end of the current line.</td>
</tr>
<tr>
<td>PAGE UP</td>
<td>Shifts view to page above current page. The cursor stays at same position on screen.</td>
</tr>
<tr>
<td>PAGE DOWN</td>
<td>Shifts view to page below current page. The cursor stays at same position on screen.</td>
</tr>
<tr>
<td>CTRL+HOME</td>
<td>Moves cursor to top line of file.</td>
</tr>
<tr>
<td>CTRL+END</td>
<td>Moves cursor to bottom line of file.</td>
</tr>
<tr>
<td>TAB</td>
<td>Moves cursor to next tab stop.</td>
</tr>
<tr>
<td>SHIFT+TAB</td>
<td>Moves cursor to previous tab stop.</td>
</tr>
<tr>
<td>CTRL+PAGE UP</td>
<td>Moves cursor to top of screen.</td>
</tr>
<tr>
<td>CTRL+PAGE DOWN</td>
<td>Moves cursor to bottom of screen.</td>
</tr>
<tr>
<td>CTRL+LEFT ARROW</td>
<td>Moves cursor to beginning of word left of cursor.</td>
</tr>
<tr>
<td>CTRL+RIGHT ARROW</td>
<td>Moves cursor to beginning of word to right of cursor.</td>
</tr>
<tr>
<td>ENTER</td>
<td>Defined by the user in the E.INI file.</td>
</tr>
<tr>
<td>CTRL+ENTER</td>
<td>Defined by the user in the E.INI file.</td>
</tr>
<tr>
<td>ESC</td>
<td>Moves cursor back and forth between text and E Editor command line.</td>
</tr>
<tr>
<td>ALT+E</td>
<td>Moves cursor to end of marked block.</td>
</tr>
<tr>
<td>ALT+Y</td>
<td>Moves cursor to beginning of marked block.</td>
</tr>
<tr>
<td>CTRL+F5</td>
<td>Moves cursor to beginning of a word.</td>
</tr>
<tr>
<td>CTRL+F6</td>
<td>Moves cursor to end of a word.</td>
</tr>
<tr>
<td>CTRL+F (repeat FIND)</td>
<td>Moves cursor to next found text.</td>
</tr>
<tr>
<td>CTRL+N</td>
<td>Moves cursor to the next active file in the ring.</td>
</tr>
<tr>
<td>CTRL+P</td>
<td>Moves cursor to the previous active file in the ring.</td>
</tr>
<tr>
<td>CTRL+Q</td>
<td>When in .ALL file, positions cursor on corresponding line in original file. If not in .ALL file, you are placed there and the cursor is moved down one line.</td>
</tr>
</tbody>
</table>

You can also scroll by holding down an arrow key. For additional information about the .ALL file and the ALL command, see “Searching for Text Using the ALL Command” on page 159.
Performing Basic Editing Tasks

In addition to entering text, there are basic features that most text editors perform, such as:

- Inserting or replacing text.
- Connecting or breaking a line of text.
- Adding a blank line.
- Deleting all or only part of a line.
- Deleting characters, words, or lines of text without marking them first.
- Restoring a deleted line.
- Setting tabs.
- Setting margins.
- Saving keystrokes in a macro.

Inserting or Replacing Text

The E Editor has two modes for entering text: insert mode and replace mode. Press the INSERT key to alternate between modes.

<table>
<thead>
<tr>
<th>To insert text:</th>
<th>Position the cursor at the point where the next text is to start and type it in. Existing text moves to the right to make room for what you type.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When you start the E Editor, it is automatically in insert mode. At the bottom right-hand corner of the E Editor screen, you see the word “Insert.” Press the INSERT key if you want to change to replace mode.</td>
</tr>
<tr>
<td></td>
<td>In insert mode, the cursor is a box shape.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To replace text:</th>
<th>Press the INSERT key to replace characters instead of inserting them. At the bottom right-hand corner of the E Editor screen, you now see the word “Replace.”</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Position the cursor at the point where the next text is to start and type it in. Existing text is overwritten when you type. Press the INSERT key again to resume inserting.</td>
</tr>
<tr>
<td></td>
<td>In replace mode, the cursor is an underscore.</td>
</tr>
</tbody>
</table>

Connecting or Breaking a Line of Text

The way to break lines at a certain point in the text is to split (breaking) them. Other times you might want to join (connecting) two or more shorter lines into one line of text. The E Editor allows you to split or join a line by selecting Split line or Join lines from the Edit menu, or using the E Editor command line as follows:
### To break lines:
Position the cursor at the point where you want to split the line and press ALT+S. The text after the point where you put the cursor is now on the next line.

### To connect lines:
Position the cursor anywhere on the line where you want the text to continue or be connected and press ALT+J. The line of text just below the cursor is now brought up to join the line the cursor is on.

You can also split a line by pressing ENTER at any spot within the text line if you are in STREAM mode. Refer to STREAM mode under E.INI in the online *PC DOS 7 Command Reference*. All the words following the cursor are moved to the next line. If you are at the end of a line or on the first character of a line and press ENTER, a blank line is inserted.

### Adding or Deleting Lines of Text
Basic tasks you can perform using a text editor are to add a line or to delete all or part of a line of text.

Most functions of the E Editor are controlled by the specifications designated in the E.INI file. Two such functions, STREAM and ADDLINE, affect the way lines are added when using the E Editor. The E Editor is installed with STREAM mode being the default. You can change the mode to ADDLINE by editing the E.INI file. For more information, refer to the online *PC DOS 7 Command Reference* under the discussion for the E.INI file.

### To add a blank line

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STREAM mode</td>
<td>Move the cursor to the end of the line and press ENTER. This is the default.</td>
</tr>
<tr>
<td>ADDLINE mode</td>
<td>Position the cursor anywhere in the line just above the row where you want to add the line and press ENTER.</td>
</tr>
</tbody>
</table>

### To erase to the end of the line:
Position the cursor anywhere on the line to the left of what you want to erase and press CTRL+E. The text to the end of the line is now erased.

### To delete a line:
Place the cursor in any column on the line to be deleted and press CTRL+BACKSPACE simultaneously.

The line is deleted from the screen and the lines below it move up to fill the gap. Continuing to press CTRL+BACKSPACE deletes multiple lines.
Restoring a Deletion
Press F9 if you incorrectly type a change to a line and you want to restore its original contents.

The contents are restored only for the current line you are editing and only if you have not:

• Moved the cursor from the current line.
• Pressed ENTER.

The UNDO command does not restore deleted lines or changes to multiple lines.

Recovering Deleted Lines or Line Blocks
If you delete a line or block of lines (using CTRL+BACKSPACE or ALT+D), you can recover the deletion by pressing CTRL+U. The default for the number of lines that can be restored is set at 50. This number can be changed by editing the E.INI file. For more information about the E.INI file, see the online PC DOS 7 Command Reference.

Deleting Unmarked Characters or Words
You can delete text one character at a time, one word at a time, one line at a time, or several lines at a time in blocks at one time.

<table>
<thead>
<tr>
<th>To delete a character:</th>
<th>Place the cursor on the character you want to delete and press DELETE.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The character is deleted from the screen and the text to the right of the cursor shifts to the left to fill the gap.</td>
</tr>
<tr>
<td></td>
<td>To delete multiple characters, repeat the steps for each character you want to delete.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To backspace over a character:</th>
<th>Press BACKSPACE.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The character to the left of the cursor is deleted from the screen and the text to the right of the cursor shifts to the left to fill the gap.</td>
</tr>
<tr>
<td></td>
<td>By pressing the BACKSPACE repeatedly, characters continue to be deleted.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To delete a word:</th>
<th>Position the cursor at the beginning of the word to be deleted and press CTRL+D.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The word is deleted from the screen and the text to the right of the cursor shifts to the left to fill the gap. Repeat the steps to delete multiple words.</td>
</tr>
<tr>
<td></td>
<td>A text editor assumes a &quot;word&quot; to be a string of characters from the point where your cursor is positioned up to and including the first following space.</td>
</tr>
</tbody>
</table>
If you have multiple characters, words or lines to delete, you might find it easier to mark words, lines, or blocks for deletion instead (see “Marking Text Using Key Combinations” on page 149).

**Setting Tabs**
The changes to Tabs and Margin settings described in this section apply only to the current session. The Tab and Margin settings revert to the default values when you leave the session.

Use the TAB key to move the cursor across the screen and insert text at set points.

**To change the tab settings:**
1. Press ESC to move your cursor to the command line.
2. Type the TABS command on the E Editor command line.
   - If you only type tabs, the current tab settings are displayed. The tabs are preset to every eighth column across the screen. For example:
     ```
     tabs 1 9 17 25 33
     ```
3. Change the tab setting with the TABS command using the following format:
   ```
   tabs [t1 [t2 [t3 ... t32] ] ]
   ```
   For example, you can reset tabs for specific tab stops by typing the following at the E Editor command line:
   ```
   tabs 4 17 39 47 ... 55
   ```
   and then pressing ENTER.
   
   or
   
   You can type the TABS command followed by a number to set the tabs to every fourth column across the screen:
   ```
   tabs 4
   ```
   In this example, the tabs are set at 1 5 9 13 ... 125.

**Setting Margins**
**To set new margins:**
1. Press ESC to move your cursor to the command line.
2. Type the MARGINS command on the E Editor command line.
   - If you only type margins, the current margin settings are displayed. For example:
     ```
     margins 1 254 1
     ```
3. Change the margin setting with the MARGINS command using the following format:

\texttt{margins \{left margin \{right margin \{new paragraph margin\}\}\}}

For example, you could type margins similar to:

\texttt{margins 1 70 5}

Then press ENTER.

To put the cursor back in the text area, press ESC. As you continue typing, the E Editor keeps your text within the new margin settings. Notice that your previously entered text is not automatically reflowed to the new margin settings.

4. Press ESC to move your cursor to the command line.

\textbf{Saving Keystrokes in a Macro}

You can record and play back any sequence of keystrokes. Such a recorded sequence constitutes a temporary \textit{macro} that can be repeated numerous times. If you find yourself entering the same key sequence more than twice, record them instead.

\textbf{To record a sequence of keys:}

1. Press CTRL+R.

2. Type your sequence of keys.

   Virtually any key can be recorded, including ESC, to switch to the E Editor command line. As you are recording the keys, the key operations are also taking place in addition to being recorded and saved.

3. Do one of the following when prompted:

   \begin{itemize}
   \item \texttt{CTRL+R} Finishes the recording of keystrokes.
   \item \texttt{CTRL+T} Completes the recording and immediately runs the saved sequence. This shortcut eliminates having to press CTRL+R a second time before pressing CTRL+T.
   \item \texttt{CTRL+C} Cancels saving the keystroke sequence.
   \end{itemize}

\textbf{To replay the sequence at any other time:}

Press CTRL+T.

Unless you have changed keystroke recordings, made a new recording, or left the E Editor, the keystroke recording is retained.
You can save your macro when you exit the E Editor and have it loaded the next time you start the E Editor by setting the MACROPATH option in the E.INI file. Refer to the online *PC DOS 7 Command Reference* for more information about the E.INI file.

**Selecting Text**

You begin most editing operations by selecting a block of text. In a single line, you can select any amount of text, from a single character to the entire line. You can also select several lines or the entire file at once.

In the E Editor, selecting a section of the text is called *marking* the text. When this is done correctly, you see the area you have marked highlighted on your screen. To copy, move, or delete a section of text, first mark the text before you can perform functions on it.

*Unmarking* the text removes the highlighting and the text is no longer selected.

There are two ways to mark text. You can use the mouse or you can use key combinations.

**Marking Text Using the Mouse**

The following type of marking is possible when using the mouse:

<table>
<thead>
<tr>
<th>Mark Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Word Mark</strong></td>
<td>Use the right mouse button and click on the word you want marked.</td>
</tr>
<tr>
<td><strong>Line Mark</strong></td>
<td>Hold down the right mouse button and drag the mouse pointer across the lines of text you want to mark. An entire line, from column 1 to column 255, is marked.</td>
</tr>
<tr>
<td><strong>Text Mark</strong></td>
<td>Ensure that the SCROLL LOCK key is off. Hold down the left mouse button and drag the mouse pointer across the lines of text you want to mark. The mark proceeds only to the end of the line. It does not go all the way across the screen unless your line of text projects out that far.</td>
</tr>
<tr>
<td><strong>Rectangular Block Mark</strong></td>
<td>Press the SCROLL LOCK key so that it is on. Hold down the left mouse button and drag it across the area you want to mark. Only a rectangular area of text is blocked.</td>
</tr>
</tbody>
</table>

Double clicking on a marked area with the left mouse button unmarks the marked area.
Marking Text Using Key Combinations

Four types of marks are recognized in the E Editor:

<table>
<thead>
<tr>
<th>Mark Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Mark</td>
<td>Marks the entire word regardless of where you place your cursor on the word.</td>
</tr>
<tr>
<td>Line Mark</td>
<td>An entire line from column 1 up to and including column 255 is marked.</td>
</tr>
<tr>
<td></td>
<td>Use line mark if you are going to copy or move text and then insert the text elsewhere in the file. Only the line mark moves the existing text down to let you insert the text. With line mark, no text shifts to the right. You are not required to add blank lines before you insert the moved or copied block of text. This is the recommended method for marking paragraphs if you are not using the mouse.</td>
</tr>
<tr>
<td>Text Mark</td>
<td>Marks a single space or multiple spaces that include text, numbers, or symbols. The marked area proceeds from where you set your cursor to begin the mark to where you set your cursor to end the mark. If you cross multiple lines, the marked area follows the path of the line and goes only as far-right as the text on that line.</td>
</tr>
<tr>
<td>Rectangular Block Mark</td>
<td>A strictly rectangular area of text.</td>
</tr>
</tbody>
</table>

To mark a line of text:

1. Use the arrow keys or other cursor movement keys to move the cursor anywhere on the line you want to select or line mark.

2. Press the line combination keys ALT+L.

To mark multiple lines of text:

After you mark a line, move the cursor to another line and press the line combination keys (ALT+L) again. All lines between the first mark and the second mark are then marked.

To mark a rectangular block of text:

1. Use the arrow keys or other cursor movement keys to move the cursor to the upper-left character of the text you want to select or block mark.

2. Press ALT+B.

3. Move the cursor to the lower-right character of the text you want to block mark.

4. Press ALT+B again to complete the block mark. The text you have marked is now highlighted.
To mark a word:
1. Use the arrow keys or other cursor movement keys to move the cursor anywhere on the word you want to select or word mark.

You can mark only one word when you use the following key combination. You must unmark the word or use the delete edit process to mark another word.

2. Press the word combination keys ALT+W.

To mark text:
1. Use the arrow keys or other cursor movement keys to move the cursor to the item (character, number, or symbol) you want to select or text mark.

2. Press the text combination keys ALT+Z. The text is highlighted.

To mark multiple items:
1. Use the arrow keys or other cursor movement keys to move the cursor to the first character of the string (characters, numbers, or symbols) you want to select.

A multiple text mark can span lines. Unlike the block mark, this type of a mark is not a strictly rectangular shape. This type of mark wraps around lines.

Note: Blank lines between text lines are not marked.

2. Press the text combination keys ALT+Z.

3. After you mark one item (a character, number, or symbol), place the cursor on the last item you want to mark and press the mark text keys ALT+Z. All text from the beginning to the end is marked.

After you have marked text, you can revise the range of the mark by placing the cursor at a different position and again pressing the combination key you last used. If the cursor is outside the range of the marked area, the marked area will be expanded to include the new position. If the cursor is within the marked area, it will be construed as a new end of the area mark.

Unmarking Text
You can clear marked text from the E Editor window by pressing ALT+U. Any marked text is no longer highlighted.
Summary of Key Combinations for Marking and Unmarking Text

Following is a table which summarizes the key combinations you would use to mark and unmark text.

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT+B</td>
<td>Block mark for rectangles or lines.</td>
</tr>
<tr>
<td>ALT+L</td>
<td>Line mark for one or more lines.</td>
</tr>
<tr>
<td>ALT+W</td>
<td>Word mark.</td>
</tr>
<tr>
<td>ALT+Z</td>
<td>Text mark for sentences, phrases, or characters.</td>
</tr>
<tr>
<td>ALT+U</td>
<td>Unmark.</td>
</tr>
</tbody>
</table>

Using Key Combinations to Manipulate Text

You can perform any type of operation on the marked text that you want (such as copy, move, delete, or reflow).

To manipulate an area of text:
1. Mark the text you wish to copy, move, delete, or reflow by pressing the key combinations in the previous summary. The E Editor highlights the area to show you what you have marked.
2. For copying or moving, select the destination for the highlighted text by moving the cursor to the destination position.
3. Press a key combination, such as ALT+C (copy) to perform the operation.

Deleting Text

You use the DELETE command to delete a block of text and reposition the text once the deletion is made.

To delete text:
1. Mark the text you want to delete.
   - Refer to “Marking Text Using Key Combinations” on page 149 for instructions on how to select text if you do not know how to mark it.
2. Press ALT+D.
   - The text is deleted and the text to the right of the cursor shifts to the left to fill the gap.
Copying Text

You use the E Editor copy command to copy and reposition a block of text.

To copy a block of text:

1. Mark the block of text you want to copy.
   Refer to “Marking Text Using Key Combinations” on page 149 for instructions on how to select text if you do not know how to mark it.
2. Select the destination for the highlighted text by moving the cursor to the destination position.
3. Press ALT+C.
   The block of text is copied to the new location, and it is not removed from its original location.

To copy a block of text into another file:

1. Load the two files you are going to copy text between (target and source files).
   For information on how to edit more than one file at a time, see page 140.
2. In the file that has the text you want to copy, mark the block of text.
   Refer to “Marking Text Using Key Combinations” on page 149 for instructions on how to select text if you do not know how to mark it.
3. Select the destination for the highlighted text by switching to the second file (F12 or CTRL+N). Then, move moving the cursor to the destination position.
4. Press ALT+C.
   The block of text is copied to the new location, and it is not removed from its original location.

You can copy the marked text into a file as many times as you want by repeating the COPY command (ALT+C). The text remains marked until you change what is marked.
Moving Text

You can move a block of text. This procedure is useful if you want to rearrange the order of text in a file.

To move a block of text within the same file:

1. Mark the block of text you want to move.
   Refer to “Marking Text Using Key Combinations” on page 149 for instructions on how to select text if you do not know how to mark it.
2. Move the cursor to the position where you want to move the text using the arrow keys.
3. Press ALT+M.
   The block of text is deleted from the original location and moved to the new destination.

To move a block of text into another file:

1. Load the two files you are going to transfer text between (target and source files).
   For information on how to edit more than one file at a time, see page 140.
2. In the file that has the text you want to move, mark the block of text.
   Refer to “Marking Text Using Key Combinations” on page 149 for instructions on how to select text if you do not know how to mark it.
3. Select the destination for the highlighted text by switching to the second file (CTRL+N or F12 on an enhanced keyboard) and moving the cursor to the destination position.
4. Press ALT+M.
   The block of text is moved to the new location, and it is removed from its original location.

When you move a block of text, the text remains marked until you change what is marked.
Reflowing Text
The E Editor allows you to reflow text to fit with a new area between margin settings or in an area you define.

Adjusting a Paragraph to the New Margins
The E Editor recognizes a blank line as the end of a paragraph. Therefore, you can reflow text in a paragraph to adjust to new margin settings. Before you can adjust a paragraph to new margins, you must first set the margins. See “Setting Margins” on page 146 for more information.

If a paragraph is not followed by a blank line or an end-of-file indicator, you must mark the paragraph before you can reflow text.

To reflow text to revised margin settings:
1. Move the cursor to the beginning of the paragraph.
2. If the paragraph is not terminated with a blank line or end-of-file indicator, mark the area using combination keys.
   The E Editor highlights the text you have marked.
3. Press ALT+P to adjust the marked paragraph to the current margin settings.

Reflowing Marked Text
Pressing the ALT+R combination keys lets you reflow a section of text to a defined space. It is typically used to reformat a special paragraph (such as an indented paragraph) without changing the margins.

To reflow marked text:
1. First mark the text to be reformatted (with any type of mark).
2. Press ALT+R.
   You are prompted to mark the new block—the space into which you want the block refloowed.
3. Move the cursor to the upper-left character of the block of text you want to reflow and press ALT+B.
4. Move the cursor to the lower-right character of the block of text you want to reflow and press ALT+B.
5. Press ALT+R and the text is refloowed. The space where the text came from is filled with blank spaces.
   ALT+P refloows a marked paragraph to the new margin settings.
In other words, with a block mark, ALT+P behaves as if you marked a block, pressed ALT+R, and remarked the same block.

**Summary of Text Operation Keys**

After you have marked text, you can manipulate it by pressing the following key combinations:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT+A</td>
<td>Copies text to a new location and fills the old position with blanks.</td>
</tr>
<tr>
<td>ALT+C</td>
<td>Copies the text to the new location by inserting it and pushing aside existing text.</td>
</tr>
<tr>
<td>ALT+D</td>
<td>Deletes marked text. The space formerly occupied is discarded.</td>
</tr>
<tr>
<td>ALT+O</td>
<td>Copies text to a new location; overlays the existing text rather than pushes it aside.</td>
</tr>
<tr>
<td>ALT+M</td>
<td>Moves marked text from one location to another location and discards the space previously occupied by the text.</td>
</tr>
<tr>
<td>ALT+F</td>
<td>Fills an entire marked area with a character you specify. The character can be a graphic; see &quot;Entering Control and Graphic Characters&quot; on page 170 for information on how to enter a graphic character. To end this operation, press ESC.</td>
</tr>
<tr>
<td>ALT+P</td>
<td>Reflow a marked paragraph to the new margin settings. If a block of text is marked, reflows only the marked text to the new margin settings. See “Adjusting a Paragraph to the New Margins” on page 154 for details. If the text is not marked, the paragraph following the cursor is reformatted.</td>
</tr>
<tr>
<td>ALT+R</td>
<td>Reflow the marked text into a new defined area. See “Reflowing Marked Text” on page 154 for details.</td>
</tr>
<tr>
<td>ALT+F7</td>
<td>Shifts marked text to the left. If you have text next to the left column of the marked area, it will overlay any text in the far-left column of the marked area.</td>
</tr>
<tr>
<td>ALT+F8</td>
<td>Shifts marked text to the right. All text to the right of the left edge boundary is shifted right. The far-left marked column is filled with blank spaces.</td>
</tr>
<tr>
<td>ALT+E</td>
<td>Moves the cursor to the end of the marked text. Except for line-marked text, this is the far-right character of the last line. For line-marked text, the cursor column is unchanged.</td>
</tr>
<tr>
<td>ALT+Y</td>
<td>Moves the cursor to the start of the marked text. Except for line-marked text, this is the far-left character of the first line. For line-marked text, the cursor column is unchanged.</td>
</tr>
</tbody>
</table>
Some operation keys do not work with all combination keys, as shown in the following table.

The top heading gives the marking keys. The left column shows the operation keys. At the intersection of any row and column is a description of where the cursor should be placed to define the destination. If no such description is given (as at the intersection of ALT+L and ALT+A), the operation is not allowed.

<table>
<thead>
<tr>
<th>Operation</th>
<th>ALT+L</th>
<th>ALT+B or ALT+W</th>
<th>ALT+Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust (ALT+A)</td>
<td>Top-Left Corner</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy (ALT+C)</td>
<td>Line Above</td>
<td>Top-Left Corner</td>
<td>At Line</td>
</tr>
<tr>
<td>Delete (ALT+D)</td>
<td>Any Position</td>
<td>Any Position</td>
<td>Any Position</td>
</tr>
<tr>
<td>Overlay (ALT+O)</td>
<td>Top-Left Corner</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move (ALT+M)</td>
<td>Line Above</td>
<td>Top-Left Corner</td>
<td>Top-Left Corner</td>
</tr>
<tr>
<td>Reflow (ALT+P)</td>
<td>Any Position</td>
<td>Any Position</td>
<td>Any Position</td>
</tr>
<tr>
<td>SHIFT (ALT+F7/F8)</td>
<td>Any Position</td>
<td>Any Position</td>
<td></td>
</tr>
</tbody>
</table>

**Using E Editor Commands**

In addition to pressing keys or combinations of keys, you can use the E Editor command line to perform many functions of the E Editor.

Enclosing an E Editor command in quotes when you invoke the E Editor lets you specify a command that takes effect immediately upon loading the E Editor. You can specify file names before the quoted command. For example, to start the E Editor, open a file named REPORT.DOC, and move the cursor to the bottom of the file, type the following at the DOS command prompt:

```
e report.doc 'bot'
```

Remember to press ESC to move from the window area of the E Editor to the command line. Press ESC again to return to the window area of the E Editor.
Finding Text

To find a word, a phrase, or a combination of characters in a file, use the / (search) or L (locate) command. The text can be a word, a phrase, or any combination of characters and spaces.

**Note:** To make sure the entire file is searched, go to the top of the file before you begin your search.

You need to be specific about limiting your searches so you find only separate occurrences, such as searching for "let" and finding these letters in the word "letters." If you searched for "lett", you are limiting the search to a more specific search pattern.

To find a word or phrase, use the following format:

```
/findword/ [options]
```

or

```
L/findword/ [options]
```

If you do not specify any options, the / (search) or L (locate) command will do the following:

- Search the entire file (not only the marked area) in the forward direction.
  - For example, the search starts at the current line and proceeds toward the end of the file.
- Search but ignore case.
  - For example, the E Editor finds both Brown and brown.
- Search left-to-right through lines.

Change the search options if you need to. When the E Editor searches for text, it starts at the current cursor position and selects the first occurrence of the text. You can specify the following search options:

- `Search from current line backwards to top of file (or if the m option is chosen, to top of marked area). Search is left-to-right.`
- `+ Search forward from current line to bottom of file.`
- `m Search within the marked text area only.`
- `a Search the current file, including the marked area.`
- `c Search but ignore case.`
- `e Search but match the search pattern’s case exactly.`
- `r Search from right to left through lines.`
- `f Search from left-to-right through lines.```
To find text:

1. Return to the top of the file and type a / (search) or L (locate) command.
   For example, if you want to find “help” as a separate word, you would type:
   
   `/help /`
   
   or
   
   `L/help /`
   
   Make sure you include the space after the word “help” because the E Editor finds all occurrences, such as the help in helpless if you do not add the space in your search pattern. The second / is normally not required if you do not have options listed. Because you are limiting your search to help followed by a space, the second / is required to add the space.

2. Press ENTER.
   
   If no occurrences of the text are found, you see the String not found message.

3. To search for the next occurrence of the specified text, press CTRL+F. Only the file in the active editor window is searched.
   
   or

4. To make a global search, press CTRL+G. All the files in the editor's ring are searched.

The / (search) or L (locate) command leaves the cursor in the text area, not on the E Editor command line.

The / (search) or L (locate) command continues to search through the file each time you press CTRL+F until it reaches the end of the file.

Here is an example of the / (search) or L (locate) command:

   `/finalize/e`

   The E option means to search but match the case exactly. After you press ENTER, the E Editor searches for the word “finalize”, ignoring any words it might find that have uppercase letters in it, such as “Finalize”.
Any search string delimiter (not only the slash /) can be used after the LOCATE command. You need this if the search string itself contains a slash. When used with the slash delimiters (/), the command does not require a blank between the C and the /. However, if you are using a different delimiter, a blank space is required between the L and the delimiter. The same is true of the C (change) command.

```
L $/$
```

In the last example, '$' is the delimiter and '/' is the string for which to search.

Multiple options can be given at one time.

```
/helper/-re
```

If contradictory options are given (such as /rf), only the last option is the one remembered.

In this example, the E Editor searches for the word “helper” from the current line backwards in the file, searches from right to left in the lines, and finds only the word “helper” and matching capitalization exactly while it is searching.

**Searching for Text Using the ALL Command**

The ALL command creates a file called .ALL that shows all occurrences of a search pattern you designated for the file you are in. The occurrences matching the pattern are listed by line number. You can move from occurrence to occurrence by pressing CTRL+Q combination.

To find a word or phrase, use the following format:

```
all /findword [/[e]]
```

The / can be any delimiter and e indicates to match case exactly.

**To use the ALL command to search in a file:**

1. Open up the file you want to search.

2. Type the following command if you want to find the word “expert” in the opened files:

```
all /expert
```

3. Press ENTER.

If no occurrences of the word are found, you see the message:

```
String not found
```
If the word is found:

- The .ALL file is created, showing the line number and contents of the line where the word is found.
- You are placed in the .ALL file with the cursor blinking on the first occurrence of the word.

4. Press CTRL+Q and you are switched from the .ALL file to the original file. The cursor is placed on the first occurrence of the word in the original file.

   Each time you press CTRL+Q, you are switched between the two files.

5. Save and quit out of your original file as usual. The .ALL file still appears on your screen. You cannot save the .ALL file; however, you can rename it first and then save it. When you quit a file, it disappears as though it never existed.

**Searching for and Replacing Text**

To find a word or phrase, use the following format: you can search for and replace a set of characters in a file at the same time using the C (change) command. The C (change) command begins at the cursor location and continues to the end of the file. To make sure that you search for and replace the entire file, move the cursor to the top of the file before you begin to search and replace text.

To find a word or phrase and replace it with other text, use the following format:

1. Type a C (change) command using the following format:

   ```c/oldtext/newtext/ [options]```

   For example, if you are trying to find “mail” and replace it with “letters”, you would type:

   ```c/mail /letters /```

   The “C” is the shortened form of the C (change) command.

   Make sure you specify the spaces where necessary because the C (change) command changes all occurrences. If the spaces were not specified in the preceding example, the `mail` in `mailbox` would then become `lettersbox` if you do not add the space in your search pattern.

   One option is available with the C (change) command that is not available with the L (locate) command. If you want to make all the changes, without being prompted, add an asterisk (*) similar to the example that follows:

   ```c/mispeled/misspelled/*```
If you do not specify options, the C (change) command will do the following:

• Change the entire file (not only the marked area) in the forward direction.
  
  For example, the change starts at the current line and proceeds toward the end of the file.

• Search but ignore case.
  
  For example, the E Editor finds both Brown and brown.

• Search left-to-right through lines.

Change the options if you need to. The E Editor starts at the current cursor position and changes the first occurrence of the text. You can specify the following change options:

* Makes all the changes, without being prompted.
- Changes from current line backwards, to top of file (or if the m option is chosen, to top of marked area). Search is from left-to-right.
+ Changes forward from current line to bottom of file.
 m Changes within the marked text area only.
a Changes the current file, including the marked area.
c Changes but ignores case. (This is the default for the CHANGE command).
e Changes but matches the search pattern's case exactly.
r Searches from right to left through lines.
f Searches from left-to-right through lines.

2. Press ENTER.

If the text is not found, the message String not found is displayed. If the text is found, you see the message Yes/No/Last/Go/Quit? near the bottom of the screen.

3. Answer the question when the text is found by typing one of the following:

 y Makes the change for this one item and searches for the next occurrence.
 n Skips the change and searches for the next occurrence.
 l Replaces this last one and then stop.
 g Goes ahead and replaces the remaining occurrences without prompting for each occurrence.
 q Stops making any further changes and discontinues the search. You can also press ESC.
Then, from the E Editor command line, either:

Press CTRL+F To find the next occurrence of the specified text.

or

Type C To repeat the same C (change) command without having to retype the C (change) command. You are immediately asked Yes/No/Last/Go/Quit?

or

Press ESC To put the cursor back in the text area.

The C (change) command leaves the cursor in the text area, not on the E Editor command line.

The C (change) command continues to search through the file each time you press CTRL+F until it reaches the end of the file.

Here are some examples of C (change) commands:

- In the following example, you are prompted to answer each time the word “bills” is found whether you want to make the change, not change this instance but search for the next occurrence, replace this one and stop, or replace this one and all the rest without prompting.

  c /bills/invoices/

- Any search string delimiter (not only the slash /) can be used after the C (change) command. You need this if the search string itself contains a slash. When used with the slash delimiters (/), the C (change) command does not require a blank between the C and the /. However, if you are using a different delimiter, a blank space is required between the "C" and the delimiter. The same is true of the L (locate) command.

  For example, typing:

  c $/$\$

  changes the / to a \

- Multiple options can be given at one time, such as:

  /helper/-re

  If contradictory options are given (such as /rf), only the last option is the one remembered.

  In this example, the E Editor searches for the word “helper” from the current line backwards in the file, searches from right to left in the lines, and finds only the word “helper” and matching capitalization exactly while it is searching.
Drawing Lines

You can use graphics characters to draw boxes and diagrams. The DRAW command can be typed at the E Editor command line:

```
draw
```

You can also press F6.

To select drawing mode, you must issue the DRAW command with one of these arguments:

<table>
<thead>
<tr>
<th>Draw Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Draws a thin, single line</td>
</tr>
<tr>
<td>2</td>
<td>Draws a thin, double line</td>
</tr>
<tr>
<td>3</td>
<td>Draws a dotted line</td>
</tr>
<tr>
<td>4</td>
<td>Draws a thick line</td>
</tr>
<tr>
<td>5</td>
<td>Draws a double, thin line horizontally; single, thin line vertically</td>
</tr>
<tr>
<td>6</td>
<td>Draws a double, thin line vertically; draws a single, thin line horizontally.</td>
</tr>
</tbody>
</table>

`/character` Uses any character that follows the slash (/) to form a box.

**Note:** Draw options 5 and 6 apply only if you are using code page 437.

If you type the DRAW command without any arguments, the visual representations: 1, 2, 3, 4, 5, 6, B, or /any char appear at the bottom of the screen as a reminder. For example:

```
draw 2
```

You are now in draw mode, which means that the cursor acts like a paint brush: everywhere you move the cursor, a double line (because you typed 2) is drawn.

Draw any shape with the cursor using the arrow keys (LEFT, RIGHT, UP, and DOWN). While in the drawing mode, you can stop drawing the double line and type in text or move the cursor to another location without drawing anything (in other words, lift the paint brush) by pressing the INSERT key. This key suspends the drawing without exiting from draw mode.

To begin drawing again, simply press the INSERT key again. Pressing any key besides those on the numeric key pad ends draw mode.
You can draw figures with characters other than the line graphics characters provided. For example, if you want to draw figures composed of the left parentheses, you would type at the E Editor command line:

```
draw /(
```

This process works with any character on the keyboard, as long as you precede the character with a slash (/).

**Creating Boxes Around Text**

You can use graphics characters to draw boxes. The BOX command can be typed at the E Editor command line:

```
box
```

To create a box, you must issue the BOX command at the E Editor command line with one of these arguments:

<table>
<thead>
<tr>
<th>Box Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Creates a box comment using Assembler syntax.</td>
</tr>
<tr>
<td>B</td>
<td>Places spaces on all sides of the marked area, creating a box of blank spaces.</td>
</tr>
<tr>
<td>C</td>
<td>Creates a box comment using C language syntax.</td>
</tr>
<tr>
<td>E</td>
<td>Erases the box around the marked area.</td>
</tr>
<tr>
<td>P</td>
<td>Creates a box comment using Pascal language syntax.</td>
</tr>
<tr>
<td>R</td>
<td>Reflows text in the marked area.</td>
</tr>
<tr>
<td>S</td>
<td>Places a SCRIPT comment box around the marked area.</td>
</tr>
</tbody>
</table>

If you type the BOX command without any arguments, the visual representations for: 1, 2, 3, 4, 5, 6, 8, /x, P, C, A, E, R, and S appear at the bottom of the screen as a reminder.

For example, for a double line, you could type:

```
box 2
```

**Combining Files**

Three E Editor commands can be used to pull text from one file and place it into a different file: GET, PUT, and APPEND.

The E Editor allows you to have multiple files open at one time. You can mark text in one file and insert that text into another file you have open.
For example, you just finished a note summarizing your monthly activities in which you listed some statistics you want to put in a second file. You do not want to insert the entire note; you want only the statistical information pulled into a second file.

**To use the GET command to insert another file into an opened file:**

1. Open the file you want to pull information into.
   
   For example, open a file named NEWFILE.TXT by typing the following:
   ```
   e c:\newfile.txt
   ```

2. Place the cursor at the top of the file because this is a new file without any current information in it.
   
   Normally you would place the cursor on an existing line, just above where you want to insert the file. Then use the GET command and the information from the other file will be pulled in following the line where the cursor is.

3. Press ESC to get to the E Editor command line.

4. Type the GET command using the following format:
   ```
   get filespec
   ```
   Substitute the full path and file name of the file you want to insert. For example, to pull the entire C:\REPORTS.TXT file into the C:\NEWFILE.TXT file, type the following at the E Editor command line:
   ```
   get c:\reports.txt
   ```

5. Press ENTER.
   
   The entire file is pulled into the NEWFILE.TXT file, following the line where the cursor is placed.

**To use the PUT command to insert a file or part of the file into another file:**

1. Open a file that contains information you want to put into another file.
   
   For example, open a file named NEWFILE.TXT by typing the following:
   ```
   e c:\newfile.txt
   ```

2. Mark the text you want to put into another file by using the line-mark keys combination ALT+L. If you do not mark any text, the entire file will be inserted.

3. Press ESC to get to the E Editor command line.

4. Type the PUT command using the following format:
   ```
   put filespec
   ```
Substitute the full path and file name of the file you want to insert the marked text into. The file can be a file that already exists or a new file.

For example, to pull the marked text from the file C:\NEWFILE.TXT into the C:\REPORTS.TXT file, type the following at the E Editor command line:

```
put c:\reports.txt
```

and press ENTER.

The marked text or the complete opened file (NEWFILE.TXT) is always written to the file specified in the PUT command (REPORTS.TXT).

Only the marked text is inserted into the REPORTS.TXT file. If the file already exists, the information can be placed only at the bottom of the file; the file is not overwritten.

If you use the PUT command to insert an entire file, you do not have to open or mark the text first.

For convenience, filespec can be omitted if you want to repeat a PUT to the same file. PUT commands without a filespec reuse the last-specified name.

If you do not move the cursor and do another PUT command, the text from the second PUT command is inserted immediately following the text inserted from the first PUT command.

**To print using the PUT command:**

You can print a marked block of text by issuing PUT prn at the E Editor command line. The readiness of the printer is tested first to avoid having to wait for a device time-out in case the printer is offline. The PRINT command allows you to print only marked text.

If no text is marked, the entire current file will be printed.

**To append text to the bottom of a file:**

The APPEND command works the same way the PUT command works, appending the text to the bottom of a file.

**To use the equal sign to repeat the file name:**

You can use the equal sign (=) as a shorthand for either the current file’s directory or file name. Remember that the equal sign is shorthand for “same path as last specified” at the DOS command prompt, or “same path as current file’s” at the E Editor command line.
For example, you are currently editing a file named REPORT1.TXT located in the C:\REPORTS subdirectory. You want to edit REPORT2 in the same subdirectory. At the E Editor command line, type:

e =report2.txt

The file's path and file name can be seen as C:REPORTS\REPORT2.TXT near the bottom left-hand part of the screen.

Adding and Multiplying Numbers
If you need to add columns or rows of numbers, the E Editor provides both an ADD and a MULTIPLY command. See "Calculating Mathematical Expressions" for the proper format.

To add or multiply a column or row of numbers:

1. Mark the text you wish to add or multiply.
   You can do this by pressing ALT+B once at the top left-hand corner of the column and again at the bottom right-hand corner of the column of numbers. When you finish marking the end of the text, the text is highlighted to show you the column of text you have marked.

2. Press ESC to get to the E command line at the bottom of your screen.

3. Type add or type mul depending on the type of operation you want to perform.

4. Press ENTER.

To return the cursor to the text area, press ESC.

Calculating Mathematical Expressions
If you need to add, subtract, multiply, or divide hex, octal, binary, or decimal numbers, the E Editor provides a set of MATH commands that compute an arithmetic expression of the following format:

arithmic expression: arith term arith operator arith term

arith term: decimal number
    | binary number
    | hex number
    | octal number
    | '( arithmic expression ')' 

arith operator: '+'
    | '-'
    | '*'
    | '/'

Chapter 10. Working with the Text Editor 167
Binary (base 2) numbers must be preceded by the letter “b”. Hexadecimal (base 16) numbers must be preceded by the letter “x”, (for example, x10 = 16). Octal (base 8) numbers must be preceded by the letter “o” (for example, o12 = 10).

<table>
<thead>
<tr>
<th>Math Command</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>math arithmetic expression</td>
<td>The MATH command computes the expression and appends the result as a decimal number.</td>
</tr>
<tr>
<td>mathx arithmetic expression</td>
<td>The MATHX command computes the expression and appends the result as a hexadecimal number.</td>
</tr>
<tr>
<td>matho arithmetic expression</td>
<td>The MATHO command computes the expression and appends the result as an octal number.</td>
</tr>
<tr>
<td>mathb arithmetic expression</td>
<td>The MATHB command computes the expression and appends the result as a binary number.</td>
</tr>
</tbody>
</table>

Try some of the following MATH commands. If your cursor is not on the highlighted E Editor command line, press ESC.

```plaintext
math -10 + 40
mathx -xff + 10
mathb b10 + b01
matho o11 * (xff - 10)
math 32000 + 32000
```

The above examples would yield 30, xFF0B, b11, o4235, and 64000, respectively. All numbers, answers, and intermediate results are limited to the range -2,147,483,648 to 2,147,483,647 for octal, hexadecimal, and binary.

**Notes:**

1. For decimal numbers the range is 19 significant digits. For example, you could have the number 1 (and eighteen zeros). Of course, the zeros would not be displayed in an actual calculation.

2. Use the PC DOS ACALC command from the E Editor command line for many more functions. Type `help acalc` for more information about the ACALC command.

**Summary of E Editor Commands**

A summary of the E Editor commands and the tasks that can be performed by them from the E Editor command line is provided in the online *PC DOS 7 Command Reference*. This summary can be found in the information about the E Editor by typing `help e` at the DOS command prompt.
Customizing the E Editor

Ways you can customize the E Editor include:

- Changing the way the window appears, such as to a non-overlapping (tiled) window or an overlapping (messy) window.
- Entering control and graphic characters
- Using syntax-directed editing features

Changing to a Non-Overlapping (Tiled) Window

The E Editor provides two styles of windowing. In the *tiled* (non-overlapping) window style, which is how the E Editor window normally appears, the windows do not overlap. This allows changes to your file to be shown immediately in neighboring views of the same file.

You can see this with a quick experiment: Press CTRL+H to split the screen into two horizontal views of the same file and type.

Tiled windows cannot be resized or moved around the screen because this might cause one window to overlap another. Tiled windowing also has the interesting characteristic that each window or *tile* contains the same ring of files as the other tiles or windows. Simply press CTRL+W when you are in the text area to alternate between the tiles. Each tile keeps track of its own cursor position so that you can edit two places in the same file without having to page up or page down.

Changing to an Overlapping (Messy) Window

In *messy* (overlapping) desktop, the windows can overlap. You use the SIZE and DRAG commands to select the window's size and position.

To acquire a messy window mode, edit the E.INI file. Refer to information about the E.INI file in the online *PC DOS 7 Command Reference* for more information.
<table>
<thead>
<tr>
<th>Keys or Command</th>
<th>How it customizes the window</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+A</td>
<td>Selects next tiled window configuration. There are four different window arrangements you can use if you have specified tiled windows. You can view all four window configurations by continuing to press CTRL+A to view each window configuration.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> CTRL+A can be used only in tiled windows.</td>
</tr>
<tr>
<td></td>
<td>One window zoomed to fill the screen.</td>
</tr>
<tr>
<td></td>
<td>Two equal windows positioned vertically.</td>
</tr>
<tr>
<td></td>
<td>Four windows divided into four equally sized windows.</td>
</tr>
<tr>
<td></td>
<td>Two equal windows positioned horizontally.</td>
</tr>
<tr>
<td>CTRL+H</td>
<td>Selects two horizontal, window-tile configuration.</td>
</tr>
<tr>
<td>CTRL+N</td>
<td>Switches to next file when you have multiple files open.</td>
</tr>
<tr>
<td>CTRL+P</td>
<td>Switches to previous file when you have multiple files open.</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Selects two vertical, window-tile configuration.</td>
</tr>
<tr>
<td>CTRL+W</td>
<td>Switches to next window.</td>
</tr>
<tr>
<td>CTRL+Z</td>
<td>Switches to one fully-zoomed, window-tile configuration. In the messy desktop configuration, this expands the current window to full screen.</td>
</tr>
<tr>
<td>F10</td>
<td>Jumps to the E Editor menu. Then the arrow keys can be used to highlight menu selections and access the menu for each choice.</td>
</tr>
<tr>
<td>F11</td>
<td>Switches to previous file when you have multiple files open.</td>
</tr>
<tr>
<td>F12</td>
<td>Switches to next file when you have multiple files open.</td>
</tr>
<tr>
<td>SIZE command</td>
<td>Resizes a window. It is used only for the messy desktop window configuration.</td>
</tr>
<tr>
<td>DRAG command</td>
<td>Moves a window. It is used only for the messy desktop window configuration.</td>
</tr>
</tbody>
</table>

**Entering Control and Graphic Characters**

You can enter PC graphic characters (those with extended ASCII codes greater than 127) with ALT+keypad numbers.

For example, to enter the symbol for the Greek character pi (represented by the code 227):

1. Press ALT and continue holding the key down.
2. Type 227 on the numeric keypad.
3. Release ALT.
Graphic symbols with codes less than 32 might be harder to enter because they conflict with control characters recognized by the E Editor. You might want to enter the character with code 12 because you like the looks of the graphic symbol or because you wish to send that control code to a printer. Code 12 is the same as CTRL+L, which is recognized as formfeeding by printers. You cannot type it simply by pressing CTRL+L because a CTRL+L is recognized by the E Editor as a special action (copy the current line of text to the command line).

In such a case, you can force the E Editor to accept the code without evaluation by prefacing it with ALT+X. Press ALT+X first, followed by CTRL+L and then press ENTER.

**Note:** ALT+X is only necessary if the key has already been defined. But pressing ALT+X is always safe. If you are unsure whether the key is predefined, press ALT+X first.

You can also follow ALT+X with an extended key such as F1, but this is seldom useful. Extended keys are represented on the computer by two characters, a null (ASCII zero, which looks like a blank) with another character. For instance, F1 gives you a null with a semicolon.

The E Editor cannot handle the following graphic characters, as they have special control meanings:

- Tab \( x'09' \)
- Line Feed \( x'0A' \)
- Carriage Return \( x'0D' \)
- End of File \( x'1A' \) (only following a CR/LF)

**Using Syntax-Directed Editing Features**

The E Editor has an optional syntax-directed editing feature for REXX and C language files. The feature is defaulted to ON. You can modify the option from the E Editor command line or by editing the E.INI file.

If you modify the feature by editing the E.INI file, you can specify a new default value. Modifying the feature from the E Editor command line only provides a temporary override of the default values.

You can also modify the syntax-directed editing indentation. The indentation feature allows you to customize both REXX and C language file indentation, independently. These features may be modified only by editing the E.INI file.

Syntax-directed editing is provided when a language-specific keyword is combined with a special key. For example, in REXX the language keyword IF is followed by the special key, SPACEBAR.
A REXX language file is identified when "/*" are the first two characters of a file having the extension .BAT or .CMD. A C-language file is identified by a .C, .CPP, .H, or .HPP extension.

Typical syntax-directed editing features can be demonstrated by the following sequence.

**To try an example of syntax-directory editing:**

1. Type `e newfile.c`
   
   This example uses the file name of NEWFILE.C. Remember that the file's extension must be .C or .BAT for syntax-directed editing to work.

   **Note:** For REXX expansion to work when you have a .BAT file, the first line must have a comment that begins with /*.

2. Type `main` and press the SPACEBAR.

3. Enter the main statement.

4. Type `if` and press the SPACEBAR.

This sequence edits a new file called NEWFILE.C. Pressing the SPACEBAR in both instances above inserts the remainder of the MAIN and IF structures.

When automatic syntax expansion is OFF, you can force expansion to occur by pressing CTRL+X.

Box comments can also be created easily, according to the syntax particular to the language.

More information about using the syntax-directed editing features is provided in the online *PC DOS 7 Command Reference*. This information can be found by typing `help e` at the DOS command prompt.

---

**Comparing a Text Editor and a Word Processing Program**

A text editor, sometimes referred to as an editing tool, differs from a word processing program in the following ways:

- Files you create by using the text editor are unformatted text files, such as ASCII text files, which means they do not contain any special formatting characters. If you save such a file when using a text editor, the special characters of the word processing program may lose their formatting function.

Because DOS batch programs and files, such as AUTOEXEC.BAT and CONFIG.SYS, must be unformatted text files, text editors are a useful tool for customizing your system.
• When you reach the end of a line using a text editor, you must press ENTER to move the cursor to the next line because there is no "word wrap" feature associated with a text editor. A line of text can be up to 255 characters long.

**Note:** There are things you can do to overcome this problem and others associated with most text editors by using the flexibility built into the E Editor. For instance, you can set margins or you can use the default margins of the E Editor which are 1 and 254. When your line of text reaches 254 it automatically wraps to the next line. This chapter helps you take advantage of this type of E Editor flexibility.

• Unlike word processing programs that always place files in a specific directory, you must specify the exact location (full path) where you want to place the file when using a text editor.

• A text editor can have its own command line within the program. This command line is not the same command line as the DOS command prompt. Other editors' command lines allow you to type editor commands used only for performing tasks within the text editor. However, the E Editor also allows you to type DOS commands at the E Editor command line.

Although not designed to be a word processor, the flexibility of the E Editor allows it to be modified to make it "act" more like a word processing program, such as:

• Set the margins before you start typing (for example, type `margins 10 70`). The text then "word wraps" when it reaches the right margin you have set. Setting margins eliminates your having to press ENTER at the end of each line of text; press ENTER only to start a new paragraph.

• Use the Autosave feature to automatically get temporary backup versions of your files.

• Make menu selections using a mouse for performing editing tasks. You can select items from the menu by doing one of the following:
  - Using the mouse to click on a selection
  - Pressing F10
  - Pressing ALT

• You can load up to 35 files into the E Editor and toggle back and forth to work on them as though these files were in a ring.
Chapter 11. Connecting Computers

Using the InterLnk utility programs (INTERLNK.EXE and INTERSVR.EXE) and a cable, you can easily connect one computer to another computer to:

- Transfer files between computers.
- Use one computer to run programs located on another computer.
- Access information without having to copy files from one computer to another using diskettes.

Assume you regularly gather information in the field using your laptop computer to record the information. When you return to the home office, you need to transfer the information to a database on your desktop computer. Using the InterLnk program, you can directly add the information you have gathered to the database on your desktop computer and print out the new information without copying files to and from diskettes.
Establishing the Connection between Computers

The following hardware, software, and available memory requirements must be met before you can use INTERLNK:

- Two computers running DOS Version 5.02 or higher. Running this version of DOS ensures that both the INTERLNK.EXE and INTERSVR.EXE files are available.

If you do not have DOS Version 5.02 or higher on one of the computers, refer to “Remote Copying of INTERSVR.EXE and INTERLNK.EXE Files” on page 183.

You can also have a configuration that consists of a computer running OS/2 2.1 or greater and a computer running DOS Version 5.02 or greater. The computer running OS/2 must be designated as the client and can only run INTERLNK. The computer running DOS must be designated as the server and can only run INTERSVR. See “Using INTERLNK on OS/2” on page 185 for more information.

- An available serial or parallel port on each computer. Your cable connection must be serial-to-serial or parallel-to-parallel; if you have an available serial port, the second computer must also have an available serial port.

CAUTION:
Plugging a parallel cable into a serial connector or vice versa will damage your computer system.

- A type of connecting serial or parallel cable, such as:
  - A 3-wire, serial cable
  - A bidirectional parallel cable
  - A 7-wire, null-modem, serial cable (only used for the remote installation)

Refer to “Reviewing Cable Specifications” on page 184 for specific details on how to wire the pin connections for serial and parallel cables. The file-transfer utility programs support serial links using a null-modem cable, and serial and parallel links that use cables provided with FastLynx**, LapLink**, and Brooklyn Bridge** products.

** FastLynx is a trademark of the Rupp Corporation.
** LapLink is a trademark of Traveling Software, Inc.
** Brooklyn Bridge is a trademark of Fifth Generation Systems, Inc.
• 16K of free memory on the client computer and 130K of free memory on the server computer.

• The INTERLNK.EXE device driver statement in your CONFIG.SYS file on the designated client computer. Instructions on how to add this statement are given later in this chapter.

Understanding What the InterLnk Program Does

InterLnk is specifically designed to let you exchange files between any two types of computers (for example, laptop to desktop or desktop to desktop) that can be connected by cables. InterLnk consists of two, separate file-transfer utility programs:

- INTERLNK.EXE
- INTERSVR.EXE

Client and Server Relationship

Before you begin using these two programs, INTERLNK and INTERSVR, you need to understand the client and server relationship.

**Client**

The computer you use to enter commands is called the client. After a connection is made to the server computer, the client computer presumes that the server computer’s drives and printers are its own, giving it accessibility to additional information, files, and printers.

The client runs the INTERLNK.EXE program.

**Server**

The computer connected to the client is the server, which is dedicated to serving the client. The server computer runs the file-transfer program.

The server runs the INTERSVR.EXE program.

Using the InterLnk program, you can create a client/server relationship between two computers.

Once a connection is made to the server computer, you can do the same things with the server computer’s drives and printers that you can do with your own computer, the client. If you connect a laptop to a desktop computer, the laptop is generally the client.

After you connect your computers and start the InterLnk program, you can use a laptop or other computer (as the client) to access data on both it and your desktop computer. The screen of the desktop computer (the server) displays the status of
the connection. You use the desktop computer keyboard only to break the connection between the two computers.

Suppose the laptop computer has three drives: a diskette drive (A) and two hard disk drives (C and D). The desktop computer also has three drives: two diskette drives (A and B) and a hard disk drive (C), similar to the following:

<table>
<thead>
<tr>
<th>Laptop Drives</th>
<th>Desktop Drives</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>C</td>
<td>B</td>
</tr>
<tr>
<td>D</td>
<td>C</td>
</tr>
</tbody>
</table>

With the InterLnk program connecting the two computers, drives on the desktop computer (the server) appear as additional drives on the laptop computer (the client). In addition to drives A, C, and D, the laptop computer now includes drives E, F, and G, which have been redirected from the desktop computer.

For example, if you typed the following command on the laptop computer, you see displayed a list of files located in the root directory of a diskette inserted into drive A of the desktop computer:

```
dir e:
```

A list similar to the illustration is displayed on your computer’s screen:

```
This Computer   Other Computer
(Client)        (Server)
E: equals       A:             
F: equals       B:             
G: equals       C:             
```

This list displays how the drives were redirected. You see E equals A displayed. “E equals A” means that drive E of the client (laptop) is redirected to drive A of the server (desktop).

The server’s drives A, B, and C are now presumed to be the client’s drives E, F, and G. If you make drive E your current drive on the laptop computer, any commands you type on the laptop are carried out on the drive A of the desktop computer.

Note that the InterLnk program assigns the drive letters, starting after the last drive letter, and does not fill in any missing drive letters such as the missing drive B, as is the case with most laptop computers.
Client Device Driver (INTERLNK.EXE)

INTERLNK is a single device driver performing either serial or parallel communication. This program redirects server drives and printers, meaning that the drives and printers from both computers can be controlled from one computer keyboard.

When you connect your computers and start INTERLNK and INTERSVR on the server, the server displays the way your drives are mapped. You can change which drives and printers have access by redirecting or remapping the server drives to the client drives. You can access only six drives at one time. If the drive or printer you need to access is not one of the six currently listed, you will need to redirect the drives or printers so the drive or printer is one of the six.

INTERLNK does not require any special switches or parameters for most configurations. Serial and parallel communications support and printer support are installed by default. Hardware ports and interrupt levels are set up automatically. INTERLNK loads itself into upper memory when upper memory blocks are available from DOS, unless you have set up the RAMBoost program to optimize your upper memory blocks.

For more information about INTERLNK or INTERLNK.EXE, see your online PC DOS 7 Command Reference. Or, type either help interlnk or help interlnk.exe at the DOS command prompt.

INTERLNK Server Program (INTERSVR.EXE)

INTERSVR is a dedicated, full-screen program, used for communicating with the client computer through serial and parallel lines. The server allows use of local drives and attached printers by the client computer.

The server program provides an interactive user interface and a command line option to do the following:

- Exclude certain drives from the server.
  Refer to "Excluding Drives from Redirection" on page 183.
- Sequence the offering of drives.
  For example, if you have five drives (A through E, of which A and B are empty diskette drives on the server computer) and the client has only three drives available, the normal sequencing would map or assign the letters A, B, and C.
To ignore drives A and B, you can type the following on the server to sequence the drives:

    intersvr c: d: e:

While the server does not require any interaction after it is started, it provides the following types of feedback:

- Current state of drive mappings and printer redirection
- Drives that are offered
- Current baud rate (speed of data transmission)
- Drive activity
- Port you are connected to (a COM port means DOS searches only for serial ports; an LPT port means DOS searches only for parallel ports)

**Note:** Network drives cannot be redirected by this program.

For a list of the options available with INTERSVR, type `help intersvr` at the DOS command prompt.

---

**Including INTERLNK in Your CONFIG.SYS File**

On the client computer, use a text editor, such as the E Editor provided with DOS, and add the following device driver statement to your CONFIG.SYS file:

    device=c:\dos\interlnk.exe

By default, you are allowed to redirect three drives from the server. To redirect more than three, you must add the `/drive` switch to specify a number other than three or to specify no drives at all if you want to redirect only printers. For example, if you wanted to redirect four drives, type:

    device=c:\dos\interlnk.exe /drives:4

If you are using a RAM drive, place the `DEVICE=INTERLNK.EXE` statement after the `DEVICE=RAMDRIVE.SYS` line to prevent INTERLNK from redirecting these drives first.

After you have added the device driver statement in your CONFIG.SYS file, restart the client computer by pressing CTRL+ALT+DEL. Restarting the client computer loads INTERLNK.
Running the InterLnk Program

Before you start the InterLnk program, make sure you have physically connected your computers by attaching the appropriate cables to the ports, either serial-to-serial or parallel-to-parallel.

To start the InterLnk program:

1. On the server computer, type the following at the DOS command prompt for a serial connection:
   
   `intersvr`

   Or, type the following on the server computer at the DOS command prompt for a parallel connection:

   `intersvr /lpt1`:

   You see a screen displaying the server drives similar to the following:

   **This Computer**
   **(Server)**
   
   **Other Computer**
   **(Client)**
   
   *==*==*==*==*

   | A:   | equals | D: |
   | B:   | equals | E: |
   | C:   | equals | F: |
   | D:   | equals | G: |
   | LPT1:| equals | LPT2: |

   *If you are running Windows, you will see a task-swapping message; if you are running DOS, you will not see this message. Press ENTER to continue or press F3 to quit.*

2. On the client computer, make sure you have added the device driver statement in your CONFIG.SYS file (see “Including INTERLNK in Your CONFIG.SYS File” on page 180).

   INTERLNK attempts to load this program into upper memory blocks if they are available; if they are not available, it loads into conventional memory. By default, INTERLNK remains in memory whether it finds another computer to connect with unless you specify the /noscan switch.

3. Verify that the InterLnk program is loaded and view the status of the connections by typing the following at the DOS command prompt of the client computer:

   `interlnk`
You see a screen displaying the drives that are connected similar to the following:

<table>
<thead>
<tr>
<th>This Computer (Client)</th>
<th>Other Computer (Server)</th>
</tr>
</thead>
<tbody>
<tr>
<td>D: equals</td>
<td>A:</td>
</tr>
<tr>
<td>E: equals</td>
<td>B:</td>
</tr>
<tr>
<td>F: equals</td>
<td>C:</td>
</tr>
<tr>
<td>G: equals</td>
<td>D:</td>
</tr>
<tr>
<td>LPT2: equals</td>
<td>LPT1:</td>
</tr>
</tbody>
</table>

You are now able to access the drives of the server computer as though they were located on your client computer. If you need different drives than the ones currently accessed, redirect the drives.

When you are finished, press ALT+F4 on the server. The server returns to the DOS command prompt and the client no longer has access to the server’s drives.

Redirecting Drives

If a device was assigned when you started INTERLNK, you can redirect the device on the client by using the INTERLNK command and specifying the server drive you want to redirect it to. Suppose that client drive D is redirected to server drive A, and the other drives are redirected as in the following example:

<table>
<thead>
<tr>
<th>This Computer (Client)</th>
<th>Other Computer (Server)</th>
</tr>
</thead>
<tbody>
<tr>
<td>D: equals</td>
<td>A:</td>
</tr>
<tr>
<td>E: equals</td>
<td>B:</td>
</tr>
<tr>
<td>F: equals</td>
<td>C:</td>
</tr>
<tr>
<td>LPT2: equals</td>
<td>LPT1:</td>
</tr>
</tbody>
</table>

To redirect client drive D to server drive C, type the following at the client workstation:

    interlnk d=c

To cancel the redirection of client drive D, do not specify a server drive, as follows:

    interlnk d=
Excluding Drives from Redirection

On the server computer, if you want to exclude a drive from redirection and make it unavailable to the client system, add the /x switch followed by the letter of the drive you want to exclude, such as:

intersvr /x:d

Breaking the Connection between Computers

To break the INTERLNK connection between computers and stop the server, press ALT+F4 on the keyboard of the server computer.

To restart the server, type:
intersvr

Remote Copying of INTERSVR.EXE and INTERLNK.EXE Files

If, for some reason, you do not have DOS Version 5.02 or later installed on one of your computers, you will need to copy the INTERLNK.EXE and INTERSVR.EXE program files to the computer that does not have these files before you can run the InterLnk program. Although you need only the INTERLNK.EXE file for the client computer and the INTERSVR.EXE for the server computer, both files can reside on each computer.

To copy files remotely:

1. If the server computer is connected to the client computer by a 7-wire null-modem serial cable, type the following at the server computer command prompt:

intersvr /rcopy

The INTERLNK Remote Installation screen is displayed.

2. Specify the serial port of the other computer by using the direction arrows until you highlight the COM (serial) port you will use and press ENTER.

3. Type on the client computer the MODE command you see displayed on the server computer. For example, you might type something similar to:

mode com1:2400,n,8,1,p

which specifies a configuration for the serial port you have selected of 2400 baud, no parity, 8 bits, and 1 stop bit. The p parameter tells the program to keep trying to configure the port until a confirmation message is received that it has been reconfigured.

4. Press ENTER.
5. Instruct DOS to accept the input from the COM1 port by typing:

```bash
ctty com1
```

The program is uploaded and sends a program which then receives the INTERSVR.EXE and the INTERLNK.EXE files automatically.

Also, you can copy the INTERSVR.EXE and INTERLNK.EXE files to a diskette and then copy the files to the other computer, placing the files in the \DOS directory.

---

**Reviewing Cable Specifications**

The file-transfer utility programs support serial links using a null-modem cable, such as LapLink or FastLynx cable. These programs interact directly with the serial port hardware instead of the computer's BIOS to make the connection. In most cases, for these programs the connecting cable is a serial cable. However, if the parallel ports on both systems are bidirectional, you will be able to use a parallel cable. You can create your own serial or parallel cable using the wiring tables below.

If you want to use a serial port to transfer your data, then you must use the null-modem cable. Connect the null-modem cable to the serial port on your computer.

To use the file-transfer utility programs, you need the following:

- Two computers with DOS 5.02 or higher installed on each computer.
  
  If you do not have DOS Version 5.02 or higher on one of the computers, refer to “Remote Copying of INTERSVR.EXE and INTERLNK.EXE Files” on page 183.

- A null-modem cable to connect to the serial ports of your computers or a parallel cable to connect to the parallel ports of your computers.

---

**Serial Cable**

There are two kinds of physical RS-232 ports used by DOS—9 pin (DB9) and 25-pin (DB25). Use the following table to wire the pin connections for a serial cable.

<table>
<thead>
<tr>
<th>9 Pin</th>
<th>25 Pin</th>
<th>25 Pin</th>
<th>9 Pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>pin 5</td>
<td>pin 7</td>
<td>&lt;--------&gt;</td>
<td>pin 7</td>
</tr>
<tr>
<td>pin 3</td>
<td>pin 2</td>
<td>&lt;--------&gt;</td>
<td>pin 3</td>
</tr>
<tr>
<td>pin 7</td>
<td>pin 4</td>
<td>&lt;--------&gt;</td>
<td>pin 5</td>
</tr>
<tr>
<td>pin 6</td>
<td>pin 6</td>
<td>&lt;--------&gt;</td>
<td>pin 20</td>
</tr>
<tr>
<td>pin 2</td>
<td>pin 3</td>
<td>&lt;--------&gt;</td>
<td>pin 2</td>
</tr>
<tr>
<td>pin 8</td>
<td>pin 5</td>
<td>&lt;--------&gt;</td>
<td>pin 4</td>
</tr>
<tr>
<td>pin 4</td>
<td>pin 20</td>
<td>&lt;--------&gt;</td>
<td>pin 6</td>
</tr>
</tbody>
</table>
**Note:** The ground wire is connected to the same pin on both ends. The last three wires are the reverse of the prior three.

**Parallel Cable**
Use the following table to wire the pin connections for a parallel cable.

<table>
<thead>
<tr>
<th>25 Pin</th>
<th></th>
<th>25 Pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>pin 2</td>
<td></td>
<td>pin 15</td>
</tr>
<tr>
<td>pin 3</td>
<td></td>
<td>pin 13</td>
</tr>
<tr>
<td>pin 4</td>
<td></td>
<td>pin 12</td>
</tr>
<tr>
<td>pin 5</td>
<td></td>
<td>pin 10</td>
</tr>
<tr>
<td>pin 6</td>
<td></td>
<td>pin 11</td>
</tr>
<tr>
<td>pin 15</td>
<td></td>
<td>pin 2</td>
</tr>
<tr>
<td>pin 13</td>
<td></td>
<td>pin 3</td>
</tr>
<tr>
<td>pin 12</td>
<td></td>
<td>pin 4</td>
</tr>
<tr>
<td>pin 10</td>
<td></td>
<td>pin 5</td>
</tr>
<tr>
<td>pin 11</td>
<td></td>
<td>pin 6</td>
</tr>
<tr>
<td>pin 25</td>
<td></td>
<td>pin 25</td>
</tr>
</tbody>
</table>

**Note:** Pin 25 to pin 25 is the ground-to-ground connection for this cable-wiring table.

**Using INTERLNK on OS/2**
INTERLNK can be run only on OS/2 2.1 or OS/2 WARP V3.0 as a client.

**To set up the InterLink environment on OS/2:**
1. Insert a blank diskette into drive A of the computer running DOS.
2. At the DOS command prompt, type the following command to format the diskette:
   ```
   format a: /s
   ```
3. Use a text editor to create a CONFIG.SYS file on the diskette in drive A. The CONFIG.SYS file on the diskette should contain the following lines:
   ```
   DEVICE=FSFILTER.SYS
   DEVICE=INTERLNK.EXE
   ```
   You might need to include additional parameters with INTERLNK.EXE. Type `help interlnk.exe` for more information.
4. Copy the INTERLNK.EXE file from your DOS subdirectory to the same diskette already inserted into drive A.

5. Take the diskette from the computer running DOS, and insert it into drive A of the computer running OS/2.

6. Copy the FSFILTER.SYS file from the \OS2\MDOS subdirectory of your boot drive (generally drive C:) to the diskette in drive A.

7. At the OS/2 command prompt, type the following command to create a DOS image file:

   vmdisk a: c:\pcdos.img

   The name of the file must have the extension IMG (such as the example PCDOS.IMG). The PCDOS.IMG file can be located on any drive.

The following scenario is a representation only. Your desktop may not be set up exactly as is described here. However, you can use the steps presented as a guide to what needs to be done to create a PC DOS icon by copying another icon and linking it to a DOS sessions program.

To create a PC DOS image file:

1. From your OS/2 desktop, double-click on the OS/2 System icon.

2. Double-click on the Command Prompts icon.

3. Use mouse button 2 (right mouse button) and click on the DOS Window icon.

4. Click on Copy.

5. On the notebook page, enter the name you want for the icon's new name (for example, PC DOS).

6. Click on Copy.

7. Click on OK to create the icon.

8. On the OS/2 desktop, click on the new PC DOS icon you just created.

9. Click on the arrow to the right of Open.

10. Click on Settings.

11. While on the notebook page, click on the Session tab.

12. Click on the DOS Settings push button.
13. While in the notebook page for Settings: click on COM_DIRECT_ACCESS and then select On for the value.

14. Then click on DOS_STARTUP_DRIVE, enter an image name and path in the Value field. and then click on the Save button.

   **Note:** Enter the same path where you placed the PCDOS.IMG file earlier in this procedure.

15. Close the Settings notebook page by double-clicking on the title bar icon in the top-left corner.

16. Close all windows that are still open on the OS/2 desktop.

17. Go to the computer running PC DOS and start the server by typing the following at the DOS command prompt:

```
intersvr
```

18. Double-click on the PC DOS icon to get your DOS session.

The server and the client are now connected.
Chapter 12. Using File Update

Use the File Update Utility to maintain files on two different systems and keep them synchronized. The two systems can be two separate PCs, a PC and a local area network (LAN), or two different locations on the same PC. This is useful if you work with the same files on separate systems (for example, when you use a laptop on the road or take work home from the office). You can also use File Update to keep backup files of your work on another drive or partition.

This chapter describes how to install File Update on two systems (referred to as base and remote locations). It shows you how to set up your system and explains how to keep files in “sync” when you transfer them from one location to another. Before you install File Update, however, it is a good idea to make sure the time and date at both locations are the same. You must also know how files and directories are organized on both your systems. File Update tracks any changes that are made to the files and directories you specify.

Ask yourself:

- What are the names and extensions of the files you want tracked? For example, all files with a .TXT extension, such as REPORT.TXT.
- In what directories are these files located? For example, C:\COMPUTER\SALES at the base location and D:\SALES at the remote location.

You can use the TREE command to answer these questions. TREE displays the directory paths and files on your drives so that you know where things are. For example, if you want to list all directories and files on drive C and save the list in a file named TREE.OUT, type the following at the DOS command prompt:

```
tree c:/f >tree.out
```

You could also redirect the output to your printer by typing:

```
tree c:/f >prn
```
Installing File Update at the Base Location

To get started, you need to install File Update at the base location – the first system or location you want to install on. This procedure creates an installation diskette, which is used to install File Update at a remote location.

Notes:

- A blank, formatted diskette is required.
- The base system must have PC DOS 7 installed.
- The base location is the client machine for a system connected by Local Area Network (LAN) or the InterLnk program—a program that establishes a communications link between two types of computers connected with a cable.
- Use the TAB key to move from one input field to another. You can also use the mouse to click on an entry field or button.
- Windows Users: To access the DOS command prompt, select the PC DOS Prompt icon in the PC DOS 7 Tools group.

To install File Update at the base location:

1. At the DOS command prompt, type:
   
   fileup

2. Press ENTER. The Welcome screen is displayed.

If you receive a Bad command or file name message, make sure the program files (FILEUP.EXE and FILEUP.HLP) exist on your system. These files are installed with PC DOS and are usually found in the DOS subdirectory.
If File Update appears without a Welcome screen, the program has been installed. To reinstall, select Delete Installation from the Setup menu, and begin again with step 1.

3. Select Continue. The Location Names screen is displayed.

4. Create names to identify your base and remote locations (for example, WORK and HOME). Enter these names in the input fields.

5. Select Continue. The Program Path screen is displayed.

6. Make sure that the path listed is correct for the remote location program files (FILEUP.EXE and FILEUP.HLP).

File Update assumes the remote location path is the same as the base location path. If the program files are not in the remote location path, you will not be able to install File Update at the remote location.
7. Select Continue. The Add/Delete Directory Pairs screen is displayed.

8. Enter the drive and directory path, including all subdirectories, where you want File Update to track files (see "Notes" on page 193). Select Add after you enter a directory pair—the names of the directories you want to synchronize on the base and remote locations.

For example, if you type C:\COMPUTER\SALES at the base location and D:\SALES at the remote location, files in the C:\COMPUTER\SALES subdirectory are updated in D:\SALES at the remote location when you transfer the files.
Notes:

- The path you specify for the base location must currently exist. However, when a path does not exist at the remote location, it can be created for you when you transfer your updated files.

- You can come back after installation to add or delete directory pairs. Directory pairs can be the same drive and directories, different drives and directories, or the same drive but different directories.

- InterLnk and LAN Users: Specify the actual drive and path (not the remapped value). In other words, you know that drive G on your client machine equals drive C on your server. Do not specify drive G directories. File Update provides for drive remapping later in the process.

- If you make a mistake or want to delete a directory entry:
  a. Choose the directory entry in the Directory List.
  b. Select Delete to erase the directory information for both locations.

9. Select Continue. The Diskette Drive Selection screen is displayed.

10. Choose the diskette drive (drive A or B) where you want to create the File Update installation diskette.

11. Insert a blank, formatted diskette in the specified drive, and select Continue.

12. Select OK when installation is completed.

13. Label your diskette “File Update Installation”, and set it aside. You will use it later to install the File Update system files at the remote location.

   If your remote location is connected through LAN or InterLnk, you do not need to use the File Update Installation diskette again. You only need to remap the drives.
You have just completed File Update installation at the base location. Go to "Using File Update Menu Choices" to review menu choices and set up your system.

Important:
The Files Being Excluded choice in the Setup menu contains a default list of file extensions that are not being tracked. Be sure to review this list so that you do not have files missing when you transfer file updates. You can add extensions to the "excluded" list so that specific file types are not tracked. You can also delete any file extensions that you want File Update to include in its tracking.

Using File Update Menu Choices

After you install File Update at the base location, use menu choices to set up your system. Keep in mind that the Files Being Excluded choice in the Setup menu contains a default list of file extensions that are not being tracked. It is a good idea to review this list and make any necessary changes.

CAUTION:
Use care when deleting extensions from the default list. These extensions are excluded so that you do not replace files by mistake. For example, suppose you have a program named "ChartMaker" at both locations. You have version 1.0 on the base system and version 2.0 on the remote system. If you delete the "DLL" extension from Files Being Excluded, you will replace files with an incorrect DLL version, and ChartMaker will not run.

There are many useful choices from the Setup menu.

<table>
<thead>
<tr>
<th>You Can:</th>
<th>Setup Menu Choice:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or delete directories you want tracked (including all subdirectories).</td>
<td>Add Directory Pairs</td>
</tr>
<tr>
<td>Exclude specific file extensions from being tracked. (Files without extensions are always tracked.)</td>
<td>Files Being Excluded</td>
</tr>
<tr>
<td>Monitor specific file names (even if you excluded the file extension).</td>
<td>Override Excluded Files</td>
</tr>
<tr>
<td>Create an installation diskette (if you need to create another installation diskette).</td>
<td>Create Installation Diskette</td>
</tr>
<tr>
<td>Delete installation (to begin again and reinstall File Update).</td>
<td>Delete Installation</td>
</tr>
<tr>
<td>Display the path where the program files reside at the base and remote locations.</td>
<td>Display Install Data</td>
</tr>
</tbody>
</table>
You can also select choices from the File Update menu.

<table>
<thead>
<tr>
<th>You Can:</th>
<th>File Update Menu Choice</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preview</strong> – Display the files you updated since the last transfer and the number of diskettes you will need to complete the transfer.</td>
<td></td>
</tr>
<tr>
<td><strong>Update Files</strong> – Transfer updated files to diskette so you can transfer files from one location to the other.</td>
<td></td>
</tr>
<tr>
<td><strong>Custom File Selection</strong> – Control the type of update you want. You can copy:</td>
<td></td>
</tr>
<tr>
<td>• Changed files for all directory pairs</td>
<td></td>
</tr>
<tr>
<td>• All files for all directory pairs</td>
<td></td>
</tr>
<tr>
<td>• Changed files for all “selected” directory pairs</td>
<td></td>
</tr>
<tr>
<td>(Use this choice after you complete your first update.)</td>
<td></td>
</tr>
<tr>
<td><strong>Preview</strong> – Display the files on diskette that you are going to transfer.</td>
<td></td>
</tr>
<tr>
<td><strong>Update Files</strong> – Transfer updated files <em>from</em> the diskettes created in Update to Diskette.</td>
<td></td>
</tr>
<tr>
<td><strong>Preview</strong> – Display the files you updated since the last transfer.</td>
<td></td>
</tr>
<tr>
<td><strong>Update Files</strong> – Transfer updated files <em>from</em> your base location.</td>
<td></td>
</tr>
<tr>
<td><strong>Custom File Selection</strong> – Control the type of update you want. You can copy:</td>
<td></td>
</tr>
<tr>
<td>• Changed files for all directory pairs</td>
<td></td>
</tr>
<tr>
<td>• All files for all directory pairs</td>
<td></td>
</tr>
<tr>
<td>• Changed files for all “selected” directory pairs</td>
<td></td>
</tr>
<tr>
<td><strong>Re-Map Connected Drives</strong> – Remap drive letters. (Connected drive letters can change if you connect to a LAN or use a program such as InterLnk.)</td>
<td></td>
</tr>
<tr>
<td><strong>Update From Diskette</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Update Connected System</strong></td>
<td></td>
</tr>
</tbody>
</table>
Transferring Updated Files to the Remote Location

Now that you have installed File Update at the base location and set up your system, resume work on your files. When you are ready to transfer updated files to the remote location, follow the procedure for your particular remote location:

<table>
<thead>
<tr>
<th>Remote System</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC (not connected through InterLnk or LAN)</td>
<td>&quot;Installing on a PC.&quot;</td>
</tr>
<tr>
<td>PC (connected through InterLnk)</td>
<td>&quot;Installing on an InterLnk-Connected System&quot; on page 200.</td>
</tr>
<tr>
<td>Local Area Network (LAN)</td>
<td>&quot;Installing on a LAN-Connected System&quot; on page 202.</td>
</tr>
</tbody>
</table>

To find out more about the InterLnk program, refer to Chapter 11, "Connecting Computers" on page 175.

Installing on a PC

Follow these procedures if the remote location is a PC, or another drive or partition on the same PC.

1. “Transferring Updates from the Base Location to Diskette.”
3. “Transferring Updated Files to the Other Location” on page 199.

Transferring Updates from the Base Location to Diskette

To transfer updates to the remote location, you must first transfer updated files to diskette. After you transfer files from the base location to the remote location the first time, use this procedure to transfer files back and forth from one location to another.

*It is not necessary to manually copy and align files at both locations before using File Update.*
To transfer updates to diskette:

1. Select File Update.

2. Select Update To Diskette.

   You have the option to:

   a. Select Preview to display the estimated number of diskettes (by media type) it takes to copy the files that File Update is tracking.

   b. Select OK. The Status screen is displayed with a list of the files to be copied. It also indicates that you are connected to the appropriate drives (if applicable).

      If you want to remove the status screen, press F5.


4. Select Update To Diskette.

5. Select Update Files.

   A message is displayed asking if you used your last update diskettes.

   • If this is the first time you are doing a file update, select Yes.

   • If you have done an Update to Diskette before but did not transfer the updated files to the other location, select No to make sure all file changes are transferred.

6. Insert a formatted diskette into the specified drive, and then select Continue.

7. To overwrite any data on the diskette, select Yes; otherwise, select No.

8. Remove the diskette and label the first diskette "#1" and continue inserting diskettes (as prompted) until all updated files are copied to diskette.

   If you have multiple diskettes, label them with the correct sequential number so that you can insert them when prompted at the remote location.

**Important:**

When you go to your other system to update your files, be sure to run Update From Diskette before performing any other functions (for example, adding or deleting directory pairs).

Go to "Installing File Update at the Remote Location" on page 198 if you are installing File Update for the first time.

If you have already installed File Update at both your locations, go to "Transferring Updated Files to the Other Location" on page 199.
Installing File Update at the Remote Location
Follow these steps to install File Update if the remote location is a PC (not connected through a LAN or the InterLnk program).

Notes:

• Before you begin, you must have completed “Installing File Update at the Base Location” on page 190 and “Using File Update Menu Choices” on page 194.
• The remote system must have PC DOS 7 installed.
• Make sure you have the File Update Installation diskette before you begin.
• This procedure has to be done only once (unless you select Delete Installation from Setup and have to begin again).
• The following steps apply to “unconnected” PCs. If you are using InterLnk or a LAN, see “Transferring Updated Files to the Remote Location” on page 196 for the correct procedure to follow.

To install the File Update Utility at a remote location:

1. From the DOS command prompt, type:
   fileup
2. Press ENTER.
   If you receive a Bad command or file name message, make sure the program files (FILEUP.EXE and FILEUP.HLP) exist on your system. These files are installed with PC DOS and are usually found in the DOS subdirectory.
4. Insert the File Update Installation diskette you created on your base system in diskette drive A or B.
5. Specify the drive where you inserted the diskette, and select Continue.
6. Select OK when the installation is completed.
Transferring Updated Files to the Other Location

Follow these steps to transfer updated files that you copied to diskette in “Transferring Updates from the Base Location to Diskette” on page 196. Follow this procedure before performing any setup activities at the remote location (such as adding directory pairs or changing the excluded file list).

To transfer updated files that you copied to diskette:

1. Select File Update.
2. Select Update From Diskette.
3. Select Update Files.
4. Insert the last diskette of the set that contains the updated files that you transferred.
5. Select Yes to continue.
6. Continue to insert and remove the applicable diskettes. You are prompted with a message indicating the number of the diskette to be inserted.

You might come across one or more of the following situations:

Files Changed in Both Locations
If a file on your system is new or changed since your last update, a message will be displayed with the name, the date stamp, and the time stamp of each file. You are given the choice to keep a specific file or to replace all remaining files. This lets you skip further messages and replace all conflicting files with the updates from diskette. This message can occur when you work on the same file at your base and remote locations and you do not update on a regular basis. It can also occur if an update is not allowed to run to completion.

No Directory Path Exists for a File Listed on the Diskette
If a directory path does not exist for a file on the diskette, a message will be displayed. You are given the choice of having the system create the directory or of skipping the file and continuing the update process.

Drives Not Connected
If you are not connected to the drives you need, an error message will be displayed. You cannot proceed with the update until you connect to these drives.

File Update is now installed and can be run from both locations. Be sure to perform a File Update at your base and remote locations on a regular basis.
Installing on an InterLnk-Connected System

Follow these steps to use File Update on two systems connected by means of the InterLnk program and a cable.

Notes:

- Before you begin, you must have completed “Installing File Update at the Base Location” on page 190 and “Using File Update Menu Choices” on page 194.
- Make sure that you are connected to your server.
- You are not required to use the File Update Installation diskette if you run File Update from only one system. However, the installation directory for the remote system that you specified in the initial installation must exist before you can perform any update.
- For more information on the InterLnk program, refer to Chapter 11, “Connecting Computers” on page 175.

To remap your drives:

1. Start the InterSvr program on your remote system and the InterLnk program on your base system.

2. At the DOS command prompt on your base location, type:
   
   fileup

3. Press ENTER.

4. Select File Update.

5. Select Update Connected System.

6. Select Re-Map Connected Drives. The Connected Drive Remapping screen is displayed.
7. Specify the remapped drive letters used to access the remote drives. These are listed under Other Computer (Client) on the InterSvr screen.

For example, on the system from which you ran the InterSvr program, you see a listing of connected drives similar to the following:

<table>
<thead>
<tr>
<th>This Computer (Server)</th>
<th>Other Computer (Client)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A:</td>
<td>F:</td>
</tr>
<tr>
<td>C: (44MB)</td>
<td>G:</td>
</tr>
<tr>
<td>D: (44MB)</td>
<td>H:</td>
</tr>
<tr>
<td>LPT1:</td>
<td>LPT2:</td>
</tr>
</tbody>
</table>

You specified the actual remote drive letters when you completed the Add/Delete Directory Pairs screen. These drives are listed under This Computer (Server) on the InterSvr program screen.

8. Select OK. You are returned to the main screen.

9. Go through the selection process again of:
   - File Update
   - Update Connected System
   - Preview, Update Files, or Custom File Selection

You have completed File Update installation. You can choose to install File Update on your server machine if you want to transfer files back and forth between systems.
Installing on a LAN-Connected System

Follow these steps to use File Update on a system connected to a Local Area Network (LAN). You do not need to use the File Update Installation diskette because you are only remapping drives (not installing File Update).

Notes:

- Before you begin, you must have completed “Installing File Update at the Base Location” on page 190 and “Using File Update Menu Choices” on page 194.
- Make sure that you are connected to your network drives.
- File Update is always run from the client machine.

To remap your drives (you have to do only once):

1. At the DOS command prompt on your base location (client), type:
   
   fileup

2. Press ENTER.


4. Select Update Connected System.

5. Select Re-Map Connected Drives. The Connected Drive Remapping screen is displayed.

![Connected Drive Remapping Screen]

6. For drive letters currently specified in Directory Pairs, specify the remapped drive letters used to access the server drives.

   Novell Network Users: The mapping for the base/remote location is the same drive letter.
7. Select OK. You are returned to the main screen.

8. Go through the selection process again of:
   - File Update
   - Update Connected System
   - Preview, Update Files, or Custom File Selection

You have completed File Update installation on your LAN-based system.

**Troubleshooting**

For troubleshooting tips for the most common questions about or problems with File Update, refer to “File Update Utility” on page 313.
Chapter 13. Making More Memory Available

RAMBoost is the memory management tool provided with PC DOS. It runs on a 80386SX*-based or higher processor that has enough extended memory available. For more information about system requirements, see “RAMBoost System Requirements” on page 207.

The purpose of RAMBoost is to determine the optimal memory location for every device driver, terminate-and-stay resident (TSR) program, and other programs you have designated for your system. It carries out this process by analyzing your computer’s existing configuration and automatically reconfiguring programs to load above 640K after restarting your system. When RAMBoost is through processing, you should have the maximum amount of available memory to use for your DOS and Windows applications.

If you are having trouble running your programs because there is not enough memory, you might need to run RAMBoost. For most systems, this simply means typing ramsetup at the DOS command prompt and following the directions given through the online RAMBoost program. When you have provided the information RAMBoost needs to run, it takes care of everything else during its processing.

Of course, the more you understand about your system and memory, the more you will appreciate all that RAMBoost can do for you. For a detailed discussion about memory and additional RAMBoost tips and techniques, see “Using RAMBoost Tips and Techniques” on page 218.

If you are a PCMCIA user, see “Running RAMBOOST with PCMCIA (Non-Thinkpad)” on page 227 for information about running RAMBOOST with PCMCIA.

Determining Your System’s Memory Type

Before running RAMBoost, you should determine what type of memory your system has and which programs are currently loaded into memory. Use the MEM command with the /c switch or use the QCONFIG command. For example, if you used the MEM command, you might type the following at the DOS command prompt:

```
mem /c /p
```

** 80386SX is a trademark of the Intel Corporation.

© Copyright IBM Corp. 1981, 1995
The /c switch provides you with a list of programs and classifies their memory into types of memory, such as conventional or upper memory. It is the upper memory blocks that are used by RAMBoost to free conventional DOS memory. The /p switch pauses the information at the end of each screen of information.

If you want to use the QCONFIG command, a more complete description of the QCONFIG command can be found in “Analysis of Your Computer’s Memory” on page 221.

Understanding How RAMBoost Works

RAMBoost manages the area of memory of your computer from 640K to 1024K, called upper memory blocks (UMBs). RAMBoost runs invisibly on your computer, optimizing available memory automatically each time your computer’s system configuration changes. If you add or remove programs from your CONFIG.SYS or AUTOEXEC.BAT files, RAMBoost automatically detects the change. When the system is rebooted, RAMBoost automatically re-optimizes and rearranges the remaining drivers in upper memory.

RAMBoost works with a memory manager. A memory manager (such as EMM386, Quarterdeck QEMM**, and Qualitas 386MAX*) makes the open areas in your upper memory blocks available for loading memory-resident programs and device drivers (referred to as “loading high”). Loading programs high makes more DOS conventional memory available for your applications. The amount of upper memory RAMBoost makes available is determined by the expanded memory specification (EMS) manager used with it.

Because the open space in upper memory is usually in several pieces of different sizes, programs can fit in some areas but not in others. RAMBoost arranges your memory-resident programs, device drivers, and other DOS resources such as those specified in the CONFIG.SYS file (for example, FILES and BUFFERS) into upper memory. This increases the amount of memory available for DOS to run applications. RAMBoost does this by creating an initialization profile (.INI file) of your memory usage and by automatically arranging the programs in your upper memory blocks. This provides the maximum compatible amount of free conventional memory. See “Using RAMBoost Tips and Techniques” on page 218 for more information about memory types.

* Quarterdeck QEMM is a trademark of Quarterdeck Office Systems.
** Qualitas 386MAX is a trademark of Qualitas, Inc.
You configure RAMBoost once. Then, each time you start your computer, RAMBoost analyzes your computer’s resident programs and device drivers, selects the optimal loading configuration, and loads them into upper memory blocks.

Important:
RAMSETUP must be run for each configuration that you want to optimize in a multiple configuration setup. This way, an .INI profile file is generated for each separate configuration. Your system needs to be rebooted twice for each configuration. The first time RAMBoost locks in the configuration in the Learn mode; and the second time, it makes it active. See page 210 for more information.

If you are familiar with memory-management techniques, you can customize RAMBoost’s performance by manually editing the settings in the profile .INI files. The two primary .INI files are RAMSETUP.INI and RAMBOOST.INI. Additional .INI files are generated when RAMBoost detects multiple configurations. For more information about the .INI files associated with RAMBoost, see the online PC DOS 7 Command Reference.

RAMBoost System Requirements
The following items are required to use RAMBoost Setup (run RAMSETUP). RAMBoost Setup is flexible in that it works with many memory managers.

- A minimum of 512K available extended memory.
- A 80386SX-based or higher processor.
- For upper memory block support, at least 640K and an EEMS/EMS 4.0 memory manager are required. Use one of the following EEMS/EMS 4.0 memory managers:
  - HIMEM.SYS and EMM386.EXE provided with DOS
  - Quarterdeck Expanded Memory Manager-386**
  - Qualitas BlueMAX** and 386MAX
  - Helix** Netroom**

Most of these third-party memory managers requires an adjustment to your CONFIG.SYS file before running RAMBOOST. If you are running RAMBOOST and install a third-party memory manager on over it (without adjustments), your system might not work correctly. If this happens, check the third-party documentation for instructions, or contact the manufacturer of the third-party product.

** Quarterdeck Expanded Memory Manager-386 is a trademark of Quarterdeck Office Systems
** BlueMAX is a trademark of Qualitas, Inc.
** Helix and Netroom are trademarks of Helix Software Company
Refer to “Compatibility with Memory Managers and Other Programs” on page 225 for compatibility information.

**Configuration Requirements**

You use the RAMSETUP.EXE program to configure RAMBoost. When loaded, RAMBoost automatically checks for the existence of memory managers, such as HIMEM.SYS and EMM386.EXE, on your system. Then, it scans upper memory to configure itself with the optimal parameters for managing upper memory.

You need to take the following into consideration before you configure RAMBoost:

- Ensure that you load all the software you normally run in your daily routines that start your adapter cards (for example, a sound blaster card). RAMBoost Setup scans the upper memory area looking for unused adapter memory. If you do not have your adapter activated, RAMBoost Setup might incorrectly use the adapter memory space.

- If you are using QEMM386, 386MAX, or Netroom, you must install it according to its installation instructions before you start RAMBoost. You must also make sure it provides upper memory blocks (UMBs).

- When installing RAMBOOST in a multiple configuration environment, it is necessary to configure each MENUITEM before allowing RAMBOOST to run an optimization process.

  1. Boot your system and load the first MENUITEM to be optimized.
  2. Start the RAMSETUP program and configure the first MENUITEM. When configured, allow RAMSETUP to reboot your system.

     Do not load the same MENUITEM. Loading the same MENUITEM forces a premature Learn process that would need to be re-optimized later.

  3. Load the next MENUITEM to be configured for RAMBOOST optimization.
  4. Start RAMSETUP, configure the MENUITEM, and then allow RAMSETUP to reboot your system.
  5. Continue this procedure with each MENUITEM of your multiple configuration.

When you have configured each MENUITEM (as needed), reboot your system. As each MENUITEM is loaded, RAMBOOST is ready to perform as intended. It will learn and optimize each MENUITEM as it is loaded without the extra Learn modes.
To configure RAMBoost:

1. From the DOS command prompt, type:
   ```plaintext
   ramsetup
   ```
2. Then press ENTER.

   RAMBoost Setup reads the RAMSETUP.INI and RAMBOOST.INI profiles and configuration files, and then displays a window. Which window is displayed depends on whether EMM386 is installed in memory.

**No EMM386 or equivalent statement installed**

```
RAMBoost

RAMSETUP will now modify your CONFIG.SYS and AUTOEXEC.BAT files. Choose OK to continue or choose Advanced to configure RAMBoost manually. To exit the RAMBoost setup program, choose Exit.

OK  Exit  Advanced
```

**EMM386 statement or equivalent installed**

```
RAMBoost

NOTE: RAMSETUP can provide the most thorough upper memory analysis at this time if EMM386 is not installed. Choose OK to let RAMSETUP reinstall EMM386 to configure maximum DOS upper memory. Choose Keep to continue with the current EMM386. To exit RAMSETUP, choose Exit. Choose Advanced to configure RAMBoost manually. If you configure RAMBoost manually, choose Keep when you return to this screen.

OK  Keep  Exit  Advanced
```

Any of the following scenarios are possible, depending on what programs exist in your CONFIG.SYS file when RAMBoost Setup is run:

**Scenario 1**

- If RAMBoost Setup detects that you have no memory manager installed but finds the DOS memory manager on your computer, select OK on the window that is displayed. RAMBoost, EMM386, and HIMEM (if it was not present) are installed into your CONFIG.SYS file. Go to step 3 on page 211.
Scenario 2

• If RAMBoost Setup detects that you have installed a memory manager other than the one in DOS, select OK on the window that is displayed. RAMBoost is installed into your CONFIG.SYS file. Go to step 3 on page 211.

Scenario 3

• If RAMBoost Setup detects that you have an EMM386 statement in your CONFIG.SYS file, you have the option of letting RAMBoost comment out (places the REM command before the statement) the statement and install a new EMM386 statement that optimizes your system. Select OK. Your system is rebooted and RAMSETUP is restarted automatically.

You can select and use the Advanced button to make changes to your memory situation. After making your changes, you must select Keep and then select Reboot.

Note: Use Advanced only if you are very familiar with upper memory concepts and management.

A second possibility exists for this scenario. You could get a message screen that reads:

RAMSETUP will not install because there is only xxx amount of memory available.

When this occurs, you have the following options:

– Select OK to let RAMBoost Setup uninstall your current EMM386 and install an EMM386 statement that optimizes your system.

– Select Advanced so that you can manually allocate the stated xxx amount of upper memory needed. After making the change, select Keep and then select Reboot.

Scenario 4

• If RAMBoost Setup cannot find a memory manager on your computer, it informs you that you must install one.

Scenario 5

• If you have multiple configurations and want to dictate how RAMBoost Setup is to handle your configurations, RAMBoost Setup detects the multiple configurations and displays a window. When you select Reorganize, RAMBoost Setup rearranges the commands in your common section and includes any statements it determines are needed for optimal compatibility with each configuration.
You can change or limit what RAMBoost will do to each configuration by making changes in the appropriate .INI file. For more information, see the online PC DOS 7 Command Reference.

If you select Reorganize, the old CONFIG.SYS is saved as CONFIG.SAV. After RAMBoost Setup installs RAMBoost in your CONFIG.SYS file, a window is displayed that allows you to reboot (restart) your computer or exit.

If you select Exit, RAMBoost will be activated the next time you start your computer. Be careful not to change your CONFIG.SYS or AUTOEXEC.BAT in the meantime.

3. Select Reboot to start RAMBoost.

RAMBoost restarts your computer twice before RAMBoost is activated.

The first reboot:
RAMBoost Setup loads all your memory-resident programs as usual and keeps a record of how much memory is used and how the programs are placed in memory.

After restarting your computer, you see the following:

RAMBOOST will automatically load in 3 seconds. Choose:

'Y' to continue.
'N' to prevent RAMBOOST from loading.

Load RAMBOOST [Y/N]?

RAMBOOST is loaded in LEARN mode.
The second reboot:
RAMBoost actually arranges the programs to fill your upper memory as much as possible. You should then find a noticeable increase in conventional memory available for running applications. You now see displayed on the last line:

RAMBoost is loaded in ACTIVE mode.

This message is followed immediately by the display of the DOS command prompt signifying that RAMBoost is loaded.

After this, each time you start your computer, RAMBoost is loaded. Whenever you restart your computer, if RAMBoost determines that one of the system files it tracks has been altered (such as your AUTOEXEC.BAT or CONFIG.SYS files) or some other special condition has changed, RAMBoost automatically enters LEARN mode to optimize your computer's new configuration.

Learn Mode
During Learn mode, RAMBoost is working to determine the optimal location for every object loaded since (and including) the loading of RAMBoost. This can be a long process. A feature of RAMBoost is a progress bar that shows the current status of Learn.

The progress bar shows the actual percentage of the possible combinations that have been looked at.

RAMBoost defaults to a default timer type of elapsed, meaning you get only the progress bar and a message indicating how much time has elapsed. However, you can change the timer type in the RAMSETUP.INI file to an eta timer type.

When the timer type is set to eta, the time display provides an estimate of how much longer the processing will take. This estimate is based on how long it has taken to process the current fraction of the job.

Analyzing Your Computer's Memory after Running RAMBoost
After RAMBoost is loaded, you might want to do the following to verify that you do have more conventional memory available:

- View your CONFIG.SYS file. Lines similar to the following are placed in this file if you successfully loaded RAMBoost:
  
  device=c:\dos\emm386.exe noems ram x=a000-b0ff i=b100-b7ff x=b800-bfff ...
  device=c:\dos\ramboost.exe load
The i= and x= are INCLUDE and EXCLUDE statements. The ... means that, although more of these statements are normally included in this DEVICE statement, they are all not listed for this example.

- Save the output by typing:

  ```
  mem /c > filename.ext
  ```

  where `filename.ext` is the name of the output file (for example, `SAVE2.OUT`). The MEM command is preferred in this case rather than QCONFIG, because it gives more details about your programs' upper memory.

You should see information similar to the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>Total</th>
<th>= Conventional</th>
<th>+ Upper Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBMDOS</td>
<td>11088 (11K)</td>
<td>11088 (11K)</td>
<td>0 (0K)</td>
</tr>
<tr>
<td>SMARTDRV</td>
<td>31024 (30K)</td>
<td>2448 (2K)</td>
<td>28576 (28K)</td>
</tr>
<tr>
<td>HIMEM</td>
<td>768 (1K)</td>
<td>768 (1K)</td>
<td>0 (0K)</td>
</tr>
<tr>
<td>EMM386</td>
<td>3392 (3K)</td>
<td>3392 (3K)</td>
<td>0 (0K)</td>
</tr>
<tr>
<td>RAMBOOST</td>
<td>10688 (10K)</td>
<td>320 (0K)</td>
<td>10368 (10K)</td>
</tr>
<tr>
<td>ANSI</td>
<td>3648 (4K)</td>
<td>48 (0K)</td>
<td>3600 (4K)</td>
</tr>
<tr>
<td>DPMS</td>
<td>1552 (2K)</td>
<td>1552 (2K)</td>
<td>0 (0K)</td>
</tr>
<tr>
<td>STACHIGH</td>
<td>16169 (16K)</td>
<td>48 (0K)</td>
<td>16112 (16K)</td>
</tr>
<tr>
<td>COMMAND</td>
<td>2656 (3K)</td>
<td>272 (0K)</td>
<td>2384 (2K)</td>
</tr>
<tr>
<td>DOSKEY</td>
<td>1152 (1K)</td>
<td>0 (0K)</td>
<td>1152 (1K)</td>
</tr>
<tr>
<td>IBMAVSH</td>
<td>5424 (5K)</td>
<td>0 (0K)</td>
<td>5424 (5K)</td>
</tr>
<tr>
<td>MOUSE</td>
<td>17280 (17K)</td>
<td>0 (0K)</td>
<td>17280 (17K)</td>
</tr>
<tr>
<td>FREE</td>
<td>702816 (686K)</td>
<td>635408 (621K)</td>
<td>67400 (66K)</td>
</tr>
</tbody>
</table>

- Print the output from the MEM command after you have run RAMSETUP.
- Compare the two printed outputs (before and after running) if you printed or saved the output from the MEM command before running RAMSETUP.

For most individuals, running RAMBoost should give you more conventional memory than you had before running it. If it does not, you might have to manually manipulate the upper memory blocks or run RAMBOOST OPTIMIZE 1. See the online *PC DOS 7 Command Reference* for information about editing your RAMBOOST.INI file.
Reviewing What RAMBoost Changes

RAMBoost Setup modifies your CONFIG.SYS file. Some of the following changes might be noted:

- A RAMBOOST.EXE statement is placed in your CONFIG.SYS file.
- An EMM386 statement is created if you choose to have RAMBoost Setup comment out (using the REM command) any previous EMM386 statement. Or, a new EMM386 statement is created if one was not already present.
- The DEVICEHIGH statements have become DEVICE statements, because RAMBoost now controls your upper memory blocks.
- For multiple configurations and single configurations, the following changes are made:
  - The AUTOEXEC.BAT file is backed up to a file named AUTOEXEC.CPS.
  - The CONFIG.SYS file is backed up to a file named CONFIG.CPS.
  - For multiple configurations only, an .INI file is created for each possible configuration in which RAMSETUP was run, matching the name of the CONFIG variable currently active.

Using Advanced Features

*Use these advanced features only if you are very familiar with upper memory concepts and management.*

RAMBoost runs by itself with minimal user interaction. It is possible, however, to customize the way RAMBoost uses the upper memory blocks of your computer.

There are two ways you can work with advanced RAMBoost features:

- Using the Upper Memory Usage Editor
- Editing the appropriate .INI file

The Upper Memory Usage Editor

The Upper Memory Usage Editor is an advanced feature of the RAMBoost memory manager. The Upper Memory Usage Editor allows you to:

- View your current upper memory usage
- Make changes to your upper memory usage

You can use the Upper Memory Usage Editor to reserve upper memory blocks for devices that might not identify their upper memory usage during RAMBoost's setup and installation. These devices can be network or special video boards. You can also use the editor to make more upper memory blocks available. For example, if
you know of an available region of upper memory blocks that appears unavailable, you can use the editor to change the status of the blocks from allocated to available.

**To start the Upper Memory Usage Editor:**

1. From the DOS command prompt, type:
   
   ```
   ramsetup
   ```

2. Then press ENTER.
   
   If RAMBoost Setup detects that you have the DOS memory manager installed, RAMBoost Setup provides you with an Advanced option button.

3. Select Advanced.

The following table shows status symbols for each block:

<table>
<thead>
<tr>
<th>This Symbol</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>- -</td>
<td>An available memory block.</td>
</tr>
<tr>
<td>. .</td>
<td>An occupied memory block.</td>
</tr>
<tr>
<td>RO</td>
<td>A block allocated for ROM.</td>
</tr>
<tr>
<td>VI</td>
<td>A block allocated for video RAM.</td>
</tr>
<tr>
<td>EM</td>
<td>A block allocated for the EMS frame.</td>
</tr>
<tr>
<td>AD</td>
<td>A block allocated for adapter RAM.</td>
</tr>
</tbody>
</table>

**To change the current memory usage of a block:**

1. Select the block you want to change, using the mouse or pressing the TAB key to start the editor and then using the arrow keys.

2. Select the function key that corresponds to the type of memory specification you want to apply.
   
   Refer to “Function Keys” for more information.

3. Repeat steps 1 and 2 until you have modified upper memory to your satisfaction.

4. Select OK to save the changes.

**Function Keys:** The table on the following page shows the function keys you can use in the Upper Memory Usage Editor.
<table>
<thead>
<tr>
<th>Function Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 HELP</td>
<td>Provides online help.</td>
</tr>
<tr>
<td>F2 AVAIL</td>
<td>Makes the selected memory blocks available for another use.</td>
</tr>
<tr>
<td>F3 EXIT</td>
<td>Exits from the program.</td>
</tr>
<tr>
<td>F4 ROM</td>
<td>Changes selected memory-block usage to ROM.</td>
</tr>
<tr>
<td>F5 VIDEO</td>
<td>Changes selected memory-block usage to video RAM.</td>
</tr>
<tr>
<td>F6 EMS</td>
<td>Changes selected memory-block usage to EMS frame.</td>
</tr>
<tr>
<td>F7 ADAPT</td>
<td>Changes selected memory-block usage to RAM adapters.</td>
</tr>
<tr>
<td>F8 DEC</td>
<td>Switches between the display of memory-block addresses in decimal and hexadecimal characters.</td>
</tr>
</tbody>
</table>

### Using the Options Editor

This dialog box lets you set the number of XMS (extended memory specification) handles, DMA support and the size of your DMA (direct memory access) buffer. The default values are correct for most personal computers (PCs). You can also enable or disable EMS (expanded memory specification) memory and specify whether your computer has a Weitek** coprocessor.

These options correspond to command-line options for the DOS memory manager, EMM386.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMS Handles</td>
<td>Specifies the number of extended memory handles EMM386 can use, from 2 to 255. If you use many programs simultaneously that use extended memory, you may need to increase this number.</td>
</tr>
<tr>
<td>DMA Buffer</td>
<td>Specifies how many kilobytes of memory to reserve for Direct Memory Access (DMA). This should be the largest DMA transfer that occurs while EMM386 is active, and it can be from 16 to 256. The default value is optimized to work on most PCs.</td>
</tr>
<tr>
<td>Enable EMS</td>
<td>Enables EMM386 to access expanded memory by designating a memory area for page swapping, which is required for expanded memory orientation. You can enable EMS if a program you use requires it. If you do not need it, you will have more available upper memory if you leave it disabled.</td>
</tr>
<tr>
<td>Weitek</td>
<td>Enables support for the Weitek coprocessor. If your computer uses this coprocessor, enable this feature.</td>
</tr>
</tbody>
</table>

** Weitek is a trademark of the Weitek Corporation.
To use the Options Editor:

1. Select Options from the Upper Memory Usage Editor menu.

2. Make any necessary adjustments and select OK to save your settings.

The RAMBoost Configuration File

The RAMBoost configuration file is an editable ASCII text file. It contains all the necessary parameters for RAMBoost to manage your system. The profile is named RAMBOOST.INI. When RAMBoost needs to consult or edit this profile, it searches for it in the \DATA subdirectory below the directory from where RAMBOOST.EXE resides.

If you have multiple configurations, a profile .INI file exists for each possible CONFIG variable that CONFIG.SYS might generate. To change the parameters for a particular configuration, make your change in the applicable .INI file.

The RAMBOOST.INI file has eight sections. Each section begins with a section header and contains specific assignments relevant to the operation of RAMBoost. The sections are:

- System
- PIF.Advice
- Completion Triggers
- Text
- Learn
- Learn.PIF
- Learn.UMB
- PIF

For more information about customizing .INI files, see the online PC DOS 7 Command Reference.
Using RAMBoost Tips and Techniques

To appreciate how RAMBoost works and perhaps answer some of the questions associated with this program, the following topics are discussed:

- Choosing the Correct Option Method in Learn Mode
- Memory types
- Using the QCONFIG command to help analyze your system
- What to do when something goes wrong
- How to handle Learn loops
- Considerations for disk caches
- Resolving problems

Additional tips and techniques and an explanation of how to edit your RAMBOOST.INI file are provided in your online PC DOS 7 Command Reference.

Choosing the Correct Option Method in Learn Mode

PC DOS is shipped with Option Method 2 selected as the default for the Learn mode. This has proved to be the better choice for most systems using RAMBoost. Should you decide to change this, you might want to consider the following factors respecting the differences between Option Method 1, Option Method 2, and Option Method 3.

- **Option Method 1**
  
  This method forces RAMBoost to re-optimize your system for maximum precision. However, on some systems, this method may take excessive time. It does not affect system performance during normal operations.

- **Option Method 2**

  This method is not as precise as Option Method 1 but it does speed up the optimization process significantly. For example, if you choose Option Method 1 and it showed an estimated process time of two hours (because of having two billion combinations to check), Option Method 2 will reduce the process time to approximately 30 seconds.

  It is a good practice to run Option Method 1 occasionally or after many changes have been made. Rather than changing the Option Method code in the .INI file, type the following at the DOS command prompt:

  ```
  ramboost optimize 1
  ```

  After this command has finished, restart your computer. RAMBoost restarts with the new optimized values, without entering the Learn mode.
RAMSETUP must have already been run, RAMBOOST.EXE must be in your CONFIG.SYS file and the OPTION=KEEPINFO must be enabled.

- **Option Method 3**
  Option Method 3 is the same as Option Method 1 except that the optimization ends when the Current best optimization on the optimizer screen reaches 100 percent. This means that RAMBoost has found and tested a combination that puts the device drivers and resident programs into UMBs. No other analysis is done.

**Comparison of Memory Types**
The five most common types of memory are described as follows:

- **Conventional DOS Memory**
The 80286*-based or higher processors, which power personal computers and run the DOS operating system, have a 1024K (1 megabyte) address space when operating in real mode. *Real mode* means these processors are running as fast 8086* based computers. The lower 640K of this memory is designated as system memory and is called *conventional DOS memory* (also known as *base memory*). This is the memory that DOS uses to process programs.

- **Reserved Memory Area or Upper Memory Block (UMB)**
The upper 384K in the 1MB address space is known as the *Upper Memory Block* and is used by video adapters, network hardware, ROM BIOS, and other memory-mapped hardware. This space, however, is never completely filled. Memory is mapped into this region between 640K and 1MB through the means of an upper memory manager (known as a *platform*). It is used for loading TSRs, DOS tables, and network software to free as much conventional DOS memory as possible. It is these upper memory blocks that are used by RAMBoost to free conventional DOS memory.

- **High Memory Area (HMA)**
The high memory area is the first 64K minus 16 bytes of extended memory located just above 1MB.

---

* 8086, 8088, 80286, 80386, and 80486 are trademarks of the Intel Corporation.
• **Extended Memory (XMS)**

Extended memory is addressed above 1024K and cannot be accessed when the processor is in real mode. Therefore, it cannot be used by standard programs running under DOS. On 80286-based and 80386™-based or higher machines, some programs (mostly RAM disks and disk-caching programs) switch the processor to protected mode and access this space. Protected mode is a special mode of operation that 80286-based or higher computers have to be in to access extended memory. Extended memory can never be used on 8088™-based and 8086-based machines, because these processors do not support protected mode or memory above 1MB.

The Extended Memory Specification (XMS) method allows DOS programs to use the additional extended memory found in 80286-based, 80386-based, and 80486™-based or higher machines in a consistent, machine-independent fashion. XMS/HMA can add almost 64K of memory that some DOS programs can access directly for storing a portion of its code segment; or, as XMS/EMA, it can provide DOS-extender programs (such as Windows 3.0 or later) with a
standard and consistent method for storing data (or inactive code) in extended memory.

- **Expanded Memory (EMS)**

Expanded memory uses a 64K window (of bank-switched memory), typically in the address space between 640K and 1024K. Application programs must be written specifically to switch blocks of memory in and out of this window. The program itself uses conventional memory and accesses this expanded memory only to store data.

**Analysis of Your Computer’s Memory**

To find out what kind of memory your system has, how much you have available for your programs, or where your adapters are located use the QCONFIG command. QCONFIG is a utility used to query information about your computer system.

The QCONFIG program is machine independent and can be run on any processor from a 8088-based to a 80486-based processor.

**To query information about your computer system:**

1. At the DOS command prompt, type:
   
   qconfig

   You can use the /p switch (type qconfig /p) or the MORE command (type qconfig | more) to view the information one display screen at a time. QCONFIG examines your system and displays an analysis on the screen similar to the following:

   ```
   : Fixed Disk 1 : 379 MB = 388096 KB = 397419304 bytes
   Logical Drive C : Size 15312KB = 14.9M Avail 3920K = 3.8M
                   : Total Units 3828 Avail Units 980 Total Sectors 30624
                   : Sectors/Unit 8 Bytes/Sector 512
                   : Local Drive - File System is FAT
   :
   Total Memory : 16000 KB = 15.6 MB
   Conventional : 640 KB Free: 611 KB
   Extended Memory : 15360 KB Free: 0 KB
   Expanded Memory : 2416 KB Free: 2048 KB Page Frame Address: C000
   XMS Memory : 1984 KB Free: 1984 KB
   EMS Version : 4.0
   XMS Version : 2.0
   ```
2. Redirect the information displayed to an output file by typing:

   qconfig /o
   This option directs output of the information displayed on the screen to a
   file named QCONFIG.OUT

   or
   qconfig /ofilename.ext
   This option directs output of the information displayed on the screen to a
   text file (filename.ext) where you give the file a name of your own choice.
   Do not put a space between the “o” and the filename.ext.

3. Print the information so you can have it available if you need to contact a
   service representative or need to use it to compare subsequent memory
   information data.

   For more information about the QCONFIG command, see the online PC DOS 7
   Command Reference.

What To Do When Something Goes Wrong

If a program does not execute correctly after running RAMBoost, or worse, it hangs
your system, reboot your computer and cancel RAMBoost by typing n at the Load
RAMBOOST prompt. Generally, the problem is a program that RAMBoost moved out
of conventional memory that should not have been moved.

To correct the problem of programs being accidentally moved out of
conventional memory:

1. Type the following at the DOS command prompt:

   ramboost pif

   and press ENTER. A report is generated that identifies the programs that
   RAMBoost moved into high memory.

2. Print out the report or note which programs were loaded high.

3. Edit your RAMBOOST.INI file to lock your programs low. Do this one program
   at a time and reboot after each edit. To force RAMBoost to load a program in
   low conventional memory, an edit is made to the (PIF.ADVISE) section of the
   RAMBOOST.INI file or, in the case of multiple configurations, the .INI file that
   matches the CONFIG variable.

   In the PIF.ADVISE section, you will find a list of default programs already
   locked low. Follow the same format of the list when adding to it.

4. When your system no longer hangs, edit the RAMBOOST.INI file. Remove the
   programs you locked low that did not correct the problem so that they will be
   loaded high. Do this one program at a time and reboot after each edit.
There are times when a combination of programs loading high may be the cause of your problem. This is why you reverse the status of a program from locked low to being loaded high by RAMBoost one program at a time.

Handling Learn Loops

There may be occasions when RAMBoost continually reboots your system, refusing to switch from the Learn mode to the Active mode. When this occurs, it is a good possibility that there is a memory allocation problem.

It is possible that the Learn loop is occurring because RAMBoost does not have enough memory to optimize the system using the Graphical User Interface.

To edit your RAMBOOST.INI to allow enough memory to optimize the system:

1. Start your computer and bypass the running of RAMBoost by typing n when prompted to load RAMBoost.
   
   You must do this before it times out or RAMBoost will load automatically.

2. Change your directory until you are in the C:\DOS\DATA directory.

3. Edit your RAMBOOST.INI file by typing:
   
   e ramboost.ini

4. Find optimizerui=ramsetup.exe oui within the [System] section.

5. Change ramsetup.exe oui to ramsetup.out oui in this section.

6. Save your change and exit from the editor.

7. Reboot your computer.

RAMBoost will now use the Text User Interface instead of the Graphical User interface and your problem should be fixed.

Considerations for Disk Caches

There may be times you are using a disk cache that has a delayed write-to-disk process.

To change the reset-delay value for disk caching:

1. Change your directory until you are in the C:\DOS\DATA directory.

2. Type e ramboost.ini to edit your RAMBOOST.INI file.

3. Find resetdelay option within the [System] section.
4. Change the default value to 5.
5. Save your change and exit from the editor.
6. Reboot your computer.

Generally, this takes care of most situations. There may be cases (such as using multiple caches or Stacker compression with another cache) where changing the value of resetdelay to 5 is still not sufficient. In these cases, try a higher setting (no higher than 15).

Problem Resolution
RAMBoost is a powerful tool but it is usually involved in the most complex process of the computer: optimal memory usage. Every system is different, and this presents a challenge for resolving problems. Depending on the complexity of your configuration, you might receive a FRAME= error or some other error.

Common problems that might occur that you can resolve include:

1. **CD-ROM does not work after upgrading**
   This could happen if you installed your CD-ROM after running RAMSETUP and RAMBoost is loaded.
   **To run RAMSETUP again to correct this problem:**
   a. Restart your computer by pressing CTRL+ALT+DEL.
   b. Type n when you see this prompt:
      Load RAMBOOST?
   c. Type ramsetup at the DOS command prompt.
   d. When prompted to remove the EMM386 line, choose not to remove the line and to continue using the current EMM386 statement.
   e. Let RAMBoost Setup restart your computer and reconfigure. It must be in Learn mode the first time. It then resets and, the second time, RAMBoost comes up in Active mode.

2. **System hangs after loading RAMBoost**
   Generally this indicates that there is a conflicting device driver or TSR. See “What To Do When Something Goes Wrong” on page 222 for more details.
Compatibility with Memory Managers and Other Programs

Installing a third-party memory manager over RAMBoost, with RAMBoost active, might cause your system to run incorrectly.

**Note:** Do not try to install a third-party memory manager without making the required adjustments (listed in this section) to your CONFIG.SYS file. By making these adjustments, the third-party memory manager should work with RAMBoost.

If a problem does occur, you can put the REM command in front of the command-line statement that contains RAMBOOST.EXE in your CONFIG.SYS file. Then, reboot your system.

The following section describes RAMBoost's compatibility with the following memory managers and other programs.

- Helix Netroom386
- Qualitas 386MAX and BlueMAX
- Quarterdeck QEMM-386
- DESQview and enhanced Windows

For example, if you use QEMM with Stealth, the upper limit is approximately 225K. If you use the EMM386 provided with DOS, the upper limit varies from 64K to 220K, depending on the BIOS, peripherals, and the careful use of INCLUDE parameters. You will see the INCLUDE parameters (for example, i=b100-b7ff) and EXCLUDE parameter (for example, x=a000-b0ff) in your CONFIG.SYS file after you have configured RAMBoost using EMM386 as the memory manager.

**Helix Netroom386**
Ensure that the following statement exists in your CONFIG.SYS file before starting RAMBoost:

```
device=c:\netroom\rm386.sys ems=c800-efff frame=none
```

This statement assumes that you are not using EMS.

**Qualitas 386MAX and BlueMAX**
The following statement should exist in your CONFIG.SYS file before starting RAMBoost:

```
device=c:\max\386max.sys include=b000-b800 ems=512
```

Change the EMS parameter to read ems=0 if you do not need EMS. Making this change increases the upper memory available to RAMBoost by 64K.
If RAMBoost Setup detects 386MAX (Version 7 or above) or detects BlueMax (Version 6.02 or above), it adds the NOS8 parameter to the MAX profile. If you install one of these versions after RAMBoost is loaded, you either need to edit the MAX profile manually or run RAMSETUP again.

Any version of 386MAX or BlueMAX before the version listed above should not include the NOS8 parameter in the MAX profile.

RAMBoost Setup deletes from the CONFIG.SYS file two incompatible BlueMAX or 386MAX (Version 7) devices, both named EXTRADOS.MAX. These files are no longer necessary, as RAMBoost provides similar function.

QEMM-386
If QEMM-386 is already installed, you should see the following statement in your CONFIG.SYS file:

```
device=c:qemm\qemm386.sys ram x=f000-ffff st:m
```

If you do not need EMS, add the noems switch to this statement in your CONFIG.SYS file. Making this change increases the upper memory available to RAMBoost by 64K.

RAMBoost Setup deletes the following incompatible QEMM (Version 7) devices from the CONFIG.SYS file:

- DOS-UP.SYS file
- DOSDATA.SYS file

DESQview and Enhanced Windows
RAMBoost does not automatically reset from the DESQview DOS box or the enhanced Windows environment.

If RAMSETUP is run from within one of the environments, you must restart your computer on exiting the DESQview DOS box or Windows. This is the only way RAMBoost can optimize memory.
Running RAMBOOST with PCMCIA (Non-Thinkpad)

To run RAMBOOST with PCMCIA on non-Thinkpad systems:

1. Edit your CONFIG.SYS file and remark out or remove the memory manager and reboot (before activating PCMCIA).
2. Install PCM PLUS (the PCMCIA support product shipped with PC DOS 7) by issuing the PCMDINST command from your DOS\PCM directory.
3. Configure all your PC-Cards using the PCM or PCMWIN utility and ensure they are functional. For example, if you have a network card, ensure you can access the network.
4. Restart your system if it doesn't restart automatically after configuring your last PC-Card.
5. Start RAMBOOST by typing `ramsetup` at the DOS command prompt.

Resolving Memory Conflicts

Memory utilization can be optimized with the use of PC DOS 7 memory optimizer RAMBOOST. But the systems must be configured so that memory areas for the PC-Card, adapter and Memory Manager (such as EMM386) do not conflict with one another.

The default memory configuration shipped with the PCMCIA support requires little or no user intervention for most people. The preconfiguration involves limiting PCMCIA card services to the top 48K of the D segment: D400-DFFF.

The upper memory map would look like this to RAMBOOST:

```
0 1 2 3 4 5 6 7 8 9 A B C D E F
C 000000000000000000000000000000000000000000000000000000000000000000
D 0000000000000000xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
```

You should attempt to configure your PCMCIA resources within the pre-set D400-DFFF range. If D400-DFFF is not available to PCMCIA or a PC-Card requires memory outside the available range, the user will have to manually re-configure PCMCIA resources. To determine the required memory space boundary for the PC-Card, refer to the manual that came with the PC-Card. Most PC-Cards specific memory requirements can be relocated when the specified boundaries are followed. Use the PCMRMAN utility to reconfigure PCMCIA resources. See Chapter 23, "Using PCMCIA Support" on page 501 for more
information. Issue the command PCMRMAN /MAP to view PCMCIA resource allocation. This displays the memory ranges currently available to PCMCIA.

Issue the command PCMRMAN to modify the PCM Plus resources. For example, suppose you have a card requiring a 16K memory range starting at D000. Use the PCMRMAN utility to “Include” ranges D000-D3FF; each block listed is 4K in size. Hence, the range of D000-D3FF. You must reboot the computer so the changes can take affect.

When you start PCM, ignore the WARNING message that the included memory is already excluded and follow the instruction to press any key to continue.

Use PCM or PCMWIN utility to configure the PC Card at the location made available through PCMRMAN. Go to the section in Chapter 23, “Using PCMCIA Support” on page 501 that discusses how to use PCM to configure the different types of PCMCIA cards.

**Making more memory available to RAMBOOST**

When you run PCMCIA before running RAMBOOST, 48K of upper memory to is made available for PCMCIA. You might not need this much space allocated. To release the space PCMCIA is not using and make it available to RAMBOOST, run PCMRMAN to exclude the unused ranges.

For example, you only have a modem card, which requires no memory. You can make 44K of upper memory available to RAMBOOST by excluding the range D400-DEFF. The upper memory map then looks similar to the following to RAMBOOST:

```
0 1 2 3 4 5 6 7 8 9 A B C D E F
C 000000000000000000000000000000000000000000000000000000000000000
D 000000000000000000000000000000000000000000000000000000000000000
```

x- Memory available to PCMCIA Card Services
0- Memory available to RAMBOOST

If you only have an ATA (Harddisk) and a modem, you can then exclude the range D800-DEFF giving RAMBOOST an extra 28K of upper memory.

** PC Card is a trademark of the Personal Computer Memory Card International Association.
The upper memory map then looks similar to the following to RAMBOOST:

```
0 1 2 3 4 5 6 7 8 9 A B C D E F
C 0000000000000000000000000000000000000000000000000000000000000
D 0000000000000000xxxxxxxxxxxxxxxx0000000000000000000000000000x
```

x - Memory available to PCMCIA Card Services
0 - Memory available to RAMBOOST

After changing your PCMCIA configuration, RAMBOOST must be re-installed. Type `ramsetup` at the DOS prompt and select to have RAMSETUP rebuild the EMM386 statement.

**Running RAMBOOST with Thinkpad PCMCIA Software**

The procedure you need to follow to run RAMBOOST with the Thinkpad PCMCIA software depends on the date the Thinkpad was shipped. Thinkpads shipped during 1993 contain the PCMCIA Version 2.0 release. Thinkpads shipped during 1994 contain PCMCIA Version 2.1

With PCMCIA Version 2.0 you need to make space available for RAMBOOST to run without a memory conflict. With PCMCIA Version 2.1, you need to make space unavailable to RAMBOOST to avoid memory conflicts.

**To adjust the PCMCIA Version 2.0 release for RAMBOOST,**

1. View your `CONFIG.SYS` file for the statement:
   ```
   DEVICE=C:\PCMCIA\DICRMU01.SYS /MA=xxxx-xxxx
   ```
   where `xxxx` represents the reserved upper memory range.
2. Record the value indicated for the reserved memory. You will use this as a guide when running RAMSETUP to allocate the available upper memory for RAMBOOST.
3. Type `ramsetup` at the DOS command prompt.
4. Select Advance.
5. TAB or click on the Upper Memory Usage Editor.
6. Click on the desired location or use the Arrow Keys to move the highlight to the desired location.
7. Press F2 to set the space to -- (Available) and make that space (memory range) available to RAMBOOST.

8. Repeat until all desired ranges are edited.

For example, if you see the following statement in your CONFIG.SYS file:

```
device=c:\pcmcia\dicrmu01.sys /ma=c000-cfff
```

You would need to set an available range of D000-DFFF in RAMSETUP for RAMBOOST to run without a memory conflict.

**To adjust the PCMCIA Version 2.1 release for RAMBOOST**

1. View your CONFIG.SYS file for the statement:

```
DEVICE=C:\PCMCIA\DICRMU01.SYS /MA=xxxx-xxxx
```

where `xxxx` represents the reserved upper memory range.

2. Record the value indicated for the reserved memory. You will use this as a guide when running RAMSETUP to allocate the available upper memory for RAMBOOST.

3. Type `ramsetup` at the DOS command prompt.

4. Select Advance.

5. TAB or click on the Upper Memory Usage Editor.

6. Click on the desired location or use the Arrow Keys to move the highlight to the desired location.

7. Press F7 to set the space to AD (Adapter RAM) so that the memory range specified by the `/ma` switch (associated with DICRMU01.SYS) is blocked from use by RAMBOOST.

8. Repeat until all desired ranges are edited.

For example, if you see the following statement in your CONFIG.SYS file:

```
device=c:\pcmcia\dicrmu01.sys /ma=c000-cfff
```

You would need to make the range of C000-CFFF unavailable to RAMBOOST to run without a memory conflict.
Chapter 14. Speeding Up Your System

This chapter explains how to speed up your system with the following methods:

- Improving the efficiency of your hard disk
- Using DOS Defragmenter
- Using the BUFFERS command
- Using SMARTDrive
- Using RAM Drive

Improving the Efficiency of Your Hard Disk

You can use the following methods to speed up your system without taking up additional memory.

Deleting Unnecessary Files

Deleting unnecessary files is an easy solution to freeing disk space. There are two categories of files you might consider deleting:

- Program and data files that you no longer use
- Temporary files that were left on your hard disk when a program ended unexpectedly

You can use the following guidelines to decide whether or not to delete a file and then use the DELETE command to delete the file.

Many programs create temporary files while they are running. Some programs store those files in a separate directory that is specified in your AUTOEXEC.BAT file by using the SET command. Most often, you designate such a directory by using the SET command with the TEMP or TMP environment variable.

You should periodically clean out your TEMP directory. This is not necessary if your TEMP directory is on a RAM (Random Access Memory) disk. To avoid deleting a temporary file that is currently in use, you should delete files in your TEMP directory only when you are not running any program.

CAUTION:

Never delete the files COMMAND.COM, IBMBIO.COM, or IBMDOS.COM. The IBMBIO.COM and IBMDOS.COM files are usually hidden files. If you delete any of these files, your system will not start.
Using the CHKDSK Command

You can use the CHKDSK command to recover lost allocation units that are taking up space on your hard disk. An allocation unit is the smallest piece of a hard disk that can be allocated to a file. Allocation units can get lost when a program ends unexpectedly, leaving temporary files on the hard disk without saving or deleting them properly.

Make sure you quit all programs before using the CHKDSK command. If you are using any memory-resident program, such as SMARTDrive, disable the corresponding commands in your CONFIG.SYS file and restart your system.

To follow the recommended procedure for using the CHKDSK command:

1. Quit all programs—including memory-resident programs.
2. Change to the hard disk you want to clean up.
   For example, you would type d: if you want to clean up the files on drive D.
3. At the DOS command prompt, type:
   `chkdsk /f`
   The /f switch finds and recovers any lost allocation units.
4. If there are any lost allocation units, you are prompted to convert them to files.
   If you want to inspect the contents of the lost allocation units before deleting them, type y for YES. If you are sure the lost allocation units do not contain information you want, type n for NO. The information is deleted and you can skip the remaining steps in this procedure.
   If you answer y for YES, the lost file allocation units are converted to visible files with file names similar to FILE0001.CHK. These files are put in your root directory.
5. Use the TYPE command to view the contents of the files.
6. Delete any .CHK files you do not want.

For more information about the CHKDSK command, type help chkdsk at the DOS command prompt.
Helping DOS Find Files Quickly

When you type a command or start a program, DOS must find the executable file before it can carry out the command or start the program. If you type the full path and file name of the file, DOS can find and carry out the command or run the program almost immediately. If you type only the file name, DOS searches for the program file as follows:

- DOS looks for the program file in your current directory.
- If the file is not in your current directory, DOS looks for the file in the directories specified by your PATH command. It searches the directories in the order they appear in the path command. Typically, the PATH command is included in your AUTOEXEC.BAT file.

This search can take time, particularly if your path contains many directories or if your directories contain many files. The fewer directories and file names DOS must search through, the faster the response will be.

If your hard disk has one or two directories that contain frequently used program files, you might want to list those directories first in your PATH command. For example, suppose all your DOS batch (.BAT) programs are in the directory C:\MYTOOLS, and the programs you use most frequently are in the directory C:\PROGRAMS. An efficient path command might look similar to the following:

```
path=c:\mytools;c:\programs;c:\dos;c:\;
```

You should keep the number of files in each directory to 150 or less. This reduces the time DOS spends searching.

Using DOS Defragmenter

Over time, as programs read from and write to your hard disk, information stored on your hard disk can become fragmented. Fragmentation occurs when a file, instead of being stored in contiguous sectors of the disk, is broken into fragments that are stored in different locations on the disk. Fragmentation does not affect the validity of the information—your files are still complete when you read them into a program. However, it takes much longer for your computer to read and write fragmented files than it does to read and write defragmented files.

To defragment files, you run a program that reorganizes your files on disk drives back into contiguous files, which then optimizes performance.

If you need help while using DOS Defragmenter, press F1. For further information about the DEFRAG command, type help defrag at the DOS command prompt.
To defragment the files on a non-compressed hard disk:

1. Delete any unnecessary files from the hard disk.
2. Quit all programs.
3. Clean up lost allocation units by typing the following at the DOS command prompt:
   
   `chkdsk /f`
4. Run DOS Defragmenter by typing the following at the DOS command prompt:
   
   `defrag`

   DOS Defragmenter displays a list of the disk drives on your computer.
5. Choose the drive you want to defragment.

   DOS Defragmenter analyzes the data on that drive and recommends a defragmentation option. It also displays how the information is laid out on the drive you specified.
6. To begin defragmentation, select **Optimize**.

   Or, if you want to change the defragmentation settings or get more information about the current defragmentation settings before you begin it, select **Configure** by pressing the RIGHT ARROW key and then pressing ENTER.

   The Optimize menu appears.

   For information about the commands on the Optimize menu, select a command by pressing the UP ARROW or DOWN ARROW key and then press F1. To begin the defragmentation from the Optimize menu, select **Begin Optimization** and press ENTER.

For information about defragmenting a compressed driver, see Chapter 21, “Using Stacker Compression” on page 427.
Using the BUFFERS Command

The BUFFERS command in your CONFIG.SYS file specifies the number of buffers that DOS reserves for file transfers. For information about the BUFFERS command, type help buffers or see the online PC DOS 7 Command Reference.

The greater the number of buffers (up to about 50), the faster your system runs. However, past a certain value, increasing the number of buffers only uses more memory without increasing speed.

When optimizing your system for speed, you want to specify the greatest number of buffers that are useful for your system. This number depends on the size of your hard disk. The following are the most effective buffer sizes for different sizes of hard disks:

<table>
<thead>
<tr>
<th>Hard-disk size</th>
<th>Buffer size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less than 40MB</td>
<td>20</td>
</tr>
<tr>
<td>40 through 79MB</td>
<td>30</td>
</tr>
<tr>
<td>80 through 119MB</td>
<td>40</td>
</tr>
<tr>
<td>More than 120MB</td>
<td>50</td>
</tr>
</tbody>
</table>

The following command specifies 40 buffers—an optimal number for a system with a 110MB hard disk:

buffers=40

When calculating the default number of buffers, DOS bases the number on how much conventional memory your system has, rather than on the size of your hard disk. The default number that DOS calculates is a minimum number. The numbers in the preceding list are larger in order to increase system speed.

When a disk cache, such as the SMARTDrive program, is in use, the BUFFERS number is not as critical and can be set lower.
Using SMARTDrive

The SMARTDrive program (SMARTDRV) is a terminate-and-stay resident (TSR) program that you can add to your AUTOEXEC.BAT file. This program reduces the time your computer spends reading data from your hard disk. You can control the size of the SMARTDRV memory cache and set up the hard-disk cache in extended memory.

If you need to use the double buffering feature of SMARTDRV, you must designate SMARTDRV as a device driver by including the proper DEVICE command in your CONFIG.SYS file. See "Using Double Buffering" on page 237.

**Note:** If your system does not have extended memory, you cannot use the SMARTDrive program.

**To use the SMARTDrive program:**

1. Verify whether your system has extended memory by typing the following at the DOS command prompt:
   
   ```
   mem
   ```

   You must have a DOS memory manager, such as HIMEM.SYS installed on your system.

   Windows and DOS contain several programs that have the same name. However, the PC DOS programs have been updated after the release of Windows 3.1. If you install Windows after installing DOS, check your CONFIG.SYS and AUTOEXEC.BAT files to make sure that you are using the programs HIMEM.SYS, EMM386.EXE, and SMARTDRV.EXE from the DOS directory and not from the Windows directory.

2. If your system has extended memory, add this command to your AUTOEXEC.BAT file so that this program runs whenever you start your computer.

   The command-line statement in your AUTOEXEC.BAT file should look like this:
   
   ```
   smartdrv [[drive[+|-]]...] [options]
   ```

   For a list of the options available for use with the SMARTDRV command, type `help smartdrv` at the DOS command prompt.

SMARTDRV reserves an area in extended memory and then uses this area to store information it reads from your hard disk. An application gets this information much faster if SMARTDRV provides it from memory than if the application has to retrieve it from the hard disk. SMARTDRV also temporarily stores information to be written to your hard disk and later writes this information when system resources are in less demand.
SMARTDRV also supports caching for CD-ROMs. This function can be enabled or disabled by typing:

```
smartdrv drive+-
```

If you do not want CD-ROM caching, you can load SMARTDRV with the /u switch. However, when SMARTDRV is loaded with this switch, CD-ROM caching cannot be enabled again until SMARTDRV is disabled.

**Using Double Buffering**

Double buffering is most commonly required if you are using a Small Computer System Interface (SCSI) hard disk, Windows, or other hard-disk controllers that cannot work with virtual memory.

To use the SMARTDrive program with double buffering:

1. Verify whether your system has extended memory.

2. If your system has extended memory, add the following command to your CONFIG.SYS file:

   ```
   device=c:\dos\smartdrv.exe /double_buffer
   ```

3. Press CTRL+ALT+DEL to restart your system.

Most hard-disk controllers do not need to use double buffering. You should remove the SMARTDRV command-line statement from your CONFIG.SYS file if you do not require double buffering.

To determine whether or not you can remove this command:

1. Ensure that the SMARTDRV driver has been loaded using the CONFIG.SYS command-line statement and double buffering has been enabled.

2. At the DOS command prompt, type `smartdrv` and press ENTER. SMARTDRV displays information about your system.

3. Look at the column labeled “buffering.” If any line in the column reads “yes” or contains a hyphen, do not remove the DEVICE command for SMARTDRV from your CONFIG.SYS file.
Using RAMDrive

RAMDrive is a memory-resident program, also known as a terminate-and-stay-resident (TSR) program, that lets you use part of your computer’s memory, called a RAM drive, as if it were a hard disk drive. By using RAMDrive, you can make programs run faster. RAM disks are temporary—any data you place on the RAM disk is lost when you turn off your computer. You can set up as many RAM disks as you want, limited only by the amount of memory your computer has and DOS drive letters available. You can run this feature on your system in either extended or expanded memory.

You should specify the extended or expanded parameter. Otherwise, RAMDRIVE.SYS uses your system’s conventional memory.

For more information about RAMDRIVE.SYS, type help ramdrive.sys or see the online PC DOS 7 Command Reference.

When you install DOS, the Setup program copies the RAMDRIVE.SYS file to your DOS directory. To create a RAM drive, you add a DEVICE or DEVICEHIGH command-line statement for RAMDRIVE.SYS drive to your CONFIG.SYS file. You must add a command for each RAM disk you use with your system.

To activate the RAMDrive feature of your system:

1. Make a copy of your CONFIG.SYS file as a backup file.
2. Open your CONFIG.SYS file by using a text editor, such as the E Editor.
3. Add a DEVICE or DEVICEHIGH command-line statement for the RAMDRIVE.SYS device driver after the DEVICE command that installs the expanded or extended memory manager. It should appear similar to the following:

   device=c:\dos\ramdrive.sys 512 /e

   This example creates a RAM drive that takes up 512K of extended memory. You can specify how much and what type of memory your RAM drive uses by customizing the command-line statement. The /e switch specifies that extended memory should be used.

4. Save the changes to your CONFIG.SYS file and exit the E Editor.
5. Open your AUTOEXEC.BAT file.
6. Set the TEMP environment variable to your RAM drive by adding a SET command-line statement. The drive letter of your RAM drive should be the letter after that of your last physical drive.

For example, if your last physical disk drive is C, your RAM drive would be D. In this case, you would add the following command to your AUTOEXEC.BAT file:

```
set temp=d:\
```

7. Save the changes to your AUTOEXEC.BAT file.

8. Restart your computer by pressing CTRL+ALT+DEL.

Important:
If RAMDrive is to use extended memory, your CONFIG.SYS file must contain a DEVICE command for the HIMEM.SYS memory manager. If RAMDrive is to use expanded memory, your CONFIG.SYS file must contain a DEVICE command for the expanded-memory manager that came with your memory board. The DEVICE command for RAMDrive must come after the one for the memory manager.

You can improve the performance of RAMDrive by doing the following:

- If you run programs from your RAM drive, list your RAM drive first in your PATH command.

  For example, if your RAM drive is drive D, add d:\ to the beginning of the PATH command. For information about the PATH command, type help path at the DOS command prompt.

- If you use the EMM386 program as an expanded-memory emulator, do not put the RAM drive in expanded memory.

Although RAMDrive can also use this emulated expanded memory, it is not as efficient as it would be if it were using real physical memory.
Chapter 15. Using Central Point Undelete

The Central Point Undelete program (Undelete) recovers files and directories protected by these methods of delete protection:

- Delete Sentry**
- Delete Tracker

Undelete is most effective when you protect files using one of its own delete protection methods, but it can also detect other methods of delete protection, such as:

- Novell** NetWare** 386
- DR DOS** DelWatch

Also, DOS can usually undelete its own files, even if they are unprotected. For information about configuring Delete Sentry and Delete Tracker, see “Central Point Data Monitor” on page 270.

Undelete files as soon as possible for the best chance of recovering all your data. If you have accidentally erased or formatted your entire disk or diskette, use UNFORMAT to recover the disk.

Installing Central Point Undelete for Windows

Undelete for DOS is installed automatically during PC DOS Setup. However, if you want to use Undelete while in a Windows session, and you did not select Undelete for Windows at initial setup, you can still install this program.

During Setup, PC DOS checks whether your computer has Windows 3.1 installed. If you do not have Windows 3.1 installed and want to use the optional tools provided with PC DOS, you should make sure you install in this order:

1. Install PC DOS as you normally would, selecting the optional tools you want from the list provided. You will not see any of the optional tools for Windows listed.

2. After you have installed PC DOS, install Windows 3.1 as you normally would.
3. Install PC DOS again using the DOS Setup /e switch to install optional tools after PC DOS and Windows have been installed.

To install Central Point Undelete for Windows using the PC DOS Setup /e switch:

1. Insert the Setup Diskette from the PC DOS installation diskettes into drive A or B.

2. At the DOS command prompt, type:
   
```plaintext
a:setup /e
```

or

```plaintext
b:setup /e
```

The /e switch allows you to return to the optional-tools selection menu without having to do a complete reinstallation. At this point, only the necessary files for the optional tools for Windows will be installed.

3. After Setup for PC DOS begins, follow the instructions displayed on the screen. Make sure you specify the same “Install to Path” as you did when you did the initial PC DOS installation.

   At the Optional Tools menu, you see a NO next to Central Point Undelete for Windows.

4. Press the UP ARROW or DOWN ARROW until you highlight Central Point Undelete for Windows. You can select other optional tools at this time by highlighting and pressing ENTER for each item.

   You now see YES next to Central Point Undelete for Windows and other optional tools you selected.

5. After you select the optional tools you want to install, move the cursor to highlight the following:

   Options correct. Continue Setup.

6. Press ENTER to accept the optional tool selections.

   Continue to follow the instructions displayed on the screen until the optional tools are installed.
Starting Undelete

Undelete is a tool that recovers files and directories protected by specific methods of delete protection. It can even undelete most files not protected by these methods. Undelete works in conjunction with Data Monitor, a memory-resident program that includes several options to guard against data loss and protect confidential data.

To start Central Point Undelete:

1. Type the following at the DOS command prompt:

   undelete

2. Then press ENTER

If you prefer, you can use the DOS command prompt to undelete files rather than use the full-screen version of Undelete.

To start the command-line version of Undelete:

1. At the DOS command prompt, type:

   undelete drive:\directory

2. Then press ENTER.

   For each occurrence of a deleted file, you are prompted:

   Do you want to recover this file? (Y/N)

3. Press Y to answer yes, or press N to answer no when queried about each file.

You can limit your search by specifying the full path for the file if you know it, by specifying a specific directory that you know contained this file, or by using wildcards just as you limit the search when using the DIR command. A better way to find out what files have been deleted is to type the following:

   undelete /list

Typing this command provides a list of the files you have deleted and the method of protection being used to protect them, such as Delete Sentry, Delete Tracker, or DOS. You see a list of deleted files for the current directory.

To start the Windows version of Undelete:

You can start Central Point Undelete for Windows by double-clicking on the Central Point Undelete icon located in the PC DOS Tools program group. You then see the main window for Central Point Undelete for Windows.
Viewing the Undelete Window
When the Undelete window appears, the directory tree on the left shows the directory structure of the selected drive. The file list on the right shows subdirectories and files that have been deleted from the highlighted directory. When you delete a file, you no longer see it when you use the DOS DIR command, but its data might still be on the disk.

<table>
<thead>
<tr>
<th>What you see</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive Line:</td>
<td>Shows the currently selected drive.</td>
</tr>
<tr>
<td>Directory tree:</td>
<td>Shows a graphical representation of all directories on the current drive.</td>
</tr>
<tr>
<td>File list:</td>
<td>Lists subdirectories and all deleted files from the highlighted directory. If a question mark (?) appears as the first character of the file name, this means that the deletion was not recorded by delete protection. If you are undeleting files on a network drive, Undelete comes up with an expanded file list rather than the directory tree and file list. See &quot;Undeleting Files on a Network&quot; on page 251.</td>
</tr>
<tr>
<td>Deleted File Status panel:</td>
<td>Informs you as to when and how the highlighted file was deleted and gives details about the file's condition.</td>
</tr>
</tbody>
</table>
**Function Keys**
The following function keys are available in Undelete:

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 HELP</td>
<td>Provides online help about the selected item.</td>
</tr>
<tr>
<td>F2 INDEX</td>
<td>Displays the Help index.</td>
</tr>
<tr>
<td>F3 EXIT</td>
<td>Exits from Undelete.</td>
</tr>
<tr>
<td>F4 VIEW</td>
<td>Displays the contents of the highlighted file.</td>
</tr>
<tr>
<td>F5 SELECT</td>
<td>Lets you select files by file name specification.</td>
</tr>
<tr>
<td>F6 UNSELECT</td>
<td>Lets you deselect files by file name specification.</td>
</tr>
<tr>
<td>F7 FIND</td>
<td>Gives you the Find Deleted Files window.</td>
</tr>
<tr>
<td>F8 UNDEL</td>
<td>Undeletes selected files.</td>
</tr>
<tr>
<td>F9 SORT</td>
<td>Lets you select a sort order for listing files.</td>
</tr>
<tr>
<td>F10 MENU</td>
<td>Activates the horizontal menu bar.</td>
</tr>
</tbody>
</table>

**Deleted File Condition**

The condition listed for each file name indicates how completely Undelete can recover it. Undelete assigns conditions based on the status of the file’s clusters. A cluster is a unit of disk space; a file occupies one or more clusters. A file’s clusters can be in consecutive order or scattered about the disk (fragmented).

<table>
<thead>
<tr>
<th>Condition</th>
<th>What You Can Expect to Recover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perfect</td>
<td>You can undelete the file completely and automatically. This is the condition of all files protected by these methods: Delete Sentry, Novell NetWare 386 Salvage, and DR DOS DelWatch.</td>
</tr>
<tr>
<td>Excellent</td>
<td>All the file’s clusters are available and unfragmented (in consecutive order on the disk) and can be undeleted automatically. There is a small chance that some data might be overwritten. This is the best condition you can expect for files protected by the Delete Tracker method of delete protection. DOS-deleted files that are small or unfragmented can also be in Excellent condition.</td>
</tr>
<tr>
<td>Good</td>
<td>One or more of the file’s clusters are in use by another file; therefore, they are not available. Some data might be overwritten.</td>
</tr>
<tr>
<td>Poor</td>
<td>The file’s first cluster and possibly more are not available. Use an Advanced Undelete method to recover as much as is still available.</td>
</tr>
<tr>
<td>Condition</td>
<td>What You Can Expect to Recover</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Destroyed</td>
<td>The file cannot be undeleted, because all of its known clusters are in use by other files. However, you might be able to recover some of the data from a DOS-deleted Destroyed file using an Advanced Undelete method.</td>
</tr>
<tr>
<td>None</td>
<td>The file cannot be undeleted, because it had no data in it when it was deleted. It is a file entry with a size of 0 bytes.</td>
</tr>
<tr>
<td>Existing</td>
<td>The file is not a deleted file. It was added to the list by the Show Existing Files option so that you can rename it or add deleted clusters to it manually, using Append to Existing File, one of the Advanced Undelete methods.</td>
</tr>
<tr>
<td>Lost File</td>
<td>The file was found by scanning for lost deleted files. It is a deleted file whose directory cannot be determined. Most likely, its directory has been deleted.</td>
</tr>
<tr>
<td>Recovered</td>
<td>The file was undeleted during the current session.</td>
</tr>
<tr>
<td>Purged</td>
<td>The file was purged from Delete Sentry, DelWatch, or NetWare during the current session. You can no longer recover the file.</td>
</tr>
</tbody>
</table>

For technical information about the status of data in Excellent, Good, Poor, and Destroyed files that can help you decide how best to undelete files with those conditions, see “How the Delete Protection Method Affects File Recovery” on page 267. These conditions have slightly different implications, depending on whether the file was protected by Delete Tracker or DOS when it was deleted.
Delete Protection Methods

The Deleted File Status panel tells you what the highlighted file's delete protection method was when it was deleted.

<table>
<thead>
<tr>
<th>Protection Method</th>
<th>How the Method Affects File Recovery and Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Sentry</td>
<td>Indicates that the Delete Sentry method of delete protection was used. Files can be undeleted in Perfect condition, because they are saved in a hidden directory.</td>
</tr>
<tr>
<td>Delete Tracker</td>
<td>Indicates that the Delete Tracker method of delete protection was used. DOS leaves deleted file data on the disk but marks the file's clusters as available. The Delete Tracker method records the cluster addresses of deleted files. As long as the file's clusters have not been overwritten by new data, a Delete Tracker-protected file can be undeleted in Excellent condition.</td>
</tr>
<tr>
<td>DOS</td>
<td>Indicates that no delete protection method was used. When DOS is the only source of information, files are undeleted based on their entries in the DOS directory and in the File Allocation Table (FAT).</td>
</tr>
<tr>
<td>NetWare 386</td>
<td>Indicates that Novell NetWare's method of delete protection was used on the network drive. Files can be undeleted in Perfect condition because they actually remain on the drive until they are purged or the space they occupied is overwritten. This method of delete protection must be configured by the network administrator and users given Create rights to retrieve files prior to using Undelete.</td>
</tr>
<tr>
<td>DelWatch</td>
<td>Indicates that the DR DOS method of delete protection, DelWatch, was used. Files can be undeleted in Perfect condition.</td>
</tr>
</tbody>
</table>

For technical details about these methods, see “How the Delete Protection Method Affects File Recovery” on page 267.
Getting More File Information

You can get additional information about any file you highlight by selecting File Info from the File menu.

<table>
<thead>
<tr>
<th>File Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>File: SHIPPING.WK1</td>
</tr>
<tr>
<td>Size: 0251</td>
</tr>
<tr>
<td>Path: B:\SALES\ANNUAL\</td>
</tr>
<tr>
<td>Modified date: 2/21/91</td>
</tr>
<tr>
<td>Deleted date: 2/20/91</td>
</tr>
<tr>
<td>First Cluster: 80</td>
</tr>
<tr>
<td>Condition: Perfect</td>
</tr>
<tr>
<td>Protected by: Delete Sentry</td>
</tr>
<tr>
<td>This file can be 100% undeleted.</td>
</tr>
</tbody>
</table>

Sorting the File List

If you select more than one file to undelete, the sort order determines the order in which the files will be undeleted. If you are undeleting a group of files at one time that have different conditions, before undeleting them, sort them in order of condition so that Undelete can recover the files that are in the best condition first. The displayed condition of a file can change as previous files are undeleted.

Changing the Sort Order

By default, Undelete sorts by file name. However, you can change the order in which Undelete displays files by selecting a different sort order. For example, you might want to see all the .BAT files or all the files created on a certain date listed together so you can quickly find the one you wanted to undelete. Or, if you knew that the file was very small, you might sort the list in order of size.

1. Select Sort by from the Options menu.

2. In the Sort by window, select one of the following sort orders, and then select OK.
   - **Name**: Sorts the files by file name, which is the default.
   - **Extension**: Sorts the files by file extension.
   - **Size**: Sorts the files by size, with the smallest files first.
   - **Deleted Date and Time**: Sorts files protected by Delete Sentry and Delete Tracker in order of the date that files were deleted. Within each date group, files are sorted in order of time deleted. DOS-deleted files that have an unknown date are listed last in unchanged order.
Modified Date and Time: Sorts the files in order of the date that files were last modified. Within each date group, files are sorted in order of time last modified.

Directory: Sorts the files alphabetically by directory name. This option is available only in the expanded-file list displayed for network drives and files found by specification, where the directory tree is not shown.

Condition: Sorts the files by condition, in the following order: Perfect, Excellent, Good, Poor, Destroyed, Existing.

Selecting Files

You must first select the files that you want to undelete. The following table gives you several ways to select these files.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a single file</td>
<td>Move the highlight bar to the file you want to undelete and click the left mouse button, or press ENTER or SPACEBAR. The selected file changes color. You can select more than one file this way.</td>
</tr>
<tr>
<td>Select or deselect a group of files with the mouse</td>
<td>Press and hold the right mouse button, position the highlight bar over the first file, then also press and hold down the left mouse button. Drag the cursor over any additional files you want to select or deselect. Release both mouse buttons when finished.</td>
</tr>
<tr>
<td>Select a group of files by specification</td>
<td>Select Select by Name from the Options menu, enter a file specification, and select OK. Selected files change color.</td>
</tr>
<tr>
<td>Deselect a group of files by specification</td>
<td>Select Deselect by Name from the Options menu, enter a file specification, and select OK. The specified files are deselected.</td>
</tr>
</tbody>
</table>

Automatic Undelete Methods

When you have selected one or more files or directories, decide on an undelete method based on the condition of the deleted file. See "Deleted File Condition" on page 245. The methods described below undelete directories as well as files.

*The Use Mirror File option is dimmed and deselectable when there is no Mirror file.*
Undeleting a File Automatically

<table>
<thead>
<tr>
<th>If:</th>
<th>Then:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A selected file's condition is Perfect, Excellent, or Good</td>
<td>Select Undelete from the File menu or press F8 to undelete the file automatically, in the directory from which it was deleted.</td>
</tr>
<tr>
<td>The file's condition is Good</td>
<td>You might want to undelete it to another drive, as described next. At least some of the disk space occupied by a Good file can be in use by another file. Use Undelete if you do not want that part of the file included. Use Undelete to if you want to include it.</td>
</tr>
</tbody>
</table>

Undeleting a File to a Different Drive
As a safety precaution, you can undelete a file to a different drive, leaving the original deleted file unchanged. You can undelete to a floppy disk, for example. Then, if that automatic undeletion does not recover all the data you want, you still have the option of rebuilding the unchanged deleted file one cluster at a time. See “Advanced Undelete Methods” on page 261.

To undelete a file to a different drive:

1. Select Undelete to from the File menu.
2. Select the drive where you want the undeleted file or files to be placed and select OK.
3. For each selected file, accept or change the default directory path and select OK.

The file is undeleted to the specified path under its original name. If the first character was “?” in the file name, it is replaced with an “X” by Undelete.

Renaming an Existing File
Undelete lets you know if a file you are undeleting has the same name as an existing file. For example, this might happen if the deleted file is a previous version of an existing file. You can rename the existing file before you undelete the deleted one, allowing you to keep both files in the same directory.
To rename an existing file:

1. If the directory tree and file list are not visible, select Tree & File List from the File menu or press F7.

2. Select Show Existing Files from the Options menu to add all existing files to the list of deleted files in each directory.

3. Select the existing file you want to rename.

4. Select Advanced Undelete ➤ Rename Existing File from the File menu.

5. In the Rename Existing File window, type a new name for the existing file and select Rename.

6. After the existing file has been renamed, you can use Undelete to recover the deleted file that would have duplicated the existing file's name. To remove the existing files from the list, select Show Existing Files again.

Undeleting Files on a Network

If you are undeleting files on a network drive, Undelete lists the files that users have deleted that were protected by Delete Sentry or Novell NetWare 386 method of delete protection. In place of a directory tree, Undelete shows the path for the deleted files in an expanded file list.
If a network directory is hidden, Undelete will not display the files unless the directory's hidden attribute is changed. Also, files deleted by other users do not appear in the list if you are using Delete Sentry, but the Novell NetWare method of deletion protection shows all files. You can undelete files that you have deleted with your current user name.

If you use Novell NetWare's method of delete protection to protect the network drive, users can see deleted files but cannot recover files unless the network administrator has assigned Create rights to the directory that contained the deleted files.

If none of these methods of delete protection were used on the network drive, Undelete does not list any deleted files.

The following commands are not available if you are undeleting files on a network drive:

- Tree & File List on the File menu
- Advanced Undelete on the File menu
- All commands on the Disk menu
- Show Existing Files on the Options menu
- Use Mirror File on the Options menu

**Note:** The Use Mirror File option will be dimmed if Mirror is not available.

For more information, see “Deleted File Condition” on page 245 and “Delete Protection Methods” on page 247.

### Undeleting Directories and Their Files

NetWare does not keep track of deleted directories, but the program does track the files in deleted directories. All other methods for finding files also find deleted directories.

A directory contains file entries identifying the names, starting locations, and other information for all files that belong to it. When you delete a directory, deleted files that were in that directory no longer appear in Undelete's file lists. However, the deleted directory appears, identified with a folder icon and <dir> listed as the file size. As soon as you undelete a directory, any deleted files it contained appear in Undelete's file lists. If you cannot find a deleted file, see if you can find its directory using the directory tree and file list. When you undelete the directory, it appears in the directory tree. Select that directory, and then select and undelete any of its deleted files.
If you cannot find a deleted file's directory, you can still find the file or its data by using one of Undelete's disk scan methods discussed in "Scanning the Disk for Lost Files and Deleted Data" on page 258.

**Undeleting a Directory**

As you add files to a directory, it grows in size. DOS splits large directories into more than one group of file entries and does not keep track of the additional groups if you delete the directory. You can undelete most directories automatically. However, when Undelete cannot determine the location of all parts of a directory, it displays the Directory Undelete window.

**Identifying Groups of File Entries Belonging to a Directory**

In the Directory Undelete window, identify the groups of file entries that belong in the directory you are undeleting.

In this window, you do not select individual files to undelete. Rather, you decide whether the entire group of file entries displayed in the list box represents files that belong in the directory you want to undelete.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>The group of file entries displayed in the scrollable file list was in the directory</td>
<td>Select Add. Undelete adds this group and searches for the next probable group of file entries.</td>
</tr>
<tr>
<td>The displayed group of file entries was not in the directory.</td>
<td>Select Skip. Undelete searches for the next probable group.</td>
</tr>
</tbody>
</table>
To identify groups of file entries belonging to a directory:

1. Continue adding groups of file entries that belong in the directory. When you have added the same number of groups as originally belonged in the directory, Undelete recovers the directory automatically (you do not have to select Undelete) and rebuilds the directory tree to include it.

2. Select Undelete to recover the directory before all groups are added.

**Finding Deleted Files**

If you cannot find a deleted file easily by looking for it in the Undelete directory tree and file list or when you want to display all deleted files on the disk in one listing, you can search for files by entering a file specification.

**To find deleted files:**

1. On the drive line above the Undelete directory tree and file list, click the drive from which the file was deleted, or press CTRL and the drive letter.

2. Select Find Deleted Files from the File menu, or press F7.

![Find Deleted Files window](image)

3. Select an option:

   **File Specification text box:** Lets you specify the name of the file or files you are searching for, using the DOS wildcard characters * and ?.

   **Containing text box:** Lets you narrow the search to deleted files that contain a specific text string. The program finds only files that contain that string.

   **Groups:** Finds files associated with a particular application.

4. In the File Specification text box, enter the file specification that describes the file or files you want to find.

You can include more than one specification, separating each by one space.

For example, type *.EXE *.COM to include all program files.
You can exclude files by prefacing a file specification with a minus sign.

For example, type *.BAT -\*.BAT to include all batch files except those in the root directory.

- Use the LEFT ARROW and RIGHT ARROW to move the cursor one character right or left, and use HOME and END to position the cursor at the beginning or end of the entry.

- To insert characters, scroll to where you want to insert them, press the INSERT key, and type the additional characters. To delete text, position the cursor after the character to be deleted and press BACKSPACE.

You can use file specifications and file contents together to narrow your search.

For example, if you type the file specification *.DOC and you type budget in the Containing text box, the program will find all IBM DisplayWrite* files and other .DOC files that contain the word “budget.”

5. Enter the text you want to search for in the Containing text box.

6. Select the text search options:

   **Ignore Case:** Finds files containing the text whether it is uppercase or lowercase. For example, if you type CHOCOLATE, Undelete will find files containing “Chocolate,” “chocolate,” and “ChoCoLate.”

   **Whole Word:** Finds only the text you enter if it is one or more complete words. For example, if you type tort, Undelete will not find “tortellini” or “retorted.”

7. Select the delete protection methods to search for and then select OK.

   If no files on the current drive are protected by Delete Sentry, Delete Tracker, or DelWatch, those checkboxes are dimmed and you cannot select them.

   **Delete Sentry:** Finds deleted files that match the file and content specifications and were protected by Delete Sentry.

   **Delete Tracker:** Finds deleted files that match the file and content specifications and were protected by Delete Tracker.

   **DOS:** Finds deleted files that match the file and content specifications and were protected only by DOS.

   **DelWatch:** Finds deleted files that match the file and content specifications and were protected only by DR DOS’s DelWatch.

* DisplayWrite is a trademark of the IBM Corporation.
All files that match the specifications appear in the Find Deleted Files window, which contains an expanded file list that shows all files that match your Find Deleted Files specifications, including their paths.

![Expanded file list](image)

For more information, see “Deleted File Condition” on page 245 and “Delete Protection Methods” on page 247.

Most menu commands available in the Undelete directory tree and file list are also available in the Find Deleted Files window. The following commands are not available: Show Existing Files and its related commands, Rename Existing File, and Append to Existing File.

8. To return to the directory tree and file list from the Find Deleted Files window, select Tree & File List from the File menu or press F7.

The function associated with F7 switches between Tree and Find, depending on which window you are in. The command on the File menu also switches between the Tree & File List and Find Deleted Files options.
Searching for a Group of Files
Search groups make it easy to find deleted files associated with specific applications.

To search for a group of files:
1. Select Find Deleted Files from the File menu.
2. Select Groups in the Find Deleted Files window.
3. Select the group or groups from the Search Groups window and select OK.
   The specification for the group or groups you selected appears in the File Specification text box. If you selected more than one group, all of their specifications appear in the text box, separated by spaces.
4. Select OK in the Find Deleted Files window.
   The groups you selected remain in effect until you change the file specification or leave the program.

To add a search group:
1. Select Find Deleted Files from the File menu.
2. Select Groups in the Find Deleted Files window.
3. Select Edit.
4. Select New, and enter a group name and file specification.
   Enter a file specification that describes the names and location of the files. For example, if all your IBM DisplayWrite files were located in C:\DW5 and had the extension .DOC, enter the file specification C:\DW5\*.DOC to define a group called "DW5 Files."
5. Select Save.
6. To use this group for the next search, select it and select OK in the Search Groups window.
To edit or delete a search group:
1. Select Find Deleted Files from the File menu.
2. Select Groups in the Find Deleted Files window.
3. Select Edit.
4. Select the search group you want to edit or delete.
   
   To edit a search group, change the group name, file specification, or both and select Save.
   
   *Or*, to delete a search group, select Delete.
5. Select OK.
6. To use this group for the next search, select it and select OK in the Search Groups window.

**Scanning the Disk for Lost Files and Deleted Data**

You can scan the entire disk for *lost files* or for deleted data that is not associated with any file or directory if you have not found a deleted file using any of the following methods:

- Looking in the Undelete directory tree and file list
- Using the Find Deleted Files command
- Undeleting the file's deleted directory

Try the Scan for Lost Deleted Files option first. If you cannot find the files you are looking for, you can scan the disk's free clusters for the deleted data.

**Scanning for Lost or Deleted Files**

You can scan the entire disk for lost files—files no longer associated with any existing directory.

To scan for lost or deleted files:
1. Go to the directory where you want lost files to be recovered. Undelete recovers lost files to the current directory.
2. Select Scan for Lost Deleted Files from the Disk menu.
3. Select the delete protection methods to scan for:

   **Delete Sentry:** Finds deleted files that match the file and content specifications and were protected by Delete Sentry.

   **Delete Tracker:** Finds deleted files that match the file and content specifications and were protected by Delete Tracker.
**DOS:** Finds deleted files that match the file and content specifications and were protected only by DOS.

If no files on the current drive are protected by Delete Sentry or Delete Tracker, that checkbox is dimmed and you cannot select it.

4. Select OK.

Undelete scans the disk for files protected by the method or methods you selected. If you selected more than one method, Undelete scans the Delete Sentry directory first, then the Delete Tracker file, then the entire disk.

The Scan for Lost Deleted Files window shows the file or cluster number being scanned and the number of scan items found. A progress bar shows you how much of the disk has been scanned.

When the disk scan is complete, the list of files found appears in the Find Deleted Files window, with Lost File as its condition. Lost files retain their original names and other information, so you can easily select and undelete the files you are looking for.

**Scanning Free Clusters for Deleted Data**

You can scan the disk's free clusters—disk space no longer associated with any existing file or directory—for a specified type of data or a text string.

**Note:** When Undelete scans the diskette's free clusters, it does not look at files protected by Delete Sentry or DelWatch.

**To scan free clusters for deleted data:**

1. Go to the directory where you want clusters containing the specified type of data to be recovered. Undelete recovers clusters to the current directory.

2. Select one of the cluster scans from the Disk menu:

   If you select Scan for Data Types, select the type of data to scan for (Lotus 1-2-3 and Symphony**, dBASE**, or normal text).

   Or, if you select Scan for Contents, specify a word, phrase, or text string to scan for. It does not matter whether you use uppercase or lowercase letters.

3. Select OK.

**Symphony** is a trademark of Lotus Development Corporation.

**dBASE** is a trademark of Borland International, Inc.
The window shows the cluster number being scanned and the number of scan items found. A progress bar shows you how much of the disk has been scanned.

When Undelete finds a contiguous group of free clusters that match the data type, it counts the group as a file and gives it a unique name. Undelete tries to match lost data with directory entries, making its best guess at the file's name. When the disk scan is complete, the list of clusters found appears in the Find Deleted Files window.

Two additional Disk menu commands act on disk scanning:

- **Set Scan Range:** Lets you limit the scans to a range of clusters, rather than scanning the entire disk for clusters that cannot possibly contain the data you are looking for. For example, if your hard disk has never been more than half full, you can limit the upper end of the cluster range to half the total number of clusters shown in the Cluster Range window. The scan range remains in effect for all disk scans until you change it, leave the program, or change drives.

- **Continue Scan:** Lets you continue a scan you interrupted by selecting **Cancel**. You can interrupt a scan at any time to look at the list of files found to that point.

### Showing Existing Files

You can add existing files to the list of deleted files to rename or add deleted clusters to them. This option is available only when you are in the Undelete directory tree and file list.

When you select **Show Existing Files** from the Options menu, all existing files are added to each directory's list of deleted files. After existing files appear, you can select them.

To rename an existing file (to undelete a file whose name already exists), select it and select **Rename Existing File** from the File menu. For more information, see “Automatic Undelete Methods” on page 249.

To add deleted clusters to an existing file, select it and select **Advanced Undelete ▶ Append to Existing File** from the File menu. See “Advanced Undelete Methods” on page 261.

Selecting **Show Existing Files** turns the option on and off. To remove existing files from the list, select the option again.
Advanced Undelete Methods

If one of the automatic undelete methods will not work, Undelete tells you to use one of its advanced file recovery methods.

Manual Undelete: Lets you undelete the highlighted file by selecting the clusters you want in it. Use this method to undelete files listed in Poor condition, on DOS-deleted Destroyed files, or on files listed in Good and Excellent condition that contain some overwritten clusters. You can start with a list of available (free) clusters that Undelete associates with the highlighted file, then add, delete, and reorder free clusters until the file contains the data you want.

To manually undelete a file:

1. From the Undelete directory tree and file list or the Find Deleted Files window, select a file to undelete manually.

2. Select Advanced Undelete ➔ Manual Undelete from the File menu.

3. If the file you selected is a DOS-deleted file whose first character has been replaced by a question mark, enter a new first character when requested.

4. In the Manual Undelete window, you can add, view, move, and delete free clusters from a list that you create. See “The Advanced Undelete Window” on page 262.
Create a File: Lets you construct a new file when Undelete cannot find the file, but you are reasonably sure that it is still on the disk—which can happen, for example, if the file’s directory has been overwritten. You enter a new file name and build the file by selecting available (free) clusters.

To create a new file from deleted clusters:
1. Select Advanced Undelete ➤ Create a File from the File menu.
2. In the Create a File window, type a name for the new file and select OK.
3. In the Create a File window, you can add, view, move, and delete free clusters from a list that you create. See “The Advanced Undelete Window.”

Append to Existing File: Lets you add available (free) clusters to an existing file. For example, if you realize that some data is missing after you undelete a file manually or create a file from available clusters, use this method to add the additional clusters. After you have appended available clusters to an existing file’s clusters, you can reorder all the clusters and delete any you do not want.

Note: When you add a free cluster to a file, it might prevent you from undeleting other deleted files, so do this only after you have undeleted any other files you want to recover and that can be automatically undeleted.

To add deleted clusters to an existing file:
1. If you are not already in the Undelete directory tree and file list, select Tree & File List from the File menu.
2. Select Show Existing Files from the Options menu.
   All existing files are added to the list of deleted files and appear in the directory tree and file list. The condition column identifies them as Existing.
3. Select the existing file you want to add clusters to.
4. Select Advanced Undelete ➤ Append to Existing File from the File menu.
5. In the Append to a File window, you can add, view, move, and delete free clusters to the list of clusters occupied by the selected file.

The Advanced Undelete Window
In the Advanced Undelete window, you determine which clusters to include in the file and in what order. By viewing clusters before you add them and by viewing the assembled file, you can tell whether the clusters you are adding contain data you want.
The window title differs, depending on whether you chose Manual Undelete, Create a File, or Append to a File.

### File Information

**File:** INVOICE.RCC  
**Size:** 2880 bytes  
**Date:** 4/26/08  
**Time:** 18:37am  
**Next Available Cluster:** # 91

### List of Added Clusters

**Starting cluster:** 91  
**Clusters needed:** 3  
**Clusters added:** 8

---

**File Information:** Includes the name and size of the file you selected to undelete, along with the date and time it was last modified.

**List of Added Clusters:** Lets you assemble a list of clusters you want to include in the undeleted file. You can add all free clusters on the current drive to this list. 

*Free clusters* are those not currently associated with any file or directory. After you add clusters to this list, you can view the assembled file to see if it contains the correct data, organized the way you want it.

<table>
<thead>
<tr>
<th>Item</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Available Cluster</td>
<td>The next free cluster on the disk that you can add to the undeleted file.</td>
</tr>
<tr>
<td>Starting cluster</td>
<td>The disk location of the file's original first cluster.</td>
</tr>
<tr>
<td>Clusters needed</td>
<td>The number of clusters the original file contained.</td>
</tr>
<tr>
<td>Clusters added</td>
<td>The total number of clusters you added. Added clusters are listed in the scrollable panel on the right-hand side of the List of Added Clusters. These clusters are not actually assigned to the file until you select Update.</td>
</tr>
</tbody>
</table>
Undeleting Clusters

Use these buttons on the Advanced Undelete window to assemble the file you want to undelete:

<table>
<thead>
<tr>
<th>Button</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Cluster</td>
<td>Lets you add all or specified free clusters, view the next available cluster, or scan free clusters for specified data. See the following procedure. Each cluster you add is listed in the scrollable List of Added Clusters panel.</td>
</tr>
<tr>
<td>Skip Cluster</td>
<td>Skips to the next available free cluster.</td>
</tr>
<tr>
<td>View File</td>
<td>Lets you examine all the clusters you have already added. If the first cluster is a recognizable file type, the clusters appear in native format; otherwise, they appear in text or binary format.</td>
</tr>
<tr>
<td>Update</td>
<td>Undeletes the file. The File Allocation Table is updated so that the clusters you added (shown in the List of Added Clusters panel) are associated with the undeleted file name.</td>
</tr>
</tbody>
</table>
To undelete clusters:

1. Select Add Cluster.

2. Select a cluster option:

   **Add All Clusters:** Available in Manual Undelete only; adds to the list the same number of free clusters originally assigned to the file. For example, if the selected file consisted of eight clusters, then the file’s starting cluster and the next seven available cluster numbers will be added to the list. If the deleted file was fragmented, these might or might not contain the data that originally belonged to the file. You can view each cluster to find out.

   **Add This Cluster:** Adds the next available cluster (shown at the top of the Cluster Options window) to the list.

   **View This Cluster:** Displays the contents of the next available cluster so you can decide whether to add it. When in the Cluster Viewer, you can view each next available free cluster without leaving the viewer window.

   **Scan for Contents:** Lets you scan the disk’s free clusters for a text string you enter in the window. The first cluster that matches your string appears in the Cluster Viewer. You can either add this cluster or display the next one containing the text string.

   **Enter Cluster #:** Lets you specify a cluster number to add to the list. This can be useful as a starting point if you know approximately where the file is on the disk.

3. After cluster numbers are displayed in the List of Added Clusters, you can modify the list.

4. Select an option:

   **Move:** Lets you use UP ARROW, DOWN ARROW, HOME, END, PAGE UP, and PAGE DOWN to move the highlighted cluster to a new place in the list.

   **Delete:** Removes the highlighted cluster from the list.

5. When the list includes the clusters you want in the file, in proper order, select OK.
Purging Deleted Files

You can specify how many days to save deleted files and a maximum percentage of disk space to allow for Delete Sentry's hidden directory by editing the DATAMON.INI file. Delete Sentry files are purged automatically when these limits are reached or when DOS needs the disk space they occupy. When Delete Sentry purges files, it removes the oldest deleted files first. See “Central Point Data Monitor” on page 270 for more information about Delete Sentry and how to configure it.

You can also use Undelete to purge all or selected deleted files that are protected by Delete Sentry, Delete Tracker, NetWare, and DelWatch. This does not change the free space actually available on your disk, because these methods allow DOS to use its disk space when needed. However, purging files does create more room for protected files, especially when disk space is at a premium.

If one of these methods is not currently protecting files on the current drive, the Purge Deleted Files command will be dimmed in the File menu and you cannot select it.

Warning: After you purge files, other files can overwrite their data, and you might not be able to recover them.

To purge all deleted files:
1. Select Purge Deleted Files from the File menu.
2. In the submenu that appears, choose which type of protected files to purge.
3. In the Purge File window, select Purge All.

   Undelete removes all files on the current drive protected by the selected method.

Note: Purging NetWare files on a large file server can be slow.
To purge selected deleted files:

1. From the Undelete directory tree and file list, select the files you want to purge.
   
   You can purge all files except those protected by DOS.
   
2. Select Purge Deleted File from the File menu.
   
3. In the submenu that appears, choose the type of protected files to purge.
   
4. In the Purge File window, select Purge.
   
   If any of the files you select cannot be purged or do not match the protection type you selected, that file selection will be ignored.

How the Delete Protection Method Affects File Recovery

Undelete can recover files by using information saved by Delete Tracker, Delete Sentry, Mirror, Novell NetWare’s method of delete protection, and DR DOS’s DelWatch. If none of these were used, Undelete uses information available through DOS. The way a file was protected when it was deleted determines how successfully you will be able to undelete it. Delete Sentry is the most reliable. To configure delete protection, use Data Monitor. See “Central Point Data Monitor” on page 270.

Undeleting Files without Delete Protection

When you delete a file without delete protection installed, DOS leaves the data on the disk; but in the File Allocation Table (FAT), it marks all the clusters used by the file as available. DOS replaces the first character of the deleted file’s name with a special character that tells DOS not to include the deleted file in the directory listing. This means that you can no longer find that file using DOS.

The file’s data remains on the disk and can be undeleted until DOS overwrites it. Because the deleted file’s clusters are no longer allocated in the FAT, DOS can use those now-free clusters for expanding or creating a file. Fortunately, a deleted file’s clusters are likely to remain intact for a while, because DOS usually looks beyond the last-saved data cluster for the next available disk space before it uses deleted-file clusters.

DOS keeps a record of a deleted file’s name (with its first character replaced by the special character), its starting cluster, and how many clusters belonged to the file. This information alone might not be enough to undelete the correct data, because the clusters belonging to a file can be scattered about the disk.
Here is a guide to interpreting the status of a file that was deleted without delete protection based on the condition assigned to it by Undelete:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Status of a file</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Excellent:</strong></td>
<td>There are enough contiguous (sequential) free clusters following the starting cluster to rebuild the file. If the original file was unfragmented, this group of contiguous clusters contains its data and you can Undelete it automatically. If the file was fragmented, use Manual Undelete to look for its data elsewhere on the disk. More information follows this list.</td>
</tr>
<tr>
<td><strong>Good:</strong></td>
<td>If the file's starting cluster is available but there are not enough contiguous free clusters following the starting cluster to rebuild a multiple-cluster file, Undelete assumes that one or more of the file's clusters are in use by other files and reduces its condition to Good. You can use View File to see what would be undeleted automatically. If data is missing, look for it elsewhere on the disk with Manual Undelete.</td>
</tr>
<tr>
<td><strong>Poor:</strong></td>
<td>The file's starting cluster is in use by another file. Use Undelete to, which copies to another drive all the clusters that Undelete assumes belonged to the original file, whether they are in use or not. Then, you can examine the file to see if any of its original data was recovered. If more than the beginning of the file is missing, use one of the Advanced Undelete methods to look for the file's data elsewhere on the disk.</td>
</tr>
<tr>
<td><strong>Destroyed:</strong></td>
<td>The file's first cluster and enough contiguous clusters to rebuild it are in use by other files. However, because DOS does not keep track of all the clusters of deleted files, some of the data might still be on the disk if the file was fragmented. The missing data can be found by using one of the Advanced Undelete methods or by scanning the disk for deleted data.</td>
</tr>
</tbody>
</table>

If you do not know whether the original file was fragmented, you might want to use View File or Undelete to to examine the file to see if it contains the data you expected. If not, use Manual Undelete and look for the file's original clusters. If the file was fragmented, you might be able to find the missing data elsewhere on the disk.

It is possible that some of the data in the available clusters of a DOS-protected file can be overwritten, even if the file's condition is Excellent or Good. See "When Data Might Be Overwritten" on page 270.
Undeleting Files Protected by Delete Tracker

The Delete Tracker method of delete protection creates a hidden file named PCTRACKR.DEL in the root directory of the protected drive. It intercepts the DOS DEL command. In the PCTRACKR.DEL hidden file, Delete Tracker stores the name of the deleted file and the location of all the clusters it occupied. DOS then completes the delete operation and changes the FAT to indicate that the file is deleted and its clusters are available.

If Delete Tracker was active when the file was deleted, Undelete will use information saved in the hidden file to find and evaluate all the deleted file's clusters.

Here is a guide to interpreting the status of a deleted file protected by Delete Tracker based on the condition assigned to it by Undelete:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Status of a file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excellent:</td>
<td>All of the original clusters for this file are available. Recover it automatically with Undelete.</td>
</tr>
<tr>
<td>Good:</td>
<td>The file's starting cluster is available. However, one or more of its remaining original clusters is currently in use by another file.</td>
</tr>
<tr>
<td>Poor:</td>
<td>The file's starting cluster is currently in use by another file.</td>
</tr>
<tr>
<td>Destroyed:</td>
<td>All of the file's clusters are in use by other files. Most likely, Undelete cannot recover any of it.</td>
</tr>
</tbody>
</table>

For Good, Poor, and Destroyed files protected by Delete Tracker, you might want to use Undelete to, which copies to another drive all the clusters that belonged to the original file, whether those clusters are currently in use by another file or not. You can then examine the file to see how much of the original data was recovered.

Even if the file's condition is Excellent, Good, or Poor, some of the data in the available clusters of a file protected by Delete Tracker might be overwritten, as described next. Before recovering the file, you can use Manual Undelete to remove any overwritten clusters.
When Data Might Be Overwritten
Files protected by Delete Tracker or DOS that have a condition of Excellent, Good, or Poor might contain some overwritten data in their available clusters.

Undelete can determine only if a file’s clusters are currently in use by another file. It has no way of determining if that file’s data has been overwritten by another file that has also been deleted, which makes those clusters available once again. For example, many programs write to temporary files that are deleted when you exit from the program. These temporary files can overwrite the same clusters that were occupied by other deleted files. For this reason, undelete files protected by Delete Tracker or DOS as soon as possible after deleting them.

Undeleting Files Protected by Delete Sentry
The Delete Sentry method of delete protection creates a hidden directory named \SENTRY off the root directory of the protected drive. It intercepts the DOS DEL command and moves the deleted file to this directory without changing the record of the file’s location stored in the FAT—effectively changing the path to the file but not its physical location. As far as DOS is concerned, the file has been moved. The file’s clusters are still allocated in the FAT and are protected from being overwritten by DOS. Undelete can find the file in Delete Sentry’s hidden directory.

If Delete Sentry was active when the file was deleted, Undelete can recover the complete file in Perfect condition. However, Delete Sentry files are purged automatically when limits set in the DATAMON.INI file are reached or when DOS needs the disk space occupied by Delete Sentry files. In that case, or if you purge Delete Sentry files using Undelete, those files can be undeleted only through DOS information.

Central Point Data Monitor
Central Point’s Data Monitor (DATAMON) is a memory-resident program that includes several options to guard against data loss.

Warning: Do not use Data Monitor with versions of Central Point programs, such as Backup, earlier than Version 7. These versions are not compatible and can cause data loss. Use Version 7 or 8 programs instead.
Choosing a Delete Protection Method
Delete protection provides two different methods of security against accidentally deleting an important file. By selecting either of the following methods, you greatly improve your chances of being able to use the Undelete program to recover a deleted file:

- Delete Tracker
- Delete Sentry

Delete Tracker
You can turn on (+) or off (-) the Delete Tracker method of protection after Data Monitor is loaded. This method provides a somewhat lesser degree of protection than Delete Sentry. However, when you use Undelete soon after a file is deleted, you have a good chance of recovering it. This method is not available on network drives.

Delete Sentry
You can turn on (+) or off (-) the Delete Sentry method of protection after Data Monitor is loaded. If you turn off Delete Sentry, you will notice a decrease in the number of free bytes reported by DIR. The value for bytes available reported by the CHKDSK command does take into account the space occupied by the Delete Sentry files. You can use this method on network and local drives.

Before you can use Delete Sentry on a network volume, the network supervisor should use Data Monitor to configure Delete Sentry for that volume. The hidden \SENTRY directory is created automatically. The supervisor should then assign, to any users that require them, the following rights to the \SENTRY directory:

- NetWare 286: All rights except Parental
- NetWare 386: All rights except Access Control and Supervisory

Loading and Configuring Data Monitor
Data Monitor loads itself high automatically to conserve conventional memory if you have:

- A memory manager such as QEMM, 386MAX, or EMM386
- Memory available between 640K and 1MB

However, when you have RAMBoost loaded into memory, the RAMBoost program loads Data Monitor where optimally most efficient.
To load Data Monitor:

1. From the DOS command prompt, type:
   
   datamon /sentry+

   or

   datamon /tracker+

   Choose either method of protection for your data based on your needs. You can have only one method of protection running at one time; Delete Sentry and Delete Tracker are mutually exclusive.

2. Configure Data Monitor options anytime after you load one of the methods of protection. To see a list of the options available with Data Monitor, type the following at the DOS command prompt:

   help datamon

Because DATAMON is a memory-resident program, you can add this command to your AUTOEXEC.BAT file.

Loading Data Monitor for Network Drives
For a network drive, you must use Delete Sentry; you cannot use Delete Tracker for network drives. To use Delete Sentry on a Novell network drive, you must load Data Monitor into memory after the Novell network drivers.

If Data Monitor is already resident in memory, you can only turn on (+) an option from the command line if one of the following is true:

- Data Monitor is originally loaded with that option turned on, and it has been temporarily turned off.

- Data Monitor is the last program loaded into memory.

Loading Data Monitor into Low Memory
If you have a memory manager program installed and memory available between 640K and 1MB, Data Monitor normally loads itself high automatically unless a memory optimization program, such as RAMBoost, is running.

If you know you are running a memory optimizer, you can use the /low switch when you configure Data Monitor to specify that you do not want to load it into Upper Memory Blocks even if they are available.
Unloading Data Monitor

Using the minus sign (-) turns off either the Delete Sentry or Delete Tracker method of protection; however, to remove (unload) Data Monitor from memory, you must type:

    datamon /unload

Data Monitor configuration choices are saved in a file called DATAMON.INI in the C:\DOS\DATA subdirectory. If an option is turned off and on, your original configuration choices will still be in effect until you unload Data Monitor from memory.

If you remove the DATAMON command in your AUTOEXEC.BAT file, you must restart your computer before Data Monitor can be unloaded.
Chapter 16. Using Central Point Scheduler

If you have a program that does not require anyone to monitor its process, then Scheduler will let you schedule this program to run. This is especially useful for lengthy procedures that do not require your presence, like a backup session. For example, you might want to perform a backup to a tape drive every workday at 7:00pm. You can schedule any executable command accepted at the DOS command prompt.

When a scheduled event occurs, Scheduler interrupts whatever program is running and provides a 15-second warning before it runs the scheduled event in case you are in the middle of an application that you do not want interrupted. When the event is completed (for example, making a backup), Scheduler returns to the application you were running.

Scheduling a Program

The memory-resident portion of Scheduler (CPSCHED.EXE) must be loaded before you can start a program at a scheduled time.

To schedule a program:

1. From the DOS command prompt, type:
   
   cpsched

   and press ENTER. This loads CPSCHED.EXE as a terminate-and-stay-resident program. Or, you can add CPSCHED to your AUTOEXEC.BAT file so that this TSR is loaded whenever you start your computer.

   Note: Load this program after all other TSRs and before a task switcher or shell program starts.

2. After the TSR is loaded, type the following at the DOS command prompt:

   schedule cpbackup

   if you want to run the Central Point Backup program (CPBACKUP), for example.

3. Press ENTER.
You see the DOS Program Scheduler main window:

4. Select the day on the calendar you want to schedule a program to run and select Add. The Schedule or Edit an Event window is displayed.

   **Note:** You can just select Add and then make applicable changes in the Schedule or Edit an Event window.

5. If you want to change the date, then type the date, using the format mm/dd/yy in the Date field.

6. Type the time you want to schedule your program, using the format hh:mm (you can use either a or p and Scheduler will append an “m” for you) in the Time field.

   *Do not put a space between the time and the am or pm.*

7. If you want to customize a scheduled backup event, for example, select one of the setup files. Use the TAB key to move to the Setup Files field and then press ENTER.

   You see a list of setup files for the CPBackup program.

8. Use the DOWN ARROW if you are using a keyboard or click on a setup file.
9. Select a frequency:

   **Note:** The Windows Scheduler only supports running the CPBackup program; however, it does not support weekly, biweekly, or monthly scheduled backups.

   **One Time Only:** Schedules the event to occur one time.

   **Daily:** Schedules the event to occur every day.

   **Workdays Only:** Schedules the event on the days you identify as workdays. You select the days of the week you want treated as workdays.

   **Weekly:** Schedules the event on the same day every week.

   **Monthly-Fixed Day:** Schedules the event on the same date each month.

   **Monthly-Fixed Weekly:** Schedules the event on the same weekday each month.

   **Biweekly:** Schedules the event the same weekday every other week.

10. Type the program name in the Event field.

    For example, type ibmavd and any options (up to 64 characters). The file’s extension is not necessary, and you can use any DOS character.

    or

    Select Browse to navigate to the directory and file that you want to schedule.

   **Note:** If you are scheduling a backup event, this window shows an option for setup files specifically for the CPBackup program. See “Using Preconfigured Setup Files” on page 405 for descriptions of these setup-file options. You can also schedule automatic virus scanning when you use the CPBackup program to back up your files.

11. Select OK to save this information.

12. Continue in this manner until you have scheduled all the events you want.

13. Select Exit.

14. Make sure the Save Changes in Schedule option in the Close window is checked to save your scheduling information.

When you want the program to run, be sure the computer is on and CPSCHED is loaded by typing cpsched at the DOS command prompt. The scheduled event occurs at the specified time and returns the machine to the state it was in prior to the event.
Editing Existing Scheduled Events

On the Scheduler window, you can see what events are scheduled, because icons appear on each day there is a scheduled event. If you have scheduled events that you want to change (for example from daily at 5:00pm to daily at 7:00pm), you can change these scheduled events by editing them.

To edit a schedule event:

1. From the DOS command prompt, load the CPSCHED.EXE terminate-and-stay-resident program by typing:
   
cpsched
   
   and then press ENTER.
2. After the TSR is loaded, type:
   
schedule program
   
   where program is the program you want the Scheduler to run (such as cpbackup).
3. Press ENTER.
   
The Scheduler calendar appears with icons representing events scheduled for the day.
4. Select the event you want to change in the Scheduled events list.
5. Select Edit.
6. Make your changes in the Schedule or Edit an Event window. The following shows what this window would look like if you type schedule cpbackup at the DOS command prompt.

   ![Schedule or Edit an Event window]

   For details, see steps 5 through 10 in “Scheduling a Program” on page 275.
7. Select OK to save this information.
8. Select Exit.

9. Make sure the Save Changes in Schedule option in the Close window is checked to save your scheduling information.

Deleting Scheduled Events

If you decide you do not want a scheduled event to occur anymore, you can delete it.

1. From the DOS command prompt, type:

   cpsched

   and press ENTER.

2. Type:

   schedule

   and press ENTER.

   The Scheduler window appears with events scheduled.

3. Select the event you want to delete in the Scheduled Events list.

4. Select Delete.

   The event is removed from the list.

Keystrokes for Navigating the Calendar

Use the following keys to navigate the Calendar window.

<table>
<thead>
<tr>
<th>Use This Key</th>
<th>To Move To</th>
</tr>
</thead>
<tbody>
<tr>
<td>LEFT ARROW and RIGHT ARROW</td>
<td>Yesterday and tomorrow</td>
</tr>
<tr>
<td>UP ARROW and DOWN ARROW</td>
<td>Last week and next week</td>
</tr>
<tr>
<td>TAB</td>
<td>Scheduled Events list and calendar</td>
</tr>
<tr>
<td>PAGE UP and PAGE DOWN</td>
<td>Last month and next month</td>
</tr>
<tr>
<td>CTRL+LEFT ARROW and CTRL+RIGHT ARROW</td>
<td>Last year and next year</td>
</tr>
</tbody>
</table>
Scheduler Options
The Options button lets you define what days you want the Scheduler to recognize as workdays and also lets you change what to display in the Event List.

When you select Options, the following window appears:

1. Select the days you want defined as workdays.
   This specifies the days of the week that are treated as workdays and appear as options under Frequency.

2. Select how you want scheduled events to appear in the Events list.
   - **Daily**: Displays only those events scheduled on the selected date.
   - **Monthly**: Displays those events scheduled on any day in the current month.
   - **All**: Displays all scheduled events.

Removing Scheduler from Memory
To remove CPSCHED from memory, type the following from the DOS command prompt:

cpsched /u

You can enter additional command-line options from the DOS command prompt that have the same effect as scheduling events from each of the specified programs.

Type help schedule for more information about the SCHEDULE command.
Chapter 17. Troubleshooting

This chapter explains how to solve problems you might have after you install PC DOS. It also answers some common questions about DOS.

If you are having problems, be sure to view the text file README.TXT that came with PC DOS. You can find this file on the Setup Diskette of your PC DOS installation diskettes or in your DOS directory.

PC DOS Installation

Following are some of the common questions you might have during Setup.

How much hard disk space do I need to install this version of PC DOS?

The answer to this question depends on the type of system and the optional tools you choose to install as follows:

- PC DOS without Windows
  - PC DOS with Central Point Backup requires 6.0MB of uncompressed space.
  - PC DOS and all PC DOS optional tools (no Windows tools) requires 14.5MB of uncompressed space.
- PC DOS with Windows (Version 3.1 or higher)
  - Windows requires 10MB of uncompressed space.
  - PC DOS and Windows optional tools requires 10MB of uncompressed space.
  - PC DOS plus all PC DOS and Windows optional tools requires 18.5MB of uncompressed space.

What if the Setup program does not run?

Setup cannot successfully install PC DOS for one or more of the following reasons:

- There is insufficient space on your hard disk.
- Your primary DOS partition is too small or incompatible with Setup.
- You do not have a hard disk.
My primary DOS partition is too small or incompatible. What can I do?

You must repartition your hard disk before installing PC DOS if your hard disk has one of the following characteristics:

- You do not have enough space in your primary partition for the system files and not enough space for a minimal install on any logical drives.
- The size of the cluster or sector is incompatible. Try running SETUP /P.
- There are more than four primary partitions.
- The primary DOS partition is not active.
- A disk-partitioning program that is not compatible with the automatic Setup program has been used to partition your hard disk.

When you repartition your disk, you have the option of creating one large partition on your hard disk or multiple smaller partitions.

**Warning:** To change the size of a partition or reduce the number of partitions, you must delete the existing partitions and create new ones. Therefore, you must back up the files on every partition you plan to modify so that you do not lose the information in those files.

**To backup your files and repartition your hard disk:**

1. Backup your hard disk. (Refer to the documentation that came with your current version of DOS.)
2. Remove the partitions from your hard disk, using the same program you used to create the partitions.
   
   If you created the partition by using the FDISK program supplied with DOS Version 3.3, use the same command to remove the partitions.
3. Use FDISK to create a partition at least large enough for the PC DOS install.
4. Use the FORMAT command to format any other partitions you created.
5. Restore your files to the primary DOS partition. (Refer to the documentation that came with your current version of DOS.)
6. To complete the installation, follow the instructions found in “PC DOS Standard Installation” on page 14.
What should I do if my computer does not restart?

If this happens and if the problem might be related to the settings in your CONFIG.SYS or AUTOEXEC.BAT, you can temporarily bypass these files to restart your computer.

1. Start your computer.
2. Press F5 immediately after your computer displays the message
   Starting PC DOS...

Notes:

1. Any device that requires an installable device driver does not work because the installable device drivers are not loaded. For example, programs that require expanded or extended memory are not able to run because no expanded- or extended-memory drivers are loaded.
2. PC DOS uses the default environment variables of PATH=C:\DOS,
   PROMPT=$P$G, and COMSPEC=C:\COMMAND.COM temporarily until you correct the problem and restart your computer.

You can bypass selected CONFIG.SYS commands by having PC DOS prompt you for each command in the CONFIG.SYS file.

To confirm each CONFIG.SYS command:

1. Start your computer. Just after your computer starts, DOS displays the text
   Starting PC DOS...
2. Immediately press and release the F8 key.
   One at a time, PC DOS displays each command in your CONFIG.SYS file followed by a prompt. For example, when PC DOS reaches the DOS=HIGH, UMB statement, it displays the following prompt:
   
   DOS=HIGH, UMB [Y,N,ESC]?

   Respond by typing either Y for YES or N for NO, for each command in your CONFIG.SYS file, press ESC to cancel the CONFIG.SYS file processing.

   When PC DOS finishes processing the CONFIG.SYS file, it displays the following prompt:
   
   Process AUTOEXEC.BAT [Y,N]?

3. Answer Y for Yes or N for No to confirm each statement in your AUTOEXEC.BAT file.
What is the maximum length of the PATH variable?

The PATH variable, like other environment variables, is limited to 127 characters. Use the PATH command to set your path variable to one or more directories. Whenever you type a command, PC DOS searches the directories in your path for the command or program you are trying to run. The following is an example of the PATH command:

```
path=c:\;c:\dos;c:\windows;d:\batfiles;d:\util
```

The name of the variable (PATH) and the equal sign take up 5 of the 127 characters. This means you can use 122 characters to specify directory names. To use those 122 characters most efficiently:

- Remove any spaces from the PATH command.
- Remove seldom-used directories from the PATH command.
- Use short directory names.
- Use batch programs to set and reset the path according to your current needs.
- Use the SUBST command to substitute a drive letter for a long directory path, if necessary.

You can then use that drive letter instead of the full path in the PATH command. You can use the SUBST command in your AUTOEXEC.BAT file. If you do, it must precede the PATH command.

For example, to shorten a path named C:\USER\LINDA\FORMS to Q:, you would include the following command (before the PATH command) in your AUTOEXEC.BAT file.

```
subst q: c:\user\linda\forms
```

For more information about the PATH and SUBST commands, refer to the online PC DOS 7 Command Reference, or type help followed by the command name.

Which device drivers should I use?

PC DOS includes several device drivers that you load by using the DEVICE command in your CONFIG.SYS file. Other products might also include some of these device drivers. The following device drivers are examples of a few general-purpose device drivers supplied with PC DOS:

- HIMEM
- RAMDrive
- SMARTDRV
- EMM386
Windows and PC DOS contain several programs that have the same name. However, the PC DOS programs have been updated after the release of Windows 3.1. If you install Windows after installing PC DOS, check your CONFIG.SYS and AUTOEXEC.BAT files to make sure that you are using the programs HIMEM.SYS, EMM386.EXE, and SMARTDRV.EXE from the DOS directory and not from the Windows directory.

If you already have SMARTDRV.SYS installed on your system, Setup comments out (REMs) the statement in your CONFIG.SYS file. To use SMARTDRV.EXE, however, you need to add the SMARTDRV command-line statement to your AUTOEXEC.BAT file.

For more information about these and other device drivers, refer to the device drivers information in the online PC DOS 7 Command Reference.

If these device drivers are in your CONFIG.SYS file before you install PC DOS, Setup modifies the file so that you are using the versions supplied with PC DOS.

**How do I determine what stack size to use in my CONFIG.SYS?**

You might need to experiment with the proper stack size for your system to avoid a stack size overflow. Refer to the STACKS command information in the online PC DOS 7 Command Reference for special cases.

**I have installed PC DOS and want to expand drive C: to be larger than 32MB. What steps do I need to take?**

This can be accomplished by backing up your system to diskettes, formatting the hard disk, repartitioning it, and then reformatting it. Then, you can reinstall PC DOS along with the other files. The following list outlines the steps to take:

1. Back up your entire system using Central Point Backup (CPBACKUP). To start CPBACKUP, type:
   ```
   cpbackup
   ```
   at the DOS command prompt, and back up all the files on all your drives.
2. Insert the Setup Diskette into your diskette drive.
3. Start up from the diskette by pressing CTRL+ALT+DEL.
4. Press F5 immediately after your computer displays the message Starting PC DOS...
5. Run FDISK, delete all partitions and remake the desired number of partitions.
6. FORMAT C: and any other hard disk partitions.
7. Install PC DOS again.

8. Restore all files using the CPBackup program.

**I have installed PC DOS and PC Tools** for Windows will not start from Windows. What steps do I need to take:

1. Edit the C:\WINDOWS\WIN.INI file. Under the section (Extensions) – (IBM DOS6 Setup Modification), change the file name in the following line:
   
   ```
   set=c:\dos\winbackup.exe
   ```

   to

   ```
   set=c:\dos\wnbackup.exe
   ```

2. Edit the C:\WINDOWS\SYSTEM.INI file. Under the section (386ENH) - (IBM DOS 6 Setup Modification), change the directory name in the following line:

   ```
   device=c:\dos\system\cpbvxd.386
   ```

   to

   ```
   device=c:\cps\system\cpbvxd.386
   ```


**What can I do to upgrade my system if I have the incorrect version of INTERLNK running?**

1. If you have INTERLNK.EXE dated 11/11/92 from MS-DOS, insert the Setup Diskette into your diskette drive, (for example, drive A).

2. At the DOS command prompt, type:

   ```
   a:setup
   ```

3. When Setup finishes, answer YES when prompted if you want to edit the AUTOEXEC.BAT and CONFIG.SYS changes.

4. Press CTRL+N (or F12 if available on your keyboard) until you are viewing the CONFIG.SYS file.

5. Edit the CONFIG.SYS file and add rem to comment out the INTERLNK.EXE driver:

   ```
   rem device=c:\dos\interlnk.exe
   ```

6. After editing the CONFIG.SYS file, press F4 to save the changes and close this file.

---

** PC Tools is a trademark of Central Point Software, Inc.

286 PC DOS User's Guide
7. Press F4 until you have closed the file and exited the E Editor.

8. At the screen that notifies you the installation is complete, remove all diskettes from drive A, and then restart your computer by pressing ENTER.

9. After rebooting, remove the REM from the command-line statements, and reboot again to load INTERLNK again.

What if I get a message I do not understand while installing?

If you receive one of the following messages when running SETUP, see the explanation that follows each message.

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Your current operating system on drive C is not recognized as being DOS Version 3.3 (or higher).&quot;</td>
<td>You might have purchased the wrong version of DOS. The upgrade version requires a previous version of DOS to be installed before you can install this version.</td>
</tr>
<tr>
<td>One or more of the following incompatible TSR programs has been detected. Stop the program, or remove it from your CONFIG.SYS and AUTOEXEC.BAT files and run SETUP again.</td>
<td>Run SETUP by booting off diskette or stop the conflicting TSR by editing them out of your CONFIG.SYS and AUTOEXEC.BAT files.</td>
</tr>
<tr>
<td>• FASTOPEN 4.0 • DESQVIEW • TASK SWAPPER • WINDOWS</td>
<td></td>
</tr>
</tbody>
</table>

Memory Problems

How can I get DOS to run in the high memory area?

If your computer has extended memory, the Setup program will configure your system so that DOS runs in the high memory area (HMA), which is the first 64K of extended memory. This conserves conventional memory for use by other programs.
You can confirm that DOS is running in the HMA by using the MEM command. If DOS is in the HMA, you see the following on the last line of the message:

PC DOS is resident in the high memory area.

If your computer has extended memory and DOS is not running in the HMA, the problem is either that your CONFIG.SYS file does not contain the correct command, or your extended-memory manager is not correctly installed. HIMEM is the extended-memory manager provided with DOS. HIMEM (or another extended-memory manager) is required in order for DOS to use the HMA.

To run DOS in the HMA:

- The CONFIG.SYS file must contain the statement DOS=HIGH,UMB or DOS=HIGH.
- The CONFIG.SYS file must contain a DEVICE command for the HIMEM memory manager (or another extended-memory manager), as in the following example:
  
  device=c:\dos\himem.sys

- The DEVICE command for HIMEM must appear before the DEVICE commands for other memory managers.
- The HIMEM.SYS file must be in the path specified by the DEVICE command in your CONFIG.SYS file.
- HIMEM must be properly installed on your computer. The computer must have at least 1MB of memory and be a 286 computer or above.

  Normally, the Setup program installs HIMEM and makes any necessary adjustments.

If DOS does not run in the HMA, even though your CONFIG.SYS file contains the correct commands and HIMEM is properly installed, the memory configuration of your computer might not permit use of the HMA.

Note: Windows and PC DOS contain several programs that have the same name. However, the PC DOS programs have been updated after the release of Windows 3.1. If you install Windows after installing DOS, check your CONFIG.SYS and AUTOEXEC.BAT files to make sure that you are using the programs HIMEM.SYS, EMM386.EXE, and SMARTDRV.EXE from the DOS directory and not from the Windows directory.
What can I do when I receive a packed file corrupt message?

DOS displays the message **packed file corrupt** when a program cannot be successfully loaded into the first 64K of conventional memory. This is most likely to occur when you load device drivers into reserved memory, thereby freeing more low conventional memory.

DOS provides the LOADFIX command. It ensures that a program is loaded above the first 64K of conventional memory. To use the LOADFIX command, include it at the beginning of the command that starts the program. The syntax of this command is:

```
loadfix drive: \path\filename
```

For example, to ensure that a program file named MYAPP.EXE (in the C:\APPS directory) is loaded above 64K, you would type:

```
loadfix c:\apps\myapp.exe
```

What can I do when a program does not use XMS extended memory?

Most programs that use extended memory conform to the Lotus*/Intel*/Microsoft/AST* (LIM) eXtended Memory Specification (XMS). To use such programs with DOS, you need an extended-memory manager, such as HIMEM.

Some programs do not conform to the XMS. Such programs cannot use extended memory if this memory is managed according to the XMS.

If you are using HIMEM, you can allocate a portion of your extended memory to programs that use extended memory but do not conform to the XMS. This is done by including the */int15* switch with the DEVICE command for HIMEM.SYS. The value you specify for the */int15* switch should be the memory you want set aside, plus 64K. For example, to reserve 512K of non-XMS extended memory, you would include the following command in your CONFIG.SYS file:

```
device=c:\dos\himem.sys /int15=576
```

Some of the programs that do not conform to the XMS cannot run when DOS is in the high memory area. If you encounter problems with such a program, load DOS into conventional memory.

---

** Lotus is a trademark of the Lotus Corporation.
** Intel is a trademark of the Intel Corporation.
** AST is a trademark of AST Research Incorporated.
What memory managers can I use with DOS?

Most memory managers work with DOS. In general, you cannot simultaneously use two memory managers that provide access to the same memory. Similarly, you cannot use EMM386 to simulate expanded memory if you already have an expanded-memory manager installed.

How can I increase the environment size of my system?

The *environment* is an area of memory in which DOS stores variables such as PATH, COMSPEC, and PROMPT. These variables are called *environment variables*. The default environment size is 256 bytes. You can allocate more environment space by specifying the /e switch with the SHELL command.

For example, if you added the following command to your CONFIG.SYS file, you would allocate 1024 bytes of environment space:

```
shell=c:\command.com /p /e:1024
```

If you are using more than one environment and you do not specify the /e switch for each, the size of the environments might vary. For information about environments, type `help set` at the DOS command prompt.

How do I run device drivers and programs in the upper memory area?

If you have a system with an 80386-based or higher processor and extended memory, you can make more conventional memory available by running certain device drivers and programs in the upper memory area. DOS provides RAMBoost, a memory optimizer program, that rearranges the existing items in your CONFIG.SYS and AUTOEXEC.BAT files for you when you run the RAMBoost Setup program. RAMBoost Setup rearranges your configuration and restarts the computer to load programs into upper memory. For information about using the upper memory area, see Chapter 13, "Making More Memory Available" on page 205.
I'm getting an error message regarding the option ROM or RAM being detected within a page frame when I restart my computer. What does it mean?

If you see the message Option ROM or RAM detected within page frame, the EMM386.EXE memory manager is detecting a device in the address area where it is trying to locate a page frame. It has found another 64K contiguous space but is notifying you that its original try was not successful. No action need be taken if you do not mind the message.

Another option is to include the area where the conflict is occurring. For example, on an AT BUS, EMM386.EXE detects a video adapter at the location C000. By including I=C000-CFFF on the EMM386 command line, this eliminates the warning message. Refer to the EMM386.EXE device driver information in the online PC DOS 7 Command Reference for more information.

I have EMM386.EXE loaded in my CONFIG.SYS, but I still do not have access to my upper memory blocks. Why?

Besides using EMM386.EXE, you must have DOS=UMB or DOS=HIGH,UMB in the CONFIG.SYS.

I'm getting an error message at the EMM386.EXE setup line in my CONFIG.SYS file. When the system is finished starting up, I do not have access to the upper memory. What can I do?

If you see the message Unable to set page frame base address, the memory manager, EMM386.EXE, is trying to locate a 64K EMS page address, but it is already occupied by another device, such as an Ethernet** or IBM Token Ring. With IBM PS/2* systems, you can use the Reference Diskette to change the address of these devices. Generally speaking, they are easiest to move out of the way if they are placed at the very beginning or the very end of the allowed address ranges.

** Note:** Windows and PC DOS contain several programs that have the same name. However, the PC DOS programs have been updated after the release of Windows 3.1. If you install Windows after installing DOS, check your CONFIG.SYS and AUTOEXEC.BAT files to make sure that you are using the programs HIMEM.SYS, EMM386.EXE, and SMARTDRV.EXE from the DOS directory and not from the Windows directory.

---

* Ethernet is a trademark of Western Digital Corporation.
* PS/2 and IBM Token Ring are trademarks of IBM Corporation.
DOS Command Problems

I accidentally deleted a DOS file. Can I get it back?

If you inadvertently delete a DOS file that you need, there are two ways to get the file back:

- Restore the file by using the UNDELETE command.

  The UNDELETE command can restore a deleted file. It is effective only if you have not changed any of the information on your hard disk or diskette after deleting that file. If you move or change any files or directories, you might not be able to restore the deleted file. For information about the UNDELETE command, type help undelete at the DOS command prompt.

- Rerun SETUP using the /e switch.

During installation, Setup copies all the DOS files and all the files for the optional tools you selected to your hard drive. By rerunning SETUP using the /e switch, the file that was deleted will be restored.

However, to save some time, you first need to determine whether the file that was deleted is either:

- An optional tool file.
- A DOS file pertaining to the operating system.

By determining whether a DOS file or an optional tool file, you save time because only the specified group of files are copies. Refer to “Recovering Files from the Setup Diskettes” on page 546 for the complete procedure.

How can I get the UNDELETE command to work?

In general, the UNDELETE command works best under the following circumstances:

- If you use the UNDELETE command immediately after you delete a file.
- If you deleted only one file.
- If you use the DATAMON command, a memory-resident program that keeps track of certain changes you make to your hard disk or diskette. For more information about the DATAMON command, refer to “Central Point Data Monitor” on page 270.

Warning: Never run a storage-compaction program (defragmentation utility program) after deleting files you want to restore. The UNDELETE command cannot restore files that were deleted before you ran the storage-compaction program.
Why can’t I get the RESTORE command to work?

There are several reasons the RESTORE command might not be able to restore files that were backed up by using the BACKUP command.

• You are trying to restore files to a different directory.

The RESTORE command restores files only to the directory from which those files were backed up. For example, you cannot restore files backed up from C:\WORD to a directory named C:\OLDWORD. (However, you can change the drive letter. For example, you could restore files backed up from C:\WORD to the directory D:\WORD.)

• You are trying to restore a file to a different file name.

The RESTORE command does not change the name of a file. For example, if you back up a file named REPORT.TXT, you cannot restore it to a file named MYREPORT.TXT.

• The RESTORE command is not compatible with the BACKUP command you used to back up the files.

Only if you backed up the files by using the DOS BACKUP command from versions of DOS prior to Version 6.1 can you use the RESTORE command to restore them.

The RESTORE command supplied with this version of PC DOS cannot restore files that you backed up by using the CPBACKUP command from DOS Version 6.1 or later.

With PC DOS 7, use the Central Point Backup optional tool to back up files or directories for safekeeping. This tool also compares and restores files. Restore can restore an entire hard disk or specifically selected files and directories.

For more information about the Central Point Backup program and restoring files backed up by this program, see Chapter 20, “Using Central Point Backup” on page 383.

I just got the error message Out of Memory right in the middle of running DEFRAG. How can I make DEFRAG finish running?

To ensure this problem does not occur again, disable all TSRs before running DEFRAG. This will free up conventional memory.

Follow the prompt to reboot your computer. Then, run DEFRAG again to run the DEFRAG routine. The problem that caused this message was that DEFRAG used up all of the conventional memory available.
What should I do when the program or device driver reports the wrong version of DOS?

Some programs or device drivers run only with specific versions of DOS. If a message appears indicating a program or device driver does not run with DOS, contact your vendor to get an updated program or to find out whether the current version of the program or device driver is actually compatible with DOS.

If the current version of the program or device driver is compatible with DOS, use the SETVER command to change the version number that DOS reports to the program or device driver. When you use SETVER, the program or device driver interprets DOS as the version it is designed to use. For example, if a program named MYAPP.EXE runs only with DOS 3.3 or earlier, you would type:

```
setver myapp.exe 3.3
```

This entry updates the Setver table with your program name. DOS will then report the changed version number to the program if there is a DEVICE command for the SETVER.EXE device driver in your CONFIG.SYS file. If the program is compatible with DOS, the SETVER command eliminates the apparent incompatibility.

**Note:** Make sure there is only one SETVER.EXE on your hard disk, because each SETVER.EXE contains a separate version table.

Type `help setver` for more information about the SETVER command.

**Warning:** Contact your software vendor for information about whether a program works with PC DOS 7. It is possible that IBM has not verified whether the program will run successfully if you use the SETVER command to change the program version number and version table. If you run the program after changing the version table in DOS, you might lose or corrupt data, or introduce system instabilities. If you do not contact your software vendor to determine the compatibility of a specific program with DOS, IBM is not responsible for any loss or damage.
PC DOS Shell

I changed the display type on my computer and now it doesn't work correctly with the DOSSHELL command. What can I do?

The easiest way to undo the modifications you have made is to reinstall PC DOS Shell as an optional tool using the SETUP command with the /e switch to return PC DOS Shell to the original default settings. Using this switch allows you to install (or reinstall) the selections you make at the optional tools menu. You must reinstall PC DOS Shell to the same path where you initially installed DOS.

Or, if you change the type of display you use, you can manually install files so that the display can work correctly with the PC DOS Shell. For example, if you were using an EGA display and change to a VGA* display, you do not gain the benefits of the VGA display when running PC DOS Shell until you manually install the VGA files.

PC DOS Shell supports seven types of displays. The files for each are located in your DOS directory after installing PC DOS 7.

The following table shows the files needed for each of the supported displays.

<table>
<thead>
<tr>
<th>Display</th>
<th>Required files</th>
</tr>
</thead>
<tbody>
<tr>
<td>MONO</td>
<td>(No .VID file necessary), MONO.INI, MONO.GRB</td>
</tr>
<tr>
<td>CGA*</td>
<td>CGA.VID, CGA.INI, CGA.GRB</td>
</tr>
<tr>
<td>EGA*</td>
<td>EGA.VID, EGA.INI, EGA.GRB</td>
</tr>
<tr>
<td>EGA MONO</td>
<td>EGA.VID, EGA.INI, EGAMONO.GRB</td>
</tr>
<tr>
<td>COLOR (VGA, Super VGA,</td>
<td>VGA.VID, VGA.INI, VGA.GRB</td>
</tr>
<tr>
<td>XGA*, 8514, and other</td>
<td></td>
</tr>
<tr>
<td>high-resolution displays)</td>
<td></td>
</tr>
<tr>
<td>MONO (VGA, Super VGA,</td>
<td>VGA.VID, VGA.INI, VGAMONO.GRB</td>
</tr>
<tr>
<td>XGA, 8514, and other</td>
<td></td>
</tr>
<tr>
<td>high-resolution displays)</td>
<td></td>
</tr>
<tr>
<td>Hercules</td>
<td>HERC.VID, MONO.INI, HERC.GRB</td>
</tr>
</tbody>
</table>

To install the DOS files for a different display, locate the files you need, copy the correct .VID and .GRB files, and then either create a DOSSHELL.INI file or modify your previous one.

* VGA, CGA, EGA, and XGA are trademarks of IBM Corporation.
To find and copy the .VID and .GRB files you need:

1. Use the preceding table to determine which files you must install.
2. Find the names of the files you need for your display.
3. Make sure you copy the destination files with the .VID and .GRB extensions, respectively.

For example, you would type the following to copy the VGA.VID file:

   copy c:\dos\vga.vid c:\dos\dosshell.vid

You would type the following to copy the VGA.GRB file:

   copy c:\dos\vga.grb c:\dos\dosshell.grb

At this point, determine whether to replace your current DOSSHELL.INI file. If you choose to replace this file, you can immediately use any additional colors your new display provides. However, you lose any modifications you previously made to PC DOS Shell, such as program groups and program items. If you do not want to lose these modifications, you must manually add the new color files to your existing DOSSHELL.INI file.

To create a DOSSHELL.INI file with updated colors:

Use the COPY command to replace your current DOSSHELL.INI file with the .INI file you need. Make sure you name the destination file DOSSHELL.INI.

For example, you would type the following to expand the VGA.INI file:

   copy c:\dos\vga.ini c:\dos\dosshell.ini

Can I start a TSR or my network connection from PC DOS Shell with task swapping enabled?

Because PC DOS Shell is not a multi-tasking environment, you should load networks and TSRs before activating PC DOS Shell.

I deleted a file from my system and I do not know how I did it. What happened?

If you are using PC DOS Shell, be very careful with the Select Across Directories option. When this option is enabled, if you select a file in one directory to delete (or change an attribute, or move), this file remains selected even if you change to a different directory. If you later chose to delete a file, ALL files that you have selected in every directory you have accessed are deleted.
If you did not realize that you have this option enabled, you might delete files accidentally. To disable Select Across Directories, from the Options menu, click next to Select Across Directories, or press ENTER. To verify that Select Across Directories is disabled, look at the options menu again. The diamond to the left of Select Across Directories is gone.

**AntiVirus**

Every effort has been made to ensure that AntiVirus is compatible with your system. The following is a description of problems that might be encountered and how you can deal with them.

New viruses continue to be written and released. A small fraction of them become widespread problems. To deal with these new viruses most effectively, any anti-virus software should be kept up to date. Select Contacts from the Help menu for more information on how to obtain updates to IBM AntiVirus/DOS.

**How will I know if I have a virus on my system?**

When AntiVirus is loaded, it performs a self-integrity test and warns you if something has changed one of the AntiVirus programs. If you get this warning, it indicates that a virus is active or that some accident has corrupted the program.

**What should I do if I get an Abnormal program termination error message?**

On DOS systems, if you get the message Abnormal program termination when first loading AntiVirus, this indicates that insufficient memory is available to run the program. Remove some of your resident programs and try again, add more memory to your system, or use the AntiVirus stand-alone program instead. This message can also occur if a virus has corrupted the AntiVirus program files.

**Not all my Windows files are being checked for viruses. What should I do?**

On systems using Windows 3.0 or later with SHARE installed, Windows locks some files and prevents them from being checked by the Windows portion of AntiVirus. If you want to check these files, exit from Windows and use the DOS portion of AntiVirus (IBMAVD).

On Windows systems, the Windows portion of AntiVirus (IBMAVW.EXE) is installed as a read-only file. This permits a self-integrity check under Windows even if the SHARE program is loaded. If you need to delete IBMAVW.EXE for some reason, you will need to make this file read-write before doing so. You can do this with the ATTRIB command.
On Windows systems, you can have only one copy of AntiVirus open at a time. If you try to open a second session of AntiVirus, the second session will not start; you can work only with AntiVirus in the session that is already open.

While the Windows portion of AntiVirus correctly detects infected boot sectors, it is not always able to disinfect them. If your system has infected boot sectors, exit Windows, and invoke the DOS portion of the product by going to the DOS command prompt and typing:

```
ibmavd
```

**Can AntiVirus scan for viruses in a diskette-image file?**

Viruses that infect boot sectors are detected by AntiVirus only in boot sectors, not in files. If you have a diskette-image file you want to check for viruses, create a diskette from the image and check the diskette. The only exceptions to this rule are the files BOOT.DOS and BOOT.OS2, which hold boot-sector images when you use the Dual Boot utility. If AntiVirus finds a virus that infects boot sectors in one of these files, it will warn you and offer to erase the file. Obtain a clean copy of the file from a similarly configured machine or from a service center before using the Dual Boot feature again.

**I'm having problems with Shield DOS. What can I do?**

Normally, Shield DOS tries to install itself into expanded memory if it is available on your DOS system. If this causes problems on your system, edit the file IBMAVDR.BAT in the \DOS directory, and remove the /x switch from both lines that call IBMAVSH (the DOS shield program). This tells Shield DOS not to install itself in expanded memory.

Normally, the DOS shield in AntiVirus checks high memory (memory above the 640K DOS limit) for resident viruses. This causes problems on some systems, especially where adapters are sensitive to having their memory space read. A common symptom of this problem is that the adapter (often a communications adapter) does not function properly when the DOS shield is installed.

**To fix problems with your hardware caused by the installation of Shield DOS:**

1. Uncheck the Check high memory check box on the Shield DOS window.
2. Select OK to save the settings.
3. Restart your system to let the new settings take effect.
Stacker Compression

A few general procedures can solve virtually any problem you might have with a Stacker drive. When you need help, scan the first part of this Stacker problem determination section to see the general troubleshooting tips and procedures, including how to:

- Run the DOS CHKDSK utility.
- Remove attributes from STACVOL files.
- Run other disk-repair utilities.

The rest of this section includes specific information in three categories. Most topics include reference to the tips and procedures for details.

- Troubleshooting during Stacker Setup
- Computer startup problems
- Other Stacker Problems

Stacker Tips and Procedures

How can I secure my compressed data and fix problems?

Stacker's AutoProtect feature runs every time you start your computer. It scans all Stacker drives on the system and quickly checks the status of each. AutoProtect can fix some problems immediately so you never even know they existed. Other problems may be more serious. If AutoProtect cannot repair a problem on a Stacker drive, Stacker write-protects the disk so your data will not be damaged and then reports to you. Stacker may suggest you run CHECK /F to correct the problem.

What can I do if my Stacker drive is corrupted?

Running the Stacker CHECK program is always a good first step. “Using the Stacker Tools (DOS and Windows)” on page 440 details how to use CHECK. If the Stacker drive is corrupted, the CHECK.COM file may be damaged. You can run CHECK from your Stacker startup diskette (if you created one) or from the uncompressed drive. CHECK is the only way to remove write protection from a Stacker drive.

What should I do first to solve system problems?

You can solve some system problems by running the DOS CHKDSK program. Running CHKDSK also runs CHECK on a Stacker compressed drive. You can use CHKDSK to make repairs. Back up damaged files, if you can, before running CHKDSK.
To run CHKDSK:

1. Change to the directory that contains DOS files, if necessary. It should be necessary only if this directory is not in your PATH statement.

2. At the DOS command prompt, type:

   `chkdsk drive:`

   where `drive:` is the drive to be checked. Run CHKDSK for both the Stacker drive and its uncompressed drive.

3. If CHKDSK reports:

   *Errors with lost allocation units only:*
   
a. At the DOS command prompt, type:

   `chkdsk drive: /f`

   b. Let CHKDSK fix any errors it finds.

   *Other errors:*
   
a. Use a complete disk-repair utility to fix them.

   b. Exit CHKDSK and run your other disk-repair utility.

   c. If you have no other disk-repair utility, try to back up any files reported as damaged.

   d. Run CHKDSK again and let it fix the errors. Stacker CHECK runs after DOS CHKDSK finishes.

4. If it offers to do a disk surface test, type `y` for YES.

How can I diagnose and repair my Stacker drives?

A Stacker drive is contained in a STACVOL file. You may have to remove hidden, system, and read-only attributes from it to correct errors or to run a surface scan.

To remove attributes from a STACVOL file:

1. At the DOS command prompt, identify the full STACVOL file name from a displayed message or by typing:

   `stacker`

2. Change to the host drive and type the following at the DOS command prompt:

   `attrib -r -s -h drive:stacvol.xxx`

   where `drive:` is the drive and `xxx` is the extension of the STACVOL file.
What do I have to do before using a disk-repair utilities program?

A multipurpose disk-repair utility can locate hard disk errors, repair many, and block out areas of the disk that are bad. If Stacker has write protected the drive, run CHECK /F to remove the write protection. You will have to run the disk-repair utility on the uncompressed drive that holds the Stacker drive. To do this, change the attributes of the STACVOL file that holds your Stacker drive.

Type stacker if you do not know the letter of the uncompressed drive and the full name of the STACVOL file.

To run a disk-repair utility:

1. Change to the uncompressed drive that contains the STACVOL file.
2. Make the STACVOL file accessible by removing its attributes (see the procedure in this chapter on page 300).
3. Unmount the Stacker drive by typing:

   ```
   stacker -drive:
   ```

   where `drive:` is the mounted drive letter.
4. Start your disk-repair utility and follow its instructions.
5. Restart your computer.

When your computer restarts, Stacker reapplies the attributes and mounts the Stacker drive.

How can I unmount my Stacker drive to use a disk repair utility?

Some disk-repair utilities cannot work while a Stacker drive is mounted. You may have to unmount the drive as well.

To unmount a Stacker drive:

1. At the DOS command prompt, type:

   ```
   stacker -drive:
   ```

   where `-drive:` is the Stacker drive to be unmounted.

When the computer restarts, Stacker remounts the drive.
Troubleshooting during Stacker Setup

Error messages during Stacker Setup always have online help available. Just press F1 when you get the error. The message and its help explain what to do next. Wherever it is always safe to stop Stacker Setup, you will see an Exit button. However, Stacker provides safeguards in case Stacker Setup is interrupted at some other point.

What can I do if Stacker Setup (SSETUP) is interrupted?

Stacker AutoRecover keeps your data safe when Stacker Setup is interrupted for some reason. AutoRecover may complete the compression process or it may remove Stacker compression from the disk, depending on the stage in progress when Stacker Setup was interrupted.

To let AutoRecover take over:

1. Remove any disk in drive A and restart your computer.
2. When Stacker Setup messages appear, follow the instructions. If it offers to decompress data, let it.
3. When the DOS command prompt returns, run a disk-repair utility or CHKDSK, and then restart your computer.
4. Run Stacker Setup again, if necessary.

What if Stacker Setup is interrupted or the power goes out while it's creating a Stacker drive?

If Stacker was finished compressing your data when the power went out or Setup was interrupted for any other reason, restart your system. Setup continues verifying your Stacker drive and completes Setup for that drive.

If Stacker was not finished compressing your data, at system restart Stacker will prompt for a choice between decompressing or leaving the drive as is. If you choose to decompress, your system will be restored to its original state. The option to leave the drive as is should not be used unless you prefer to make changes manually.
Computer Startup Problems
When your computer runs, the Stacker driver controls any Stacker drives. If your computer does not start normally, you may not be able to access to data on Stacker drives. If you have trouble starting, scan this section to find out what to do.

What do I do if I have installed Stacker and now my computer won’t start?

If your system will not start up at all on drive C, the DOS system files might be missing or corrupted. The PC DOS startup diskette contains those files. All you have to do is copy them back to your drive C.

You might want to make a backup copy of your Setup Diskette before beginning and not use your original Setup Diskette for this procedure.

To restore the Stacker configuration files:
1. Insert the Setup Diskette from your PC DOS installation diskettes into drive A and restart your computer.
2. Answer N for NO when queried if you want to install DOS.
3. At the DOS command prompt, type:
   c:\stacker\config
4. Press ENTER.
   You can use the Stacker startup diskette instead if you created one. Let it make suggested changes.
   If your Stacker files are stored in a different directory, use it instead.
5. When the DOS command prompt returns, remove the Setup Diskette and restart the computer again.

If the computer still does not restart from drive C, you may have to restore the DOS system files as well.
To restore DOS system files:

1. Insert your Setup Diskette into drive A and restart your computer.
2. Answer N for NO when queried if you want to install DOS.
3. At the DOS command prompt, type:
   
   c:\stacker\stacker

   This command lists your drive map.

   If you specified for Stacker Setup to store the files in a different directory, use that directory instead.
4. Identify the drive letter of the uncompressed boot drive (in brackets at the end of the drive C line).
5. At the DOS command prompt, type:
   
   sys drive:

   where drive: is the uncompressed drive letter.
6. Remove the Setup Diskette and restart your computer.

If your computer still will not start up from drive C, you might have a problem with your DOS version. Check the PC DOS 7 Command Reference for more information.

Computer Starts, But Cannot Access Compressed Data

When the computer appears to start up normally but you cannot find your compressed data, it usually means the Stacker drive was not mounted. To verify that the Stacker drives were not mounted, type:

   c:\stacker\stacker

If STACVOL files are not listed, they were not mounted. DCONVERT does not mount the drive.

To mount a Stacker drive temporarily:

Type stacker drive:, where drive is the disk that contains the STACVOL file.

If you restart your computer, this drive will be unmounted again.

If you see a message that there are no available replaceable drives, edit the STACKER.INI file (refer to “Editing the STACKER.INI file” on page 460 if you need information on how to edit this file) to add /RP=2. If you already have an RP command, increase its value by at least one.
To mount a Stacker drive permanently:

Edit the STACKER.INI file to cause a converted drive to be mounted when you restart your system. DCONVERT does not modify the STACKER.INI file. (refer to “Editing the STACKER.INI file” on page 460 if you need information on how to edit this file) and add a drive-specification line. For example, on a new line, you would type:

\texttt{drive:\stacvol.dsk, sw}

When you restart your computer, the drive is mounted, along with any other drives specified in STACKER.INI.

The STACKER.INI file is a hidden file in the root directory of the boot drive.

See “Using the Stacker Tools (DOS and Windows)” and “Working with Advanced Stacker” for details on mounting removable Stacker drives.

When you type \texttt{dir c:}, you see files on the uncompressed drive. Several critical DOS and STACKER files are stored here. Stacker includes the CONFIG command that you can use to rebuild basic configuration files that mount existing Stacker drives.

To rebuild the Stacker configuration:

1. At the DOS command prompt, change to the usual boot drive (usually drive C) and type:
   \texttt{c:\stacker\config}

   CONFIG searches for STACVOL files and builds the entries needed to configure the basic system. If you modified it earlier, you will have to do it again.

2. Restart your computer.

Write-Protected Stacker Drive

When an application exits improperly, a damaged file, such as a temporary swap file, a holding file, or a document, may be left behind. This damage is present whether or not Stacker is on your system.

The next time you restart your computer, Stacker's AutoProtect notices the problem and tells you what to do. When CHECK /WP runs from your AUTOEXEC.BAT file, it automatically repairs the damage, removes the write protection, and restarts your computer. If you are not sure if the disk is still write protected, run CHECK /F. If any problems remain, CHECK fixes them and removes write protection for you.
Detected a Restart While Stacker Optimizer Was Writing
The system was restarted while the Stacker Optimizer was in the "Writing New Directories..." stage of optimization. The program must finish what it started to put the STACVOL file in usable condition. Your data is safe, but you cannot access it until Stacker can mount the drive.

*Do not restart your computer while the Stacker Optimizer is running. If you must interrupt it, press F10 to exit safely.*

To let Stacker Optimizer continue:
1. Determine the STACVOL file name (use the STACKER command, if necessary).
2. Insert the *Setup Diskette* and change to that drive (or change to the Stacker installation drive and directory), and type:

   ```
sdefrag /restore=drive:\stacvol.xxx
   
   where drive: is the uncompressed drive and xxx is the file extension of your STACVOL file (most likely DSK).
   
   3. Let Stacker Optimizer continue working. When finished, it restarts your computer and mounts the Stacker drive.

Detected a Restart While Stacker Optimizer Was Optimizing Files
The system was restarted while Stacker Optimizer was in the "Optimizing files..." stage of optimization. Stacker write-protected the Stacker drive to protect your data. You will have to let the Optimizer repair the Stacker drive. Then, restart to remove the write protection.

To complete Stacker Optimizer and remove the write protection:
1. At the DOS command prompt, type:

   ```
sdefrag drive:
   
   where drive: is the Stacker drive. The SDEFRAG command repairs the drive and restarts your computer.
   
   2. Run CHECK /F. Then, run Stacker Optimizer again.
Unable To Repair FATs, #139 (SDEFRAG)
If SDEFRAG is not able to repair the Stacker drive in the above situation, you will get this message. It means that both copies of the File Allocation Table (FAT) have been corrupted. You will lose some data following this procedure, but it is the only way to save the remaining data on your disk.

To repair FAT and get rid of damaged files:
1. At the DOS command prompt, make the Stacker drive current and type:
   \texttt{check /a /f}

   \textbf{Be careful when using the /a parameter.}

2. When CHECK offers to repair the drive, let it.
3. When CHECK offers to delete files, respond No.
4. Restart your computer and run CHECK /F again. Let it delete any files still reported as damaged. Then, use your most recent backup to restore missing files.

Other Stacker Problems
This section explains how to deal with some problems that occur occasionally while using Stacker:

- Stacker Optimizer and 32K clusters
- Errors while running Stacker Optimizer (SDEFRAG)
- Bootable Stacker diskette
- Deletion of last Stacker drive

Stacker Optimizer and 32K Clusters
If you use drives with 32K clusters, Stacker Optimizer may need more memory (more than the 600K needed in previous Stacker versions). If you do not have that much conventional memory available, run Stacker Optimizer with a special option. Using this option affects speed, but it allows you to run Stacker Optimizer using less memory.
To run Stacker Optimizer in less memory:

1. Exit Windows completely.

2. From the DOS command prompt, type:

   sdefrag /buffer=nnn

   where nnn is a value between 256 and 4096, inclusive. By default, SDEFRAG normally runs at /buffer=4096.

The following examples show how much memory you can save with various values:

sdefrag /buffer=3072   21K memory saved
sdefrag /buffer=2048   42K memory saved
sdefrag /buffer= 256   78.75K memory saved

Read, Write, and Media Errors While Optimizing

When you run the Stacker Optimizer, SDEFRAG reads, writes, and verifies every bit of data on your Stacker drive. In the process, it may come across disk surface errors, inconsistencies in the file, or directory structures on the disk. It cannot continue until these are fixed. Depending on your system and the exact problem, you may see any of these message numbers: 109, 110, 112, 118, 120, 170. They all indicate that the Stacker Optimizer found an error on your disk while attempting to read, write, verify, or decompress a file. The problem may be in the file allocation table (FAT) or on the disk itself. It is a good idea to back up your data if you have not done it recently. If the message indicated a read error (109 or 120), however, you will not be able to back up until you correct the problem.

There are two steps to finding and fixing the problem. First, run a surface-scan utility on the uncompressed drive to deal with media problems. Then, run a read scan on the Stacker drive to deal with any resulting data problems.
To identify and correct the problem:

1. Repair the uncompressed drive using a utility such as Central Point's PC Tool DiskFix.
   Message 170 indicates a serious problem. First run a tool such as Central Point PC Tools's DiskFix. If it finds a problem and offers to fix it, let it. If it does not find any problems, however, you will have to run Calibrate, which takes more time but is more thorough.

2. Run CHECK /F to find and repair data-structure problems on the Stacker drive.
3. When CHECK asks if it should do a surface scan, let it.

If you prefer, you can use a disk repair utility to do a read scan of the Stacker drive. You will have to add a command to the STACKER.INI file first.

To scan the Stacker drive with another utility:

1. Use the PC DOS E Editor to add the /R command to the beginning of your STACKER.INI file.
2. Restart your computer. Then, run a disk-repair utility PC Tools' DiskFix on the Stacker drive.
3. Remove the /R switch (it is only for diagnostic use), and restart your computer.
4. Use Check Drive Integrity in the Stacker DOS Toolbox and follow the instructions. Let CHECK delete any damaged files.

Bootable Stacker Diskette
Many problems with compressed data result from errors in the DOS file system or defects in the hard-disk media. When Stacker detects either type of problem, it write-protects your disk to protect your data and suggests how to fix the problem.

When all else fails, you can always start your system using the PC DOS startup diskette. It gets you to the DOS command prompt. You cannot troubleshoot your machine under Windows.
How do I create a bootable Stacker diskette?

One of the best precautions you can take to protect your data from a system failure is to have a bootable diskette that is Stacker-aware. If your system has compressed data files, all the files your system needs for rebooting are available on this diskette.

You can create your own Stacker-aware startup diskette in the event of a system emergency. Keep this startup diskette in case your system ever has a problem. You will be able to start your system from this disk; it will know about Stacker and provide access to your data.

To create a Stacker bootable diskette:

1. Insert a blank unformatted diskette into drive A. The capacity of the diskette must be larger than 720K to hold the files you need to copy.

2. Type `format a: /s /u` to provide a formatted diskette containing the operating system files.

3. Use the DOSKey program or type the following commands to copy some essential DOS files to a diskette.

   **Note:** Make sure you are at the A:> prompt before you begin typing.

   ```
   copy c:\dos\e.exe
   copy c:\dos\e.ex
   copy c:\dos\attrib.exe
   copy c:\dos\chkdsk.com
   copy c:\dos\defrag.exe
   copy c:\dos\format.com
   ```

4. Some of the compression files you need to copy are hidden. You must use the ATTRIB command to unhide them before they can be copied onto your diskette:

5. Change to the host drive and type the following at the DOS command prompt:

   ```
   attrib -r -s -h drive:filename.xxx
   ```

   where `drive` is the drive where your compression files are located and `filename` is the name of the file or STACVOL to be copied.

   If you need to see your systems drive mapping, type `stacker` at the DOS command prompt.
6. Use the DOSKey program or type the following commands to copy some essential compression files to your diskette.

**Note:** Make sure you are at the A:> prompt before you begin typing.

The following example assumes your files are on drive C and your STACKER.INI file is on drive G, so you would type:

```plaintext
copy c:\dos\stacker\check.exe  
copy c:\dos\stacker\config.exe  
copy c:\dos\stacker\stacker.com  
copy c:\dos\stacker\stacker2.bin  
copy c:\dos\stacker\stacvol.xxx  
copy c:\dos\stacker\sysinfo.exe  
copy c:config.sys  
copy c:\dos\dblspace.bin  
copy g:\stacker.ini
```

You do not need to rehide your Stacker Compression files; they are rehidden when you reboot your computer.

7. Edit the CONFIG.SYS file on the diskette in drive A so that only the following line remains:

```plaintext
files=30
```

8. Try rebooting your computer with this diskette in drive A. Verify that it starts up with the A:> prompt rather than the usual C:> prompt. Verify that you can access the files on your drive C.

9. Remove the diskette from drive A, write protect it, and label it as a bootable Stacker diskette. Then, store the diskette in a safe place.

10. Restart your computer from your hard disk by pressing CTRL+ALT+DEL.

**Deletion of Last Stacker Drive**

If you choose to uncompress Stacker drives, after your last (or only) Stacker drive is uncompressed, you are prompted whether you want to remove the Stacker driver from your system. You should answer NO.

If you answer YES, you will need to recreate your DBLSPACE.BIN file unless you copied the required files suggested in "Bootable Stacker Diskette" on page 309; if not, use the following procedure.
To recreate your DBLSpace.BIN file:

1. Change to the Stacker directory.
2. At the DOS command prompt, type:
   
   ```
   copy /b stacload.bin + stacker.com dblspace.bin
   ```

3. Locate and copy the DBLSpace.BIN file to the root directory of the boot drive (usually drive C).
4. Copy the STACKER2.BIN file from the Stacker directory to your root directory.
5. Reboot your system to reload the Stacker driver.

   After rebooting, you can rerun Stacker to create new Stacker drives.

### Central Point Backup

This section provides answers to some of the most common questions asked about Central Point's Backup program.

**How do IBM tape devices and Central Point Backup correspond to each other?**

When configuring tape devices for Central Point Backup, the software attempts to determine what type of device is attached. The following table provides a cross reference between IBM tape devices and their corresponding Central Point Backup equivalent.

<table>
<thead>
<tr>
<th>IBM Tape Device Name/Model</th>
<th>Central Point Backup Tape Device Name/Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM 1.2GB 3450-001</td>
<td>Tandberg IBM 4100</td>
</tr>
<tr>
<td>IBM 2.0GB 4mm 3440-001</td>
<td>IBM35480A</td>
</tr>
<tr>
<td>IBM 2.3GB 8mm 3532-023</td>
<td>EXABYTE EXB-8200</td>
</tr>
<tr>
<td>IBM 5.0GB 8mm 3445-001</td>
<td>EXABYTE IBM-8505</td>
</tr>
</tbody>
</table>

**I am running an IBM 2.3GB 8mm SCSI tape drive and get the error Function not supported when I try to run Central Point Backup. What do I do?**

The Central Point Backup program does not support the IBM 2.3GB 8mm SCSI tape drive (3532-023). This tape drive is an OEM version of the EXABYTE 8200 SCSI tape drive. The firmware was modified to meet a business need. This changed the commands used to communicate with the tape's hardware. As far as Central Point Backup is concerned, it is communicating with an EXABYTE SCSI drive. Because of the modification this is not the case and the error occurs.
File Update Utility

I made changes to my directory pairs and now I can’t find them. What happened?

If you update directory pairs before you select Update From Diskette, directory changes on the “to” location are replaced. You must re-enter your directory changes.

I keep running into memory problems? Am I doing something wrong?

Using File Update from the DOSSHELL can cause memory problems. Exit from the DOSSHELL (F3) before starting File Update.

My files are “out of sync” at the base and remote locations. How do I align and synchronize my files without having to manually copy files from one location to the other?

If the files at your locations are not synchronized, select Copy all files from all directories from the Custom File Selection choice.

I am missing files. What can I do?

If you are missing files, make sure that:

• The extension is not included in the Files Being Excluded list.
• The subdirectory is defined in the Directory Pairs list.

Other Common Problems

What should I do when the program or device driver reports the wrong version of DOS?

Some programs or device drivers run only with specific versions of DOS. If a message appears indicating a program or device driver does not run with DOS, contact your vendor to get an updated program or to find out whether the current version of the program or device driver is actually compatible with DOS.
If the current version of the program or device driver is compatible with DOS, use the SETVER command to change the version number that DOS reports to the program or device driver. When you use the SETVER command, the program or device driver interprets DOS as the version it is designed to use. For example, if a program named MYAPP.EXE runs only with DOS Version 3.3 or earlier, you would type:

```plaintext
setver myapp.exe 3.3
```

DOS reports the changed version number to the program when you restart your computer. If the program is compatible with DOS, the SETVER command eliminates the apparent incompatibility. There must be a DEVICE command for the SETVER.EXE device driver in your CONFIG.SYS file in order for the SETVER command to report a different version to a program. Also, make sure there is only one SETVER.EXE on your hard disk, because each SETVER.EXE contains a separate version table.

**Note:** Make sure the SERVER.EXE is being loaded before your device drivers in the CONFIG.SYS file.

Type `help setver` for more information about the SETVER command, or refer to the online *PC DOS 7 Command Reference*.

**Warning:** Contact your software vendor for information about whether a program works with DOS. It is possible that IBM has not verified whether the program will run successfully if you use the SETVER command to change the program version number and version table. If you run the program after changing the version table in DOS, you might lose or corrupt data, or introduce system instabilities. If you do not contact your software vendor to determine the compatibility of a specific program with DOS, IBM is not responsible for any loss or damage.

---

**I have installed PC DOS 7 and want to expand drive C: to be larger than 32MB. What steps do I need to take?**

This can be accomplished by backing up your system to diskettes, formatting the hard disk, repartitioning it, and then reformatting it. Then, you can reinstall DOS along with the other files.
To back up your entire system using CPBackup:

1. Type the following at the DOS command prompt to start CPBackup:
   ```
cpbackup
   ```
2. Back up all the files on all your drives.

   If you need more information about backing up your files, refer to Chapter 20, “Using Central Point Backup” on page 383.

3. Insert the *Setup Diskette* from your PC DOS installation diskettes into the diskette drive.

4. Leave the *Setup Diskette* in the diskette drive and press CTRL+ALT+DEL. This restarts your system.

5. Press F5 immediately after your computer displays the message *Starting PC DOS*...

6. From your *Setup Diskette*, run FDISK.

7. Delete all partitions and remake the desired number of partitions. Refer to “Using FDISK” on page 83 for more information.

8. Format drive C and any other hard disk partitions.

9. Install DOS again.

10. Restore all files using CPBackup program. Refer to “Restoring Data” on page 409.
Part 2. Using the DOS Optional Tools

Chapter 18. Using the PC DOS Shell ........................................ 319
Chapter 19. Using IBM AntiVirus/DOS .................................... 363
Chapter 20. Using Central Point Backup ................................. 383
Chapter 21. Using Stacker Compression ................................. 427
Chapter 22. Using PenDOS .................................................. 481
Chapter 23. Using PCMCIA Support ...................................... 501
Chapter 18. Using the PC DOS Shell

Through the use of color and graphics, the PC DOS Shell offers a visual way of working with DOS. Information is set up in different areas on your screen, making it easy to find. For example, when you first run the PC DOS Shell, the following information is displayed on your screen:

- The disk drives available on your system.
- The directory structure or tree for the current disk drive.
- A list of files in the current directory.
- A list of programs that you can run.

You can use the PC DOS Shell to perform many of the same file-management and disk-maintenance tasks that you perform from the command line. For example, you can use the commands on the File menu to create directories, copy files, and view the contents of a file. You can use the Disk Utilities group to perform disk-maintenance tasks, such as formatting and copying disks. You can also use the PC DOS Shell to organize and start programs, and to switch between them.

Installing the PC DOS Shell after Installing PC DOS

If you did not choose to use the PC DOS Shell for file-management and disk-maintenance tasks at initial installation of PC DOS, you can still rerun PC DOS Setup using the /e switch.

The PC DOS installation diskettes contain everything you need to install PC DOS Shell. You might want to refer to Chapter 1, “Installing” on page 3 before you begin the installation of additional optional tools.

To install PC DOS Shell using the /e switch:

1. Insert the Setup Diskette from the PC DOS installation diskettes into drive A or B.

2. At the DOS command prompt, type:

   a:setup /e

   or

   b:setup /e

   The /e switch allows you to return to the optional tools selection menu without having to do a complete reinstallation of PC DOS. Only the necessary files for the optional tools will be installed.
3. After Setup begins, follow the instructions displayed on the screen. Make sure you specify the same “Install to Path” as you did when you did the initial PC DOS installation.

At the Optional Tools screen, use the UP ARROW to scroll up the list of optional tools, or click on the UP ARROW shown in the brackets next to the word “More” to scroll. You see NO next to PC DOS Shell.

4. Press the UP ARROW until you highlight PC DOS Shell and then press ENTER. Or, use your mouse to select the PC DOS Shell.

5. Select other optional tools you want to install either by highlighting the name of each optional tool and pressing ENTER to select each item if you are using the keyboard, or clicking on the item if you are using a mouse.

6. After you select the optional tools you want to install, move the cursor to highlight the following:

   Options correct. Continue Setup.

   and press ENTER to accept the optional tool selections. Or, if you are using a mouse, just click on this line.

7. Continue to follow the instructions on the screen until you have completed the installation of the optional tools.

---

**Starting the PC DOS Shell**

You have two ways to view DOS and enter commands:

- The PC DOS Shell view
- The DOS command prompt view

**The PC DOS Shell View**

The *PC DOS Shell* is a type of interface used to operate PC DOS, known as a *graphical user interface* (GUI). GUI is a graphical way to present information on-screen and to accept information from you. You can manage your computer from the PC DOS Shell by using graphical alternatives to the DOS commands typed at the DOS command prompt.

**To start the PC DOS Shell each time you start your computer:**

During PC DOS 7 installation, if you select PC DOS Shell, the command-line statement to load the PC DOS Shell automatically is added for you by the Setup program. Therefore, whenever you start your computer, the PC DOS Shell is displayed instead of the DOS command prompt.
However, if you are upgrading your version of PC DOS, you previously had the PC DOS Shell installed and do not install the PC DOS Shell that is provided with PC DOS 7, you must use the following procedure:

To modify the AUTOEXEC.BAT file if not installing the PC DOS 7 Shell:

1. At the DOS command prompt, type:
   
   `e autoexec.bat`

2. Use the DOWN ARROW to move the cursor to the following line:
   
   `rem C:\DOS\DOSSHELL.EXE`

3. Press ALT+L to mark this line of text.
4. Move the cursor to the last line of this file.
5. Press ALT+M. to move this line of text so it becomes the last line of the file.
6. Press ALT+U to unmark the line of text.
7. Remove the REM statement so the line is as follows:
   
   `C:\DOS\DOSSHELL.EXE`

8. Press F4 to save and close the file.
9. Reboot your system by typing CTRL+ALT+DEL

The PC DOS Shell window is displayed.

The DOS Command Prompt View

The DOS command prompt view is the traditional look of the DOS command prompt (`C:\>`). Using the command line is quicker after you know the commands and their options. When you first start out using DOS, however, the PC DOS Shell eliminates the need to know the names of some commands and their options.

If your system is currently set up so that the DOS command prompt appears, you can start the PC DOS Shell from there.

Note: A terminate-and-stay-resident (TSR) program is a program that is loaded and stays loaded in memory until you unload it. If you start a TSR program before starting PC DOS Shell, do not quit the TSR program by using its exit procedure while you are still in the PC DOS Shell. Instead, you must first leave the PC DOS Shell and then quit the TSR program.
To start the PC DOS Shell from the DOS command prompt:

1. At the DOS command prompt, type:
   
   dosshell

2. Then press ENTER to display the PC DOS Shell window.

In the section “Introducing PC DOS Shell Basics” on page 324, the PC DOS Shell is discussed in greater detail. Right now you simply are taking a “first look.”

**Menu Bar**

Provides a list of menu options. The menu bar is below the title bar of the main window.

**Drive Icon area**

Lists the disk drives that your computer recognizes. The selected drive is highlighted. Drives A and B are diskette drives. The first hard disk drive is C. If your hard disk drive or drives are partitioned into separate logical drives, each drive letter is treated as a separate physical drive.

**Directory Tree area**

Shows the directories for the selected drive. The current directory is highlighted.

**File List area**

Shows the files for the current directory. A current file is highlighted.

**Program List area**

Lists the programs available from the current program group, and lists other program groups.
Status Line

Shows function keys, messages, and the current time at the bottom line of the PC DOS Shell window.

A title for an area is highlighted when this area is selected, such as the title for Main shown in the illustration above.

Displaying Information About Your Files and Programs

The PC DOS Shell displays information about your files and programs. You can choose from a number of different ways to display this data. These different views are called display modes.

When you start the PC DOS Shell, you see a full-screen display. This initial display contains information that is displayed automatically. The display shows you the list of disk drives in your computer, the files in the root directory, and a list of some of the DOS programs available.

In graphics mode, the PC DOS Shell uses icons—small picture that graphically represents an object—such as disk drives, directories, programs, and text files.

If you have an EGA or VGA display, you can display the PC DOS Shell in graphics mode. The following PC DOS Shell view is in 30-line graphics mode. You can use this mode if your display has EGA or better resolution. Changing the display options for this mode is discussed in “Changing the PC DOS Shell View” on page 345.
Other parts of the PC DOS Shell, such as the scroll bars and the *mouse pointer* (a symbol, usually an arrow, that shows you the position of the mouse) are easier to read in graphics mode.

**Selection Cursor**
Indicates the selected drive, directory, file, or program with a highlighted area or band in graphics mode. In *text mode*, the selection cursor is a small triangular arrow. If no title bar is highlighted, the selection cursor is in the disk drives area.

**Mouse Pointer**
Indicates the current position of the mouse on the display. Use the mouse pointer to select items.

**Scroll Bars**
Scrolls any list of directories, files, or programs that is too long to fit in the display area.

---

**Introducing PC DOS Shell Basics**

The PC DOS Shell makes DOS easier to use. No commands to memorize, no file names to remember, and help at the touch of a key. You just select actions from menus, type answers to questions, and check off options in dialog boxes. The PC DOS Shell is a shortcut for those who already understand the basics of DOS. You can issue most of the same DOS commands that you type at the DOS command prompt by using a mouse or the keyboard to point to and select the following:

- A *menu*—displays below the menu bar when you select any of these menu options: File, Options, View, Tree, and Help.

- A *dialog box*—a window containing options that appears when a command needs additional information.

The PC DOS Shell view is a full-screen window with menus and help screens. The PC DOS Shell provides a visual presentation of DOS, with options from which you make selections.

When DOS needs you to supply more information to complete a command, DOS displays a dialog box. You type the answers to the prompts, and DOS completes the command.

**Selecting Items from Lists or Menus**

From the PC DOS Shell, you can initiate DOS commands, run programs, find files, view the contents of files; and change the way that the PC DOS Shell area appears. All these *actions* are performed by selecting menu options. You do not have to remember command names or the format and parameters of the commands.
The concept of selecting an item and then performing some action with that item is one of the main concepts behind the PC DOS Shell graphical user interface. An item can be a disk, a directory, a file, or a program. You select an action from a menu.

You select an item by using either the mouse or the keyboard.

**Using the Mouse**

Although you can use the PC DOS Shell with the keyboard or the mouse, you will find that using the mouse is much easier. The graphical user interface was designed to be used with a mouse.

With the mouse, you can select items and menu options. As you move the mouse, the mouse pointer moves in the same direction on-screen. The mouse pointer takes on different shapes in the various modes of PC DOS. In graphics mode, for example, the mouse pointer is an arrow. In text mode, the mouse pointer is a colored rectangle. In addition, the mouse pointer sometimes changes shape to indicate the action taking place.

You should be familiar with mouse terminology. To select an item with the mouse, make sure that the tip of the mouse pointer is over the item you want to select and click. When you *click* a mouse button, you press and release the left mouse button once without moving the mouse. Your mouse might have two or three buttons, but unless otherwise indicated you should use the left button. Sometimes you *double-click*, meaning to click the left mouse button twice in rapid succession.

Selecting a menu option and a command from the menu with a mouse is easy. Follow these steps:

**To use the mouse to work with menus:**

1. Move the mouse pointer to the menu option and click the mouse button.
2. Move the mouse pointer to the menu command you want to use and click the mouse button again.

To *drag* the mouse, move the mouse pointer over an object, and then press and hold down the mouse button as you move the object with the mouse pointer. You can move the mouse in any direction: up, down, left, right, or at any angle.

A directory listing is automatic when you are in the PC DOS Shell. You always see a listing of the subdirectories and files in the current directory. If you move the mouse pointer to the folder icon next to C:\ in the Directory Tree area and click the left mouse button, the directory tree alternately expands (to show all branches) and collapses (to show no branches).
If you move the mouse pointer to the icon next to Disk Utilities in the program area and double-click the left mouse button, the program area title switches from Main to Disk Utilities. The program area now displays the DOS disk utilities. Double-click the icon next to Main to switch back to the Main program list.

**Using the Keyboard**

If you prefer to use the keyboard to select an item, you can use any of the following procedures:

- Press TAB to select the area you want. Pressing TAB highlights the selected area title. If no *title bar*, which identifies the name of the current window or dialog box, is highlighted, the selected area is the disk drive area near the top of the display.
- Press SHIFT+TAB to move back to the previously selected area.
- After you are in the appropriate area, use the UP ARROW or DOWN ARROW to move the *selection cursor*, (a highlighted band or area that indicates that an item is selected) to the directory, file, or program you want to select.
- In the disk drives area, use the LEFT ARROW or RIGHT ARROW to select a different disk drive.
- Use a shortcut key
  
  You can use a shortcut key, which is a key or key combination instead of a menu selection to issue a command, as explained in "Making Menu Selections" on page 328.

- Use mnemonic selection
  
  *Mnemonics* are characters that appear highlighted or underlined on the menu bar or list of menu items. Make a selection by typing the single character displayed in a different color or different highlighting. If your menu bar does not display a highlighted character, press ALT.

  To access the menu bar, you must press ALT followed by the highlighted letter in the menu choice. For example, to access the File menu, you would press ALT+F to get the list of menu items.

**To select a menu option and a command from the menu with the keyboard:**

1. Press ALT or F10 to access the menu bar.
   
   This action highlights the File menu bar item.

2. Press the LEFT ARROW or RIGHT ARROW to highlight the menu bar option you want.

3. Press the DOWN ARROW to access the menu.
4. Press the DOWN ARROW or UP ARROW to highlight the menu item you want.

5. Press ENTER to select the menu item.

**Using Mnemonic Selection**
You also can use another keyboard method to make selections from a menu more quickly.

**To use the mnemonic selection keyboard method:**
1. Press ALT or F10 to access the menu bar.
   
   This action highlights the File menu bar.

2. Type the underlined or highlighted letter, depending on the type of system you have, of the menu bar item you want.
   
   This step opens the menu for that menu bar item.

3. Type the underlined or highlighted letter of the menu item you want to use.

**Using Shortcut Keys**
A shortcut key lets you press a key or combination of keys instead of selecting a menu item. Some of the most common menu items have shortcut keys. These keys do save time when you use a menu item often.

Shortcut keys are listed next to the menu item in the menus. If no key is listed, that command has no shortcut key. If two keys are listed together, press both keys at the same time.
Making Menu Selections
Performing tasks in the PC DOS Shell is similar to performing tasks in everyday life. When you want to open a file in the PC DOS Shell, you first select File (the object), and then you select Open (the action).

Most often you choose an action from a menu. The initial menu options are listed in the menu bar. The possible menu selections are File, Options, View, Tree, and Help. When the program area is highlighted, the Tree menu is not available.

When you select a menu option, a menu is displayed. From the menu, you select the specific action you want, such as a DOS command. Menu options that appear dimmer than others are unavailable for selection.

Some menu options remain dim if you do not have a file or text selected. Most of the options in the File menu, for example, require something to be highlighted before the option is available for use.

Selecting More Than One Item
If you want to perform the same actions, such as copying, on more than one item, you can use the multiple selection method.

To select more than one item that are consecutive in a list:
1. Click on the first item to highlight it using the left mouse button.
2. Press SHIFT and hold it down.
3. Click on the last item using the left mouse button.
   All the items in between the first and last items are highlighted.

To select more than one item that are not consecutive in a list:
1. Click on the first item to highlight it using the left mouse button.
2. Press CTRL and hold it down.
3. Click on the each item you want to select it using the left mouse button.
   All the items you selected are highlighted.

Cancelling Menus
If you select a menu in error, you can cancel the selection and make a different menu selection. To cancel a menu with the mouse, just click anywhere outside the menu area, or click the right mouse button. To cancel a menu with the keyboard, press ESC.
If you make the wrong menu selection with the mouse, just click on the correct menu option in the menu bar. The incorrect menu disappears, and the new menu opens. If you make the wrong menu selection with the keyboard, just press the LEFT ARROW or RIGHT ARROW to select the menu choice you want.

**Using Dialog Boxes**

Sometime you must enter additional information before DOS can carry out the command you selected. When DOS needs additional information, it opens a dialog box. When a command has a dialog box, the command name in the menu is followed by an ellipsis (...). A dialog box may request one piece of information or many separate pieces of information, depending on the command.

If you click on File Display Options from the Options menu, for example, you see a dialog box that lets you change the way data is displayed in the files area.
The File Display Options dialog box requests that you enter the files you want to see, how you want them sorted, and whether you want the hidden or system files displayed.

The dialog box is one of the main features of a graphical user interface. With some menu systems, you must choose many different levels of menus to get to the one you want. Often, you must make more than ten selections to start one command. With menus and dialog boxes, however, you select a menu and a command; then, if additional information is needed, DOS prompts you for that information in a dialog box, which can be as large as a full screen if necessary.

Dialog boxes can contain the following elements:

- **Text box**: A box in which you type text, such as a file name.
- **Check box**: An on-and-off or yes-or-no question enclosed in square brackets. If the option is selected, an “X” appears in the square brackets.
- **Option Button**: A circle next to a specific option. The selected option has a black dot in the circle. Related option buttons are grouped together. You can choose only one option button at a time from a group.
- **List box**: A list of options that is similar to a list of option buttons, but in a different format. You can choose only one option from the list.
- **Command button**: A possible action you can take from the dialog box. The OK button processes the command. The Cancel button cancels the command. The Help button displays online help for the dialog box.

**Entering Text in Dialog Boxes**

To use the mouse to select a text box in a dialog box, move the mouse pointer to the text box and click the left mouse button. If you are using the keyboard, press TAB or SHIFT+TAB until an underline appears in the text dialog box where you want to enter text.

To type over an existing entry, just type the new entry. To change an existing entry, press the LEFT ARROW or RIGHT ARROW to position the cursor. Press BACKSPACE to delete a character to the left of the cursor and DEL to delete the character at the cursor; then type any new text.
Selecting Options in Dialog Boxes
To select or deselect a check box with a mouse, move the mouse pointer between the square brackets and click. To use the keyboard, press TAB or SHIFT+TAB to move to the check box, and then press the SPACEBAR.

To use the mouse to select an option from a list of option buttons, move the mouse pointer to the option button and click. A black dot appears in the selected option button and disappears from any other button in the list. If you click the black dot, nothing happens. With a keyboard, use the UP ARROW or DOWN ARROW to move the black dot to the option you want to select.

In some dialog boxes, a list of possible options is displayed in a box. You select from this list. To select an option from a list box with the mouse, move the mouse pointer to the option you want and click. With the keyboard, use the DOWN ARROW or UP ARROW to highlight the option you want.

This list box lets you select from a number of different color schemes, depending on the type of display you have.

Using Command Buttons
After you supply the requested information in a dialog box, you select the OK command button to start the command with your choices. Select the Cancel button to ignore all information entered in the dialog box and cancel the command. Other command buttons might be available, such as Help.
To select a command button with the mouse, move the mouse pointer to the button and click the left mouse button. If you are using the keyboard, press TAB or SHIFT+TAB until an underline appears on the command button you want; then press ENTER or the SPACEBAR. You can press ESC to cancel a command at any time.

**Using Scroll Bars**

Sometimes a list is too long to fit within a display area or dialog box. If you use a mouse, you can use scroll bars to view text that is not visible. The scroll bar runs the length of a list. The scroll box is a gray, rectangular box inside the scroll bar. The scroll box represents the position and the fraction of the data in the currently displayed list. In this Directory Tree area, the scroll box starts at the top of the scroll bar, which means that the top of the list of directories is displayed.

To scroll down a list, click the black area of the scroll bar, below the scroll box. The scroll box moves down a page at a time, and the list scrolls down to display another part of the list.

After you click below the scroll box, the text scrolls down. You can keep clicking until the scroll box reaches the bottom, revealing the bottom of the list of directories.

At the top and bottom of the scroll bar is a scroll arrow—an arrow you can click to scroll the screen in the direction of the arrow. To scroll up or down by one line, move the mouse pointer to the up scroll arrow or the down scroll arrow and click. For every click, the display scrolls one line and the scroll box moves accordingly.
The DOS directory contains many files. The size of the scroll box lets you know how much of the list is visible. If the scroll box is halfway between the scroll arrows, this indicates that only about half of the files are visible.

When a list is long, you can scroll swiftly by dragging the scroll box. To drag a scroll box, move the mouse pointer to the scroll box, hold down the right mouse button, and move the pointer up or down. As long as you keep the mouse button pressed while you move the mouse, the scroll box moves with the mouse pointer and also scrolls the list.

To scroll with the keyboard, press TAB to select the area you want; then press the UP ARROW or DOWN ARROW to move the selection cursor one item at a time in the direction of the arrow. Page up or page down to scroll up or down, respectively, one full screen at a time.

Using PC DOS Shell Commands

When you choose a menu option, DOS displays a menu and a list of menu commands for that selection pop down. To move, copy, or rename files or to execute other commands, you do not have to remember command names; you just select items from command menus.

The PC DOS Shell provides procedures online for performing each menu command. Use the following steps for each menu command under the File option.
To access the online procedures:

1. Select the File menu.
2. Use the DOWN ARROW or UP ARROW to highlight the command you want procedures for, such as Copy.
4. Select the hypertext link under “Related Procedure.”
5. Scroll to where the procedures are visible within the window.

---

**Getting Help**

PC DOS Shell online help provides a quick way to get information about PC DOS Shell basics and how to use menus, commands, dialog boxes, dialog box options, and procedures.

You can get help in three ways:

- By pressing F1.
- By selecting the Help button that appears in most dialog boxes.
- By using the Help menu.

**To request help on a menu:**

1. Press ALT.
2. Use the RIGHT ARROW or LEFT ARROW to highlight the menu you want help on.

**To request help on a command:**

*Mouse*

1. Click on the menu that contains the command you want help on.
2. Use the DOWN ARROW or UP ARROW to highlight the command you want Help on.
1. Press ALT to select the menu bar.
2. Use the RIGHT ARROW and LEFT ARROW to highlight the menu that contains the command you want help on.
3. Use the DOWN ARROW or UP ARROW to highlight the command you want Help on.

A Help window containing information about the selected menu appears.

You will notice that in most help screens, several terms appear in bold type. By double-clicking on a bold term, you can move to another help screen on that particular topic. Use the Back button when you are ready to return to the Help screen from which you came.

**To request help on a dialog box option:**

1. Open the dialog box you want help on.
2. Select a command button or option using the TAB or the arrow keys.

For example, if you have selected Search For in the Search File dialog box and you press F1, the PC DOS Shell displays the following Help window:

![Help window](image)

Each F1 Help screen contains the following command buttons:

<table>
<thead>
<tr>
<th>Command Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Cancels help</td>
</tr>
<tr>
<td>Back</td>
<td>Displays previous Help screen</td>
</tr>
<tr>
<td>Keys</td>
<td>Displays help on keyboard keys</td>
</tr>
<tr>
<td>Index</td>
<td>Displays the Help index</td>
</tr>
<tr>
<td>Help</td>
<td>Displays help on how to use the Help system</td>
</tr>
</tbody>
</table>
Getting Help on a Related Procedure

Often Help refers you to a related procedure. For example, if you requested Help on the Color Scheme dialog box, this Help contains a reference to the procedure for changing colors.

Within Help, related procedures are displayed in a different color or in reverse video, depending on the color scheme you have selected.

To view a related procedure:

*Mouse*  
Double-click on the related procedure.

*Keyboard*  
1. Press TAB until the related procedure is selected.
2. Press ENTER.

A Help window containing information about the related procedure appears.

Using the Help Menu

You can use the commands on the Help menu to view an index of Help topics; information on the keys you can use with the PC DOS Shell; basic skills for working with the PC DOS Shell commands and procedures; and information about using the Help system.

To use the Help menu:

*Mouse*  
From the Help menu, click on the Help category you want.

*Keyboard*  
1. Press ALT+H.
2. Press the highlighted letter for the Help category you want.
   
   Or, press the UP ARROW or DOWN ARROW to select the Help category you want, and then press ENTER.

Either information about the subject or a list of topics related to the subject appears.

**Note:** If you have not used Help before, select Using Help from the Help menu to learn more about the type of information available.
Help Menu Options

The following items are available from the Help menu:

- **Index**: Provides a list of all the PC DOS Shell Help topics.
- **Keyboard**: Lists keys and key combinations you can use with the PC DOS Shell.
- **Shell Basics**: Provides an introduction to using the PC DOS Shell.
- **Commands**: Explains all the PC DOS Shell commands. This information is organized according to the menu in which the command appears. You can get the same information by selecting a command and then pressing F1.
- **Procedures**: Provides step-by-step instructions for performing tasks in the PC DOS Shell.
- **Using Help**: Provides an introduction to using the PC DOS Shell Help.
- **About Shell**: Displays copyright and version information about PC DOS Shell.

If you select Shell Basics from the Help menu, the following help window demonstrates the type of information you would see:
Starting a Program

PC DOS Shell automatically displays information about a disk, a directory, and programs. You use a mouse or the keyboard to move around the display, to select menu items, and to start programs.

This section introduces the idea of starting programs from the PC DOS Shell. *Programs* are files that have an .EXE or .COM file extension. Batch files with a .BAT file extension contain DOS commands and start programs.

Central Point Scheduler, Central Point Undelete, and the E Editor are PC DOS programs available from the PC DOS Shell.

Programs can be started from the Main group of PC DOS Shell by double-clicking on the program name or by using the TAB key to move the cursor to the Main group and then using the DOWN ARROW or UP ARROW until the program name is highlighted. Then press ENTER.

Ways to start a program from PC DOS Shell include:

- **From a program group**, choose a program item.
  
  For example, Disk Utilities and Main are two program groups available with PC DOS Shell. From the Main group you could start Central Point Scheduler by selecting the program—by highlighting it and then pressing ENTER if you are using the keyboard, or double-clicking on the item if you are using a mouse.

- **From a file list**, choose a program file or a file associated with that program.
  
  From the list of files in a specific directory, you can start the program by selecting any file with an extension of .BAT, .EXE, or .COM. For example, to start the E Editor, select the program by highlighting the E.EXE file and then pressing ENTER if you are using the keyboard, or double-clicking on the item if you are using a mouse.

- **From the File menu**, select Run. Type the name of the program file in the Run dialog box, and then select OK.
  
  For example, type qconfig to start the QCONFIG program.
• From the Main group, double-click on Command Prompt and you see the message Type EXIT and press ENTER to return to DOS Shell. You do not see this message if the Task Swapper is running.

Type the name of the program at the DOS command prompt. After the program completes its processing or you exit from the program, type exit and press ENTER to return to the PC DOS Shell.

  – Do not type dosshell to return to the PC DOS Shell because the program is already running.

  – To return to the PC DOS Shell, you must type exit and then press ENTER.

Finding Files

You have seen how the PC DOS Shell simplifies using commands. The PC DOS Shell also lets you work with the files on your disk. For example, it can help you keep track of all the files you have stored, including finding files.

The PC DOS Shell gives you many ways to find lost files. You can use the Search option from the File menu, or you can change the PC DOS Shell view and the file display options.

You will learn how to change the file display options in “Changing the PC DOS Shell View” on page 345.

Using Search

If you know the name or extension of the file you need to find, or even if you only know part of the name or extension, you can use Search to find it. You can use wildcard characters if you want to search for a series of files.

To search for one or more files:

1. Press ALT+F or click on File to display the File menu.
2. Click on Search from the File menu. The Search File dialog box opens.
3. Enter the name of the file you want to find in the Search for text box. You can use wildcards. To search for all the files with a .BAT extension for example, type *.BAT in the Search File dialog box.

4. To search the entire disk, select the Search entire disk check box. To search only the current directory, deselect the Search entire disk check box.

5. Select OK.

DOS lists all the files it finds on the Search Results screen.

6. Press ESC to return to the main PC DOS Shell screen from the Search Results screen.
Using the Task Swapper

A feature of the PC DOS Shell is the Task Swapper. With the Swapper running, you can start more than one program at the same time and swap between them. This feature can be handy if you regularly use more than one program, such as a word processor and a spreadsheet and often change between them.

To enable the Task Swapper:

1. Click on Options from the menu.
2. Select Enable Task Swapper.

A black diamond appears to the left of the command on the menu to indicate that the Swapper is enabled.

When the Task Swapper is enabled, the program area at the bottom of the screen is split into two areas. The Active Task List area lists all programs that have been started.

With the Swapper enabled, you can start a program, and then suspend the program and return to the PC DOS Shell.

To return to the PC DOS Shell from a program, press ALT+ESC. Once back in the PC DOS Shell, you can start one or more other programs, which also can be suspended by pressing ALT+ESC.
In this example, the E Editor and the Command Prompt programs are running as active tasks, and current action has been returned to the PC DOS Shell.

When you start one or more programs and return to the PC DOS Shell, the programs are listed in the Active Task List area.

To resume an active task:

• Double-click on the task name
• Or, select the task and press ENTER.

When you return to an active task, you return to the exact environment you left. The same file or files are in memory, the cursor is in the same spot, and any options are unchanged.

It is important to remember to quit all active tasks before you leave the PC DOS Shell, or turn off your computer. If you do not, you run the risk of damaging your program files.

Updating a directory
If you made changes to a directory such as adding or deleting files, the changes will not be displayed in the File List area until you update the directory.

To update a directory:

1. Select the directory that you want to update.
2. Press CTRL+F5.

Leaving the PC DOS Shell

You can leave the PC DOS Shell and move to the DOS command prompt in two ways. You can quit the PC DOS Shell temporarily, in which case you can work at the DOS command prompt while the PC DOS Shell is still in your system’s memory. Or you can quit the PC DOS Shell and remove it from your system’s memory before you switch to the DOS command prompt.

To leave the PC DOS Shell temporarily:

• Press SHIFT+F9.
• Or, select Command Prompt from the Main group on the program list.

To return to the PC DOS Shell, you must type exit and then press ENTER.

Note: Do not type dosshell to return to the PC DOS Shell because the program is already running.
If Task Swapper is enabled, you can switch back to the PC DOS Shell without quitting Command Prompt by pressing CTRL+ESC. Note that Command Prompt is still running and listed in the Active Task List.

To quit the PC DOS Shell:

1. If there are programs displayed in the Active Task List, you must quit each program before leaving the PC DOS Shell.
   
   If you try to quit the PC DOS Shell while you still have programs listed in the Active Task List, the Exiting Error dialog box appears. The dialog box tells you that you cannot quit the PC DOS Shell without first quitting all programs that you have running.
   
   Select OK to close the dialog box.
   
   Use one of the following three options if you decide to exit the PC DOS Shell and return to the DOS command prompt:
   
   • Press F3.
   • Press ALT+F4.
   • Click on Exit from the File menu.

Customizing the PC DOS Shell

Before you begin customizing the PC DOS Shell, make sure that the PC DOS Shell is installed on your computer and that you know how to use it.

You can customize the PC DOS Shell in several ways. You can change the screen colors or change the way information is displayed in the PC DOS Shell window. You can also organize your programs into groups and display the groups graphically, making it easier to find and use your programs. When you add a program item to a group, you can further customize the program by creating your own Help text, controlling the memory needed to run the program, and defining application shortcut keys.
Changing Screen Colors

If you have a color display, you can view the PC DOS Shell in color. You have a choice of available color schemes.

To choose a color scheme:

1. From the Options menu, select Colors.
   The Color Scheme window appears.

2. To select the scheme you want, click on the scroll arrows until the color scheme you want comes into view and then click on that color scheme. Or use the UP ARROW or DOWN ARROW to select the color scheme you want.

3. If you want to see what the selected color scheme looks like on your screen, select Preview.

4. Select OK to implement the color scheme.

Switching between Text and Graphics Mode

The appearance of the PC DOS Shell on your screen depends on what type of display adapter you have and the screen mode you are using. A display adapter determines the screen display’s capabilities, such as resolution and screen mode. The screen mode controls the size and shape of the images that appear on your screen.

There are two types of screen modes: text and graphics. All display adapters support text mode, which is the mode the PC DOS Shell uses the first time you start it. Only some display adapters support graphics mode.

Within text or graphics mode, you usually have a choice of how many lines you want displayed. For example, if you choose to view 50 lines instead of 25 lines (the default), you see more information on your screen at once, but the words and symbols appear smaller.
To change the screen mode:

1. From the Options menu, select Display.
   The Screen Display Mode window appears.
2. Select the screen mode you want.
3. If you want to see what the selected screen mode looks like on your screen, select Preview.
4. Select OK to implement the screen mode.
   The PC DOS Shell appears in the screen mode you selected.

Changing the PC DOS Shell View

The PC DOS Shell view used so far has three or four areas: a directory area, a files area, a program area, and if the Swapper is enabled, an active task list area. You can change this display with the View menu options. Each display choice is called a view. Five possible view choices are available.

The View menu shows the possible view choices:

**The Program/File Lists View**

The default view is Program/File Lists. This view lists directories and files at the top of the screen and programs at the bottom of the screen. The current view choice appears gray or dim on the View menu because you cannot change the view to the current view. Program/File Lists is the most common view because it permits you to work with both files and programs at the same time.
The Dual File Lists View
The Dual File Lists view makes it easier when you want to copy or move files. You can display two directories on the same disk or on different disks at the same time.

The Single File List View
The Single File List view is good for when you want to look at a large group of files. With this view, you can see the entire directory tree and many more files in the DOS directory.
The All Files View
The All Files view lists every file on the disk, in alphabetical order, regardless of the directory. The All Files view is good for when you are trying to locate a specific file or looking for duplicate file names in different directories.

The Program List View
The Program List view is useful if you are using a long list of programs and they do not all fit in the program area with the Program/File Lists view. The Program List view is also a useful tool in setting up your system; you do not have to directly access directories.
Organizing Programs

You can organize programs into program groups to suit your needs. When you create a program group, you give it a title, which appears in the program list. In the default view, Program/File Lists, the program list appears in the lower-left corner of the PC DOS Shell window. To work with a group, you choose its title.

Adding and Deleting Groups

You can add groups to the Main group, the Disk Utilities group, or a group you have created. For example, you might use three programs to keep track of your finances—one to maintain your checkbook, one to estimate taxes, and one to track your monthly bills. You might add a group named Accounts and put these account programs into it.

When you create a group, you must give it a title. You can also give it a password that a user must know to view the group, and a Help message that provides information on the group and its program items.

To add a group:

1. Make sure you have selected Program/File Lists on the View menu.
   Whatever is currently selected appears greyed out. If the mnemonic character for Program/File Lists is highlighted or underscored, then type F to select.

2. Press TAB to move to the program-list area of your screen. Or click anywhere inside the program-list area.

3. If the group to which you want to add the new group is not open, open it by double-clicking the group name. Or use the UP ARROW or DOWN ARROW key to select the group and then press ENTER.

   For example, double-click on the Disk Utilities group icon under Main, which is the program-list area.

4. From the File menu, select New.
   The New Program Object window appears.

5. Select Program Group.

6. Select OK.
The Add Group window appears.

7. In the Title field, type a title for the new group.

8. If you want the group to have a Help message, type up to 255 characters (including blanks) in the Help Text field.

   For example, you might type a Help message that reads, “Use the programs in this group to perform statistical operations.” When you select this group and press F1, the PC DOS Shell displays the message. The message appears exactly as you have typed it and is formatted to fit in the Help window. If you want a line break to appear in the text, type ^m (a caret followed by the letter M) at the point where you want the new line to start.

9. If you want the group to have a password, type the password in the Password field.

10. Select OK.

To delete a group:

1. Select the group you want to delete.

2. From the File menu, select Delete.

   Or, press DEL.

   The Delete Item window appears.

3. Select OK.

When you delete a group, the PC DOS Shell removes the group name from the program list and deletes the group’s password and Help message.
Changing the Contents of a Group

You can change the contents of a group by adding program items, copying program items from another group, reordering items, and deleting items.

Adding a Program Item

When you add a program item to a group, you give it a title and specify the command that starts the program. In addition to assigning titles and startup commands, you can associate a variety of other information with a program item. For more information, see “Working with Properties” on page 353.

To add a program item to a group:

1. Make sure you have selected Program/File Lists on the View menu.
2. Press TAB to move to the program-list area of your screen. Or click anywhere in the program-list area.
3. If the group to which you want to add the new item is not open, open it by double-clicking the group name. Or, use the UP ARROW or DOWN ARROW key to select the group and then press ENTER.
4. From the File menu, select New. The New Program Object window appears, with New Program Item already selected.
5. Select OK. The Add Program window appears.

6. In the Program Title field, type the program-item title that you want to appear in the program list.
7. In the Commands field, type the startup command, the command that starts the program. If the command is not in the current directory or in a directory specified by the PATH environment variable, or if it is not an internal command, you must include the complete path of the file in the command.

You can include more than one command in this field. For more information about startup commands, see “Specifying a Startup Command” on page 354.
8. Specify optional information you want to associate with the program item. You can specify the following:

- A startup directory, which the PC DOS Shell changes to before starting the program.
- An application shortcut key, which (after you have started a program) you can use to switch to the program from other programs or from the PC DOS Shell.
- Pause after exit, which prompts you to press any key to return to the PC DOS Shell after the program has finished running.
- A password, which will be required before starting the program item. For more information about these options, see “Working with Properties” on page 353.

9. If you want to specify other options, select Advanced.

For information about the options in the Advanced window, see “Specifying Advanced Properties” on page 360.

10. Select OK. If you select Advanced, you return to the Add Program window when you select OK. You must then select OK in that field, also.

**Copying a Program Item to Another Group**

To copy a program item to another group, you select Copy. For example, if you have an spreadsheet program item in your Account group, you can also put it in your Tax group. You can copy a program item to as many groups as you like.

**To copy a program item from one group to another:**

1. Select the program item you want to copy.
2. From the File menu, select Copy. Instructions appear in the status bar.
3. Open the group you want to copy the program item to.
4. If the group you are copying to has a password, type the password when the Password window appears and select OK.
5. Press F2.
Reordering Items in a Group
To move a program item or group title from one position in a group to another, use the REORDER command.

To reposition a program item or group title:
1. Select the program item or group title you want to reposition.
2. From the File menu, select Reorder. Instructions appear in the status bar.
3. Double-click on the new location.
   Or move the selection cursor to the new location, and then press ENTER.
   The selected program item or group title moves to the new location.

Deleting a Program Item from a Group
You can delete a program item that you no longer need. Deleting a program item from a group does not delete the program file from the directory that contains it.

To delete a program item from a group:
1. Select the program item you want to delete.
2. From the File menu, select Delete.
   Or, press DEL.
   The Delete Item window appears.
   If the program item has a password associated with it, you will see a warning message, but you can still delete the program item.
3. Select OK.
Working with Properties

A property is a piece of information that you associate with a program item. You can specify numerous properties for each program item.

The following two properties are required:

- Program-item title
- Startup command

These properties are optional:

- Startup directory
- Application shortcut key
- Pause after exit
- Password
- Additional advanced properties

For information about creating program items, see “Adding a Program Item” on page 350.

After you create a program item, you can change its properties by using the PROPERTIES command.

To change the properties of a program item:

1. Select the program item.
2. From the File menu, select Properties.
   If the program item has a password, the Password window appears. Type the password, and select OK.
   The Program Item Properties window appears. The Program Title field and the Commands field show the properties that have been specified for the program item you selected, along with any optional properties.
The Program Item Properties window is the same as the Add Program window, which is displayed when you create a program item.

3. Type the information for the properties you want to change.
4. Select OK.

**Specifying a Startup Command**

When you create a program item, you must type a startup command in the Commands field of the Add Program window. If the command is not in the current directory or in a directory specified by the PATH environment variable, or if it is not an internal command, you must include the complete path of the program file. For example, if you are creating a program item named WordPerfect and the path for WordPerfect is C:\WP\WP.EXE, you would type that path in the Commands field.

You can also specify additional commands, run batch programs, and include replaceable parameters for the program. The following sections describe how to include these options.

**Specifying Additional Commands**

PC DOS Shell carries out each command in the order it appears in the Commands field. Each command must be separated by a semicolon (;). There must be one or more spaces on each side of the semicolon. Text in the Commands field cannot exceed 255 characters.

For example, suppose you want to put an abbreviated list of the files in a directory into a text file, load the file into your text editor, edit the file, save it under a different name, and delete the original file when you are finished. If you are using the E Editor, your startup command might look like this:

```
dir /b > tmp.txt ; c:\dos\e.exe tmp.txt ; del tmp.txt
```

In this example, the PC DOS Shell first stores the names of files in the current directory in a file named TMP.TXT. Then it runs the E Editor, loading the TMP.TXT file. When you quit the E Editor, the TMP.TXT file is deleted, and you return to the PC DOS Shell.

**Running Batch Programs in a Startup Command**

You can run batch programs by including CALL commands in the startup command. For example, suppose you want to run a batch program named PREP.BAT before you start WordPerfect, and one called POST.BAT after you quit WordPerfect. You would type the following in the Commands field:

```
call prep ; wp ; call post
```
For information about batch programs, see Chapter 7, "Working with Batch Programs" on page 97.

Using Replaceable Parameters
A parameter is additional information you give a program when you start it. For example, when you start E Editor from PC DOS Shell, the File to Edit window appears. You can specify a filename in the Text field. If you type recipes.txt, for example, E Editor loads the file RECIPES.TXT as soon as it starts.

Many programs accept parameters in this manner. If the program item you add to a program group accepts parameters, you can include these parameters in the Commands field.

If you want to be able to specify a different parameter whenever you run the program item, you can put a replaceable parameter in the Commands field. Each time you select the program item, PC DOS Shell displays a window that prompts you to fill in the value for the replaceable parameter before the program starts.

In the Commands field, you indicate a replaceable parameter with the percent sign (%) followed by a numeral (1 through 9). For example, if you want the PC DOS Shell to prompt you for a filename when you start WordPerfect, you might type the following in the Commands field:

```
c:\wp\wp.exe %1
```

The %1 in this example indicates that you want the PC DOS Shell to prompt you to type a value in place of %1 every time you select the program item for WordPerfect. The PC DOS Shell will prompt you by displaying a prompt window.

To include a replaceable parameter in a startup command:

1. Select the program item.
2. From the File menu, select Properties
   - If the program item has a password, the Password window appears. Type the password and select OK.
   - The Program Item Properties window appears.
3. In the Commands field, specify the command and indicate the replaceable parameters by typing a percent sign (%) followed by a numeral (1 through 9) for each.
4. Select OK.
A Program Item Properties or Add Program window appears for each replaceable parameter you have specified.

The information you type in this window will create a customized window for the program item that you are adding or changing.

Type the information that you want to appear in the window. Each time you select the program item, PC DOS Shell displays the information you have typed.

The Window Title you supply will appear at the top of the window. The Program Information you supply will appear under the title. You can type up to 106 characters in the Program Information field. The Prompt Message you specify will appear to the left of the field where you specify the parameter value.

If you specify a value in the Default Parameters field, the value will appear in the prompt window. You can accept the default parameter or change it. Specify a default parameter value if you plan to use that value frequently when you run the program. For example, if you are working on a project that often requires you to use a particular document, you might type that document’s name as the default parameter for a text editor.

There are two special parameters that you can use in the Default Parameters field to automatically set a default parameter. The %f parameter (a percent sign followed by the letter f) sets the default filename to the filename currently selected in the file list. The %l parameter (a percent sign followed by the letter L) sets the default parameter to the parameter that was specified the last time the program item was run.
If you want the PC DOS Shell to prompt you for a file to load when you start a text editor, you can specify values such as the following in the Program Item Properties window:

![IBM AntiVirus/DOS](image)

Each time you select the program item, the PC DOS Shell will prompt you with a prompt window.

**Using the Same Replaceable Parameter More Than Once:** You can use the same replaceable parameter more than once in a Commands field. For example, suppose you create files by using WordPerfect, and you store them in C:\EDIT\WP. Suppose that as you create these files, you always back them up on a disk in drive A. To load a file into WordPerfect and then back up the file (onto a disk in drive A) after you have edited it, you would type the following in the Commands field:

```
c:\edit\wp\wp.exe %1 ; copy %1 a:
```

**Using More Than One Replaceable Parameter:** You can include up to nine different replaceable parameters in the Commands field. For example, suppose you want the PC DOS Shell to prompt you for a file to load with WordPerfect and for a backup directory to copy the file to when you finish editing. You would include two different replaceable parameters in the Commands field, as in the following example:

```
c:\wp\wp.exe %1 ; copy %1 %2
```

If you add this command in the Commands field, you will be prompted to provide the name of the file you want to edit in addition to the directory to which you want to copy the file. Then you can edit your WordPerfect document.

For each replaceable parameter, the PC DOS Shell prompts you for information to appear in the prompt window, as described previously.
Specifying a Startup Directory
You can specify which directory you want DOS to change to before it starts a program that is in a program group. For example, if you keep budget spreadsheets in a directory named C:\FILES, you need to make sure the PC DOS Shell changes to that directory before starting your spreadsheet program.

To specify a startup directory:
1. Select the program item whose properties you want to change.
2. From the File menu, select Properties.
   The Program Item Properties window appears.
3. In the Startup Directory field, type the drive and path of the directory you want the PC DOS Shell to change to before it starts the program, as in the following example:

Specifying an Application Shortcut Key
If you have started a program but are not currently working with it, you can use a key combination to switch quickly to it from another program or from the PC DOS Shell. The shortcut key must have the form CTRL+character, SHIFT+character, or ALT+character, where character is a letter, number, or function key on your keyboard. Exceptions are noted in the following section, “Reserved Combination Keys” on page 359. You can use any combination of the CTRL, SHIFT, and ALT keys with the character.

To specify an application shortcut key:
1. Select the program item you want.
2. From the File menu, select Properties.
   The Program Item Properties window appears.
3. In the Application Shortcut Key field, specify the key combination by pressing and holding down CTRL, SHIFT, or ALT, and then pressing a character.

For example, suppose you have a program item named My Editor in the Main group and that you have enabled Task Swapper. You could assign CTRL+E as the shortcut key for My Editor. If My Editor is on the Active Task List, you can press CTRL+E to switch back to it from another program or from the PC DOS Shell.

The name of the shortcut key will appear next to the program-item title in the Active Task List.
Reserved Combination Keys
The following key combinations are reserved and are not available as application shortcut keys:

<table>
<thead>
<tr>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+M</td>
</tr>
<tr>
<td>CTRL+I</td>
</tr>
<tr>
<td>CTRL+H</td>
</tr>
<tr>
<td>CTRL+C</td>
</tr>
<tr>
<td>CTRL+[</td>
</tr>
<tr>
<td>CTRL+5 (on the keypad)</td>
</tr>
<tr>
<td>SHIFT+CTRL+M</td>
</tr>
<tr>
<td>SHIFT+CTRL+I</td>
</tr>
<tr>
<td>SHIFT+CTRL+H</td>
</tr>
<tr>
<td>SHIFT+CTRL+C</td>
</tr>
<tr>
<td>SHIFT+CTRL+[</td>
</tr>
<tr>
<td>SHIFT+CTRL+5 (on the keypad)</td>
</tr>
</tbody>
</table>

Specifying Whether to Pause After a Program Ends
You can specify whether the PC DOS Shell should pause after you quit a program that is in a program group. By default, the PC DOS Shell prompts you to press a key to return to the PC DOS Shell after you quit such a program.

To eliminate the pause after you quit a program:
1. Select the program item you want.
2. From the File menu, select Properties
   The Program Item Properties window appears.
3. Clear the Pause After Exit option by clicking on the "X".
   Or, press TAB until you select the option, and then press the SPACEBAR to clear it.
4. Select OK.

Specifying a Password
If you want the PC DOS Shell to prompt you for a password before it starts a program item, you can specify the password in the Program Item Properties window.

To specify a password for a program item:
1. Select the program item.
2. From the File menu, select Properties
   You see the Program Item Properties window.
3. In the Password field, type the password you want.
4. Select OK.
Specifying Advanced Properties
When you select Advanced in the Add Program or Program Item Properties window, another window appears in which you can specify additional properties. The Advanced window looks like this:

![Advanced Properties Window]

Adding Help Text
You can add a Help message of up to 255 characters to any program item. This Help message is displayed if you press F1 when the program item is selected. The PC DOS Shell displays the message exactly as you have typed it and formats it to fit in a Help window. If you want to begin a new line of text, type ^m (a caret followed by the letter M) at the point where you want the new line to start.

If you do not want the program item to have a Help message, leave the Help Text field blank.

Specifying Conventional Memory
Use the Conventional Memory KB Required field to specify how many kilobytes of conventional memory must be free in order to start a program. This property is useful for programs with specific memory requirements.

Regardless of what you type in the Conventional Memory KB Required field, when you start a program, the PC DOS Shell gives it all available conventional memory. The number you type in this field determines how much memory must be available before the PC DOS Shell starts the program; it does not limit how much conventional memory the program receives.

If the PC DOS Shell cannot provide as much memory as you specify, a message appears, telling you there is not enough memory to run the program.

If Task Swapper is not enabled, the PC DOS Shell ignores any conventional memory specification.
Specifying Extended Memory
Use the XMS Memory options to specify how much extended memory to give to a program that uses memory according to the Lotus/Intel/Microsoft/AST Extended Memory Specification (XMS) standard. If Task Swapper is not enabled, the XMS memory specifications are ignored.

A description of each XMS Memory option follows. Before using these options, you must have extended memory set up on your system. For more information, see the discussion about extended memory in Chapter 13, "Making More Memory Available" on page 205.

**KB Required**  Specifies how many kilobytes of extended memory must be free in order to run a program.

Leave this setting blank for most programs. Specifying a value significantly increases the time it takes to switch to and from a program. Specify a value only if a program requires a certain amount of extended memory in order to run.

If you run a program that requires extended memory, and the PC DOS Shell cannot provide as much memory as you specify, a message appears when you try to start the program, telling you there is not enough memory. However, if Task Swapper is not enabled, the memory specification is ignored.

**KB Limit**  Specifies the maximum amount (in kilobytes) of extended memory that the PC DOS Shell can give to a program.

This option is useful for limiting a program's access to extended memory because some programs take all available extended memory whether they need it or not. If Task Swapper is not enabled, the KB Limit specification is ignored.

Leave this setting blank to prevent a program from gaining access to any extended memory.

Setting this option to -1 gives the program all the extended memory it requests (up to the maximum amount available). Set this option to -1 only if the program requires large amounts of extended memory.

Using Video Mode
Video Mode has two options: text and graphics. Use text mode unless you are having trouble switching to a program.

Usually the memory reserved by text mode is enough, but you might need more memory if you are using a CGA monitor. Graphics mode requires more memory than text mode. Use text mode for all program items if you have a high-resolution graphics (VGA or EGA) monitor or a monochrome monitor.
Reserving Shortcut Keys
Use the Reserve Shortcut Keys option when you want a program to use shortcut keys typically used by Task Swapper (ALT+TAB, ALT+ESC, and CTRL+ESC). If you want to reserve a shortcut key for a program, select it in the Reserved Shortcut Keys area of the Advanced window.

For example, suppose you have a text editor that typically uses the ALT+TAB shortcut key to insert a special character. If you want to maintain that function while your text editor is running under PC DOS Shell, you need to select the shortcut key for the program. When you select this key, it is no longer reserved for the PC DOS Shell.

Preventing Program Switching
If you want to prevent a program from switching to another program or to the PC DOS Shell, select the Prevent Program Switch option from the Advanced window. If you select this option, you must quit the program to return to the PC DOS Shell.

Changing Group Properties
A program group must have a title associated with it. It can also have Help text and a password. You can change any of these properties for all groups except the Main group.

To change group properties:
1. Select the appropriate group.
2. From the File menu, select Properties
   
   If the group has a password, the Password window appears. Type the password and select OK.

   The Program Group Properties window appears.

3. Change the title, Help text, or password.
4. Select OK.
Chapter 19. Using IBM AntiVirus/DOS

IBM AntiVirus/DOS (AntiVirus) is a comprehensive antivirus product for DOS and Windows systems. It is designed to detect and remove viruses from your system. It can detect as many as 2,100 different types of viruses.

This chapter will help you understand viruses. It explains how to protect your computer data from viruses and describes how to install and use AntiVirus.

AntiVirus offers two kinds of automated protection. When you install AntiVirus, Automated check and Shield DOS are installed. If you want to turn off these features, refer to "Customizing AntiVirus" on page 372.

**Automated check** checks your fixed disks for viruses whenever you start your system. When Automated check detects a virus, you are given the opportunity to examine your system thoroughly to find every instance of the virus and to remove it.

**Shield DOS** checks DOS memory for viruses when you start DOS and monitors programs as you run them. If Shield DOS detects a virus when you start DOS, you are notified, and the virus is disabled. If a virus is detected when you are running a program, you are notified and the virus is prevented from becoming active or spreading. When the program is no longer infected, you can use the program without further spreading of the virus.

**Note:** After a virus has been detected, it is very important to run AntiVirus to check your entire system for viruses as soon as possible.

Some common viruses destroy programs, so it is not possible to disinfect them reliably. Such programs, including AntiVirus, do not function correctly and must be reinstalled when they become corrupted. Keeping the DOS shield installed at all times helps prevent this from happening.

### Installing IBM AntiVirus/DOS after Installing PC DOS

If you did not choose antivirus protection at initial installation, you can still install IBM AntiVirus/DOS by rerunning DOS Setup using the /e switch.

The PC DOS Setup diskettes contain everything you need to install AntiVirus. Refer to Chapter 1, "Installing" on page 3 before you begin.
During Setup, PC DOS checks whether your computer has Windows 3.1 installed. If you do not have Windows 3.1 installed and want to use the optional tools provided with DOS for Windows, you should make sure you install in this order:

1. Install PC DOS as you normally would, selecting the optional tools from the list provided. You will not see any of the optional tools for Windows listed if you do not have Windows 3.1 installed already.

2. After you have installed PC DOS, install Windows 3.1 as you normally would.

3. Install PC DOS again using the Setup /e switch after DOS and Windows have both been installed.

To install IBM AntiVirus/DOS using the Setup /e switch:

1. Insert the Setup Diskette from the PC DOS installation diskettes into drive A or B.

2. At the DOS command prompt, type:
   
   a:setup /e
   
   or
   
   b:setup /e

   The /e switch allows you to return to the optional tools-selection menu without having to do a complete reinstallation. At this point, only the necessary files for the optional tools for Windows will be installed.

3. After Setup begins, follow the instructions displayed on the screen. Make sure you specify the same “Install to Path” as you did when you did the initial PC DOS installation.

   At the Optional Tools screen, you see a NO next to IBM AntiVirus/DOS and IBM AntiVirus/DOS for Windows.

4. Press the UP ARROW or DOWN ARROW until you highlight IBM AntiVirus/DOS.

5. Press ENTER.

   You now see YES next to IBM AntiVirus/DOS.

6. Select other optional tools you want to install at this time, such as IBM AntiVirus/DOS for Windows, by highlighting the name of each optional tool and pressing ENTER for each item.

   If you are using IBM Boot Manager to start various operating systems, have IBM AntiVirus/DOS on each of the DOS and Windows partitions. For DOS, Boot Manager does not allow one bootable partition to access another.
7. Move the cursor to highlight the following:
   Options correct. Continue Setup.

8. Continue to follow the instructions displayed on the screen until the optional tools are installed.

Starting IBM AntiVirus/DOS

AntiVirus has been designed to protect your system automatically. You can also use it to check your system for viruses whenever you want. In addition, AntiVirus provides the following features:

**AntiVirus Defaults:** The defaults for the PC DOS Setup program have been constructed to provide the best protection for your system. PC DOS is set up to run a virus check on the first boot of the week on any new or changed program files. Shield DOS is installed whenever you start (boot) DOS.

**Stand-alone AntiVirus Program:** AntiVirus also includes a stand-alone program. The stand-alone program can be used from a diskette when you cannot access the usual AntiVirus program or start your system due to virus problems on your system. The stand-alone program can be started from a .BAT file or any command prompt after starting your system from a write-protected, virus-free diskette. See “Running the AntiVirus Stand-Alone Program” on page 379 for more information on the stand-alone program.

**Dual Boot Systems:** With Dual Boot systems, you can start either DOS or OS/2 from the same partition. If you want protection under both operating systems, you must have the AntiVirus program installed during PC DOS Setup and you must purchase the IBM AntiVirus/2 program separately for use with OS/2. See the coupon for IBM AntiVirus/DOS and IBM AntiVirus/2 for information about ordering updates for IBM AntiVirus/DOS.

**To start the DOS version of AntiVirus:**

1. Type the following at the DOS command prompt:
   ibmavd

2. Press ENTER.
   You see the main IBM AntiVirus/DOS window.
3. To begin a check for viruses, type P or click on the box in the center of the window where you see Push here. This box remains permanently placed in the center of the main IBM AntiVirus/DOS window.

You can use mnemonic selection with IBM AntiVirus/DOS. Make a selection by typing the single character displayed in a different color or shade on the push button. This single character is known as a *mnemonic* character.

To access the menu bar, you can either:

- Make a selection using a mouse.
- Press F10 and then press ENTER.
- Press ALT followed by the letter shown in a different color on the list of menu choices. For example, to access the Check menu, you would press ALT+C.
The first time you check your system, it will take longer to check for viruses because AntiVirus is building a database that remembers what your files look like. On subsequent checks for viruses, AntiVirus does not have to rebuild this database again; therefore, the time needed to run checks is shortened.

**To start the Windows version of AntiVirus:**

You can start IBM AntiVirus/DOS for use within Windows by double-clicking on the AntiVirus icon located in the PC DOS Tools program group.

You then see the main window for IBM AntiVirus/DOS for Windows.

---

**Protecting Your Computer Data against Viruses**

A computer virus is a program that can "infect" other programs by modifying them to include a (possibly "evolved") copy of itself.

Viruses can spread themselves, without the knowledge or permission of the workstation users, to potentially large numbers of programs on many machines. Viruses can also contain instructions that cause damage or annoyance; the combination of possibly-damaging code with the ability to spread is what makes viruses a considerable concern.

Viruses are not mysterious. They are just computer programs and only do things that programs can do. However, unlike most other programs, they are specifically designed to spread themselves.
Viruses can often spread without any readily visible symptoms. When a virus is started on a workstation, it can run any instructions that its author chooses to include. These instructions can be event-driven effects (for example, triggered after a specific number of executions), time-driven effects (triggered on a specific date, such as Friday the 13th or April 1st), or it can occur at random.

Depending on the motives of the virus author, a virus can contain no intentionally harmful or disruptive instructions. Or, it can cause damage simply by replicating itself and taking up scarce resources, such as hard disk space, CPU time, or network connections.

IBM AntiVirus/DOS has been carefully designed to help you reduce the risk of a virus infecting your computer. AntiVirus examines your system for characteristics of specific viruses or classes of viruses. When it detects something with one of these characteristics, it warns you and tries to clean (remove) the virus.

No program can entirely eliminate the risk of viruses, but there are a few simple things you can do to make sure the risk is reduced:

- Use AntiVirus’ Automated checking and Shield DOS features to detect viruses sooner than you would without these features. Use AntiVirus to check diskettes for viruses before starting or running programs from these diskettes.
- Keep AntiVirus up to date. As new viruses are discovered, AntiVirus will be updated to deal with them. Select Contacts from the Help menu for more information about ordering updates for IBM AntiVirus.
- Keep good backups and update them periodically. In some cases, the only way to clean up a system that has become infected with a virus is to restore it using virus-free backup copies. Check your system using AntiVirus just before you do a backup to help prevent backing up infected files. If you do not currently have a good backup of your system, make one immediately after you install PC DOS.
- Keep your diskettes write-protected whenever possible. Write protecting your diskettes keeps them from becoming infected. Most viruses travel from one computer to another on diskettes. Diskettes become infected when they are used in an infected system and have not been write-protected.
- If possible, prevent executable files on LAN file servers from being modified by client computers. Preventing modifications keeps an infected client computer from infecting the LAN file server and keeps the infection from spreading to other client PCs. The DOS “read-only” attribute does not prevent virus infection.

Your LAN administrator knows how to use the server’s operating system to protect the server files.
Checking for Viruses

You can choose to check for viruses by either:

- Checking your system
- Checking diskettes

Checking Your System

Normally, Automated check verifies whether your system has any viruses when your computer is restarted. However, you can check your system whenever you want.

To check your system:

1. Select Push here on the main AntiVirus window.

   AntiVirus checks boot sectors (including Boot Manager boot sectors) and files on your system for known viruses and for changes that might indicate the presence of an unknown virus. Network drives (on LAN servers) and local drives also can be checked.

2. If a virus is detected, a thorough examination of your system will be done to find every instance of the virus, and you will be given the opportunity to remove them.

Checking Diskettes

It is a good idea to check diskettes for viruses before starting (booting) from them or before running programs from them.

To check a diskette:

1. From the Check menu, select Check diskettes

   The following illustration shows the Check diskettes window.
Boot sectors and files on diskettes in the selected diskette drive are checked for viruses.

2. Select Execute after all selections have been made.

3. When a virus is detected, you are given the opportunity to remove it from the diskette.

Checking Compressed Files

Many people use compression software to store individual program files and data files. This software reduces the amount of disk space required to store a file and reduces the amount of time required to transmit it via modem. Some programs are distributed in compressed form and decompressed automatically before they are run. Because compression changes the contents of the file, it also inhibits scanning software from examining the byte patterns within the original, decompressed file to see if they match any known viruses.

IBM AntiVirus/DOS determines if individual compressed files have changed suspiciously but will not usually be able to search them properly for known viruses. To search them properly, decompress the files before you check your system.

IBM AntiVirus/DOS will properly check disks that have been compressed with disk compression software, such as Stac's Stacker compression program, as long as the disk compression software is currently active.

** Stac and Stacker are trademarks of Stac Corporation.
Shield DOS detects and deactivates any of the viruses it knows about if you run an infected program—no matter what compression technique is used to store the program file.

**Reviewing Logs**

AntiVirus logs its activities so you can review them later. These logs contain information about when your system was checked, what files were checked, and whether any viruses were detected.

The log from your current session of AntiVirus is stored in the file CURRENT.LOG. The log from your previous session is stored in PREVIOUS.LOG. A cumulative log that briefly summarizes the results of any automated checks is stored in CUM.LOG. All these log files are stored in the \DOS directory. These files can be printed directly to your printer.

An entry is added to the cumulative log each time AntiVirus does an automated check. It does not record checks you do manually. You can edit or erase this cumulative log file if it grows too large.
Customizing AntiVirus

You can customize the automated checking, the DOS shield, diskette checking, and system checking features of IBM AntiVirus/DOS.

The default settings for AntiVirus have been designed to do the right thing for most systems. Use the default settings unless you have a specific reason for preferring another setting.

Customizing Automated Protection

To customize Automated check:

1. From the Setup menu, select Automated check.

2. Specify Automated check to be done either periodically or whenever you start your system. Then, select Save settings.

3. Select Check options on the Automated check window to specify which drives to check, what kinds of files to check, and whether to check only new or changed files or to even check unchanged files. Then, select Save settings.
For Automated check to work, set it for any option except the Never option.

Select Help from the Automated check window for more information on specific options, such as Advanced options.

**To customize Shield DOS:**

1. From the Setup menu, select Shield DOS.
2. Check (or uncheck) the Install shield check box on the Shield DOS window, and then select OK.

If you check Install shield, the shielding program will be loaded whenever DOS is started in the future, and the DOS memory space will be checked for resident viruses. Subsequently, the shielding program monitors for indications of activity from common DOS viruses. If viral activity is found, you will see a warning. The virus is not allowed to become active or to spread.

or

If you do not want to install Shield DOS, uncheck the check box on the Shield DOS window to prevent shielding from being installed when you run DOS.

3. Check (or uncheck) the Check high memory option, and then select OK.

Normally, IBM AntiVirus/DOS checks high memory (memory above the 640K DOS limit) for resident viruses. This check might cause problems on some systems, especially where hardware adapters are sensitive to having their memory space read. Refer to page 298 for more information.

For more information on customizing Shield DOS, select Help from the Shield DOS window.

**Customizing Diskette Checking**

To customize the way diskette checking is done:

1. From the Check menu, select Check diskettes.

   The Check diskettes window lets you specify which drive to check and whether to check all files or only program files.

2. Select Save settings to save changes when you have completed the changes you want.

   Select Help from the Check diskettes window for more information on specific options.

**Customizing System Checking**

You can choose to check the system at times other than when scheduled for automated checking.

To check the system at any time:

1. Select Push here on the main AntiVirus window.

2. From the Check menu, select Check system to customize the way in which this checking is done.
The Check system window lets you specify which drives to check, what kinds of files to check, and whether to check new and changed files, or all files. Other combinations of disks, directories, and files can be checked by selecting Advanced Options.

3. Select Save settings to save any changes after resetting to the new options.

Select Help from the Check system window for more information on specific options.
Cleaning Up When a Virus Is Detected

When a virus is detected during a check of your system, you are given the opportunity to clean up any infected files or boot sectors that have been detected so far. However, cleaning up a virus infection does not stop there. It is likely that your check examined only some of the files on your system—those in which viruses are most likely to be detected. It is possible that the virus has also infected other parts of your system. If you clean up only the infection you have detected so far, the infection you did not detect can continue to spread within your system and perhaps to other systems as well.

Whenever a routine check turns up a virus, AntiVirus provides an opportunity to perform a thorough check of your entire system and to let you clean up any viruses detected. This thorough check can take more time than your routine check, but it helps ensure that you have thoroughly cleaned your system. Let AntiVirus complete this thorough check anytime you encounter a virus.

Infected Systems

When AntiVirus finds a virus on your system, the virus infection report presents choices on how to remove the virus. Viruses whose identity can be positively verified can usually be disinfected, thereby restoring the infected files or boot sectors to their original, uninfected condition. AntiVirus is designed so that all common viruses can be reliably repaired this way.

Some viruses damage files or boot sectors when they infect them. In this case, AntiVirus does not disinfect them because you would be left with damaged programs afterwards. You are cautioned that they might not be disinfected.

AntiVirus can deal with hundreds of infected objects at one time. In the unlikely event that there are too many infected objects to deal with, you are presented with a series of virus infection reports. After you have dealt with one set of infected objects, the next set is displayed.

Infected Diskettes

The virus you detected on your system came from somewhere and might have spread beyond your system as well. If it was a boot sector virus, it infected your system when the system was started from an infected diskette. If it was a file-infecting virus, it infected your system when an infected program was executed or copied from a diskette or file server. In either case, the virus might have spread to the diskettes used in your system, if your diskettes were not write-protected.
After an infection is detected, it is very important to check for viruses on the diskettes that were used recently in the infected systems. If you do not check, the virus might reinfect your system or might spread to other systems.

To check diskettes for viruses, see "Checking Diskettes" on page 369.

**Infected Nearby Systems**

When you share diskettes with other systems and use file servers on local area networks, infections can be passed between systems. The virus that infected your system might have come from one of these types of systems. It is very important to notify the users of these other systems and to make sure they also check their systems for viruses. You cannot eliminate this step in the antivirus procedure or the virus continues to spread from their systems, reinfects your system again, and continues to infect other systems.

If you find a virus on your own system and your system is connected to a file server, it is very important to check that file server thoroughly for viruses. If any viruses are detected on the server, all the client PCs that use that server must be checked as well.

Even if your system is not connected to a file server, nearby systems should be checked for viruses because you might have exchanged diskettes with them recently. This includes all the other systems in your office or laboratory, systems that belong to your friends, systems in your department or related departments, and systems belonging to people located near you.

Ideally, all these other systems also have AntiVirus installed on them. In this case, the users of these systems can have AntiVirus check their systems. If AntiVirus is not installed, you can use the AntiVirus stand-alone program to check them.

**Uncommon Viruses**

Although it is unlikely to happen, your system can be infected with a new or very uncommon virus that AntiVirus cannot positively verify.

Infected files or boot sectors that cannot be disinfected reliably, either because the virus could not be positively verified or because the virus damaged them, should be erased/replaced. AntiVirus overwrites and erases infected files, so they cannot be restored accidentally.
Names of files you erase are written to the log to help you to restore them from backups, if necessary. You can view any of these logs:

- Current log
- Previous log
- Cumulative log

Select the log you want to view from the Log menu.

Information about the current log, the previous log, and the cumulative log is stored in the files CURRENT.LOG, PREVIOUS.LOG, and the CUM.LOG, respectively, located in your \DOS directory. These are text files that can be printed directly to your printer.

Erasing/replacing the master boot record of a hard disk is required to replace it with a valid master boot record. This is almost always the right thing to do. The only exceptions are when the disk has an unusual master boot record, like those used by some DOS security products. In these cases, erasing/replacing the master boot record can leave the system in an unusable state. Contact the vendor of the security product for assistance before trying to remove an unverified virus from these systems.

System boot sectors infected with unverified viruses cannot be repaired automatically because their structure depends upon the operating system and version you are using, including Boot Manager boot sectors. In this case, use the DOS SYS command to replace an infected system boot sector. If you need information about the SYS command, type help sys at the DOS command prompt.
Be sure you start your system from a DOS diskette that:

- Is the same version that your hard disk uses.
- Has been checked and is free of viruses.
- Is write-protected at all times.

Start your system by turning off the power, inserting the DOS diskette in drive A and turning on the power. Do not use CTRL+ALT+DEL to start your system. Some viruses can remain active in your system if you use CTRL+ALT+DEL. Issue the SYS command to replace the system boot sector. Then, restart and use AntiVirus to check your system for viruses once more, just in case.

### Running the AntiVirus Stand-Alone Program

A system can be so corrupted by a virus that it is not possible to run the usual version of AntiVirus. In some cases, it can be so corrupted that it cannot even be started. In these situations, you should use the AntiVirus stand-alone program to clean up your system. This program can be run from:

- A .BAT file, by adding command-line arguments.
- A diskette, after starting your system from a virus-free DOS diskette. Write protect this diskette immediately to prevent it from becoming infected.

The AntiVirus stand-alone program is not intended to be used in place of the standard versions of AntiVirus. It does not have the features of automated operation, heuristic virus detection, or higher performance of the standard versions.

Make a separate emergency diskette by copying the AntiVirus stand-alone program files to a virus-free DOS diskette. Write protect this diskette immediately to prevent it from becoming infected. This AntiVirus stand-alone program can be used to check DOS and Windows systems if you have virus problems that do not allow you to access the IBM AntiVirus/DOS program on your system. The stand-alone program files consist of the following:

- **ADMIN.PRF**
  - Data file for profile information used to record settings in IBM AntiVirus/DOS. Do not change this file.

- **IBMAVSP.EXE**
  - The AntiVirus stand-alone program itself. It can be run directly from a DOS command prompt.

- **LOCAL.MSG**
  - A message that is displayed if a virus is detected.

- **VERV.VDB**
  - Data file used by the stand-alone program to verify the identity of viruses and disinfect them. Do not change this file.

- **VIRSIG.LST**
  - Data file used by the stand-alone program to scan for indications of viruses. Do not change this file.
If you create a batch file as discussed in “Running the Stand-Alone Program from a BATCH File or REXX Program” on page 380, place a copy of this batch file on the diskette also.

**To run the AntiVirus stand-alone program:**

1. Type the following from the drive A prompt:
   
   ibmavsp

2. When you use the AntiVirus stand-alone program, specify whether to check all local fixed drives for viruses or only selected drives. You can check diskettes by specifying their corresponding drives.

3. You are then asked if you want to check all files on the drive or only program files. Because you already suspect that there are viruses on the system, you should check all files because viruses can infect files that are not normally thought of as program files.

When a virus is detected, you are given the opportunity to remove it.

If AntiVirus can determine that it is safe to disinfect the boot sector or file, you will be given the opportunity to do so. Otherwise, you are asked if you want to have the file erased or the boot sector replaced. Respond in one of three ways:

- **Yes** To perform the operation on this file or boot sector.
- **No** To skip this file or boot sector. It remains infected. It is important not to do this, because the infection can continue to spread.
- **Go** To perform the operation on this file or boot sector and perform it without asking about any others that are detected to be infected. Use this option if there are many infected files and you do not wish to respond to them individually.

**Running the Stand-Alone Program from a BATCH File or REXX Program**

You might prefer to run the AntiVirus stand-alone program interactively as outlined previously. However, because the stand-alone program is a utility that protects your system, you can incorporate this program into a batch file or REXX program so that it monitors for viruses automatically.

If you use this stand-alone program in .BAT files, you are able to specify command-line options. For example, to scan all programs on all local hard drives and place the log into the file IBMASVP.LOG on drive C, you would type the following command:

```
c:\dos\ibmavsp * -programs -logc:\ibmavsp.log
```
This method of operation is useful in .BAT files and whenever user interaction is not desired.

Type ibmavsp /? for more information about the IBMAVSP command.

**Using the AntiVirus Stand-Alone Program on an Infected System**

Starting from an infected diskette or hard disk can cause the virus to become active and to spread. Some viruses remain active even after restarting with CTRL+ALT+DEL.

**To start an infected machine safely:**

1. Turn off the computer's power.
2. Insert a write-protected DOS diskette that has been checked and is free of viruses into drive A. Make sure the diskette is write-protected or you might infect it accidentally.
3. Turn on the computer's power. Let it run from the diskette.
4. After the computer has started, type:
   
   ibmavsp

   at the DOS command prompt to run the AntiVirus stand-alone program and check the system for viruses.

**Systems that Use Resident Data Compression**

Some systems use resident data-compression software to allow them to store more data on the hard disks. This software operates by intercepting reads and writes to the disk, compressing data as it is written, and uncompressing it as it is read back. Although the data is stored in compressed form on the disk, most programs only see it in uncompressed form.

If you start from a diskette, you might not have the necessary software resident to access the compressed data correctly. In particular, the AntiVirus stand-alone program might not be able to correctly check or repair your disk, if you have started such a system from a diskette.

In these cases, consult the product documentation for your data compression software to determine proper operation after starting from a diskette, or contact the data compression software vendor for assistance.
Systems that Use Security Software

Some systems use security software that is designed to prevent unauthorized users from accessing individual files, disks, or the entire system. In some cases, this software modifies the hard disk so that it cannot be accessed without going through the security software. In particular, such disks might not be able to be accessed correctly when your system is started from a diskette. This can cause the AntiVirus stand-alone program to be unable to check or repair your disk, if you started from a diskette.

In these cases, consult the product documentation for your security software to determine proper operation after starting from a diskette, or contact the security software vendor for assistance.

Troubleshooting IBM AntiVirus/DOS

For troubleshooting tips or procedures for some of the most common IBM AntiVirus/DOS problems, refer to “AntiVirus” on page 297.
Chapter 20. Using Central Point Backup

The Central Point Backup** program (CPBackup) provides protection against data loss by allowing you to make a backup copy of data. This backed up copy ensures that you can restore data quickly if the need ever arises. With CPBackup, you can do the following:

- Back up an entire disk, specific files and directories, or only files that have changed since your last backup. The backup can be processed to diskettes, tape, hard disk, or a network volume.

- Compare data on your backup media to your original hard disk data to ensure that the data is restorable.

- Restore your entire backup or only selected files and directories. The restoration can be done on the computer you backed up from or to a different computer.

- Back up your data to a network directory.

Installing Central Point Backup after Installing PC DOS

If you did not select Central Point Backup for DOS or Central Point Backup for Windows at initial installation, you can still install these optional tools by rerunning DOS Setup.

The PC DOS installation diskettes contain everything you need to install Central Point Backup on your system.

During Setup, PC DOS checks whether your computer has Windows 3.1 installed. If you do not have Windows 3.1 installed and want to use the optional tools provided with DOS for Windows, you should make sure you install in this order:

1. Install PC DOS as you normally would, selecting the optional tools you want from the list provided. You will not see any of the optional tools for Windows listed.

2. After you have installed PC DOS, install Windows 3.1 as you normally would.

3. Install PC DOS again using the /e switch after DOS and Windows have been installed.

** Central Point Backup is a trademark of Central Point Software, Inc.

© Copyright IBM Corp. 1981, 1995
To install Central Point Backup using the Setup /e switch:

1. Insert the Setup Diskette of the PC DOS Setup diskettes into drive A or B.

2. At the DOS command prompt, type:

   a:setup /e  

   or  

   b:setup /e

   The /e switch allows you to return to the optional tools selection menu without having to do a complete reinstallation of PC DOS. At this point, only the necessary files for the optional tools are installed.

3. After Setup begins, follow the instructions displayed on the screen. Make sure you specify the same “Install to Path” as you did when you did the initial PC DOS installation.

   At the Optional Tools screen, you will see NO next to Central Point Backup.

4. Press the UP ARROW or DOWN ARROW until you highlight Central Point Backup.

   You can also select any of the other optional tools, such as Central Point Backup for Windows, that you want to install by highlighting each tool and then pressing ENTER for each item.

   You now see YES next to all the optional tools you selected.

5. Move the cursor to highlight the following:

   Options correct. Continue Setup.

6. Press ENTER to accept the optional tool selections.

7. Continue following the instructions on the screen until the optional tools are installed.

Configuring Central Point Backup

The following procedure assumes you already have Central Point Backup installed on your computer by using the PC DOS Setup diskettes. See “Installing Central Point Backup after Installing PC DOS” on page 383 if the program is not installed. During configuration, the program guides you through the process and saves your choices in a file called CPBACKUP.CFG.
To start configuring CPBackup from the DOS command prompt:

Type cpbackup and press ENTER.

The first time you use CPBackup, a Welcome screen is displayed. Each subsequent time, a selection screen is displayed, allowing you to specify:

- Backup
- Restore
- Compare

To start configuring CPBackup from PC DOS Shell:

If available in your Main program group of PC DOS Shell, double-click on Central Point Backup if you are using a mouse. Or, if you are using a keyboard, press TAB until you highlight Main. Use the UP ARROW or DOWN ARROW to highlight Central Point Backup, and then press ENTER.

If Central Point Backup is not available in your Main program group of PC DOS Shell, refer to “Adding a Program Item” on page 350 for information on how to add programs to the PC DOS Shell.

To start configuring Central Point Backup for Windows:

You can start Central Point Backup for Windows by double-clicking on the Central Point Backup icon located in the PC DOS Tools program group.

The first time you use CPBackup, you must configure the program to work optimally with your system.

You start with a Welcome screen and proceed to specify the following:

- Type of tape drive (none, QIC 40/80-FDC, or SCSI)

  SCSI is defined as Small Computer System Interface and FDC is defined as Floppy DISK Controller.

  To configure a SCSI tape drive, insert a tape cartridge into your SCSI tape drive before configuring. This allows CPBackup to determine the size of the tape you use.
• Equipment
  Based on previous selections, you are given a choice of hardware options available for performing the backup.

• Drive and media type
  
  Drive type is the physical type of disk drive (hardware) in your computer. Media type is the diskette or tape you use for the backup.

Whenever you need help, press F1.

Performing the Confidence Test

After designating the configuration of the system you use for your backups, CPBackup determines whether a confidence test is needed. When the backup media is a tape or floppy drive, a confidence test is requested; when backing up files to the hard disk, a test is not needed.

CPBackup tests your computer for the speed setting that gives you the best performance and reliability. This eliminates guessing whether your computer supports high-speed backups. Run this test on every computer, especially if you change the system environment in any way (such as adding or removing drives or using different media). That way, you can be sure that CPBackup always works with your current configuration.

To skip the confidence test, select Skip on the Backup Confidence Test screen. CPBackup sets the speed to High automatically.

Warning: Skipping the confidence test can result in unreliable backups.

Understanding the Results of the Confidence Test

CPBackup always tests your system at high speed first. If the test fails, it repeats automatically at medium speed. However, at times, some computers fail the high-speed test in such a way that prevents testing at medium speed.
To change the Backup Speed if your computer fails the high-speed setting:

1. Turn your computer off and then back on to reset the hardware.
2. Type `cpbackup` at the DOS command prompt.
3. Select Backup Speed from the Configure menu.
4. Select Medium.
5. Select OK.
6. Select several files to back up for the test.
7. Select Start Backup.
   
   When the test is complete, a message window informs you of the results. The backup speed is set automatically to the fastest speed as determined by the test.

8. Select Compare when the backup is complete.
   
   If all files compare, your computer can do safe, reliable backups at the chosen speed.
9. Select Save as Default from the File menu to save the new information.

The confidence test checks only the drive and media you selected. If you change the drive or media you use for backing up, test the new drive and media combination. Some systems can run at high speed with one type of media but might need to use medium or low speed with other media to be reliable.

If you have difficulties with the confidence test during the initial configuration process and have since corrected the problem, you can run the test again by selecting choices from the Configure menu.

To rerun the confidence test:

1. Select Choose Drive and Media from the Configure menu and select a setting.
2. Select Backup Speed from the Configure menu.
3. Select Test.
4. Select OK when the test is complete.
5. Select Save as Default from the File menu to save the new information.
Viewing the Main Central Point Backup Window

After you have configured CPBackup, the next time you load CPBackup, the main Central Point Backup window appears.

Central Point Backup has an extensive online help facility for your use. If at any time you need help, press F1.

When you select Backup, Restore, or Compare from the main Central Point Backup window, the following Express window appears:
CPBackup defaults to this Express Window. This *Express feature* simplifies your backup, compare, or restore procedures with a simple “point-and-click” interface.

Buttons let you perform certain menu options quickly. All of the button commands also appear on the menus. At the Beginner and Intermediate user levels, some of these buttons are *dimmed*, meaning the default value is used and cannot be changed.

### Changing the User Level

If you want to change the user level from Advanced user, use the following procedure. The default user level is Advanced.

**To change the user level:**

1. Select *User Level* from the Configure menu.
2. Select the level you want.

**Beginner:** If you are not concerned with options you are not familiar with or just want to do a backup as easily as possible, use the Beginner level. Central Point Backup automatically defaults to the options that reflect the highest degree of safety, security, and ease of use for the Beginner level.

**Intermediate:** If you want to perform backups as quickly and easily as possible but need additional control over file selection and backup methods, then use the Intermediate level.

**Advanced:** For maximum control over all aspects of your backup, use the Advanced level. If you are familiar with previous versions of Central Point Backup, use the Advanced level.

3. Select the check box to password-protect the user level so it cannot be changed without the proper password.

   An “X” appears, indicating that password protection is on.

4. Select OK to continue or Cancel to retain the current user level.

The table on the following page shows the commands available in each level.
<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Beginner</th>
<th>Intermediate</th>
<th>Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File menu</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Setup</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Save Setup</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Save Setup As</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Save as Default</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Print history</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Exit</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Action menu</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Backup</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Backup From</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Select Files for Backup</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Schedule Backups</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Restore</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Compare</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Options menu</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Backup Method</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Reporting</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Compress</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Data Encryption</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Verify</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Media Format</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Auto Compare</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Format Always</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Error Correction</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Virus Detection</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Save History</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Overwrite Warning</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Time Display</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Selection Options</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Display Options</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

The Configure, Tape Tools, and Help menus remain the same for all user levels.
Making a Backup

This section explains how to do a full backup of your hard drive using the default settings of CPBackup.

The following procedure assumes that CPBackup is installed and that you have configured it to match your system.

You can start CPBackup by:

- Selecting Central Point Backup from the PC DOS Shell.
- Typing the command at the DOS command prompt.

To start CPBackup:

1. From the DOS command prompt, type:
   
   cpbackup

2. Press ENTER and the main Central Point Backup window appears.

3. Select Backup.
Backing Up All Files

CPBackup performs a quick scan of each local hard drive when you select it. This scan identifies problems that could potentially interrupt the backup or cause data distortion.

1. Select a drive to back up in the Backup From list (also available as Backup From on the Action menu).

   By default, all files on that drive are selected, as indicated by a checkmark to the left of the drive icon. If you would rather not scan each drive when selected, you can turn off the scan by selecting Drive Integrity from the Configure menu.

   Or, select specific directories and files to back up by choosing Select Files for Backup.

   When you choose this method, all files are unselected by default. To apply your selection filters, press F8 while displaying the directory tree and file lists. Refer to “Selecting Files” on page 394 for more information.

2. Select a backup destination in the Backup To drop-down list box (also available as Choose Drive and Media from the Configure menu).

3. Select Start Backup (also available from the Action menu). The Name Backup Set window is displayed.

4. Type a descriptive name of up to 30 characters, press TAB, and type an optional password; then select OK.

   Describe your backups uniquely. This description is what appears in the History list, Select Directory, or Search History files window when you do a compare or restore, and it can help you remember the correct history file to use.

   Warning: Remember your password. If you attempt to restore a password-protected backup set, the program asks you for the password. If you forget or lose the password, you cannot restore your data. This password is different than the user-level password. It is specific to each backup and is intended to prevent unauthorized restoring of your data.

5. Insert the backup diskette or tape into the drive, when prompted.
Note: It is normal for the drive light to stay on continuously during a backup using high and medium speed. You will not damage your disks by inserting or removing them when you are prompted to do so, even when the drive light is on.

If you are using diskettes or fixed media for your backup, skip ahead to step 6.

If you are using tape, do not remove the tape cartridge from the drive when the tape is moving. Doing so can damage the tape.

When you are backing up to a tape, a list of all the backups made to the tape appears in the Tape Directory box. The list contains the descriptions entered at the beginning of each backup. The list also includes the date and time of the backup, the size of the files on the tape (in compressed format), and the original sizes of the files.

If you are backing up to a SCSI tape, the Tape Directory window contains a Catalog selection button.

a. Select OK to append to the tape, Erase to overwrite the tape, or Cancel.

If you are sharing a SCSI tape with other users, select the Catalog button to scan the tape for all backup sets and update the tape directory on your hard disk. See “Synchronizing the Volume Tape Content (VTC) Files” on page 421 for details.

b. Enter the tape password if you select Erase and if it is password-protected.

This prompt for a password is a security measure to prevent deletion of other backups on that tape.

6. Press ESC, after the backup begins, any time you want to pause or cancel the backup.

A window displays options to Resume, End, or Quit the backup.

Warning: If you are using a SCSI tape, quitting the backup results in an unreadable tape. Previous complete backups can be recovered from the tape. The current backup cannot be recovered. The tape must be erased before future backups can be written to it. Use the End option (not Quit) so that proper end-of-data markers are written to the tape.

When the backup is complete, the backup statistics appear.

Perform a comparison at this point to be absolutely sure your backed-up data matches the original data exactly.

7. Select Compare to begin the comparison process. See “Comparing Data” on page 407 for further details.

If you are using a tape drive, you can have CPBackup perform an automatic comparison by selecting Auto Compare from the Options menu.
Selecting Files

You can use one of the following two ways to select files:

- Automatically with file-filter commands.
  For information about file-filter commands, refer to page 394.
- Manually from the directory tree.
  For information about the directory tree, refer to page 398.

Selecting Files Automatically

There are several options that affect selected files: the backup method, manual file selections, and the following automatic file selection filters, grouped under the command Selection Options from the Options menu. These file-filter commands are:

- Manual subdirectory inclusion
- Include/exclude files
- Attribute exclusions
- Date range selection

Manual Subdirectory Inclusions

This command is on by default. Therefore, any time you click a directory to select or deselect it (or press ENTER when the cursor is on it), all subdirectories are also selected or deselected.

Including and Excluding Files

The Include/exclude files process is the only method by which you can save file selections for future backups. Selecting Include/exclude displays a text window where you can enter an unlimited number of statements that list the drives, directories, and files to include or exclude in a backup. The default is *.* (all files selected).

CPBackup processes the files on your drive by looking at the include/exclude list. The applicable backup method is applied to the list of files and then the files are backed up.

To include and exclude files:

1. Select Selection options ➤ Include/exclude files from the Options menu.
   The Include/Exclude Files window is displayed.
These are the guidelines for using the list:

- You can create an unlimited number of include/exclude statements. Each statement can define only one specification.

- If you have multiple drives selected to back up, you can enter different specifications for each drive.

- Check the Include Subdirectories box while creating a specification, if you want to back up nested subdirectories contained in the specification. For example, if your \WORD directory contained subdirectories named \DATA and \LETTERS:

<table>
<thead>
<tr>
<th>Path/File</th>
<th>Include Subdirectories?</th>
<th>What is Backed Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\WORD*.</td>
<td>Yes</td>
<td>All files contained in \WORD, \WORD\DATA, and \WORD\LETTERS.</td>
</tr>
<tr>
<td>C:\WORD**</td>
<td>No</td>
<td>Only files contained in \WORD.</td>
</tr>
</tbody>
</table>

- For multiple-drive backups, each entry must begin with the drive letter it applies to; otherwise, the entry applies globally (to all selected drives).

- You can use DOS wildcard characters (* and ?).

- If you do not specify a path, the root directory is used by default.

- If you do not specify a file, the specification *.* is used by default.

2. Type the path of the directory you want to include or exclude in the Path text box.
3. Type the file specification for the group or type of file you want to include or exclude in the File text box.

4. Select Include or Exclude.

5. Select Include Subdirectories if you want CPBackup to apply your designated file specification to all subdirectories of the directory you specified on the Path line.

6. Select Check Path to have CPBackup ensure that every path you have entered in the Path text box exists. When you choose the Add or Replace buttons, the path of your entry is checked and, if it is not valid, a message prompt advises you to enter the correct path.

7. Select Log drives and apply selection filters when you want CPBackup to log every drive referenced by your entries and want the include/exclude filters applied to your files.

8. Select one of the following:
   - **Add**: Adds the specification as a new statement in the include/exclude list.
   - **Replace**: Replaces the highlighted statement in the include/exclude list with the new specification.
   - **Delete**: Deletes the highlighted statement in the include/exclude list.
   - **Clear List**: Deletes all statements in the include/exclude list.

9. Select OK when you have finished creating include/exclude statements.

**Warning**: Do not enter mapped drive letters and server\volume names in the same include/exclude list. Errors can occur and drives might not be logged.

**Including and Excluding a Single File or Directory**
You can use function keys to automatically add include/exclude statements to the include/exclude list by doing the following:

1. Highlight a specific file or directory while displaying a selected drive’s files and directories.

2. Perform one of the following:
   - **Shift+F6**: Inserts an include statement in the include/exclude list.
   - **Shift+F7**: Inserts an exclude statement in the include/exclude list.

   All subdirectories of a directory are selected by this process if you have the Manual Subdirectory Inclusion selection turned on.
Attribute Exclusions
The Attribute exclusions command acts as a modifier to the Include/Exclude Files command. For example, when you select a directory to back up and Exclude Hidden Files is marked, no hidden files in that directory are backed up.

To exclude file attributes:
1. Select Selection options ▶ Attribute exclusions from the Options menu.
2. Select the attributes you want to exclude and select OK.

Hidden Files: Hidden files (and directories) are usually a sign of copy-protection and can be position-sensitive on the hard disk. Therefore, if you copy the files off the diskette and onto another diskette, they probably will not work because of the copy protection. If your hard disk crashes, you will have to reinstall the program from the original diskettes.

System Files: These are your DOS system files (for example, IBMBIO.COM). Because they are DOS system files, you probably do not need to back them up as they are also position-sensitive.

If you are backing up a drive prior to changing DOS versions, do not back up the DOS files. If you do, do not restore them.

Read-Only Files: Files you can open and use but not modify in any way.

Date Range Selection
Date Range Selection modifies the include/exclude entries by letting you select files by date. Files are selected if their dates are within the range set by the start and end dates you specify.

To set a date range:
1. Select Selection options ▶ Date range selection from the Options menu.
2. Select On. Date Range Selection is off by default.
3. Type the range of dates as follows:
   **mm/dd/yyyy**
   CPBackup uses the date format that is standard in your country. For example, the United States uses the format shown above. Enter the date as you would with the DOS DATE command.
4. Select OK.
Selecting Files Manually

Manual file selections apply only to your current backup session. To save file selections in your setup file for future backups, add your selections to the Include/exclude list.

If you are accustomed to displaying your hard drive’s tree structure to select directories and files, you can pop up a directory tree from Express, or you can disable Express to use the tree exclusively.

To display the Tree List using the Express window:

1. Select Action on the Action bar; then, select Select Files for Backup from the Action pull-down menu.

   Or, select Select Files for Backup.

By default, all files are unselected. To apply your selection filters, press F8 while displaying the directory tree and file lists.

Note: Displaying the tree is not available at the Beginner user level.

The Tree List lets you select directories and files by clicking on each with the mouse, or using the TAB, ENTER, UP ARROW, DOWN ARROW, LEFT ARROW, and RIGHT ARROW to navigate around the tree and select files.

When a directory is active in the Tree List, the files contained in that directory appear in the File List on the right. You can select or deselect individual files with the mouse by clicking, or you can use the keyboard.

If you press F8 while displaying the directory tree and file lists, the Include/Exclude file specifications will overwrite your manual specifications.
To select files or directories:

1. Select the directories and files you want to back up with the mouse by clicking on them or by using the keyboard:
   - Use LEFT ARROW to move to the previous directory at the same level as the current directory.
   - Use RIGHT ARROW to move to the following directory at the same level as the current directory.
   - Scroll the lower-level directories with the UP ARROW and DOWN ARROW.

The number of selected directories appears at the bottom of the Tree List and the number of selected files appears at the bottom of the File List, if you are using the Express Interface.

2. If you want to deselect all files and directories, press SHIFT+F8 (ClrTree) while displaying the directory tree and file lists. For monochrome users, a bullet appears to the left of each file that is selected.

3. Press ESC or F10 to return to the Express selection window.

Disabling Express

The directory tree always appears when you turn off the Express interface. If you prefer, you can disable Express so the tree always appears.

To disable Express:

1. Select Express Interface from the Configure menu. The Tree List appears for the currently selected drive.
The number of selected directories in the Tree List and the number of selected files in the File List appears at the top, if you are not using the Express Interface.

2. Select Save as Default from the File menu. This makes the Tree and File Lists always visible for future sessions.

Selecting Drives to Back Up
CPBackup displays all the storage devices it finds (such as hard drives, network drives, and Bernoulli** drives) in the Backup From list. You can select multiple drives to back up at one time. A checkmark appears next to each selected drive in the Backup From list.

Selecting Local Drives
1. Select the drives you want to back up in the Backup From list box.  
   Or, select Backup From from the Action menu.
2. Select the drives to back up.
   When Express is disabled, additional options appear:

   ** Allow Single Drive Backups:** When selected, all drive icons dim except for the currently selected drive. The path box appears so you can type a specific path (for example, E:\ACCOUNTS). The drive letter appears in the path box, if you select the drive icon first.

   ** Allow Multiple Drive Backups:** When selected, the path box disappears. You can then select more than one drive to back up.

   You cannot specify a path when drives are displayed as server volume names.
3. Select OK.

Displaying Multiple Drives with Express Disabled
The letters of the drives you have selected to back up appear in the Settings box when Express is disabled.

The currently selected drive's directories appear in the directory tree window.

- Press F4 or + on your numeric keypad to display the next drive.
- Press SHIFT+F4 or - on your numeric keypad to display the previous drive.

** Bernoulli is a trademark of Iomega Corp.
You will see only the next drive displayed using F4, if you have more than one drive selected.

Multiple-Drive Backups
If your system consists of multiple drives, you might want to back up all of them during the same backup session. CPBackup processes each drive of a multiple-drive backup as separate backup sets.

For example, if you select drives C, D, and E to back up, CPBackup prompts you to insert diskette #1. After drive C is backed up and the history file is written, you are prompted again to insert diskette #1 of set #2. Do not insert diskette #1 of your just-completed backup. Use a new diskette. This diskette becomes the first of the backup set for drive D. This process repeats for each drive of a multiple-drive backup. Similarly, if you use tape, each drive creates a separate backup set on the tape.

If you are using low speed, the Fixed or Removable Drive and Path options, and backing up multiple drives, each drive creates a subdirectory named X_DRIVE on the destination media (where x=drive letter) that contains the data for each drive.

Displaying Novell Network Drives
If you are connected to a Novell network, you can select how you want local and network volumes displayed in the Backup From list. CPBackup defaults to displaying drives by drive letters.

Many network volumes are mapped to a drive letter that is actually a specific path on a particular volume of a particular file server. For example, if you map drive G to the directory NOVELL\SYS:ACCTS\RECEIVE, you access that directory whenever you type G: at the DOS command prompt.

You can select to display the server and volume name instead of a drive letter. By referencing network servers by name, you avoid confusion if the network drive mappings change.

For example:

<table>
<thead>
<tr>
<th>This Drive:</th>
<th>Indicates:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive C</td>
<td>Local DOS drive.</td>
</tr>
<tr>
<td>Drive G</td>
<td>[SYS:ACCTS\RECEIVE] mapped drive.</td>
</tr>
<tr>
<td>NOVELL\SYS: ACCTS</td>
<td>Single volume on a network drive.</td>
</tr>
</tbody>
</table>
Be careful when backing up and restoring files that appear as mapped drive letters. If the mappings change after the files are backed up, the files might not be restored.

**To select to display the server and volume name instead of a drive letter:**
1. Select Novell Network ➤ File Selection from the Configure menu.
2. Select from the following:

   **Drive Letter:** Displays logical drive letters, assigned by the NetWare Map command to a network volume.

   **Server\Volume:** Displays network drives as true network volumes, rather than as logical drive letters.

   If you want to back up an entire volume on a server, select the **Server\Volume** option, or make sure that the drive mapping for the backup is mapped to the root of the volume. CPBackup allows up to 10 server volume drives in a setup file.

---

**Viewing Files**

CPBackup features viewers for many popular applications. The viewer automatically adjusts to display the correct file format (a spreadsheet display for spreadsheet files, for example). However, the viewer cannot let you edit the contents of the file.

Viewing a file can be especially useful if you have multiple files with the same names in different directories or if you cannot remember the contents of a file. CPBackup can view word-processing files, spreadsheet files, database files, graphics files, as well as binary files containing executable code.

**To view specific files:**
1. Select the file you want to view.
2. Press F2 (QView).

Use the online help available for this optional tool to see how to use the function keys when using the Central Point Backup viewer.
Working with Setup Files

CPBackup comes with several preconfigured setup files. One, named WEEKLY.SET, does a full backup of all files on the first hard drive of your computer system, which is usually drive C. Other preconfigured setup files include SPREAD.SET, which backs up Lotus 1-2-3**, Excel**, and Quattro** files on your first hard drive; and WORDPROC.SET, which backs up many word-processing documents from applications such as Microsoft Word**, WordPerfect**, Lotus Write/Ami**, and Lotus Ami Pro**. The database set, DATABASE.SET, backs up files with extensions .DB, .DBF, .NDX, .IDX, .PX, and .DTF.

Select the setup file you want to use from the Setup Files drop-down list. You can modify the setup file to further customize it for your system and backup needs. If you make changes, select the Save Setup button to save the new information.

Follow steps 3 through 7, beginning in “Backing Up All Files” on page 392.

Setup files offer a way to save your selections for future use without having to go through repetitious configurations. You can load these setup files from the command line or from within CPBackup.

Note: You must have setup files to schedule unattended backups with the Scheduler.

You can use setup files with all operations—backup, compare, and restore—to instantly configure CPBackup to the specifications contained in that setup file. This is especially important if you want to compare or restore a backup where you might not remember all the details about the setup you used at the time.

A setup file processes the files on your hard drive according to the criteria contained in that setup file. Although you can always see all files and directories on your hard drive when the Tree List is displayed, only the highlighted ones are used during a backup, compare, or restore.

** Lotus 1-2-3, Write/Ami, and Lotus AmiPro are trademarks of Samna Corporation.
** Quattro is a trademark of Borland International, Inc.
** Microsoft Word is a trademark of Microsoft Corporation.
** WordPerfect is a trademark of WordPerfect Corporation.
** Excel is a trademark of Microsoft Corporation.
The information contained in a setup file includes the settings for the following commands:

- Setup description
- Backup from (all selected drives)
- Back up to (media size)
- Server/volume or Drive Mappings display
- Backup speed (high, medium, or low)
- Backup method (full, incremental, differential, full copy, separate incremental, or virus scan)
- Reporting (to file, printer, or none)
- All include/exclude statements
- Attribute exclusions
- Date range selections
- Overwrite warning (on or off)
- Compression
- Display options
- Error correction (on or off)
- Data encryption (on or off, and the type)
- Formatting options
- Save history (on or off)
- Verification option
- Virus detection (on or off)
- Exit when complete

Defining and Saving Setup Files
The Save Setup commands let you define and save multiple backup types and options.

**Save setup As:** Saves the settings and include/exclude statements you make during a backup session with a specific file name and .SET as the extension.

**Save setup:** Saves all current settings and include/exclude statements without prompting you for a setup name (thus overwriting the current setup file). If there is not a current setup file, the Save Setup command defaults to a setup file name of Untitled.

**Note:** The Save Setup commands are not available at the Beginner user level.

If you save setup files with include/exclude file statements, then another file with a .INX extension is also saved with its parent .SET file.
If you are backing up server\volumes to a QIC-format tape, be sure to turn on the Save History command. This ensures that the name of the server\volume is saved with the backup information on your hard disk. Because of the QIC-format design, server\volume names cannot be saved on the tape itself.

**Saving Setup Files**

1. Select the Save Setup option (also available as Save setup As from the File menu).
2. Enter the name to use for this backup configuration.
3. Enter a description of this setup file, using up to 32 characters.
4. Select OK.

**Warning:** When you save files, all the manual file specifications in these files are lost. To save your changes, you must use the include/exclude command to enter all of your specifications.

**Loading Setup Files**

Load setup lets you select and load a previously saved backup configuration. If you have saved setup files from previous versions of CPBackup, you can load and use them with this command.

**Note:** The BACKUP command is not compatible with the Central Point's Backup Program (CPBACKUP).

To load setup files:

1. Click on Setup.
   
   *Or, select Load setup from the File menu.*
2. Select the setup file to use for this session, and select OK.

**Using Preconfigured Setup Files**

CPBackup includes several preconfigured setup files. One, named WEEKLY.SET, does a complete backup of all the files on the first hard drive of your computer system, which is usually drive C. Another file, DAILY.SET, backs up only those files that have changed since the last full backup.
The following table shows other preconfigured setup files. Use these setup files as a foundation to customize for your particular needs and system. Be sure to save any modifications you make.

<table>
<thead>
<tr>
<th>Preset File Name</th>
<th>Files Backed Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATABASE.SET</td>
<td>*.DB *.DBF *.NDX *.IDX</td>
</tr>
<tr>
<td></td>
<td>*.DTF *.RBF *.PX</td>
</tr>
<tr>
<td>SPREAD.SET</td>
<td><em>.XL</em> <em>.WK</em></td>
</tr>
<tr>
<td></td>
<td>*.CAL <em>.WQ</em></td>
</tr>
<tr>
<td>WORDPROC.SET</td>
<td><em>.DO</em> *.STY <em>.WP</em> *.WRI</td>
</tr>
<tr>
<td></td>
<td>*.JW *.SAM *.TXT</td>
</tr>
</tbody>
</table>

**Scheduling Backups**

The Scheduler button and the Schedule Backups command use Central Point Scheduler, which is an application that lets you schedule backups without monitoring the procedure. Scheduler can also be used whenever you want to schedule any program to run automatically at a specified time. For example, you might want to run a program that has to be compiled. You can set up a batch file first and then schedule it to run automatically when you are not using your computer. This is especially useful for backing up to tape drives, removable cartridges, or to a network volume.

**Note:** The Schedule Backups command is not available at the Beginner user level.

Scheduler provides a 15-second warning before it runs the scheduled backup in case you are in the middle of an application that you do not want interrupted. When the backup is complete, Scheduler returns to the application you were running.

*The memory-resident program, CPSCHED, must be resident in order to launch CPBACKUP at the scheduled time. You can arrange to have CPSCHED load each time you start your computer by placing this statement in your AUTOEXEC.BAT file. If you chose not to have CPSCHED automatically load, you must load CPSCHED prior to any scheduled backups.*

To load CPSCHED, from the DOS command prompt, type:

cpsched
For complete instructions on how to schedule events, such as scheduling a backup, see Chapter 16, “Using Central Point Scheduler” on page 275.

**Unattended Backups**

When you want the backup to run, be sure the computer is on, CPSCHED is loaded, and a tape is in the drive. CPBackup performs the backup at the specified time and returns the machine to the state it was in prior to the backup.

If the setup file used in the scheduled backup has a description, that description also becomes the description of that backup. Otherwise, the backup has the name “Unattended Backup.”

- If CPBackup is launched from a batch file and the backup progresses without interruption, control is returned automatically to the batch file to execute the next command.
- If CPBackup is launched from the command line with a setup file or from Scheduler, then Express is automatically disabled to conserve memory. This means the directory tree and file list is always visible on screen. Any automatic backup (scheduled or run from the command line) answers the default button in any window that appears. At the beginning of tape backups, a window appears, showing the tape contents, and offers options to Append or Erase the tape. For all backup methods, except Full/Erase Tape, the default button is Append, which is what happens in automatic tape backups.

**Comparing Data**

After performing a backup, compare your hard-disk data with the data contained on your backup media. This comparison is an extra measure of security so that you are sure the data contained on your backup disks or tapes matches the files on your hard drive and is restorable.

Use Compare whenever you make changes to your hardware configuration or backup settings, or when you use new media. You can have CPBackup perform an automatic comparison by selecting AutoCompare from the Options menu.

**Comparing Your Backup to the Original Data**

If you used a setup file when doing the backup, use the same setup file for the comparison, so all the settings are identical. You have the opportunity to start a comparison immediately after a backup is complete.

Compare saves a report of the comparison results automatically, if you have turned on the Reporting command.
To compare your backup to the original data:

1. Select Compare from the main selection window (or Compare from the Action menu).

2. Select the setup file (if any) from the Setup list used to create the backup you want to compare to. This is necessary if you are doing a comparison at a time other than immediately after a backup.

3. Select History and select the history file of the backup set containing the data you want to compare.

   Or, highlight the history file you want, press the SPACEBAR to load the history file, and press ENTER to display the history tree.

   Or, use the Retrieve History button, if the history file you want to compare is not in the History list.

   Double-click on a drive icon in the Compare To list to display a text box, and type a specific path to compare to or press ENTER.

4. Select Start Compare.

   If you used a password when the backup was originally performed, you see a prompt to enter it now. Also, if you encrypted the data, you are prompted for the encryption key. For online help about Data Encryption, select this item from the Options menu and then press F1 for online help.

5. Insert the first diskette or tape of your backup set. Continue to insert diskettes or tapes as prompted.

   At the conclusion of the comparison, the results are displayed.

Displaying the Compared Files

If some of your files do not match, it is easy to see which ones they are. The icons next to each mismatched file indicate why the file did not compare. (See the symbol table that follows.)

To display the compared files:

Double-click on the history file you just compared.

Or, press TAB until you get to the History list, and then press ENTER.

Windows updates certain files every time you exit from Windows. Therefore, if you back up with the Windows version of CPBackup, you should exit from Windows. Then use either version to compare the backup. Some of the backed-up files from your Windows directory will never compare with the original files on the hard disk. These files include most of the .GRP files, and some .INI files, including PROGMAN.INI.
**Compare Symbols:** The symbol next to each file icon indicates how that file compared with the original file, as follows:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>What it Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>The backup file was identical to the hard-disk file.</td>
</tr>
<tr>
<td>x</td>
<td>The backup file did not match the hard-disk file, although the date and time stamps matched.</td>
</tr>
</tbody>
</table>

The following symbols can appear (in addition to the above symbols) if you are doing a comparison at a time other than immediately after a backup:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>What it Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>The backup file did not match the hard-disk file, and the date/time stamp was older.</td>
</tr>
<tr>
<td>&gt;</td>
<td>The backup file did not match the hard-disk file, and the date/time stamp was newer.</td>
</tr>
<tr>
<td>s</td>
<td>The backup file matched the hard-disk file, but the date/time stamp was different.</td>
</tr>
<tr>
<td>-</td>
<td>The backup file was missing from the hard disk.</td>
</tr>
</tbody>
</table>

No symbol next to a file means that the file has not been compared (for example, if you are not comparing all files on your hard disk).

**Restoring Data**

CPBackup can restore an entire hard disk or specifically selected files and directories. You can restore files that were backed up on one machine to a different machine, or restore files to a previous state.

All the restore functions available in Express are also available when Express is disabled. For each command button of Express, there is a corresponding menu command on the Action menu when in Restore mode. To perform a restore or search a history file, select the appropriate command from the Action menu. To retrieve, rebuild, or print a history file, select Choose directories from the Action menu.
Full Restore

If you experience a hard-disk crash and need to reformat, you must install DOS and CPBackup again before you can start your restore.

If you are restoring multiple drives, you must restore each drive individually. If you are restoring network volumes, see “Performing Network Backups” on page 411.

It is important to restore your files using the same speed as the original backup. For example, if you backed up your files using low speed, you must restore your files at that speed.

If you are accustomed to using a mouse, reinstall your mouse drivers before running CPBackup.

To perform a full restore of your system:

1. From the DOS command prompt, type:
   
   ```
cpbackup
   ```
   
   and then press ENTER.
   
   Because this is the first time you are using CPBackup after installing it on your hard disk, you must configure it again.

2. Select Restore after configuration.

3. Select Retrieve History.

   Or, if Express is disabled, select Choose Directories from the Action menu.

4. When prompted, insert the last diskette or the requested tape of the backup set.

   The history file is read from the backup and the history name and backup date appear in the History drop-down list.

   To select the restore destination, double-click on a drive icon in the Restore To list box to display a text box. Then, type a specific path to restore to, or press ENTER.

5. Select Start Restore.

6. When prompted, insert the first diskette or tape of your backup set.

   The progress of the restore process appears on the screen.

7. Continue to insert disks or tapes until the restore is complete.
It is normal for the drive light to stay on continuously while restoring at high and medium speed. You will not damage your disks by inserting or removing them when you are prompted to do so, even when the drive light is on.

**Overwrite Warning:** If this warning is on, a window appears when the directory containing your newly restored CPBackup files is detected. Select *Skip this file* and *Repeat for all Later Files* to avoid overwriting the files.

*Be especially careful if you are restoring a backup that might contain an older version of DOS than what is currently on your hard drive.*

If you are restoring a directory with attributes that are different than the existing directory, an overwrite warning appears.

If your backup method is incremental, you need to do only a single restore because all incremental backups are appended automatically to the parent full backup, and only the most current files are selected to restore.

**Printing a Directory from a History File**

Use the *Print History* command from the File menu to print the directory of a backup set to a disk file or to a printer.

If you send the directory to a file, you can view the directory when the File List is displayed in Backup mode. The file is named YYMMDD.RPB.

**To print a directory from a history file:**

1. Select the history file you want to print from the History list.
2. Select *Print History*.

**Performing Network Backups**

Central Point CPBackup allows you to back up files between your personal workstation, Local Area Networks (LANs), and networks such as Novell NetWare.

**Backing Up the Local Area Network**

If you are connected to a Local Area Network and have write access to the LAN, you can back up your workstation files to the LAN drives (if backups are permitted).

Or, you can back up LAN drives the same way you back up your own workstation drives, by specifying the full path of the LAN drive.
Before you back up files from a specified path, make sure that the Express Interface is disabled and there are no Novell Network Server/Volumes designated. If the box does not provide a path, select Allow Single Drive Backups because you cannot specify a path with a multiple drive backup.

**Backing Up Workstation Data**

A workstation user can back up the data on a hard drive to a directory on the network.

**To back up to a network directory:**

1. Create a subdirectory named FULL on the network and do a full backup, either weekly or monthly, to that directory. This subdirectory should be a subdirectory of your \HOME directory.

2. Create two subdirectories named DAILY1 and DAILY2 on the same volume.

   Alternate daily differential or separate incremental backups to the two DAILY directories.

   By creating the three directories, you avoid the problem of overwriting the three files that CPBackup writes that contain your data and information about the backup. These three files are:

   - CPBACKUP.001, which contains your backed-up data.
   - CPBACKUP.DIR, which contains the directory of the backed-up data.
   - CPBACKUP.INF, which contains boot-record information.

   Normal network security is in effect during a backup. This means each user must have rights to read from and write to the drive and directory specified.

3. Select the data you want to back up.

4. Click the Backup To drop-down list and select Fixed Drive.

   Or, select Choose Drive and Media from the Configure menu and then select Fixed Drive and Path.

5. Enter the path as a destination, and select OK.

   To enter a server\volume name, turn on the Server\Volume option in the File Selection window, which is under Novell Network from the Configure menu.

6. Select Save Setup to save the settings for future use.

7. Select Start Backup.

You can use the Scheduler command to schedule a backup of your data to the network after you go home for the day. See “Scheduling Backups” on page 406.
Backing up Novell Networks
CPBackup can back up data to a network directory or to a SCSI device or QIC-02/36 tape device attached to the server. You can display server\volumes by name or as drive letters mapped to specific paths.

As a network supervisor, you can back up and restore the network data.

Retry on Busy File
If you are attempting to back up a file that is locked or in use by someone else, you can instruct CPBackup to keep trying to back up the file or skip the file.

If you activate this option and, if during a backup, CPBackup encounters a busy file, the backup stops for as long as the file is busy. No other files are backed up while CPBackup is in the retry mode.

To activate the retry on busy option:
1. Select Novell Network - Retry on Busy from the Configure menu. The Novell Network File Busy window is displayed.
2. Select one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry every ( n ) minutes</td>
<td>Specify how often you want the busy file accessed to back it up. This number must be a whole number (between 1-600). No decimal points are accepted.</td>
</tr>
<tr>
<td>Retry until not busy</td>
<td>Specifies that CPBackup is to continue trying to access a busy file until it is no longer busy. When the file is no longer busy, it is backed up.</td>
</tr>
<tr>
<td>Do not retry</td>
<td>Specifies that busy files are to be skipped by CPBackup. This is the default.</td>
</tr>
<tr>
<td>Total retry time</td>
<td>Specifies how long you want CPBackup to continue to attempt to back up a busy file. You can specify 9 hours and 60 minutes.</td>
</tr>
</tbody>
</table>

Backing Up and Restoring Bindery Files and Trustee Information
Backing up and restoring bindery files and trustee information is supported by SCSI tape drives only. You must have administrative authority to perform this function.
To back up bindery files and trustee information:

1. Select Novell - Bindery Trustee from the Configure menu. The Novell Network window is displayed.

2. Select one of the following:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back up bindery information</td>
<td>This selection affects a backup of the bindery; the database that contains the network user lists and the groups they belong to on the network. The bindery consists of permanent, hidden system files that are always located in the SYS:SYSTEM directory. Refer to the documentation that comes with your network software for more information.</td>
</tr>
<tr>
<td>Back up trustee information</td>
<td>This selection affects a backup of the assigned rights of every selected file.</td>
</tr>
</tbody>
</table>

3. Select OK.

To restore bindery/trustee information:

1. Select Restore on the Main CPBackup window. The Restore window is displayed.

2. Make adjustments using the choices on the Restore window as needed.

3. Select Start Restore.

During Restore, the catalog file of the backup set is opened and checked for bindery, trustee information, and directory information. The Novell Network window is displayed, prompting for confirmation of the files that have been found.

4. Select the files you want restored.

5. Select OK.
Configuring Tape Drives

CPBackup supports a variety of tape drives, ranging from those that connect to a floppy controller card to multiple-gigabyte SCSI drives. The most common type of tape drive for single-user PCs is the mini-cartridge drive, which encompasses the QIC standard as well as proprietary formats. Mini-cartridges are quarter-inch tapes, generally known as DC-2000 or DC-2120, and can hold up to 250MB of compressed data.

Many drives that are sold as 120MB or 250MB capacity actually are referring to the capacity of the tape when data compression is used. How much the data is compressed depends a great deal on the data itself.

Note: If you are having trouble configuring your tape drive or other problems related tape drives, refer to “Central Point Backup” on page 312.

Floppy or Secondary Controller Card and QIC Drives

CPBackup is compatible with the following tape drives:

The following lists of tape drives represent those that have been tested with this product. If you do not find your tape drive among these lists, you should check with your manufacturer to ensure compatibility.

| Aiwa TD803                  | Colorado DJ-20 (Jumbo 250) |
| Aiwa TD811                  | Colorado KE-10              |
| Alloy 120                   | Colorado KE-15              |
| Alloy Retriever 40/60       | Colorado KE-15              |
| Alloy Retriever 60e         | Compaq**                    |
| Alloy Retriever 125c        | Internal 40MB               |
| Alloy Retriever 250c        | Compaq Internal 80MB        |
| ArchiveXL 5580i             | EdisonTech 40MB             |
| Archive 5540                | IBM PS/2 Internal Tape Backup Unit |
| ArchiveXL 5580e             | Identity 120                |
| Backtrax 80MB               | Identity 120e               |
| CMS Tape 40/INT             | Identity 80i                |
| CMS T2120AT                 | Insight 125/250             |
| Colorado DJ-10 (Jumbo 120)  | Insight 80i                 |

** Compaq is a trademark of Compaq Computer Corporation
<table>
<thead>
<tr>
<th>Tape Drive</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Iomega** Tape 250MB</td>
<td>Summit SE 120</td>
</tr>
<tr>
<td>Irwin 445</td>
<td>Summit SE 250</td>
</tr>
<tr>
<td>Irwin 485</td>
<td>Sysgen Valuestor 250</td>
</tr>
<tr>
<td>Irwin 745</td>
<td>Tallgrass FS120</td>
</tr>
<tr>
<td>Irwin 785</td>
<td>Tallgrass FS300</td>
</tr>
<tr>
<td>Irwin Accutrac A120</td>
<td>Tallgrass TG1140</td>
</tr>
<tr>
<td>Irwin Accutrac A250</td>
<td>Tallgrass FileSecure 80</td>
</tr>
<tr>
<td>Irwin DC 2000 Series: Model 2040 (40MB)</td>
<td>Tecmar MiniVault 120i</td>
</tr>
<tr>
<td>Irwin DC 2000 Series: Model 2080 (80MB)</td>
<td>Tecmar MiniVault 120e</td>
</tr>
<tr>
<td>Irwin SXe 120/250</td>
<td>Tecmar MiniVault 250i</td>
</tr>
<tr>
<td>Irwin SX 5540 and 5580</td>
<td>Tecmar MiniVault 250e</td>
</tr>
<tr>
<td>Mountain Filesafe FS-4000</td>
<td>Tecmar QT-40e</td>
</tr>
<tr>
<td>Mountain Filesafe FS-8000</td>
<td>Tecmar QT-40i</td>
</tr>
<tr>
<td>Mountain Filesafe TD-4000</td>
<td>Tecmar QT-80e</td>
</tr>
<tr>
<td>Mountain Filesafe TD-4340</td>
<td>Tecmar QT-80</td>
</tr>
<tr>
<td>Mountain Filesafe TD-4440</td>
<td>Wangtek 3040</td>
</tr>
<tr>
<td>Mountain Filesafe TD-8000</td>
<td>Wangtek 3080</td>
</tr>
<tr>
<td>Mountain 4400</td>
<td>Wangtek FAD 3500</td>
</tr>
<tr>
<td>Procom 80MB</td>
<td>Well-Tech (Colorado drive for Toshiba* T5200)</td>
</tr>
</tbody>
</table>

If you use a tape drive that is connected to your high-speed floppy controller card, you cannot access the floppy drives during the tape backup.

### SCSI Tape Drives

CPBackup is compatible with the following SCSI tape drives:

<table>
<thead>
<tr>
<th>Tape Drive</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Turbo Python (2.0GB)</td>
<td>Tandberg 3620</td>
</tr>
<tr>
<td>Archive Python (2.0GB)</td>
<td>Tandberg 3640</td>
</tr>
<tr>
<td>Archive Viper 2060 (60MB)</td>
<td>Tandberg 3660 (150MB)</td>
</tr>
<tr>
<td>Archive Viper 2125 (125MB)</td>
<td>Tandberg 3820 (525MB)</td>
</tr>
<tr>
<td>Archive Viper 2150 (150MB)</td>
<td>Tandberg 4120 (1.0GB)</td>
</tr>
<tr>
<td>Archive Viper 2525 (525MB)</td>
<td>Tandberg 4220 (2.0GB)</td>
</tr>
<tr>
<td>Exabyte 8200Sx (2.0GB)</td>
<td>Teac MT-01 (250MB)</td>
</tr>
<tr>
<td>Exabyte 8200 (2.0GB)</td>
<td>WangDAT 1300 (2.0GB)</td>
</tr>
<tr>
<td>Exabyte 8500 (5GB)</td>
<td>WangDAT 3200 (2.0GB)</td>
</tr>
<tr>
<td>Exabyte 8505 (5GB)</td>
<td>Wangtek 5525ES (525MB)</td>
</tr>
<tr>
<td>Exabyte 850c (5GB)</td>
<td>Wangtek 7200HS (2.2GB)</td>
</tr>
</tbody>
</table>

** Iomega is a trademark of Iomega Corp.

* Toshiba is a trademark of the Toshiba Corporation.
Tape Formatting (non-SCSI)

Formatting a tape is a process that is required only once; however, it is a good idea to purchase preformatted and certified tape cartridges. This is not only more convenient for you but also saves time during a backup. CPBackup can format a tape during a backup, if necessary, but the time involved is considerable. Use Format on the Tape Tools menu to format a tape before you use it.

Every tape must have two things done to it before it is ready to use:

- **Formatted (initialized):** Formatting lays out data tracks and maps them for the read/write mechanism. This process is very similar to formatting a diskette. Formatting a tape is not the same as erasing a tape. Erasing deletes data from the tape; formatting lays out the data tracks that the data is stored on.

- **Certified:** Verifies the tape by checking for bad blocks and locking them out (similar to DOS locking out bad sectors on a diskette). This is done last.

An Irwin-formatted tape has one additional process done to it before it is formatted and certified:

**Servo-written:** Writes permanent information to the tape. This information is precisely placed along the track so the tape drive’s read/write mechanism is guided along the proper data tracks. This is usually a one-time-only procedure. If a tape ever needs to be servo-written again, bulk-erase the tape first.

The following table shows the approximate time it takes to fully format various non-SCSI tapes. The third and fifth columns refer to special tapes that can be formatted to greater capacity. These tapes are marked “XL,” which means they have extra length. If you buy a 40MB tape marked XL, you can format it to hold 60MB of data. Similarly, if you buy an 80MB XL tape, you can format it to hold 120MB of data.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>40MB non-SCSI tape</th>
<th>40MB XL non-SCSI tape</th>
<th>80MB non-SCSI tape</th>
<th>80MB XL non-SCSI tape</th>
</tr>
</thead>
<tbody>
<tr>
<td>Servo-written (Irwin only)</td>
<td>36 min</td>
<td>54 min</td>
<td>51 min</td>
<td>76 min</td>
</tr>
<tr>
<td>Formatted</td>
<td>18 min</td>
<td>27 min</td>
<td>33 min</td>
<td>50 min</td>
</tr>
<tr>
<td>Certified</td>
<td>18 min</td>
<td>27 min</td>
<td>33 min</td>
<td>49 min</td>
</tr>
<tr>
<td>Totals:</td>
<td>36 min</td>
<td>54 min</td>
<td>66 min</td>
<td>99 min</td>
</tr>
<tr>
<td>Totals with servo-write:</td>
<td>72 min</td>
<td>108 min</td>
<td>117 min</td>
<td>175 min</td>
</tr>
</tbody>
</table>
These times are based on a 500 Kbps (kilobits per second) data rate that a high-density diskette controller uses, such as those found in AT-class machines. All times should be doubled if done at the 250 Kbps rate used by low-density diskette controllers, such as those found in XT-class machines. All times should be halved if using a high-speed 1000 Kbps controller card.

If you insert a blank tape, CPBackup first rewinds the tape and attempts to read the tape header. If that is unsuccessful, the tape is retensioned and you have the opportunity to format the tape, insert a new tape, or cancel.

**QIC Format and Full-Screen CPBackup Format**

CPBackup supports the standard QIC-40/80 format for tapes and the proprietary Full-Screen CPBackup format. There are some differences between the Full-Screen CPBackup format and QIC, which are summarized in the following table:

<table>
<thead>
<tr>
<th>QIC</th>
<th>Full-Screen CPBackup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freely interchangeable with other QIC format backup programs.</td>
<td>Proprietary format can be restored only with CPBackup.</td>
</tr>
<tr>
<td>Writes directory information at the beginning of the backup set.</td>
<td>Writes directory information at the end of the backup.</td>
</tr>
<tr>
<td>Supports all backup methods but incremental because of placement of directory.</td>
<td>Supports all backup methods.</td>
</tr>
<tr>
<td>Might have to insert every tape of a multiple-tape backup to restore a single file.</td>
<td>Needs only the specific tape of a multiple-tape backup to restore a single file.</td>
</tr>
<tr>
<td>If the first tape (where directory is stored) of a multiple-tape backup is lost, no data is recovered from any of the remaining tapes (even if a history file exists on the hard disk). You cannot restore any data contained on tapes beyond the missing tape. (For example, if tape #3 of a six-tape backup is lost, only the data on tapes 1 and 2 can be restored.)</td>
<td>If the last tape (where the directory is stored) of a multiple-tape backup is lost, but the history is on the hard disk, all data up to the missing last tape is recovered. As long as a directory exists (on tape or hard disk), all data is recovered except what was contained on the missing tape.</td>
</tr>
</tbody>
</table>

* Micro Channel is a trademark of IBM Corporation.
There is no significant performance increase of one format over the other, and both formats use about the same amount of space on the tape (all things being equal such as method and compression).

After a tape is formatted as QIC, it does not need to be reformatted as Full-Screen CPBackup because the low-level formatting is identical. There is one exception to this—non-SX Irwin tape drives. These drives use special servo-writing (described previously) which is not QIC-compatible. The Irwin SX series of tape drives is QIC-compatible.

Be aware that using encryption on a backup set written to a QIC tape makes that backup set unrestorable by other QIC-compatible backup programs.

If you are backing up server\volumes to a QIC-format tape, be sure the Save History command is on. This ensures that the name of the server\volume is saved with the backup information on your hard disk. Because of the way QIC format was designed, server\volume names cannot be saved on the tape itself.

**Tape Controller Card Technical Information**

CPBackup supports various manufacturers' floppy and tape controller cards. In many cases, the card is recognized and used with no information required from you. However, some cards require special parameters to be set the first time you use CPBackup so the card is recognized for future backups. This is saved in the default configuration file. This section provides details on the various cards that require this special information.

Adapter cards connect between the primary diskette controller and the diskette and tape drives. CPBackup automatically detects the following cards when you select Search with the Define Equipment command.

- Archive XL20A
- Colorado AB-10
- Irwin 4251

**Secondary Tape Controller Cards Supported (Micro Channel):** It is not necessary to specify any address information for these cards:

- Irwin 4100MC
- Mountain MACH2 (Micro Channel*)
- Tecmar MCA Floppy Tape Controller
Secondary Tape Controller Cards Supported (ISA): The following tape controller cards, which are Industry Standard Architecture (ISA), must have the I/O port address, IRQ channel, and the DMA channel specified.

<table>
<thead>
<tr>
<th>Tape Drive</th>
<th>ADDR</th>
<th>IRQ</th>
<th>DMA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alloy FTFA Controller</td>
<td>340</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>Colorado FC-10</td>
<td>180</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>Colorado TC-15</td>
<td>180</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>Compaq Expansion Chassis #1075-70-001</td>
<td>370</td>
<td>6</td>
<td>2</td>
</tr>
<tr>
<td>Iomega PC10p</td>
<td>370</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>Archive/Irwin 4100A/M</td>
<td>370</td>
<td>6</td>
<td>2</td>
</tr>
<tr>
<td>Mountain MACH2</td>
<td>3E7</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>Summit Accelerator</td>
<td>3E7</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>Tecmar QT</td>
<td>300</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>Wangtek Lightning Thunderbolt</td>
<td>300</td>
<td>3</td>
<td>1</td>
</tr>
</tbody>
</table>

The addresses listed are the factory settings of the cards. If you have altered these settings in any way, you must specify the values you have set so CPBackup can recognize the card.

You can specify settings by entering the correct values in the Tape Configuration window, which you access with the Define Equipment command.

The Colorado FC-10 and TC-15 are jumperless controllers and are not fixed at the rates shown in the above table. If CPBackup does not find your tape driver, reconfigure and try one of the following sets of value until it does find the tape drive:

- 180-3-2
- 300-6-1
- 300-6-2
- 370-6-2
Synchronizing the Volume Tape Content (VTC) Files

During the SCSI configuration of CPBackup, a window appears.

The options that appear in this window can vary, depending on the type of SCSI adapter card you have.

A *.VTC (volume tape catalog) file is written to your hard disk after the backup process for each SCSI tape used and is subsequently updated after each backup.

When the Resync Volume Table before each Backup option is on, which is the default setting, the *.VTC file on your hard disk is updated with the *.VTC file on the tape before the tape directory appears on your screen. This process is time-consuming because the tape must be rewound and searched for the last *.VTC file.

If you use a tape for a single PC, and you are the only one using that tape, you can safely turn off the Resync Volume Table before each Backup option because your *.VTC files are always identical. Turning off this option saves time by not having to rewind the tape and search for the last *.VTC file.

However, if multiple users are backing up to the same tape, it is essential that the Resync Volume Table before each Backup option is on. This ensures that the *.VTC file on each user's hard disk always displays the actual directory of the tape.

If there is any doubt about the contents of a SCSI tape, select the Catalog button in the Tape Directory window, which automatically compares and updates the VTC files.

Backup Strategies

Backing up your data depends on how frequently that data changes. Consider the following questions:

- How valuable are my files to me or my business?
- How many of my files change daily?
- How long would it take to replace those files if something happened to them?

CPBackup offers several methods of backing up your data, depending on drive, media, and speed.

Diskette Backup Strategy

Make and use setup files for different backup methods, or use the WEEKLY and DAILY setup files that came with CPBackup. Use at least two sets of backup disks so that you are never overwriting your last backup with the current backup.
Using a Preconfigured Setup File
CPBackup ships with a preconfigured setup file (WEEKLY) that is set to back up all files on your first hard drive (usually C) and another one called DAILY that backs up only the changed files since the last full backup.

To back up only changed files on a weekly basis:

1. Start CPBackup on Friday by typing:
   cpbackup weekly
2. Begin your backup using the first set of diskettes.
3. Label each diskette with its backup sequence number, name, and set number.
   For example, #1, Friday backup, Set A. The next diskette would be #2, Friday backup, Set A, and so on.
4. Start CPBackup on Monday through Thursday by typing:
   cpbackup daily
   When prompted, insert the last diskette of your backup set (if doing an incremental backup). For example, if you used 25 disks for your Friday backup, you would insert diskette #25 of backup set A. When prompted, insert additional diskettes as needed.
5. Label each diskette with its proper sequence number (#26 of Set A, #27 of Set A, and so on).

Each day, you back up and append the changed files to the Friday full backup set. By the end of Thursday's daily backup, you might have several disks beyond the original 25 you used on Friday.

Conversely, if you do a differential backup, you are prompted to insert a new diskette each day. If the need to restore ever arises, you restore the full backup and the last differential diskette.

To back up on even-numbered weeks starting on Friday:

Repeat the above steps, using the second set of diskettes. Be sure to label these as Set B.
Using Different Backup Methods
For many people, a monthly full backup is sufficient, coupled with daily backups of the changed files. Use one of the following methods, depending on your particular needs, every day:

- Do a daily differential backup to diskettes. Alternate between two sets of disks for safety. When the sets use more than six diskettes, do another full backup. The differential method does not save multiple daily versions of the changed files. It saves only the latest versions.

- Do a separate incremental backup on Monday (which starts a new backup set), followed by daily incremental backups to diskettes. This keeps daily versions of the files that change but creates less backup sets than using separate incrementals exclusively.

Tape Backup Strategies
A tremendous advantage to using a tape drive for your backup is its ability to totally automate your backups. A simple strategy is to use at least two tapes so you are never writing over your last backup with the current backup.

To back up using the two-tape strategy:
1. Schedule a weekly full backup using the WEEKLY setup file and Tape #1.
2. Schedule a daily backup using the DAILY setup file and Tape #1.
3. Use Tape #2 the second week, and continue alternating tapes each week.

Another popular backup strategy, referred to as “Grandfather, Father, Son,” uses 10 tapes and gives you a complete backup of 12 weeks’ data.

To back up using the ten-tape strategy:
1. Label the tapes as follows:

   1 - Monday
   2 - Tuesday
   3 - Wednesday
   4 - Thursday
   5 - 1st Friday
   6 - 2nd Friday
   7 - 3rd Friday
   8 - 1st Month
   9 - 2nd Month
   10 - 3rd Month

2. Use tape 5 on the first Friday and back up your entire system.
3. On the following Monday, use tape 1, labeled Monday, to do a separate incremental or differential backup of the changed files. Repeat this every weekday using the appropriately labeled tape.
4. On the second Friday, use tape 6 (2nd Friday) for another full backup, and repeat the Monday through Thursday backups, using the corresponding tapes (you will overwrite these tapes).

5. Repeat step 4 for week 3, using tape 7 (3rd Friday).

6. Repeat step 4 for week 4, and use tape 8 (1st Month) on the fourth Friday.

7. Repeat steps 2 through 6, using tape 9 (2nd Month) on the fourth Friday of the second month and using tape 10 (3rd Month) on the fourth Friday of the third month.

In subsequent months, recycle the three “Month” tapes, always overwriting the oldest tape.

**To back up using the combined diskettes and tapes strategy:**

Do full backups to tape, with subsequent differential or separate incremental backups to diskettes. This saves the expense of purchasing many tapes (as in the above strategy).

Use this method if you are backing up to a removable cartridge, such as a Bernoulli or SyQuest drive, or to a directory on a network.

**To back up using the removable media or network backup strategy:**

1. Create a subdirectory named FULL on the network or cartridge and do a full backup, either weekly or monthly, to it.

2. Create two subdirectories named DAILY1 and DAILY2 on the same drive.

   Alternate daily differential backups to the two DAILY directories.

By creating the three subdirectories, you avoid the problem of overwriting the three files that CPBackup writes that contain your data and information about the backup. These three files are:

- CPBACKUP.001, which contains your backed-up data.
- CPBACKUP.DIR, which contains the directory of the backed-up data.
- CPBACKUP.INF, which contains boot record information.
Using the CPBDIR Program

The CPBDIR program determines the number of disks and the correct order of a high-speed or medium-speed diskette backup (very helpful if you forgot to label the disks in their proper order) as well as information about how the backup was made.

Use the DOS DIR command on low-speed disks to find out the diskette number and date of backup. There will be two files on the diskette:

- CPBACKUP.INF
- CPBACKUP.nnn, where nnn is the diskette number of the set.

There will also be a CPBxxx.DIR on the last diskette of the set (this is the history file).

CPBDIR is a stand-alone application that you run by typing the following at the DOS command prompt. If you want to read a backup diskette from a different drive, type:

```
  cpbdir d:
```

where d is the drive letter of the drive where the backup diskette is inserted.

You must put a colon after the drive letter.

CPBDIR then displays information from the backup diskette, such as the disk number of the backup set, media used, formatting, speed used, and whether a directory exists on the diskette. CPBDIR recognizes the following parameters:

- d The drive the backup diskettes are in.
- /x An extended list of information about the backup disk.
Chapter 21. Using Stacker Compression

Stacker for Windows & DOS is the award-winning data compression standard that safely increases your disk capacity. Stacker’s patented LZS™ compression and new Stacker SmartPack™ combine to give you more disk space than any other data compression product.

Stacker transforms a typical 100MB disk into 250MB. Other compression products only double your disk, at best. Stacker is the first to more than double your disk and break through the 2-to-1 compression barrier.

Stacker takes full advantage of compression features built into PC DOS 7. If you have DoubleSpace/DriveSpace drives, SuperStor/DS drives, or previous Stacker versions Stacker automatically converts them and gives you even more extra space—the exception being Stacker for OS/2 & DOS.

Installing Stacker after Installing PC DOS

If you did not select Stacker Compression at the initial installation of PC DOS 7, you can still install this optional tool by rerunning PC DOS Setup using the /e switch.

The PC DOS installation diskettes contain everything you need to install Stacker on your system. Just install PC DOS again using the /e switch after PC DOS and Windows have been installed. The /e switch allows you to return to the optional tools selection menu without having to rerun PC DOS Setup again. At this point, only the necessary files for the optional tools are installed.

To install Stacker using the Setup /e switch:

1. Insert the Setup Diskette from the PC DOS installation diskettes into drive A or B.

2. At the DOS command prompt, type:
   a:setup /e
   or
   b:setup /e

** LZS and SmartPark are trademarks of Stac Electronics.

© Copyright IBM Corp. 1981, 1995

427
3. After Setup for PC DOS begins, follow the instructions displayed on the screen. Make sure you specify the same "Install to Path" as for the initial PC DOS installation.

At the Optional Tools screen, you will see NO next to Stacker Compression.

4. Either press the UP ARROW or DOWN ARROW until you highlight Stacker Compression, and then press ENTER, or click on the optional tool if using the mouse.

You can also select any of the other optional tools that you want to install by highlighting each tool and then pressing ENTER for each item.

You now see YES next to all the optional tools you selected.

Note: Selecting Yes to install Stacker Compression copies only the required compression files to the DOS directory. You must run Stacker Setup before compressing your data (explained in detail in "Starting the Stacker Setup Program (SSETUP)" on page 431).

5. Move the cursor to highlight the following:

Options correct. Continue Setup.

6. Press ENTER to accept the optional tool selections.

7. Continue following the instructions on the screen until the optional tools are installed.

---

**Before Using Stacker**

Stacker gives you more disk space by compressing files so they take up less space. Stacker's patented data compression technique—Stacker LZS—eliminates repetitive information from your files. And, Stacker SmartPack tightly packs your files into spaces on your disk that DOS cannot access without Stacker's help.

Unlike other compression products, Stacker monitors your compression. If your data compresses better than 2.5 to 1, Stacker adjusts your actual compression ratio to reflect the improvement, giving you the most space possible.

After you set up Stacker and more than double your disk space, you still use your computer just as you did before. The only difference is that you have a great deal more space on your disk.
What's New about PC DOS's Stacker Compression

Stacker now frees up more of your disk space and makes it easy to monitor your drives from either the Stacker DOS Toolbox or the new Stacker Windows Toolbox.

Stacker:

- *Gives you the most disk space.* Stacker continues to improve upon its patented, Stacker LZS technology to give you the most space possible.

- *Lets you take data on compressed disks anywhere*—even if the computer does not have Stacker installed, using Stacker Anywhere**.

- *Instantly converts other compressed drives.* The resulting Stacker drives give you more space than either DoubleSpace/DriveSpace or Superstor/DS.

- *Uses less memory.* Stacker uses as little memory as possible.

- *Makes monitoring your drives effortless.* Stacker DOS Toolbox tools show you extra bytes, free space, and fragmentation. All Stacker's tools are on an easy-to-use menu in the Toolbox.

- *Fine-tunes for Stacker MaxSpace* ** or Stacker MaxSpeed** **. Choose from 10 tuning settings (available for DOS by editing the STACKER.INI file or available for Windows using the Windows Toolbox). Then, even if you set your computer for MaxSpeed, you can use the Optimize tool's Full-MaxSpace method to recompress occasionally and gain more space.

- *Guards your data.* Every time you start up your system, Stacker runs AutoProtect to make sure your data is in good condition. Stacker AutoSave, available only through the Windows Toolbox, backs up important file-access information.

- *Shows how much data needs backing up.* The new Backup Status gauge, available only through the Windows Toolbox, keeps track for you.

- *Flashes or plays sounds to remind you of disk maintenance tasks.* You can set up the Stacker Windows Toolbox to let you know when the disk is getting full or when it is time to back up files or optimize your disk.

** Stacker Anywhere, Stacker Maxspace, and Stacker Maxspeed are trademarks of Stac Electronics.
Getting Stacker Help
Stacker includes comprehensive online help. Help is available at the press of a key or a click of your mouse.

- **Need help during Stacker Setup?** Press F1 or click on Help.
- **Need help using the Stacker DOS Toolbox?** Press F1 to get context-sensitive help from any screen.
- **Need help using the Stacker Windows Toolbox?** Select Toolbox Help from the Help menu to see the index of topics. Or, press F1 to get context-sensitive help on any dialog box or screen.
- **Need help on general topics?** Double-click on the Stacker Help icon in the Stacker Windows Program group.

For late-breaking information not included in this guide, refer to the README.TXT file located in the STACKER subdirectory.

**Note:** If you have not run Stacker Setup (SSETUP), this file will be in the C:\DOS\STACKER subdirectory (if this is the directory where you installed PC DOS to). After running SSETUP, this file will be located in the C:\STACKER directory.

For PC DOS, use any text editor, such as the PC DOS E Editor, to view this document. For Windows, double-click on the Readme icon in the Stacker Program Group.

Setting Up Stacker
Setting up Stacker is easy. All you have to do is:

- Install Stacker files using the PC DOS Setup program (PC DOS SETUP command).
- Back up your data before you run the Stacker Setup program.
- Set up Stacker initially using the Stacker Setup program (SSETUP).
- Use the Stacker Setup program (SETUP) for compressing additional drives thereafter (after you initially have run SSETUP).
Back up Your Data
Before setting up Stacker, back up your data. Stacker is completely safe and does not harm your data. Still, before making any system change, it is always a good idea to back up. If you have a backup routine, just follow it, but do a complete backup.

If you use a tape backup, do a file-by-file backup (not an image backup). Refer to Chapter 20, “Using Central Point Backup” on page 383 for details on backing up.

Starting the Stacker Setup Program (SSETUP)
Start the Stacker Setup program (SSETUP) from DOS or Windows and press ENTER as required in response to the screens. When Stacker finishes, continue working with your system as you always did but with more than double the disk capacity.

Setting up Stacker is easy under either DOS or Windows. Even if you set it up under Windows, Stacker still has to exit to DOS to perform its work.

To set up Stacker:

1. Be sure you selected Stacker Compression when you first installed PC DOS.
   You can verify that you selected compression by checking if you have a Stacker directory (for example, if you selected the default directory when installing PC DOS, the Stacker files are copied to the C:\DOS\STACKER directory) until you run Stacker Setup (SSETUP).
   If you did not select compression during the installation of PC DOS, you cannot run SSETUP. Refer to “Installing Stacker after Installing PC DOS” on page 427 before proceeding with Stacker Setup.

2. From the DOS command prompt, type:
   ssetup

3. Press ENTER.

4. Follow the instructions on your screen.
   If your computer has an LCD, gray-scale, or monochrome monitor, type ssetup /m so you can read the screens easier.

   If you are planning to use Stacker from Windows, from the Program Manager’s File menu, select Run. In the Command Line field, type ssetup and press ENTER.
If you do not have Windows installed yet, you should install Windows first so that your Stacker Windows group will be set up automatically for you. If you already have Stacker installed and need to install Windows, do so and then use the Stacker SGROUP command to create the Stacker Windows group. Type help sgroup at the DOS command prompt for complete information.

Creating Stacker Drives after Initial Stacker Setup (SETUP)
While running SSETUP for the initial installation of Stacker, the Stacker directory and files are moved from C:\DOS\STACKER to C:\STACKER.

Thereafter, just use Stacker’s SETUP command to compress any additional drives. Refer to “Compressing Additional Drives” on page 440 for complete instructions.

Getting Help on Stacker Setup
Stacker Setup guides you through a series of decisions. If you are not sure which choice to make, you can get help by pressing F1 or click on Help from any of the screens. If you are still not sure about a Stacker Setup screen choice, accept Stacker’s default—simply press ENTER.

Choosing Express or Custom Stacker Setup
If earlier versions of Stacker or other types of compressed drives are detected when you run Stacker Setup, you are asked to choose one of two setup methods—Express or Custom.

Choose Express to:
• Set up Stacker quickly and easily.
• Set up Stacker on all hard disks or partitions larger than 5MB.
• Let Stacker make the decisions for your system.

Choose Custom to:
• Set up Stacker on one disk or partition at a time.
• Compress only the free space left on the disk. Free space is space not used by data. You will be asked how much free space you want to reserve as uncompressed space.
• Control options such as whether or not to use Expanded Memory Specification (EMS), the cluster size of your Stacker drives, or how much space to leave uncompressed.
Upgrading Stacker and Getting the Best Compression

When you run Stacker Setup, it detects any earlier versions of Stacker on your system and offers you two options—Full Update or Quick Update. Select Full Update. It might take as long as a few hours, but Full Update is a thorough upgrade for your entire system and gives you the best compression.

Choosing a Full Update:

- First updates earlier Stacker files.
- Then defragments the drive.
- Recompresses the data using Stacker's improved compression technology to give you up-to-date optimum compression.

If you select Quick Update, Stacker updates any earlier files but does not defragment or recompress any files on the drive. To take advantage of Stacker's compression, recompress the drive later to improve compression. To do so, you can use the Stacker Optimizer** tool through the Stacker DOS Toolbox. Just select Full-MaxSpace as the optimization type.

Stacker's Optimizer uses extended memory while defragmenting your Stacker drives. Stacker Optimizer uses as much extended memory as it can, thus reducing the amount of conventional memory it needs.

** Stacker Optimizer is a trademark of Stac Electronics.
**Note:** If your system does not use extended memory, the Optimizer uses conventional memory.

For more detailed information about memory requirements, refer to “Using DPMS with Stacker” on page 462.

**Converting DBLSPACE or DRVSPACE Drives**

If you have DBLSPACE or DRVSPACE drives compressed by:

- PC DOS’s SuperStor/DS (Versions 6.1 and 6.3)
- Microsoft’s DoubleSpace (Versions 6.0 and 6.2)
- Microsoft’s DriveSpace (Version 6.2.2)

Stacker Setup automatically converts them to Stacker drives. The drives must be mounted before Stacker can convert them. Refer to your original compression product's documentation for mounting details.

Stacker and another compression program cannot both work on the same system. After you install Stacker, you will not have access to the data on unmounted drives compressed by other products. You must first mount the drives, temporarily or permanently, and then run either DCONVERT or HCONVERT (for previous versions of Stacker). For information about these commands, type `help` at the DOS command prompt followed by the name of the command (for example, `help dconvert`).

During Stacker Setup, when it encounters mounted drives compressed by other software, Stacker Setup lists the drives it converts.
When Stacker builds a compressed file on one of your existing uncompressed fixed or removable disks (called the *host drive* after compression is completed), Stacker remaps your drives.

When you select Convert, Stacker restarts your computer, runs CHKDSK, and offers to run a base-level safety check to make sure none of your data was corrupted by previous compression. Press ENTER to answer Yes. Ensuring your data's safety takes only about two seconds per megabyte. If the safety check finds any errors and offers to fix them, let it.

Running the safety check and fixing even minor problems now helps you avoid major problems later. After the safety check, Stacker Setup converts your DoubleSpace/DriveSpace or SuperStor/DS drives to Stacker drives.

If you are converting compressed files from another type of compression program, Stacker Setup may display a message that there is not enough space to convert the files. Try moving some files to another disk or drive and rerun Stacker Setup. If you get the same message, you may need to make more space available on the uncompressed portion of the drive. See your other compression program’s documentation for information about how to make more uncompressed space available. Then, rerun Stacker Setup.

Stacker's safety and compression features are now installed on your computer. To take advantage of Stacker's compression, you will want to recompress the data on the converted drive. You can run the Stacker Optimizer from the Stacker Toolbox and select Full-MaxSpace. Until you have optimized the drive, each time you start the computer, Stacker reminds you to do so to get the best possible compression and safeguards for your data.

**Converting Removable Disks**

Stacker's Setup converts only mounted, fixed DoubleSpace/DriveSpace or SuperStor/DS (DBLSPACE) drives. However, Stacker's DCONVERT program easily converts a removable disk, such as a floppy disk, a Bernoulli, or a SyQuest.

*This program works only under DOS.*

For this example, let's assume that drive G: is a Bernoulli drive that was compressed with SuperStor/DS. In the conversion procedure, you will check the drive for any pre-existing problems, run a program called DCONVERT to convert the drive, and then mount the new Stacker drive.

Because it is not yet a Stacker drive, drive G does not appear in Stacker's drive map.
The following procedure assumes you have already installed Stacker.

To use the DCONVERT program to convert the drive and mount the new Stacker drive:

1. Check for any pre-existing problems.
2. If you are in Windows, you must exit to DOS because this procedure works only under DOS.
3. Insert the removable disk into its drive.
4. Check the drive for any pre-existing problems. For this example, at the DOS command prompt, you would type:
   
   chkdsk g:

5. Press ENTER.

   Let the DOS CHKDSK utility fix any problems it finds.

To convert the drive to a Stacker drive:

1. Find the name of the compressed volume file by typing:
   
   dir g: /ah

2. Press ENTER.

3. Look for a filename such as DBLSPACE.000. Note the name to use in the next step.

4. At the DOS command prompt, type:
   
   dconvert /c g:\dblspaee.000

   where DBLSPACE.000 is the drive to be converted to a Stacker drive.

5. Press ENTER.

CAUTION:
Do not interrupt the conversion process! If you do not let DCONVERT finish, you may lose data.

DCONVERT converts the drive into a Stacker drive. The name of Stacker's "volume file" is STACVOL.DSK.
To mount the drive as a Stacker drive:
1. Ensure that the removable disk is in its drive.
2. From the DOS command prompt, type:
   \texttt{config}
3. Press ENTER.
4. Allow the program to make changes to your STACKER.INI file.
5. Restart your computer.

To recompress your data with the Stacker Optimizer:
1. At the DOS command prompt, type:
   \texttt{stac}
2. Press ENTER.
4. Select the drive you want to recompress.
5. Select Full-MaxSpace.
   Stacker recompresses the data on the selected drive.
Monitoring Your Drives from DOS

After Stacker is installed, you do not have to do anything else. But, if you want to check how a drive is doing or modify Stacker settings, you can. Stacker’s Toolbox is your gateway to Stacker tools.

You will learn how to:

• Use the Stacker DOS Toolbox to perform Stacker tasks when you are not using Windows.

• Use the Stacker Windows Toolbox to:
  – Get drive information and perform Stacker tasks.
  – Interpret the Toolbox gauges.
  – View Stacker information about your files and drives from the Windows File Manager.

Both the Stacker DOS Toolbox and the Stacker Windows Toolbox are described in the following sections.

The Stacker DOS Toolbox lets you monitor your Stacker drives from DOS. The Toolbox contains Stacker’s most commonly used tools.

Once you select a tool on the left, the information on the right explains how to use it.

Stacker 4.0 for Windows & DOS

Stacker Toolbox

Compress

Compress Drive

Check

Check Integrity

Optimize

Stacker Optimizer

Configure

Change Drive Size

Toolbox lets you compress any disk.

After you press Enter, Stacker Toolbox transfers you to Setup. You choose the drive to compress, whether to compress the entire disk or just the free space, and any other Setup options.

You can choose any valid disk on your system, including removable ones.

F1 for help. Arrows (F1) to select. F10 to exit.

Then, for more information, press F1 for help.
To use the Stacker DOS Toolbox:

1. If the Stacker directory is not already in your PATH statement, change to your Stacker directory first.

2. At the DOS command prompt, type:
   
   stac

   and press ENTER.

3. Using the UP ARROW or the DOWN ARROW, highlight the tool, and press ENTER, or press the highlighted letter of the tool.

4. Follow the directions on the screen for choosing options. You can press F1 to get help at any time.

The following table summarizes the tools in the Toolbox.

<table>
<thead>
<tr>
<th>Use this tool...</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compress Drive</td>
<td>Run Stacker Setup to compress additional hard disks or diskettes.</td>
</tr>
<tr>
<td>Compress Floppy</td>
<td>Compress the available free space on diskette or other removable diskettes.</td>
</tr>
<tr>
<td>Uncompress</td>
<td>Uncompress your Stacker drive and reverse the Stacker Setup process.</td>
</tr>
<tr>
<td>Check Integrity</td>
<td>Check the integrity of your Stacker drive and fix any errors.</td>
</tr>
<tr>
<td>Compression Report</td>
<td>Display compression and disk usage information.</td>
</tr>
<tr>
<td>Stacker Optimizer</td>
<td>Defragment or recompress files on your Stacker drive.</td>
</tr>
<tr>
<td>Stacker Tuner</td>
<td>Control the balance between how tightly and how quickly Stacker compresses data after Stacker Setup.</td>
</tr>
<tr>
<td>Change Drive Size</td>
<td>Increase the Stacker drive size or make more compressed space.</td>
</tr>
<tr>
<td>Expected Compression</td>
<td>Change the expected compression ratio for your Stacker drive.</td>
</tr>
<tr>
<td>Passwords</td>
<td>Assign a password to your Stacker drive for read/write or read-only access or remove an existing password.</td>
</tr>
</tbody>
</table>
Using the Stacker Tools (DOS and Windows)

Stacker has a complete set of tools for compressing additional data, improving your computer's performance, and protecting your data. This section describes how to use tools from the Stacker Toolbox. You will find information about:

- Compressing your data whether it is on another hard disk, a diskette, or another removable drive.
- Using a compressed diskette (or other removable) on computers with or without Stacker by running Stacker Anywhere.
- Improving your Stacker drive's performance by tuning, defragmenting, or recompressing.
- Protecting your Stacker drives by ensuring the safety of your data and limiting access with passwords.

Compressing Additional Drives

After installing Stacker, you can compress data on another hard disk or on removables, such as diskettes or opticals.

Compressing Hard Disks

When you set up Stacker, you may have left some partitions uncompressed on your disk. Or, perhaps you have added another hard disk to your computer.

From DOS, you can use the Compress Drive command in the Stacker DOS Toolbox to compress data on another partition or on another hard disk.

To compress another hard disk:

1. At the DOS command prompt, type:
   
   stac

2. From the Stacker DOS Toolbox, choose the Compress Drive tool.
   
   Stacker Setup begins.

   If Stacker detects any terminate-and-stay resident programs loaded in memory that might interfere with compressing your disks and prompts you for a response as to whether you want to remove them temporarily.
3. Select Restart if you want Stacker Setup to take care of them.

4. When prompted, choose the drive to compress.

5. To compress existing data on the disk, choose Entire Drive.

6. To create a new Stacker drive from the free space on the disk, choose Free Space. You will have to specify how much free space to use on the disk.

7. Follow the instructions on the screen.

For an overview of the Stacker DOS Toolbox, see "Monitoring Your Drives from DOS" on page 438.

From Windows, select an uncompressed drive, if necessary, to make the Compress tool available; then, select the Compress tool. After Stacker Setup begins, choose OK when prompted to exit Windows and continue the steps above under DOS, starting with step 4.

**Adding New Drives**

Here's what happens when you add another drive to your system. When DOS loads, it assigns drive letters to recognized hardware, such as hard drives. If you have one hard drive (C) and you compress it with Stacker, and you add another drive, DOS assigns it the next letter (D).

When you use Stacker to compress the data on a hard disk, such as drive C, Stacker creates an uncompressed drive that works in concert with the original drive. Stacker drive letter assignments begin after the other DOS drive letter assignments. Because letters C and D have been assigned, Stacker drive letters adjust. The next drive letter (E) is assigned to the uncompressed drive that works with drive C. You still find your data on drive C, and your new hard disk is drive D.
To see all your drive letters and their corresponding Stacker drive letters, at the DOS command prompt, type:

    stacker

If you add a software-driven removable drive or one that requires a specific drive letter, you will need to modify Stacker's configuration. See “Working with Advanced Stacker” on page 455, for the procedures.

---

**Compressing Diskettes (or Other Removables)**

Use Stacker to compress your diskettes or other types of removables, too. Why be content with a standard 1.4MB diskette when Stacker can turn it into approximately a 3.4MB diskette. You can use these diskettes anywhere, even on computers that do not have Stacker.

Most users format several diskettes at a time. It is just as easy to compress several diskettes at the same time, so have several diskettes ready to use.

You can use either the Stacker DOS Toolbox or the Stacker Windows Toolbox to compress diskettes or removables.

**To compress a removable or a diskette:**

1. At the DOS command prompt, type:

    stac

2. From the Stacker DOS Toolbox, choose Compress Drive and press ENTER.

    If Stacker detects TSRs, it will prompt you for a response as to whether you want to remove them temporarily. If Stacker removes them, the system must be rebooted before Stacker Setup lists drives you can compress.

    **Note:** If you are using OS/2, any files shared by DOS and OS/2 should not be compressed. A warning message appears if OS/2 files are detected.

3. Following the removal of TSR programs and reboot of the system, insert the removable or diskette into the diskette drive.

4. Select the drive where you inserted the removable diskette (usually drive A or B) to let Stacker create and verify the drive.

5. Select Continue.

6. When Stacker Setup asks if you want to compress the Entire Disk or just the Free Space, select Entire Drive,
If you want to compress empty diskettes using this procedure, select Free Space. If you should choose to compress only free space, decide how much of the free space you want to compress.

7. Then select Compress to continue. Answer any additional screen prompts.
   You will see a message if the Stacker drive is created successfully.

8. If you have more diskettes to compress, select Compress Another and follow the instructions on the screen and repeat the procedures for each diskette.

9. When Stacker Setup finishes, restart your system by selecting Restart after all the diskettes have been compressed.

If you want to use Windows to compress an empty diskette or a removable that already has data on it, you can use the Stacker Windows Toolbox. Insert the empty diskette into the disk drive. From the Stacker Windows Toolbox, select the removable drive (usually A or B) and click on the Compress tool, and then click on OK to let Stacker create and verify the drive. Choose OK to return to the Windows Toolbox. Then, click once more on the removable drive to refresh the screen and see the new compression.

After you compress a disk in a removable drive, you can use either standard disks or Stacker disks in that drive. Stacker recognizes both formats. For more information about AutoMounting procedures, see “Working with Advanced Stacker” on page 455.

The Stacker-compressed disk is slightly less than 3.4MB. When you compressed the disk, Stacker put a special program—Stacker Anywhere—onto the uncompressed portion of the disk, which is why you have a bit less than 3.4MB. This program lets you use the disk on non-Stacker systems. Because you already have Stacker on your system, you do not need to use this program. But, if you want to use the disk on a computer that does not have Stacker, you can use Stacker Anywhere to access your data.

Using Stacker Anywhere on Non-Stacker Systems
  If you try to use a Stacker-compressed diskette on a non-Stacker system, you will not see your data files.

  Note: If you have Stacker on your system, use the Stacker tools instead of Stacker Anywhere to work with your data files.
Mounting a Drive on a System Without Stacker
First you need to mount the drive so it can recognize Stacker's format. How can you mount a drive on a system that does not have Stacker? Use the Stacker Anywhere program that Stacker conveniently loaded onto the disk during compression.

To mount a Stacker Anywhere drive under DOS:
1. If you are using Windows, you must exit Windows completely.
2. Change to the drive where you insert your diskettes or removable.
3. At the DOS command prompt, type:
   
   stacker drive:
   
   where drive: is the letter of the drive you want to mount.

   This is a temporary mount. If you restart your system, you will have to remount the drive.

When you use Stacker Anywhere to mount a drive under Windows, the data on the disk is available only from Windows. If you try to view the data from DOS, DOS reports that the drive is no longer valid. If you want the data to be accessible from either Windows or DOS, mount the drive under DOS.

To unmount a Stacker Anywhere drive under DOS:
1. Change to the drive where you insert your diskettes or removable.
2. At the DOS command prompt, type:
   
   exit
   
   Each time, type exit to unmount the last drive that Stacker Anywhere mounted. This is a temporary unmount. If you restart your system, the drive will not be remounted. For information on permanently mounting a drive, refer to “AutoMounting a Removable Diskette Drive” on page 465.

   If you used Windows to mount the drive, you will need to unmount it from Windows.
To mount a Stacker AnyWhere drive under Windows:

1. Start Windows File Manager.
2. Insert the Stacker removable diskette into the disk drive.
3. Click on the drive icon for that drive.
   The Windows File Manager lists files on the uncompressed portion of the drive.
4. Double-click on STACKER.EXE to run the Stacker Anywhere program.
5. Click on OK to let Stacker Anywhere mount the drive.
6. Click on OK again.
7. Reselect the drive icon to refresh the Windows File Manager and access your data files. Use the disk as you would any other disk.

The STACKER.EXE file does not appear when the drive is mounted. Instead, you see your data files. After you start Stacker Anywhere, it stays in memory until you exit Windows. You can mount and unmount removable drives at any time during this Windows session. Use the icon that remains on the desktop for easy access.

Note: When the Compression Ratio gauge on the Stacker Windows Toolbox shows 1.0 compression (none) if you insert a compressed, removable diskette, then the drive is unmounted. Either perform a temporary mount or AutoMount the drive to access the data on the disk. For information on how to perform either a temporary or a permanent mount, refer to “AutoMounting a Removable Diskette Drive” on page 465.

Unmounting a drive
If you need to unmount a Stacker Anywhere drive, the procedure will depend on how you mounted the drive. If you mounted the drive from DOS, you must unmount the disk under DOS.

To unmount a Stacker Anywhere drive under Windows:

1. Start Windows File Manager.
2. Insert a compressed removable diskette into the diskette drive, if necessary.
3. Click on the drive.
4. Press ALT+TAB until you see the Stacker Anywhere icon. Choose Unmount from the Stacker Anywhere icon’s menu.
5. Click on OK.
Uncompressing a Stacker Drive

Stacker's Uncompress tool takes all your files out of the Stacker drive, decompresses them, and places them back on the uncompressed drive.

In the Stacker DOS Toolbox, choose Uncompress. When you choose it, Uncompress first checks to ensure that you have enough space for your uncompressed data. It may ask you to remove some files to make room before it can uncompress.

To uncompress a Stacker drive:

1. At the DOS command prompt, type:
   `stac`
2. From the Stacker DOS Toolbox menu, use the UP ARROW or DOWN ARROW.
3. Select Uncompress, and press ENTER.

4. Select the Stacker drive you want to uncompress.
   Stacker makes sure you have enough space for all your uncompressed data and optimizes your disk in preparation for decompressing the data.

5. When the optimization is done, Stacker asks Are you SURE?? that you want to Uncompress. Answer Yes if you really want to uncompress and press ENTER.
   If this is the last Stacker drive, Stacker asks if you want to remove Stacker from your system configuration. Select Remove Stacker to do so.

6. Press ENTER to restart your system.
In the Stacker Windows Toolbox, the Uncompress Disk tool appears only on the Tools menu. When you are using Windows, click on the Uncompress tool, and then click on OK to leave Windows. The process is the same as under DOS.

Improving Stacker Drive Performance
Stacker drives can get even better performance when you maintain them in optimal condition. In this section, you will learn how to improve the speed and responsiveness of your Stacker drive.

You will see how to:
• Tune your system for the best balance between compression and speed.
• Optimize the Stacker drive by defragmenting it.
• Recompress data while defragmenting it by choosing Full–MaxSpace. This process is especially important if you have upgraded Stacker or converted from another compression product. It ensures that you get the best compression and all Stacker's safety features.
• Increase performance by using 32-bit file access and Windows for Workgroups**.

Tuning Your Compression
Stacker works by compressing and decompressing data as you use it. The Stacker Tuner controls the balance between how fast Stacker works (speed) and how tightly it compresses data (space). For Windows, the tuning is known as MaxSpeed and MaxSpace, respectively.

Stacker Setup automatically sets the Tuner to maximum space. This gives you the maximum compression, but Stacker's speed is a bit slower. However, most computers today are very fast. You will probably never notice any difference in speed. If you prefer, you can select a faster speed, but data will not compress quite as well.

The DOS Toolbox offers three tuning settings. You can use Stacker's maximum compression, a middle setting, or the fastest setting.

** Windows for Workgroups is a trademark of the Microsoft Corporation.
Or, you can fine tune your compression settings even further by editing the STACKER.INI file. The /p=n parameter can be set to any number from 1 to 10, where 10 is the most compression and 1 is the least.

The tuning setting you choose affects all Stacker drives on your system. Whenever your system has to read to or write from a drive, depending on the tuning setting you selected, you might notice some reduction in system performance.

To change compression tuning:

1. At the DOS command prompt, type:
   
   stac

2. From the Stacker DOS Toolbox, select Stacker Tuner.

3. Use the arrow keys to get the setting you want, and then select Continue.

If you have an older, slower computer, you can lower the Tuner setting to increase Stacker's speed. Of course, this means that you will not receive the best compression. To keep the speed and also get maximum compression, periodically choose Full–MaxSpace from the Stacker Optimizer to recompress all the data on the drive.

Changing the tuning affects your entire Stacker configuration. From this point on, any data you write to your disk is compressed using this tuning setting.
When you are not using DOS, click on the Tune tool from the Stacker Windows Toolbox. You can tune to 10 compression settings. Move the slider to the setting you want or click on MaxSpace (for maximum compression) or MaxSpeed (for fastest speed). Then, click on OK.

Understanding Fragmentation
When you save files, DOS organizes them and writes them to the disk in areas called clusters or allocation units. DOS tries to store each file in one continuous location. As disks get full and file sizes change, however, DOS might not be able to find large blocks of contiguous space. As a result, file access takes longer while DOS locates and keeps track of all the pieces.

Optimization reduces fragmentation on disks. If a disk is highly fragmented, optimization will speed up file access and increase your disk's efficiency.

Optimizing a Stacker Drive
You can defragment a drive with quick or full optimization or while recompressing the data. A quick optimization defragments the clusters, making access quicker and easier. A full optimization defragments the files as well; it also compacts the free space so that all the files are at one end of the disk and all the free space is at the other. Full optimization takes much longer, of course. Choosing Full-MaxSpace tightly recompresses all the data on the disk, along with a full optimization.

Note: Always use the Stacker Optimizer to defragment your Stacker drives. Do not use a non-Stacker optimizer unless it has been updated to work on Stacker drives.
To optimize your Stacker drive:

1. At the DOS command prompt, type:
   
   stac

2. From the Stacker DOS Toolbox, select Stacker Optimizer.

3. Select the drive you want to optimize.

4. Select one of the following: Quick Optimize, Full Optimize, or Full-MaxSpace. 
   
   Do not press CTRL+ALT+DEL or reset your computer during optimization. If you have to quit, press F10 as indicated on the screen. This leaves the disk in usable condition.

   You will see messages on the screen as the Stacker Optimizer analyzes the drive. It reports a fragmentation level and lets you continue or exit.

   If you choose to continue, Stacker Optimizer begins optimizing the drive. You ultimately see a drive map on the screen like the following one.

   ![Drive Map](image)

   The Stacker Optimizer moves data around as it defragments the drive.

5. When it is finished, follow the instructions on the screen. DOS is able to find data more quickly after optimization.

To optimize your Stacker drive if using Windows, select the drive, and then click on the Optimizer tool. Click on Quick, Full, or Full-MaxSpace. Then, click on OK. Follow the same procedures as for DOS until you have to click on OK to leave Windows so the Stacker Optimizer can complete its work. After Stacker Optimizer leaves Windows, you ultimately see a drive map on the screen similar to the one for DOS.
Recompressing Data
The Stacker Optimizer can recompress data as it optimizes. Just choose Full–MaxSpace to get the very best compression possible. After defragmenting and recompressing the data, Stacker recalculates how much space is available, based on the current status. If you have converted from an earlier Stacker drive format or another compression product, optimizing with Full–MaxSpace gives the full benefits of Stacker.

You will want to recompress a Stacker drive if you have:
• Converted from another compression product.
• Chosen Quick Update when you upgraded from an earlier Stacker version.
• Used Stacker for several months without your tuning set to MaxSpace.

To recompress data:
1. At the DOS command prompt, type:
   stac
2. From the Stacker DOS Toolbox, select the Optimizer tool.
3. Choose the drive to optimize, and then select Full–MaxSpace.
4. Follow the instructions on the screen.

If you are using Windows, select the drive and then click on the Optimizer tool. Click on Full–MaxSpace. Then, click on OK to leave Windows so the Optimizer can complete its work. Follow the instructions on the screen. It works much as it does through DOS.

The Optimizer fully optimizes while recompressing all the data, so you get the most space possible. Stacker returns you to Windows after it is finished.

Protecting Your Data
Like most computer users, you are concerned about the safety of your data. Stacker includes many features that protect data from damage and help you correct any problems that may occur.
This is how these safety features work:

- AutoProtect looks for problems every time you start up your system and fixes most of what it finds. Stacker automatically write-protects a disk whenever it senses a problem.
- Check verifies Stacker drives and repairs any problems.
- Passwords limit access to data on your Stacker drives.
- AutoSave, if you are using Windows, maintains a copy of the Stacker drive header, which contains essential information that lets Stacker find your data.

**Running AutoProtect**

Stacker's AutoProtect feature adds an extra level of protection for your data. AutoProtect works when you restart your system and while you use your Stacker drive.

AutoProtect regularly scans your Stacker drive for problems. When it detects a problem, Stacker immediately write-protects the drive to protect your data from any further damage. Just remember: the write-protection is there for you. Your data is still safe; Stacker has write-protected it, so you do not risk losing data by making changes.

Stacker Setup inserts a command like this one in your AUTOEXEC.BAT file:

```
c:\stacker\check /wp
```

**Note:** C:\STACKER is the default path where your Stacker compression files are placed during Stacker Setup—unless you specified another path during Setup. This chapter refers only to the default Stacker Setup path in its examples.

This command looks for write-protected Stacker drives, makes any repairs it can, and removes the write-protection. If CHECK detects problems it cannot handle, you will see messages that tell you what to do.

**Checking Your Stacker Drives**

The same processes in your computer system that cause DOS-related problems may also cause Stacker drive problems. It is a good idea to check your drive regularly to prevent any potential problems.

Stacker’s Check tool examines your data integrity and drive integrity. When run under DOS, Check can correct any problems that involve the Stacker structures on the disk.
Checking drive integrity involves several steps:

- Checking the file structures on the disk (cluster and file allocation table (FAT) integrity).
- Repairing any errors found.
- Checking the disk media (surface scan).

It is a good idea to run the Check tool every few weeks to verify the Stacker structures and eliminate trouble. Check might recommend that you run DOS's CHKDSK to solve DOS problems. Running a disk-repair utility after running CHECK, especially if CHECK detects any problems, can capture DOS problems as well.

**Note:** Under PC DOS 7, after CHKDSK tests a Stacker drive, it runs CHECK to look for Stacker structure problems.

Take time to correct any problems identified by either CHKDSK or CHECK before doing anything else. If Stacker write protects the Stacker drive to protect data from further damage, restart your computer or run CHECK again. After it fixes problems, CHECK removes the write protection.

**Checking a Disk**

Stacker works at the DOS level to repair your disk. If Check detects any problems, it tells you how to repair them.

**To check the drive integrity:**

1. If you are running Windows, exit Windows.
2. To open the Stacker DOS Toolbox, type the following at the DOS command prompt:
   ```
   stac
   ```
3. Select Check Integrity and follow the instructions on the screen.

You will see messages on the DOS screen as CHECK examines the Stacker structures. If the Stacker CHECK command finds a Stacker problem, it suggests that you run CHECK /F under DOS to make the repairs.

If you are using Windows, while at the Stacker Windows Toolbox, choose the drive. Then, click on the Check tool. To make repairs, just exit to DOS and run CHECK /F to fix the Stacker drive.
Using Passwords

You can assign a password for your Stacker drive to keep your data safe from other users. Stacker supports two types of passwords:

*Read/write*  
Gives a user full access to the disk.

*Read-only*  
Lets a user read and print data but does not permit any changes or file deletions.

After you have password-protected your disk, keep the password in a safe place for system protection. Each time Stacker mounts the drive (usually at startup), you enter the password to gain access to the disk.

**To set or change a password:**

1. At the DOS command prompt, type:
   
   `stac`

2. From the Stacker DOS Toolbox, select *Passwords*.

   The first password you assign is always a read/write password.

3. Enter the new password. Then confirm it by entering the same password again.

4. If the drive already has a read/write password, a Read-Only field appears. Check it to use a read-only password.

   If the Type Old Password field appears, you must enter it before changing an existing password.
5. Type your new password in the Type New Password field, and type it once more in the Verify New Password field.

6. Select OK to activate the password.

7. Select OK again to return to the Stacker DOS Toolbox.

If you are using Windows, from the Stacker Windows Toolbox click on the drive, click on the Password tool, and then click on Set Password.

**To remove a password:**

1. At the DOS command prompt, type:
   ```
   stac
   ```

2. From the Stacker DOS Toolbox, select Password.

3. Type the current password in the Password field and press ENTER.

4. Leave the Password field blank if you want to remove the current password, and press ENTER.

5. Then, leave the Password field blank again to verify the removal, and press ENTER.

If you are using Windows, from the Stacker Windows Toolbox, select the drive and then click on the Password tool. Click on Remove Password. Follow the same steps as for DOS. When completed, click on OK.

---

**Working with Advanced Stacker**

After Stacker is installed, you may never have to think about it again. In certain situations, you may have to go beyond the simple Stacker Toolbox. You can tailor Stacker's configuration for your system and learn how to:

- Change the Stacker drive size or expected compression ratio if you change how you use Stacker.

- Examine or change Stacker's configuration to take advantage of changes in your system.

- Type advanced Stacker commands at the DOS command prompt to monitor and maintain your computer.
Changing Stacker Drive Size

After Stacker Setup, the Stacker drive (the STACVOL file) contains all your data in compressed form. The uncompressed drive still contains some uncompressed data, such as system files, and it holds the compressed STACVOL file.

The sizes of the STACVOL and the remaining space on the uncompressed drive are fixed relative to each other; if you make one larger, the other gets smaller.

Making a larger Stacker drive: If you move a permanent swap file to a Stacker drive, you may want to enlarge the Stacker drive to reclaim the unused, uncompressed space.

Making more uncompressed space: If the STACVOL file is very large and there is little free space available on the drive, move some files to another disk or drive to free up space within the STACVOL file. You can then shrink the Stacker drive, which results in more space on the uncompressed drive.

You will not have to change the size of a Stacker drive very often; most users never have to. If you get a message indicating that there is not enough compressed or uncompressed space to do something, use the following procedure to make room.

To change the Stacker drive size:

1. At the DOS command prompt, type:
   
   `stac`

2. From the Stacker DOS Toolbox, select Change Drive Size.

3. Select the Stacker drive.

4. Select the resize option you want:
   
   • To make the Stacker drive larger, select Increase Stacker drive size.
   • To make the Stacker drive smaller, select More uncompressed space available.

   Stacker can resize a Stacker drive without defragmenting first.
Stacker 4.0 for Windows & DOS

Choose if you need to store more compressed data on the Stacker drive. This choice increases the size of your Stacker drive and decreases the amount of your uncompressed space.

Choose if you need more room for uncompressed data. This choice increases the size of your uncompressed drive and decreases the size of your STACUOL.DSK file. Stacker adjusts the expected compression ratio so your Stacker drive remains the same size. If the expected and actual compression ratios are significantly different, some programs may not report available space accurately. You can change your expected compression ratio using the Stacker DOS Toolbox.

5. When Stacker displays the acceptable size range, type the size you want the final Stacker drive to be.

6. If you agree with the displayed results, select Perform changes on Stacker drive. Otherwise, select Modify settings or Exit. Stacker changes the Stacker drive.

7. When prompted, press ENTER or any other key to restart your system.

If you are using Windows, you can change the Stacker drive size by selecting the Stacker drive. From the Stacker Windows Toolbox, click on the Configure tool, click on Change Stacker drive size, and then click on OK.

Click on OK again to leave Windows and complete the operation. From this point on, the procedure is the same as for DOS. After changing the Stacker drive size, Stacker returns you to Windows.

Changing Expected Compression Ratio

As you use your computer, data on your disk may compress differently than it did when you first set up Stacker. This may result in an actual compression ratio significantly better or worse than the expected compression ratio. Stacker Windows Toolbox gauges and the Stacker Report show how the expected and actual compression ratios compare. If the two ratios are far apart, some programs may not be able to accurately project how much space is available on the disk.

Note: When you recompress by choosing Optimize, Full–MaxSpace, Stacker analyzes the data and adjusts your expected compression ratio if you are getting better than 2.5-to-1 compression.
You can use the Stacker DOS Toolbox to change the expected compression ratio to get more accurate free-space projections. This process does not affect the actual compression ratio on the disk.

To change your expected compression ratio:

1. At the DOS command prompt, type:

   stac

2. Select Configure Expected Compression.

3. If you have more than one Stacker drive, choose the drive to be changed.

4. Press any key as prompted, so Stacker can optimize the drive, if necessary.

   Stacker displays a range of valid compression values, such as 1.4:5.1.

5. Type the desired expected compression ratio (you do not need to type :1), and then press ENTER.

   Stacker displays a projected result. You can choose to change the expected compression ratio, modify your choices, or exit without making changes.

6. To change the disk, choose Perform changes on Stacker drive.

7. When prompted, press any key to restart your computer and put the changes into effect.
How Stacker Drives Are Stored

Each Stacker drive is actually a hidden file named STACVOL.xxx stored on an uncompressed drive, where xxx is DSK or a 3-digit number. If the STACVOL file is 80MB in size, the Stacker drive it represents typically holds at least 200MB of data. Stacker Setup inserts the commands DOS needs to give the STACVOL file a drive letter and handle it as a disk drive.

Suppose you have a single hard disk with drive letter C. After Stacker Setup compresses the data, DOS acts as though you have two hard disks. C is the Stacker drive, containing all the original data. D is the uncompressed drive; it contains any files needed to start up your system and any other files that must remain uncompressed. Drive D also contains the hidden STACVOL file.

Note: Formatting the uncompressed drive that holds a STACVOL file or deleting a STACVOL file destroys all your data. Back up your files on another drive or disk before performing such a critical function.

Identifying Drive Letters

When Stacker Setup compresses data on a hard disk, the compressed Stacker drive keeps the original drive letter. The associated, uncompressed drive is assigned a new letter. Stacker takes care of organizing the drive letters so you do not have to. All your data will still be on the drives where you expect it to be.

However, if you are a more advanced user, you may want to tailor your system's configuration. You can use the following method to determine the Stacker drive letters and those of the uncompressed drives.

To determine the letters of Stacker drives and their associated, uncompressed drives:

1. At the DOS command prompt, type:

   stacker

A Stacker drive map such as this displays:

Drive A: was drive A: at boot time
Drive B: was drive B: at boot time [Auto-mounting Stacker drive]
Drive C: was drive C: at boot time [E:\STACVOL.DSK=174.6MB]
Drive D: was drive D: at boot time [F:\STACVOL.DSK=26.7MB]
Drive E: was drive E: at boot time
Drive F: was drive F: at boot time
Some drives have information in brackets at the end of the line. For those lines, the first drive letter is the Stacker drive. In brackets at the end of the line, the drive letter in front of the STACVOL file is the uncompressed drive associated with the Stacker drive.

**Editing the STACKER.INI file**
Stacker gets detailed information from the STACKER.INI file and depends on the CONFIG.SYS file for basic system-configuration information. To tailor your configuration, you may need to edit both files.

Stacker Setup creates STACKER.INI as a hidden file in the root directory of your boot drive, if it does not already exist. Other Stacker commands modify the file as needed.

**To edit the hidden STACKER.INI file:**

1. Change to the host drive, if not in your PATH statement.
2. At the DOS command prompt, type:
   ```
   e /i
   ```
   The E Editor /i switch finds, unhides, and opens the STACKER.INI file so you can edit it.
3. If you need to add a line, move the cursor to the line preceding where you want to insert the blank line, and press ENTER.
4. Press F4 to exit the text editor and save the changes if you have to make any edits.
5. Restart your computer to put the changes into effect.

The STACKER.INI file provides configuration information for the Stacker device drivers so they can establish access to the Stacker drives. A STACKER.INI file contains two types of lines: commands and drive specifications.

- **Commands**
  
  Commands are usually near the top of the STACKER.INI file; all start with a slash (/).
  
  STACKER.INI contains only the commands needed to configure your Stacker system, each on its own line. The order of the commands makes no difference, and you can add commands to customize your Stacker configuration. Default settings do not appear.
  
  Refer to “Using Stacker Commands” on page 467 for a summary of Stacker commands.
If you add commands to STACKER.INI, enter each on a separate line, usually near the top of the file. For example, adding /Q results in a list of the Stacker drives during system startup. You can add it if you want to see detailed information whenever you restart.

- **Drive Specifications**

begin with a drive letter and a colon; each specification occupies a separate line; each defines a different Stacker drive and specifies its mounting status (SW-swapped, NS-not swapped, or RP-replaced).

The following line is a typical drive specification in a STACKER.INI file:

```
d:\stacvol.dsk,sw
```

It shows the STACVOL file name on the uncompressed drive (D). The SW indicates that the letter of the uncompressed drive was swapped with that of the Stacker drive. The compressed Stacker drive that holds all your data has the original drive letter.

Stacker drives created from free space are mounted not swapped (NS); removable drives are mounted replaced (RP). When Stacker mounts a drive replaced, it uses a single drive letter for both the uncompressed drive and the compressed Stacker drive. Because of this “split personality,” you can access only one portion at a time—compressed or uncompressed.

For a complete list of commands and more information about modifying the STACKER.INI file, refer to the *PC DOS 7 Command Reference* or see Stacker Help included in the Windows Stacker program group.

Stacker relies on the STACKER.INI file for configuration information for the device drivers. Stacker Setup creates STACKER.INI as a hidden file in the root directory of your boot drive, if it does not already exist. Other Stacker commands modify this file, as needed.

**Editing the CONFIG.SYS File**

The CONFIG.SYS file sets up basic configuration information for your system. DOS knows nothing about your Stacker drives until it reads the CONFIG.SYS file. Stacker's device drivers are defined in the CONFIG.SYS file.

Your memory-management choices affect the CONFIG.SYS file. You can put the Stacker driver and its buffers into conventional memory (the first 640K), but this may cause other DOS programs to run out of memory. You can free up conventional memory by loading the entire Stacker driver into upper memory or extended memory, if your system has the capability.
Exactly how Stacker loads high depends on the operating system and memory manager you use. If you use a memory manager provided by DOS, refer to Chapter 13, "Making More Memory Available" on page 205 for further information about memory management. If you use a different memory manager, check its documentation.

**Loading Stacker High**

In the CONFIG.SYS file, memory-management commands make upper memory (between 640KB and 1MB) available if your system has the capability. Operating systems that take advantage of upper memory blocks (UMBs) require that this area be enabled and referenced correctly. To do so, you need to use a memory manager.

Drivers that use upper memory blocks access them via DOS's DEVICEHIGH=keyword. Other memory managers may use different keywords.

For PC DOS 7, there is only one DEVICEHIGH line, and that line is for STACHIGH.SYS:

```
device=c:\dos\himem.sys
dos=high,umb
device=c:\dos\emm386.sys noems
.
.
devicehigh=c:\stacker\stachigh.sys
```

Most block device drivers should be loaded before the STACHIGH.SYS line. Block device drivers loaded after this line will be assigned letters above all the host drive letters.

**Using DPMS with Stacker**

Some of the latest computers load Stacker beyond upper memory—into extended memory. This is the best way to minimize use of conventional or upper memory. If you have at least a 386 computer with more than 1MB of RAM, Stacker uses Novell's DOS Protected Mode Services (DPMS). This allows most of the Stacker driver to be stored in extended memory, freeing conventional and upper memory for those programs that cannot use DPMS.

Just as you needed a memory manager to control use of the upper memory allocations, for DPMS you need a special memory manager, such as HIMEM.SYS, to control DPMS access. The memory manager must provide Virtual Control Program Interface (VCPI) services and a DPMS server (such as Stacker's DPMS.EXE). Most memory managers provide VCPI services.
With DPMS, about 17K of the Stacker device driver resides in conventional memory if DEVICE is used for the STACHIGH.SYS line. If you use DEVICEHIGH instead, the 17K can move into upper memory blocks.

If your system uses DPMS, Stacker Setup adds another line, the DPMS.EXE line, to your CONFIG.SYS file:

```
device=c:\dos\himem.sys
dos=high,umb
device=c:\dos\emm386.sys noems

device=c:\stacker\dpms.exe
devicehigh=c:\stacker\stachigh.sys
```

The DPMS.EXE line precedes the STACHIGH.SYS statement. The logic is to enable the DPMS area first; then, tell Stacker to go high. It is also important to note that the DPMS statement must follow any EMM386 statement.

Stacker Setup automatically uses DPMS, when possible. However, if STACKER.INI contains an /ems, /umb, or /-dpms switch, Stacker uses EMS instead. Stacker Setup adds the /ems switch only if DPMS cannot be used and if you compressed a large drive (more than 400MB). If your system cannot take advantage of DPMS, you may be able to use EMS. You can use only one or the other—DPMS or EMS. To use EMS, delete any switches that enable DPMS.

**Using EMS with Stacker**

As with DPMS, using expanded memory (EMS) requires a special memory manager. When you run Express Setup, Stacker automatically adds the /ems switch if DPMS cannot be used and you compress any large drives. During Custom Setup, Stacker asks if you want EMS. If you answer Yes, Stacker Setup adds the /ems switch.

Stacker cache buffers can reside in EMS. The lines in your CONFIG.SYS file should look something like this:

```
device=c:\dos\himem.sys
dos=high,umb
device=c:\dos\emm386.sys ram

devicehigh=c:\stacker\stachigh.sys
```
Notice that the EMM386.SYS line says RAM instead of NOEMS. Use DEVICEHIGH on the STACHIGH.SYS line. In either case, there is no DPMS.EXE line.

**Note:** Windows and DOS contain several programs that have the same name. However, the PC DOS programs have been updated after the release of Windows 3.1. If you install Windows after installing DOS, check your CONFIG.SYS and AUTOEXEC.BAT files to make sure that you are using the programs HIMEM.SYS, EMM386.EXE, and SMARTDRV.EXE from the DOS directory and not from the Windows directory.

After setting up Stacker in upper memory, it is a good idea to run PC DOS's RAMBoost Setup or your memory optimizer to let it reconfigure your upper memory and account for Stacker.

Check the Stacker Readme file (README.TXT located in your Stacker directory), before using some software programs, such as QEMM Stealth and 386MAX.

**Mounting Removable Stacker Drives**

With Stacker on your system, you can compress removable disks as well as hard disks. This holds true for diskettes as well as others, such as PCMCIA, Bernoullis, or SyQuests**. After you compress a removable disk in one of your drives, Stacker assumes you will want access to that data later. It AutoMounts the drive by adding a line to your STACKER.INI file. This makes the drive Stacker-aware. It can read Stacker-compressed disks in addition to standard ones.

For example, if you compress an empty diskette in drive B, Stacker inserts the following line into your STACKER.INI file:

```
b:\stacvol.dsk,rp
```

You can AutoMount your other removable drives, even if you do not compress any disks at this time. Or, you can use Stacker Anywhere to mount the drive temporarily when you need to access a compressed, removable Stacker disk. See “Using the Stacker Tools (DOS and Windows)” on page 440 for the procedures.

---

**SyQuest is a trademark of Syquest Technology.**
AutoMounting a Removable Diskette Drive
When you plan to use compressed, removable diskettes, AutoMount your removable diskette drives to make them permanently Stacker-aware. Then the drive recognizes Stacker disks whenever you insert them. AutoMounting does not affect how the drive reads a noncompressed disk. If you insert a standard, uncompressed disk, the drive reads the usual data.

To have Stacker AutoMount drive B:
1. Exit Windows completely.
2. Change to the host drive, if this drive in not in your PATH statement.
3. At the DOS command prompt, type:
   ```
   e  /i
   ```
   The E Editor /i switch finds, unhides, and opens the STACKER.INI file so you can edit it.
4. Move the cursor to the end of the file.
5. Press ENTER to get a new line, if necessary.
6. Type:
   ```
   b:\stacvol.dsk,rp
   ```
7. Press F4 to exit the text editor and save any changes.
8. Restart your computer to put the changes into effect.

You can add as many drive letters (each on a separate line) as you have removable drives.

AutoMounting Software-driven Removable Drives
To AutoMount other removable drives, such as a Bernoulli or a SyQuest, the procedure depends on how the drive is driven and which DOS your system uses. DOS readily recognizes hard drives and removable drives that are "hardware-defined."

However, if you have a removable drive that is software-defined by a device driver in the CONFIG.SYS file (such as a Bernoulli), DOS and Stacker do not “see” it when they load. By the time CONFIG.SYS loads the device driver, DOS has already determined all drive letters. You can edit your STACKER.INI file to make the drive visible to DOS and enable it to AutoMount.
To AutoMount a device-driven removable drive:

1. Exit Windows completely.

2. Change to the host drive, if necessary, and type the following to edit the hidden STACKER.INI file:

   ```
   e /i
   ```

   The E Editor /i switch finds, unhides, and opens the STACKER.INI file so you can edit it.

3. When your current STACKER.INI file displays on screen, on a separate line, at the top of the file, type:

   ```
   /auto
   ```

   The /AUTO command ensures that AutoMount is turned on.

4. At the bottom of the file, on a separate line, type:

   ```
   drive:
   ```

   where drive is the letter of the drive you want to mount.

5. Save your changes and exit the E Editor.

6. Restart your system for the changes to take effect.

Beginning Stacker Drive Letters at a Specific Letter

Certain drives require use of a particular drive letter. If you cannot reconfigure the drive to use a different letter, you can have Stacker drive letters begin at a specified letter.

For example, most CD-ROMs are assigned drive letters by the MSCDEX.EXE program through AUTOEXEC.BAT, after Stacker drive letters have been assigned. If your computer has only one hard disk but uses letters D and E for other devices, you can tell DOS to start assigning new drive letters with drive F.

To assign drive letters starting with a specific letter:

1. Change to the host drive, if necessary.

2. At the DOS command prompt, type:

   ```
   e /i
   ```

   The E Editor /i switch finds, unhides, and opens the STACKER.INI file so you can edit it.
3. Move to the point in the file where the commands are listed, press ENTER to add a blank line, and then type:

\(/bd=drive\)

where \(drive\) is the first drive letter you want to be assigned to Stacker drives.

4. Save the STACKER.INI file and exit the editor.

5. Restart your computer, and your STACKER.INI file will be hidden again.

---

**Using Stacker Commands**

If you prefer to work from the DOS command prompt, Stacker provides a full set of commands that help you monitor and maintain Stacker drives on your computer.

To get detailed syntax information about each command, at the DOS command prompt, type `help` followed by any one of the Stacker commands described briefly in the following table. The *PC DOS 7 Command Reference* lets you know when to use each command and provides examples of the more complex commands.

For quick help on Stacker commands, type the command name followed by `/?`, such as `check /?` to see syntax information.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHECK</td>
<td>Checks a Stacker compressed drive, produces a status report, and can be used to fix any detected problems.</td>
</tr>
<tr>
<td>CONFIG</td>
<td>Creates Stacker lines in the system configuration files.</td>
</tr>
<tr>
<td>CREATE</td>
<td>Creates an empty Stacker drive using available disk space.</td>
</tr>
<tr>
<td>DBLSPACE</td>
<td>Calls the DBLSPACE menu-driven interface.</td>
</tr>
<tr>
<td>DCONVERT</td>
<td>Converts a DoubleSpace or SuperStor/DS compressed disk to a Stacker drive.</td>
</tr>
<tr>
<td>DPMS</td>
<td>Puts Stacker driver in extended memory.</td>
</tr>
<tr>
<td>HCONVERT</td>
<td>Updates an earlier version of Stacker drive that was not mounted when you ran Stacker Setup or a removable Stacker drive that needs to be updated.</td>
</tr>
<tr>
<td>PASSWD</td>
<td>Sets a read/write and read-only password for Stacker drives.</td>
</tr>
<tr>
<td>REMOVDRV</td>
<td>Deletes the Stacker stacvol file and all the data from the specified Stacker drive.</td>
</tr>
<tr>
<td>REPORT</td>
<td>Reports statistics for Stacker drives.</td>
</tr>
<tr>
<td>Command Summary</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td></td>
</tr>
<tr>
<td>RESIZE</td>
<td>Changes the size of the Stacker drive, making the uncompressed drive's size change also. If you increase the size of the Stacker drive, the uncompressed drive becomes smaller; if you add space to the uncompressed drive, the storage in your STACVOL.nnn is reduced.</td>
</tr>
<tr>
<td>SCREATE</td>
<td>Compresses RAM drives. Must be loaded in CONFIG.SYS file.</td>
</tr>
<tr>
<td>SDEFRAG</td>
<td>Runs the Stacker Optimizer to defragment or recompress a Stacker drive. However, select RESIZE instead of using the Stacker command SDEFRAG /GP because Stacker can resize a Stacker drive without defragmenting first.</td>
</tr>
<tr>
<td>SDIR</td>
<td>Displays the compression ratio for a list of files and directories.</td>
</tr>
<tr>
<td>SETUP</td>
<td>Prepares drives and compresses disks.</td>
</tr>
<tr>
<td>SGROUP</td>
<td>Creates a Windows program group.</td>
</tr>
<tr>
<td>SSETUP</td>
<td>Activates the Stacker installation program to prepare disks for compression.</td>
</tr>
<tr>
<td>STAC</td>
<td>Accesses the Stacker DOS toolbox.</td>
</tr>
<tr>
<td>STACHIGH</td>
<td>Loads Stacker in high memory. A statement must be added to the CONFIG.SYS file before it can be loaded.</td>
</tr>
<tr>
<td>STACKER</td>
<td>Mounts or unmounts Stacker drives, or displays the Stacker drive map.</td>
</tr>
<tr>
<td>STACWIN</td>
<td>Accesses the Stacker utility program in Windows.</td>
</tr>
<tr>
<td>SYSINFO</td>
<td>Gathers and displays information about your computer system.</td>
</tr>
<tr>
<td>TUNER</td>
<td>Displays the Stacker Tuner screen, allowing you to choose the compression speed for your system.</td>
</tr>
<tr>
<td>UNCOMP</td>
<td>Uncompresses all the data stored in the Stacker drive and stores it on the original uncompressed disk.</td>
</tr>
</tbody>
</table>
Monitoring Your Drives from Windows

The Stacker Windows Toolbox includes a drive bar, a toolbar, and gauges that you can use to monitor your drives and maximize their performance. Select a drive, select a tool, and follow the directions on the screens.

When you select a drive, the gauges display information for that drive.

The new toolbar lets you perform Stacker commands from the Stacker Windows Toolbox.

As you pass the cursor over an area on the Toolbox, a brief explanation about that area appears here.

Stacker still determines the original settings for the Toolbox gauges, but now you can have some control over your compressed drives. You can set some preferences for each gauge so the Stacker Toolbox can monitor your drives better and report the information that you want to know.

To open the Stacker Windows Toolbox:

1. From the Stacker Program Group, double-click on the Toolbox icon to open it.
2. Then, click on any drive on the drive bar to see information for that drive.

Note: After you select a drive, the Details icon in the toolbar and the Backup Status gauge remain gray for a few seconds while Stacker gathers new information.

Stacker Windows Toolbox gauges display dynamic information about any drive you select from the drive bar. The gauges monitor and show the Compression Rates and Extra Bytes available, Disk Space used and free, Fragmentation level, and Backup Status of the drive. Compressed drives are shown in blue letters; noncompressed drives are shown in black letters.

Note: If you need more information about areas on the Stacker Windows Toolbox or about how parts of the Toolbox work, press F1, or use the Help menu from the menu bar.
Compression Ratio Gauge: The Compression Ratio gauge shows how well your data compresses. Stacker analyzes the selected drive and calculates the actual compression ratio, which Stacker then uses to project the size of your Stacker drive. Depending on the types of files on your drive, the actual compression ratio could differ from that expected.

If you double-click on Compression Ratio, the Compression Ratio gauge changes to show how many extra bytes you now have, compliments of Stacker. If you recompress this drive later and the actual compression ratio changes, the extra bytes will also change to reflect the new actual compression ratio.

Disk Space Gauge: The Disk Space gauge shows the amount of disk space used and free. Even when minimized to an icon, the Stacker Toolbox still displays dynamic disk space information.

Note: Some third-party utilities cannot project the true amount of free space available on a Stacker drive. Stacker can. It analyzes the data on your drive and projects an accurate size for the Stacker drive based on current data.

Fragmentation Gauge: The Fragmentation gauge shows how fragmented the current drive is. When there are not any large blocks of space left on your disk, DOS splits files and fits pieces into smaller spaces throughout the disk. When your drive becomes quite fragmented, file access slows as DOS locates and collects all the pieces to a file.

Generally, the more blocks on the Fragmentation gauge that are filled with color, the more fragmented your disk is becoming. To remedy this condition, select the Optimize tool, and then select Full or Full-MaxSpace. Only the Full—MaxSpace method of optimization achieves recompression.
**Note:** Depending on whether you are working from the DOS Toolbox or the Windows Toolbox, the selections will vary.

This disk was recently optimized and shows little fragmentation.

**Backup Status Gauge:** The Backup Status gauge shows how much of your disk has been backed up. Use a backup utility such as PC DOS's CPBACKUP to regularly back up data on your disk.

Represented data that has been backed up.

Represented data that has not been backed up.

**Note:** When you back up a Stacker drive, you can perform your standard backup procedure to back up files on the Stacker drive. If you also want to back up the files on the uncompressed drive, back up all files except the hidden STACVOL file. (The STACVOL file actually contains your compressed data, which was backed up during the regular backup procedure.)
To see a map of your Stacker drives and their corresponding uncompressed drives, at the DOS command prompt, type:

```
stacker
```

The location of the STACVOL file is in brackets.

For example, on a computer with drive C as the Stacker drive, the uncompressed drive is typically drive D [D:STACVOL.DSK=size]. You would back up all the files on drives C and D except the file STACVOL.DSK.

**Toolbox Gauge Preferences:** The Stacker Windows Toolbox gathers information and updates gauges regularly. Each gauge has different settings because each monitors different information. You can accept Stacker's original settings, or you can change any of them on a gauge's Preferences screen. When you change settings on a gauge's Preferences screen, those settings affect all your Stacker drives.

For any gauge, you can set:

- How often the gauge updates.
- When the gauge should flash a warning message or play a sound to alert you, such as when your disk reaches a certain level of fragmentation.
- How the gauge will alert you—a flashing message, a sound, or both.

![Stacker Toolbox Preferences](image)
To view or change preference settings for Stacker Windows Toolbox gauges:

1. Double-click on any Stacker Toolbox gauge to open its Preferences screen.
2. Type your new settings.
3. Click on OK to activate them.

When a gauge updates, you probably will not even notice it on most computers. However, if you are using a slower computer or if you have more than one Stacker Windows Toolbox running, you may notice a brief delay in your applications each time a gauge gathers information. If this occurs, set a longer time between updates.

For example, in Disk Space Preferences, Stacker lets you set a percentage of space as a buffer so you can be alerted when your disk fills to that point. As you use your computer, data fills the drive. When the data fills to the buffer zone you set, the gauge flashes a warning message to alert you. The warning flashes even if you have minimized the Stacker Toolbox to an icon.

If you have a sound driver installed, you may also want to select a sound to warn you when the disk has reached the disk full zone. You can use any .WAV file, such as the ones in your Windows directory.

**Note:** Stacker can only alert you when the Toolbox is open. It is a good idea to keep a minimized Toolbox open on the desktop so Stacker can alert you with a flashing message or sound, when necessary.

At any time, you can disable a gauge's warning or sound on the Preferences screen. Or, you can disable them all directly from the Toolbox. On the toolbar, click on to disable sounds or to stop any flashing messages. When disabled, the button is crossed out.

**Disk Space Details:** The Disk Space Details button shows you more compression information for the files on the selected drive. When you open the Stacker Toolbox, this button is dimmed while Stacker gathers your drive information. When the Toolbox updates, this tool becomes available.
Most users have many types of files on their systems. The actual compression you get depends on what you have on your system. Certain files, such as games, programs, and ZIP files cannot compress further. However, other files, such as spreadsheets, data files, and some kinds of graphics, compress well. Stacker collects your files and sorts them into four categories:

- Precompressed data
- Programs
- Data
- Free space

In the following example, 7% of the files are data files that compress at 4.5 to 1. The right column, Bytes Available, shows you how much more of this kind of data will fit. Stacker assesses all these ratios to determine your actual compression ratio.

Using the Stacker Menu in Windows File Manager
You can monitor compression from the Windows File Manager as well as from the Stacker Windows Toolbox. To do so, open the Windows File Manager. Then, from the Stacker menu, you can choose Selected Files, All Files, or Disk Summary to view compression information about the current drive.
The Selected Files view shows compression information about files and directories you specify.

First select the files and directories in the Windows File Manager window. Then, click on Selected Files to see the compression information for these files. You can set the sort order of each column separately. For example, you might want the Type of files view to be in Ascending order but see the Compression Ratio in Descending order.

The All Files view shows how different types of files are compressing on the current drive. For this view, you do not have to select any files. Stacker automatically shows information about all the files for the drive, grouped by extension.
You can also get this information from the Stacker DOS Toolbox. From the toolbar, select Report. To print the report, select Print.

The Disk Summary view presents an overview of space used and free for the current drive. It also lists the expected and actual compression ratios.

![Disk Summary](image)

Choose Disk Summary from the Stacker menu in File Manager to see this information.

---

**Adding a Windows Permanent Swap File**

A Windows Permanent Swap File (WPSF) must remain uncompressed. Stacker allows you to keep a permanent swap file in an uncompressed area within the compressed Stacker drive. If you had a permanent swap file when you installed Stacker, Stacker Setup already reserved space for it on the uncompressed drive. You can put a permanent swap file of up to 32MB within the Stacker drive, if you are using Windows 3.1 in Enhanced mode.

**To build a permanent swap file on a Stacker drive using the Stacker Windows Toolbox:**

1. Select any Stacker drive.
2. Click on the Configure tool.
3. Click on Change swap file settings.
4. Click on Change>>.
5. Click on the Stacker drive to hold the swap file.
6. Click on Permanent as the type.
7. Accept the recommended New Size or type a size up to 32MB. Then click on OK.

For more information about Windows swap files, refer to your Windows documentation.
Increasing Stacker Performance

Stacker now works seamlessly with Windows for Workgroups 3.11 32-bit file access (32BFA). Stacker requires no special options or configurations. You do have to enable lazy writes, however, in your SYSTEM.INI file and turn on 32BFA.

To enable lazy writes in Windows for Workgroups:

1. From the Windows Program Manager File menu, click on Run.
2. Type the following in the Command Line text box:
   ```
sysedit
```
3. Select the window that contains your SYSTEM.INI file.
4. Edit this file using a text editor, such as the E Editor,
5. Locate the [386Enh] section, and add the following line, which assumes that your Stacker drives are C, D, and E:
   ```
   ForceLazyOn=CDE
   ```
6. Save the file and exit the E Editor.

After you have enabled lazy writes, you must turn on the 32-bit file access.

To turn on 32-bit file access:

1. Double-click on the Control Panel.
2. Double-click on the 386 Enhanced icon.
3. Click on the Virtual Memory button,
4. Click on the Change button.
   
   At the bottom of the dialog box, check the 32-bit file access box. A cache size appears in the adjacent window. Accept the default setting for now. If you want to change it later, you can.

   **Note:** Make sure you check the 32-bit *file* access. Checking only 32-bit disk access does not increase performance.

5. Click on OK.
6. Then click on OK again to accept the changes and return to the Control Panel.
7. Close the Control Panel.
8. Restart Window to make the changes effective.

If you have problems initializing 32BFA, refer to Stacker's README.TXT file in the STACKER directory for common 32BFA workarounds.
Running AutoSave

The AutoSave tool, a tool available only by using the Windows interface, stores updated versions of headers.

Each Stacker drive has a header that contains detailed information about its structure. Stacker needs the information in the header to access data on the drive. When you start up your system, Stacker can automatically save a copy of all Stacker headers.

After you turn on AutoSave, it works in the background while your computer is idle. AutoSave works only after there has been no keyboard or mouse activity for a certain period of time. When the time comes for saving a header, AutoSave makes sure the computer is not in use, checks out the drive, and saves a header. If you use the computer during this time, AutoSave stops immediately, giving you full access to your computer. When the computer is idle again, AutoSave resumes.

To speed up the time it takes Stacker to save header information at startup, edit your AUTOEXEC.BAT file. Move the line C:\STACKER\CHECK /NP so it follows the DOS SMARTDRV.EXE line; your path should also point to the DOS SMARTDRV.EXE instead of Windows SMARTDRV.EXE if using PC DOS 7. You can change the frequency or time of the AutoSave and, if you prefer, you can configure the settings for each Stacker drive individually.

To change AutoSave headings:

1. From the Stacker Windows Toolbox, select the Stacker drive.
2. Click on the AutoSave tool.
3. To enable AutoSave for that drive, click on Enable AutoSave.
4. To change the interval, click on Interval. Then, type or select how often Stacker should save the header.
5. To schedule AutoSave for a particular time, click on Scheduled and enter the time to AutoSave.
6. To make the current setting the default, click on Set As Defaults.
7. To change settings to the current default, click on Use Defaults.
8. To let Stacker AutoSave interrupt processing to display problems, check Enable Warning Messages.
9. By default, AutoSave runs invisibly. To display the AutoSave icon continuously, uncheck Run AutoSave Invisibly.
After AutoSave has saved a header, you can be sure that your Stacker drive is in good condition.

Using the Stacker Screen Saver
Stacker provides a special screen saver that you can use with Windows 3.1. You can install the Stacker Screen Saver on your Windows desktop.

To install the screen saver under Windows 3.1:
1. In Windows Program Manager, double-click on the Control Panel icon.
2. From the Control Panel, double-click on the Desktop icon.
3. Under Screen Saver, click on the arrow, select the Stacker screen saver, and click on OK.

Troubleshooting Stacker
For troubleshooting tips or procedures for some of the most common Stacker compression problems, refer to “Stacker Compression” on page 299.
Chapter 22. Using PenDOS

PenDOS** lets you use pen-based applications as well as standard mouse-based DOS applications on any 386** or higher computer. Computing has never been easier because you can write, draw, and issue commands using two skills you learned as a child: pointing and using a pen.

PenDOS lets you use the mouse as a pen. You do not need any other special equipment to try pen computing. To get you started, PenDOS lets you use the mouse as a pen. For instructions, see “Using the Mouse as a Pen” on page 484.

Using a pen tablet computer or externally attached digitizer tablet, you can write naturally because PenDOS includes CIC’s Handwriter** Recognition System. To introduce you to pen computing, this version of Handwriter recognizes numbers and symbols only. A full version of Handwriter that recognizes uppercase and lowercase letters, numbers, punctuation marks, and symbols is available separately from IBM.

Installing PenDOS after Installing PC DOS

If you did not choose to use pen-based applications at initial setup, you can still install PenDOS by rerunning PC DOS Setup using the /e switch.

The PC DOS Setup diskettes contain everything you need to install PenDOS. You might want to refer to Chapter 1, “Installing” on page 3 before you begin the installation of optional tools.

Note: PenDOS requires the EMM386 memory manager to run. Then, running RAMBoost Setup allows you to install the EMM386 memory manager. Select the EMS option on the Advanced Option screen when running RAMSETUP.

** PenDOS is a trademark of Communication Intelligence Corporation.
** 386 is a trademark of Intel Corporation.
** Handwriter is a trademark of Communication Intelligence Corporation.

© Copyright IBM Corp. 1981, 1995
To install PenDOS using the PC DOS Setup /e switch:

1. Insert the Setup Diskette from the PC DOS installation diskettes into drive A or B.

2. At the DOS command prompt, type:
   
   a:setup /e
   
   or
   
   b:setup /e
   
   The /e switch allows you to return to the Optional Tools menu without having to do a complete reinstallation. At this point, only the necessary files for the optional tools for Windows will be installed.

3. After Setup for PC DOS begins, follow the instructions displayed on the screen. Make sure you specify the same “Install to Path” as you did when you did the initial PC DOS installation.

4. At the Optional Tools screen, press the UP ARROW and DOWN ARROW until you highlight PenDOS.

   At the Optional Tools screen, there is a NO next to PenDOS.

5. Press ENTER.

   You now see a selection of pen and mouse tablet drivers. Look for the name of the tablet or pen computer you will use with PenDOS and select one of the following:

   • Your computer’s tablet driver, if you have a pen tablet computer with a self-contained digitizer.

   • The proper tablet driver for your digitizer, if you have an externally attached digitizer.

   • The Digitizing Pad Emulation via Mouse tablet driver, if you will be using your mouse as a pen.

   Use the arrow keys to scroll up or down until your selection is highlighted, and then press ENTER.

   When you return to the Optional Tools menu, you now see YES next to PenDOS.

6. Select any other optional tool you want to add at this time by highlighting an optional tool and pressing ENTER. Repeat this step for each optional tool.

   You now see YES next to the optional tools you want to install.

7. Move the cursor to highlight the following:

   Options correct. Continue Setup.
8. Press ENTER to accept the optional tool selections.

9. Continue following the instructions on the screen until the optional tools are installed.

10. After your computer reboots, you need to edit your CONFIG.SYS file and add the following line, if it is not present:
    
    device=c:\dos\system\pendev.sys
    
11. Press CTRL+ALT+DEL to make this change effective and restart your computer.

12. Then run RAMBoost Setup and select the EMS option.

**Starting PenDOS**

Before starting PenDOS, it is important to make sure you have the proper hardware installed and the correct tablet driver selected. If you have a pen tablet computer with a self-contained digitizer, you should have chosen that computer's tablet driver during PC DOS Setup. Refer to “Installing PenDOS after Installing PC DOS” on page 481 for details.

If you have an externally attached digitizer, be sure the digitizer is connected to the proper communication port on your computer. Refer to the digitizer manufacturer's instructions for the proper installation procedure. You should have also selected the proper tablet driver for your digitizer during PC DOS Setup. If you will be using your mouse as your pointing device, select the Digitizing Pad Emulation via Mouse tablet driver during PC DOS Setup.

The DOS Setup program modifies your CONFIG.SYS file by adding the appropriate device statement when you select PenDOS as an optional tool and then select a tablet or mouse device.

If you do not want to modify your AUTOEXEC.BAT to have PenDOS start automatically whenever you start your computer, you can type the PENDOS command at the DOS command prompt each time you want to use this program.

**To start PenDOS:**

1. Type the following at the DOS command prompt:
   
   pendos
   
2. Press ENTER.
Using the Pen

With PenDOS, you use the pen to write, edit, draw, select text or objects, and issue commands such as saving or closing a file.

Hold the pen the same way you hold an ordinary pen or pencil.

- Rest your hand and forearm on the writing surface as you would when you write on a piece of paper.
- Press the pen tip lightly against the writing surface.

The pen has two important features: the pen tip and the side button.

- **Pen Tip**: You press the pen tip on the writing surface to write in the Writing Window, make gestures, select text and objects, choose menu commands, and tap the on-screen buttons.

- **Side Button (some pen models)**: You hold down the side button with the pen close to the writing surface to display the PenDOS menu. You also hold down the side button while you make editing gestures, such as delete or insert.

If your pen does not have a side button, tapping the extreme upper-right corner of the writing surface is equivalent to holding down the side button.

Using the Mouse as a Pen

If you have a pen tablet computer or an externally attached digitizer tablet and pen, you will not need to use your mouse as a pen. Simply install the correct tablet driver for your hardware as explained in “Starting PenDOS” on page 483.

To use the mouse as a pen, use the Digitizing Pad Emulation via Mouse tablet driver by selecting it during PC DOS Setup.
If you do not have a statement about MOUSE.COM in the AUTOEXEC.BAT file, before you start PenDOS, type mouse on the DOS command prompt to load MOUSE.COM.

Then, when you move the mouse in PenDOS, the special "arrow" cursor displays the location of the pen tip. To write characters, hold down the left mouse button while you move the mouse. Use the right mouse button as the pen's side button. To write gestures, hold down both buttons simultaneously.

### Using the PenDOS Menu

The PenDOS menu contains buttons you can tap to display the Writing Window and the PenDOS keyboard, as well as to send ESC and ENTER to an application.

**To display the PenDOS menu:** press the pen tip lightly against the writing surface while holding down the side button. The PenDOS menu appears in the upper-right corner of the screen.

C:\PENDOS>

The PenDOS menu buttons perform the following actions:

<table>
<thead>
<tr>
<th>Button</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>![K]</td>
<td>Displays a keyboard, used for entering all characters, including non-printable characters such as CTRL, ALT, SHIFT, and function keys.</td>
</tr>
<tr>
<td>![ESC]</td>
<td>Acts like the ESC key on a keyboard.</td>
</tr>
<tr>
<td>![←]</td>
<td>Acts like the ENTER key on a keyboard.</td>
</tr>
<tr>
<td>![WW]</td>
<td>Displays the Writing Window.</td>
</tr>
</tbody>
</table>
Entering Characters

There are two ways to enter characters with PenDOS: writing in the Writing Window and tapping keys on the PenDOS keyboard.

Using the Writing Window

The Writing Window provides a pop-up window in which you can enter and edit characters and then send them to the DOS command prompt or to an application. In this version of PenDOS, only numbers and symbols are recognized.

To display the Writing Window:

You can:

1. Press the pen tip lightly against the writing surface while holding down the side button. The PenDOS menu appears.
2. Tap the WW button on the PenDOS menu.

Or, you can:

Write the Insert gesture anywhere on the writing surface.

For information about gestures, see “Editing Characters” on page 490.

The Writing Window appears:

The Writing Window has three important areas:

- The editing line displays the characters that were entered.
- The writing area contains a row of boxes. Write one number or symbol in each box.
The function buttons let you edit the characters you wrote as well as send them to an application. You can also display the PenDOS keyboard by tapping the K button.

<table>
<thead>
<tr>
<th>Button</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLEAR</td>
<td>Clears all characters in the Writing Window.</td>
</tr>
<tr>
<td>SPACE</td>
<td>Inserts a space character at the editing line cursor.</td>
</tr>
<tr>
<td>CANCEL</td>
<td>Closes the Writing Window without sending any characters to the application.</td>
</tr>
<tr>
<td>SEND</td>
<td>Sends characters to the application, closes the Writing Window, and returns to the application.</td>
</tr>
<tr>
<td>MORE</td>
<td>Sends the characters to the application and clears the editing line.</td>
</tr>
<tr>
<td>K</td>
<td>Displays the PenDOS keyboard.</td>
</tr>
</tbody>
</table>

To display the PenDOS keyboard: tap the K on the Writing Window.

To return to the Writing Window from the PenDOS keyboard: tap the CANCEL button on the PenDOS keyboard.

Using the PenDOS Keyboard

If a DOS application does not provide mouse-aware menus or if you need to enter non-printable characters such as ALT+F1, use the PenDOS keyboard to issue commands. PenDOS sends the keystrokes to the application as if you had typed them on a physical keyboard.

To display the PenDOS keyboard: hold down the pen’s side button and tap the K button on the PenDOS menu, or tap the K button on the Writing Window.
The PenDOS keyboard has three important areas besides the standard keys:

- The *editing line* displays the characters that were entered.
- The *numeric keypad* lets you enter ASCII values. It is displayed only when the NL (Num Lock) button is selected.
- The *function buttons* let you edit the characters you wrote as well as send them to an application, or you can display the Writing Window.

The buttons on the PenDOS keyboard have the same function as the buttons on the Writing Window:

<table>
<thead>
<tr>
<th>Button</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLEAR</td>
<td>Clears all characters in the editing line.</td>
</tr>
<tr>
<td>←</td>
<td>Deletes the last character before the cursor on the editing line, like the BACKSPACE key on the keyboard.</td>
</tr>
<tr>
<td>CANCEL</td>
<td>Closes the keyboard without sending any characters to the application.</td>
</tr>
<tr>
<td>SEND</td>
<td>Sends characters to the application, closes the keyboard, and returns to the application.</td>
</tr>
<tr>
<td>MORE</td>
<td>Sends the characters to the application and clears the editing line.</td>
</tr>
<tr>
<td>WW</td>
<td>Displays the Writing Window.</td>
</tr>
</tbody>
</table>
To use the PenDOS keyboard: use the pen to tap the keys for the desired characters. The characters appear in the editing line.

To use special keys such as SHIFT and CTRL:
1. Tap the modifier keys. The modifier keys on the PenDOS keyboard are SHIFT, CTRL, ALT, CL (Caps Lock), NL (Num Lock), and SL (Scroll Lock).
2. Tap the desired character that follows the modifier key.

Note: The notation <scan> appears for some control characters, function keys, and certain instances of ALT+character.

For example, to enter CTRL+A, tap CTRL, and then tap A. PenDOS sends ^A to the editing line at the top of the PenDOS keyboard.

To send keystrokes to the application: tap the SEND or MORE button, or tap the key on the PenDOS keyboard. Tapping sends the contents of the editing line, followed by a carriage return, to the application.

To enter an ASCII value:
1. Tap NL (Num Lock) to display the numeric keypad.
2. Tap ALT.
3. Tap the numbers of the ASCII code on the numeric keypad (located on the right side of the PenDOS keyboard).

For example, the ASCII code 156 is equivalent to the £ character.

The ASCII code and the associated character appear above the numeric keypad.
4. Tap ALT again.

The value is sent to the editing line.

To display the Writing Window: tap the WW button on the PenDOS keyboard.

To return to the PenDOS keyboard from the Writing Window: tap the CANCEL button on the Writing Window.

To remove the PenDOS keyboard from the screen: tap the CANCEL button on the PenDOS keyboard.
Editing Characters

To edit the characters in the Writing Window, on the PenDOS keyboard, or in an application, you make gestures with the pen. *Gestures* are simple pen strokes that resemble proofreaders' marks.

Some gestures have the same effect in most DOS applications. These are called *universal gestures*. For example, the Delete gesture is a universal gesture for deleting a single character. Not all gestures are supported in every application. For example, if the application does not have a command for undoing the last action, the Undo gesture has no effect in that application.

**Note:** You can use gestures if your pen does not have a side button. Tapping the extreme upper-right corner of the writing tablet is equivalent to holding down the side button.

The following table describes the PenDOS gestures:

<table>
<thead>
<tr>
<th>Gesture</th>
<th>What it does</th>
<th>Universal gesture</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Delete Gesture" /></td>
<td>Deletes a single character.</td>
<td>Yes</td>
</tr>
<tr>
<td><img src="image" alt="Delete Block Gesture" /></td>
<td>Deletes the highlighted block of text.</td>
<td>Yes</td>
</tr>
<tr>
<td><img src="image" alt="Display Window Gesture" /></td>
<td>Displays the Writing Window and inserts text at this location.</td>
<td>Yes</td>
</tr>
<tr>
<td><img src="image" alt="Insert Space Gesture" /></td>
<td>Inserts a space.</td>
<td>Yes</td>
</tr>
<tr>
<td>Gesture</td>
<td>What it does</td>
<td>Universal gesture</td>
</tr>
<tr>
<td>---------</td>
<td>--------------</td>
<td>------------------</td>
</tr>
<tr>
<td><img src="image" alt="Gesture" /></td>
<td>Simulates clicking the right mouse button. To write the Tap gesture, hold down the pen’s side button and tap the pen tip lightly against the writing surface.</td>
<td>Yes</td>
</tr>
<tr>
<td><img src="image" alt="Gesture" /></td>
<td>Undoes the last action.</td>
<td>No</td>
</tr>
<tr>
<td><img src="image" alt="Gesture" /></td>
<td>Pastes previously copied text.</td>
<td>No</td>
</tr>
<tr>
<td><img src="image" alt="Gesture" /></td>
<td>Copies the highlighted block of text.</td>
<td>No</td>
</tr>
</tbody>
</table>

Most gestures have hot spots, shown in the table as a black dot on the gesture stroke. The hot spot indicates where you want the action to occur. For example, the hot spot for the Insert gesture is at the tip; that is, when you write the Insert gesture, make sure the tip is centered on the character to the right of where you want to insert.

The following gestures do not have hot spots, so you can write them anywhere on the writing surface:

- Undo
- Delete a block
- Copy a block
- Tap

For your convenience, PenDOS provides gesture macros used by many popular applications. A *macro* is a sequence of keystrokes that executes a command.
To write a gesture:

1. Press the pen tip lightly against the writing surface, while holding down the side button.
2. Write the gesture.
   The gesture should remain within a 2.5-inch by 2.5-inch square.
3. Lift the pen from the writing surface.

Editing Characters in the Writing Window and PenDOS Keyboard

This section describes how to edit the characters that appear in the editing line of both the Writing Window and the PenDOS keyboard.

To delete a character: hold down the side button and write one of the delete gestures over the character in the editing line.

The character is deleted. Any characters to the right move over to close the space.

To insert a character:

1. In the editing line on the Writing Window or PenDOS keyboard, place the cursor by tapping the character to the right of the position where you want to insert the new character.

   For example, to insert a "7" before the "8" in the following illustration, place the cursor on the "8."

   The insertion point is highlighted, and all characters in the writing area disappear.

2. Write the new character in the writing area, or tap the new character on the PenDOS keyboard.
To insert a space:

There are two ways to insert a space:

- Write the Insert Space gesture in the editing line.
  
  Make sure the hot spot is centered on the character to the right of where you want the space to appear.

- Tap the character in the editing line that is to the right of where you want the space to appear and then tap the SPACE button.

To clear the writing area: hold down the side button and write one of the delete gestures anywhere in the writing area:

**Note:** The delete gestures clear the writing area only. To clear the editing line as well as the writing area, tap the CLEAR button.

---

**Working with Applications**

This section explains how to work with standard mouse-aware applications using PenDOS.

**Starting Applications**

You can start applications whether you are using PC DOS Shell or not.

**To start an application if you are using PC DOS Shell:**

1. Tap twice rapidly with the pen (double-tap) on the drive that contains the application you want to start.

2. Double-tap the directory name.
   
   If the directory does not appear in the scroll list, scroll down by using the scroll arrows or thumb or by making a fast, vertical pen stroke that starts anywhere and extends below the window. Do not hold down the side button when you make the pen stroke.

3. Double-tap the application's file name. Executable files normally have the extension .EXE or .BAT.
To start an application if you are not using PC DOS Shell:

1. At the DOS command prompt, hold down the side button and press the pen tip lightly against the writing surface.

   The PenDOS menu appears in the upper-right corner of the screen.

2. Tap the K button to display the PenDOS keyboard.

3. Go to the directory that contains the file by tapping `cd `directory_name` and then tapping the Enter key.

   If you make an entry mistake, see "Editing Characters" on page 490.

4. Start the application by tapping the keys for `filename` and then tapping the Enter key.

   Note: You can also start applications by typing commands on a physical keyboard.

**Pointing and Selecting**

To position the application cursor: lightly tap the writing surface with the pen tip. Tapping with the pen tip is equivalent to clicking the left mouse button.

To select menu items: tap the item with the pen tip.

To select a block of text or group of objects:

1. Tap one end of the selection and keep the tip in contact with the writing surface; then, drag the pen to the other end of the selection.

2. Lift the pen from the writing surface.

   This is equivalent to holding down the mouse button and dragging the mouse.

Note: These instructions apply only to mouse-aware applications that support block highlighting.
Editing Characters in the Application

To delete a character: hold down the side button and write one of the delete gestures. Make sure the hot spot is centered on the character you want to delete.

To delete a highlighted block or group of objects: hold down the side button and write the Delete Block gesture.

To insert a character using the Writing Window:
1. Hold down the side button and write the Insert gesture in the application file. Make sure the hot spot is centered at the location where you want to insert the character. The Writing Window appears.
2. Write the characters you want to insert.
3. Tap ..., SEND, or MORE.

To insert a character using the PenDOS keyboard:
1. Place the cursor by tapping the character to the right of the position where you want to insert the new character.
2. Display the PenDOS keyboard by holding down the pen's side button and tap the K button on the PenDOS menu.
3. Use the pen to tap the keys for the desired characters.
4. Tap the ... key, the SEND, or MORE button.

To insert a space: hold down the side button and write the Insert Space gesture. Make sure the hot spot is centered at the location where you want to insert the space.

To paste previously copied text or objects: hold down the side button and write the Paste gesture in the application file. Make sure the hot spot is centered at the location where you want to paste the text or objects.
To undo the previous command: hold down the side button and write the Undo gesture anywhere on the writing surface.

Note: The Undo gesture is not a universal gesture; it might not work in all applications.

Using an Off-the-Shelf Application
You can use PenDOS with most of the DOS applications you already have. See the following example.

To use PenDOS with Borland’s Quattro Pro" spreadsheet application:
1. In Quattro Pro, tap a cell to highlight it.
   To select a group of cells, drag the pen.
2. Hold down the side button with the pen close to the writing surface to display the PenDOS menu.
3. To enter characters in the highlighted cell, write the Insert gesture, or tap WW or $K$ on the PenDOS menu.
   • In the Writing Window, write numbers in the boxes and then tap $\text{SEND}$, or MORE.
   • On the PenDOS keyboard, tap the keys of the characters you want to enter and then tap ENTER ($\text{SEND}$).
4. To clear a cell, highlight the cell and write one of the delete gestures.
5. To delete a cell or several cells, highlight the cells and write the Delete Block gesture.
6. To copy a cell or several cells, highlight the cells and write the Copy gesture.
7. To undo the last action, write the Undo gesture.

Note: Undo must be enabled.

** Quattro Pro is a trademark of Borland International, Inc.
Aligning the Tablet

If the ink does not seem to line up with the tip of your pen, you can align the tablet.

To align the tablet:

1. Start the PSETUP.EXE file.
   
   **Note:** Follow the instructions in “Working with Applications” on page 493. You will find the PSETUP.EXE file in the C:\DOS\SYSTEM directory.

   The following window appears:

   ![Alignment Window](image)

   2. Use the pen to tap the center point of the cross-hairs.
      
      Hold the pen at the same angle you do when you write.

   3. Test the alignment by writing anywhere outside the box that contains the cross-hairs. To clear the ink, tap the CLEAR button.

   4. If the alignment is still not precise, tap the center point again.

   5. When the tablet is aligned to your satisfaction, tap the SAVE button to save the new alignment and exit the program.

      To exit the alignment program without saving any changes, tap the CANCEL button.
Recognition Tips
This section contains tips to help you ensure that PenDOS recognizes all of your characters.

Separate Your Characters
The Writing Window contains boxes to help you separate the characters. Write one character in each box.

Closing Loops
Make sure the loops are fully closed. An open "9" could be misinterpreted as a "4."

Retracing
To avoid confusion, do not retrace characters. PenDOS interprets retraces as a new character.

Writing Slashes and Parentheses
Write slashes and parentheses so that they cross both the top and bottom lines of the box.
Character Variations

PenDOS uses CIC's Handwriter Recognition System. This section lists the characters that this version of Handwriter recognizes and how to write them. When the direction and sequence of the pen strokes is important, arrows indicate the direction of the pen stroke and numbers indicate the sequence of the strokes. Horizontal lines represent the top and bottom lines of the boxes in the PenDOS Writing Window.

<table>
<thead>
<tr>
<th>Numbers</th>
<th>Symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Chapter 22. Using PenDOS 499
Chapter 23. Using PCMCIA Support

A computer having Personal Computer Memory Card International Association (PCMCIA) support provides sockets into which you can insert credit card-sized devices called PC Cards. A PC Card lets you extend the capabilities of your computer by adding functions, such as:

- Communications (FAX/Modems, Token Ring, Ethernet, 3270, and 5250)
- Memory (SRAM and Flash)
- Rotating media (ATA disk drives)
- Solid state disk drives

PC DOS provides PCMCIA support through PhoenixCARD Manager Plus Version 3.01 from Phoenix Technologies, Ltd. This product is referred to as PCM+. This latest version provides user-friendly, menu-interfaced utilities for the setup, configuration, and maintenance of your system. Your specified configuration is stored in an initialization file, PCM.INI, which can be modified through these utilities.

Notes:

1. You can also edit the PCM.INI file in a limited way using a text editor, such as the E Editor supplied with PC DOS. Refer to the online PC DOS 7 Command Reference for more information about the PCM.INI file.

2. For prior DOS versions of Phoenix PCMCIA, the command-line switches previously specified are no longer part of the command-line syntax. Everything is specified through the PCM utilities that modify the PCM.INI file.

This latest version of PCMCIA provides the following features:

- An uninstall program that backs up your current system PC DOS and Windows configuration files as .PCM files. Any command-line statements for prior versions of PCMCIA are commented out of the current configuration files. This ensures that the majority of conflicts are avoided when installing this new version of PCMCIA over an existing PCMCIA system.

- A Setup program that allows the new user to quickly and easily install PCMCIA while also providing a full range of customizing features for the sophisticated user.

- Support for PC DOS multiple-configurations.

** PC Card is a trademark of the Personal Computer Memory Card International Association.

© Copyright IBM Corp. 1981, 1995
• Support for Microsoft's Flash File System II (FFSII) device driver.

The MS Flash device driver is not supplied with PC DOS. You cannot use this interface without the device driver. The interface driver is included in PC DOS so that, if you have Microsoft's Flash support, you can use it with the PC DOS PCMCIA support.

• Easy-to-use information and configuration utilities for managing PC Cards in both PC DOS and Windows environments.

• Hot insertion and removal of PC cards without the need to reboot.

• Support for Power Management.

• Support for the largest number of PCMCIA cards: Flash Memory, SRAM Memory, FAX/Modem, ATA, hard disks, SCSI, LAN, and other I/O Cards. See "Configuring PC Cards after the Original Installation" on page 524 for information about configuring these cards after PCM Plus is initialized on your system.

**Installing Phoenix PCMCIA Support after Installing PC DOS**

If you did not choose Phoenix PCMCIA Support at initial installation, you can still install it by rerunning PC DOS Setup using the /e switch.

The PC DOS installation diskettes contain everything you need to install Phoenix PCMCIA Support. You might want to refer to Chapter 1, "Installing" on page 3 before you begin.

During Setup, PC DOS checks whether your computer has Windows 3.1 installed. If you do not have Windows 3.1 installed and want to use the optional tools provided with PC DOS for Windows, you should make sure you install in this order:

1. Install PC DOS as you normally would, selecting the optional tools you want from the list provided. You will not see any of the optional tools for Windows listed if you do not have Windows 3.1 installed already.

2. After you have installed PC DOS, install Windows 3.1 as you normally would.

3. Install PC DOS again using the Setup /e switch after DOS and Windows have both been installed.
To install Phoenix PCMCIA Support using the Setup /e switch:

1. Insert the Setup Diskette from the PC DOS installation diskettes into drive A or B.

2. At the DOS command prompt, type:
   
a:setup /e
   
or
   b:setup /e
   
The /e switch allows you to return to the optional tools-selection menu without having to do a complete reinstallation. At this point, only the necessary files for the optional tools for Windows will be installed.

3. After Setup begins, follow the instructions displayed on the screen. Make sure you specify the same “Install to Path” as you did when you did the initial PC DOS installation.
   
   At the Optional Tools screen, you see a NO next to Phoenix PCMCIA Support.

4. Either press the UP ARROW or DOWN ARROW until you highlight Phoenix PCMCIA Support and then press ENTER, or click on Phoenix PCMCIA Support if you are using a mouse.
   
   You now see YES next to Phoenix PCMCIA Support.

5. Select other optional tools you want to install at this time by highlighting the name of each optional tool and pressing ENTER for each item, or click on each optional tool if using a mouse.

6. Either move the cursor to highlight the following:

   Options correct. Continue Setup.

   and press ENTER or click on this line if using a mouse.

7. Continue to follow the instructions displayed on the screen until the optional tools are installed.

---

Starting PCMCIA

If you choose the PCMCIA optional tool during the installation of PC DOS 7, the files for this tool are copied to the PCM directory of the drive and path you specified. The exception is the Flash File System. PC DOS includes an interface driver to the MS Flash File System. If you have this Flash File System, you can use it with the PCMCIA supplied with PC DOS.
To successfully activate PCMCIA, you need to:

- Do one of the following before running PCMDINST.

  **If RAMBOOST is already installed and configured:**
  Edit the CONFIG.SYS file. Remove both the RAMBOOST statement and the EMM386 statement.

  **If RAMBOOST is not already installed and configured:**
  Before you install RAMBoost, you must edit the CONFIG.SYS file and remove the EMM386 statement.

After running PCMDINST, running RAMBoost Setup re-adds these statements back into the CONFIG.SYS file for you and configures your system based on your current PCMCIA configuration. If you are using hardware other than an IBM Thinkpad, refer to the procedures in “Running RAMBoost with PCMCIA (Non-IBM Thinkpad)” on page 528.

- Uninstall prior version of PCMCIA (including Phoenix). This is automatically done for the majority of PCMCIA programs by running PCMDINST.EXE. However, if you are using client or point enablers shipped with your PC Cards, you need to manually remove them.

- Have access to the following information to help you during the setup and configuration routines:
  - The number of PCMCIA sockets your computer possesses, including the number of sockets associated with your docking bay station, if you have one.
  - The full path to the directory where you installed Windows. If you are uncertain, look for the WIN.INI and SYSTEM.INI files. The directory containing these files is your Windows directory.
  - If you are using multiple configurations, be aware that PCMCIA changes your CONFIG.SYS file and installs itself in the configuration that you have designated to start when you turn on your computer.
    You must boot with the desired environment you want PCMCIA to run under.
  - If you are using a memory manager other than EMM386, you must manually exclude UMB memory for Card Services and ATA support and reset the system.
  - If you intend to run RAMBOOST with PCMCIA, see “Running RAMBoost with PCMCIA (Non-IBM Thinkpad)” on page 528.

If you did not specify the PCMCIA optional tool during the initial install, you can install it later by rerunning PC DOS Setup using the /e switch.
Setting Up PCMCIA (PCMDINST)

To begin the setup and configuring process for PCMCIA:

1. Remove any PC-cards from the sockets.

2. Change to your DOS directory (for example, C:\DOS) and type:
   
   pcmdinst
   
   This is generally done only once. The only other time you might have to use the PCMDINST command is if PCMCIA is removed from your system and you have to reinstall. For future configuration changes, you must use PCMSETUP.

   A message is displayed, indicating that your current PCMCIA configuration will be reconfigured and that your current system files will be backed up. Type Y to answer Yes and continue the process.

   If you are using EMM386 in your CONFIG.SYS file, it is commented out and replaced by a generic one. After the installation is complete, copy any Excludes for I/O cards from your old EMM386 line to the new one. PCMSETUP adds the Excludes for Card Services and ATA Support, as necessary.

   PCMINST is automatically started, and the Phoenix Card Manager Installation screen is displayed. This utility determines if your system has a PCMCIA controller supported by PC DOS. If found, the controller type is displayed on the PCMCIA Controller Found screen. If the controller in the system is not supported, an error message is displayed and PCMINST stops.

   Upon completion, PCMINST automatically starts PCMSETUP so that you can continue to configure your system.

Configuring Your PCMCIA System (PCMSETUP)

Use the following steps each time you need to reconfigure your computer.

To use these steps independent of the initial installation:

1. From the directory in which PCMCIA resides (for example, C:\DOS\PCM), type:
   
   pcmsetup
   
2. Follow the instructions on the PCMCIA SETUP screen.

   If you have configured your system before, the existing configuration message is displayed.
3. Press any key to continue.
   The Socket information screen is displayed.

4. Verify the default number of sockets and press ENTER.
   If the number of sockets is not correct, specify the correct value (including
   sockets in a docking station).
   The Windows screen is displayed with the Yes selection highlighted.

5. Press ENTER to select Yes, if you are going to use PCMCIA cards under the
   Windows program. A default path statement screen is displayed. If the path
   shown is correct, press ENTER. If it is not correct, specify the correct path, and
   press ENTER.
   Or, select No and press ENTER.
   The Advanced Setup screen is displayed.

**Designating Values on the Advanced Setup Screen**

The Advanced Setup screen is displayed with default values shown that apply to
most system configurations. Unless you are very familiar with memory
management, accept the defaults.
To designate values on the Advanced Setup Screen:

1. If your cards require values that are different than the default values displayed, specify values for the following:

   **IRQ** The default value is 10. You can accept this value and not change it. Card insertion and extraction are recognized within the system through polling (instead of interrupts), which provides greater system compatibility.

   **CIS Window Address** The default value shown relates to your system's current boot configuration. The value can be different for each system. Unless you understand memory management, accept the default value.

   If you need to manually specify this value, it requires a 4K memory window; hence, you must have 4K of free memory from the start address. For example, if you specify C000, you must have the range of C000-C0FF available.

   **Token Ring Speed** The default speed is 4. If you do not have a Token Ring Network Card, accept the default. If you do have a Token Ring Network card, choose 4 or 16, depending on your network setup.

   **Card Settle Time** The default is 660, representing milliseconds. This value specifies the amount of elapsed time after a card is inserted before Card Services accesses the socket.

2. Press ENTER to accept all the values listed.

   If you select a value that conflicts with an existing driver or device, a conflict warning is displayed. You are returned to the Advanced Setup screen, and you can either:

   - Enter another valid value.
   - Or, exit PCMSETUP, resolve the conflict, reboot your computer after resolution, and then rerun PCMSETUP.

   You must resolve the conflict before continuing the configuration. When there are no conflicting values, the Flash File System screen is displayed.
Designating Values for the Flash File System

The Flash File System screen is displayed with Yes highlighted as the default.

To designate values for the Flash File System:

1. Press ENTER if you are using the MS Flash File System. Accepting Yes indicates that you have the MS-FLASH.SYS device driver. This driver is not supplied with PC DOS. If you do not have this file, contact your Service Representative (not IBM).

   or

Select No and press ENTER. Go to “Designating Values for PCMCIA FAX/Modem Cards” on page 509. If you obtain the MS Flash File System in the future, rerun PCMSETUP and select YES.

2. If you accepted YES as the selection, a path default screen is displayed. The Flash File System path defaults to the C:\DOS directory. If this is correct, press ENTER. If it is not correct, type the correct path and press ENTER. The Flash File System Information screen is displayed with the default values that the system has determined you need to use with your Flash Card.

   If the MS-FLASH.SYS file is not found in the specified directory, a warning screen is displayed. When you escape from the warning screen, you are moved forward to the Communication Ports screen.

3. Press ENTER to accept the defaults on the Flash File System Information screen. The Communication Ports screen is displayed.

   If you select a value which conflicts with an existing driver or device, a conflict warning is displayed. You are returned to the Flash File System Information screen. You can:

   • Enter another valid value.
   • Exit PCMSETUP, resolve the conflict, reboot your computer after resolution, and then retry this configuration.

   You must resolve the conflict before continuing the configuration.
Designating Values for PCMCIA FAX/Modem Cards

The Communication Ports screen is displayed with YES highlighted as the default.

To designate values for PCMCIA modem/FAX cards:

1. Press ENTER if you are going to use PCMCIA modem/FAX cards. A Communication Ports screen is displayed, allowing you to specify the communication port you want your computer to use for the cards.

   or

   Select No and press ENTER. Go to “Designating Values for ATA-type Cards.”

2. Select an available communication port and press ENTER. The ATA Socket screen is displayed.

Designating Values for ATA-type Cards

The ATA Socket screen is displayed with YES highlighted as the default.

To designate values for ATA-type cards:

1. Press ENTER if you are going to use ATA-type cards. An ATA Socket screen is displayed with a default value highlighted for the window address.

   or

   Select No and press ENTER. Go to “Designating a PCMCIA Card” on page 510.

2. Change the value and press ENTER. An ATA Socket screen is displayed with a default value highlighted for the number of minutes to allow for a drive to be inactive before powering down the drive.

   Unless you understand memory management, you should accept the default value for the ATA window address. If you need to manually specify this value, it requires a 16K memory window; hence, you must have 16K of free memory from the start address.

3. Verify the default value (or change it) for the number of minutes you want to allow a drive to be inactive. The lower the value, the fewer minutes of inactivity allowed before the hard disk is powered down.

4. Press ENTER, and an ATA Socket screen is displayed starting with Socket 0 as the slot into which the ATA card is to be inserted.

   Most ATA hard disk drives (Type III PCMCIA card) occupy two sockets. Make sure you specify the correct socket (slot) number.

   When you select Yes, an ATA Socket screen is displayed that allows you to specify the number of partitions the ATA drive is to have.
5. Specify the number of partitions the ATA drive is to have, and press ENTER. The PCMCIA Card Selection screen is displayed.

For each socket on your computer, including the docking bay, you must specify a socket number and the number of partitions.

ATA cards can have up to four partitions. Make sure you specify the maximum number of partitions you are using or plan to use. You can always change this value later by rerunning PCMSETUP.

**Designating a PCMCIA Card**

You can choose to select one at a time, all, or none of the card selections during PCMSETUP or wait until you actually have the card. If you wait, your system will be dynamically configured using the PCM or PCMWIN utilities.

An additional advantage to waiting is saving memory. If you configure for a card you do not have, the unused configuration still gets loaded and occupies memory.

**To wait:**

1. Press ENTER. The SETUP Complete screen is displayed with Yes selected.
2. Press ENTER, and you are returned to the DOS command prompt.
3. Restart your system by pressing CTRL+ALT+DEL.
   
   If this is an initial Setup, your computer reboots automatically.

**To select one or more of the card selections:**

1. Use the UP ARROW or DOWN ARROW to highlight the desired card.
2. Press the SPACEBAR to select the card. An arrow appears to the left of your selection. To deselect that card, press the SPACEBAR again. The arrow disappears.
3. Press ENTER to confirm your choice. The Setup Complete screen is displayed with Yes selected.
4. Press ENTER, and you are returned to the DOS command prompt.
5. Restart your system by pressing CTRL+ALT+DEL.

   If this is an initial Setup, your computer reboots automatically.
To select all the choices:

1. Press F5 to select all the choices.
2. Press ENTER to confirm your choice. The Setup Complete screen is displayed with Yes selected.
3. Press ENTER, and you are returned to the DOS command prompt.
4. Restart your system by pressing CTRL+ALT+DEL.

   If this is an initial Setup, your computer reboots automatically no matter what choice you make on the final screen.

PCMSSETUP updates the PCM.INI file, CONFIG.SYS, WIN.INI and SYSTEM.INI files, as appropriate. It also adds the PCM directory to your PATH statement in your AUTOEXEC.BAT file. The updates are activated when you restart your system. PCM.INI is an editable ASCII file. You can change values as needed by using the E Editor. Refer to the online *PC DOS 7 Command Reference* for more information.

During the installation process, after a system reboot, the following drivers were loaded into your system:

- **CNFIGNAM.EXE** Used to specify which PCM Plus configuration should be accessed from the PCM.INI file.
- **PCMSS.EXE** Socket Services support. Works at the BIOS level as an interface between the PCMCIA card socket and the Card Service program.
- **PCMCS.EXE** Card Services support. Works at the operating system level to manage all PCMCIA cards, resources, and client drivers.
- **PCMRMAN** Scans the system for resource status and availability.
- **PCMSCD.EXE** Super Client Driver support. Configures FAX/Modem cards, LAN cards, or other I/O cards.
- **PCMATA.SYS** Used for IDE hard-disk emulation. Supports SRAM, rotating disk cards, or solid-state mass storage cards.
- **PCMFFCS.EXE** If Flash is selected, this driver is used to support the Microsoft Flash File System (FFS) protocol. Supports SRAM and Flash memory cards.

For more information about these drivers, refer to the online version of the *PC DOS 7 Command Reference*.  

Chapter 23. Using PCMCIA Support 511
Configuring PCMCIA

After PCMCIA is installed and set up, it should recognize the majority of the PCMCIA cards when you insert them into your computer. It dynamically configures memory, modem, and ATA cards. Most I/O cards must be configured before they can be used.

To configure I/O cards, you can use PCM or PCMWIN, the configuration programs provided with PCMCIA. These programs do not configure ATA or memory cards. For ATA and memory cards, you need to use PCMSETUP for configuration.

Using the DOS Configuration Utility (PCM)

To use the PCMCIA configuration program:

1. Insert the I/O PCMCIA card or cards into the available slots.
2. At the DOS command prompt, type the following command:
   
   pcm

   After pressing ENTER, the General Information Per Socket window is displayed with information about the card presently inserted in the designated socket.

3. Check the status line.

   This line displays the current status of the resident card. If PCMCIA was able to configure the card automatically, the status reads Card configured successfully. If the program did not recognize the card or the card has no CIS, this line reads Unconfigured.
4. Go to “Using PCM Configure” on page 513 if you need to:
   - Define an I/O card that PCMCIA cannot recognize.
   - Assign a new set of configuration values to an existing I/O card.
   - Edit an existing configuration for an I/O card.

5. To view additional information about the I/O card, press ALT+V to access the menu for View. Then, select Advanced or press the A key.

   To exit the Advanced Information screen, press ESC. You are returned to General Information Per Socket screen.

6. To exit the General Information Per Socket screen, press ALT+V to access the menu for View.

7. Type X or select Exit and press ENTER. You are returned to the DOS command prompt.

Using PCM Configure
To use PCM Configure, leaving the card in the slot, select Configure from the Menu Bar on the General Information Per Socket screen. The menu associated with this selection allows you to:

   - Add a card to the PCMCIA card list.
   - Edit the configuration values associated with a card already listed.

To add a PCMCIA card to the card list:

1. Starting from the General Information Per Socket screen, press ALT+C. The configure menu is displayed.

2. Select Add Card to List and press ENTER. The Add New Card to List screen is displayed. There may be several card configuration possibilities. The number of possibilities associated with the card is identified by the value shown for “Config Number.”

3. Use the UP ARROW and DOWN ARROW to switch between configurations.

4. Press ENTER when you find the configuration you want to use. A message prompt is displayed asking you whether you want the system to validate the configuration.

5. Select Yes or No and press ENTER. If you selected Yes, PCMCIA tests the configuration for conflicts and returns a message indicating no conflicts or that a conflict exists.

   If a conflict exists, it will be in one of the following values:
   - Memory Window address range
   - I/O Window address range
   - IRQ level
You can choose one of the following:

- Select another configuration, if one exists that meets your needs.
- Correct the value that is in conflict. Check the documentation that came with your card. If you cannot find the value you need, call the manufacturer of the card.

If you selected No, a message prompt is displayed asking you whether you want the system to save the configuration.

6. Select No not to save the settings. You are returned to the General Information Per Socket screen.

   The configuration is applied immediately by the system and, if saved, the configuration information is written to the PCM.INI file.

To edit the configuration values for a card you have already added to the card list:

1. Starting from the General Information Per Socket screen, press ALT+C. The Configure menu is displayed.

2. Select Edit Config Parameters and press ENTER. The Edit Card Configuration screen is displayed. There may be multiple configurations to choose from.

3. Edit the following editable fields:
   
   - Memory Window
   - I/O Window
   - IRQ

   Press TAB or use the UP ARROW and DOWN ARROW to move into the editable fields and scroll forward from field to field. Use the LEFT ARROW or RIGHT ARROW to move within the input area of a field. Press SHIFT+TAB or use the UP ARROW to scroll backwards from field to field.

4. Press ENTER when you are finished making changes. A message prompt is displayed asking you whether you want the system to validate the configuration.

5. Select Yes or No and press ENTER. If you selected Yes, PCMCIA tests the configuration for conflicts and returns a message indicating no conflicts or that a conflict exists.

   If a conflict exists, recheck your changes, make corrections, and press ENTER to start the process again.

6. Select No not to save the settings or select Yes to save the new values and press ENTER. You are returned to the General Information Per Socket screen.

   The configuration is applied immediately by the system and, if saved, the configuration information is written to the PCM.INI file.
Using the PCM Information Selection
Using PCM, you can access a list of I/O cards and their configuration sets that have been saved to the PCM.INI file. You can also access a list of PCMCIA client drivers that are active. To use this feature, start from the General Information Per Socket screen, and press ALT+I to display the menu for Information.

To review the card list:
1. Select Card List, and press ENTER. The Select PC Card screen is displayed.

   The card list displays all PCMCIA cards currently enabled for use by PCMCIA, together with specific configuration information. Not all cards need to be listed in this database to be used by PCMCIA. Normally, LAN, FAX/modem, and other cards that use multiple system resources should be added to the configuration list.

2. Use the UP ARROW and DOWN ARROW to scroll and highlight the card you want to view and press ENTER. The Preview PC Card Configuration screen is displayed.

3. Use the UP ARROW and DOWN ARROW to scroll through the configurations that have been established for the card.

4. Press ESC to return to the General Information Per Socket screen.

To review the client information:
1. Select Client Info and press ENTER. The Client Program Information screen is displayed.

   The Client Program Information lists the PCM client drivers currently loaded and provides specific information on each client. A client driver is a device driver (such as PCMATA.SYS) designed to support one or more PC Cards.

2. Use the UP ARROW and DOWN ARROW to scroll through the client information.

3. Press ESC to return to the General Information Per Socket screen.

Using the PCM Option Selection
The Option selection allows you to specify the use of a displayed message to confirm PC card insertion and removal while in PCM. The default is enabled.
To disable this selection:

1. Press ALT+O when the General Information Per Socket screen is active. The Message On Card Events message is displayed.

2. Press ENTER. The following message prompt is displayed:
   Card Events Disabled

**Using Windows Configuration Utility (PCMWIN)**

The PCMCIA configuration process is handled in Windows almost the same way as it is in PC DOS. PCMWIN is installed automatically by PCMSETUP, if your computer has Windows installed and you select Windows from the PCMSETUP program. The installation program inserts a PCMCIA program group into your Program Manager and places the PCMWIN icon inside that window. PCMWIN does not work in Windows standard mode. It works only in 386 Enhanced mode.

If you do not currently have Windows installed, but install it at a later time, you need to rerun PCMSETUP to activate PCMCIA for Windows.

**Running PCMWIN**

Running and configuring cards using PCMWIN is very similar to running the PCM configuration program for PC DOS. Use your mouse to select menus and other action items on a window. For detailed task oriented descriptions, see “Using the DOS Configuration Utility (PCM)” on page 512.

An additional option is provided in PCM for Windows configuration that is not available in PCM configuration for PC DOS is Associations.

**To use the Associations option:**

1. Starting from the General Information Per Socket screen, press ALT+O to display the menu for Options.

2. Select Associations and press ENTER.

   The Associations window is displayed. This option works only with Windows applications. It enables you to specify an associated program whenever the card is inserted. For example, most modem cards are used with a communication program such as the Windows Terminal program. Using this option, the communication program is started whenever the modem card is inserted.

   The card number, manufacturer name, and the model for this card are displayed in the first three lines. This information should be helpful to ensure that the proper association is used.
3. To enable the start-up of the associated program, click the Enable check box. An X appears to indicate that the association is enabled.

4. Use TAB or the mouse to move to the File field.

5. Type in the exact path and executable file to start the associated program.
   - If you do not know the path or name of the program, click on Select File to browse through your files until you locate the one you need. (Most executable files have an .EXE extension.)

6. Click on Previous or Next to edit or create other card-program associations.

7. When you are finished, click on OK.

### Using Advanced Configuration

PCMCFIA also includes an assortment of utilities, drivers, and adaptations to complement any PCMCIA environment, including:

- Multiple Configurations Support
- Advanced PCMCIA Utilities, such as PCMFDISK and PCMRMAN

### Handling Multiple Configurations Support

PCMCIA supports multiple configurations. You can use the multiple configurations option to select a specific configuration when the system is booted. For more information about multiple configurations, see Chapter 13, "Making More Memory Available" on page 205 or refer to the online *PC DOS 7 Command Reference*.

When you start PCMSETUP, it scans the CONFIG.SYS file for the menu section. If the multiple configuration option is detected, PCMSETUP checks the CONFIG variable in the environment to determine the current configuration name.

### Notes:

1. At startup, if you pressed F5 at the Startup Menu to bypass startup files, an error message is generated when you try to run the PCMCIA installation program, and it terminates. Reboot your system with a valid configuration to run PCMCIA installation.

2. To check all of the current configuration settings on your system, type set at the DOS command prompt. The configuration name appears as CONFIG=configname, where configname is the name you selected at boot time for a specific configuration. PCMCIA installs and sets up its files for the current configuration only. Any other configuration environment is not edited.

3. To install PCMCIA for a different configuration, you need to boot your system using that configuration and run the PCMCIA installation program. The
PCMCIA initialization file (PCM.INI) contains a section for each configuration environment you install.

**Using Advanced PCMCIA Utilities**

The following additional programs are available for use when you install PCMCIA and should be used with extreme caution:

- PCMFDISK
- PCMRMAN

**PCMFDISK**

PCMFDISK, like the DOS FDISK utility, sets the partition table for ATA-rotating disk and solid-state, mass-storage PCMCIA cards only. PCMFDISK can be run from the DOS command prompt or from within Windows under a DOS session.

**Warning:** PCMFDISK will destroy all data on the device if you create new partitions. You cannot use PCMFDISK on SRAM PC Cards formatted for use with PCMATA.

During PCMSETUP, you set the number of partitions to allow on ATA cards. All ATA cards have a minimum of one and a maximum of four partitions. You can use PCMFDISK to optimize the settings from PCMSETUP.

If you change the number of partitions to a higher number than what you specified during PCMSETUP, you must rerun PCMSETUP and reset the number of partitions. You can use the Environment selection to view the number of partitions that were set during the original PCMSETUP.

After inserting the ATA PC Card, run PCMFDISK to set (or reset) the following:

- Number of partitions
- Number of drive heads
- The number of sectors per track

PCMFDISK calculates the resulting drive size. This utility can also be used to adjust partition settings to enhance the performance of the disk. Consult the documentation accompanying your ATA PC Card for the optimum configuration.

**To run PCMFDISK:**

1. Type the following at the DOS command prompt:
   
   pcmfdisk

2. Press ENTER.

   The Partition and Geometry screen is displayed.
The Partition and Geometry screen presents information on the current partitions existing on the ATA card. Information on each partition is provided, including the:

- Socket number where the card is located
- System type
- Partition size
- Amount of the partition currently being used
- Number of heads used by the partition
- Number of cylinders used by the partition
- Number of sectors used by the partition

Below this information, the geometry for the total ATA disk is provided.

Usually, there is no reason to change the disk geometry. The default geometry has computed the fastest access speed. However, some ATA cards allow you to change their geometry.

**Warning:** After you change the geometry, the partition table might be invalid and need to be reset. Some ATA cards also fail to write and become unstable. If this is the case, the original values should be returned.

To modify the Partition of the installed ATA card, you can do one of several things:

- Create a new partition. You must delete the existing partitions and then create the new partition.
- Add a new partition to existing partitions. The new partition is limited to the size of the disk minus the existing partition size. If the Usage field on the Partition and Geometry screen shows one hundred percent, there is no room on your disk to add a new partition.
To use Delete Partition:

1. Press ALT+M to display the Modify menu.

2. Select Delete Partition and press ENTER. You are asked to confirm the deletion or abort the process.

   If more than one partition exists on the card, the system deletes the last partition first. For example, if two partitions exist on your disk, Partition 2 is deleted before Partition 1.

3. Press ENTER to confirm and continue the process.

   Any changes made to the partition table using the Modify option are not committed to disk until you use the Write Partition option under the Save menu.

To use the Create Partition Option:

1. Press ALT+M to display the Modify menu.

   Use this option to create a partition entry in the first empty partition slot. At most, up to four partition entries are allowed per ATA card.

2. Select Create Partition, and press ENTER. The Create Partition screen is displayed.

3. Press ENTER to accept the partition size shown in the highlighted field (this value reflects the total size of the Megabytes remaining on the disk).

   Or, type in a new size and press ENTER. The Partition table is displayed with the new partition table values.

4. If you want to create another partition, repeat steps 1 through step 3.

Any changes made to the partition table using the Modify option are not committed to disk until you use the Write Partition option under the Save menu.

To use the Save Option:

1. Press ALT+S to display the Save menu.

   No modifications to the ATA disk’s partition tables become actual until you use the Write Partition option. This saves all the changes you have made and deletes/creates a new partition table for the disk.

2. Select Write Partition and press ENTER. A warning and confirmation message is displayed. The warning indicates that, if you go ahead with the PCMFDISK process, it is possible to lose all of the data currently on the card.

3. Select Yes to confirm you want the process to be completed.

4. Exit to the DOS command prompt and format the drive using the PC DOS FORMAT command.
5. At the DOS command prompt, type:
   \texttt{format drive: /u}
   
   where \textit{drive} is the drive letter, and then press ENTER.

To exit from PCMFDISK:
1. Press ALT+S to display the Save menu.
2. Select Exit and press ENTER. You are returned to the DOS command prompt.

PCMFDISK provides three areas of help under the Help menu. These include:

\textbf{Contents} \quad A short overview of PCMFDISK and what it can change.

\textbf{About PCMFDISK} \quad The utility’s version numbers.

\textbf{Environment} \quad Information about partitions and drive assignments that were set up by PCMSETUP.

\textbf{PCMRMAN}

The PCMCIA Resource Management Utility (PCMRMAN) performs two distinct functions:

- As a stand-alone utility, it detects and displays the resources used by PCM Plus, such as memory and interrupts.

- As a command-line utility, it can change the current run-time values for the allocation of some system resources. For more information, refer to the online \textit{PC DOS 7 Command Reference}.

\textbf{Warning:} This program should be used with extreme caution. When used improperly, it can affect adversely the way your computer operates with PCMCIA cards.

To run PCMRMAN as a stand-alone program from the DOS command prompt:
1. Remove any PCMCIA cards from your computer.
2. Type this command at the DOS command prompt:
   \texttt{pcmrman}
3. Press ENTER.
   
   You can run this program from the DOS command prompt, from within Windows at the DOS session, or click on the File Run option, and type the command to start the program.
   
   The title screen appears.
4. Press any key to continue.
A warning screen is displayed. Read this carefully before continuing.

5. Press any key.

The main PCMRMAN screen is displayed.

Using Display
Display allows you to see available and unavailable values for Memory, I/O, and IRQ. All the screens associated with these values are read-only. The main PCMRMAN screen actually shows the memory ranges available and unavailable.

The two additional read-only screens are selectable from the Display menu:

- I/O Usage
- IRQ Usage

To use the Display menu:
1. Press ALT+D to display the Display menu.
2. Select I/O Range or IRQ Number and press ENTER. The applicable screen is displayed.

Using Modify
Modify allows you to change memory, I/O, and IRQ values. The changes you make are shown immediately on the screen where the change is being made. However, the changes do not take effect until you save them to the PCM.INI file and restart your computer.
To use the Modify menu:

1. Press ALT+M to display the Modify menu.
2. Select one of the resources to modify and press ENTER.

To modify memory ranges:

1. Select Memory Ranges from the Modify menu. The Upper Memory Usage screen is displayed with a User Override column that has the first item highlighted.

   Each memory range block listed is 4K in size and the value shown reflects the beginning and ending hexadecimal addresses. If you have installed a memory manager and PCMCIA, the available ranges or levels have been selected during this process.

2. Press the SPACEBAR, and the highlighted field displays a new value. Press the SPACEBAR until you see the value you need. There are three values defined:

   - None: Allow the availability of this resource to be determined by whether the computer itself is using it.
   - Excluded: This range has been specifically excluded from PCMCIA.
   - Included: PCMCIA has access to this range.

3. When you have modified all the User Override fields you require, press ENTER to accept these changes. The changes are shown on the screen.

To modify I/O ranges:

1. Select I/O Ranges from the Modify menu. The I/O Usage screen is displayed, along with the Edit I/O Range window.

2. Type in the new beginning and ending ranges you want to modify and then specify the type of modification desired.

3. When the User Override field is highlighted, use the SPACEBAR to change the value, if needed. The values are: None, Exclude, and Include and have the same meaning as described for memory ranges.

4. When you are finished modifying the I/O ranges, press ENTER to confirm your choice. The I/O Usage screen changes to reflect your modifications.
To modify IRQ numbers:

1. Select IRQ Number from the Modify menu. The IRQ Usage is displayed with first line in the User Override column highlighted.

2. Press the SPACEBAR, and the highlighted field displays a different value. Press the SPACEBAR until you see the value you need. The values are: None, Exclude, and Include and have the same meaning as described for memory ranges.

3. When you have modified all the User Override fields you require, press ENTER to accept these changes. The changes are shown on the IRQ Usage screen.

To save changes you have made to the Memory, I/O, or IRQ values:

1. Press ALT+F to display the File menu.

2. Select Save Configuration and a confirmation message is displayed.

3. Select No to ignore changes made and return to the main PCMRMAN menu. Select Yes to save changes. If you save a modified configuration, the new values take effect as soon as the computer is restarted.

To exit from PCMRMAN:

1. Press ALT+F to display the File menu.

2. Select Exit and press ENTER. You are returned to the DOS command prompt.

---

**Configuring PC Cards after the Original Installation**

This section provides guidelines for configuring the following types of cards:

- I/O Cards - FAX/modem
- I/O Cards - All others (LAN, Audio, SCSI, RS232, and so on)
- Memory Card - Flash
- Memory Card - SRAM
- ATA Drives (Rotating Hard Disk or Solid State File drives)

**Configuring FAX/Modem I/O Cards**

Most FAX/modem cards are automatically configured through the PCM Plus Super Client Driver. However, PCM can be used to configure and add the card to the card lists, but the defined configuration overrides the generic successful configuration.
To configure:

1. Use PCM or PCMWIN.

2. Insert the card.

3. Select to add a card, if it is not already added through PCMSETUP. A list of the preset configurations is displayed, one of which is displayed as being loaded.

4. Select the configuration you want or build your own by using TAB to move to the input fields and then typing the values needed. If all the resources are available, the selected configuration is successfully configured.

   It is suggested that you accept the automatic configuration rather than choosing one other than the default or building one manually.

Configuring All Other I/O Cards

All I/O cards, with the exception of FAX/modem I/O cards, must be configured with PCM or PCMWIN before they can be used. All resources that these cards need must be made available prior to configuration. If the resources (for example, memory, IRQ, or I/O) are not available when configuring, there might be a system conflict and the card will not configure.

The resource requirements for your card are provided by the PC Card Manufacturer. Consult your PC Card documentation for the resource requirements prior to configuring.

Use the following guidelines to help ensure that the needed resources are available for your card:

Memory

The default memory configuration shipped with PCM PLUS requires little or no user intervention for the majority of users. The default limits PCMCIA card services to the top 48K of the D segment; D400-DFFF. You should attempt to configure your PCMCIA resources within the default range. If you cannot or you need to make additional adjustments, see “Running RAMBoost with PCMCIA (Non-IBM Thinkpad)” on page 528 for more information.

Most I/O adapters use upper memory windows for ROM and RAM addressing areas. If you are using a memory manager such as EMM386, the memory manager makes use of all available upper memory space.
For example, if you are using EMM386 and an IBM Token Ring PC Card that requires the memory ranges of DC00-DDFF and D800-DBFF, the following exclusions need to be added on the EMM386 line in your CONFIG.SYS:

```dos
device=c:\dos\emm386.exe
noems
x=df00-dfff
x=d400-d7ff
x=dc00-ddff
x=d800-dbff
```

If you intend to run RAMBoost on your system, refer to “Running RAMBoost with PCMCIA (Non-IBM Thinkpad)” on page 528 for more information.

A memory conflict could exist even if you are not using a memory manager such as EMM386. An adapter could be using the same memory you need to use. In this case, you could use PCMRMAN to help identify what memory regions are available. At the DOS command prompt, type:

```
pcmrman /map
```

A status of your system’s resources is displayed. If you need to make adjustments for your memory ranges, you can use a text editor (such as the E Editor supplied with PC DOS) to make the change in your CONFIG.SYS file. To make the change effective, make sure that you reboot your system after making a change in the CONFIG.SYS file.

**IRQ**

Use PCMRMAN with the /map parameter to view the resource status for PCM. Verify that the IRQ you plan to use is listed in the IRQ allocation section under Available.

If the IRQ you plan to use is not available, check your PC Card manufacturer’s documentation to see if you can use any of the IRQs that are available. If you still believe that the IRQ you want to use is available, use the full-screen PCMRMAN utility to force the IRQ to become available. See page 524 for more information about modifying the IRQ number.
The following table provides the IRQ values that have been assigned to devices:

<table>
<thead>
<tr>
<th>IRQ Number</th>
<th>Assigned Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Timer Output</td>
</tr>
<tr>
<td>1</td>
<td>Keyboard</td>
</tr>
<tr>
<td>2</td>
<td>Route to Interrupt Controller 2, IRQ 8 to 15</td>
</tr>
<tr>
<td>3</td>
<td>Serial Port COM2</td>
</tr>
<tr>
<td>4</td>
<td>Serial Port COM1</td>
</tr>
<tr>
<td>5</td>
<td>Parallel Printer Port 2</td>
</tr>
<tr>
<td>6</td>
<td>Floppy-disk controller</td>
</tr>
<tr>
<td>7</td>
<td>Parallel Printer Port 2</td>
</tr>
<tr>
<td>8</td>
<td>Real-Time Clock</td>
</tr>
<tr>
<td>9</td>
<td>Software redirect to IRQ2 (INT OAH)</td>
</tr>
<tr>
<td>10</td>
<td>Reserved (default PC Card events)</td>
</tr>
<tr>
<td>11</td>
<td>Reserved</td>
</tr>
<tr>
<td>12</td>
<td>Reserved</td>
</tr>
<tr>
<td>13</td>
<td>80x87 Math Co-processor</td>
</tr>
<tr>
<td>14</td>
<td>Hard-Disk controller</td>
</tr>
<tr>
<td>15</td>
<td>Some Hard-Drive/SCSI controllers</td>
</tr>
</tbody>
</table>

**I/O**

Use PCMRMAN with the /map parameter to view the resource status for PCM. Verify that the I/O range you plan to use is listed in the I/O allocation section under Available.

If the I/O range you plan to use is not available, check your PC Card manufacturer's documentation to see if you can use any other available I/O. If you still believe that the I/O you want to use is available, use the full-screen PCMRMAN utility to force the I/O range to become available. See page 522 for more information.

**Configuring the FLASH Memory Card**

If you are using the Microsoft Flash File System support, you must select Flash in PCMSsetup.

If you are not using the Microsoft Flash File System support, you must select No to Flash in PCMSsetup. Consult your PC Card documentation on setting up your Flash support drivers and configuring your Flash Card.
Configuring a SRAM Memory Card
If, during installation, you selected Yes to ATA, your SRAM card is automatically configured when you insert it.

Use PCM or PCMWIN to view your SRAM card status. Ensure that the card is not write protected. If the system returns a message that says the card configured successfully, it is ready to use. If this message is not returned, check the following:

• Ensure that you have selected ATA support during PCMSETUP. If not, rerun PCMSETUP and select ATA support.
• Ensure that the socket you inserted the card in was a socket selected for ATA support during PCMSETUP.

Configuring ATA Drives (Rotating Hard Disk or Solid State)
If, during installation, you selected Yes to ATA, your ATA card is automatically configured when you insert it. If you did not have the ATA card, run PCMSETUP and select Yes for ATA support.

Use PCM or PCMWIN to view your ATA card status. If the system returns a message that says the card configured successfully, it is ready to use. If this message is not returned, check the following:

• Ensure that you have selected ATA support during PCMSETUP. If not, rerun PCMSETUP and select ATA support.
• Ensure that the socket you inserted the card in was a socket selected for ATA support during PCMSETUP.

If you would like multiple partitions on your drive, use PCMFDISK to partition it. See “PCMFDISK” on page 518 for more information.

Running RAMBoost with PCMCIA (Non-IBM Thinkpad)
If you have a computer, other than the IBM Thinkpad computer, that you want to install PCMCIA Support on, you must remove any memory manager you might have running first. After the installation of PCMCIA is complete, you can run the RAMBoost memory optimizer.

To install RAMBOOST with PCMCIA on Non-IBM Thinkpad systems:

1. Edit your CONFIG.SYS file and comment out, or remove, the memory manager.
2. Reboot your system (before activating PCMCIA).
3. Install PCM PLUS (the PCMCIA support product shipped with PC DOS 7), by issuing the PCMDINST command from your DOS\PCM directory.
4. Configure all your PC Cards using the PCM or PCMWIN utility and ensure they are functional. For example, if you have a network card, make sure you can access the network.

5. Restart your system if it does not restart automatically after configuring your last PC Card.

6. Start RAMBoost by typing `ramsetup` at the DOS command prompt.

**Resolving Memory Conflicts**

Memory utilization can be optimized with the use of PC DOS 7 memory optimizer RAMBoost. But the systems must be configured so that memory areas for the PC Card, adapter and Memory Manager (such as EMM386) do not conflict with one another.

**Note:** The following descriptions are highly dependent on your hardware configuration. You might have adapters (for example, CD-ROM, SoundCard) which could occupy some of the upper memory.

The default memory configuration shipped with the PCMCIA support requires little or no user intervention for the majority of users. The preconfiguration involves limiting PCMCIA card services to the top 48K of the D segment; D400-DFFF.

The upper memory map would look like this to RAMBoost:

```
0 1 2 3 4 5 6 7 8 9 A B C D E F
C 0000000000000000000000000000000000000000000000000000000000000000
D 0000000000000000xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
```

- `x`— Memory available to PCMCIA Card Services
- `0`— Memory available to RAMBOOST

Users should attempt to configure their PCMCIA resources within the pre-set D400-DFFF range. In the event that D400-DFFF is not available to PCMCIA or a PC Card requires memory outside of the available range, the user will have to manually re-configure PCMCIA resources. To determine the required memory space boundary for the PC Card, refer to the manual that came with the PC Card. Most PC Cards specific memory requirements can be relocated as long as the specified boundaries are followed. Use the PCMRMAN utility to reconfigure PCMCIA resources. See “Using Advanced PCMCIA Utilities” on page 518 for more information.

Issue the command `PCMRMAN /MAP` to view PCMCIA resource allocation. This displays the memory ranges currently available to PCMCIA.
Issue the command PCMRMAN to modify the PCM Plus resources. For example, suppose you have a card requiring a 16K memory range starting at D000. Use the PCMRMAN utility to “Include” ranges D000-D3FF; each block listed is 4K in size. Hence, the range of D000-D3FF (You must reboot the computer so the changes can take affect).

When you start PCM, ignore the WARNING message that the included memory is already excluded and follow the instruction to press any key to continue.

Use PCM or PCMWIN utility to configure the PC Card at the location made available through PCMRMAN. Go to “Configuring PC Cards after the Original Installation” on page 524 for information on how to use PCM or PCMWIN to configure the different type of PCMCIA Cards.

**Making More Memory Available to RAMBoost**

When you run PCMCIA before running RAMBOOST, 48K of upper memory is made available for PCMCIA. You might not use all the allocated space. To release the space PCMCIA is not using and make it available to RAMBoost, run PCMRMAN to “exclude” the unused ranges.

For example, you only have a modem card (which requires no memory). You can make 44K of upper memory available to RAMBoost by excluding the range D400-DEFF. The upper memory map then looks like the following to RAMBoost.

```
0 1 2 3 4 5 6 7 8 9 A B C D E F
C 0000000000000000000000000000000000000000000000000000000000000
D 000000000000000000000000000000000000000000000000000000000000000

x- Memory available to PCMCIA Card Services
0- Memory available to RAMBOOST
```

If you only have an ATA (Harddisk) and a modem, you can then exclude the range D800-DEFF giving RAMBoost an extra 28K of upper memory.

The upper memory map then looks like the following to RAMBoost:

```
0 1 2 3 4 5 6 7 8 9 A B C D E F
C 000000000000000000000000000000000000000000000000000000000000000
D 000000000000000000000000000000000000000000000000000000000000000000

x- Memory available to PCMCIA Card Services
0- Memory available to RAMBOOST
```
After changing your PCMCIA configuration, reboot your system. Then, type `ramsetup` at the DOS command prompt. Select the option to have RAMSETUP rebuild the EMM386 statement.

**Running RAMBOOST with IBM Thinkpad PCMCIA Software**

The procedure you need to follow to run RAMBOOST with the Thinkpad PCMCIA software depends on the date the Thinkpad was shipped. Thinkpads shipped during 1993 contain the PCMCIA Version 2.0 release. Thinkpads shipped during 1994 contain PCMCIA Version 2.1.

With PCMCIA Version 2.0 you need to make space available for RAMBoost to run without a memory conflict. With PCMCIA Version 2.1, you need to make space unavailable to RAMBoost to avoid memory conflicts.

**To adjust the PCMCIA Version 2.0 release for RAMBOOST,**

1. View your CONFIG.SYS file for the statement:
   ```
   device=c:\pcmcia\dicrmu01.sys /ma=xxxx-xxxx
   ```
   where `xxxx` represents the reserved upper memory range.

2. Record the value indicated for the reserved memory. You will use this as a guide when running RAMSETUP to allocate the available upper memory for RAMBoost.

3. Type `ramsetup` at the DOS command prompt.

4. Select Advance.

5. Press TAB or click on the Upper Memory Usage Editor.

6. Click on the desired location or use the arrow keys to move the highlight to the desired location.

7. Press F2 to set the space to -- (Available) and make that space (memory range) available to RAMBoost.

8. Repeat until all desired ranges are edited.

For example, if you see the following statement in your CONFIG.SYS file,
```
device=c:\pcmcia\dicrmu01.sys /ma=c000-cfff
```
You would need to set an available range of D000-DFFF in RAMSETUP for RAMBOOST to run without a memory conflict.
To adjust the PCMCIA Version 2.1 release for RAMBOOST

1. View your CONFIG.SYS file for the statement:
   
   ```
   device=c:\pcmcia\dicrmu01.sys /ma=xxxx-xxxx
   ```
   
   where `xxxx` represents the reserved upper memory range.

2. Record the value indicated for the reserved memory. You will use this as a
guide when running RAMSETUP to allocate the available upper memory for
RAMBOOST.

3. Type `ramsetup` at the DOS command prompt.

4. Select Advance.

5. Press TAB or click on the Upper Memory Usage Editor.

6. Click on the desired location or use the arrow keys to move the highlight to the
desired location.

7. Press F7 to set the space to AD (Adapter RAM) so that the memory range
specified by the `/ma` switch (associated with DICRMU01.SYS) is blocked from
use by RAMBoost.

8. Repeat until all desired ranges are edited.

For example, if you see the following statement in your CONFIG.SYS file,

```
device=c:\pcmcia\dicrmu01.sys /ma=c000-cfff
```

You would need to make the range of C000-CFFF unavailable to RAMBOOST to
run without a memory conflict.
Appendix A. More About Installing

Procedures for a standard PC DOS installation can be found in "PC DOS Standard Installation" on page 14. Be sure to review "Before You Begin" on page 5 before performing any type of installation.

This appendix provides installation procedures if you want to perform something other than a standard PC DOS installation,

This appendix also provides more detailed information about the options and choices you can make during a PC DOS installation, such as whether or not to back up your current DOS version. Other installation-related information, is provided in this appendix also.

Choosing the Correct Installation Procedure

Table 2 on page 13 helps you choose the correct procedure for the type of installation you want to do. Unique types of installations are detailed in the following sections.

Installing DOS Files on a Drive Other than Drive C

If you have previously partitioned your hard disk into logical drives, you can install the DOS directory on any of those drives. The files required to run your operating system are copied to primary drive C. All other files associated with the install are copied to the drive you specify.

To install PC DOS on a drive other than drive C:

1. Follow the steps in "PC DOS Standard Installation" on page 14 until the optional tools screen is displayed.

2. In addition to selecting the tools you want to use, highlight the Install to Path line.

3. Press ENTER.

4. Type the drive and directory where you want to install PC DOS.

5. Press ENTER.

6. Continue until the installation is completed. PC DOS is installed to the drive and directory you specified in step 4.
Installing PC DOS If You Have OS/2 Installed

The following guidelines only apply if you have installed:

- OS/2 and a Dual Boot system.
- OS/2 with Boot Manager active.
- OS/2 as a FAT file system.
- OS/2 and have Stacker for OS/2 & DOS installed.

To install if your system only has OS/2 installed as a FAT file system:

1. Insert the Setup Diskette into drive A.
2. Restart your computer by pressing CTRL+ALT+DEL.
3. Follow the instructions on your screen.
   You might receive a message informing you that your system will be turned into a Dual Boot system.

After your installation is complete, first time users of the OS/2 Dual Boot feature need to refer to “Switching Between PC DOS and OS/2 Using Dual Boot” on page 535 for information on how to use the OS/2 Dual Boot feature.

If you are using OS/2 Version 1.2 or lower, upgrade your version of OS/2 before installing PC DOS.

To install using the OS/2 Boot Manager:

You must do the following within OS/2 before PC DOS can be installed.

1. Use OS/2 FDISK to set the DOS partition to installable while OS/2 is running.
2. Shut down OS/2 by clicking mouse button 2 (normally the right mouse button) on an empty area of the desktop. Place the Setup Diskette into drive A, and then restart your computer by pressing CTRL+ALT+DEL.
3. Follow the install instructions as they are displayed on your screen.
4. At the screen that notifies you the installation is complete, remove the diskette from drive A, and then restart your computer by pressing ENTER. The Boot Manager starts, allowing you to choose which system you want to start.
To install if your system already has Dual Boot capability:

1. Change to the directory where the BOOT.COM file is located (generally C:\os2). by typing:
   
   cd \os2

   **Note:** BOOT.COM is an OS/2 file that starts Dual Boot. If your system does not have this file installed, you will have to retrieve it from your OS/2 diskettes and install it in your OS2 directory.

2. To move from the OS/2 operating system to the DOS operating system, type the following at the command prompt:

   boot /dos

3. When DOS finishes booting, insert the **Setup Diskette** from your PC DOS installation diskettes into drive A.

4. Type the following at the DOS command prompt:

   a:setup

5. Follow the instructions on your screen.

6. After the PC DOS installation is done, remove the diskette from the diskette drive and then you can return to OS/2 by typing the following at the command prompt from the DOS operating system.

   boot /os2

**Switching Between PC DOS and OS/2 Using Dual Boot**

Before you can use Dual Boot, you must switch to the directory that contains BOOT.COM which will start Dual Boot. This file is generally located in the C:\OS2 directory.

**To use OS/2 dual boot to switch between operating systems:**

After you have installed PC DOS to operate along with your OS/2 system, use the OS/2 Dual Boot feature to switch between the operating systems.

To get to this directory, type the following:

   cd\os2

To move from the OS/2 operating system to the DOS operating system, type the following at the command prompt:

   boot /dos
To return to OS/2 from the DOS operating system, type the following at the command prompt:

```
boot /os2
```

**Installing PC DOS If You Have OS/2 Stacker Compression**

If you are using OS/2, do not use PC DOS Stacker to compress any drives where the following types of files are located:

- OS/2 files
- Files used for DOS sessions of OS/2
- Dual Boot files

If your OS/2 drives are already compressed using Stacker's own Stacker for OS/2 & DOS version, remember you can use only one compression program at a time. Refer to the Stacker README.TXT file in the STACKER directory, if you want to uninstall Stacker from OS/2 and install Stacker from PC DOS.

If you compress drives with these types of files using PC DOS Stacker, OS/2 will not function properly.

**Installing PC DOS on a PS/1 Computer**

Follow the installation detailed in “PC DOS Standard Installation” on page 14 if your PS/1:

- *Is not a four-quad system*
  
  Or, you can disable the four-quad system during Setup by typing `setup /p` to start Setup.

- *Has compression installed*
  
  The four-quad system will not be enabled after installation if you already have compression and run Setup, or if you install compression after running Setup.

- *Is a newer model PS/1*
  
  New models of PS/1 do not have DOS built into the ROM.

Use the following installation procedure if your PS/1 is a PS/1 model (Model FC0B or F830) that uses a specific ROM chip.

**Note:** Do not select the optional tool for compression.
To install DOS on an earlier version of PS/1 that has a ROM four-quad system:

1. Insert the Setup Diskette into drive A.
2. At the Four-Quad screen, select Your Software.
3. Select Drive A.
4. Select Setup.
5. Follow the instructions in “PC DOS Standard Installation” on page 14 to complete the installation.

Setup enables four-quad ROM systems by copying the ROMSHELL.COM file from ROM memory and by copying the RSSTUB.EXE file from the PC DOS installation diskettes to the same directory specified for the install-to path. Setup also adds an RSSTUB statement to your AUTOEXEC.BAT file so that the four-quad screen is displayed whenever the PS/1 machine is started.

Installing PC DOS on a Compressed Drive

Use the following procedures to install PC DOS on systems where drives have been compressed using disk compression programs.

Setup recognizes and allows you to install on compressed drives using:

- SuperStor/DS** provided with PC DOS Versions 6.1 and 6.3.
- Any previous version of Stacker compression.
- Microsoft’s DoubleSpace or DriveSpace
- Novell’s DR DOS 7.0’s version of Stacker compression.
- Addstor**’s SuperStor** 2.0 and SuperStor PRO**.
- DoubleDisk Gold Version 6.0. for any drive other than drive C.

These compression programs are incompatible with the PC DOS Setup program:

- DoubleDisk Gold 6.0 (only if your drive C is compressed).
- Any version of XtraDrive.

Note: Refer to the README.TXT file on the Setup Diskette of the PC DOS installation diskettes or, after installation, on the directory where your DOS files are located.

** SuperStor, SuperStor/DS, SuperStor PRO, and Addstor are trademarks of Addstor, Inc.
To install PC DOS on a drive that has been compressed with a compatible disk compression program:

1. Start your system.

2. Type a:setup to run Setup. Your compatible disk compression program will be recognized and handled accordingly.

3. Follow the installation steps in “PC DOS Standard Installation” on page 14.

To install PC DOS on a drive that has been compressed with SuperStor PRO with no swappable drive support installed:

1. Start your system with your current software.

2. Insert the Setup Diskette into drive A, and type:
   
a:setup

3. When Setup is finished, insert the Setup Diskette into drive A again, and restart your system.

4. Type \ when prompted whether you want to install PC DOS. (If you do not answer in 10 seconds, the default answer YES is assumed.)
   
The command prompt A:\> is displayed.

5. While at the A:\> prompt, type:
   
sys c:

6. Remove the diskette and press CTRL+ALT+DEL to restart the system from the hard drive.

7. Modify the CONFIG.SYS file and move the SuperStor device drivers to the top of the file. Refer to your SuperStor documentation to determine what device drivers it is using.

8. After rebooting, make sure IBMBIO.COM and IBMDOS.COM files, or the compressed drive, get updated.

   **Note:** When you install to a SuperStor PRO compressed drive that has the files IBMBIO.COM and IBMDOS.COM, they might not be updated correctly.

9. If you need to update these files, (assuming drive C is the compressed drive and drive D contains the uncompressed files used to start your system), type:
   
   ```
   attrib -s -h -r c:\ibmbio.com
   attrib -s -h -r c:\ibmdos.com
   del c:\ibmbio.com
   del c:\ibmdos.com
   ```
10. Insert the Setup Diskette from the PC DOS installation diskettes into the diskette drive and type:

   a:\sys a: c:

   The SYS command copies the COMMAND.COM, IBMBIO.COM, and IBMDOS.COM file to your hard drive.

11. Remove the Setup Diskette, and press CTRL+ALT+DEL to restart the system from the hard drive.

Notes:

1. Before upgrading a compatible compression drive it is a good practice to ensure your hard disk has the latest compression program installed. For example, if you have a version of SuperStor before Version 1.4, you need to upgrade. Refer to the PC DOS README.TXT file for further information.

2. If you have compressed your drives using a non-compatible disk compression program, contact your software vendor.

Installing PenDOS

If you plan to select PenDOS optional tool, keep these things in mind:

• The proper hardware must be installed.
   
   If you select PenDOS as an optional tool and then select a tablet or mouse device, Setup will modify your CONFIG.SYS and AUTOEXEC.BAT files and will add the appropriate device statement. A command-line statement for PENDOS.BAT is also added by Setup in your AUTOEXEC.BAT.

• The proper tablet driver is required for your digitizer:
   
   – If you have a pen tablet computer with a self-contained digitizer, you should choose that computer’s tablet driver.
   
   – If you will be using your mouse as your pointing device, select the Digitizing Pad Emulation via Mouse tablet driver.

• The digitizer must be connected to the proper communication port on your computer if you have an externally attached digitizer. Refer to the digitizer manufacturer’s instructions for the proper installation procedure.

• PenDOS requires the EMM386 memory manager to run.

• Running RAMBoost Setup allows you to install the EMM386 memory manager. Be sure to select the EMS option on the Advanced Option screen.
Performing the LAN Server Administrator Installation of PC DOS

The following information is intended for LAN administrators who will be installing PC DOS from a network server or a remote workstation. If you are installing PC DOS on a single workstation that is not connected to a network, you do not need this information.

Running SETUP /A provides two options for LAN administrators:

- Creating a LAN Administrator's Directory
  Before you can install PC DOS across the network, you must first create an administrator's directory on the server that will contain all the DOS and optional tool files from the PC DOS Setup diskettes.

- Creating a directory for DOS Files and Tools
  This option provides the LAN administrator DOS files and optional tool files in an unpacked format available in a \DOSFILES subdirectory on the LAN.

**Note:** Setup does not allow you to select YES for both options at the same time. If you want to select both options, you must run SETUP twice, selecting a different option each time you run SETUP /A.

Creating a LAN Administrator Directory

Running SETUP /A creates a LAN administrator directory that allows for PC DOS installation across the network by individual workstations. The name of the directory is specified by the LAN administrator. After SETUP /A is completed, PC DOS can be installed to a workstation using the SETUP program from this directory.

These instructions do not apply to Remote Initial Program Load (RIPL**) systems or medialess computers. For RIPL systems, see your manufacturer's instructions about installing PC DOS images.

If your server is running OS/2 WARP, you can run SETUP/A from the DOS session or DOS Window. If your server is running OS/2, run SETUP /A from a remote DOS workstation. The workstation must have read/write access to the server.

** RIPL is a trademark of CTA, Inc.
To create an administrator's directory at the server:

1. Make sure you have 9.5MB of disk space available for the LAN administrator's directory before beginning the installation.

2. Insert the Setup Diskette into a drive on the system server.

3. Start Setup by typing:
   
   \[ n:\text{setup} /a \]

   where \( n \) represents the drive where the Setup Diskette is inserted.

   **Note:** If you use the /t switch, in combination with the /a switch (for example, \( \text{setup} /a /t:c:pcdos7 \)), to specify a directory path, the option selection screen will be bypassed and Setup will default to this Create a LAN administrator directory option.

4. Press ENTER and follow the instructions on your screen.

5. When queried how you want to install DOS to a network, select Create an administrator directory.

   All the files on the PC DOS installation diskettes are then copied to the DOS7 directory unless you specified your own directory name. If you specify the name for the administrator's directory, do not specify the DOS directory or the DOSFILES directory, and do not specify the root directory.

   The **bundle** files are not unpacked. Refer to "Working with Setup Bundle Files" on page 554 for complete information about bundle files provided with PC DOS.

6. Either use the DOWN ARROW to scroll to:

   Options correct. Continue Setup.

   Then press ENTER, or click on this line if using a mouse.

7. After the installation has been completed, mark the files in the subdirectory as read only.

8. Follow the LAN administrator procedures necessary to share this subdirectory with workstations that will be installing PC DOS across the LAN.
To create an administrator's directory from a remote workstation to a server:

1. Start your network software on the workstation and connect to the network server where the administrator directory is to be created. The workstation must have read/write access to the server.

2. Insert the Setup Diskette into a drive on the workstation.

3. Follow step 3 through step 8 on page 541 in the instructions for creating an administrator's directory at the server.

   Note: Make sure you change the path to the network drive.

Creating a Directory for DOS Files and Tools

SETUP /A also provides the LAN administrator the option of having a \DOSFILES subdirectory on the LAN containing DOS files and optional tool files in an unpacked format.

This option does not permit you to install PC DOS to a workstation; this option does allow you to copy individual DOS files.

To install a directory of DOS files and tools at a server:

1. Make sure you have 16.0MB of disk space available for the DOS files and tools directory before beginning the installation.

2. Insert the Setup Diskette into a drive on the system server.

3. Start Setup by typing:

   \n:setup /a

   where \n represents the drive where the Setup Diskette is inserted.

4. Press ENTER and follow the instructions on your screen.

5. Specify a directory name, when prompted, if you do not want to install to the DOS7 directory or if you want to specify your own directory name. Do not specify the DOS directory, the DOSFILES directory, nor the root directory.

6. When queried how you want to install DOS to a network, select Copy all PC DOS files and tools.

7. Make sure the "Install to Path" is for a network drive.

8. Select Options correct. Continue Setup to complete the installation.

All DOS files and all optional tools files are unpacked and copied to the subdirectory DOSFILES. Subdirectories for DATA, SYSTEM, STACKER, and PCM (for PCMCIA support files) are created under \DOSFILES. For example, \DOS7\DOSFILES\DATA and \DOS7\DOSFILES\STACKER would be created.
During Setup, you are not allowed to specify another name for the administrator's \DOSFILES subdirectory.

To install a directory of DOS files and tools from a remote workstation to a server:

1. Start your network software on the workstation and connect to the network server where the DOS files are to be copied. The workstation must have read/write access to the server.
2. Insert the Setup Diskette into a drive on the workstation.
3. Follow steps 3 through 8 on page 542 in the instructions for installing a directory of DOS files and tools at a server.

Installing PC DOS after the LAN Administrator Install
If you do not have access to the server containing PC DOS or are not sure how to upgrade the network files, contact your LAN administrator.

To install PC DOS after the LAN administrator has made it available within the LAN:

1. Start the workstation with your current version of DOS.
   
   Avoid starting applications, terminate-and-stay-resident (TSR) programs, disk caches, multi-taskers, and task switchers when installing PC DOS.
   
   If you are running OS/2 with the Dual Boot feature, type the following at the DOS command prompt:

   boot /dos

2. Start your network software; then connect to the server containing PC DOS.
   
   Note: Upgrade your network files to work with PC DOS according to instructions from the LAN administrator.

3. Start Setup that is on the server. For example, if the DOS files are located in a subdirectory named PCDOS70 on network drive N, you would type:

   n:\pcdos70\setup

   Then press ENTER.

4. After installing PC DOS, restart your workstation.

5. Reconnect to the LAN server to ensure your LAN software upgrade was successful. If you cannot start the LAN software or reconnect to the LAN server, see your LAN administrator.
Installing PC DOS from a CD-ROM Drive

Installing PC DOS 7 from a CD-ROM requires:

- The installation be while running under a DOS operating system; you should not install from any other type of operating environment.

- A CD-ROM drive installed on your computer system. If this hardware is not already installed, you will need to follow the hardware manufacturer's installation documentation.

- The proper statements for the CD-ROM support utility are added to your AUTOEXEC.BAT and CONFIG.SYS files. After PC DOS is installed, you can type help mscdex for further information.

To install DOS from a CD-ROM drive:

1. Ensure that MSCDEX command to install CD-ROM devices is already loaded.
   Or, type the command to load it at the DOS command prompt.

2. Insert the CD-ROM disk into your CD-ROM drive.

3. Type the following at the DOS command prompt:

   cdromdrive:setup
   
   where cdromdrive is your CD-ROM drive letter.

4. Continue following the instructions until the installation has completed.
   The DOS and tools files are installed to the DOS directory.

Rerunning Setup

Rather than perform a complete installation of PC DOS, you can rerun Setup instead. Reasons to rerun Setup include:

- To install additional optional tools for DOS and Windows using SETUP /E.

- To change the current time and date, country support for international character sets, keyboard layout for different countries, or ISO fonts for VGA hardware (SETUP /Q).

- To recover either a DOS file or an optional tool file from your PC DOS installation diskettes if, after installation, they have been accidentally deleted or damaged (using SETUP if a DOS file; using SETUP /E if an optional tool file).
Installing Additional DOS and Windows Optional Tools

As you upgrade your equipment or as your needs expand, you will want to rerun Setup to add any optional tools you did not install initially. You can install PC DOS optional tools for DOS and Windows (provided Windows is already installed) as many times as is necessary using the /e switch. When you rerun Setup using the /e switch, you save time during installation because Setup does not re-copy the DOS files.

When you rerun Setup, be sure to:

• Review the installation steps that apply to your system. (Use Table 2 on page 13 to guide you.)
• Not select the optional tools you already have installed; select only the new tools you want to add.
• Install to the same drive and path that contains your current DOS directory when you rerun Setup or else you will receive disk error messages.

To rerun Setup using the /e switch:

1. Insert the Setup Diskette into drive A or B.
2. At the DOS command prompt, type:
   
a:setup /e
   
or
   
b:setup /e
3. At the optional tools screen, either use the UP ARROW to scroll to the optional tool you want to add. Then press ENTER, or click on the optional tool if using a mouse. The selection choice changes from NO to YES.

   It is not necessary to re-select options you already have installed. Using the /e switch only allows you to add tools—it does not remove your current optional tools.
4. Verify that you have specified the same drive and path as where your current DOS directory is located.
5. Either use the DOWN ARROW to scroll to the line:
   
   Options correct. Continue Setup.

   if you are not already there, and then press ENTER, or click on the line when using a mouse, if all the options are correct.
6. Continue to follow the instructions displayed on the screen until installation is complete.
Recovering Files from the Setup Diskettes

During installation, Setup copies all the DOS files and all the files for the optional tools you selected to your hard drive.

However, should you need to copy a file that might have been deleted from your hard drive or damaged after you have installed PC DOS, run Setup entirely—only if you do not know which file was deleted or damaged. Any files that might have been deleted or damaged will be restored.

However, if you know which file was deleted or damaged, or know whether the file is either:

- A DOS file pertaining to the operating system
- An optional tool file

you can save time by rerunning Setup using the /e switch instead of rerunning Setup completely.

To determine whether a file is a DOS file or an optional tools file:

1. View FILES.TXT file using the PC DOS E Editor by typing:
   
   e files.txt

2. Search the FILES.TXT file by typing the following at the E Editor command line:

   L/filename

   where filename is the name of the deleted or damaged file you are trying to search for.

3. Look in the bundle column and note whether the file is not packed in a bundle, packed in the “DOS” bundle file or in a bundle file for an optional tool, such as “COMPRESS” for Stacker Compression files.

Files not packed in a bundle show a hyphen in the “BUNDLE” column. All non-bundled files are located on the Setup Diskette. If the file you need to recover has a hyphen next to it, you can use the COPY command to copy it to your hard drive instead of following this recovery procedure.

Refer to “Working with Setup Bundle Files” on page 554 for an explanation of bundle files.
4. Follow the instructions in step 5 for either recovering a DOS file or an optional tool file from the *Setup Diskette*:

   **Note:** In addition to the file you want to recover, all other files in either the DOS bundle file or the specified optional tool bundle file are copied also.

5. *If you want to recover a DOS file:*
   a. Insert the *Setup Diskette* into drive A.
   b. Rerun Setup by typing:
      ```
a:setup
```
   c. Follow the instructions on the screen.
   d. Do not select any optional tools at the optional tools screen. Make sure there is a NO beside each optional tool.

   *If you want to recover an optional tool file:*
   a. Insert the *Setup Diskette* into drive A.
   b. Rerun Setup by typing:
      ```
a:setup /e
```
   c. Follow the instructions on the screen.
   d. At the optional tools screen, select only the appropriate optional tool. Change the NO to YES only for the optional tool that pertains to the missing or damaged file. This is the only tool that should have YES next to it.

6. Complete the installation.

---

**Uninstalling and Restoring Your Previous Version of DOS**

If, in the future, you want to be able to uninstall PC DOS 7 and restore the previous DOS version (the version on your system before the initial installation of PC DOS 7), the Setup Uninstall process makes it easy.

However, you must select YES to the Back up previous DOS files option during the initial installation of PC DOS 7. In most cases, there will be no reason to uninstall DOS; however, the option exists if you need it.

The backup diskettes that Setup creates contain your previous version of DOS, including copies of your previous CONFIG.SYS and AUTOEXEC.BAT files.
You cannot use your backup diskettes if you have done any of the following after installing PC DOS:

- Repartitioned or reformatted your hard disk.
- Deleted or moved either of the two DOS hidden system files (IBMBIO.COM and IBMDDOS.COM).
- Installed a disk compression program. If you have done this, you must uncompress the drive before the Uninstall process can work.

**To restore your previous version of DOS:**

1. Insert the Setup Diskette into drive A.
2. Type the following at the DOS command prompt:
   ```plaintext
   a:setup /u
   ```
3. Answer N for No when queried whether you want to install PC DOS 7.
4. Follow the instructions on your screen, using your backup diskettes.

---

**Viewing and Editing the System Files during Install**

Immediately before the PC DOS installation is completed, you can view or edit the changes Setup has already made to your AUTOEXEC.BAT and CONFIG.SYS files. Optionally, you can make additional changes yourself. Any edits made to these files will not be put into effect until after a system reboot.

**To view or edit the changes to the system files:**

1. While running Setup, follow the instructions on the screen.
2. When prompted whether you want to edit the AUTOEXEC.BAT and CONFIG.SYS changes during the installation:
   - If you do not want to see the changes, leave the selection as NO and make sure the Option correct. Continue Setup. line is highlighted and then press ENTER, or click on this line if using a mouse.
   - Use the UP ARROW to highlight the edit changes line and then press ENTER, or click on this line if using a mouse. Your selection will change to YES. Then highlight the line:
     ```plaintext
     Option correct. Continue Setup.
     ```
     Then press ENTER, or click on this line if using a mouse.
If you selected YES, the E Editor is activated and three files are opened for you:

- A help screen file explaining what you need to do when you either view or edit the remaining two files.
- The AUTOEXEC.BAT file with comment lines (REM) added.
- The CONFIG.SYS file with comment lines (REM) added.

When SETUP changes the AUTOEXEC.BAT and CONFIG.SYS files, comments are added to identify what lines have been added, deleted, replaced, or updated—similar to the following:

```
REM ===== PC DOS 7.0 - Add =====
```

**Note:** If, after the SETUP program has completed and the system has been rebooted, you want to remove all the comments that were added by DOS Setup, insert the Setup Diskette into drive A and use the SETUP /C command. Any comments you may have added are not removed.

While viewing these files during Setup you cannot issue any DOS commands from the E Editor command line; only E Editor commands can be issued while viewing these system files during Setup.

3. Press CTRL+N (or F12 if available on your keyboard) each time you want to alternate between the three files.

4. Do one of the following for each of the three files:

- View the file and then press F3 to close the file after viewing. If you press F3, be sure you did not make any changes to the file because your changes do not get saved. Remember that any changes made by Setup were already saved before being opened for you to view or edit them.

- Edit the files, if necessary, and then press F4 after editing to save your changes and exit the file.

This allows you to modify the files before Setup restarts the machine and the changes Setup made to these files are put into effect.

5. Press F3 or F4 (depending on whether edits were not made or were made to the file, respectively) until you have closed all the files and exited the E Editor.

6. Press any key to restart your system.
Viewing the README.TXT File

PC DOS comes with a README.TXT file. This file can be found either on the Setup Diskette of the PC DOS installation diskettes, or in the directory where you installed DOS.

This file contains important information. If you have a PC DOS system, you can view or print this file before installing PC DOS for additional information about PC DOS.

When you want to look at the contents of a file, you can use any text editor, use the E Editor's BROWSE command, or use the MORE command.

To use the BROWSE command to view a file:

1. Change to the directory where your DOS files are located (usually C:\DOS).
2. Type the following at the DOS command prompt:
   browse readme.txt
   This command allows you to use the E Editor's BROWSE command to see the contents of the PC DOS README.TXT file.
3. Press PAGE DOWN to continue viewing the contents online.
4. If you want to stop viewing, press F3.

To print the README.TXT file:

1. Type the following command at the DOS command prompt:
   print readme.txt
2. Press ENTER.

Working with XDF-Formatted Diskettes

Setup for PC DOS 7 uses a new format known as eXtended Density Format (XDF) that extents the capacity of a standard 1.44MB diskette to approximately 1.86MB and a standard 1.2MB to approximately 1.54B—increasing the capacity of the diskette by almost 25% or 28%, respectively.

No special instructions are necessary to run Setup from XDF-formatted diskettes. Setup is designed to handle this special format.
XDF-formatted diskettes are read-only; you cannot write to, create a new file on, copy a file to, or delete files from an XDF-formatted diskette. For these reasons, the label for each XDF-formatted diskette is marked:

\[
\text{Diskette } n \\
(\text{XDF-formatted diskette})
\]

**Note:** The *Setup Diskette* is not XDF-formatted.

Review the procedures first before attempting to do any of the following tasks that involve using the PC DOS installation diskettes, which are XDF-formatted (other than installing).

- Using DOS commands with XDF-formatted diskettes.
- Viewing the contents of XDF-formatted diskettes.
- Loading the XDF program.
- Viewing the README.XDF file.
- Formatting XDF-formatted diskettes.
- Making backup copies of the PC DOS installation diskettes.

**Using DOS Commands with XDF-Formatted Diskettes**

Keep in mind that, if you are using XDF-formatted diskettes:

- Certain DOS commands only work with XDF-formatted diskettes (the XDF and XDFCOPY commands)
  - The XDF program is a terminate-and-stay-resident (TSR) program that supports XDF-formatted diskettes. It must be loaded to be able to see the directory contents of your XDF-formatted installation diskettes. You can unload this TSR program by typing `xdf /u` at the DOS command prompt. Unloading this TSR saves memory.
  - The XDFCOPY command performs a function similar to the DISKCOPY command, except XDFCOPY is used only for XDF-formatted diskettes and DISKCOPY only works on DOS-formatted diskettes.

- There are certain DOS commands that, if used with XDF-formatted diskettes, will not produce the the same expected result as when you use them with standard DOS-formatted diskettes (the DIR and FORMAT commands).
  - The DIR command can be used with XDF-formatted diskettes to view the entire contents of the diskette—but only when the XDF program is loaded. Without XDF being loaded, the only file you see listed when the DIR command is typed is a README.XDF file.
  - Never use the FORMAT command on any original installation diskettes.
Other DOS commands cannot be used with XDF-formatted diskettes at all (the DISKCOPY and DISKCOMP commands).

- XDFCOPY can be used to make backup copies of the XDF-formatted diskettes. However, you cannot use the DISKCOPY command with XDF-formatted diskettes.
- The DISKCOMP command can only be used on the Setup Diskette.

Refer to the online *PC DOS 7 Command Reference* for complete details when using these commands with XDF-formatted diskettes.

### Making Backup Copies of Setup Diskettes

Use the XDFCOPY command to make backup copies of the XDF-formatted installation diskettes; only use DISKCOPY for the Setup Diskette.

**Note:** Use DISKCOPY as you normally would for all diskettes other than the PC DOS installation diskettes.

**To make backup copies of your PC DOS installation diskettes:**

*If you have a new computer system that does not have any type of operating system installed:* install PC DOS before you make backup copies.

*If you are installing over another version of DOS:*

1. Insert the Setup Diskette into your diskette drive.
2. To copy the necessary .EXE files needed to make backup diskettes to your hard drive, type:
   ```
   copy a:\diskcopy.exe c:\
   copy a:\xdfcopy.exe c:\
   ```
   This example, assumes your diskette drive is drive A and your hard drive is drive C.
3. If you have only one diskette drive (drive A for example), leave the Setup Diskette in drive A and type:
   ```
   diskcopy a: a:
   ```
   Press ENTER.
   Or, if you have two diskette drives (drive A and B for example), type:
   ```
   diskcopy a: b:
   ```
   Press ENTER.
4. Follow the instructions on the screen until the diskette has been copied.
5. Insert one of the XDF-formatted diskettes (any diskette other than the Setup Diskette) into your diskette drive.

6. If you have only one diskette drive (drive A for example), type:

```
  xdfcopy a: a:  
```

Press ENTER.

Or, if you have two diskette drives (drive A and B for example), type:

```
  xdfcopy a: b:  
```

Press ENTER.

7. Follow the instructions on the screen.

During this XDFCOPY process, one progress bar appears, indicating the progress as you copy from the source drive. Then another bar appears, indicating the progress as it verifies and completes the XDFCOPY process for this diskette.

8. Insert another XDF-formatted diskette into the source drive.

9. Repeat steps 6 to step 8 for each of the remaining XDF-formatted diskettes.

10. Label your backup copies similarly to the way your original PC DOS installation diskettes are labeled to distinguish the standard DOS-formatted diskette (the Setup Diskette) from the XDF-formatted diskettes.

11. Delete the copies of the two .EXE files you copied to your hard drive (for example, the ones copied in the step above to drive C). Keep the copy of these two files placed in the DOS directory by Setup.

```
  del c:\diskcopy.exe  
  del c:\xdfcopy.exe  
```

Formatting XDF-Formatted Diskettes

When you use the DOS FORMAT /U command on a XDF-formatted diskettes, they become standard DOS-formatted diskettes. There is no command to format a diskette to the XDF format.

Loading the XDF Program

The XDF program is a terminate-and-stay-resident (TSR) program that supports XDF-formatted diskettes. Two DOS commands were designed to work with XDF: XDF and XDFCOPY.

When working with the XDF-formatted installation diskettes, the DIR command requires that the XDF program be loaded before you can view all the contents of the diskette. If XDF is not loaded when you use the DIR command, the only file you will see listed is the README.XDF file.
You do not need to load the XDF program to use the XDFCOPY command, nor do you have to load the XDF program during installation. Setup loads XDF for you and also unloads it at the conclusion of Setup.

To load the XDF program into memory:

1. At the DOS command prompt, type:
   
   a:\xdf

2. Then press ENTER.

You should always unload this program to save memory. After PC DOS is installed, you can type xdf /u at the DOS command prompt.

Viewing the README.XDF File

Before you load the XDF program, the DIR command only lists the README.XDF file. This file is a standard .TXT file that can be browsed or viewed using the E Editor that comes with PC DOS, or you can use the TYPE command to display the contents.

After loading XDF and typing the DIR command, you see the full list of the diskette’s contents. Note, however, that after XDF is loaded, the README.XDF file is no longer visible until XDF is unloaded. To see the README.XDF file again, type xdf /u

Viewing the Contents of XDF-Formatted Diskettes

If the XDF program is loaded, you can use the DOS DIR command (as you normally would to view the contents of a diskette) on diskettes that are XDF-formatted. If you see only the README.XDF file, this indicates that the XDF program is not loaded. After PC DOS 7 is installed, you can type help XDF at the DOS command prompt to find out more about the XDF command.

Working with Setup Bundle Files

When viewing the contents of any of the PC DOS installation diskettes, note there might be large files without extensions. These files are called bundle files. A bundle file groups together files pertaining to the same optional tool (or it may group together the DOS files pertaining to the base DOS operating system).

There can be one or more bundle files with the same bundle name on multiple diskettes. For example, all the files pertaining to AntiVirus are placed in one or more bundle files named “AV”; all the files pertaining to the DOS base system are placed in one or more bundle files named “DOS.”
Not all files are placed in bundles. Non-bundled files are placed on the Setup Diskette.

To find out if a file is in a bundle or which bundle the file is in, use the E Editor to look at the information in the FILES.TXT file. The FILES.TXT lists the:

- Name of the file
- Bundle name
- Number of the diskette where the bundle is located
- Size of the file
- DOS subdirectory name, if any
- Brief description of what the file is

Bundle files have been grouped together and compressed using a special process known simply as packing. The Setup program unpacks and copies the Setup files during your PC DOS installation.

When you need to recover a single file from your PC DOS installation diskettes, the preferred method is to rerun Setup. Follow the instructions in "Recovering Files from the Setup Diskettes" on page 546.

More experienced DOS users can use the UNPACK2 command to recover a file. The UNPACK2 command allows you to see what is in each bundle or unpack and copy one or more files from a bundle file. If you use the COPY command to copy a bundle file to your hard disk, the files will still be in a bundle; therefore, use the UNPACK2 command instead. After PC DOS 7 is installed, you can type help unpack2 for information about the UNPACK2 command.

Warning: Do not unpack all the files from the Setup diskettes using the UNPACK2 command; Run Setup instead to unpack, copy the files, and place the files in the directory that DOS expects for proper operation.

Using the Emergency Startup Diskette

Use the Setup Diskette to boot the computer when the hard disk is not accessible. Many of the files needed when you have system problems are on this first diskette. To view the list of files considered to be emergency files, use the DIR command.

The Setup Diskette is not an XDF-formatted diskette. No special procedures are needed to use this diskette.
To use the Setup Diskette as the startup diskette:

1. Insert the Setup Diskette into drive A.

2. Turn the power for your computer on (cold boot) or, if it is already powered on, press CTRL+ALT+DEL (warm boot) to restart your computer.

3. Type N when prompted whether you want to install PC DOS. (If you do not answer in 10 seconds, the default answer YES is assumed.)

   The command prompt A:\> is displayed.

Troubleshooting PC DOS Setup

If you have trouble during installation, there could be a number of causes. Refer to “PC DOS Installation” on page 281 for resolutions for some of the most common problems.
Appendix B. Accessibility for Individuals with Disabilities

The IBM Independence Series*, is a family of products designed to help individuals with disabilities achieve greater personal and professional independence through the use of technology. The following products are designed specifically for improving access between individuals with disabilities and others through the use of a computer: Screen Reader*/DOS, Screen Reader/2, AccessDOS, KeyGuard, and Screen Magnifier*/2.

Also, there are some clinical products that are designed to aid the therapy of those people with speech and attention/memory impairments: SpeechViewer II, THINKable*/DOS, and THINKable/2.

For further information or assistance with ordering any of these Independence Series products, call the IBM Independence Series Information Center at 1-800-426-4832 (Voice) or 1-800-426-4833 (TDD). In Canada, call 1-800-465-7999 (Voice).

IBM AccessDOS

AccessDOS is a complimentary DOS-based utility used to extend keyboard, mouse, and sound access on a personal computer. AccessDOS is useful for people with mobility, visual, or hearing impairments because of the specialized control it offers. Key features include:

- **StickyKeys**
  Enables you to individually press each key for multiple key operations. For example, you can press CTRL, press ALT, and then press DEL to restart your system instead of pressing the keys simultaneously.

- **MouseKeys**
  Makes it possible to use the keys on the numeric keypad to simulate the use of a mouse.

- **RepeatKeys**
  Enables you to set the rate at which keys repeat when held down.

- **SlowKeys**
  Instructs the computer not to accept a key as “pressed” until it has been held down for a specific length of time.

- **BounceKeys**

* Independence Series, Screen Reader, Screen Magnifier, SpeechViewer, and THINKable are trademarks of the IBM Corporation

© Copyright IBM Corp. 1981, 1995
Prevents double characters from being typed if your finger bounces on the key when pressing or releasing it.

- **SerialKeys**
  Enables you to control the keyboard and mouse functions using a special input device (not included) attached to a serial port.

- **ToggleKeys**
  Causes a beep to sound when the Caps Lock, Num Lock, or Scroll Lock keys are activated.

- **ShowSounds**
  Causes the screen to blink or display a small musical note on the screen when the computer makes a sound.

**IBM Screen Reader/DOS**

Screen Reader/DOS reads the words on a display screen to people who are blind or visually impaired so that they can use a computer as a sighted person would. It can also be used effectively by individuals who have reading dysfunctions.

Screen Reader/DOS contains prewritten profiles for many application programs. You can also modify existing profiles or write your own, using the Profile Access Language.

Some of the major functions include:

- **Powerful reading functions**
  Allow you to read complete screens, paragraphs, sentences, words, or letters. You read only the amount of information you need.

- **Dedicated 18-key keypad**
  Controls Screen Reader/DOS functions to enhance productivity by reserving the keyboard for application functions. As an alternative, Screen Reader/DOS can also be controlled from the keyboard.

- **Autospeaks**
  Monitors the screen and alerts you when changes, such as status or error messages, occur.

- **Windowing**
  Provides easy access to many display formats featured in today's popular applications.

- **Host/LAN support**
  Enables connectivity.
IBM KeyGuard

The IBM KeyGuard is designed for use on IBM keyboards on many IBM computer systems, including the PS/2, PS/ValuePoint®, AS/400®, and RISC System/6000®. The KeyGuard is a molded keyboard overlay with holes that expose and isolate each keytop. It attaches securely so the keyboard can be tilted at any desired angle. Features include:

- **Better keying control**
  Enables mobility-impaired users to achieve greater control by pressing keys through the corresponding holes on the KeyGuard when using a typing stick or a single finger.

- **Increased accuracy**
  Helps minimize accidental key strokes in a busy office or plant environment.

- **Hand support**
  Provides a handrest, an important feature for individuals with palsied or other coordination conditions.

The IBM KeyGuard is also appropriate for use in educational and preschool environments with young children who have not yet mastered typing skills.

* PS/ValuePoint, AS/400, and RISC System/6000 are trademarks of the IBM Corporation.
Appendix C. Notices

References in this publication to IBM products, programs, or services do not imply that IBM intends to make these available in all countries in which IBM operates. Any reference to an IBM product, program or service is not intended to state or imply that only IBM's product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any of IBM's intellectual property rights or other legally protectable rights may be used instead of the IBM product, program, or service. Evaluation and verification of operation in conjunction with other products, programs, or services, except those expressly designated by IBM, are the user's responsibility.

IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood NY 10594, U.S.A.

Trademarks and Service Marks

The following terms, denoted by an asterisk (*) in this publication, are trademarks or service marks of the IBM Corporation in the United States or other countries:

AS/400 Micro Channel PS/ValuePoint
CGA OS/2 RISC System/6000
EGA Personal Computer AT (PC/AT) Screen Magnifier
DisplayWrite Personal Computer XT (PC/XT) Screen Reader
IBM Personal System/2
IBM Personal Computer (PC) Personal System/55 SpeechViewer
IBM Token Ring PhoneCommunicator THINKable
Independence Series PS/2 VGA

The following terms, denoted by a double asterisk (**) in this publication, are trademarks of other companies as follows:

Addstor Addstor, Inc.
AST AST Research, Inc.
Bernoulli Iomega Corporation
BlueMAX Qualitas, Inc.
Brooklyn Bridge Fifth Generation Systems, Inc.
Central Point Central Point Software, Inc.
Central Point Backup Central Point Software, Inc.
Compaq Compaq Computer Corporation
dBASE Borland International, Inc.
Delete Sentry Central Point Software
DoubleSpace Microsoft Corporation
<table>
<thead>
<tr>
<th>Weitek</th>
<th>Weitek Corporation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Microsoft Corporation</td>
</tr>
<tr>
<td>WordPerfect</td>
<td>WorkPerfect Corporation</td>
</tr>
<tr>
<td>Workgroup for Windows</td>
<td>Microsoft Corporation</td>
</tr>
<tr>
<td>Write/AMI</td>
<td>Samna Corporation</td>
</tr>
<tr>
<td>XDF</td>
<td>Ametron, Inc.</td>
</tr>
<tr>
<td>386</td>
<td>Intel Corporation</td>
</tr>
<tr>
<td>386MAX</td>
<td>Qualitas, Inc.</td>
</tr>
<tr>
<td>8086</td>
<td>Intel Corporation</td>
</tr>
<tr>
<td>8088</td>
<td>Intel Corporation</td>
</tr>
<tr>
<td>80286</td>
<td>Intel Corporation</td>
</tr>
<tr>
<td>80386</td>
<td>Intel Corporation</td>
</tr>
</tbody>
</table>
Special Characters
/-DPMS switch (Stacker) 463
/? switch for online help 47
/ =a parameter for CHECK (Stacker) 307
/A switch (Setup) 540, 542
/AUTO switch for Stacker 466
/B switch (COPY) 312
/BD=drive, Stacker 467
/C switch (Setup) 7
/E switch (Setup) 544, 545
/EMS switch (Stacker) 463
/F switch (CHECK) 453
/F switch (CHKDSK) 232
/I switch (E Editor) 460
/int15 switch 289
/P switch (DIR) 34
/Q (STACKER.INI) 461
/Q switch (Setup) 9, 544
/R switch (Stacker) 309
/T switch (Setup) 541
/U switch (FORMAT) 553
/U switch (XDF) 551
/UMB switch (Stacker) 463
/W switch (Setup) 9
... (ellipsis) 329
* (IBM trademark) 561
** (other company’s trademark) 561
< (take output) 109
= (E Editor) 140, 166
> (send output) 109
>> (adding output) 109
| (pipe) 111

Numerics
386MAX 225
386MAX and Stacker 464
8514 color display 295
8514 monochrome display 295

A
AccessDOS 557
accessing
See also installation
Central Point Backup 391
IBM AntiVirus/DOS for Windows 365
Undelete 243
active partition
describing 83
setting 91
Active Task List area 341
active window, definition of 50
actual compression ratio, Stacker 457, 476
Add command (E Editor) 167
adding
a blank line (E Editor) 144
a line of text (E Editor) 137
numbers using E Editor 167
output from a command 109
PC card to the card list 513
search groups 257
address table for tape controller cards 420
ADMIN.PRF 379
administrator installation
copying PC DOS files and tools 541
creating administrator directory 541
advanced
configuration for PCMCIA 517
features of RAMBoost 214
PCMCIA utilities 518
properties of PC DOS Shell 360
setup, PCMCIA 507
All command (E Editor) 159
ALL file (E Editor) 159
All Files, Stacker 475
allocation units
defining 449
lost (Stacker) 300
recovering 232
ALT, PenDOS modifier key 489
antivirus stand-alone program 379
AntiVirus/DOS for Windows 11
AntiVirus/DOS for Windows tool 11
AntiVirus/DOS tool 11, 363
APPEND command 68
Append command (E Editor) 166
appending
  deleted data (Undelete) 262
  the PC DOS Viewer topic information 52
application shortcut keys 351, 358
archive file attribute 30
ASCII 56, 170, 489
Assembler syntax 164
assigning drive letters 90
ATA cards, PCMCIA 509
ATA Drives, PCMCIA 528
ATTRIB command 30, 300, 538
ATTRIB command with Stacker 300
attribute
deletion of 300
  exclusions for CPBackup 397
file 30
AutoCompare 407
AUTOEXEC.BAT file
  common commands in 67
  editing 66
  editing during installation 16
  explanation of 53
  multiple configurations 64
  startup commands in 66
  using to customize system 66
automated virus checking 363
AutoMount (Stacker) 465
automounting drives (Stacker) 464, 466
AutoProtect for Stacker 299, 452
AutoRecover for Stacker 302
Autosave command (E Editor) 139
AutoSave for Stacker 299, 478

back up (continued)
  before installing Stacker 431
  files 282
  multiple drives 401
  Setup diskettes 552
Backup for DOS (Central Point) tool 12
Backup for Windows (Central Point) tool 12
Backup From command, CPBackup 400
Backup program
  See CPBackup
backup status gauge (Stacker) 471
balancing compression and speed 448
base location, File Update 190
basics of PC DOS Shell 324
batch commands 98
batch files 338
batch program 97
calling from another batch program 104
creating 99, 100
creating conditional processing 106, 107
including comments in 103
running in a startup command 354
starting 99
stopping permanently 100
testing 101
batch programs
colon for labels 106
commands for 98
GOTO command 106
IF and GOTO together 107
IF command 106
naming conventions for 99
replaceable parameters 105
before installing Stacker 431
Bernoulli drive 400
block mark (ALT+B), E Editor 148, 149
block reflowing (ALT+R), E Editor 154
block, configuration 61
boot 460
bypassing startup commands 54
commands 54
drive 460
from Setup diskette 14
BOOT command (OS/2)  535
Boot Manager  364, 534
bootable
  partition  364
  Stacker diskette  309
  startup diskette  78
bootable diskette
  See system diskette
booting
  Dual Boot  365
  IBM Boot Manager  364
  starting the system  364
  using IBM Boot Manager  365
Box command (E Editor)  164
breaking a text line in E Editor  143
breaking connection between computers  183
BROWSE command  550
buffering, double  237
BUFFERS command  59, 235
bundle file
  definition of  4
  listed in FILES.TXT  546
  on installation diskettes  554
buttons on PenDOS menu  485
bypassing
  AUTOEXEC.BAT commands  56
  CONFIG.SYS commands  54
bytes defined  73

carriage return (continued)
  sending  487
CD command  33
CD-ROM
  caching with SMARTDRV  237
  installing a device driver  57
  installing PC DOS from  544
  Stacker drive letters  466
  using with RAMBoost  224
Central Point
  Backup for DOS  12, 383, 391
  Backup for Windows  12, 385
  Data Monitor  270
  Scheduler  275
  Undelete for DOS  241
  Undelete for Windows  11, 242
certified tapes in CPBackup  417
CGA display  295
Change (C) command (E Editor)  160
changing
  AUTOEXEC.BAT file  66
  color schemes for the PC DOS Shell  344
  colors, PC DOS Shell screen  344
  CONFIG.SYS file  56
  configurations  54
  dialog box entries (PC DOS Shell)  331
  directory (CD command)  33
  expected compression ratio  457
  file attributes  31
  group contents for PC DOS Shell  351
  group contents, PC DOS Shell  352
  group properties, PC DOS Shell  362
  hardware devices  54
  margin setting (E Editor)  147
  memory usage of a block  215
  passwords  454
  PC DOS Shell window  344
  preferences  472
  program item properties, PC DOS Shell  353
  screen attributes  68
  screen background color  69
  screen modes for the PC DOS Shell  344
  screen text color  69
character
  activating send, PenDOS 487
  entering for PenDOS 486
  variations for PenDOS 499
characteristics of viruses
  CHECK /F command (Stacker) 453
  check boxes (dialog boxes) 330
  CHECK command 299, 307, 452, 453
  Check Integrity tool 439
  checking
    automatically for virus 369
    compressed drives for viruses 370
    diskettes for viruses 369
    Stacker drives 452, 453
    your hard drive for viruses 369
  CHKDSK /F command 232
  CHKDSK command 74, 234, 299, 300, 436
    increasing disk space 232
    running 300
  choices (menu) for File Update 194
  choosing correct install procedure 13, 533
  CIS window address, PCMCIA 507
  CL (Caps Lock), PenDOS modifier key 489
  clearing the E Editor window
client, definition of 177
closing
  a file (E Editor) 134
  loops in PenDOS 498
clusters
  available (free) 258
  Stacker optimization 449
CMDREF online book 41
command (continued)
HELP 45
IBMAVD 298, 365
INTERLNK 176, 286
INTERSVR 179, 181
LOADFIX 289
MD (make directory) 35
MEM 206, 236
MORE 111, 550
MOVE 28
MSCDEX 544
PATH 233, 284
PCM 512
PCMDINST 505
PCMFDISK 518
PCMRMAN 521
PCMSSETUP 505
PENDOS 483
PRINT 550
QCONFIG 206, 221
RAMSETUP 208
RD (remove directory) 36
REM 7, 210
REN (rename) 26
RESTORE 293
SDEFRAG 306
SET 239, 286
SETUP (Stacker) 442
SETUP for PC DOS 8
SETVER 294, 314
SHELL 290
SMARTDRV 236
SORT 112
SSETUP (Stacker) 431
STAC 437
STACKER 300, 442
SUBST 284
SYS 79, 304, 538, 539
TREE command 189
UNDELETE 26, 28, 243, 292
UNPACK2 555
VIEW 41
XCOPY 38
XDF 551, 554

Index 569
compressed (continued)
drives using Stacker for OS/2 536
DRV/DBLSPACE drives 434
compressing
additional drives 440
diskettes 442
empty diskettes 442, 443
hard disks 440
compression
considering speed versus space 448
details 473
expected vs actual ratios 457
ratio gauge 470
using virus protection with 381
Compression Report tool 439
compression tool, Stacker
compatible programs 537
incompatible programs 537
installation of 12
computers, connecting 175
conditional processing 106, 107
confidence test (CPBackup) 387
CONFIG command 303, 305, 437
CONFIG.SYS file
adding commands to 56
bypassing commands in 54
changing 56
changing during installation 16
confirming each command during startup 283
editing 56
EMM386.EXE 291
example of 59
explanation of 53
memory management 461
multiple configurations 63
configuration
blocks, defined 61
common blocks 62
first time for CPBackup 385
menu block 60
multiple 54
system 53
Configure (PCM) 513
configuring
ATA Drives, PCMCIA 528
configuration considerations 208
fax/modem I/O cards 524
Flash Memory Card, PCMCIA 527
other I/O cards, PCMCIA 525
PC cards for PCMCIA 524
PCMCIA 505, 512
RAMBoost 208
RAMBoost with PCMCIA 528
SRAM Memory Card, PCMCIA 528
using PCMSETUP command 505
confirming each CONFIG.SYS command 283
connecting a text line in E Editor 143
Contents push button 44
control characters using E Editor 170
ccontroller cards (CPBackup) 419
conventional memory 219
specifying in the PC DOS Shell for programs 360
converting DBL/DRVSPACE drives 434
copy block of text gesture for PenDOS 491
Copy command (PC DOS Shell) 351
copying
administrator files and tools 541
directories 38
files to Setup diskettes 546
PC DOS Viewer topic information 52
previously typed command 129
program items among program groups 351
Setup diskettes 552
subdirectories 39
text (ALT+C) using E Editor 155
topics into a file 51
VGA.VID file 296
with the E Editor (ALT+C) 152
country selections 9
CPBackup
changing user level 389
choosing files with the keyboard 398
compare symbols 409
comparing data 407
configuring for the first time 385
CPBackup (continued)
   contents of setup files 404
   CPBDIR command 425
   date range selection 397
disabling Express 399
displaying the directory tree 398
   drive display 401
   excluding file attributes 397
   failing high-speed confidence test 387
   file-filter commands 394
   files that do not compare 408
   files, low-speed backups 412, 424
   hidden files 397
   include/exclude list guidelines 395
   including subdirectories 395
   installing 383
   making a backup 391
   monochrome file selection 399
   network device or directory 412
   non-Express window explained 399
   performing the confidence test 386
   preconfigured setup files 403, 405
   previous versions 405
   printing a backup directory 411
   quitting a SCSI backup 393
   restoring data 409, 410
   restoring when Express is disabled 409
   running confidence test 387
   SCSI tape directory 393
   selecting files automatically 395
   selecting files by date 397
   selecting files manually 398
   selecting multiple drives when Express is
disabled 400
   setting passwords for backup set 392
   setting tape password 393
   setup files defined 403
   setup files description 405
   skipping the confidence test 386
   starting a compare 407
   strategies for backing up 421
   system files 397
tape information 415
testing backup speed 387

CPBackup (continued)
   troubleshooting confidence test 386
   unattended backups 407
   user level reference chart 390
   using CPSCHED 406
   using the include/exclude list 394
   viewing files 402
   volume tape catalog explained 421
   CPBACKUP command 285, 315, 410
   CPBACKUP.001 file 412
   CPBACKUP.CFG file 386
   CPBACKUP.DIR file 412
   CPBACKUP.INF file 412
   CPBDIR command 425
   CPS format for tapes 418
   CPSCHED command 68, 406
   creating
      batch programs 99, 100
      DOS files and tools directory 542
      DOSKey macros 121
      E Editor file 137
      extended DOS partition 88
      LAN administrator directory 540
      logical drives 89
      online help 360
      online help for PC DOS Shell 349
      primary DOS partition 86
      Stacker drive 440
      system diskette 79
CTRL, PenDOS modifier key 489
CTRL+BREAK key combination 100
CTRL+C key combination 100
current directory 33
current drive 21
cursor movement
   keys 141
   move to beginning of marked area
      (ALT+Y) 155
   move to end of marked area (ALT+E) 155
custom setup, Stacker 432
customizing
   AUTOEXEC.BAT file 66
   automated virus protection 372
diskette checking for viruses 374
customizing (continued)
E Editor 141
E Editor window 169
Help messages for the PC DOS Shell 360
PC DOS Shell 343
PCMCIA 518
Stacker configuration 459
STACKER.INI file 460
system checking for viruses 374

D
damaged files, removing for Stacker 307
data file, definition of 19
Data Monitor delete protection 247, 266
data, recovering 241
DATAMON command 68, 271, 292
DATAMON Delete Sentry 271
DATAMON Delete Tracker 271
DATE command 397
date range selection, CPBackup 397
DBLSPACE drives 434
DCONVERT command (Stacker) 436
defaults
resetting tape drive (CPBackup) 420
running AntiVirus 365
defaults (E Editor)
   Change command case search 161
   function keys 133
   margin settings 137
   number of lines restored 145
   search options 158, 162
   stream mode 144
   syntax-directed editing 171
   tiled window 169
defective sectors reported 77
defining a startup menu 60
DEFFRAG command 234, 293
defragmenting
   configure selection 234
   files 233
   optimize selection 234
   Stacker drives 449
DELETE command 27
Delete command (PC DOS Shell) 349, 352
delete protection methods 247
Delete Sentry method 247, 270
Delete Tracker method 247, 269
deleting
   a character for PenDOS 488
   a character left of cursor
      (BACKSPACE) 145
   a character right of cursor (DELETE) 145
   a directory 27, 36
   a line of text (CTRL+BACKSPACE) 144
   a program group, PC DOS Shell 349
   a program item, PC DOS Shell 352
   a word of text (CTRL+D) 145
   all directory files 27
   character gesture for PenDOS 490
directory entry, File Update 193
DOSKey macro 123, 124
file attributes 300
files and directories 37
highlighted block gesture for PenDOS 490
marked text (ALT+D) 155
partition or logical drive 92
program groups 349
program items from groups 352
search groups 258
Setup comment lines 7
text using E Editor 151
deletion, restoring (E Editor) 145
DELTREE command 27, 36
destroyed Undelete file condition 246
details, disk space for Stacker 473
DEVICE command 58, 59, 238
device driver
386MAX 225
explanation of 57
HIMEM.SYS 288
installable 57
INTERLNK.EXE 177, 286
Netroom 225
order in CONFIG.SYS file 58
PCMCIA 230
QEMM386 226
RAMBOOST.EXE 212
device driver (continued)  
RAMDRIVE.SYS 238  
SMARTDRV.EXE 236, 237  
device, hardware 57  
DEVICEHIGH command 58, 59, 238  
diagnosing Stacker drives 300  

dialog boxes  
changing entries 331  
entering additional information 329  
explanation of 324  
list box 330  
replacing entries 331  
text box 330  

dimmed menu options 345  
DIR /S command 24  
DIR command 34, 551, 554  
directories  
changing to another 33  
copying 38  
copying all files in a directory 38  
creating as you copy files 39  
deleting 27, 36  
making 35  
moving files 28  
naming 32  
recovering deleted files from 26, 28  
removing 36  
renaming 40  
undeleting files in 252  
using the /P switch 34  
viewing contents of 34  
viewing groups of file names in 35  
directory 21  
current 33  
description of 21  
new 35  
parent 21  
startup for program items 351  
directory tree 32  
CPBackup 398  
PC DOS Shell 322  
Undelete 244  
disabilities, individuals 557  

disabling warnings, Stacker 473  
discontinue batch processing 100  
disk  
buffer size 235  
definition of 73  
definition of fixed disk 19  
partition data 85  
space used and free 470  
summary of expected vs actual ratios 476  
types of 74  
utilities with PC DOS Shell 326  
volume label for 76, 80  
Windows File Manager 476  
disk space 77  
disk-repair utilities 299, 301  
DISKCOMP command 552  
DISKCOPY command 4, 551  
diskette  
bootable 54  
new feature, XDF 5  
sizes and types of 73  
XDF-formatted 550  
diskette drives 75  
diskettes  
backing up, installation 552  
creating a Stacker bootable 310  
creating a system diskette 78, 79  
formatting 76, 77  
restoring 78  
transferring File Updates to 197  
unmounting if compressed 445  
using for emergency startup 555  
viewing contents of 554  

DiskFix, PC Tools 309  
disks  
formatting after FDISK 94  
formatting using FDISK 75  
making volume label 79  
partitioning 81, 82  
preparing for DOS files 76  
recovering allocation units 232  
renaming 79  
restoring 78  
speeding up your system 235
Display command, PC DOS Shell 345
display mode
   See graphics mode, text mode
display monitors, PC DOS Shell 295
displaying
   batch commands and messages 101
   multiple drives in CPBackup 400
   the directory tree in CPBackup 398
document format, special 56, 66
documentation links 45
DOS
   command prompt 321
   editing keys 127
   error messages 46
   extended partition 82
   memory managers 290
   partition, primary 82
   README.TXT file 281
   restoring system files 304
   running FDISK 83
   starting the PC DOS Viewer from 41
   Toolbox for Stacker 442
   troubleshooting commands 292
   version number 294
   wildcards in CPBackup 395
DOS Protected Mode Services
   See DPMS
   DOS=HIGH command 283
   DOS=HIGH,UMB command 59
   DOSSHELL.INI file 295
   DOSSHELL online book 41
   DOSSHELL program (continued)
      typing multiple commands 116
      using replaceable parameters 124, 125
      using with commands 115
      using with macros 120
      viewing previous command 116
   DOSREXX online book 41
   DOSSTART command 321
   DOSSTART.INI file 295
double buffering, SMARTDRV 236, 237
   DPMS (Stacker) 462
   DPMS.EXE 462, 463
drawing lines 134
drive
   compressed, DBLSPACE 434
   compressed, DRVSPACE 434
   current 21
   installing if other than C 533
   integrity, checking 453
   letters for Stacker 459
   letters for Stacker drives 460
   map for Stacker 459
   specifications in STACKER.INI 461
   Drive Icon area, PC DOS Shell 322
   drive letters
      assigning 90, 441, 459
      identifying 442, 459
      specifying 466
      substituting 91
   drives
      displaying multiple in CPBackup 400
      light, during Backup 393
      mapping explained 401
      multiple selection in CPBackup 400
      remapping for File Update 200
      resetting defaults for tapes 420
      scanning for available (free) clusters 258
      selecting multiple in CPBackup 400
   DRVSPACE drives 434
   Dual Boot (OS/2) 534
dual boot systems 365
duplicating XDF-formatted diskettes
E
E Editor 131
activating the menu 134
adding and multiplying numbers 167
cursor movement keys 142
editing a file 134
function keys 133
joining and splitting lines 143
naming a file 134
printing a file 141
restoring a line 134
saving files 139
search options 161
unmarking text (ALT+U) 150
E /I command (E Editor) 460
E command 137
E.INI file 141, 144
ECHO command 101
ECHO OFF command 67
editing
AUTOEXEC.BAT file 66
characters in PenDOS 490
CONFIG.SYS 461
DOSKey macros 120
files using E Editor 134
keys defined 115
multiple files 140
multiple files (E Editor) 140
PCMCIA configuration values 513
previously typed command 129
system files during install 16
system files during installation 548
using DOS keys 127
using DOSKey program 115
editing keys, DOSKey 116, 119
editing, PenDOS
inserting a space character 487
inserting space gesture 490
pasting 491
sending characters to application 487, 488
sending characters with carriage return 487
sending characters, clearing line 488
editor for RAMBoost 216
EGA display 295
EGA MONO display 295
emergency diskette 555
EMM386
adding memory range exclusions 526
before running PCMDINST, PCMCIA 504
commenting out for RAMBoost 210
detecting within page frame 291
if not accessing upper memory 291
including noems switch 58
loading Data Monitor high 271
options with RAMBoost 216
putting device drivers in order 58
required for PenDOS 481
simulating expanded memory 58
using PC DOS's vs Windows 236
using with expanded-memory manager 290
using with I/O adapters 525
using with ram switch 59
using with RAMBoost 206
using with RAMDrive 239
using with Stack 464
EMM386.EXE 237, 291
empty diskette, compressing 442, 443
EMS and Stack 463
environment size 290
environment variable 111
erase to end of line (CTRL+E) 144
error messages
getting help for online 46
out of memory (DEFRA) 293
reported by CHKDSK 300
searching for online 46
Setup program 287

Index 575
error messages (continued)
  using online book 41
  while optimizing using Stacker 308
examples of commands 45
excellent Undelete file condition 245
existing Undelete file condition 246
exiting
  an E Editor file 137
  E Editor 137
  PC DOS Shell 343
  PC DOS Viewer 45
  Stacker Anywhere for DOS 444
EXPAND command 4
expanded memory (EMS or EEMS) 221
expected compression ratio
  changing 457
  for Stacker 476
Expected Compression tool 439
Express
  disabling in CPBackup 399
  restoring when disabled in CPBackup 409
express setup, Stacker 432
extended
  DOS partition 81, 82, 88
  memory (XMS) 220, 289
  memory specified in the PC DOS
    Shell 361
  memory with SMARTDRV 236
  memory with Stacker 462
extensions
  BAT (batch files) 99, 338
  text files 20
extra length tapes in Backup 417

F
F1 for online help 48
F5 during startup 55, 283, 285, 315
F8 during startup 55, 283
FAT
  See File Allocation Table
FAT system (OS/2) 534
fax/modem I/O cards 524
FC command 29
FDISK command 83, 282
FDISK program
  running during installation 83
  running other than installation 84
  viewing main options menu 84
FDISK.COM file 78, 315
features of
  E Editor 131
  PC DOS 7 xxi
  RAMBoost, advanced 214
  Setup program 3
  Stacker compression 429
file
  attributes described 30
  attributes, changing 31
  AUTOEXEC.BAT 54
  automatic selection, CPBackup 394
  batch program 97
  bundled 554
  compressed drive (STACVOL) 456
  conditions for undeleting 245
  CONFIG.SYS 54
  created by low-speed backups 412, 424
  defragmented 233
deletion 292
description of 19
extensions 20
name and extension 19
name extension, batch programs 99
name restrictions 20
names of 20
not matching, CPBackup 408
overwritten 245, 250, 267
remain uncompressed 536
selection indicator 399
setup for CPBackup 403, 405
specification (path and file name) 22
types of 19
File Allocation Table (FAT) 75
  file system for OS/2 534
Undelete 258, 267
File List area, PC DOS Shell 322
File Manager, Stacker drives 474
file server, backing up  413
File Update
installing at base location  190
installing if InterLnk-connected  200
installing on a PC (remote)  196
synchronizing files  189
transferring files to remote  196
troubleshooting  313
using menu choices  194
using with LAN-connected system  202
files
appending information into  52
backing up  282
backing up by date  397
batch  338
comparing using the FC command  29
copying  24
copying from Setup diskettes  546
copying information into  52
copying to a directory  38
copying topics into  51
creating using text editors  132
deleting  27
excluding by attribute in CPBackup  397
finding if deleted  254, 258
finding in a deleted directory  252
finding using DIR /S  24
moving and renaming  29
naming  20
network, undeleting  252
printing using E Editor  134, 141
recovering from Setup diskette  546
recovering if deleted  26, 28, 241, 252
redirecting input from  110
redirecting output to  109
renaming  26, 250
saving QCONFIG output to  213
selecting automatically in CPBackup  395
selecting manually in CPBackup  398, 399
storing data in  19
transferring to remote location  196
undeleting  241
viewing attributes of  30
viewing in CPBackup  402
FILES command  59, 311
FILES.TXT file  546
fill marked area (ALT+F) using E Editor  155
filter command
FIND command  112
MORE command  111
SORT command  112
FIND command  112
finding
deleted files  254
files in deleted directory  252
files using DIR /S  24
files using the PC DOS Shell  339
index topics, PC DOS Viewer  50
searching, PC DOS Shell  339
text and replacing  160
text using E Editor  157
text within a file  31
viruses  363
first time configuration in CPBackup  385
fixed disk
See disks
Fixed Disk Setup Program
See FDISK program
Flash File System, PCMCIA  508
Flash Memory Card, PCMCIA  527
flashing message, Stacker  472
floppy
See diskette
FORMAT command  76, 79, 551
format, special for documents  56, 66
formatting
creating a system diskette  79
disk capacity, specifying  76
disks  76
disks using FDISK  75
hard disk after using FDISK  94
non-XDF formatted diskettes  551
paragraphs with E Editor  155
preparing for DOS files  76, 77
quick format  76
restore disk after  78
safe format  76
system diskette  78
formatting (continued)
  time table in CPBackup 418
  unconditional format 76
  XDF-formatted diskettes 553
Forward push button 44
fragmentation 449
fragmentation gauge, Stacker 470
free space 441
  compressing diskette/removable 442
  compressing on hard drive 440
  defining 432
Full optimization with Stacker 449
Full Update, Stacker optimization 433
Full-MaxSpace for Stacker 449, 451
full-screen backup tool 383
function
  buttons for PenDOS 487, 488
  keys for E Editor 133
  keys for Undelete 245

G
gauges, Stacker
  Backup Status 471
  Compression Ratio 470
  Disk Space 470
  Fragmentation 470
  Preferences, Windows 473
gestures, PenDOS
  definition of 490
  types of and functions 490
Get command in E Editor 165
getting help
  E Editor 134, 136
  for PC DOS Shell 334
  for PC DOS Shell procedure 336
  online other than PC DOS Viewer 45
  Stacker compression 430, 464
  Stacker Setup 432
  Stacker Windows Toolbox areas 469
  using the /? switch 47
  using the PC DOS Viewer 48
getting ready for Stacker 431
good Undelete file condition 245
GOTO command 106, 107
graphic characters using E Editor 170
graphical user interface
  See GUI
graphics mode, PC DOS Shell 323, 344, 361
greater-than sign for redirection 109
group of files, deleting 27
group properties, PC DOS Shell 362
GUI (graphical user interface) 320

H
hard disk
  compressing, Stacker 440
  formatting after FDISK 94
  having multiple 94
  installing on 14
  partitioning 81
  performing safe format on 76
  repartitioning 282
  restoring after formatting 78
  space requirements 281
hard disks
  See disks
hardware device, adding 54
header, saved for Stacker 299
hearing impairment 557
help
  creating online 349
  F1 key 48
  for E Editor 136
  for Stacker compression 430
  for the PC DOS Shell 336, 337
  from within the PC DOS Viewer 48
  Help menu option 48
  menu option, PC DOS Viewer 45
  messages, PC DOS Shell 349
  on Stacker Setup 432
  online 336, 337
  online about PC DOS Viewer 43
  online for PC DOS Shell 360
  online other than PC DOS Viewer 45
  online, PC DOS Shell 334
  PC DOS Shell procedures online 336
  push button, PC DOS Shell 330, 335
help (continued)
  push button, PC DOS Viewer 45
HELP command 45, 46
Help menu option 48
help menu, PC DOS Shell 337
Hercules display 295
hidden file attribute 30
hidden files in CPBackup 397
hidden files with Stacker 459
high memory area (HMA) 219, 287
high-speed test, CPBackup 387
HIMEM.SYS and Stacker 464
HIMEM.SYS device driver 288
history files, printing directory 411
HMA
  See high memory area
host drive, definition of 435
hot key letter, defined 51
hypertext links 45

I

IBM AccessDOS 557
IBM AntiVirus/DOS 11, 363
IBM AntiVirus/DOS for Windows 11, 365
IBM Boot Manager 364
IBM Independence Series 557
IBM Screen Reader 558
IBM Thinkpad 531
IBMAVD command 298, 365
IBMAVSP.EXE 379
IBMDOS.COM file 78
identifying drive letters, Stacker 459
IF command 64, 106, 107
INCLUDE command 63
include subdirectories, CPBackup 395
include/exclude files, CPBackup 394
incompatible compression programs 537
incorrect version of INTERLNK 286
increasing system speed 235
Independence Series 557
index
  push button in PC DOS Viewer 44
  topics in PC DOS Viewer 50
INF file extension, online books 41
Information Center for disabilities 557
information selection, PCMCIA 515
INI file
  DOSSHELL.INI 295
  E.INI 141, 144
  PCM.INI 518
  RAMBOOST.INI 223
  RAMSETUP.INI 209, 212
  STACKER.INI 305
  SYSTEM.INI (Windows) 286
initialized tapes in CPBackup 417
input, redirecting 109
insert mode 143
insert space gesture for PenDOS 490
installation device driver 57
installation of
  bundle files 554
  Central Point Backup for DOS 383
  Central Point Backup for Windows 385
  Central Point Undelete for Windows 241
country codes 9
IBM AntiVirus/DOS 363
IBM AntiVirus/DOS for Windows 363
ISO fonts 5
keyboard layouts 5, 9
mouse drivers 410
optional tools 545
PC DOS 3
PC DOS from a LAN server 540
PC DOS from a LAN workstation 540
PC DOS Shell 319
PenDOS 481
Phoenix PCMCIA Support 502
Phoenix PCMCIA Support for Windows 502
Stacker compression 427
Windows tools 9
installing
  answering problems 281
  backing up files 282
  booting from diskette 14
  copying Setup files 546
File Update at remote location 198

Index 579
installing (continued)

from a CD-ROM drive 544
from within your DOS system 14
if a LAN administrator 540
if after the LAN Administrator installs 543
if from a remote workstation to a server 542
if installing to a server 541
if OS/2 is installed 534
if OS/2 is installed as FAT 534
if rerunning Setup (/E) 544
if using a mouse 5
if using Boot Manager 534
if using diskettes 14
if using Dual Boot 534
if using OS/2 Boot Manager 534
if using OS/2 Stacker 534
if wanting optional tools 545
if you have a PS/1 536
if you have OS/2 Stacker compression 536
if your drives are compressed 537
if your system already has Dual Boot capability on a LAN-connected system 202
on a remote PC 196
on an InterLnk-connected system 200
on drive other than C 533
on hard disk 14
partitioning disks 282
removing comment lines 7
using XDF-formatted diskettes 550
INTERLKNK command 176, 180, 286
INTERLKNK device driver 286
InterLnk program 175
using with File Update 200
INTERSVR command 179, 181
InterSvr program
describing use of 179
using with File Update 200
IRQ, PCMCIA 507
ISO font selection 5

J
joining a text line in E Editor 143

K
KEEPINFO option, RAMBoost 219
key stroke, E Editor 147
  sequence play (CTRL+T) 147
  sequence record (CTRL+R) 147
KEYB command 68
keyboard
  choosing files in CPBackup 398
displaying 485
  editing characters on 487, 488
keyboard selections 9
keyboard shortcut keys 327
KeyGuard 559
keys
cursor movement, E Editor 142
DOS editing 127
for E Editor functions 133
help in PC DOS Viewer 45
stopping a batch program 100
keys for marking (E Editor)
  adding numbers in (ADD) 167
  append text 166
  block mark (ALT+B) 151
copied text, insertion (ALT+C) 155
copied text, overlay (ALT+O) 155
deleting text (ALT+D) 155
fill marked area (ALT+F) 155
gtext 165
line mark (ALT+L) 151
move cursor to beginning of (ALT+Y) 155
move cursor to end of (ALT+E) 155
moving text 155
moving text, space filling (ALT+A) 155
paragraphing text (ALT+P) 154, 155
put text from file 165
reflowing text (ALT+R) 154, 155
remove mark (ALT+U) 151
search restriction 160
shift left (ALT+F7) 155
shift right (ALT+F8) 155
Local Area Network (LAN) (continued)
  using with File Update  202
LOCAL.MSG  379
locating files using DIR /S  24
locating text using E Editor  157
logical drives  83, 89
lost file Undelete file condition  246

M
macro, DOSKey
  creating  121
  defining  120
  deleting  124
  editing  123
  running  122
  saving  123
  using replaceable parameters  125
macros
  PenDOS for gestures  491
  saving keystrokes in, E Editor  147
making a backup  391
margins
  paragraph adjustment to  154
  setting  146, 154
marking
  as deleted file  28
  line (mouse)  148
  text using a mouse  148
  text using key combinations  149
marking text
  See text marking
Math command in E Editor  167
mathematical expressions in E Editor  167
MaxSpace for Stacker  447
MaxSpeed for Stacker  447
MD (make directory) command  35
media errors while optimizing  308
megabytes defined  73
MEM command  206, 236
memory
  analysis of your computer  221
  conventional  461
  expanded (EMS)  463
  extended  462
memory (continued)

extended memory (XMS) 289
loading DOSKey program in 115
problems with 287
ranges, RAMBoost 229
required for PC DOS Shell programs 360
run the optimizer 464
specifying in the PC DOS Shell for
programs 361
upper 462
Upper Memory Area 290
upper memory blocks 462

memory manager
compatibility with each other 225
DPMS access 462
EEMS/EMS 4.0 types 207
HIMEM.SYS 288
other types of and RAMBoost 206
PC DOS-provided 207, 462
used with PC DOS 290

memory types
conventional memory 219
expanded memory (EMS or EEMS) 221
extended memory (XMS) 220
high memory area (HMA) 219
upper memory block (UMB) 219

memory-resident program 68
defragment 233
RAMDrive 238
SMARTDRVR 236

menu
block for multiple configurations 60
buttons for PenDOS 485
choices for File Update 194
E Editor 134
optimize option, DEFRAG 234
option for PC DOS Viewer help 48
selections for PC DOS Shell 328
selections for PenDOS 485
system startup choices 60
menu bar, PC DOS Shell 322
MENUCOLOR command 60
MENUDefault command 60
MENITEM command 60
messages
abnormal program termination 297
creating for PC DOS Shell help 360
EMS page address, EMM386 291
high memory area 288
incorrect DOS version 294
online book of errors 46
out of memory 293
packed file corrupt 289
ROM or RAM within page frame 291
Stacker Setup 302
startup 283
while installing 287
with batch programs 101
methods and backup strategies 423
mnemonic selection 326, 366
mobility impairment 557
MODE command 67
modem/FAX cards, PCMCIA 509
modifier keys for PenDOS 489
modifying E Editor file 137
monitor, video 295
monochrome screen
    file selection indication in CPBackup 399
    required file 295
    Stacker /m switch 431
MORE command 111, 550
mounting
diskette drives (AutoMount) 464
drives to make data available 445
permanent Stacker drives 465
removable Stacker drives 442, 461
removable Stacker drives 464
software-drive removable drives 465
Stacker Anywhere drives 444
Stacker Windows drives 445
temporary drives 444
mouse
drivers with CPBackup 410
pointer for PC DOS Shell 324
scrolling with 333
selection for PC DOS Shell 324
using as a pen 484
mouse (continued)
    using during install 5
MOUSE command 68
MOVE command 28

movement
    of cursor 141
    of cursor to beginning of marked area
        (ALT+Y) 155
    of cursor to end of marked area
        (ALT+E) 155

moving
    around in E Editor 142
    around in the PC DOS Viewer 44
    blocks of text, E Editor 153
    marked text using E Editor 155
    text, E Editor (ALT+M) 153

MS-FLASH.SYS file 508
MSCDEX command 57, 66, 466, 544
Mult command (E Editor) 167
multi-tasking using PC DOS Shell 296
multiple
    .INI files 207
    commands, typing on one line 116
    configurations at startup 54
    configurations with PCMCIA 503, 517
    configurations with RAMBoost 207
    configurations, common block 62
    configurations, menu block 60
    drive backups 401
    drive selection in CPBackup 400
    editing, E Editor 140
    files, deleting 27
    files, editing (E Editor) 140
    hard drives 94
    menu block 60
    partitions 81
    selections using PC DOS Shell 328
    system configurations 60
    text mark 150
    multiplying numbers (E Editor) 167

naming (continued)
    a file in E Editor 134
    batch program 99
    unnamed E Editor file 138
Netroom 225
network volumes, restoring 410
networks 252
New command (PC DOS Shell) 348, 350
new features of Stacker 429
next DOSKey command 117
NOEMS and Stacker 464
noems switch 58
non-DOS partitions 82
non-Express window in CPBackup 399
non-SCSI tapes supported 417
normal use of AntiVirus 365
Novell network 412, 413
Novell network drive display 401
Num Lock (NL), PenDOS modifier key 489
numeric keypad 488

O
online book
    copying topics 51
    exiting from 45
    getting help for 45
    linking to more topics 49
    names of 41
    printing topics 51
    starting the PC DOS Viewer 41
    table of contents 45
    viewing the screen 43

online help
    creating for PC DOS Shell 349
    creating Help messages 360
    E Editor 136
    E Editor F1 key 134
    for PC DOS Shell 334, 335
    for PC DOS Shell procedures 336
    for the PC DOS Shell 336, 337
    getting for the PC DOS Viewer 45
    PC DOS Viewer 45
    opening files using E Editor 134

index 583
optimization
  Stacker drives 449
types of 450
  versus recompressing 449
optimize and defragment 234
optimizing
  by increasing system speed 232, 233
  by reducing file search time 233
optimizing your system 235
option methods (RAMBoost)
optional tools
  adding after initial DOS install 364
  adding after initial DOS installation 503
  Central Point Backup for DOS 10, 383
  Central Point Backup for Windows 10
  Central Point Undelete for Windows 10
  IBM AntiVirus/DOS 10, 363
  IBM AntiVirus/DOS for Windows 10
  PC DOS Shell 10
  PCMCIA Support 10
  PenDOS 10
  rerunning Setup to install 545
  REXX Language Support 10
  Stacker Compression for DOS and
  Windows 10
options editor, RAMBoost 216
order of devices in path 239
ordering products, disabilities 557
OS/2
  starting the PC DOS Viewer from 42
  using dual boot for switching 535
  using the AntiVirus program 365
output, redirection commands 109
overlay text using E Editor 155
overwrite warning during restore 410
overwritten files 245, 250, 267, 270

paragraph (continued)
  formatting (ALT+P) using E Editor 155
parameters
  for CPBDIR 425
  for SETUP 8
  in startup commands for program
  items 355
  replaceable for DOSKey 124
parent directory 21
partition
  data, viewing 85
deletion of 92
  extended 81
  hard disks 81
  non-DOS partitions 82
  primary 81
  primary DOS 282
partitioning and formatting 87
Pascal syntax 164
password
  changing 454
  protecting a backup 392
  removing 455
  setting 454
Password tool, Stacker 439
passwords
  for Central Point Backup 392
  for CPBackup user levels 389
  for program groups 349
  for program items 351
paste gesture for PenDOS 491
PATH command 67, 233, 284
path order for devices 239
PAUSE command 102
PC DOS Shell
  adding program groups 348, 349
  attaching programs to 338
  changing group contents 350
  changing program item properties 357, 360
  changing the window 344
  creating help messages 349
default view 345
deleting a program group 349

P
packed file corrupt 289
packed format 555
page frame 291
paragraph
  adjusting to new margins using
  E Editor 154
PC DOS Shell (continued)
described 319
Directory Tree area 322
disk utilities 326
display monitors supported 295
displays 324
displays supported 295
finding files 339
getting help 360
graphics mode 323
installing 319
leaving temporarily 342
online help 349
quitting 343
quitting active tasks 342
requesting Help 334
starting from DOS prompt 321
starting programs from 338
Task Swapper 341
troubleshooting 295
using the Help menu 336, 337
viewing Help procedures 336
PC DOS Shell window
changing for the PC DOS Shell 344
rearranging items in program groups 352
PC DOS Shell, customizing
adding passwords for program items 359
adding program groups 348, 349
adding program items to groups 350, 351
copying program items among groups 351
creating startup commands 354
defining application shortcut keys 358
deleting a program group 349
deleting program items from groups 352
pausing after quitting a program 359
preventing program switching 362
rearranging items in program groups 352
reserving PC DOS Shell shortcut keys 362
running batch programs in a startup
command 354
setting video mode for programs 361
specifying memory for programs 360, 361
using a startup directory for programs 358
PC DOS Viewer
appending information to a file 52
copying information to a file 52
copying topic information 51
copying topics 51
definition of 41
exiting from 45
finding index topics 50
getting help for 45
getting help while using 48
getting other types of online help 45
linking to more topics 49
linking to topics 49
moving around in 44
moving around in the PC DOS Viewer 44
printing 51
printing from the PC DOS Viewer 51
starting from a DOS Command Prompt 41
starting from OS/2 42
starting from PC DOS Shell 42
starting from Windows 43
starting the online Help 41
using the HELP command 45
using the viewer 41
viewing the initial PC DOS Viewer screen 43
PC Tools DiskFix 309
PCM Card List, PCMCIA 515
PCM command 512
PCM Configure selection, PCMCIA 513
PCM Information selection, PCMCIA 515
PCM Option selection, PCMCIA 515
PCM utility for DOS 512
PCM utility for Windows (PCMWIN) 516
PCM.INI file 501, 518
PCMATA.SYS file 511
PCMCIA
advanced configuration considerations 517
ATA card settings 509
configuring with RAMBoost 528
considerations before using 503
designating a card 510
dynamic configuration 512
Flash File System 508
PCMCIA (continued)
installed driver list 511
latest enhancements 501
modem/FAX card settings 509
multiple configurations 503, 517
PCM for Windows (PCMWIN) 516
PCM utility for DOS 512
PCMFDISK 518
PCMRMAN 518
UMB memory 503
using PCM command 512
using PCMDINST command 505
using PCMFDISK command 518
using PCMRMAN command 521
using PCMSETUP command 505
PCMCIA Support 11
PCMCS.EXE file 511
PCMDINST command 505
PCMDINST, removing EMM386 before running 504
PCMFDISK command 518
PCMFFCS.EXE file 511
PCMRMAN 521
PCMRMAN command 511, 521
PCMSCD.EXE file 511
PCMSETUP command 505
PCMSS.EXE file 511
PCMW5IN
running and configuring cards 516
using only 386 enhanced mode 516
pen, using with PenDOS 484
PenDOS
aligning tablet 497
buttons on menus 485
copy block of text gesture 491
ENTER button 485
entering characters 486
ESC button 485
installing 481
K button 485
keyboard 487
menu and buttons 485
modifier keys 489
paste gesture 491
PenDOS (continued)
starting 483
starting applications 493
tap gesture 491
undo gesture 491
using with EMM386 481
Writing Window 485
PENDOS command 483
PenDOS optional tool 11
perfect Undelete file condition 245
performance improvements 239, 447
permanent swap file, Stacker Windows 476
Phoenix PCMCIA Support 11, 501, 502
phrase mark (E Editor) 150
pipe
for getting command input 111
with the MORE command 111
with the SORT command 113
poor Undelete file condition 245
precompressed data, Stacker 474
preconfigured setup files in CPBackup 403, 405
preferences gauges 472, 473
preinstall considerations (INTERLNK) 176
Prevent Program Switch (PC DOS Shell) 362
preview for File Update 197
previous DOSKey command 117
Previous push button 44
primary DOS partition 86, 282
creating 86
defining 81
PRINT command 550
Print command, E Editor 141
Print History command in CPBackup 411
Print push button 44
printer
redirecting output to 109
printer control characters using E Editor 170
printing
a CPBackup directory 411
compare report in CPBackup 407
E Editor file 134, 141
README.TXT file 550
topics in the PC DOS Viewer 51
problem determination 281
backing up system 314
DOS commands 292
File Update utility 313
memory problems 287
PC DOS Shell 295
Stacker Compression 299
task swapping, PC DOS Shell 296
problem resolutions 281
procedures, online for PC DOS Shell 336
procedures, troubleshooting 299
products, disabilities
IBM AccessDOS 557
IBM Screen Reader 558
KeyGuard 559
Screen Reader 558
products, individuals with disabilities 557
program file, definition of 19
program flow, batch program 106
program groups
adding 348, 349
adding passwords for 349
adding program items to 350, 351
copying program items 351
creating Help messages for 349
deleting 349
deleting program items from 352
rearranging program items 352
program item properties, PC DOS Shell 353, 360
program items
adding passwords for 351, 359
adding to program groups 350, 351
changing 351
changing properties of 353
copying among program groups 351
creating Help messages for 349
creating startup commands for 350, 354, 355, 356, 357
defining shortcut keys for 351, 358
deleting from program groups 352
group contents, PC DOS Shell 352
preventing switching 362
rearranging 352
program items (continued)
reserving shortcut keys for 362
setting video mode for 361
specifying memory requirements for 360, 361
using a startup directory for 351, 358
Program List 322
area of PC DOS Shell 322
display view, PC DOS Shell 347
programs
attaching to PC DOS Shell 339
Program List view 347
returning to PC DOS Shell from 339
running from PC DOS Shell 338
starting from PC DOS Shell 338
PROMPT command 67
Properties command, PC DOS Shell 353, 362
properties in the PC DOS Shell 353, 362
advanced 360
application shortcut keys 358
CALL command in startup commands 354
Help messages for program items 360
memory requirements for programs 360, 361
password for program items 359
pause after program exit 359
program switching 362
reserved shortcut keys 362
startup commands 354
startup directory for program items 358
video mode 361
protection
against file deletions 247, 267
AutoProtect for Stacker 299, 452
AutoRecover for Stacker 302
checking compressed disks 453
features of Stacker 451
from computer viruses 367
from viruses, Automated check 363
from viruses, Shield DOS 363
password for Stacker 454
PS/1 systems, installing on 536
purged Undelete file condition 246
purging delete protected files  266
push button, PC DOS Viewer
  Contents  44
  Forward  44
  Help  45
  Index  44
  Previous  44
  Print  44
  Search  44
Put command (E Editor)  165

Q
QCONFIG command  206, 221
QEMM Stealth and Stacker  464
QEMM386  226
QIC format for tapes  418
QIC tape drives supported  415
quick format  76
Quick optimization for Stacker  449
 quitting
  an E Editor file  137
  PC DOS Shell  343
QView  402

R
RAM and Stacker  464
ram switch with EMM386  59
RAM within page frame  291
RAMBoost
  advanced features  214
  changing memory usage of a block  215
  comparing memory types  219
  configuration file  217
  configuring  208
  configuring with PCMCIA  528
  considerations before configuring  208
  expanded memory (EMS or EEMS)  221
  extended memory (XMS)  220
  extended memory specification  221
  freeing conventional DOS memory  219
  options editor  216
  overview  206
  RAMSETUP command  208
RAMBoost (continued)
  requirements for  207
  reserved memory area  219
  system requirements  207
  upper memory blocks  219
  upper memory editor function keys  215
  upper memory usage editor  214
  using with EMM386 options  216
XMS  221
RAMBOOST.INI file  217, 223
RAMDrive device driver  238
RAMDRIVE.SYS  238
RAMSETUP.INI file  209, 212
RD (remove directory) command  36
read errors while optimizing  308
read-only file attribute  30
read-only password, Stacker  454
read/write password, Stacker  454
README.TXT file  281, 550
README.XDF file  554
rebooting
  CTRL+ALT+DEL  66
  without system file commands  54
rebuilding configuration, Stacker  303, 305
recognition tips for PenDOS  498
recompressing a disk, Stacker  449, 451, 457
recovered Undelete file condition  246
recovering
  allocation units  232
  deleted data  241
  deleted files  26, 28, 245
redirected drives  178
redirecting
  command input or output  109
  drives, InterLnk  182
  input and output  109
  input and output of commands  126
redirection character
  combining commands with  113
  defined  109
  for input or output  109
  output to file or printer  109
  redirecting command input  110
redirection characters 113
reference chart of user levels
(CPBackup) 390
reflowing
   any position (ALT+P) using E Editor 156
   marked area (ALT+R) using E Editor 154, 155
   marked block of text (ALT+R) 154
   paragraph (ALT+P) 154
text in box 164
reformatting a hard disk 315
REM command 7, 103, 210
remapping
   drives for File Update 200
remarks in batch programs 103
remote location, File Update 198
removable Stacker drives
   mounted not swapped (NS) 461
   mounted replaced (RP) 461
   mounting 442
removing
   attributes 300
   incorrect version of INTERLNK 286
   passwords 455
   Setup comment lines 7
   Stacker drives 446
   viruses when detected 376
   write protection 299, 301
   write-protection 452
RENAME command 26
renaming
   a directory 40
   a disk 79
   a file 26
Reorder command (PC DOS Shell) 352
repair utilities, disk
   running with Stacker 301
repairing
   CHECK errors 453
   Stacker drives 301
   uncompressed drive 309
repartitioning hard disk 282
replace mode 143
replaceable
   drives, defining for Stacker 461
   parameters 105
   parameters in macros 124, 125
   parameters, PC DOS Shell 355, 357
replacing text using E Editor 160
Report tool, Stacker 439
requirement, hard disk space 281
rerunning Setup 544
reserve shortcut keys (PC DOS Shell) 362
reserved memory area 219
resetting tape drive defaults 420
restarting
   CTRL+ALT+DEL 66
   without system file commands 54
restarting problem 283
restore a file 292
RESTORE command 293
restoring
   an E Editor line 134, 145
data in CPBackup 409, 410
deleted files 26
disks 78
DOS system files 304
previous version of DOS 547
Stacker header 299
   viewing overwrite warning 410
reviewing virus information logs 371
REXX commands 46
REXX Language Support for DOS 11
ROM within page frame 291
root directory 32, 53
running 54
   CHKDSK on Stacker drive 299
   programs from PC DOS Shell 338
   system without system commands 54
S
   safe format 75
Save command (E Editor) 139
Save Setup, CPBackup 404
SAVEHDR* files, Stacker 299
saving
   DOSKey macro 123
saving (continued)
  E Editor file and quitting (F4) 134, 137, 139
  edited E Editor files (F2) 134, 139
  scanning disk for available clusters 258
  Schedule Backups command 406
  Scheduler, Central Point 275
  scheduling an unattended backup 406, 407
  screen
    attributes and colors, changing 68
    colors for the PC DOS Shell 344
    initial, PC DOS Viewer 43
    modes for PC DOS Shell 344
  scroll bars, PC DOS Shell 332
  Scroll Lock (SL), PenDOS modifier key 489
  SCSI
    See Small Computer System Interface
  SCSI drives supported 416
  SCSI tape directory 393
  SDEFRAG command 306
  Search command, PC DOS Shell 339
  Search push button 44
  searching
    for all text 159
    for files in reduced search time 233
    for files using PC DOS Shell 339
    for text to replace 160
    for text using E Editor 157, 160
    for the PC DOS Viewer index topics 50
    for the PC DOS Viewer topics 49
  section, definition of 73
  sectors defined
  security software 382
  selected files, monitoring compression 475
  selecting
    displays 324
    E Editor text 148
    files manually in CPBackup 399
    PC DOS Shell 320
    Scheduler options 280
    Undelete files 249
    using a mouse 5, 325
    with a mouse 324
    with keyboard 326
  send output (») 109
  sentence mark (E Editor) 150
  server volume display 401
  server, definition of 177
  servo-written tapes 417
  SET command 67, 239, 286
  setting
    compression level, Stacker 448, 449
    margins using E Editor 146
    passwords for Stacker 454
    Stacker up 431
    system time and date 5
    TEMP before using a pipe 111
  setting active partition 91
  setting up PCMCIA 505
  SETUP
    See also Installation
    /A switch 540
    /E switch 295, 545
    /U switch 9
    command syntax for 8
    new features of 5
    reasons for not running 281
    rerunning 544
    switches for installation 7
  SETUP command (Stacker) 442
  Setup diskettes
    backing up 552
    using DOS commands 551
    viewing contents of 554
  setup files in CPBackup 403
    contents of 404
    description 405
    loading 405
    preconfigured 405
    preconfigured in CPBackup 403
    saving 405
  setup files, CPBackup 404
  setup for Stacker
    express or custom 432
    getting help on 432
    recovering from interrupted 302
    running 431
    troubleshooting 302
SETVER command 294, 314
Shell
  See PC DOS Shell
SHELL command 290
Shield DOS 363
shift marked text
to the left (ALT+F7) 155
to the right (ALT+F8) 155
SHIFT, PenDOS modifier key 489
shortcut keys 327
  for starting program items 351, 358
  reserving for program items 362
size of environment 290
SL (Scroll Lock), PenDOS modifier key 489
Small Computer System Interface (SCSI) 237
smaller, making Stacker drive 456
SMARTDRV
  CD-ROM caching 237
  controlling size of memory cache 236
  double-buffering 237
SMARTDRV command 68, 236
SMARTDRV.EXE device driver 237
software for security 382
SORT command 112
sorting
data 112
  Undelete file list 248
sound for Stacker 472, 473
source file 25
space character, inserting 487
special commands for batch programs 98
special document format 56, 66
specifying disk capacity 76
speech recognition program 559
speeding up your system 231, 232, 233
splitting a text line in E Editor 143
SRAM Memory Card, PCMCIA 528
SSETUP command (Stacker) 431
STAC command (Stacker) 437
Stacker
  assigning for CD-ROM drive 466
  creating a bootable diskette 310
  installing with PC DOS 427
  running disk-repair utilities 301
Stacker (continued)
  startup diskette 309, 310
  troubleshooting 299
  unmounting a drive, DOS 301
  using with EMM386 464
Stacker Anywhere
  explanation of 443
  in memory 445
  running 445
  using on non-Stacker systems 443
Windows icon 445
STACKER command 300, 442
Stacker command summary 467
Stacker compression
  DOS Toolbox 438
  DPMS 462
  installation of 12
  introduction to 427
  menu, File Manager 474
  OS/2 & DOS version 534
  STACVOL files 459
Stacker DOS Toolbox
  changing expected compression ratio 458
  changing Stacker drive size 456
  compressing removable 442
  defragmenting a disk 450
  defragmenting data 450
  optimizing 450, 451
  optimizing data 450
  recompressing a disk 451
  recompressing data 450
  tuning 448, 449
  uncompressed a disk 447
  using the password tool 454
Stacker drive
  changing size of 456
  creating 441
  determining letters of 459, 460
  storing 459
  unmounting for Windows 445
Stacker Drive Size tool 439
Stacker Optimizer tool 439, 449, 450, 451
Stacker startup diskette 299, 309
  for Stacker drives 309
Index 591
Stacker Tuner tool 439
Stacker Windows Toolbox
  changing Stacker drive size 457
  Check tool 453
  compress tool 440
  compressing removable 443
  Configure tool 457, 476
defragmenting a disk 450
gauges 469, 472
  minimizing 473
  opening 469
  optimizing 451
Optimizing tool 450
  overview 469
Password tool 455
  recompressing data 450, 451
  tuning 449
  Uncompress tool 446
warnings 473
STACKER.EXE 445
STACKER.INI 461
  /AUTO switch 466
  /BD=drive 467
  /Q switch 461
  commands in 460
  editing using /I switch 460, 461
  syntax for 461
STACKER.INI file 460
STACVOL
  do not delete or format file 459
  restoring file headers 299
  Stacker file 459
stand-alone AntiVirus 365
stand-alone program, virus checking 379
Start Restore command, CPBackup 410
starting (continued)
  DOS by bypassing startup commands 54
  DOSKey macro 122
  E Editor 137
  IBM AntiVirus/DOS 365
  IBM AntiVirus/DOS for Windows 365
  IBM Boot Manager 364
  PC DOS Shell 321
  PCMCIA 503
  PenDOS 483
  programs from PC DOS Shell 338
  Stacker compression 431
  system (booting) 364
  the E Editor 133
  the online documentation viewer 41
Undelete 243
Windows AntiVirus 367
starting the PC DOS Viewer
  from OS/2 42
  from PC DOS Shell 42
  from the DOS Command Prompt 41
  from Windows 43
startup commands for program items
  creating 354
  running batch programs in 354
startup commands, AUTOEXEC.BAT 66
startup commands, bypassing 54
startup directory for program items 351, 358
startup diskette 555
  See also system diskette
  for PC DOS 78
  for Stacker 310
startup menu 60
startup problems, Stacker 303
status gauge, backup (Stacker) 471
status line, PC DOS Shell 323
status of file's clusters 245
status, mounting
  RP 461
  SW 461
stopping
  batch program 102
  batch program permanently 100

See also installation
  applications using PenDOS 493
  batch programs 99
  Central Point Backup 391
  Central Point Backup for Windows 385
  Central Point Undelete for Windows 242
  compare in CPBackup 407
  computer if troubleshooting 283
stored DOSKey commands 117
strategies for backing up 421
subdirectories, copying 39
SUBMENU command 60
SUBST command 284
summary of
  DOSKey character redirection 126
  DOSKey editing keys 116
  DOSKey movement keys 119
Super VGA color display 295
Super VGA monochrome display 295
surface scan, Stacker 308
switch
  /-DPMS for Stacker 463
  /? for command syntax 47
  /A for Setup 540, 542
  /B for COPY 312
  /C for Setup 7
  /E for Setup 295, 545
  /EMS for Stacker 463
  /F for CHKDSK 232
  /F for Stacker CHECK 453
  /l for E Editor 460
  /int15 for HIMEM.SYS 289
  /P for DIR 34
  /Q for Setup 9
  /R for Stacker 309
  /T for Setup 9, 541
  /U for FORMAT 553
  /U for XDF 551
  /UMB for Stacker 463
  /W for Setup 9
  U 9
switches for Setup program 8
switching, text/graphics modes 344
symbols used in compare in CPBackup 409
syntax
  Assembler 164
  C language 164
  Pascal 164
syntax directed E Editor features 171
SYS command 79, 304, 538, 539
system
  booting using Boot Manager 364
  booting using dual boot 365
  requirements for RAMBoost 207
  setting system time and date 5
  speeding up using BUFFERS 235
  using data compression 381
  using security software 382
system diskette
  creating 78
  making backup of 303
  using in an emergency 555
  using Setup Diskette for 54
system file
  attributes of 30
  bypassing 54
  configuration 53
  modifications by Setup 6
system files
  backing up 397
  checking for viruses 374
  restoring for DOS 304
  viewing during installation 548
  when formatting a disk 78
SYSTEM.INI file (Windows) 286

T
  table of contents 45
  tablet, aligning 497
  taking input (<) 109
  tap gesture for PenDOS 491
tape
  making a backup 393
  using password-protection, CPBackup 393
tape (CPBackup)
  address table 420
  certified 417
  controller cards supported 419
  extra length tapes in Backup 417
  formats, QIC vs CPS 418
  initialized 417
  resetting defaults 420
  servo-written 417
  volume tape catalog 421
tape backup with Stacker 431
tape controller cards address table 420
tapes information (CPBackup) 415

tapes supported, CPBackup
  non-SCSI 417
  QIC drives 415
  SCSI 416
target file 25
task swapping, PC DOS Shell 296, 341
TEMP environment variable 111, 239
template, definition of 127
terminate-and-stay resident (TSR) program
defragmenter 233
RAMDrive 238
SMARTDRV 236
testing
  batch programs 101
testing backup speed 387
text
  box in PC DOS Shell 330
color, changing 68
  copying, E Editor (ALT+C) 152
deletions, E Editor (ALT+D) 151
  file extensions 20
  file, creating 137
  format, changing 68
  marking in E Editor 150
  modes for entering 143
text editor
  comparison to word processor 172
  DOS 5.0 Editor 132
  E Editor 131, 132
  Edlin Editor 132
  special document format 56, 66
text mode
  appearance of cursor 324
text mode, PC DOS Shell
  changing screen modes in the PC DOS
    Shell 344
  setting for program items 361
text, selecting for PenDOS 494
time table, formatting tapes in Backup 418
tips, troubleshooting 299

Token Ring speed, PCMCIA 507
Toolbox, Stacker DOS
  changing expected compression ratio 458
  changing Stacker drive size 456
  compressing removable 442
defragmenting a disk 450
defragmenting data 450
  Optimize tool 450
  optimizing 451
  optimizing data 450
  Password tool 454
  recompressing a disk 450, 451
  recompressing data 450
  tuning 448, 449
  uncompressing a disk 447
Toolbox, Stacker Windows
  changing Stacker drive size 457
  Check tool 453
  compress tool 440
  compressing removable 443
  Configure tool 457, 476
defragmenting a disk 450
gauges 469, 472, 473
  minimizing 473
  opening 469
  Optimize tool 450
  optimizing 451
  overview 469
  Password tool 455
  recompressing data 450, 451
  tuning 449
  Uncompress tool 446
  warnings 473
tools
  See optional tools
tools, Stacker
  change expected compression ratio 458
  check 453
  compress 440
  configure Stacker drive size 456
  configure swap file settings 476
  optimize 449
  password 454
  report 475
Undelete (continued)
starting 243
starting cluster number 263
undeleting a file 252
undeleting a file automatically 250
undeleting a file manually 261
undeleting a file to another drive 250
using search groups 257
viewing available clusters 262
without (DOS delete) protection 247
UNDELETE command 26, 28, 243, 292
Undelete for DOS 241
Undelete for Windows 242
Undelete for Windows, Central Point 11
undeleting
files automatically 250
files manually 261
files to another drive 250
restore a DOS file 292
Undo command (E Editor) 145
Undo gesture for PenDOS 491
UNFORMAT command 78
unfragmented files 233
uninstalling 547
universal gestures, defined 490
unloading
Central Point Scheduler 280
unmarking text, E Editor (ALT+U) 150
unmounting Stacker drives
disk-repair utilities 301
DOS 301
Windows 445
unnamed file in E Editor 138
UNPACK2 command 555
unpacking a Setup file 555
updating Stacker drives 433
upgrading across a LAN 543
upgrading Stacker 433
getting the best compression 433
upper memory
loading Stacker high 462
Upper Memory Area 290
upper memory blocks (UMB) 219, 291, 462
upper memory usage editor
RAMBoost 214
User Level command in CPBackup 389
user level, CPBackup
changing 389
passwords 389
reference chart 390
using PC DOS’s version

V
values for PCMCIA Advanced Setup 506
values, ASCII (PenDOS) 489
variable, environment 111
variations of characters for PenDOS 499
version of DOS 294
version table for SETVER 294
VERV.VDB 379
VGA color display 295
VGA files 296
VGA monochrome display 295
video display 295
video mode options (PC DOS Shell) 361
VIEW command 41
viewing
client information, PCMCIA 515
disk partition data 85
disk volume label and serial number 80
file attributes 30
files in CPBackup 402
list of stored DOSKey commands 117
other DOSKey commands in the list 118
PC DOS Viewer screen, initial 43
PCM Card List, PCMCIA 515
previous or next command 117
README.TXT file 550
README.XDF file 554
PC DOS Viewer screen, initial 43
system files during install 16
system files during installation 548
the first or last DOSKey command 118
using MORE command 111
views (screen) of PC DOS Shell 320
VIRSIG.LST 379
Virtual Control Program Interface (VCPI) 462
virus characteristics 368
virus protection methods
  Automated check 363
  Shield DOS 363
viruses
  protection against 367
  what to do if detected 363
visual impairment 557, 558.
VOL command 80
volume label 80
  creating 79, 80
  defined 79
  specifying when formatting a disk 76
volume serial number 80
  assigned when formatting a disk 77
  defined 79
volume tape catalog explained 421
VTC file (CPBackup) 421

Windows
  building permanent swap file 476
  Central Point Backup 12
  Central Point Undelete 241, 243
  Central Point Undelete for Windows 242
  enhanced mode 237
  File Manager Stacker Menu 474
  help for Stacker 430
  IBM AntiVirus/DOS 11, 367
  PC DOS optional tools 9
  preferences gauges 473
  starting the PC DOS Viewer from 43
  SYSTEM.INI file 286
  using with File Update 190
  WIN.INI file 286
  with Central Point Backup 385
  with PC DOS Stacker 427
  with Stacker compression 385
  Windows permanent swap file 476
  word mark (E Editor) 150
  word wrap 143
  WPSF
  See Windows permanent swap file
  write errors while optimizing 308
  write protection, Stacker 299, 301
  write-protected Stacker drive 305
  write-protection, Stacker 452
  writing area 486
Writing Window
  button for 485
  cancelling, not secding characters 487
  clearing characters 487
  closing Writing Window 487
  displaying 485, 486, 489
  editing characters in 490
X
  XCOPY command 38
  XDF command 551, 553, 554
  XDF-format
    backing up diskettes 552
    copying diskettes 552
    formatting again 553
    installing 550
  XDF-formatted diskettes 554
  XDFCOPY command 551, 552
  XGA color display 295
  XGA monochrome display 295
  XMS extended memory 289
  XMS Memory options (PC DOS Shell) 361

Index 597